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1 Tekla PowerFab 2023 release
notes

Welcome to Tekla PowerFab 2023!

Tekla PowerFab introduces functionalities that help you manage changes in
your projects efficiently to minimize the chance of something going wrong. You
will also have better insights into your workflows. Supporting sustainability
goals, we have added improved ways of tracking the origin of raw materials.

New time-saving functionalities are now also available in the mobile tool Tekla
PowerFab Go.

The Product Guides have also undergone some major changes to provide
more a consistent structure and content.

1.1 Manage changes to a production control job
The new change management functionality allows you to easily see and
understand the impact of changes when importing a new bill of materials into
a production control job.

If you are uncertain of a particular change, you can save it for later so that the
relevant person can review and implement the change. Then the associated
drawings are placed on hold to prevent any further work being carried out
while the change is pending.

Changes that would have previously been ignored, are now added to the
revision queue so that the necessary action can be taken to make the change.

For more information, see Manage changes to a production control job
(page 854)

1.2 Add inventory to load
You can now add items to shipment directly from inventory.
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In doing so, the inventory is taken from stock, and the weight of the materials
is included in the overall weight of the load. The shipping ticket report then
displays the additional inventory items.

The ability to add inventory to load has been added to both Tekla PowerFab
and Tekla PowerFab Go. For more information, see:

• Add inventory to load (page 551)

• Add inventory to load in Tekla PowerFab Go in Tekla PowerFab Go User
Guide

1.3 Quick access to dashboards
You can now launch the production dashboard and the shipping calendar from
the desktop version of Tekla PowerFab. This eliminates the need to log into
Tekla PowerFab Go to view and manage production productivity and to
manage the shipping schedule.
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You can navigate and customize the dashboards as if you were using Tekla
PowerFab Go in a browser. To access other functionalities of Tekla PowerFab
Go, you have to open Tekla PowerFab Go in a browser.

For more information, see View the production dashboard (page 852).

1.4 Set mill of origin for material
To achieve greater material traceability, you can define individual mill locations
in the address book.
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When material is received from a purchase order or added to inventory, you
can specify the mill of origin for each item. This will also be a key element of
sustainability reporting in the future.

You can utilize the mill of origin both in the desktop version of Tekla PowerFab
and in Tekla PowerFab Go.

Tekla PowerFab Office

First, you need to identify the firms that should be classed as a mill, and define
their locations. In the Address Book, if a firm is designated as a Supplier in
the firm type, there is an additional Is Mill checkbox on the Addresses tab. If
selected, the firm is classed as a mill and the address registered as a mill
location.

Within the same firm, it is possible to have some addresses that are mills and
others that are not, as mills often have service centers and distribution centers
that do not produce new material. You can also set a default mill location.

Next, you must select the Mill of Origin checkbox in Maintenance -->
Purchase Orders --> Company Standards to show the Mill of Origin
checkbox in the Receive dialog box in Purchasing.
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When you have defined the mill locations, these can be applied to materials,
both when receiving from a purchase order and when adding or editing
inventory.

In the Receive dialog box in Purchasing, you find a Mill of Origin drop-down
list, which lists all suppliers in the address book that have at least one address
that has the Is Mill checkbox selected.
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If the selected supplier in the Mill of Origin list has more than one address
with the Is Mill checkbox selected, a second drop-down list appears to allow
you to select the appropriate mill location.

Once the material is received, the inventory record is updated to display the
mill of origin, which can be viewed by including the Mill of Origin column on
the Inventory grid.

For existing inventory, the mill of origin value can be updated, either by
enabling the Mill of Origin input field, or via the global edit window.

Tekla PowerFab Go
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In Tekla PowerFab Go, you can select the appropriate mill of origin when
receiving material from a purchase order, both for individual lines and using
batch edit.

It is possible to filter inventory by the Mill of Origin field, and it can also be
displayed as a column throughout the Inventory area.

For more information, see:

• Modify company or contact properties (page 146)

• Add an item to the inventory (page 538)

• Define company standard settings for purchase orders (page 957)

• Receive purchase order items (page 1033)

1.5 Swap bars in Tekla PowerFab Go
You can now swap bars (and sheets) on a cut list to another suitable bar. This
is particularly useful when the intended bar either cannot be found, has failed
quality control, or is simply at the bottom of a stack of bars.
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You can swap material from both the Pick List and the Cut Lists view in Tekla
PowerFab Go. This allows both the inventory foreman and the machine
operator to update the list of bars to be used before they are cut.

Unlike the existing exchange bar tool when processing an individual cut, with
the swap bar function, the new bar can have a different length and grade, but
only if it still satisfies the nest.

In the Cut Lists view, you can click the Swap Material icon against a bar or
sheet to open the Swap Material view.

At the top of the view, you can see the allocated bar on the cut list, and the list
at the bottom of the view contains all suitable alternatives.

The search field allows you to search for a bar or sheet using values like
Location, Supplier, PO #, and Heat #. This is particularly useful when the list
of suitable alternatives is extensive.

The list of suitable alternatives that can fulfill the cut list includes any bar or
sheet that is in inventory (not on order) and allocated to the same job, or is
unreserved. This includes both longer and shorter bars. Any properties of the
suitable alternatives that are different from the allocated bar are highlighted
and are in bold italic text.

In the example above, the allocated bar is 10 meters long, but the list of
suitable alternatives lists an 8 meter bar, as this would be able to produce all
of parts due to be cut from the allocated bar.

When the Use Grade Substitutions checkbox is selected, the list of suitable
alternatives will also include bars of a higher grade, determined by the
Substitutions for grades defined in Maintenance --> Shapes/Grades/Sizes
for the given shape.
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In the example below, the allocated bar is grade S355JR, but the list of suitable
alternatives lists a bar with a grade S355J2, as this is specified as a higher
quality.

To complete the swap, you must select the checkbox alongside the bar or
sheet to be used, ensure the Qty to swap is set correctly, and click Swap
Material. This returns you to the Cut Lists view, which now reflects the new
bar or sheet.

The swap material icon can also be found on the Pick List interface for a cut
list when you first click on the View icon alongside the corresponding material.
From here, the process is the same as described above.

The same functionality was introduced in the 2022i desktop version of Tekla
PowerFab.

For more information, see View cut lists and process items in Tekla PowerFab
Go User Guide

1.6 View next station and route in Tekla PowerFab Go
You now have now have greater visibility of a part's or assembly's journey
through the fabrication process.

You can enable a new Next Station column to show in the Cut Lists and
Production Tracking views. This column indicates the next station where the
item needs to go for its next operation. If the TFS station is the last station on
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the item's route, it will display the station after the main assembly's TFS
station.

In Production Tracking, you can see the next station in both the Add and Add
Batch views.

The view that shows the next station for single items when accessed via Add:

The view that shows the next station for multiple items when accessed via Add
Batch:
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A new Status icon  has been added in the Assemblies and Inspections
views. This allows you to see the item's full route and current progress.

When you click the Status icon in the Assemblies view, it opens a pop-up view
that displays the overall route progress.

For more information, see View and modify production tracking statuses in
Tekla PowerFab Go User Guide.
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1.7 Timer for piece tracking in Tekla PowerFab Go
In Tekla PowerFab Go, you can mark a part or assembly as completed and
enter the time that it took to complete it. You can use a timer that you can
start, pause, resume, or finish, and use the accumulated time as the labor time
to complete a station for one or several assemblies.

When you use the timer, you do not have to record or remember a start time
for each assembly. The timer is helpful also when you have to take a pauses,
as you can just log off and resume the timer when you log in again.

You can either use a general clock or a clock for each assembly or part in the
process.

Each timer is independent from each other, which means that clocks can be
started at different times for individual parts. If you prefer a batch timer, it can
also be split to run for different parts or assemblies.

When you tap Stop, the clock displays the options to resume, reset, or finish
the time.
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If you use the batch timer, you need to select the assemblies that were
fabricated and then tap Finish. This divides the time equally by quantity
between the assemblies.

For more information, see View and modify production tracking statuses in
Tekla PowerFab Go User Guide.

1.8 Tekla PowerFab and Tekla PowerFab Go 2023 fixlist
Here you can find the improvements and fixes implemented in Tekla PowerFab
and Tekla PowerFab Go 2023
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2 Install Tekla PowerFab

The Tekla PowerFab Suite license includes several items that you need to
install. To get a Tekla license, contact your organization's administrator.

2.1 Tekla PowerFab license content
The Tekla PowerFab license includes the following software:

• Tekla PowerFab: The main application for estimating, project management,
purchasing, inventory management and production control with a server
installation and a client installation

• Tekla PowerFab Go: A device-independent application for browser with an
embedded Trimble Connect viewer

• Trimble Connect: A tool for real-time visualization and collaboration
between all project parties

The Tekla PowerFab server installation contains the MySQL database
installation and Tekla PowerFab Go. The MySQL database contains the
information used by Tekla PowerFab. You can have multiple sets of data within
the database. The MySQL database is usually only installed on the server
computer. The connection information is the IP address or the computer
name of the computer running the server installation. However, the server
machine is connected to the local host.

Tekla PowerFab database connection can be selected by machine and by port.

As for Tekla PowerFab Go, the Tekla PowerFab Remote Server service allows
performing functions remotely. For example, Tekla PowerFab Remote Server
allows running automated events and using the Tekla PowerFab Go mobile
application.

The licenses of each Tekla PowerFab user are tied to the user's Trimble Identity
and not to particular workstations. For this reason, users always need to sign
in to Tekla PowerFab with their Trimble Identity. Since the licenses are
managed online, you need to have a reliable internet connection to use Tekla
PowerFab.
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2.2 Tekla PowerFab installation overview
1. Create your Trimble Identity

2. Install Tekla PowerFab on a server (page 39).

a. Set the Default directories (page 38).

b. Set up Tekla PowerFab Remote Server for Tekla PowerFab Go
(page 41).

3. Install Tekla PowerFab on a client (page 46).

4. Install Trimble Connect (page 48).

a. Install Trimble Connect Status Sharing tool.

b. Install Trimble Connect.

2.3 System requirements for Tekla PowerFab server
Make sure you follow the system requirements for Tekla PowerFab server
installation for best performance.

 Minimum server
specifications

Recommended server
specifications

Operating system Windows Server 2012 Windows Server
2012/2016/2019

Memory 8 GB 32 GB RAM
Server disk space 10 GB 100 GB reserved for

Tekla PowerFab
(software and data),
solid state drive (SSD)

Standard drives are
acceptable, but SSDs
have faster response
times.

Processor – No specific
recommendations on
the processor.

2.4 System requirements for Tekla PowerFab client
Make sure you follow the system requirements for Tekla PowerFab client
installation for best performance.
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 Minimum client
specifications

Recommended client
specifications

Operating system Windows 10 Windows 10
Memory 4 GB 16 GB RAM
Disk space 2 GB 4 GB
Display resolution 1024 × 768 –

2.5 Create your Trimble Identity
You need a Trimble Identity to download Trimble products and to use your
subscriptions.

For more information, see Create your Trimble Identity.

See also

Troubleshoot 401 Unauthorized error (page 1118)

2.6 Default directories
During the Tekla PowerFab installation procedure, you need to set default
directories. Default directories are the folders where Tekla PowerFab saves
information by default. Default directories are used in the program to manage
external files.

The intended functionality requires that certain shared directories are set on
each Tekla PowerFab user workstation.

If the default directories are to be located on the same server, the server
setting should always use the local path to the folders. In turn, each user sets
their default directories pointing to the same location.

On the client machines, the shared directories are best set using IP addresses
or UNC file paths. The use of mapped drives is not recommended even though
they may work.

It is possible for individual users to have their own default directories, but this
is not recommended, with the exception of the Log directory.

Set the default directories for saving files

TIP To ensure that the default directories are consistent on all computers,
you can copy the settings.ini file from the first client Tekla PowerFab
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installation to C:\Users\Public\Documents\Tekla\Tekla
PowerFab\Settings for all later installations.

1. Go to File --> Default Directories. 

The Default Directories dialog box opens. Set the default directories for
the content specified in Install Tekla PowerFab on a server (page 39) and
Install Tekla PowerFab on a client (page 46). The Custom Reports
directory is not created during the installation and, therefore, you must
add it.

2. To change the default directories, do the following:

a. Click ... on the right side of a field.

b. In the Browse For Folder dialog box, browse to find the folder that
you want to set as the default directory. If necessary, you can add a
new folder under the currently selected one by clicking Make New
Folder.

c. Select the folder.

d. Click OK.

Repeat steps a to d to set all necessary default directories.

NOTE It may be easiest to copy and paste the path in the available field.
You can check the access to the folder or path by double-clicking
in the field for the directory.

3. To update the default directories, click OK.

2.7 Install Tekla PowerFab on a server
As an administrator, installing Tekla PowerFab on a server is the first step. The
server installation includes the MySQL database.

Install Tekla PowerFab on a server

NOTE To download the latest installation files and to install a Full
configuration, make sure you are signed in with a Trimble Identity that
with a current maintenance license. Without a Trimble Identity, use
the Viewer configuration and sign in with the default Tekla PowerFab
sign-in information.

For further instructions, see a video on installation files.
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1. Go to Tekla Downloads and download the installer for the desired Tekla
PowerFab version or service pack.

2. Double-click the installer to run the installation.

a. Review the license agreement. Select Accept and click Next.

b. From the drop-down menu, select the installation type Server. 

By default, New Tekla PowerFab Installation and MySQL Database
are selected.

c. Click Next >.

d. Select the installation folder. 

We recommend installing Tekla PowerFab to the default folder
C:\Program Files (x86)\Tekla\Tekla PowerFab. You can also
select your preferred location.

e. Click Install. 

The Tekla PowerFab installation starts. When the application files
have been installed, you are prompted to install the MySQL database.

f. Review the license agreement. Select Accept and click Next.

g. Use the default folder for installation. Click Install. 

The MySQL installation starts.

h. When the installation is complete, close the installer. 

The actual fabrication database is not yet installed.

3. Open Tekla PowerFab.

4. Sign in with your Trimble Identity.

5. Click Log In. Use the default Tekla PowerFab sign-in information:

• User: admin
• Password: fab
You get a message that the database is not yet installed and that the
program will extract and restore the sample database. The log-in process
runs through both the upgrade and update processes.

6. Sign in and log in again as prompted.

7. You may be prompted to back up the database. Click No.

Proceed to defining the Default Directories. For instructions, see Default
directories (page 38).

After defining the directory structure, exit Tekla PowerFab and proceed to
setting up the remote service for Tekla PowerFab Go. For instructions, see Set
up Tekla PowerFab Remote Server for Tekla PowerFab Go (page 41).
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Default directories for server

• Backup - C:\Users\Public\Documents\Tekla PowerFab\Backup
• Export - C:\Users\Public\Documents\Tekla PowerFab\Export
• Import - C:\Users\Public\Documents\Tekla PowerFab\Import
• Log - C:\Users\Public\Documents\Tekla PowerFab\Log
• Document Index - C:\Users\Public\Documents\Tekla PowerFab

\Documents
• Drawings - C:\Users\Public\Documents\Tekla PowerFab

\Documents\Jobs
• Updates - C:\Users\Public\Documents\Tekla PowerFab\Updates
• Custom Reports - C:\Users\Public\Documents\Tekla PowerFab

\CustomReports

Set up Tekla PowerFab Remote Server for Tekla PowerFab
Go
The Tekla PowerFab Remote Server allows you to perform Tekla PowerFab
actions remotely. In practice, the Tekla PowerFab Remote Server enables
running automated events and using the Tekla PowerFab Go mobile
application.

For details on installing and troubleshooting Tekla PowerFab Go, see Tekla
PowerFab Go User Guide.

Tekla PowerFab Remote Server
For Tekla PowerFab Go installation, you need to install the Tekla PowerFab
Remote Server and set up and manage its service settings in the Tekla
PowerFab Remote Monitor.

The Tekla PowerFab Remote Server is a Windows service that is installed on
the Tekla PowerFab server. This service listens for and responds to traffic from
Tekla PowerFab Go and executes automated events.

The Tekla PowerFab Remote Server allows you to perform Tekla PowerFab
actions remotely. In practice, the Tekla PowerFab Remote Server enables
running automated events and using the Tekla PowerFab Go mobile
application.

The Tekla PowerFab Remote Server is typically only installed on the Tekla
PowerFab server computer. To use Tekla PowerFab Go, a TCP port (not TCP/
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UDP) needs to be forwarded to the computer on which you install the Tekla
PowerFab Remote Server.

You can manage Tekla PowerFab Remote Server settings in the Tekla
PowerFab Remote Monitor dialog box.

Tekla PowerFab Remote Monitor
The Tekla PowerFab Remote Monitor is a graphical user interface for setting
up and managing Tekla PowerFab Remote Server service.

Tekla PowerFab Remote Monitor reports the following details in real-time:

Item Description Output example
Remote Server Status The current status of the

service.

If the service is running,
shows the TCP port that
the service is listening
for connections.

The service is not
running.

The service is running.
Running - Port 9154.
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Item Description Output example
Uptime The time in hours,

minutes, and seconds
that the service has
been active.

145:35:46

Connection SSL Cipher Indicates whether Tekla
PowerFab Remote
Server is connected to
the MySQL database via
an encrypted
connection.

If Tekla PowerFab does
not use encryption for
its ODBC connection,
this will be blank.

 

Total Remote
Connections

The total number of
connections that have
been made during the
time that the service has
been active.

154

Current Remote
Connections

The count of
connections that are
currently active.

17

Total Commands The total number of
XML/JSON commands
that have transacted
during the time that the
service has been active.

987

Current Sockets The number of TCP
sockets that are
currently active.

4

Total Sockets The total number of TCP
sockets that have been
created during the time
that the service has
been active.

876

Install Tekla PowerFab Remote Server
We recommend that you install the Tekla PowerFab Remote Server service
during the initial the Tekla PowerFab installation when you select the Server
configuration. You can also install Tekla PowerFab Remote Server separately.

1. In File Explorer, go to C:\Users\Public\Documents\Tekla\Tekla
PowerFab\Backup.
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2. Double-click the TeklaPowerFabRemoteServerSetup.exe file to install
the Tekla PowerFab Remote Server.

3. Click Install. 

The Tekla PowerFab Remote Monitor dialog box opens. A Tekla
PowerFab Remote Monitor icon has been created on the desktop.

4. Click OK to close the installer. 

You are prompted to sign in with Trimble Identity to start the service.

The Tekla PowerFab Remote Monitor dialog box opens automatically after
the installation is finished.

Next, define the Tekla PowerFab Remote Server settings and start the remote
server.

Set up and start Tekla PowerFab Remote Server
You can set up and manage the Tekla PowerFab Remote Server service
settings in the Tekla PowerFab Remote Monitor dialog box.
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1. If you do not have the Tekla PowerFab Remote Monitor dialog box
open, do either of the following:

a. Double-click the Tekla PowerFab Remote Monitor icon on the
server desktop.

b. Go to the default installation directory C:\Program Files
(x86)\Tekla\Tekla PowerFab and double-click
✗Tekla.PowerFab.Remote.Monitor.exe. 

Individual installation locations may vary.

2. In the Tekla PowerFab Remote Monitor dialog box, click Settings 

The Remote Server Settings dialog box opens. You can see the IP
address and port for the database connection.

3. To sign in, click Sign in in the upper right-hand section of the dialog box.
Sign in with a Trimble Identity that is an administrator for all the Trimble
Connect projects of your company.

4. In the Port field in the Socket section, type any non-standard TCP port
(1024–65535) not already in use. 

The default port is 9154. See also Setting up port forwarding.

5. Click Save Settings.

6. In the Tekla PowerFab Remote Monitor dialog box, click Start Service.

If the settings have been defined successfully, the Tekla PowerFab Remote
Server starts running.

You can always check in the Tekla PowerFab Remote Monitor dialog box if
the Tekla PowerFab Remote Server is running .
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The server installation is complete.

For troubleshooting, see Tekla PowerFab Go User Guide.

2.8 Install Tekla PowerFab on a client
After server installation, you can proceed to client installations and defining
the Default Directories for a client.

Install Tekla PowerFab on a client
Before you start, write down your server name and IP address. You need them
to set the connection to the server when you first log in to a client workstation.

1. Go to Tekla Downloads and download the installer for the desired Tekla
PowerFab version or service pack. 

To ensure that you are using the same version installed on the server, use
the installation file downloaded for the server install.

2. Double-click the installer to run the installation.

a. Review the license agreement. Select Accept and click Next.

b. From the drop-down menu, select the installation type Client. 

New Tekla PowerFab Installation

is selected by default.

c. Select the installation folder.

d. Click Install. 

The Tekla PowerFab installation starts.

e. When the installation is complete, close the installer.

3. Open Tekla PowerFab using the desktop icon or the Windows Start menu.

4. Sign in with a Trimble Identity. 

The Connection Settings window opens with the default connection
information.

5. To connect to the server, change the Connection Settings information to
your Tekla PowerFab server. 

Use either the IP address or the server name. Change the port only if it
was set differently on the server.

6. Sign in with a username and password for the database. 

If no username and password have been created for you, use the default
values:
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• User: admin
• Password: fab

Next, set the default directories and then exit Tekla PowerFab.

Default directories for client

The recommended directory structure for clients is the following:

• Backup - C:\Users\Public\Documents\Tekla PowerFab\Backup
• Export - C:\Export (User preference)
• Import - C:\Import (User preference)
• Log - C:\Users\Public\Documents\Tekla PowerFab\Log
• Document Index -\\(IP Address)\Shared Folder\Documents
• Drawings - \\(IP Address)\Shared Folder\Drawings
• Updates - \\(IP Address)\Shared Folder\Updates
• Custom Reports - \\(IP Address)\Shared Folder\Custom Reports

The directory structure is as follows:

• Backup: Tekla PowerFab database backup files. This can stay as default as
backups are rarely done from a user's device. User preference.

• Export: Initial location selected for the export of files. User preference.

• Import: Initial location opened for the selection of import files. User
preference.

NOTE Once a file type has been selected, the location defaults to the last
opened location.

• Log: Import log and error log text files. Leave as default.

NOTE This is typically set to a local path on each device so as not to
combine information from different devices in the same error logs.

For Document Index, Drawing, Update, and Custom Report, it is best to
use an IP address or an UNC file path. These need to be set to a shared
network location normally on a server.

• Document Index: Files that are linked or attached to records in the
program and to be shared among other users. A shared network location
required. See also Set the standard categories for attached documents
(page 150).

Install Tekla PowerFab 47 Install Tekla PowerFab on a client



NOTE It can be useful to use the same directory as Drawing in that it
automatically creates project-specific folders that can be then set
as the directory for other documents related to the specific project.

• Drawing: Drawing directories for each project, type, log, and revision are
automatically created within this directory. Drawing files are copied to the
appropriate directory during import. A shared network location required.

• Update: Tekla PowerFab update files.

With the new update file placed in the directory, the user is prompted to
run the update when they open the program. A shared network location
required.

• Custom Report: All customized report files. This directory is not created
during the installation and, therefore, you must add it.

• Extension: This is activated in the administrator settings and is not visible
by default.

The purpose of this directory is to allow external software API extensions
developed by others for combining and cut lists to be added to the
program.

2.9 Install Trimble Connect
Trimble Connect is an open collaboration tool. Tekla PowerFab subscription
contains a Trimble Connect license that you need for access. The license also
controls the features available to the user.

Install Trimble Connect Status Sharing tool
1. Go to Tekla Downloads.

2. In Tekla PowerFab Suite, click Download and select the Trimble Connect
tab.

3. To download the workflow tools for Tekla PowerFab to Trimble Connect,
click Download also Workflow tools for Trimble Connect for Windows.

4. Click Download --> Download 64-bit.

5. Double-click the installer to run the installation. 

The Trimble Connect Status Sharing Setup Wizard opens.

6. Click Next.

7. Select the installation folder.

8. Click Next --> Next --> Yes.
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9. When the installation is complete, close the installer.

Next proceed to install Trimble Connect. See Trimble Connect product guides.

To use Trimble Connect for viewing IFC models for estimating and production
control jobs, you also need to link Tekla PowerFab and Trimble Connect to
each other.
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3 Manage Tekla PowerFab

As an administrator, you need to define your company information, automatic
backup settings, and administration settings, add the necessary users, and
otherwise set up Tekla PowerFab, so that other users can start working in it.

NOTE These instructions contain actions that can only be performed by Tekla
PowerFab users with administrative rights in the database. If you do not have
administrative rights, contact your administrator for help.

For more information, see also Tekla Online Admin Tool.

After setting up Tekla PowerFab, administrators can do the following:

• Download and install updates, so that the updates are installed
automatically for other Tekla PowerFab users in your company

• Create backup copies of the Tekla PowerFab database to restore the
database if it is compromised

• Optimize and compress the information in the Tekla PowerFab database

• Clear extra logs from particular actions performed by Tekla PowerFab users
in the company

• Export labor information from a Tekla PowerFab database, and import the
labor information to another Tekla PowerFab database

• Recover deleted combining, estimating, and production controls jobs, and
recover import backup files

• Find and repair program errors in Tekla PowerFab

See also

Install Tekla PowerFab (page 36)

Manage Tekla PowerFab users (page 54)

Manage Tekla PowerFab workstations (page 72)

Manage Tekla PowerFab company information (page 74)

Define Tekla PowerFab administration settings (page 77)
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Update Tekla PowerFab (page 51)

Set up and work with integrated software in Tekla PowerFab (page 84)

Export labor information (page 517)

Manage the Tekla PowerFab database (page 110)

Repair program errors (page 119)

3.1 Update Tekla PowerFab
In the lower left corner of the Tekla PowerFab main window, you can see when
there are new versions of Tekla PowerFab available. Always run the update on
the server first.

Update server
Before you begin updating Tekla PowerFab, ensure the following:

• You are signed in with a Trimble Identity that has a Tekla EPM or Tekla
PowerFab maintenance license.

• Tekla PowerFab is closed.

• All users and integrated software are signed out of the database. See View
currently signed-in users (page 53) and Force shutdown (page 54).

1. To download the update file, go to downloads.tekla.com and in Tekla
PowerFab Suite, click Download.

2. In All Downloads, click the latest version to download it.

3. In File Exlorer, go to the Downloads folder and double-click the update
file to run it. 

The installation wizard opens.

4. Accept the license agreement.

5. Select Update as the install type. 

If the update fails, the Client install is shown as the default instead.

6. In the Destination Folder field, check the location where the update will
be installed. 

The location of the latest install is shown as default.

7. To install the update, click Install. 

If there is an error, check the Task Manager to make sure that there are
no Tekla PowerFab processes running and retry the installation.

If the update was aborted, run the installation as a client install and follow
the remaining steps.
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8. When the update is complete, click Close to close the installation window.

9. Sign in to Tekla PowerFab as an administrator. 

The application prompts you to update the database.

10. To update the database, click OK --> Yes.

The server update is complete and the program restarts the remote server
service. Verify the restart in Tekla PowerFab Remote Monitor.

Update client
Before you update any client workstation, note that:

• The server computer must be updated first.

• Tekla PowerFab has to be closed on all client workstations. See View
currently signed-in users (page 53) and Force shutdown (page 54).

• You must be signed in with a Trimble Identity.

• To connect and share information, all workstations in your company need
to have the same version of Tekla PowerFab as the server computer.

1. In File Exlorer, move the update file from the Downloads folder to the
Update directory. 

If the Update directory is set properly, this will prompt the users to
update when they open the program. To check the directory, go to File -->
Default Directories.

When the program asks you to confirm the update, click Yes.

If Update field is not correct in the Default Directories or the users are
not allowed to act as a local administrator, the update file must be run on
each client machine manually. In this case, you get an error message and
need to do steps a and b:

a. Click OK --> No. 

If you click Yes, this will delete your database.

b. Go to the location where you downloaded the update, and to run the
update, double-click the update file.

2. In the Tekla PowerFab License Agreement wizard, accept the license
agreement.

3. Click Next >.

4. Check that the type of install is Update and click Next >.

5. In the Destination Folder field, check the location where the update will
be installed.

6. To install the update, click Install.

7. To start the update, click OK.
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8. When the update is complete, click Close to close the installation window.

You can now start working in the updated version of Tekla PowerFab.

View currently signed-in users
Administrators can view the Tekla PowerFab users that are currently signed in
using the Users Currently Logged In command. This can be useful when
trying to run an update from one Tekla PowerFab version to another, which
requires that other users exit Tekla PowerFab. Administrators can also close
other users' Tekla PowerFab sessions and sign them out.

1. Go to File --> Administration.

2. Click the Administration ribbon tab. 

3. On the menu, select Users Currently Logged In.

4. In the Users Currently Logged In dialog box, view the users that are
currently signed in. 

For users within the office, you can see the IP address of the computer on
which the user is signed in and the time that the user has signed in.

5. If necessary, do either of the following:

• To close a user's Tekla PowerFab session and sign them out, select the
user and click Force Shutdown.

• To cancel closing the user's Tekla PowerFab session and signing them
out, click Cancel Shutdown.

6. To close the Users Currently Logged In dialog box, click the Close button
(X) in the upper-right corner.
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Note that you can also use the Remote Users Currently Logged In command
to view the remote users that are currently signed in.

For remote users, you can see the time that they have signed in and the time
of their last activity in Tekla PowerFab Go. However, you cannot close remote
users' Tekla PowerFab Go sessions or sign the users out.

Force shutdown
When you are logged in as an administrator, you can force the shutdown of
any users logged in.

You may need to do this when updating Tekla PowerFab and need to make
sure that all users are signed out.

1. Go to File --> Administration.

2. In the Administration context menu, select Users Currently Logged In.

3. Click Force Shutdown. 

Note that you can end the session of any remote users by stopping the
remote server.

In Microsoft Task Manager, check that there are no Tekla PowerFab
processes running.

3.2 Manage Tekla PowerFab users
On the Tekla PowerFab Users tab of the Administration dialog box,
administrators can add new users, modify the properties of the existing users,
and delete any unnecessary users. Users added to this list also include the
workers available in production tracking and inspection. Administrators can
also reset users' passwords.

Access user data
To manage Tekla PowerFab users, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.

2. On the File menu, select Administration.
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Add a user
1. Go to File --> Administration.

2. On the Tekla PowerFab Users tab, click New.

3. Define the user properties. 

The properties marked with an asterisk (*) are mandatory information.

Option Description
Username * The username with which the user logs in to Tekla

PowerFab.

Note that the user name cannot be changed after
the user has been added.

Role The user role assigned to the user. A role
determines which permissions the users with that
role have in Tekla PowerFab. For more information,
see Manage Tekla PowerFab user roles (page 61).

You can also modify the permissions individually
for users. For more information, see Manage Tekla
PowerFab user permissions (page 57).

Click the arrow on the right side of Role list and
select a role in the list.
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Option Description
Group The group which the user belongs to. For example,

you can define groups for estimators and project
managers.

Note that groups do not allow you to automatically
assign permissions to the user.

First Name, Last Name The first and last name of the user.

Type the appropriate names in the First Name and
Last Name fields.

Trimble Identity The email address that has been registered as the
user's Trimble Identity.

The Trimble Identity is a user account that allows
the user to access various Tekla Online services
and other Trimble products.

For more information, see Trimble Identity for
Tekla Online services.

Type the appropriate email address in the Trimble
Identity field.

4. Click Add.

The user is added to Tekla PowerFab.

When the users log in to Tekla PowerFab for the first time, they need to leave
the Password field blank. Then, they need to set the new password in the
Change Password dialog box. For more information on defining the password
policy, see Define Tekla PowerFab administration settings (page 77).

NOTE If you have not assigned any roles or permissions to new users, they
have no access to any information in Tekla PowerFab. You need to
modify the new users' permissions to give them access to the
necessary information and modules. You can manage the user
permissions in the company either separately for each user, or by
creating user roles and assigning them to multiple users.

For more information, see Manage Tekla PowerFab user permissions
(page 57).

Reset a user's password
If necessary, you can reset a user's password, so that they can create a new
one the next time they log in to Tekla PowerFab.

Note that if the user remembers their current password, they can change the
password by themselves at any time.

1. Go to File --> Administration.
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2. On the Tekla PowerFab Users tab, select the user whose password needs
to be reset.

3. Click Reset Password.

4. To confirm resetting the password, click Yes in the confirmation dialog
box.

When the user logs in after the password has been reset, they need to leave
the Password field blank. Then, they need to set the new password in the
Change Password dialog box.

Modify a user
1. Go to File --> Administration.

2. On the Tekla PowerFab Users tab, select the user that you want to
modify.

3. Modify the user's role, group, first and last name, and Trimble Identity
according to your needs.

4. Click Save.

Delete a user
1. Go to File --> Administration.

2. On the Tekla PowerFab Users tab, select the user that you want to
delete.

3. Click Delete.

4. To permanently delete the user, click Yes in the confirmation dialog box.

See also

Troubleshoot 401 Unauthorized error (page 1118)

3.3 Manage Tekla PowerFab user permissions
After creating a new Tekla PowerFab user, the administrator has to manage
the user permissions and roles before the user can access any module.

NOTE If you have not assigned any roles or permissions to new users, they have no
access to any information in Tekla PowerFab. You need to modify the new
users' permissions to give them access to the necessary information and
modules. You can manage the user permissions in the company either
separately for each user, or by creating user roles and assigning them to
multiple users.
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User permissions dialog box
The User Permissions dialog box has multiple tabs that represent the
different modules and features of Tekla PowerFab. This way, the user
permissions can be set separately for each module.

The tabs are divided into sections that represent different parts of the module
or feature. This allows you to give the user permissions to only perform
particular actions related to the module.

All sections contain checkboxes that determine what the user can do in that
part of the module. The available checkboxes are:

• Select: When selected, allows the user to select and filter information, such
as material items.

• Insert: When selected, allows the user to add new information.

• Update: When selected, allows the user to modify existing information.

• Delete: When selected, allows the user to delete information.

For example, to allow the user to select items and add items in a combining
job, select the Select and Insert checkboxes in the Combining Items section
of the Combining tab. If only the Select and Insert checkboxes were selected,
the user could not modify or delete combining items, so the Edit and Delete
buttons would not be available.
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Edit user permissions
1. Go to File --> Administration.

2. On the Tekla PowerFab Users tab, select the user whose permissions you
want to modify.

3. Click Edit Permissions. 

Note that if the user has been assigned a role, their permissions cannot
be modified individually, so the Edit Permissions button is inactive.

4. At the top of the User Permissions dialog box, select the Allow Tekla
PowerFab Login checkbox. 

When logging in to Tekla PowerFab has been allowed for the user, you can
modify the other permissions.

5. To modify the user permissions, do any of the following: 

To Do this
Select the permissions
one by one

a. Click a tab at the top of the User Permissions
dialog box to open it.

b. Select checkboxes next to the permissions that
you want to give to the user.

You can also click the A (all) and N (none)
buttons to select or clear all checkboxes in a
section. This way, you can quickly give the user
all or no permissions to that part of the
module or feature.
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To Do this
c. Repeat steps a to b on all necessary tabs.

Select multiple
permissions at once

Do one of the following:

• To allow the user to perform an action
anywhere in the selected module, click the
desired button at the bottom of the current tab.

• To allow the user to perform an action
anywhere in Tekla PowerFab, click the desired
button at the bottom of the dialog box.

For example, when the Update All checkbox is
selected at the bottom of a tab, the user can
modify information in all parts of the module.

However, if the Update All checkbox is selected at
the bottom of the User Permissions dialog box,
the user can modify information in all modules of
Tekla PowerFab.

Copy the permissions of
another Tekla PowerFab
user

a. At the lower-right corner of the dialog box,
click the arrow on the right side of the Copy
Permissions From list.

b. Select the desired user in the list.

c. Click OK.
Give all possible
permissions

• In the lower left-hand corner of the dialog box,
select the Administrator checkbox.

6. Click Save to save the permissions.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

View the user permission report
Administrators can view a report that shows the permission settings of the
Tekla PowerFab users in their company.

As an administrator, you can select between two commands:

• View User Permissions Report - All: Displays the permissions of all Tekla
PowerFab users

• View User Permissions Report - Selected: Allows administrators to select
which users' permissions they want to view

To manage Tekla PowerFab user permissions, see Manage Tekla PowerFab
user permissions (page 57).
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View the permissions of all users
1. Go to File --> Administration.

2. Click the Administration ribbon tab.

3. On the menu, select View User Permissions Report - All.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

You can also export the report and save it in another file format.

View the permissions of a selected user
1. Go to File --> Administration.

2. In the Administration dialog box, select the user whose permissions you
want to view.

3. Click the Administration ribbon tab.

4. On the menu, select View User Permissions Report - Selected.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

You can also export the report and save it in another file format.

3.4 Manage Tekla PowerFab user roles
User roles allow the administrator to quickly assign the same permissions to
multiple users.

On the Roles tab of the Administration dialog box, you can add user roles,
manage the permissions of the roles, and delete any unnecessary roles. After
you have added the necessary user roles and modified the permissions
according to your needs, you need to assign the roles to the desired users on
the Tekla PowerFab Users tab.

To manage user roles, do the following:

1. Go to File --> Administration.

2. Open the Roles tab.
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Add a user role
1. Go to File --> Administration.

2. On the Roles tab, click New.

3. In the Role field, type a name for the user role. 

For example, Project managers.

4. Click Save to create the role.

5. To manage the permissions of the new user role, click Edit Role
Permissions. 
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The User Permissions dialog box opens.

For more information on the dialog box, see User permissions dialog box
(page 58).

6. Modify the user permissions as instructed in Edit user permissions
(page 58).

7. Click Save to save the permissions.

8. To close the User Permissions dialog box, click the Close button (X) in the
upper-right corner.

9. In the Administration dialog box, click Save to update the permissions.

Assign a user role to a user
1. Go to File --> Administration.

2. Open the Tekla PowerFab Users tab.

3. Select the user for whom you want to assign a user role.

4. Select the user role from the Role drop-down list.

5. Click Save.

Modify a user role
1. Go to File --> Administration.
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2. On the Roles tab, select the role that you want to modify in the left-hand
pane.

3. In the Role field, modify the name of the user role.

4. To manage the permissions of the user role, click Edit Role Permissions. 

The User Permissions dialog box opens.

For more information on the dialog box, see User permissions dialog box in
Manage Tekla PowerFab user permissions (page 57).

5. Modify the user permissions as instructed in Edit user permissions in
Manage Tekla PowerFab user permissions (page 57).

6. Click Save to save the permissions. 

The changed permissions are immediately applied to all users that have
been assigned the role.

7. To close the User Permissions dialog box, click the Close button (X) in the
upper-right corner.

8. In the Administration dialog box, click Save to update the permissions.

Delete a user role
Note that deleting a user role is permanent and cannot be undone.

1. Go to File --> Administration.
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2. On the Roles tab, select the role that you want to delete in the left-hand
pane.

3. Click Delete.

4. To permanently delete the user role, click Yes in the confirmation dialog
box.

3.5 Manage Tekla PowerFab external users
Administrators can add, modify, and delete external users on the External
Users tab of the Administration dialog box. Administrators can also reset the
passwords of the external users.

NOTE Initially, the external user has no access to any information in Tekla
PowerFab. You need to modify the user permissions to give them
access to the necessary information and modules. For more
information, see Manage Tekla PowerFab remote user permissions
(page 68).

1. Go to File --> Administration.

2. In the Administration dialog box, open the External Users tab.
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Add an external user
1. Go to File --> Administration.

2. On the External Users tab, click New.

3. Define the user properties. 

The properties marked with an asterisk (*) are mandatory information.

Option Description
Username * The username with which the external user logs in

to Tekla PowerFab.

Type the username in the Username field.

Note that the username cannot be changed after
the external user has been added.

Group The group to which the external user belongs. For
example, you can define groups for estimators and
project managers.

Note that groups do not allow you to automatically
assign permissions to the user.

Type the user group in the Group field.
First Name, Last Name The first and last name of the external user.

Type the appropriate names in the First Name and
Last Name fields.

4. Click Add.

5. Do any of the following: 

To Do this
Generate and send an
email with the external
user's user name and
password

a. In the confirmation dialog box, click Yes.

Microsoft Outlook opens and generates a new
email containing the username and password.

b. Add the recipient.

c. If necessary, modify the default email content.

d. Send the email.
Continue without
generating and sending
an email

a. In the confirmation dialog box, click No.

A message appears, displaying the password
that the user needs to log in to Tekla
PowerFab.

b. Highlight and copy the password to send it to
the external user.

c. Click OK to close the message.
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To Do this
d. Send the password to the external user in the

desired communication channel.

The external user is added to Tekla PowerFab.

Reset an external user's password
1. Go to File --> Administration.

2. On the External Users tab, select the external user whose password you
want to reset.

3. Click Reset Password.

4. To confirm resetting the password, click Yes in the first confirmation
dialog box.

5. Do any of the following: 

To Do this
Generate and send an
email that contains the
username and new
password of the external
user

a. In the second confirmation dialog box, click
Yes.

Microsoft Outlook opens and generates a new
email containing the username and new
password.

b. Add the recipient.

c. If necessary, modify the email content.

d. Send the email.
Continue without
generating and sending
an email

a. In the second confirmation dialog box, click
No.

A message appears, displaying the password
that the user needs to log in to Tekla
PowerFab.

b. Highlight and copy the password to send it to
the external user.

c. Click OK to close the message.

d. Send the password to the external user in the
desired communication channel.

Modify an external user
1. Go to File --> Administration.
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2. On the External Users tab, select the external user whose information
you want to modify.

3. Modify the group, first name, and last name according to your needs.

4. To modify the user permissions, click Remote Permissions. 

For more information, see Manage Tekla PowerFab remote user
permissions (page 68).

5. Click Save to save the changes.

Delete an external user
1. Go to File --> Administration.

2. On the External Users tab, select the external user that you want to
delete.

3. Click Delete.

4. To permanently delete the external user, click Yes in the confirmation
dialog box.

3.6 Manage Tekla PowerFab remote user permissions
Administrators can allow any internal or external Tekla PowerFab users to
access information remotely using Tekla PowerFab Go.

The users that have been assigned remote permissions can access Tekla
PowerFab Go through a remote link when they are out of the office, and
modify the information in Tekla PowerFab Go according to the permissions
they have been given.

1. Go to File --> Administration.

2. On either the Tekla PowerFab Users tab or the External Users tab,
select the user whose remote permissions you want to modify.
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3. Click Remote Permissions.

4. At the top of the Remote Permissions dialog box, select the Allow
Remote Login checkbox. 

When you have allowed logging in to Tekla PowerFab Go, you can modify
the other remote permissions.

Note that the Remote Permissions has two tabs:

• Production Control/Project Management

• Inventory/Inspection/Time Tracking

You need to modify the information on both tabs separately.

5. On the Production Control/Project Management tab, select which
production control jobs the user can access remotely, and what
information theyh can view and modify. The options are:

• None: the user cannot access the information of any production
control job remotely.

• Selected: allows you to select the control jobs that the user can access
remotely.
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To select the jobs, click Edit in the Select Jobs section of the
Production Control/Project Management tab.

You can also create job groups in Production Control to allow the
users to only access jobs in particular job groups. For example, you
could create a job group called Active, and allow the users to access
all jobs in the Active job group. You could also create a job group
called Inactive and store all jobs that you do not want users to
access in Tekla PowerFab Go in the Inactive job group.

• All: the user can access the information of all production control jobs
remotely.

6. On the Inventory/Inspection/Time Tracking tab:

a. Select the actions the user can do the inventory, (View, Move,
Receive)

b. To select the inspections tests the user can view or modify, click
Select Inspection Tests.

c. Click the arrow buttons to move the items tests that the user needs to
access remotely to the Included list.

d. Click OK.

e. Select what kind of time tracking records the user can add (records
for themselves or for all employees, records that have a late start or
end time).
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7. To modify the user permissions further, do any of the following: 

To Do this
Select the permissions
one by one

a. Click a tab at the top of the Remote
Permissions dialog box to open it.

b. Select checkboxes next to the permissions that
you want to give to the user.

Repeat steps a to b on both tabs of the
Remote Permissions dialog box.

c. To only allow access to particular drawing
types, stations, or inspection tests:

1. Click the Select Drawing Types, Select
Stations, or Select Inspection Tests
button.

2. Use the arrow buttons to move the
accessible items to the Included list.

3. Click OK.
Copy the remote
permissions of another
user

a. In the upper-right corner of the dialog box,
click the arrow on the right side of the Copy
Permissions From list.
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To Do this
b. Select the desired user in the list.

c. Click Copy.
Select or remove
multiple permissions at
once

• Do one of the following:

• To allow the user to view, but not modify, all
information listed on the current tab, click
View All at the bottom of the dialog box.

• To remove all permissions that the user has
on the current tab, click Clear All.

Select or remove the permissions on both tabs of
the Remote Permissions dialog box.

Give all remote
permissions on the
current tab

• In the lower-left corner of the dialog box, click
All.

Note that to give all available remote permissions,
you need to click All on both tabs of the Remote
Permissions dialog box.

8. Click Save Remote Permissions.

The user can now view and modify the information according to the remote
permissions you gave them.

See also

Manage Tekla PowerFab external users (page 65)

3.7 Manage Tekla PowerFab workstations
On the Workstations tab of the Administration dialog box, you can add new
workstations, modify existing workstations, or delete unnecessary
workstations.

To manage workstations, do the following:

1. Go to File --> Administration.

2. Open the Workstations tab.
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Add a workstation
1. Go to File --> Administration.

2. On the Workstations tab, click New.

3. In the Station field, type the workstation name or the computer ID.

4. Click Add.

Modify a workstation

1. Go to File --> Administration.

2. On the Workstations tab, select the workstation that you want to modify.

3. In the Station field, modify the workstation name or the computer ID.

4. Click Save to save the changes.

Delete a workstation
1. Go to File --> Administration.

2. On the Workstations tab, select the workstation that you want to delete.
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3. Click Delete.

4. To permanently delete the workstation, click Yes in the confirmation
dialog box.

Create replicas
Replication is a legacy function. For details, contact the local support.

In File --> Administration --> Replication, administrators can connect to
workstations in an off-site location to share Tekla PowerFab files and activity.
Replication requires a special license and a separate server installation at the
slave site.

3.8 Manage Tekla PowerFab company information
Administrators are responsible for defining the company information. The
company information is used throughout Tekla PowerFab. It is also possible to
add multiple companies.

You can manage the information of your company in the Company
Information dialog box that is located in the Maintenance ribbon tab.
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Add company information
1. Go to Maintenance --> Company Information and click New.

2. Add a description for the company. 

For example, Main.

3. Fill in the company name, address, city, state, zip code, phone, and fax
according to your needs. The company name is mandatory information.
All other details are optional.

4. Click Save.

5. To add the company logo for reports, click either Top Logo or Bottom
Logo.

a. Click Load From File.

b. In the Open dialog box, browse to find the logo file, and select it. 

Note that the logo file needs to be a .bmp, .jpg, or .png file. We
recommend using the .jpg format because logo files in any other
format are converted to .jpg when you add them.

The maximum height for the logo file is 3 inches, or 76,2 mm, at 96
pixels per inch. A maximum width is not enforced, but we
recommend that you use a logo file that is narrower than the
standard paper size of your company.

c. Double-click the logo file, or click Open.

d. Select if the logo should be aligned left, center, or right.

e. Confirm if the selected logo contains company information.

The logo is added for the company.

Note that if you want to use another logo file instead, you need to click
Top Logo or Bottom Logo again, and click Clear in order to delete the
current logo file.

6. Click Save and close the Company Information dialog box.

The company is added to the list.

Note that you can add multiple companies, if necessary. For example, if you
want the Shipped From location to be something other than the address of
your main company, you need to add another company with that name and
address. These can be the name and address of a vendor or a supplier.

You can change which one of the available companies is used in the Report
Types dialog box.
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Set the default company
If you have added multiple companies, you should set one of the companies
as the default company used in reports.

Note that you can only set the default company for the current user.

1. Go to Maintenance --> Company Information and select the company
that you want to set as the default company.

2. At the bottom of the dialog box, click Set Selected As Default.

3. To confirm using the selected company as the default option, click Yes in
the confirmation dialog box.

The selected company is set as the default company used in reports.

Note that the default company is shown in the Default field at the bottom of
the Company Information dialog box.

You can change which one of the available companies is used in the Report
Types dialog box.

Modify company information
1. Go to Maintenance --> Company Information and select the company

that you want to modify.

2. Modify the company description, name, address, city, state, zip code,
phone, and fax according to your needs.

3. To modify the logo for the company, do the following:

a. According to your needs, click click either Top Logo or Bottom Logo.

b. Click Clear to delete the existing logo file.

c. Click Load From File.

d. In the Open dialog box, browse to find the logo file, and select it. 

Note that the logo file needs to be a .bmp, .jpg, or .png file. We
recommend using the .jpg format because logo files in any other
format are converted to .jpg when you add them.

The maximum height for the logo file is 3 inches, or 76,2 mm, at 96
pixels per inch. A maximum width is not enforced, but we
recommend that you use a logo file that is narrower than the
standard paper size of your company.

e. Double-click the logo file, or click Open.

f. Select if the logo should be aligned left, center, or right.

g. Confirm if the selected logo contains company information.

The logo is added for the company.
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4. Click Save to update the company information.

Delete company information
1. Go to Maintenance --> Company Information and select the company

that you want to delete.

2. Click Delete.

3. To permanently delete the selected company and its information, click Yes
in the confirmation dialog box.

3.9 Define Tekla PowerFab administration settings
Administrators can define the way in which Tekla PowerFab can be used. In the
Settings dialog box accessed via the Administration ribbon tab,
administrators can adjust several general settings and database backup and
restore settings, and define the password policy.

Define general administration settings
In the administrator role, you can define a variety of settings affecting the way
Tekla PowerFab can be used.

1. Go to File --> Administration.

2. Click the Administration ribbon tab. 
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3. On the menu, select Settings. 

The Administration - Settings dialog box opens.

4. On the General tab, define the settings according to your needs: 
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Option Description
Restrict each user to a
single Tekla PowerFab
session

When selected, users can only have one Tekla
PowerFab session open at the same time.

When cleared, users can have multiple Tekla
PowerFab sessions open at the same time.

Tekla PowerFab Go
Site Address

Enter the user's Tekla PowerFab Go site address.

Tekla PowerFab idle
session timeout

Allows you to define the number of minutes that a
user can remain inactive before the user's session
times out and the user is logged out.

Type the number of minutes in the Tekla
PowerFab idle session timeout field.

If you do not want sessions to time out, type 0 in
the Tekla PowerFab idle session timeout field.

True-Shape Dimension
Add-On

The symbol that is displayed after dimensions if a
plate item has a CNC file attached to it and the
actual shape of the item in the CNC file is not a
rectangle.

For example, if a plate is triangular, Tekla PowerFab
knows the true shape, although it cannot be shown
in the item dimensions.

You can replace the § symbol with [SQM] to display
the area of non-rectangular plates in square feet or
square meters.

Allow list of changes to
be cleared

When selected, allows administrators and other
users with the correct user permissions to clear the
list of changes in a particular Tekla PowerFab
module.

When cleared, the list of changes cannot be cleared
in any module, even by administrators or users
that have the correct permissions.

_fs_rl_user account
enabled

When selected, the built-in user login is enabled, so
that the Tekla PowerFab Remote Server can
connect to the Tekla PowerFab database without
the administrator adding the username and
password in the monitor settings.

When cleared, the built-in user login is disabled, so
the Tekla PowerFab Remote Server cannot connect
to the Tekla PowerFab database without the
administrator adding the username and password
in the monitor settings.

_fs_backup_user
account enabled

When selected, the built-in username and
password are enabled, so that Tekla PowerFab can
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Option Description
perform scheduled backups from the server
computer without a username and password.

When cleared, Tekla PowerFab cannot perform
scheduled backups from the server computer
without a username and a password.

Enable extension
directory

When selected, users can use their own extensions
with Tekla PowerFab. User-defined extensions need
to be saved in the Extension default folder that is
defined in the Default Directories dialog box.

When cleared, users cannot use their own
extensions with Tekla PowerFab. Also, the
Extension option is not available in the Default
Directories dialog box.

5. To save the changes, click Save.

Define database backup and restore settings
On the Database Backup/Restore tab of the Administration - Settings
dialog box, you can define how the database can be restored and how often
users should get reminders to create backup copies of the database.

1. Go to File --> Administration.

2. Click the Administration ribbon tab.

3. On the menu, select Settings. 

4. On the Database Backup/Restore tab of the Administration - Settings
dialog box, define the settings according to your needs: 

Option Description
Allow database restore from any
workstation

When selected, allows administrators
to restore the Tekla PowerFab
database using any computer.

When cleared, the Tekla PowerFab
database can only be restored on the
server computer.

For more information, see Restore the
Tekla PowerFab database (page 111).

Show background message if
backup has not been run in 'x' days
(0 for no message)

The number of days after the
previous database backup when Tekla
PowerFab should remind users with a
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Option Description
background message about backing
up the Tekla PowerFab database.

You can type a different number of
days for users with administrative
rights and for regular Tekla PowerFab
users. If you do not want to give a
reminder message, type 0.

See an example of a background
message below.

For instructions on how to back up
the Tekla PowerFab database, see
Save a backup copy of the Tekla
PowerFab database (page 110).

Show popup message if backup has
not been run in 'x' days (0 for no
message)

The number of days after the
previous database backup when Tekla
PowerFab should remind users with a
pop-up message about backing up
the Tekla PowerFab database.

You can type a different number of
days for users with administrative
rights and for regular Tekla PowerFab
users. If you do not want to give a
reminder message, type 0.

See an example of a pop-up message
below.

For instructions on how to back up
the Tekla PowerFab database, see
Save a backup copy of the Tekla
PowerFab database (page 110).

5. To save the changes, click Save.
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Define password policy
On the Password Policy tab of the Administration - Settings dialog box, you
can define the password policy settings such as complexity and length.

If no password policy is defined, any passwords can be used. Note that Tekla
PowerFab passwords are always case-sensitive.

1. On the Password Policy tab, define the minimum length for Tekla
PowerFab passwords and select the checkboxes for the characters that all
Tekla PowerFab passwords need to contain.

2. To save the changes, click Save.

3.10 Adjust Tekla PowerFab spell-checking settings
Tekla PowerFab has a spell-checking tool that allows you to spellcheck the text
that you write in input fields. Automatic spell-checking is enabled by default in
Project Management for subject lines and body texts. You can also perform
spell-checking manually in any input field in any Tekla PowerFab module.

Enable spell-checking
If your settings.ini file does not contain the spell-checking function, you
need to edit the file to add it.

1. Ensure that Tekla PowerFab is closed.

2. Go to the C:\Users\Public\Documents\Tekla\Tekla PowerFab
\Settings folder.

3. Find and open the settings.ini file in a text editor.

4. To find or add the section, write [SpellCheck]. 
[SpellCheck]
Enabled=1
AutoSpellCheckEnabled=1
Dictionary=en_US

5. Save and close the settings.ini file.

Perform spell-checking
1. In Tekla PowerFab, click the field whose text you want to spell-check.

2. Press Ctrl+S on the keyboard. 

Tekla PowerFab spell-checks the text in the current field.
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3. If you need to add a new word to the dictionary, so that the spell-checking
tool will recognize it in the future, right-click the word and select Add. 

New words are saved in the tekla-epm.dic file C:\Users\Public
\Documents\Tekla\Tekla PowerFab\Settings\. Do not edit the
tekla-epm.dic file manually.

Disable spell-checking
1. Ensure that Tekla PowerFab is closed.

2. Go to the C:\Users\Public\Documents\Tekla\Tekla PowerFab
\Settings folder.

3. Find and open the settings.ini file in a text editor.

4. In the [SpellCheck] section, do any of the following: 

To Do this
Disable all spell-checking in Tekla
PowerFab

• Set the Enabled value to 0

Disable automatic spell-checking • Set the AutoSpellCheckEnabled
value to 0

5. Save and close the settings.ini file.

Switch to another spell-checking dictionary
By default, Tekla PowerFab uses a spell-checking dictionary that matches the
current system locale setting. However, you can force the use of another
dictionary.

1. Ensure that Tekla PowerFab is closed.

2. Go to the ..\Program Files (x86)\Tekla\Tekla PowerFab folder.

3. Find and open the settings.ini file in a text editor.

4. In the [SpellCheck] section, set the Dictionary value to one of the
following: 

• en_AU (English / Australia)

• en_CA (English / Canada)

• en_GB (English / United Kingdom)

• en_US (English / United States)

• es_ES (Spanish / Spain)

• es_MX (Spanish / Mexico)
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• fr (French / France)

• ru_RU (Russian)

5. Save and close the settings.ini file.

3.11 Set up and work with integrated software in Tekla
PowerFab
You can use Tekla PowerFab together with several integrated software
products.

Software integrations save you time and work, because you do not need to
enter the same information to several applications or programs. Among other
things, you can use software integrations to mult and nest materials, and to
visualize IFC models.

See also Tekla PowerFab Integrations. You can access the list also from
Maintenance --> Integration Settings --> Integration List.

See also

Link Tekla PowerFab to Trimble Connect (page 84)

Use Tekla PowerFab together with Tekla Warehouse (page 89)

Use customized extensions for combining (page 89)

Manage inventory, cut lists, and nests with ProNest (page 91)

Mult and nest materials with Steel Projects PLM (page 102)

Link Tekla PowerFab to Trimble Connect
To use Trimble Connect for viewing IFC models for estimating and production
control jobs, you need to link Tekla PowerFab and Trimble Connect to each
other.

To enable updating the statuses of Tekla PowerFab items to Trimble Connect,
you also need to set up status sharing or set up the Trimble Connect organizer
published fields.

Linked jobs in the Estimating, Production Control, and Project
Management modules can all be linked to a Trimble Connect project.

Note that if an estimating or production control job is linked to a project
management job, the Trimble Connect project is managed through the project
management job. In this case, you need to link the project management job to
Trimble Connect. The link is then applied to any linked estimating and
production control jobs. The Trimble Connect project cannot be modified
when you access it through the estimating or production control job.
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Linking Tekla PowerFab to Trimble Connect
1. Go to Maintenance --> Integration Settings

2. On the menu, select Trimble Connect. 

3. If you have not yet migrated to Tekla licensing, in Trimble Connect
Settings dialog box, select the Use Trimble Connect Desktop To View
Models checkbox.

4. To invite users to participate in your Trimble Connect projects, type their
emails on separate lines in the Default Users for Trimble Connect
Project section. 

The users whose email addresses you type here can later be added to
existing Trimble Connect projects.

5. If necessary, click the arrow on the right side of the Default Server
Location list, and change the server location.

6. Click Save.

Note that you need to restart Tekla PowerFab to be able to use Trimble
Connect for viewing IFC models.

Set up status sharing with Trimble Connect
You can enable sharing the statuses of production control jobs to Trimble
Connect.

The available status types are:

• Purchasing: None, Started (on a purchase order but not yet received),
Completed
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• Production: None (production not started), Started, Completed

• Station: can include all or any individual stations set up in Tekla PowerFab.

• Shipping: None, Started (at an intermediate shipping destination), or
Completed

• Destination: can include all or any individual destinations set up in Tekla
PowerFab.

• In Tekla PowerFab Production: items highlighted with green are in the
production control job.

• In Tekla PowerFab Estimating: items highlighted with green are in the
estimating job.

1. Go to Maintenance --> Integration Settings

2. On the menu, select Trimble Connect Status Share . 

3. In the Trimble Connect Status Share Mappings dialog box, create the
status types that can be shared to Trimble Connect:

a. Click New.

b. Click the arrow on the right side of Tekla PowerFab Status list, and
select a status.

c. Depending on the selected status, click the arrow on the right side of
the Station or Destination list, and select an option in the list.

d. In the Trimble Connect Status Action Name field, type the name
used for the status in Trimble Connect.
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e. Click Add.

Repeat steps a to e for each status that you want to add.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add Trimble Connect projects
Use the Add New Trimble Connect Projects command to create Trimble
Connect projects based on the existing project management jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Trimble Connect . 

3. In the Trimble Connect Settings dialog box, click Add New Trimble
Connect Projects.

4. In the Select Project dialog box, click the arrow buttons to move the
production control jobs that you want to add as projects to the Included
list.

5. Click OK.

6. In the Add Users to Project dialog box, click the arrow buttons to move
the users that need access to the new project to the Included list. 

All users that are set as default Trimble Connect users are automatically in
the Included list.

7. Click OK.

8. In the Status dialog box, view the project creation process.

9. When the setup is completed, click OK to close the Status dialog box.
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10. To attach an IFC model to the project, do the following:

a. Open Trimble Connect for Windows.

b. Double-click the new project to open it.

c. In the Explorer side pane on the left, click the Add File button.

d. In the Add Files dialog box, browse to find the IFC model.

e. Select the IFC model and click Open.

See also

Add users to Trimble Connect projects (page 88)

Add users to Trimble Connect projects
Use the Add Users to Existing Trimble Connect Projects command to invite
users to participate in specific Trimble Connect projects.

1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Trimble Connect . 

3. In the Trimble Connect Settings dialog box, click Add Users to Existing
Trimble Connect Projects.

4. In the Add Users to Project dialog box, click the arrow buttons to move
the users that need access to the project to the Included list. 

The users in the Included list receive email invitations to the projects you
select.

5. Click OK.
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6. In the Select Project dialog box, click the arrow buttons to move the
projects to which you want to add the selected users to the Included list.

7. Click OK.

8. In the Status dialog box, view the user invitation process.

9. When the setup is completed, click OK to close the Status dialog box.

The selected users have now been sent email invitations to the selected
Trimble Connect projects.

See also

Add Trimble Connect projects (page 87)

Use Tekla PowerFab together with Tekla Warehouse
Tekla Warehouse is a service for collaboration and for storing and sharing
content used for Tekla Structures and Tekla PowerFab.

Tekla Warehouse provides centralized access to a wide range of content that
you can use in Tekla Structures and Tekla PowerFab.

For example, you can download the Workflow Tools for Tekla Structures
application from Tekla Warehouse to allow showing the statuses of the items
pushed from Tekla PowerFab to Trimble Connect in the related Tekla
Structures model. Similarly, downloading Workflow Tools for Trimble Connect
Desktop allow showing the statuses of items pushed from Tekla PowerFab to
Trimble Connect in Trimble Connect for Windows.

NOTE You need to have a Trimble Identity to download content from Tekla
Warehouse.

To access Tekla Warehouse, go to https://warehouse.tekla.com/.

For more information on Tekla Warehouse, see Getting started with Tekla
Warehouse.

Use customized extensions for combining
You can create your own extensions that send multing and nesting requests
from Tekla PowerFab to other software. This way, using external multing or
nesting software becomes smoother.

NOTE Before you can use extensions with Tekla PowerFab, users with
administrator rights need to enable using extensions in the
Administration - Settings dialog box. For more information, see
Define Tekla PowerFab administration settings (page 77).
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Add and save an extension
1. Create the extension with a suitable tool. 

For example, you can use Microsoft Visual Studio.

Remember to create the necessary error messages if something goes
wrong when you use or test the extension.

2. To check where the extension needs to be saved, click the File ribbon tab
in the upper-left corner of the Tekla PowerFab window.

3. On the File menu, select Default Directories. 

4. Save your extension to the default folder for extensions.

Export materials for combining
To test and use your extensions:

1. Open a job and click the contextual ribbon tab. 

For example, in an open production control job, click the Production
Control tab.

2. On the menu, select Combine.

3. Select a combining command: Mult, Nest, or Mult & Nest.

4. Set the combining filters according to your needs.

5. Click Optimizations.
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6. In the Combining Setup dialog box, set Multing Software or Plate
Nesting Software to Other.

7. Combine the necessary items.

8. Click the Combining Run ribbon tab.

9. In the menu, go to Export Parts for Nesting and select your extension.

10. In the Export Parts for Combining dialog box, adjust the settings
according to your needs: 

• To include existing inventory materials in the export, select the Include
available inventory checkbox.

• To include inventory materials that are on order in the export, select
the Include orderable inventory.

• In the CNC files list, select how you want to include CNC files in the
export.

11. Click Send.

Manage inventory, cut lists, and nests with ProNest
You can use Tekla PowerFab and ProNest together to keep your inventory, cut
lists, and nests synchronized, so that you do not have to enter the same
information in both software.

Integration requirements
See the requirements for the ProNest integration below.

Software Required version
Tekla PowerFab 2019 or newer
ProNest 2019 or newer
ProNest DataSync 2019 or newer

Note that the integration also requires:

• Having particular ProNest licenses. For more information, contact your
ProNest representative.

• Downloading the following files:

File name Description Download file to
FabSuite Inventory
Sync.xml

The inventory sync task
for ProNest DataSync.

On the ProNest
database server

Tekla PowerFab Work
Order.xml

Needed if you plan to
export items from Tekla
PowerFab in the work
order format.

C:\ProgramData
\Hypertherm CAM
\Data Sync
[version]\Tasks\
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File name Description Download file to
ProNest to Tekla
PowerFab
Summary.fr3

The custom report to
import nested items
from ProNest back to
Tekla PowerFab.

C:\ProgramData
\Hypertherm CAM
\ProNest
2019\Reports
(FastReport)\Custom
Reports\

• Having DataSyncCMD installed on the Tekla PowerFab server.

• Having DataSyncCMD and DataSync server running on the ProNest server.

To test the connection between Tekla PowerFab and ProNest DataSync:

1. On the start screen of the Tekla PowerFab server, type cmd into the
search.

2. In the command prompt, copy and paste the following:

" "[Data Sync Path]" test1"
If you get the error message "The specified task name is unknown", DataSync
is running properly.

If you get the error message "Cannot find Data Sync Service", contact your
ProNest representative.

Set up Tekla PowerFab to work with ProNest
1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> ProNest.

3. To allow sending inventory to ProNest and using ProNest for nesting
plates, select the Enable ProNest for Plate Nesting checkbox at the top
of the ProNest Settings dialog box.

4. In the Nesting Request Format list, select how you want to send nesting
requests: 

• Work Order: Allows sending the part list in a single click, and after
that, automatically imports to the part list in ProNest

• PNL/SNL: Allows sending both the part list and the available inventory
to ProNest in two files, PNL and SNL, with the same name. Opening the
PNL file in ProNest imports the parts, selects the imported parts for
nesting, and sets the available inventory for the nest to the plates
within the related SNL file.

5. On the Database Connection tab in the dialog box, define how Tekla
PowerFab connects to the ProNest database to sync the inventory: 
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Option Description
IP address The IP address of the ProNest database.

The default value is [Computer name]\PRONEST.
Note that the computer name needs to be the
name of the computer on which ProNest has been
installed. This might not be the computer on which
you are using Tekla PowerFab.

If you want to check if Tekla PowerFab can connect
to the ProNest database properly, click Test
Connection. If the connection is not successful,
open ProNest and ensure that the database is
networked, and that you have typed the right
computer name in the IP address field.

ProNest Version The ProNest version that you are using.

Note that the oldest available ProNest version is
version 2012, or version 10.

Use Windows
Authentication

If you want to use Windows Authentication to
connect to the ProNest database, select the Use
Windows Authentication checkbox.

If you do not want to use Windows Authentication,
clear the Use Windows Authentication checkbox.

Username, Password Your username and password in ProNest.

6. On the Inventory Sync tab, define the inventory synchronization settings:

Option Description
Inventory Sync Folder The path to the folder in which inventory sync files

are stored.

Note that both Tekla PowerFab and ProNest need
to be able to read from and write to the inventory
sync folder. This means that if Tekla PowerFab and
ProNest are installed on different computers, the
inventory sync folder needs to be a shared folder.

Data Sync Command
Path

The path to the location on the Tekla PowerFab
workstation or the server where you have installed 
DataSyncCmd.exe.

Inventory Sync
Timeout

The time in minutes that Tekla PowerFab will wait
for DataSyncCmd.exe to respond.

3 to 5 minutes is usually a sufficient time.
Material Display
Format

The material display format defined in ProNest
regional settings. Note that the format needs to
match the format used in ProNest.
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Option Description
Show File Location
Errors for Cut Lists

If you want to get notifications when ProNest cut
lists are located in unsuitable folders, select the
Show File Location Errors for Cut Lists checkbox.

If you do not want to see these errors, clear the
Show File Location Errors for Cut Lists checkbox.

Import Cut List before
Inventory Sync

To receive updates on which items have been cut
before synchronizing the inventory, select the
Import Cut List before Inventory Sync checkbox.
We recommend that you select the Import Cut
List before Inventory Sync checkbox.

If you do not want to receive updates on cut items
before synchronizing the inventory, clear the
Import Cut List before Inventory Sync checkbox.

Sync Material On
Order

To send material that has not yet been received to
ProNest, select the Sync Material On Order
checkbox.

To avoid sending material that has not yet been
received to ProNest, clear the Sync Material On
Order checkbox.

Sync Combined
Material

To synchronize inventory stock material that has
been used in combining, select the Sync
Combined Material checkbox.

To prevent synchronizing inventory stock material
that has been used in combining, clear the Sync
Combined Material checkbox.

Enable Automatic
Inventory Sync

If you want to allow Tekla PowerFab to
automatically synchronize the inventory with
ProNest, select the Enable Automatic Inventory
Sync checkbox.

If you do not want to allow Tekla PowerFab to
automatically synchronize inventory with ProNest,
clear the Enable Automatic Inventory Sync
checkbox.

NOTE If you have created an automated event
(page 233) for synchronizing the inventory
between Tekla PowerFab and ProNest, you
should clear the Enable Automatic
Inventory Sync checkbox. We recommend
creating an automated event instead of
selecting the Enable Automatic
Inventory Sync checkbox.
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Option Description
Automatic Inventory
Sync Interval

The time in minutes after which Tekla PowerFab
automatically synchronizes the inventory with
ProNest.

The synchronization should happen frequently
enough to keep your inventory up to date. We
recommend using an interval between 10 and 60
minutes.

7. On the Transfer Settings tab, select to which ProNest fields you want to
map the following Tekla PowerFab fields: 

Option Description
Tekla PowerFab
Remnant ID Field

The unique, unchanging ID that Tekla PowerFab
assigns to each remnant.

If you want to see the remnant ID in ProNest as
well, select the ProNest field in which you want to
show the remnant ID.

Heat Serial Number
Field

The heat serial number of each inventory item.

Note that the heat number of each inventory item
is automatically mapped to ProNest.

If you use a heat serial number in Tekla PowerFab
and want to see the heat serial number in ProNest
as well, select the ProNest field in which you want
to show the heat serial number.

PO Number Field The purchase order on which the inventory item
has been added.

If you want to see the purchase order information
in ProNest as well, select the ProNest field in which
you want to show the purchase order number.

Bill of Lading Field The bill of lading number, or the shipment number
that the inventory item was received on.

If you want to see the bill of lading number in
ProNest as well, select the ProNest field in which
you want to show the bill of lading number.

Secondary Location
Field

The secondary location of each inventory item.

Note that the primary location of each inventory
item is automatically mapped to ProNest.

If you want to see the secondary location in
ProNest as well, select the ProNest field in which
you want to show the secondary location.
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Option Description
ProNest Name Field This setting corresponds to the information in the

Name field in ProNest plate inventory.

We recommend that you select the Shape Grade
Thickness option. However, if you have used Tekla
PowerFab and ProNest together without the
integration before, you can also select the
PartNumber option.

Dimension Units Select if you want to show dimension lengths in
imperial or metric units.

Blank Class To ensure compatibility with ProNest, select an
option for items without a class:

• Three Spaces: use this option with newer
versions of ProNest

• Empty: use this option only with older versions
of ProNest

Use Full Path for CNC
Filename

To ensure that the ProNest integration works,
select this checkbox if you use version 2021 of
ProNest or newer.

8. Click Save.

Synchronize inventory information with ProNest
Use the Sync with ProNest command to synchronize Tekla PowerFab
inventory information with ProNest and update the cut lists in ProNest. We
recommend that you synchronize the two software regularly.

Before you begin, ensure that:

• DataSyncCmd.exe is running

• Tekla PowerFab can access the ProNest database

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export --> Sync with ProNest . 

The inventory information in Tekla PowerFab is exported to ProNest to
synchronize the two software. You can view the process in the Status
dialog box.

3. When the synchronization process is completed, click OK to close the
Status dialog box.

In the synchronization process, Tekla PowerFab checks the ProNest database
for new items and links each new item in the ProNest inventory to the
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appropriate piece in the Tekla PowerFab inventory. When synchronization is
complete, ProNest has all the inventory items that Tekla PowerFab has.

Note that inventory items that have previously been in ProNest but have not
been linked to Tekla PowerFab are not affected by the synchronization.

Import ProNest inventory to Tekla PowerFab
1. In ProNest, print the plates that you want to export into an HTML file.

2. In Tekla PowerFab, open the Inventory module.

3. Click the Inventory ribbon tab.

4. On the menu, select Import --> Inventory from HTML.

5. Browse to and select the inventory HTML file from ProNest.

6. Click Open. 

The selected ProNest plates are imported into the Tekla PowerFab
inventory. The import creates a link between Tekla PowerFab and ProNest,
so that the imported plates can be used in nests.

Existing plates in the Tekla PowerFab inventory are updated, but their
quantity is not decreased.

7. See the progress of the import in the Import dialog box. 

To see more details on the import, click Open Import Log.

8. When the import is complete, click the Close button (X) in the upper-right
corner to close the Import dialog box.

Import ProNest cut lists to Tekla PowerFab
Before sending cut lists to Tekla PowerFab, send the nest to CNC in ProNest.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Import --> ProNest Cut List . 

Tekla PowerFab imports the cut lists that are available in ProNest.

3. See the progress of the import in the Import dialog box. 

To see more details on the import, click Open Import Log.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Update the inventory using a cut list
After you have imported a ProNest cut list to Tekla PowerFab, you can update
the inventory as follows:

1. Open a production control job.
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2. Click the Production Control ribbon tab.

3. On the menu, select Review --> Cut Lists.

4. At the bottom of the Cut Lists dialog box, click New.

5. Click Make Report.

6. In the Report Selection dialog box, click Save Cut List.

7. Type a description and select a due date for the cut list.

8. Ensure that Share Cut List is selected.

9. Click Save To Cut List. 

The new cut list appears in the Cut Lists dialog box.

10. In the Cut Lists dialog box, double-click the new cut list.

11. To view the nest details of an item, double-click the item in the cut list.

12. To see images of the nest, click Nest Image.

13. When an item in the cut list has been cut by a machine, in the Cut Lists
dialog box, select the item and click Cut.

14. Define the properties of the used inventory item.

15. Define the drop properties.

16. To remove the item from the Tekla PowerFab inventory and add the
resulting remnant to the inventory, click TFS. 

The status of the item in the cut list is now set to Complete and
highlighted in green.

The remnant item is linked to ProNest and can be used in ProNest for
further nesting.

You can see an image of the remnant, if you double-click the remnant
item in the Inventory dialog box.

Troubleshooting TFS

Sometimes, when you take an item from stock with the TFS command, you get
an error saying "External Nesting Result is not available". This occurs when the
cut list that was imported from ProNest to Tekla PowerFab could not be
completed during the import.

This can happen in the following cases:

• The ProNest job was sent to CNC with the initial nesting, but the material
items in Tekla PowerFab needed to be ordered. This means that the
inventory did not exist in Tekla PowerFab when ProNest marked this item
as cut.

• The ProNest job was sent to CNC multiple times.

• The cut list was imported to Tekla PowerFab before the material that was
being cut had been received in the Tekla PowerFab inventory.
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• Something in the nest changed in Tekla PowerFab, invalidating the nest. For
example, this can happen if the reserved inventory was used for something
else.

To fix the error, try the following:

1. Ensure that all inventory needed for the nest is in stock and received in
the Tekla PowerFab inventory.

2. In ProNest, re-send the job to CNC.

3. Import the cut list to Tekla PowerFab again.

If you continue to face the same error after this, contact support.

Export plates to be nested in ProNest
1. Open a combining, estimating, or production control job, a requisition, or

a purchase order.

2. Click the contextual ribbon tab. 

For example, if you are working on a combining job, click the Combining
ribbon tab.

3. On the menu, select Combine.

4. In the Select Combining Run dialog box, click Nest.

5. It the lower-left corner of the Combining Run Filters dialog box, click
Optimizations.

6. On the Plate Nesting Settings tab, set Plate Nesting Software to
ProNest.

7. Click Save.

8. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4. 

In the Combining Run Results dialog box, all parts show as not
combined.

9. Click Save Combining Run.

10. Click the Combining Run ribbon tab.

11. On the menu, select Export Parts for Nesting --> Export to ProNest.

12. Depending on the nesting request format that you have selected in the
ProNest Settings dialog box, do one of the following: 

If you have selected Do this
the Work Order format a. To open the calendar, click the arrow

on the right side of Work order due
date, and select a date in the
calendar.
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If you have selected Do this
b. To allow ProNest to mirror plates in

the nesting process, select the Mirror
Plates checkbox.

c. To allow ProNest to rotate plates in
the nesting process, select the Allow
plate to be rotated checkbox.

d. To include the job number in the
piece marks of items, select the
Include Job Number in Piecemark
checkbox.

For example, the piece mark p1.dxf
in job called Job123 would change
into Job123-p1.dxf.

This can help you to recognize items
with the same piece numbers in
different jobs.

e. Click Export Parts.

The work order is automatically
created and imported to ProNest. The
name and location of the work order
file are not important.

f. After the export is complete, open
ProNest and click Add Parts, or select
Job in the menu.

g. On the Home tab, select Edit Part
List --> Edit Part List.

h. On the Work Orders tab of the Edit
Part List dialog box, select some or
all of the newly imported items, and
drag them to the part list.

i. Click the Close button (X) to return to
nesting.

the PNL/SNL format a. To open the calendar, click the arrow
on the right side of Work order due
date, and select a date.

b. To allow ProNest to nest onto current
stock materials, select the Include
Sheets checkbox, and define the
priority for nesting onto current stock
material.

Priority 1 is the primary option for
nesting.

Manage Tekla PowerFab 100 Set up and work with integrated software in Tekla
PowerFab



If you have selected Do this
c. To allow ProNest to nest onto

remnants, select the Include
Remnants checkbox, and define the
priority for nesting onto remnants.

Priority 1 is the primary option for
nesting.

d. To allow ProNest to nest onto
orderable inventory, select Include
Orderable Sizes checkbox, and
define the priority for nesting onto
orderable inventory.

Priority 1 is the primary option for
nesting.

e. To open the PNL file in ProNest when
the file has been created, select the
Automatically Open PNL checkbox.

f. To include the job number in the
piece marks of items, select the
Include Job Number in Piecemark
checkbox.

For example, the piece mark p1.dxf
in job called Job123 would change
into Job123-p1.dxf.

This can help you to recognize items
with the same piece numbers in
different jobs.

g. To use the ProNest setup for
mirroring, select the Auto-Tab
checkbox.

h. Click Export Parts.

The export creates two files: a PNL
file, which contains the parts to nest,
and an SNL file, which contains the
inventory plates currently available
for combining.

i. If the PNL file is not automatically
opened in ProNest, on the Home tab,
select Edit Part List --> Import Part
List and select the PNL file.

The matching SNL file is imported
automatically.
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Import nesting results to Tekla PowerFab
1. In the Combining Run Results dialog box, click the Combining Run tab.

2. On the menu, select Import Nested Parts.

3. In the Open dialog box, browse for and select the nesting results file.

4. Click Open.

Mult and nest materials with Steel Projects PLM
You can use Steel Projects PLM to mult and nest materials outside Tekla
PowerFab. You can also export cut lists from Tekla PowerFab to Steel Projects
PLM.

Set up Tekla PowerFab to work with Steel Projects PLM
1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Steel Projects.

3. In the Steel Projects Settings, select the Enable Steel Projects
Integration checkbox.

4. If you want to allow Steel Projects PLM to reserve material to a job that
does not exist in Tekla PowerFab, select the Allow Nests without a Tekla
PowerFab Job checkbox.

5. Click Save.

6. If you use Tekla PowerFab Go, we recommend that you create an external
user. 

For detailed instructions, see Add, modify, and delete external users
(page 65).

7. Give the external user the necessary remote permissions. 

For detailed instructions, see Manage remote user permissions (page 68).

8. Ensure that the Tekla PowerFab Remote Server is running. 

For detailed instructions, see Set up Tekla PowerFab Remote Server for
Tekla PowerFab Go (page 41).

Note that you still need to set up Steel Projects PLM to work with Tekla
PowerFab. For detailed instructions, see the Steel Projects PLM
documentation.

Send a work order to Steel Projects PLM
A work order is a nesting or multing request. A work order contains the CNC
files to be cut, and the available and orderable inventory on which you can
nest materials.
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1. Open a combining, estimating, or production control job, a requisition, or
a purchase order.

2. Click the contextual ribbon tab. 

For example, if you are working on a combining job, click the Combining
ribbon tab.

3. On the menu, select Combine.

4. In the Select Combining Run dialog box, click a desired combining option
to select it. 

The options are:

• Mult: combines linear items, like beams and angles.

• Nest: combines items that have area, like plates or gratings.

• Mult & Nest: combines all items.

5. In the lower-left corner of the Combining Run Filters dialog box, click
Optimizations.

6. Depending on which items will be combined, do one or both of the
following: 

• On the Mult Settings - Linear Material tab, set Multing Software to
SteelProjects.

• On the Plate Nesting Settings tab, set Plate Nesting Software to
SteelProjects.

7. Click Save.

8. To combine the materials, click the Mult, Nest, or Mult and Nest button
at the bottom of the Combining Run Filters dialog box. 

In the Combining Run Results dialog box, all parts show as not
combined.

9. Click Save Combining Run.

10. Click the Combining Run ribbon tab.

11. On the menu, select Export Parts for Nesting --> Export to Steel
Projects.

12. In the Export Parts for Combining dialog box, adjust the settings
according to your needs: 

• To include existing inventory materials in the export, select the Include
available inventory checkbox.

• To include inventory materials that are on order in the export, select
the Include orderable inventory.

• In the CNC Files list, select how you want to include CNC files in the
export.

13. Click Export Parts.
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Tekla PowerFab exports the parts to be multed and nested.

You can now open Steel Projects PLM and import the XML file that has been
created by Tekla PowerFab. For detailed instructions on multing and nesting
parts, see the Steel Projects PLM documentation.

After the parts have been nested in Steel Projects PLM, you can save the
nesting results. The results will be automatically imported back to Tekla
PowerFab.

If the required material is not available in the Tekla PowerFab inventory, Steel
Projects PLM will ask you to create a requisition, which will then appear in the
Select Requisition/Purchase Order dialog box.

Export a cut list to Steel Projects PLM
1. Open a production control job.

2. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

3. On the menu, select Review --> Cut Lists.

4. In the Cut Lists dialog box, click New Cut List.

5. In the Enter Value dialog box, click the arrow on the right side of the
available field, and select the production control job for which you want to
create the cut list. 

When you are creating a new cut list, Tekla PowerFab by default filters the
items in the new cut list, so that only items that are not yet assigned to a
cut list are included.

6. In the Production Control Purchasing Report Filters dialog box, click
Make Report.

7. In the Report Progress dialog box, click Save Cut List.

8. In the Save Cut List dialog box, type a description and due date for the
cut list.

9. To allow importing the cut list to Steel Projects PLM, select the Share Cut
List checkbox.

10. Click Save To Cut List.

The cut list appears in the Cut Lists dialog box in Tekla PowerFab. You can now
import the cut list to Steel Projects PLM.

Manage purchase orders with Trimble Viewpoint
Use the Trimble Viewpoint integration to manage your Tekla PowerFab
purchase orders more efficiently. You can export your purchase orders or job
costing transactions to Trimble Viewpoint, or audit the inventory information
between Tekla PowerFab and Trimble Viewpoint.
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Set up the Trimble Viewpoint integration
1. In the Maintenance menu, select Integrations --> Trimble Viewpoint.

2. On the Global Settings tab of the Trimble Viewpoint Integration dialog
box, adjust the following settings: 

Setting Description
Viewpoint Software Select if you are using Trimble

Viewpoint Spectrum or Trimble
Viewpoint Vista.

Workflow Select if you want to perform job
costing when items are consumed, or
when items are purchased or
reserved.

Company Code Type the company code that you use
in Trimble Viewpoint.

If you want to ensure that the
company code is correct each time
you export purchase orders, select
the Prompt on export checkbox
below the Company Code field.

Cost Center Type the cost center that you use in
Trimble Viewpoint.

If you want to ensure that the cost
center is correct each time you export
purchase orders, select the Prompt
on export checkbox below the Cost
Center field.

3. To save the settings on the Global Settings tab, click Save Settings.

4. On the Receiving tab, to ensure that you only export the newest
transactions for receiving, click Set and enter the number of the last
exported transaction. 

Only the transactions after the last exported transaction will be exported.

5. On the Job Costing tab, do the following:

a. To ensure that you only export the newest transactions for job
costing, click Set and enter the number of the last exported
transaction. 

Only the transactions after the last exported transaction will be
exported.
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b. Type the batch code, the GL debit account number, and the GL credit
account number. 

If you want to ensure that the batch code, GL debit account number,
or GL credit account number is correct each time you export
purchase orders, select the Prompt on export checkbox below the
related fields.

c. To update the job costing settings, click Save Settings.

6. If you want to create customized reports to use with the Trimble
Viewpoint integration, do any of the following: 

To create a customized report for Do this
A purchase order a. On the Purchase Orders tab,

click Design.

b. In the Select Purchase Order
dialog box, double-click the
purchase order.

c. If you have selected the Prompt
on export checkboxes for any
properties, ensure that the values
are correct, and click OK.

d. To confirm copying the report to
your custom report directory,
click Yes.

e. Use the Stimulsoft Report
Designer to customize the report.

For instructions, see the
Stimulsoft Reports user guide.

Receiving a. On the Receiving tab, click
Design.

b. If you have selected the Prompt
on export checkboxes for any
properties, ensure that the values
are correct, and click OK.

c. To confirm copying the report to
your custom report directory,
click Yes.

d. Use the Stimulsoft Report
Designer to customize the report.

For instructions, see the
Stimulsoft Reports user guide.

Job costing a. On the Job Costing tab, click
Design.
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To create a customized report for Do this
b. If you have selected the Prompt

on export checkboxes for any
properties, ensure that the values
are correct, and click OK.

c. To confirm copying the report to
your custom report directory,
click Yes.

d. Use the Stimulsoft Report
Designer to customize the report.

For instructions, see the
Stimulsoft Reports user guide.

Inventory summary a. On the Inventory Summary tab,
click Design.

b. Select the inventory date and
time in the available calendar and
lists and click OK, or click Use
Current Inventory to use the
current inventory values.

c. To confirm copying the report to
your custom report directory,
click Yes.

d. Use the Stimulsoft Report
Designer to customize the report.

For instructions, see the
Stimulsoft Reports user guide.

Saving the customized report in Stimulsoft Report Designer updates the
changes to Tekla PowerFab.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

You can now start working with the Trimble Viewpoint.

According to your needs, see any of the following instructions.

Export the selected purchase orders to Trimble Viewpoint
You can export purchase orders to both Trimble Viewpoint Vista and Trimble
Viewpoint Spectrum.

Before you export the purchase order, ensure that:

• The company code of the vendor in the Tekla PowerFab Address Book
matches the vendor in Trimble Viewpoint
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• The job number of the Tekla PowerFab purchase order matches the job
number in Trimble Viewpoint

• The Cost Code field in Tekla PowerFab purchase orders is mapped to the
phase in Trimble Viewpoint purchase orders.

1. Do any of the following: 

a. At the top of the Tekla PowerFab window, click the Purchasing
button.

b. On the Maintenance menu, select Integrations --> Trimble
Viewpoint. Then, click Export on the Purchase Orders tab.

2. In the Select Requisition/Purchase Order dialog box, select the
purchase orders that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.

4. On the menu, select Export Purchase Orders --> Trimble Viewpoint -
Selected.

5. Click Yes to confirm exporting the selected purchase orders.

6. If you have selected the Prompt on export checkboxes for any properties
in the Trimble Viewpoint Integration dialog box, ensure that the values
are correct, and click OK.

7. In the Save As dialog box, browse to the folder where you want to save
the exported purchase orders. 

By default, Tekla PowerFab saves the purchase orders in the Export
folder.

8. If necessary, change the file name.

9. Click Save.

The exported purchase orders are saved as a .txt file in the folder that you
selected.

You can then import the .txt file to any Trimble Viewpoint solution according
to your needs.

Export purchase orders with receiving transactions to Viewpoint
You can export purchase orders to both Trimble Viewpoint Vista and Trimble
Viewpoint Spectrum.

Before you export the purchase order, ensure that:

• The company code of the vendor in the Tekla PowerFab Address Book
matches the vendor in Trimble Viewpoint
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• The job number of the Tekla PowerFab purchase order matches the job
number in Trimble Viewpoint

• The Cost Code field in Tekla PowerFab purchase orders is mapped to the
phase in Trimble Viewpoint purchase orders.

1. Do any of the following: 

a. At the top of the Tekla PowerFab window, click the Purchasing
button.

b. On the Maintenance menu, select Integrations --> Trimble
Viewpoint. Then, click Export on the Receiving tab.

2. In the Select Requisition/Purchase Order dialog box, select the
purchase orders that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.

4. On the menu, select Export Purchase Orders --> Trimble Viewpoint -
Receiving.

5. In the Save As dialog box, browse to the folder where you want to save
the exported purchase orders. 

By default, Tekla PowerFab saves the purchase orders in the Export
folder.

6. If necessary, change the file name.

7. Click Save.

The exported purchase orders are saved as a .csv file in the folder that you
selected.

NOTE To avoid errors, do not open an exported .csv file with Microsoft
Excel. If you do so, the formatting of information changes, and
the .csv file will fail to import to Trimble Viewpoint products.

Export job costing transactions
1. On the Maintenance menu, select Integrations --> Trimble Viewpoint.

2. On the Job Costing tab, click Export.

3. If you have selected the Prompt on export checkboxes for any properties
in the Trimble Viewpoint Integration dialog box, ensure that the values
are correct, and click OK.

4. In the Save As dialog box, browse to the folder where you want to save
the file with exported job costing transactions. 

By default, Tekla PowerFab saves the file in the Export folder.
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5. If necessary, change the file name.

6. Click Save.

The exported job costing transactions are saved as a .csv file in the folder
that you selected.

NOTE To avoid errors, do not open an exported .csv file with Microsoft
Excel. If you do so, the formatting of information changes, and
the .csv file will fail to import to Trimble Viewpoint products.

View the inventory summary report
To audit the inventory information between Tekla PowerFab and Trimble
Viewpoint:

1. On the Maintenance menu, select Integrations --> Trimble Viewpoint.

2. On the Inventory Summary tab, click View.

3.12 Manage the Tekla PowerFab database
Administrators can manage the Tekla PowerFab database in multiple ways.

As an administrator, you can do the following:

• Save backup copies of the database

• Use a backup copy restore a compromised database

• Compress the database

• Clear information on user activity from log tables

• Recover previously deleted jobs

• Import backup files

See also

Save a backup copy of the Tekla PowerFab database (page 110)

Restore the Tekla PowerFab database (page 111)

Compress the Tekla PowerFab database (page 112)

Clear all information from log tables (page 113)

Recover deleted files (page 114)
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Save a backup copy of the Tekla PowerFab database
We recommend that administrators save backup copies of the Tekla PowerFab
database regularly. This way, you can restore a compromised database by
using a backup copy of the database.

NOTE The best way to ensure reliable database backups is using the
automated event for creating automatic backups.

1. Close all dialog boxes that you have open in Tekla PowerFab.

2. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.

3. On the File menu, select Backup Database.

4. In the Save As dialog box, browse to the location where you want to save
the backup file.

5. If necessary, modify the name of the backup file.

6. Click Save.

Tekla PowerFab copies all database information to the selected folder as a
compressed 7z file.

NOTE You can change the compression level of backup copies in the 
settings.ini file under the folder where Tekla PowerFab has been
installed. To do so:

1. Open the settings.ini file.

2. Find or add a section called [DatabaseBackup].

3. Below the [DatabaseBackup] line, type CompressionLevel, an
equal sign, and the compression value.

The compression values are from 1 (lowest level of compression,
fastest backup) to 5 (highest level of compression, slowest
backup).

For example, to save as compressed backup copies as possible,
type:

[DatabaseBackup]
CompressionLevel=5

4. Save and close the settings.ini file.

See also

Restore the Tekla PowerFab database (page 111)
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Restore the Tekla PowerFab database
Administrators can use the Restore Database command to replace the Tekla
PowerFab database with a previously saved backup copy. This can be useful if
the database has been compromised, or if the database needs to be moved
from one server to another.

1. Ensure that all other users have logged out of Tekla PowerFab.

2. To stop the Tekla PowerFab Remote Server:

a. Go to C:\Program Files (x86)\Tekla\Tekla PowerFab.

b. To open the Tekla PowerFab Remote Monitor window, double-click 
Tekla.PowerFab.Remote.Monitor.exe.

c. In the Tekla PowerFab Remote Monitor window, click Stop Service.

3. Close all dialog boxes that you have open in Tekla PowerFab.

4. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.

5. On the File menu, select Restore Database.

6. In the Open dialog box, browse to find the backup file that you want to
use.

7. Select the file and click Open.

8. To replace all existing information in the Tekla PowerFab database with
the information in the backup file, click Yes in the confirmation dialog box.

Tekla PowerFab restores the database. This may take a while.

9. In the Message dialog box, click OK to close Tekla PowerFab.

10. To use the restored database, restart Tekla PowerFab and log in.

If you have any problems, contact your local support. See Contact support
(page 298).

See also

Save a backup copy of the Tekla PowerFab database (page 110)

Compress the Tekla PowerFab database
Administrators can use the Optimize Tables command to compress the Tekla
PowerFab database.

1. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab. 
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4. On the menu, select Optimize Tables. 

The Optimize Tables dialog box opens, and the compression process
starts.

The more information is saved into Tekla PowerFab, the longer the
compression process takes.

5. In the Optimize Tables dialog box, review the result of the compression
process. 

• Optimized shows the number of files that were compressed.

• Optimization Not Required shows the number of files that did not
need to be compressed.

• Errors Found shows the number of errors that were found in the
compression process. The errors are also listed in the Optimize Tables
dialog box.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Clear all information from log tables
All actions that are performed in Tekla PowerFab are saved in log tables.
Administrators can use the Clear Log Tables command to manually clear extra
logs from particular actions made by the Tekla PowerFab in the company.
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1. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab. 

4. On the menu, select Clear Log Tables.

5. To confirm clearing the log tables, click Yes in the confirmation dialog box.

Recover deleted files
When a user deletes a combining job, estimating job, or a production control
job, Tekla PowerFab saves the jobs in the Tekla PowerFab database as KISS
files. Administrators can recover the deleted combining jobs, estimating jobs,
and production control jobs within 30 days of deleting the job.

To access the recovering options, do the following:

1. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.

2. On the File menu, select Administration.

3. Click the Administration ribbon tab.
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Recover jobs
1. On the menu, select any of the following depending on the job type:

• Recover Deleted Combining Jobs

• Recover Deleted Estimating Jobs

• Recover Deleted Production Control Jobs

2. In the recovering dialog box that opens, select the jobs that you want to
recover. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click Recover. 

A message opens, informing you that Tekla PowerFab will create KISS files
for the selected jobs. You can then import the KISS files back to Tekla
PowerFab to view and modify the recovered job again.

4. Click OK to close the message.

5. In the Save As dialog box, browse to the location where you want to save
the first KISS file for recovering the job.

6. If necessary, change the file name.

7. Click Save. 

Repeat steps 5 to 7 to select the saving location of all KISS files.

8. Close all open dialog boxes in the Tekla PowerFab.

9. To re-import the recovered job to Tekla PowerFab, click the File ribbon
tab.

10. On the File menu, select Import.
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11. In the navigation tree on the left of the Import dialog box, select the job
type (Combining, Estimating, or Production Control) and then, select
KISS. 

12. Click the ... button.

13. In the Open dialog box, browse to find the KISS file that you want to
import.

14. Select the file and click Open.

15. Click Import.

16. In the job editing dialog box, modify the job information according to your
needs.

17. Click Save.

18. In the Import dialog box, view the status of the import process. 

If necessary, you can view the import details and errors in a text file by
clicking the Open Import Log button.

19. To close the dialog box, click the Close button (X) in the upper-right
corner.

The recovered job can now be opened and modified when you open the
related module in Tekla PowerFab.

Recover import backups
Tekla PowerFab creates import backup files automatically when information is
imported to a production control job. Import backup files contain the
information of a production control job before any new information was
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imported. By recovering import backup files, you can revert a production
control job to the state before new information was imported.

1. On the menu, select Recover Import Backups.

2. In the Recover Import Backup dialog box, select the import backup file. 

You can identify the correct backup file by the import date and time, the
user that imported the information, and the job number.

3. Click Recover. 

A message opens, informing you that Tekla PowerFab will create KISS files
for the selected import backups. You can then import the KISS files back
to Tekla PowerFab to revert the production control job to the state before
importing information.

4. Click OK to close the message.

5. In the Save As dialog box, browse to the location where you want to save
the KISS file.

6. If necessary, change the file name.

7. Click Save.

8. Close all open dialog boxes in Tekla PowerFab.

9. To revert the job to the state before new information was imported, Tekla
PowerFab, click the File ribbon tab.
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10. In the navigation tree on the left of the Import dialog box, select the
import file type and then, select KISS .

11. Click the ... button.

12. In the Open dialog box, browse to find the KISS file that you want to
import.

13. Select the file and click Open.

14. Click Import.

15. In the Job # list, select the job that you want to revert to its previous state.

16. Click Save.

17. To overwrite the current information with the import backup file, in the
Import dialog box, select Add & Replace.

18. Click OK. 

If you have selected the Prompt to confirm import fields in the
Company Standards dialog box for the Production Control module, the
Select the included fields dialog box opens.

19. In the Select the included fields dialog box, click the arrow buttons to
move the fields whose information that you want to replace to the
Included list. 
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20. Click OK.

21. Define other necessary information for the imported backup file.

22. Click OK.

23. In the Import dialog box, view the status of the import process. 

If necessary, you can view the import details and errors in a text file by
clicking the Open Import Log button.

24. To close the dialog box, click the Close button (X) in the upper-right
corner.

3.13 Repair program errors
Administrators can use the Check/Repair Tables commands on the server
computer to find and repair errors in Tekla PowerFab. When one of these
commands is executed, the program information is checked against the
MySQL database and any corrupt files are repaired.

NOTE To repair errors, you must execute the Check/Repair Tables
commands on the server computer. On other workstations, the
Check/Repair Tables commands can help you find corrupted files,
but the files cannot be repaired.

1. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.

2. On the File menu, select Administration.
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3. Click the Administration ribbon tab. 

4. On the menu, select one of the following commands:

• Check/Repair Tables: Quick (Fast)

• Check/Repair Tables: Medium (Recommended)

• Check/Repair Tables: Extended (Slow)

The Check/Repair Tables dialog box opens, and the check and repair
process starts.

The more information is saved into Tekla PowerFab, the longer the check
and repair process takes.

5. In the Check/Repair Tables dialog box, review the result of the check and
repair process. 
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6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Repair program errors from command prompt
Occasionally, program errors need to repaired from outside of Tekla
PowerFab. Administrators can use the command prompt on the server
computer to find and repair errors in Tekla PowerFab.

When the commands presented here are executed, the program information
is checked against the MySQL database, and any corrupt files are repaired.

NOTE To repair errors, the administrator must execute the commands on the server
computer. The commands do not work on other workstations.
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Prerequisites
Before performing the repair steps, you need to have the following
information available:

• The directory that MySQL is installed to. By default this is installed at
C:\mysql\.

The installation may have been directed to a different location. You can
check this in the Path column and MySQL Path row in MySQL Service
Manager.

• The port number for the the database you want to check.

By default the Tekla PowerFab database runs on port 3306, but it can be
changed. You can check this in the Port column and Port row in MySQL
Service Manager.

• The admin password for the Tekla PowerFab database.

By default, MySQL Service Manager is installed at C:\Program Files
(x86)\Tekla\Tekla PowerFab\MySQL.Service.Manager.exe. The
installation may have been directed to a different location.

The admin password should have been changed by someone at your
organization. Tekla/Trimble does not have a way to discover this password. To
reset the admin password, contact your local support.

Repair the database from command prompt
1. Open a Command Prompt instance.

2. To change the directory to the MySQL bin directory, type 

cd [path]
Replace [path] with the path to the MySQL bin directory.

3. In the MySQL bin directory, run the following command: 
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mysqlcheck -u admin -p --auto-repair --check --all-databases --port=[port]

Replace [port] with the port that the MySQL database is running on.

NOTE You can exclude --port= if you are using the default port 3306.

4. When you are prompted to Enter Password:, type in the admin
password and press Enter. The mysqlcheck command runs the Check/
Repair on the database.

When the mysqlcheck command has completed, you can either type exit
and press Enter to close the command prompt session, or just close the
window.

Example: MySQL is in the default location and the database is on the
default port (3306)
1. Open a Command Prompt instance.

2. To change the directory to the MySQL bin directory, type 

cd C:\mysql\bin
3. In the MySQL bin directory, run the following command: 

mysqlcheck -u admin -p --auto-repair --check --all-databases
4. When you are prompted to Enter Password:, type in the admin

password and press Enter.

When the mysqlcheck command has completed, you can either type exit
and press Enter to close the command prompt session, or just close the
window.

Example: MySQL is in the default location and the database is on port
3220
1. Open a Command Prompt instance.

2. To change the directory to the MySQL bin directory, type 

cd C:\mysql\bin
3. In the MySQL bin directory, run the following command: 

mysqlcheck -u admin -p --auto-repair --check --all-databases --port=3220
4. When you are prompted to Enter Password:, type in the admin

password and press Enter.

When the mysqlcheck command has completed, you can either type exit
and press Enter to close the command prompt session, or just close the
window.
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Example: MySQL is on another drive or location and the database is on
port 3220
1. Open a Command Prompt instance.

2. To change the directory to the MySQL bin directory, type 

cd D:\mysql_5_7_29\bin
3. In the MySQL bin directory, run the following command: 

mysqlcheck -u admin -p --auto-repair --check --all-databases --port=3220
4. When you are prompted to Enter Password:, type in the admin

password and press Enter.

When the mysqlcheck command has completed, you can either type exit
and press Enter to close the command prompt session, or just close the
window.

3.14 Migrate Tekla PowerFab to a new server
When migrating Tekla PowerFab to a new server, you need to first install Tekla
PowerFab to the new server and then move the data from the old server to the
new one.

See View currently signed-in users (page 53) and Force shutdown (page 54).

1. Install Tekla PowerFab server
See Install Tekla PowerFab (page 36).

1. Install Tekla PowerFab on a server. 

See Install Tekla PowerFab on a server (page 39).

2. Install Tekla PowerFab Remote Server service. 

See Install Tekla PowerFab Remote Server in Set up Tekla PowerFab
Remote Server for Tekla PowerFab Go (page 41).

3. Document the directory locations, server IP address, and server name for
the installation and update on client machines.

4. You may need to create an inbound rule for the Windows firewall to allow
the connection to the database through TCP port 3306.
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2. Get the data from the old server

NOTE Before you start migrating Tekla PowerFab to a new server, all users
must be out of the system until the database has been restored on
the new server.

1. Open Tekla PowerFab on the old server as an administrator.

2. To note the current location of the default directories, go to File -->
Default directories.

3. Optional: Go to File --> Administration.

4. Optional: Click the Administration ribbon tab and select Check/Repair
Tables: Medium.

5. Optional: Go to File --> Administration.

6. Optional: Click the Administration ribbon tab and select Optimize
Tables.

7. In the File ribbon tab, select Backup Database.

8. Save the file to an accessible location on the new server or portable
media.

9. Open the Services application and click Stop the service.

10. To prevent users from doing work in the old database, stop and disable
MySQL_TeklaPowerFab. 

NOTE Instead of MySQL_TeklaPowerFab, the service name may be
MySQL_Fabsuite.

a. Open the Services application and click Stop the service.

b. Right-click the service and select Properties.

c. On the General tab, in Startup type, select Disabled.

d. Click Apply.

e. Click OK.

3. Restore the data on the new server
1. Open Tekla PowerFab and log in as an administrator.

2. Go to File --> Restore Database.

3. Browse to the location of the database backup from the old server and
select the file.

4. Follow the prompts to restore the database.
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4. Migrate default directories to the new locations
If the default directories are local to the old server, they may need to be
moved to the ones set up on the new server. If they are on a separate file
server they may or may not need to be moved.

1. Migrate the content of the Document Index, Drawing, and Custom
Report directories to the new location. 

Migrating the content in other directories is optional.

2. Locate the default directories.

3. Copy the content of those directories to the new directories on the new
server or location.

5. Update the connection and settings on the client
machines
1. Open Tekla PowerFab on the client machine.

2. In the login dialog box, click Connection, and on the Database
Connection tab, set the connection to the new IP address or server name.

3. Click OK.

4. If multiple connections are to be used, the local Windows administrator
must do the following:

a. In the login dialog box, click Connection, and on the Other tab, select
Separate ODBC Data Sources by Connection Details.

b. Click OK.

5. Log in. 

If the database connection has changed, you get a message telling to
update the ODBC connection to match the new one. This is for ensuring
that the report viewer connection is also changed.

6. Select Yes.

7. Go to File --> Default Directories and set the directories to the new
location. 

Document Index, Drawing, and Custom Report directories are critical.
The Update directory is important if you want to have future updates
running through a system-generated prompt.

6. Update Tekla PowerFab Connection
It is important for those using Tekla PowerFab Go that the port forwarding on
your router is updated if the server IP address is changed.
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NOTE If the server is moved to a different network that requires a change in
the public IP address, contact support to have it updated for your site.

Due to the number of varieties of routers and software interfaces for setting
port forwarding, we cannot provide specific instructions for this.
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4 Configure and use Tekla
PowerFab

Tekla PowerFab is a software solution designed for the needs of the steel
fabrication industry. Tekla PowerFab brings together various modules that
integrate seamlessly with each other, so the information that you enter in one
Tekla PowerFab module is available through the entire workflow.

Tekla PowerFab is built upon the industry best practices. However, the
operations and options in Tekla PowerFab can be customized to match your
existing processes and procedures.

Tekla PowerFab consists of the following modules:

• The Combining module allows you to create advanced bills of materials
while optimizing the use of material and minimizing the waste.

• The Estimating module allows you to create estimates with customizable
pricing based on multiple sources for material pricing and shop-specific
labor.

• The Inventory module allows you to track your entire inventory across all
jobs as material is received and consumed. The Inventory module also
allows you to track stock materials and non-steel items.

• The Project Management module allows you to easily share project
information to all users that participate in a project, and create and view
project schedules in order to track the progress of the project.

• The Production Control module allows you to view and manage the
fabrication process of material items.

• The Purchasing module allows you to create requisitions, and automate
and optimize creating and tracking purchase orders.

• The Order Entry module allows you to manage all tasks related to selling
material from your warehouse or shop, such as creating quotes and orders,
invoicing, and recording payments.
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For more information, see the following links:

Sign in to Tekla PowerFab (page 130)

Set the default printer (page 298)

Set the standard categories for attached documents (page 150)

Manage the address book (page 141)

Manage taxes and currencies (page 220)

Import files to Tekla PowerFab (page 226)

Create, modify, and delete automated events (page 233)

Customize Tekla PowerFab (page 250)

4.1 Tekla PowerFab configurations
Tekla PowerFab allows access to all the desktop application modules. Only
permissions within the database can restrict access to areas or modules.

Tekla PowerFab Viewer allows access to all the desktop application modules
in the read-only mode. Only permissions within the database can restrict
access to areas or modules. The read-only mode only allows the viewing of
records and does not permit to add, edit or delete any records.

Additionally, there are legacy Tekla PowerFab configurations that provide the
opportunity to use different modules and features.

The Tekla PowerFab modules included in different configurations are:

Name Tekla PowerFab
Full

Tekla PowerFab
Production

Tekla PowerFab
Estimating

Combining ✔ ✔ ✔

Estimating ✔  ✔

Inventory ✔ ✔ ✔

Project
Management

✔ ✔  

Production
Control

✔ ✔  

Purchasing ✔ ✔ ✔

Order Entry ✔ ✔  

In addition to the Tekla PowerFab configurations in the table, there are specific
Tekla PowerFab configurations that replace the Fabsuite configurations used
by former Fabsuite customers.
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4.2 Sign in to Tekla PowerFab
Before you sign in to Tekla PowerFab for the first time:

• Make sure you have a Trimble Identity, see Create your Trimble Identity.

• Make sure that you have been assigned the appropriate license by your
organization's administrator. You can check your licenses in Tekla Online
Profile.

1. Start Tekla PowerFab.

2. In the Trimble ID section of the Log In dialog box, click Sign in. 
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3. Sign in with your Trimble Identity.

If you do not have a Trimble Identity, see Create your Trimble Identity.

If you have forgotten your password, contact a Tekla PowerFab user in
your company that has administrative rights, so that they can reset your
password (page 54).

4. If necessary, in the Configuration list of the Log In dialog box, select
which configuration of Tekla PowerFab you want to use. 

Note that you only need to select a configuration if you have purchased
more than one configuration of Tekla PowerFab.

5. Type your Tekla PowerFab username and password. 

The username and password need to be created by an administrator in
your company.

The default Tekla PowerFab sign-in information for administrators is:

• username: admin
• password: fab
If you have previously used Fabsuite, your username and password are
the same as in Fabsuite.

6. Click Log In.

7. In the Enter Value dialog box, do either of the following:

Configure and use Tekla PowerFab 131 Sign in to Tekla PowerFab

https://support.tekla.com/doc/tekla-structures/not-version-specific/ins_create_your_trimble_identity


• To save your Trimble Identity and use it automatically when you sign in
to Tekla PowerFab, select Yes in the list.

• To not use your Trimble Identity automatically when you log in, select
No in the list.

If you have any problems with signing in, check the frequently asked questions
in Trimble Identity for Tekla Online services. See also https://
support.tekla.com/doc/tekla-structures/not-version-specific/
ins_create_your_trimble_identity.

See also

Tekla PowerFab configurations (page 129)

Tekla PowerFab user interface (page 136)

Set or change your Tekla PowerFab password (page 132)

Set or change your Tekla PowerFab password
Use the Change Password command to either create the password you will
use when you log in to Tekla PowerFab, or change your current password.

NOTE Passwords are case-sensitive.

If your initial password does not meet the company password policy, the
Change Password dialog box opens automatically when you first log in to
Tekla PowerFab.

If you are setting your password for the first time, leave the Old Password
field blank and sign in.

If you have forgotten your password, ask the administrator to reset it so that
you can create a new one.

1. Go to File --> Change Password 
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2. In the Change Password dialog box, type your old password in the Old
Password field. If you are setting your password for the first time, leave
the Old Password field blank.

3. Type your new password in the New Password and Confirm fields. 

The passwords in the New Password and Confirm fields need to be
identical.

You can verify your company's requirements for the password in the
Password Policy section of the dialog box. The password policy is set by
the Tekla PowerFab administrators of your company.

4. Click Save to update the password. 

A message appears, telling you that the password has been changed.

5. Click OK to close the message.
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Emergency use when no access to online system
If you cannot access the online system because you do not have a connection
to the internet, access to the license server, or an active Trimble Identity, you
have three emergency uses available for your machine to access the system.

Do not use your emergency uses unless it is absolutely necessary.

NOTE If you have used all three emergency uses, contact your local support.

For instructions for contacting support, see Contact support (page 298) .

Example: No internet access or loss of internet access
When you lose internet access, you get the following message:

1. Click OK to close the message.

2. Delete the text in the Configuration field. 
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3. Type in your username and password and click Log In. 

You are asked to confirm the sign-in.

4. Click No. 

You get a message saying "HTTP request failed".

5. Click OK. 

You are asked to confirm the use of one emergency use.

6. To confirm the emergency use, click Yes.

Example: Your Trimble Identity is inactive or not created
For an inactive Trimble Identity you get the sign-in window, but when you
close it without signing in, you get the "Trimble Identity login canceled"
message.

1. Delete the text in the Configuration field. 
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2. Type in your username and password and click Log In. 

You are asked to confirm the sign-in.

3. Click No. 

You get a message saying "Invalid configuration".

4. Click OK. 

You are asked to confirm the use of one emergency use.

5. To confirm the emergency use, click Yes.

4.3 Tekla PowerFab user interface
The main elements of the Tekla PowerFab user interface comprise the ribbon
tab with its drop-down menus, icons for each module, and active drop-down
menus for each module.
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At the very top, there are four ribbon tabs, File, Maintenance, About, and
Windows, which can be used to access certain features and options.

• The File ribbon tab is mainly used for administrative tasks, except for
Import.

• The Maintenance ribbon tab is used mostly for configuration, both for
individual modules and global settings.

• The About ribbon tab provides information on the current version of Tekla
PowerFab, contact details, access to the Tekla PowerFab release notes, and
Tekla PowerFab support.

• The Windows ribbon tab lists all the windows that you currently have
open. This is helpful when you have multiple windows open
simultaneously, and you want to bring a certain window to the front.

Across the top there are icons for each of the major modules. Clicking an icon
launches a particular module.

In most cases, this opens a selection table for selecting, for instance, the
desired estimate, job, or purchase order. When you double-click a row, this
opens the module main window. An exception to this is Inventory, which
opens the main inventory window.

If you do not have the rights to access a module, the module icon appears gray
and cannot be selected.

In any module, when you click to open a job, the main window opens. All
modules have a consistent layout on the main window.
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(1) Navigation tree: Allows quick filtering of information shown on the display
area

(2) Display area

(3) Input area: Allow entering information manually

(4) Summary grid: Displays information for an item, selected item, filtered
items, and for the total job

The individual name of each window is displayed in the top left hand corner,
and all windows can be closed, minimized, and restored from the top right
hand corner.

A fifth ribbon tab appears when you open any window for a module. This
ribbon tab provides contextual features and options based on the selected
window. Below is an example of an active Estimating ribbon tab and drop-
down menu.
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You can resize all windows by placing the mouse cursor on the edge of the
window and dragging in the desired direction.

See also

Change the user interface language (page 139)

Customize Tekla PowerFab (page 250)

Change the user interface language
You can change the user interface language in the Log In dialog box.

1. In the Log In dialog, click Connection. 

Configure and use Tekla PowerFab 139 Tekla PowerFab user interface



2. Go to the Internationalization tab. 

3. Select the language from the drop-down menu, click OK and Yes to
restart.

4.4 Adjust the initial settings
Before you start working in Tekla PowerFab, it is important to adjust the
material database and pricing to match those of your company. You can also
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set the default printer that you want to use, and define the standard
categories that you want to use for attaching documents to jobs in Document
Index.

See also

Set up the material database (page 161)

Set up pricing (page 199)

Set the default printer (page 298)

Set the standard categories for attached documents (page 150)

Set the user preferences (page 297)

4.5 Manage the address book
Use the Address Book to define and manage the companies and contacts
used in all Tekla PowerFab modules. We recommend that you set up the
address book as early as possible, so that working in Tekla PowerFab becomes
more fluent and efficient.

To access the Address Book, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Address Book.

The Address Book dialog box opens.

(1) Navigation tree: Allows you to only view specific companies.

You can expand and select options in the navigation tree. When you select an
option, only companies that match the selected option are displayed.
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For example, you can expand Firm Type and select Supplier to only display
suppliers.

(2) Firm type: Tells Tekla PowerFab where the company information should be
used.

For more information, see View firm types (page 143).

(3) Properties: Allows you to view the current company properties and credit
settings and modify them.

(4) Contacts: Allows you to switch to a view where the contact persons of the
companies are displayed.

Any red cells indicate companies that are over their assigned credit limit.

NOTE You can customize the layout of the Address Book dialog box. For
more information, see Customize the layout of a dialog box
(page 258).

For more information, see the following links:

Find companies or contacts (page 142)

View firm types (page 143)

Add companies to the address book (page 143)

Add contacts to the address book (page 145)

Modify company or contact properties (page 146)

Import contacts to the address book (page 147)

Export companies or contacts (page 149)

Delete companies or contacts from the address book (page 149)

Find companies or contacts
You can use the Find Company and Find Contact commands to quickly find
and select the correct company or contact in the Address Book dialog box.

Find companies
1. Go to Maintenance --> Address Book. The Address Book dialog box

opens and the Address Book ribbon tab appears.

2. In the Address Book ribbon tab, select Find Company.

3. Select if you want to search companies by name or by company code.

4. Type the company name or company code in the empty field, or click the
arrow on the right side of the field and select the company in the list.
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5. Click OK.

The company is selected in the Address Book dialog box.

Find contacts
1. Go to Maintenance --> Address Book.

2. In the Address Book dialog box, click Contacts The Address Book -
Contacts dialog box opens.

3. Click the Address Book Contacts ribbon tab.

4. On the menu, select Find Contact.

5. Type the contact name in the empty field, or click the arrow on the right
side of the field and select the contact in the list.

6. Click OK.

The contact is selected in the Address Book - Contacts dialog box.

View firm types
The various firm types in the address book are used in different modules in
Tekla PowerFab. Use the Firm Types command to quickly view the different
firm types and where they can be used.

1. Go to Maintenance --> Address Book. The Address Book dialog box
opens and the Address Book ribbon tab appears.

2. Click the Address Book ribbon tab.

3. On the menu, select Firm Types.

4. In the Firm Types dialog box, review the firm types and where they can
used in Tekla PowerFab.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add companies to the address book
To add new companies to the address book and define their properties, do the
following:

1. Go to Maintenance --> Address Book. The Address Book dialog box
opens and the Address Book ribbon tab appears.

2. At the bottom left corner of the Address Book dialog box, click New.

3. On the General tab of the Firm Details dialog box, select a suitable firm
type in the Firm Type list. 
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Firm types help Tekla PowerFab to sort the list of companies in the
address book. For more information, see View firm types (page 143).

TIP You can add more than one firm type for a company. For example, a
steel detailer can be added as both a detailer for Project
Management and as a supplier for purchase orders.

4. Type a name and a code for the company. 

The company code can be any value. For example, you can use the
accounting code of the company.

Note that you cannot use the same company code for two companies that
have the same firm type.

5. Select a primary currency type for the company.

6. If necessary, modify the credit limit of the company, and add any
additional notes regarding the company.

7. Open the Addresses tab.

8. Click New Address.

9. Type a description for the address and enter other necessary contact
information. 

Sometimes, it might be useful to have multiple addresses for a client. For
example, if a client has different production control jobs, they can have
multiple jobsite addresses that you should ship materials to. In these
situations, you can use the jobsite names or job numbers as the
descriptions of the jobsite addresses.

Remember to add the jobsite contacts on the Contacts tab. For more
information, see Add new contacts to the address book (page 145).

10. Select one of the available checkboxes to define if the address is a
shipping or mailing address.

11. Select the Active checkbox. 

If you do not select the Active checkbox, the address will not be available
for use anywhere in Tekla PowerFab.

12. Click Save Address.

13. On the Contacts tab, add contacts for the company. 

For more information, see Add new contacts to the address book
(page 145).

14. Click Save.

The Firm Details dialog box closes. The new company is saved to the address
book.
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See also

Modify company or contact properties (page 146)

Add contacts to the address book
You can add new contact persons either when adding or modifying company
properties, or in the Address Book - Contacts dialog box. You can also view all
existing contacts by clicking the Contacts tab at the bottom of the Address
Book dialog box.

You can also import contacts to the address book. For more information, see
Import contacts to the address book (page 147).

Add a new contact person in the company properties
1. In the Firm Details dialog box, go to the Contacts tab.

2. Click New Contact.

3. Type the name and contact information of the new contact person.

4. If the contact person is an inspector, select the Inspector checkbox and
add an inspector ID.

5. Select the Active checkbox. 

If you do not select the Active checkbox, you cannot select the contact
person anywhere in Tekla PowerFab.

6. To save the contact person and add the contact person to the list of
contacts, click Add Contact.

7. In the Default Contact list, select a default contact person for the
company.

8. Click Save. 

The Firm Details dialog box closes.

Add a new contact person in the contact list
1. At the bottom of the Address Book, click Contacts.

2. In the lower-left corner of the Address Book - Contacts dialog box, click
New.

3. In the Contact Details dialog box, select the firm type and company for
the new contact person. 

4. Type the contact person's name and contact information.

5. If the contact person is an inspector, select the Inspector checkbox and
add an inspector ID.

Configure and use Tekla PowerFab 145 Manage the address book



6. Select the Active checkbox. 

If you do not select the Active checkbox, you cannot select the contact
person anywhere in Tekla PowerFab.

7. Click Save.

The Contact Details dialog box closes. The new contact person is added to
the list of contacts.

Modify company or contact properties
You can modify the properties of existing companies and contacts in the
Address Book dialog box. For example, this can be useful when you need to
update phone numbers, or shipping and mailing addresses.

1. At the bottom of the Address Book dialog box, click Properties. 

The General tab of the Firm Details dialog box opens.

2. Modify the company properties on the various tabs. 

On the General tab, you can change the firm type, name, company code,
and currency.

On the Addresses tab, you can specify the required address details.
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Is Mill defines the mill location so that it can be applied to materials, both
when receiving from a purchase order and when adding or editing
inventory.

NOTE Only firm type Supplier can have the property Is Mill.

On the Contacts tab, you add add and modify contacts for a company.

3. Click Save.

The company and contact details are updated, and the Firm Details dialog
box closes.

Import contacts to the address book
You can import contacts from your Microsoft Outlook address book or a
Microsoft Excel worksheet to Tekla PowerFab.
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Import contacts from Microsoft Outlook
Before you import contacts from Microsoft Outlook, verify that the contacts
are listed with the companies in the manner that you want them to appear in
Tekla PowerFab.

1. In the Address Book dialog box, click the Address Book ribbon tab.

2. On the menu, select Import Outlook Contacts. 

The Select Contacts to Import dialog box opens.

Tekla PowerFab reads the list of contacts in Microsoft Outlook, and the
contacts appear on the Included side of the dialog box.

3. In the lefthand pane, select the contacts folder from which you want to
import contacts.

4. If you want to include the contacts in the sub-folders of the selected
folder, ensure that the Include Sub-Folder Contacts checkbox is
selected.

5. Click the arrow buttons to move the contacts that you want to import to
the Included list.

6. Click Save.

The selected Microsoft Outlook contacts are imported to the address book in
Tekla PowerFab. The Import Outlook Contacts closes.

Import companies or contacts from Microsoft Excel
1. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab

window.

2. On the File menu, select Import.

3. In the navigation tree on the left side of the Import dialog box, select
Address Book.

4. Below Address Book, select if you want to import companies (Firms) or
contacts.

5. Click the ... button.

6. In the Open dialog box, browse to find the Microsoft Excel worksheet that
you want to import, and select it.

7. Double-click the file, or click Open.

8. To import the file, click Import. 

If the Microsoft Excel worksheet contains unnecessary fields, Tekla
PowerFab asks you if the fields can be ignored in the import.

9. To ignore the unnecessary fields, click Yes.
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Tekla PowerFab imports the companies or contacts in the selected Microsoft
Excel worksheet.

If any import errors occur, you can see the error details at the bottom of the
Import dialog box. To see further details about errors in the import, click
Open Import Log.

Export companies or contacts
You can export the current list of companies or contacts in the Address Book
and save the list as a Microsoft Excel worksheet or a text file.

1. In the Address Book dialog box, click the Address Book ribbon tab.

2. On the menu, select either Export Firms or Export Contacts.

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.

5. If necessary, select another file format in the Save as type list.

6. Click Save.

The list of companies or contacts is exported and saved to the selected
location.

Delete companies or contacts from the address book
To keep the address book up to date, you may need to delete unnecessary and
outdated companies and contacts.

1. Do one of the following according to your needs:

• To delete a company, select the company in the Address Book dialog
box.

• To delete a contact, select the contact in the Address Book - Contacts
dialog box.

2. Click Delete in the lower-right corner of the dialog box.

3. To permanently delete the company or contact from the address book,
click Yes in the confirmation dialog box.

4.6 Document Index
Document Index is a place for storing files to be shared among other users
with access so that everyone can easily keep up to date.

Configure and use Tekla PowerFab 149 Document Index



Every module, with the exception of Inventory and Order Entry, have their
own Document Index area that allows various kinds of files to be stored
within the appropriate module. For example, you may store design drawings in
the Estimating document index and order acknowledgement files in the
Purchase Order document index.

The structure of the Document Index can be customized for each module to
define the required document categories and sub-categories.

See also

Default directories (page 38)

Set the standard categories for attached documents (page 150)

Manage Document Index categories (page 152)

Add document references (page 153)

Edit a document reference (page 158)

Open a document (page 159)

Delete a document reference (page 159)

Attach a document reference to an email (page 160)

View Document Index history of changes (page 161)

Set the standard categories for attached documents
Document Index allows you to organize and save documents for a job in the
Combining, Estimating, Project Management, Production Control, and
Purchasing modules. The standard categories where you can organize
documents need to be set separately for each module.

1. Click the Maintenance ribbon tab.

2. On the menu, go to Document Index, and select any of the following:

• Standard Categories - CMB: set the categories for organizing
documents related to combining jobs.

• Standard Categories - EST: set the categories for organizing
documents related to estimating jobs.

• Standard Categories - ORD: set the categories for organizing
documents related to customer orders.

• Standard Categories - PRJ: set the categories for organizing
documents related to project management jobs.

• Standard Categories - PDC: set the categories for organizing
documents related to production control jobs.

• Standard Categories - REQ: set the categories for organizing
documents related to requisitions.
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• Standard Categories - PO: set the categories for organizing
documents related to purchase orders.

The Document Index - Edit Categories dialog box opens with the default
categories.

Placeholders: The user can define the job organization by using placeholders
that will separate the jobs.

Default Directory: Dynamically creates subfolders in the folder defined in File
--> Default Directories/Document Index.

In Company Standards under the Maintenance ribbon tab for each module
mentioned above, you can select Automatically Create Document Index
Directories. Items in areas that have been created before this is set need to
be edited manually.

For more information, see Document Index in Tekla PowerFab.

Add a category
1. In the Document Index - Edit Categories dialog box, select the category

under which you want to create the new category.

2. At the bottom of the dialog box, click Add. 

The New Category dialog box opens.
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3. Type a name for the new category.

4. Click OK to add the category.

Rename a category
1. In the Document Index - Edit Categories dialog box, select the category

that you want to rename.

2. Click Rename.

3. In the New Category dialog box, type a new name for the category.

4. Click OK to update the name.

Delete a category
Note that deleting a category is permanent and cannot be undone.

1. In the Document Index - Edit Categories dialog box, select the category
that you want to delete.

2. Click Delete.

3. To permanently delete the category, click Yes in the confirmation dialog
box.

Manage Document Index categories
You can add new Document Index categories, and rename and delete existing
categories. You can also change the default folder where document references
are stored.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

2. Click Edit Categories.

3. Select the category you want to modify

4. Do any of the following: 
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To Do this
Add a new category a. In the navigation tree at the top of the dialog

box, select the parent category for the new
category.

b. Click Add.

c. Type a name for the new category.

For example, Miscellaneous documents.

d. Click OK.

The new category is added to the list.
Rename a category a. In the navigation tree, select the category that

you want to rename.

b. Type a new name for the category.

c. Click OK.

The category name is updated.
Delete a category Note that you cannot delete a category that has

sub-categories.

a. In the navigation tree, select the category that
you want to delete.

b. Click Delete.

c. To permanently delete the category, click Yes
in the confirmation dialog box.

Change the folder where
documents in the
selected category are
saved

a. In the navigation tree, select the category
whose default folder you want to change.

b. Click Default Directory

c. Do either of the following:

• Select the folder that you want to use as
the default folder.

• Click Make New Folder to add a new sub-
folder under the currently selected folder.
Then, click the sub-folder to use it as the
default folder.

d. Click OK

5. To close the dialog box, click X in the upper-right corner.

Add document references
You can either upload completely new document references, such as
documents, Microsoft Outlook emails, and Microsoft Outlook email
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attachments to Document Index, or add documents already loaded to
Document Index for the current job.

Add new documents
1. To access the Document Index - By Category dialog box, do either of the

following:

• For Combining, Estimating, Project Management, Production
Control, Purchasing, open the module and click the Document Index
button

• For Inventory, open the module and go to the Inventory ribbon tab
and select Document Index.

The Document Index - By Category dialog box opens.

2. Select the category where you want to save the document.

3. Click Add Document Reference. 

4. In the Document Index - Add Document Reference dialog box, do one
of the following:

• Click Add File. Then, browse for and select the document, and click
Open. If you want to add more documents with the same settings,
click Add Additional File, and browse for and select the additional
files. Then, click Open.

• Drag and drop a file to the Document Index - Add Document
Reference dialog box.

5. From the File Source drop-down list in the Add File dialog box, select the
company and contact that provided you with the document.

6. (Optional) Do one of the following:

• To compress multiple documents into one archive, select the
Compress Files into a Single Archive option.

• To leave the documents that you added uncompressed, select the
Leave Files Uncompressed option.

7. (Optional) Type a description for the attached document.

8. (Optional) To change the folder where the document is saved, click
Browse and select a new folder.

9. (Optional)

• To move the original document to the selected folder, select the Move
Files option.

• To copy the document to the selected folder but leave the original
untouched, select the Copy Files (Leave Original) option.

10. Click Add File.
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11. Click Add Document Reference

The Document Index - Add Document Reference closes, and the documents
are added to Document Index.

You can see all the added documents in the list in the Document Index - By
Category dialog box.

Add a Microsoft Outlook email
1. In Microsoft Outlook, select the email that you want to add.

2. To access the Document Index - By Category dialog box, do either of the
following:

• For Combining, Estimating, Project Management, Production
Control, Purchasing, open the module and click the Document Index
button

• For Inventory, open the module and go to the Inventory ribbon tab
and select Document Index.

The Document Index - By Category dialog box opens.

3. In the navigation tree, select E-mail Correspondence.

4. Click Add Document Reference.

5. In the Document Index - Add Document Reference dialog box, click Add
Outlook Email. 

A copy of the email is added to Document Index. The text of the email is
added to the Description field.

6. (Optional) Type a description for the attached document.

7. Click Add File.

8. Click Add Document Reference

The Document Index - Add Document Reference closes, and the emails are
added to Document Index.

Add an attachment from a Microsoft Outlook email
1. In Microsoft Outlook, select the email with the attachment that you want

to add.

2. To access the Document Index - By Category dialog box, do either of the
following:

• For Combining, Estimating, Project Management, Production
Control, Purchasing, open the module and click the Document Index
button

• For Inventory, open the module and go to the Inventory ribbon tab
and select Document Index.
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The Document Index - By Category dialog box opens.

3. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the attachment.

4. Click Add Document Reference.

5. In the Document Index - Add Document Reference dialog box, click Add
Outlook Attachments.

6. Browse to the folder where you want to save the email attachment, and
click the folder to select it.

7. Click Open.

8. In the Add File dialog box, select the company and contact that provided
you with the email attachment in the File Source lists.

9. (Optional) Do one of the following:

• To compress multiple documents into one archive, select the
Compress Files into a Single Archive option.

• To leave the documents that you added uncompressed, select the
Leave Files Uncompressed option.

10. Type a description for the email attachment.

11. Click Add File.

12. Click Add Document Reference

The Document Index - Add Document Reference closes, and the email
attachments are added to Document Index.

Search for and add a document already in Document Index
To find and add documents for the current job that are already saved in
Document Index, use the Search command.

1. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the document.

2. Click Add Document Reference.

3. In the Document Index - Add Document Reference dialog box, click
Search.

4. In the Search dialog box, click Browse and select the folder where you
want to look for documents. 

TIP To also search from the subfolders of the selected folder, select the
Sub-Directories checkbox in the Search dialog box.

5. To narrow the search, do one or more of the following:

• In the Filename list, type the document name
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• In the Ext field, type the file name extension.

• In the Source lists, select the company and contact person that have
provided the document.

• In File Date, select the dates between which the document has been
created or downloaded onto your computer.

• In Date Loaded, select the dates between which the document has
been added to Document Index.

6. Click Search. 

The search results appear at the top of the Search dialog box.

7. In the search results, double-click the document that you want to add.

The document is added to Document Index for the current job.

Browse for and add a document already in Document Index
To browse to and add documents to the current job that are already saved in
Document Index, use the Find By Directory command. You can also add new
documents, delete existing documents, rename documents and categories,
move documents to other folders, and open documents.

1. In the navigation tree of the Document Index - By Category dialog box,
select the category where you want to save the document.

2. Click Add Document Reference.

3. In the Document Index - Add Document Reference dialog box, click
Find By Directory.

4. In the navigation tree on the left of the Document Index - By Directory
dialog box, select a category. 

The documents within the category are listed in the display area of the
dialog box.

5. Select a document.

6. In the lower-right corner of the dialog box, click Select. 

Note that besides adding an existing document to the current job, you can
also use the buttons at the bottom of the dialog box to:

• Add new documents (Add File).

• Delete a document (Delete File).

• Move a document to another folder within the document index folder
(Move File).

• Rename a document (Rename File).
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• Open a document (Open File).

The document is added to Document Index for the current job.

Edit a document reference
You can modify the source and description of a document in Document
Index.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

2. Select the document that you want to modify.

3. Click Edit Document Reference.

4. In the Document Reference Details dialog box, do any of the following: 

To Do this
Change the source or description of a
file

a. Click Filename.

b. In the File Details dialog box,
select a new source company and
contact person for the file.

c. Adjust the description.

d. Click Save

e. To close the File Details dialog
box, click the Close button (X) in
the upper-right corner.

To change the description of the
entire document reference

a. Adjust the description.

b. Click Save

Note that entering a description in
the Document Reference Details
dialog box will override the file
description that you entered in the
File Details dialog box. To have a
different file description, see Change
the source or description of a file.
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5. To close the Document Reference Details dialog box, click the Close
button (X) in the upper-right corner.

See also

Add document references (page 153)

Open a document (page 159)

Delete a document reference (page 159)

Open a document
Use the Open File command to open and view a document reference.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

2. Select the document that you want to open.

3. Click Open File.

See also

Add document references (page 153)

Edit a document reference (page 158)

Attach a document reference to an email (page 160)

Delete a document reference (page 159)

Delete a document reference
Deleting a document reference from Document Index is permanent and
cannot be undone. If you delete a document reference, you or any other Tekla
PowerFab users will not be able to access the document reference or any
documents, emails, or attachments that it contains from Document Index.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.
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• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

2. In the Document Index - By Category dialog box, select the document
reference that you want to delete.

3. Click Delete Document Reference.

4. To permanently delete the document reference, click Yes in the
confirmation dialog box.

See also

Add document references (page 153)

Edit a document reference (page 158)

Open a document (page 159)

Attach a document reference to an email
You can create a new Microsoft Outlook email and send a document to the
desired recipients via email.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

2. Sselect the document that you want to send via email.

3. Click Email File. 

Microsoft Outlook opens. A new email with the selected document is
created, with the selected document attached to it.

4. Add recipients for the email.

5. Modify the subject and body text of the email.

6. Send the email.
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See also

Add document references (page 153)

Open a document (page 159)

View Document Index history of changes
You can view the history of changes that have been made to the Document
Index.

1. Go to Maintenance --> Document Index --> History of Changes. 

The Document Index - History of Changes dialog box opens.

You can narrow down the search by user and date, and by change area.

2. To view the history, click View History of Changes. 

The history of changes view opens.

4.7 Set up the material database
Before you start working in Tekla PowerFab, it is important to adjust the
material database to match that of your company.

Tekla PowerFab contains a variety of different materials, which are stored in
the material database. These materials are the foundation of all material
calculations in Tekla PowerFab, and therefore adjusting the material database
according to the needs of your company is extremely important.

You can also add any materials that you need to the material database. Note
that you can also add material items that are not steel, from equipment and
consumables to office supplies. Tekla PowerFab accepts a variety of property
formats used to assist with material calculations for weights, pricing, and
surface area for coating.

You can view and manage the materials that have been added to the material
database in the Shape/Grade/Size Maintenance dialog box. You can both
add new materials, and modify, deactivate, or delete existing materials.

Note that when you add new materials to the material database, the materials
still need to be added to the pricing database separately. The pricing database
is where Tekla PowerFab looks for the material dimensions and lengths for
combining materials.

If you add dimensions for shapes by importing, remember to check the
material database for dimensions that do not have complete properties. You
can easily find any dimensions with incomplete properties by creating a zero
weight report. For detailed instructions on creating material reports, see
Create material reports (page 196).

To start managing the materials in Tekla PowerFab:

Configure and use Tekla PowerFab 161 Set up the material database



1. Go to Maintenance --> Shapes/Grades/Sizes.

The Shape/Grade/Size Maintenance dialog box opens.

(1) Shape list: Shows all shapes in the material database. You can see the
shape abbreviation, the description of the shape, the number of material
grades and dimensions, and if the shape is activated. When you select a shape
in the shape list, you can start managing its dimensions, grades, and
abbreviations.

For more information, see Manage shapes (page 163).

(2) Navigation tree: Filter the shapes that are shown in the shape list. You can
expand the categories in the navigation tree by clicking the + signs on the left
side of the categories. For example, if you only want to show shapes that have
material grades, click + on the left side of Has Grades, and select Yes.

(3) Dimensions tab: Add new dimensions, modify dimension properties, add
alternate dimensions and grade overides, show where particular dimensions
are used in Tekla PowerFab, and delete unnecessary dimensions.

For more information, see Manage dimensions (page 186).

(4) Grades tab: Add, modify, or delete grades, and add grade substitutions or
grade redirections.

For more information, see Manage grades (page 180).

(5) Shape Abbreviations tab: Add new abbreviations for shapes. By adding
shape abbreviations, you can ensure that Tekla PowerFab recognizes any
shapes that you import, even if the imported shapes do not use the Tekla
PowerFab standard abbreviations.
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For more information, see Add, modify, and delete shape abbreviations
(page 176).

(6) When you have selected a shape, you can see the material group, weight
calculation method, and cost calculation method, and the cost display units
here. If necessary, you can change the cost display units.

See also

Find shapes, grades, dimensions, or shape abbreviations (page 163)

Find shapes, grades, dimensions, or shape abbreviations
Use the Find commands to find material shapes, grades, dimensions, and
shape abbreviations in the Shape/Grade/Size Maintenance dialog box
without scrolling.

1. In the Shape/Grade/Size Maintenance dialog box, do any of the
following:

• To find a shape, click Find Shape at the bottom of the dialog box.

• To find a material dimension, open the Dimensions tab. Then, select
the shape whose dimensions you want to view in the shape list, and
click Find Dimension.

• To find a material grade, open the Grades tab. Then, select the shape
whose grades you want to view in the shape list, and click Find Grade.

• To find a shape abbreviation, open the Shape Abbreviations tab.
Then, select the shape whose abbreviations you want to view, and click
Find Abbreviation.

2. In the Find dialog box, type the search term in the field. 

Note that when searching for a dimension, you need to leave a space on
both sides of x. For example, 3 x 3 x 1/4.

3. Click OK.

The shape, grade, dimension, or shape abbreviation that you searched for is
selected in the Shape/Grade/Size Maintenance dialog box.

Manage shapes
You can add, delete, activate, and deactivate shapes in the Tekla PowerFab
material database . In addition, you can add grades, dimensions, and
abbreviations for shapes.

NOTE The shape list also contains system shapes that users cannot modify. Many of
these system shapes may be missing some of the actual shape information,
such as material grades or dimensions. These shapes are added for user
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convenience. If necessary, you can add material grades or dimensions for the
shapes, or deactivate the shapes (page 175)

If you want to, you can use separate shapes for materials that may have the
same or similar shape but have different grades. You can use the Tekla
PowerFab system shapes for this purpose: just add the necessary dimensions
or grades for these system shapes.

The shape list in the dialog box in Maintenance --> Shapes/Grades/Sizes lists
all existing shapes in alphabetical order. You can see different details of
shapes:
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• The Shape column lists the abbreviations for the material shape.

Abbreviations are common references that Tekla PowerFab uses to
recognize a particular shape. For example, when you import a bill of
materials, Tekla PowerFab searches for a match in the shape list. If no
match is found, Tekla PowerFab asks you to select one. For example, this
could happen if flat bars were referenced as FL instead of FB.
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The material database also contains shapes that are identical but can be
found under two abbreviations, such as HSS and TS. Both abbreviations are
available in the database to meet the needs of companies that use
different terminology. Note that even though the two options are available,
you should select one of them and use it consistently. This way, you can
avoid problems when combining materials.

The abbreviation is defined when adding a new shape. New abbreviations
can also be added to enable cross-referencing in Tekla PowerFab.

• The Description column shows the name of the shape.

• The Grades column shows the number of grades included for the shape.

• The Dimensions column shows the number of dimensions, or material
sizes, included for the shape.

• The Activated column shows whether a shape is active within Tekla
PowerFab.

Deactivated shapes, marked with No, are not available for combining or
pricing.

See also

Add, modify, and delete shapes (page 166)

Activate or deactivate shapes (page 175)

Add, modify, and delete shape abbreviations (page 176)

Export shapes (page 177)

Add, modify, and delete shapes
The Shape Maintenance dialog box allows you to add new shapes to the
material database. You can also select which dimension properties are used
for the shapes, and permanently delete unnecessary shapes.
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Each shape in the Shape Maintenance dialog box belongs to one of the
following material groups:

• Angles

• Beams

• Plates

• Rods

• Tubes

• None

All material groups have their own dimension property sets that determine
how Tekla PowerFab calculates the dimension properties and estimates labor.

Each shape in Tekla PowerFab has the following properties:

Property Description
Description Each dimension property has a description in both

imperial and metric units.
Dynamic Determines what kind of entries the shape accepts.

If Dynamic is set to Yes, the shape accepts any
entry that the user enters as dimension. If
Dynamic is set to No, the dimensions of the shape
need to be added to the list.

Note that if you select Yes, you cannot assign
weights or other dimension properties for the
shape.
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Property Description
Length Shows if the dimension has length or if the

descriptions contain the length.

If the dimension descriptions contain the length or
the dimension does not have length, Length is set
to No. If the descriptions do not contain the length,
but the dimension has a length, Length is set to
Yes.

Property Shows the weight calculation format of the
dimension.

You can view the details of the format by
expanding the Dimension Format Properties
section and opening the Property Formats tab.

Sur. Area Shows the surface area calculation format of the
dimension.

You can view the details of the format by
expanding the Dimension Format Properties
section and opening the Surface Area Formats
tab.

Note that some shapes also have qualified alternate dimension properties that
you can select to use. In this case, two or more lines are shown for the
selected shape.

• Select the line whose properties you want to use, and click Save Shape to
save the changes.

Add a shape

1. In the Shape/Grade/Size Maintenance dialog box, click the Shape/
Grade/Size Maintenance ribbon tab.

2. On the menu, select Shape Maintenance.
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3. In the shape list of the Shape Maintenance dialog box, select a shape
that has as similar properties as possible to the shape that you want to
add. 

For example, when adding deformed bar anchors, you may want to select
the anchor bolts shape, whose properties are calculated in the same way.
This way, you do not have to modify the shape properties too much.

4. At the bottom of the dialog box, click New Shape.

5. In the Shape field, enter an abbreviation for the shape. 

You can use any abbreviation that is not currently used by another shape.

6. Enter a description for the shape.

7. In the Material Group list, select a suitable group for the shape. 

Note that if you select the None material group, Tekla PowerFab cannot
calculate labor for the shape in the Estimating module.

8. Select the price and weight format for the shape.

9. In the Combining list, select if the shape should be multed, nested, or not
combined at all.

10. If you want Tekla PowerFab to always look for a piece mark association
when importing items of the new shape, select the PDC - Piece Mark
Required checkbox. 

If piece marks are not used, you can leave the checkbox unselected.
Whether you use piece marks or not is defined in your company standard
settings for the Production Control module.

11. If you do not want to allow piece tracking for the shape, select the Exclude
from Instance Tracking checkbox. 

Selecting the Exclude from Instance Tracking checkbox is especially
useful for items like hardware.

12. If you are adding a shape that is also used in the enterprise resource
planning (ERP) software, type the shape designation that is used in that
software in the ERP Designation field.

13. Click Save Shape. 

The new shape is added to the shape list.

Next, you can close the Shape Maintenance dialog box, and add dimensions
(page 188), grades (page 182), additional shape abbreviations, (page 176) and
other properties for the shape according to your needs.

Modify a shape

1. In the Shape/Grade/Size Maintenance dialog box, click the Shape/
Grade/Size Maintenance ribbon tab.

2. On the menu, select Shape Maintenance.
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3. In the shape list of the Shape Maintenance dialog box, select the shape
that you want to modify.

4. Modify the shape properties according to your needs. 

For example, you can change how the shape should be combined, and
which price and weight formats are used.

5. Click Save Shape.

6. To confirm changing the shape properties, click Yes in the confirmation
dialog box.

Delete a shape
You can delete unnecessary shapes from the material database. For example,
you might need to delete a shape whose properties are incorrect. Note that
when you delete a shape in the Shape Maintenance dialog box, the shape
and its properties are permanently deleted from Tekla PowerFab. Shapes that
are currently used somewhere in Tekla PowerFab cannot be deleted.

NOTE We recommend that you deactivate shapes instead of deleting them.
If needed, you can easily start using deactivated shapes by activating
the shapes again.

1. In the Shape/Grade/Size Maintenance dialog box, click the Shape/
Grade/Size Maintenance ribbon tab.

2. In the menu, select Shape Maintenance.

3. In the shape list on the left side of the Shape Maintenance dialog box,
select the shape that you want to delete.

4. At the bottom of the dialog box, click Delete Shape.

5. To permanently delete the shape from Tekla PowerFab, click Yes in the
confirmation dialog box.

Split shapes
You can split shapes to other shapes, particularly wideflange beams to
wideflange tees.

Allow a shape to be split

1. Go to Maintenance --> Shapes/Grades/Sizes. 

The Shape/Grade/Size Maintenance dialog box opens.

2. Click the Shape/Grade/Size Maintenance ribbon tab.

3. On the menu, select Shape Maintenance.
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4. In the shape list of the Shape Maintenance dialog box, select a shape
that you want to split. 

For example, select W Wideflange Beams to be split to WT Wideflange
Tees.

5. Ensure that the Allow Splitting checkbox is selected. 

The Allow Splitting option is available for all linear shapes.

6. Click Save Shape and OK.

Create a split configuration

1. Go to Maintenance --> Shapes/Grades/Sizes The Shape/Grade/Size
Maintenance dialog box opens.

2. Select a shape, for example, the W shape.

3. On the right, open the Splits tab. 

The Splits tab is available only for shapes that have the Allow Splitting
option selected. See Allow a shape to be split (page 170).

Most of the typical W shapes are already set to be split evenly to WT. If you
select different dimensions, you can see under Description the WT sizes
that the W shape has been configured to split to.

4. To create additional split configurations, click Add. 

In the Split Configuration dialog box, create an Equal Split or an
Unequal Split. You can add shapes from what is already in Shape/Grade/
Size Maintenance, or add new sizes for the selected shape.

Note that the Split Configuration dialog box allows any linear shape to
be assigned and does not limit selection to only logical splits.

5. Click Save.

Combining setup for split tees
In the Combining Setup dialog box for each module, under Mult Settings -
Linear Material, there is an option Allow Split T’s.

1. Open a module and open a job.

2. In the ribbon tab, select Combine.

3. Click Mult.

4. Click Optimizations.

5. Go to the Mult Settings - Linear Material tab.

6. Select Allow Split T’s.

7. Click Save.
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Example: Combine WTs to W in a requisition

A requisition has several WT5x15s that need to be cut from W10x30s.

1. Run a combine on the WTs. 

As a result you have close to 80’ of linear material.

2. Switch to Manual Combine Mode.

3. Add a 40’ W10x30. 

Note that the W10 is marked as Combined (C) even though it does not
have any parts assigned to it yet.

4. Right-click the W10x30 and select Split Selected. 

The Split Package dialog box shows the parts that are available to be split
from the selected material.

There are 2 tabs, one for each WT that is being split from the W.
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5. On the first tab, move parts from the Not Included column to the
Included column and vice versa. 

Use the > button for a single item, the >> button for all items, or the Qty>
button to move just the entered Quantity to Add: of the selected item.

A red message will be displayed if you exceed the length of the selected
material. When you are near the limit, changing Quantity to Add: to 1
and using the Qty> and Qty< buttons can help get the most out of the
material.

Parts to combine to Result 1:

Parts to combine to Result 2:
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6. When the split package is ready, click Add to complete the combining. 

7. Click Split Details at the bottom right to view and modify the split
package. 
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You can view the split details in Purchasing reports.

Activate or deactivate shapes
In the Shape/Grade/Size Maintenance dialog box, you can activate and
deactivate shapes to enable or disable using the shapes in Tekla PowerFab.
You can also use the Activated/Deactivated list to select if you want to
display activated, deactivated, or all shapes.

According to your needs, see any of the following instructions:

Deactivate shapes

NOTE We recommend that you deactivate shapes instead of deleting them.
If needed, you can easily start using deactivated shapes by activating
the shapes again.

1. In the shape list, select the shapes that you want to deactivate. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Deactivate Selected Shapes.

3. To confirm deactivating the shapes, click Yes in the confirmation dialog
box.

The deactivated shapes are no longer available for Tekla PowerFab to use in
combining and pricing. You can re-activate deactivated shapes at any time.

Activate shapes

1. In the shape list, select the shapes that you want to activate. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Activate Selected Shapes.

3. To confirm activating the shapes, click Yes in the confirmation dialog box.
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Add, modify, and delete shape abbreviations
Shape abbreviations allow Tekla PowerFab to identify a shape. By adding
shape abbreviations, you can ensure that Tekla PowerFab recognizes the
shapes in any files that you import, even if the files do not use the Tekla
PowerFab standard shape abbreviations.

If you are importing a file and Tekla PowerFab does not recognize an
abbreviation in the file, Tekla PowerFab automatically prompts you to select
the shape and grade that the abbreviation should redirect to. Then, Tekla
PowerFab asks you if you want to add an abbreviation for the imported shape.

We recommend that you keep detailers up to date on the used shape
abbreviations, so that you can minimize the need to create new shape
abbreviations.

According to your needs, see any of the following instructions:

Add a shape abbreviation

1. In the shape list of the Shape/Grade/Size Maintenance dialog box, select
a shape.

2. Open the Shape Abbreviations tab. 

You can see the existing abbreviations for the selected shape in the
Abbreviation list.

3. At the bottom of the Shape Abbreviations tab, click Add Abbreviation.

4. In the Abbreviation field, type a letter combination or a number.

5. Click OK.

The abbreviation is added for the selected shape. If necessary, you can delete
previous abbreviations.

Modify a shape abbreviation

1. In the table of the Shape/Grade/Size Maintenance dialog box, select a
shape.

2. Open the Shape Abbreviations tab. 

The existing abbreviations for the selected shape appear in the
Abbreviation list.

3. In the Abbreviation list, select the item that you want to modify.

4. At the bottom of the Shape Abbreviations tab, click Edit Abbreviation.

5. Modify the abbreviation.

6. Click OK.

The abbreviation is updated.
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Delete shape abbreviations

1. In the table of the Shape/Grade/Size Maintenance dialog box, select a
shape.

2. Open the Shape Abbreviations tab. 

The existing abbreviations for the selected shape appear in the
Abbreviation list.

3. In the Abbreviation list, select the item that you want to delete.

4. At the bottom of the Shape Abbreviations tab, click Delete
Abbreviation.

5. To permanently delete the abbreviation, click Yes in the confirmation
dialog box.

Export shapes
Exporting shape information is useful for making shape identification changes
while keeping all of the information defined in Tekla PowerFab. You can export
either specific shapes or all shapes to the ASCII or XML format.

1. In the Shape/Grade/Size Maintenance dialog box, click the Shape/
Grade/Size Maintenance ribbon tab.

2. On the menu, select Export and the export format.

3. Depending on the export format, do any of the following: 

If you are exporting to Do this
ASCII format (.txt file) a. If you only want to export

particular shapes, in the Filter
dialog box, click the arrow
buttons to move the shapes that
you want to export to the
Included list.

b. Click OK

c. In the Save As dialog box, browse
to the folder where you want to
save the file.

By default, Tekla PowerFab saves
the file to the Export folder.

d. If necessary, change the file
name.

e. Click Save.
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If you are exporting to Do this
ProNest a. In the Save As dialog box, browse

to the folder where you want to
save the file.

By default, Tekla PowerFab saves
the file to the Export folder.

b. If necessary, change the file
name.

c. Click Save.

You can see the progress of the
export in the Status dialog box. After
the export has finished, you can close
the dialog box by clicking OK.

XML format a. In the XML Shapes Export
Options dialog box, select the
checkboxes for the items that
you want to include in the export.

b. Click Export.

c. If you only want to export
particular shapes, in the Select
Shapes dialog box, click the
arrow buttons to move the
shapes that you want to export to
the Included list.

d. Click OK.

e. In the Save As dialog box, browse
to the folder where you want to
save the file.

By default, Tekla PowerFab saves
the file to the Export folder.

f. If necessary, change the file
name.

g. Click Save.

You can see the progress of the
export in the Status dialog box. After
the export has finished, you can close
the dialog box by clicking OK.

SigmaNest a. In the Select Supplier dialog box,
select the supplier warehouse of
the shapes to be exported.
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If you are exporting to Do this
b. Click OK.

You can see the progress of the
export in the Status dialog box. After
the export has finished, you can close
the dialog box by clicking OK.

For the Export To ASCII, Export To ProNest, Export To XML options, the
exported shapes are saved to the selected folder, where you can find them
and import them to the related software.

For Export to SigmaNest, the shapes are imported directly to SigmaNest
through SimTrans.

Example: Changing the shape abbreviation FB to FL by exporting an
ASCII .txt file

For example, you could change a material shape abbreviation for FB (flat bar)
to FL (also an indicator for flat bar). This change can be made outside of Tekla
PowerFab, when you export the shapes into a .txt file. After the change,
the .txt file can be imported back to Tekla PowerFab.

To change the shape abbreviation, do the following:

1. In the Filter dialog box, only move the FB shapes to the Included list.

2. Name and save the file to the desired location.

3. Browse to find the saved file and open it in Microsoft Notepad.

4. Open the Edit menu in the upper-left corner of the Microsoft Notepad
window.

5. Click Replace.

6. In the Find what field, type FB.

7. In the Replace with field, type FL.

8. Click Replace All and save the file.

9. In Tekla PowerFab, click the File tab, and select Import on the File menu.

10. In the navigation tree of the Import dialog box, select Sizes --> ASCII .

11. Click ... to browse for and select the updated file.

12. Click OK.

13. Click Import.

Since the ASCII file only contains the flat bar shapes, you do not need to
filter the shapes. Instead, you can leave all shapes in the Included list.

14. Click OK.

The new shape list is imported to Tekla PowerFab, and the abbreviation of the
flat bars changes.
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See also

Add, modify, and delete shapes (page 166)

Add, modify, and delete shape abbreviations (page 176)

Manage grades
In the Shape/Grade/Size Maintenance dialog box, you can manage the
material grades of shapes in multiple ways. You can add, modify, and delete
grades, set default grades for shapes, and add grade overrides, grade
redirections, grade substitutions, and grade abbreviations.

• To modify grade properties, select the shape whose grades you want to
modify, and open the Grades tab.
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The Shape/Grade/Size Maintenance dialog box shows the different grade
details of the shape:

(1) The Grade list shows all available material grades included for the selected
shape. To view the properties of a specific material grade, select it in the Grade
list.

(2) The default grade of the selected shape. Each shape with grades has a
default grade that Tekla PowerFab uses for the shape by default. The default
grade of the shape is marked with an asterisk (*).
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You can change the default grade by selecting another grade in the Default
list, and clicking Update.

(3) The Substitutions tab shows the existing grade substitutions of the
selected grade. Grade substitutions allow Tekla PowerFab to combine
materials to material grades in the inventory that do not match the material
grades in bills of materials. Grade substitutions can be useful when very little
material of a particular material grade is needed, so another grade can be
used instead.

You can add and delete grade substitutions, and increase or decrease the
order of grade substitutions.

(4) The Redirections tab shows the existing grade redirections of the selected
grade. Grade redirections allow Tekla PowerFab to recognize material grades
that are imported to Tekla PowerFab with names that Tekla PowerFab does not
initially recognize. When you use grade redirections, the imported material
grades are redirected to the appropriate material grades.

(5) The Abbreviations tab shows the grade abbreviations added for the
selected grade. Grade abbreviations are alternative spellings that you can use
for your material grades in Tekla PowerFab.

See also

Add, modify, and delete grades (page 182)

Add grade substitutions (page 184)

Add grade redirections (page 185)

Add, modify, and delete grade abbreviations (page 184)

Add, modify, and delete grades
In the Shape/Grade/Size Maintenance dialog box, you can add material
grades for a selected shape, modify the properties of existing grades, or delete
unnecessary grades.

According to your needs, see any of the following instructions:

Add grades

1. In the Shape/Grade/Size Maintenance dialog box, open the Grades tab.

2. In the shape list, select a shape.

3. At the bottom of the dialog box, click Add Grade.

4. In the Grade Details dialog box, type the new grade in the Grade field.

5. If necessary, modify the weight multiplier.

6. If you use ProNest for nesting, type the ProNest shape to which you want
to associate the grade in the ProNest Shape Designation field.
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7. To save the grade, click Save. 

The material grade is added to the Grade list of the selected shape.

Modify grades

1. In the Shape/Grade/Size Maintenance dialog box, select the Grades
option.

2. In the shape list, select a shape.

3. In the Grade list, select the grade that you want to modify.

4. At the bottom of the dialog box, click Edit Grade.

5. In the Grade dialog box, do one or more of the following to modify the
grade:

• In the Grade field, type a new name for the grade.

• Modify the weight multiplier value.

• To change the ProNest shape to which you want to associate the
grade, type a new name in the ProNest Shape Designation field.

6. Click Save.

The grade properties are updated.

Delete grades

1. In the Shape/Grade/Size Maintenance dialog box, select the Grades
option button.

2. In the shape list, select a shape.

3. In the Grade list, select the grade that you want to delete.

4. At the bottom of the dialog box, click Delete Grade.

5. To permanently delete the grade, click Yes in the confirmation dialog box. 

If a single grade that you are trying to delete is used somewhere else in
Tekla PowerFab, a dialog box opens, showing in which jobs the grade is
used.

If multiple grades that you are trying to delete are used somewhere else in
Tekla PowerFab, notification messages appear, telling you that the grades
are used somewhere else in Tekla PowerFab. Then, deleting the selected
grades is canceled.

6. Do one of the following:

• View where the grades is used, and click OK to close the dialog box
without deleting the grade. You can then change the grade used in the
listed jobs, and delete the grade later.

• If you are sure that you want to delete the grade now, click Force
Delete, select the new grade that will be used elsewhere in Tekla
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PowerFab instead of the grade that you are deleting, and click Perform
Force Delete.

Add, modify, and delete grade abbreviations
Grade abbreviations are alternative spellings that you can use for your
material grades in Tekla PowerFab.

1. In the Shape/Grade/Size Maintenance dialog box, open the Grades tab.

2. In the shape list, select a shape.

3. In the grade list, select the grade whose abbreviations you want to
manage.

4. Open the Abbreviations tab.

According to your needs, see any of the following instructions:

Add a grade abbreviation

1. At the bottom of the Abbreviations tab, click Add.

2. Type the abbreviation.

3. To save the abbreviation, click OK.

The new grade abbreviation is added in the Abbreviation list.

Modify a grade abbreviation

1. In the Abbreviation list, select the abbreviation that you want to modify.

2. At the bottom of the Abbreviations tab, click Edit.

3. Modify the abbreviation according to your needs.

4. To save the abbreviation, click OK.

The modified grade abbreviation is updated to the Abbreviation list.

Remove a grade abbreviation

1. In the Abbreviation list, select the grade abbreviation that you want to
modify.

2. At the bottom of the Abbreviations tab, click Delete.

3. To permanently delete the abbreviation, click Yes in the confirmation
dialog box.

Add grade substitutions
Grade substitutions allow Tekla PowerFab to combine materials to material
grades in the inventory that do not match the material grade in the bill of
materials. Creating grade substitutions can be useful when very little material
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of a certain grade is needed, so another grade can be used instead. Grade
substitutions need to be created separately for each job.

Note that you should only add grade substitutions that meet or exceed the
requirements of the current grade.

1. In the Shape/Grade/Size Maintenance dialog box, open the Grades tab.

2. In the shape list, select a shape.

3. In the Grade list, select a grade.

4. On the right side of the Grades tab, open the Substitutions tab.

5. Click Add.

6. In the Select a substitute grade list, select a grade.

7. Click OK. 

The new grade substitution is added to the list.

8. Use the (+) Use Order and (-) Use Order to move the substitute grade up
or down in the list. This way, you can define the order in which Tekla
PowerFab uses the substitute grades.

If necessary, you can delete substitute grades by selecting them in the
substitution list and clicking Delete at the bottom of the Substitutions tab.

See also

Add, modify, and delete grades (page 182)

Add grade redirections (page 185)

Add grade redirections
Grade redirections allow Tekla PowerFab to recognize material grades that are
imported to Tekla PowerFab with names that Tekla PowerFab does not initially
recognize. When you use grade redirections, the imported material grades are
redirected to the appropriate material grades. For example, if an item to be
imported has the grade A500-GR.B, adding a redirection allows Tekla PowerFab
to recognize the grade and use the A500 grade from the material database.

1. In the Shape/Grade/Size Maintenance dialog box, open the Grades tab.

2. In the shape list, select a shape.

3. In the Grade list, select the grade for which you want to add a redirection.

4. Open the Redirections tab.

5. At the bottom of the Redirections tab, click Add.

6. In the Shape list of the Grade Redirection dialog box, select the shape.

7. In the Grade field, type the grade that should be redirected to the
selected grade.

8. Click Save.
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See also

Add, modify, and delete grades (page 182)

Add grade substitutions (page 184)

Manage dimensions
You can manage material dimensions, or material sizes, in the Tekla PowerFab
material database in several ways. You can add, modify, and delete
dimensions, and add grade overrides or alternates for the dimensions.

• To view and modify dimension properties, go to Maintenance --> Shapes/
Grades/Sizes and, in the Shape/Grade/Size Maintenance dialog box,
open the Dimensions tab .
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The Shape/Grade/Size Maintenance dialog box shows the different details of
dimensions:

(1) Dimension list: View all available dimensions for the selected shape. To
view the properties of a specific dimension, select it in the list.

(2) Alternates tab: View, add, modify, and delete alternate dimensions. When
importing a dimension with a description that Tekla PowerFab does not
recognize, alternate dimensions allow Tekla PowerFab to identify the imported
dimension.
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(3) Properties tab: View the properties of the selected dimension.

(4) Grade Overrides tab: View, add, modify, and delete grade overrides. Grade
overrides allow Tekla PowerFab to assign a specific unit weight for a specific
dimension. Grade overrides should only be used for shapes that do not have
linear unit weights, such as stainless steel.

See also

View the dimensions of a shape (page 188)

Add dimensions (page 188)

Modify dimension properties (page 190)

Modify the properties of multiple dimensions (page 192)

Add grade overrides (page 193)

Add alternate dimensions (page 194)

Show where grades and dimensions are used (page 194)

Delete dimensions (page 195)

View the dimensions of a shape
If necessary, you can hide shapes that do not have material dimensions. To do
so, in the navigation tree on the left, click + on the left side of Has
Dimensions. Then, select Yes.

1. In the shape list of the Shape/Grade/Size Maintenance dialog box, select
a shape.

2. Open the Dimensions tab. 

The existing dimensions for the shape are shown in the Dimension list.

See also

Add dimensions (page 188)

Modify dimension properties (page 190)

Modify the properties of multiple dimensions (page 192)

Add dimensions
You can add material dimensions, or material sizes, to the shape list in the
Shape/Grade/Size Maintenance dialog box.

1. In the Shape/Grade/Size Maintenance dialog box, select a shape in the
shape list.

2. Open the Dimensions tab.

3. Click Add Dimension at the bottom of the dialog box.

Configure and use Tekla PowerFab 188 Set up the material database



4. In the Dimension dialog box, define the dimension properties according
to your needs. 

Note that the available and mandatory fields the Dimension dialog box
vary according to the shape properties.

a. If you want to add a name for the dimension that is used in an
integrated software, type the designation in the ERP Desgn or
ProNest Desgn field.

b. In the Revaluation section, define the revaluation properties
according to your needs. 

The revaluation settings discount the drop material by length by
applying a percentage of the drop cost to the job using the stock
length.

You can set the revaluation calculation to either a percentage of the
original value or a price for each length by selecting an option in the
Calc list. We recommend using the % option because it is easier to
maintain.

For example, the revaluation of a 15'-0 drop might be considered
worth 80% of the original price, and 10'-0 might be worth 50%. These
values are then used for evaluating the remaining stock materials in
the inventory for accounting purposes.

If you want all the drop material below a particular length to be
charged to the job where the original length was used, you can type
the desired length in the Charge Length field. If you want all drop
material to be charged to the job, typing 60' in the Charge Length
usually covers all items.

c. In the Scrap section, set a scrap length. 

Use the scrap length settings to automatically keep your reserved
items and open stock clear of unusable lengths. The material at scrap
length or under is removed from the inventory and moved to the
inventory history. The scrap information is handy in evaluating a
project because it links to Project Summary report in Project
Management. Scrap settings may vary according to material size and
type.

d. In the Combining section, define the kerf, squaring amounts, and
clamp allowance according to your needs. 

Use the Combining settings to automatically calculate any material
length loss due to cutting and other manufacturing requirements.
The values defined in the Combining section are added to the cut
lengths for performing the combining run. Adding the waste involved
with managing materials may help to prevent material shortages.

Defining Combining settings is optional. If these settings are not
defined, return to stock lengths can be adjusted within the Take
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From Stock process while working in the Production Control
module or the Inventory module.

Select the Clamp Allowance from Part checkbox to allow the clamp
allowance to be included in any length of the part that exceeds the
clamp allowance. For example, if 6" pieces cut are cut from a 20' piece
that has a 24" clamp allowance, the 24" would be considered waste.
However, if there was a 36" piece cut with the 6" pieces, the 24" clamp
allowance would be part of the 36" piece.

NOTE The Valid Scrap % field should only be used in conditions
where extreme fine-tuning for the combining of materials is
necessary. This setting is connected to the combining
algorithms of Tekla PowerFab. Set Valid Scrap % to 0 unless
the Tekla PowerFab Support instructs you otherwise.

5. Click Save.

The new dimension is added to the Tekla PowerFab material database and
shown in the Dimension list for the selected shape.

See also

Modify dimension properties (page 190)

Modify the properties of multiple dimensions (page 192)

Modify dimension properties
In the Dimension dialog box, you can modify the different properties of
dimensions. These properties include the revaluation settings, the scrap
length, and the combining settings. The values that you set in the Dimension
dialog box are used for calculating material weight, pricing, and combining, so
accuracy is important.

1. In the shape list of the Shape/Grade/Size Maintenance dialog box, select
a shape.

2. Open the Dimensions tab.

3. In the Dimension list, select the dimension whose settings you want to
modify.

4. Click Edit Dimension.

5. In the Dimension dialog box, modify the dimension properties according
to your needs. 

Note that the available and mandatory fields the Dimension dialog box
vary according to the shape properties.

a. In the Revaluation section, modify the revaluation properties
according to your needs. 
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The revaluation settings discount the drop material by length by
applying a percentage of the drop cost to the job using the stock
length.

You can set the revaluation calculation to either a percentage of the
original value or a price for each length by selecting an option in the
Calc list. We recommend using the % option because it is easier to
maintain.

For example, the revaluation of a 15'-0 drop might be considered
worth 80% of the original price, and 10'-0 might be worth 50%. These
values are then used for evaluating the remaining stock materials in
the inventory for accounting purposes.

If you want all the drop material below a particular length to be
charged to the job where the original length was used, you can type
the desired length in the Charge Length field. If you want all drop
material to be charged to the job, typing 60' in the Charge Length
usually covers all items.

b. In the Scrap section, change the scrap length. 

Use the scrap length settings to automatically keep your reserved
items and open stock clear of unusable lengths. The material at scrap
length or under is removed from the inventory and moved to the
inventory history. The scrap information is handy in evaluating a
project because it links to Project Summary report in Project
Management. Scrap settings may vary according to material size and
type.

c. In the Combining section, modify the combining properties according
to your needs. 

Use the Combining settings to automatically calculate any material
length loss due to cutting and other manufacturing requirements.
The values defined in the Combining section are added to the cut
lengths for performing the combining run. Adding the waste involved
with managing materials may help to prevent material shortages.

Defining Combining settings is optional. If these settings are not
defined, return to stock lengths can be adjusted within the Take
From Stock process while working in the Production Control
module or the Inventory module.

Select the Clamp Allowance from Part checkbox to allow the clamp
allowance to be included in any length of the part that exceeds the
clamp allowance. For example, if 6" pieces cut are cut from a 20' piece
that has a 24" clamp allowance, the 24" would be considered waste.
However, if there was a 36" piece cut with the 6" pieces, the 24" clamp
allowance would be part of the 36" piece.

NOTE The Valid Scrap % field should only be used in conditions
where extreme fine-tuning for the combining of materials is

Configure and use Tekla PowerFab 191 Set up the material database



necessary. This setting is connected to the combining
algorithms of Tekla PowerFab. Set Valid Scrap % to 0 unless
the Tekla PowerFab Support instructs you otherwise.

6. Click Save to update the dimension properties.

See also

Modify the properties of multiple dimensions (page 192)

Add dimensions (page 188)

Add grade overrides (page 193)

Add alternate dimensions (page 194)

Modify the properties of multiple dimensions
Use the Global Edit command to modify the settings of multiple dimensions
of a particular shape at once. For example, using the Global Edit command
can be useful when changing the revaluation settings for all dimensions of a
shape.

NOTE The Global Edit command is only available for shapes that belong to
the Plate and Angle material groups. For other material groups, you
need to modify each dimension separately.

1. In the Shape/Grade/Size Maintenance dialog box, click the Shape/
Grade/Size Maintenance ribbon tab.

2. On the menu, select Global Edit.

3. In the Shape list at the top of the Shapes/Grades/Sizes Global Edit
dialog box, select the shape whose dimensions you want to modify.

4. Click the arrow buttons to move the dimensions that you want to modify
to the Included list.

5. Modify any dimension properties according to your needs. 

For example, you can modify the scrap length or the kerf.

6. Select checkboxes next to the properties that you want to update.

7. Click Update.

The dimensions in the Included list are updated according to the changes you
made.

See also

Modify dimension properties (page 190)
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Update dimension weights for newly added shapes
Use the Global Edit - Dimension Values command to update the unit weights
of material groups when material weight standards change. For example, you
can use the Global Edit - Dimension Values command to update the weights
of newly added shapes. Tekla PowerFab then calculates the weights based on
the existing dimensions.

1. In the Shape/Grade/Size Maintenance dialog box, click the Shape/
Grade/Size Maintenance ribbon tab.

2. In the menu, select Global Edit - Dimension Values.

3. In the list at the top of the Shapes/Grades/Sizes Global Edit - Dimension
Values dialog box, select the desired shape.

4. In the Material list, select the desired material group.

5. In the field on the right side of the Material list, define the weight of the
material.

6. Click the arrow buttons to move the dimensions whose weights you want
to update to the Included list.

7. Click Save.

Add grade overrides
Grade overrides allow Tekla PowerFab to assign a specific unit weight for a
particular dimension. Grade overrides should only be used for shapes that do
not have linear unit weights, such as stainless steel.

NOTE When you add a grade override, the cost to discount is still applied to
the job using the original length of the dimension.

1. In the shape list in the Shape/Grade/Size Maintenance dialog box, select
a shape.

2. Open the Dimensions tab.

3. In the Dimension list, select a dimension.

4. Open the Grade Overrides tab on the right side of the dialog box.

5. Click Add.

6. In the Grade list of the Grade Override dialog box, select a grade.

7. In the Override Unit Weight, type a weight.

8. Click Save.

The new grade override is added to the material database and shown in the
list on the Grade Overrides tab.
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See also

Add dimensions (page 188)

Add grade redirections (page 185)

Add alternate dimensions (page 194)

Modify dimension properties (page 190)

Delete dimensions (page 195)

Add alternate dimensions
If a dimension in a bill of materials that you want to import has a different
description than in Tekla PowerFab, problems might occur when importing the
file. Adding alternate dimensions enables Tekla PowerFab to cross-reference to
the same dimension, and that way, identify the dimension.

1. In the shape list in the Shape/Grade/Size Maintenance dialog box, select
the shape.

2. Open the Dimensions tab.

3. In the Dimension list, select a dimension.

4. Open the Alternates tab.

5. Below the existing alternate dimensions, click Add.

6. Type the description that will cross-reference to the selected dimension.

7. Click OK.

The new alternate dimension is added to the material database and shown in
the Dimension Alternate list.

See also

Add dimensions (page 188)

Add grade overrides (page 193)

Show where grades and dimensions are used
If you cannot delete a grade or a dimension from the material database
because it is used somewhere else in Tekla PowerFab, you can view the jobs in
which the grade or dimension is used.

1. In the shape list in the Shape/Grade/Size Maintenance dialog box, select
a shape.

2. Depending on whether you want to view the jobs that use a particular
grade or a particular dimension, open the Grades or Dimensions tab.

3. Select the grade or dimension.

4. Click the Shape/Grade/Size Maintenance ribbon tab.
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5. In the menu, select Show Where The Selected Dimension/Grade Is
Used. 

A dialog box opens, listing the jobs where the grade or dimension is used.

6. Once you have viewed the locations, click OK to close the dialog box.

You can change the grade or dimension used in the listed jobs, so that it is safe
to delete the selected grade or dimension from the material database.

If necessary, you can also delete the grade or dimension even if it is used
somewhere else in Tekla PowerFab by using the Force Delete command.

See also

Delete dimensions (page 195)

Delete dimensions
If necessary, you can delete existing dimensions from the Tekla PowerFab
material database.

1. In the shape list of the Shape/Grade/Size Maintenance dialog box, select
the shape.

2. Open the Dimensions tab.

3. In the Dimension list, select the dimensions that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click Delete Dimension in the lower-right corner of the dialog box.

5. To permanently delete the dimensions, click Yes in the confirmation dialog
box. 

If a single dimension that you are trying to delete is used somewhere else
in Tekla PowerFab, a notification message appears and allows you to see
where the dimension is used.

If multiple dimensions that you are trying to delete are used somewhere
else in Tekla PowerFab, notification messages appear, telling you that the
dimensions are used somewhere else in Tekla PowerFab. Then, deleting
the selected dimensions is canceled.

6. To view where the single dimension is used, click OK. 

A dialog box opens, displaying the jobs where the dimension is used.

7. Do one of the following:

• View where the dimension is used, and click OK to close the dialog box
without deleting the dimension.

• If you are sure that you want to delete the dimension, click Force
Delete, select the new dimension that will be used elsewhere in Tekla
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PowerFab instead of the dimension that you are deleting, and click
Perform Force Delete.

See also

Add dimensions (page 188)

Manage material reports
While in the Shape/Grade/Size Maintenance dialog box, you can create
various material reports, such as shape lists. After creating the reports, you
can view, print, email, or export them in Tekla PowerFab Report Viewer.

See also

Create material reports (page 196)

View material reports (page 197)

Print material reports (page 197)

Send material reports via email (page 198)

Export material reports (page 198)

Create material reports
You can create various types of material reports in Tekla PowerFab, such as
shape lists and size lists.

1. While in the Shape/Grade/Size Maintenance dialog box, click the Shape/
Grade/Size Maintenance ribbon tab.

2. In the menu, select Reports. 

The Report Filters dialog box opens.

3. To only include specific materials in the reports, in the Report Filters
dialog box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, click the arrow buttons to move the material items
that you want to include in the reports to the Included list.

5. Click OK. 

To further limit the included items, repeat steps 3 to 5 for all necessary
filter types in the Report Filters dialog box.

6. Click Make Report.

7. In the Report Selection dialog box, click the report that you want to
create.

Next, you can view the report, print or export the report, or send the report via
email in Microsoft Outlook.
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See also

View material reports (page 197)

Print material reports (page 197)

Send material reports via email (page 198)

Export material reports (page 198)

View material reports
Once you have created a material report, you can view it in Tekla PowerFab
Report Viewer.

1. Create a report. 

For detailed instructions, see Create reports (page 196).

2. In the Report Selection dialog box, click View.

3. In Tekla PowerFab Report Viewer, do any of the following according to
your needs: 

To Do this
Move between pages • Click the arrows at the top of

Tekla PowerFab Report Viewer.
Go to a specific page of the report • Type the page number in the

empty field at the top of Tekla
PowerFab Report Viewer.

Find a text in the report a. Click the binocular icon.

b. In the blank field, type the text
that you want to find.

c. Click Find Next.

Any matching text is highlighted
with a red box.

Zoom in or out • Click the magnifying glass icon and
select the zoom value in the list.

Once you have viewed the report, you can close Tekla PowerFab Report
Viewer, or print, email, or export the report.

See also

Print material reports (page 197)

Send material reports via email (page 198)

Export material reports (page 198)
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Print material reports
To print a material report in Tekla PowerFab Report Viewer, do the following:

1. Create a report. 

For detailed instructions, see Create reports (page 196).

2. In the Report Selection dialog box, click View.

3. At the top of Tekla PowerFab Report Viewer, click Print Report.

4. Select the printer that you want to use.

5. Define the pages that you want to print.

6. If necessary, modify other printer settings.

7. Click Print.

See also

Send material reports via email (page 198)

Export material reports (page 198)

Send material reports via email
You can send material reports via email as either Microsoft Excel workheets or
PDF files. Note that the Email Excel and Email PDF commands only work with
Microsoft Outlook. If you use some other email service, you need to export the
report and attach it to an email manually.

1. Create a report. 

For detailed instructions, see Create reports (page 196).

2. In the Report Selection dialog box, click View.

3. In the upper-right corner of Tekla PowerFab Report Viewer, click either
Email Excel or Email PDF. 

When the report is ready, the Microsoft Outlook icon appears at the
bottom of the screen.

4. Click the icon to open Microsoft Outlook.

5. Modify the email according to your needs.

6. Send the email.

Export material reports
You might need to export a report, such as a shape list, to send it to the steel
detailer. This way, they will have all the shape information used in Tekla
PowerFab. Having the shape list will minimize the need to create new shape
descriptions and abbreviations, grade abbreviations, substitutions, and
redirections in Tekla PowerFab.
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1. Create a report. 

For detailed instructions, see Create reports (page 196).

2. In the Report Selection dialog box, click View.

3. In the upper-left corner of Tekla PowerFab Report Viewer, click Export
Report.

4. In the Save As dialog box, browse to the folder where you want to save
the file.

5. If necessary, change the file name.

6. If necessary, select another file format in the Save as type list.

7. Click Save.

The report is saved to the selected location.

Change the display units of prices
Use the Change command to change the display units of a shape used in
pricing. Changing the display units is useful for items like HSS, as the pricing is
often by foot rather than by pound or hundredweight. Where applicable,
pricing by item is also available.

1. In the Shape/Grade/Size Maintenance dialog box, select the shape
whose display units you want to change.

2. In the upper-right corner of the dialog box, click Change.

3. In the New Display Units list, select the desired units.

4. Click OK.

The units used in the pricing of the shape are updated.

The selected pricing units are used in requisitions, purchase orders, and
inventory.

4.8 Set up pricing
Before you start working in Tekla PowerFab, it is important to adjust pricing to
match that of your company. We recommend that you set up the Pricing
Maintenance database as early as possible, so that working in Tekla
PowerFab becomes more seamless.

The material database used in Pricing Maintenance contains a variety of pre-
loaded material shapes. However, only the most commonly used shapes are
available in Pricing Maintenance by default.

The missing material shapes should be added to Pricing Maintenance in
order to combine materials in several Tekla PowerFab modules. If the required
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material shapes, grades, sizes, and lengths are not available in Pricing
Maintenance, Tekla PowerFab cannot combine materials.

You can add new shapes, grades, sizes, lengths, and pricing information to the
Pricing Maintenance database.

NOTE You can create and use multiple pricing data sets in Tekla PowerFab.

The pricing data sets are referred to as supplier warehouses in Tekla PowerFab.
Despite their name, supplier warehouses can also represent pricing that is for
pricing tiers or other purposes. Supplier warehouses can be labeled in
different ways according to their purpose.

NOTE The supplier warehouse labeled Warehouse is meant for items that need to
be purchased, not items that are in the company's warehouse.

You can update the pricing of multiple items by importing pricing information
or by using the Global Edit and Global Edit Form commands. You can also
update pricing while working in the Purchasing module, in the Estimating
module, or while creating pricing forms.

See also

Open Pricing Maintenance (page 200)

Add a supplier warehouse (page 217)

Find shapes, grades, and dimensions in Pricing Maintenance (page 201)

Manage material dimensions in pricing (page 202)

Modify lengths and pricing (page 204)

Create pricing forms (page 211)

Create and manage pricing lists (page 212)

Open Pricing Maintenance
In Pricing Maintenance, you can add the material sizes and lengths that you
want to use when combining materials in Tekla PowerFab.

1. Click the Maintenance ribbon tab.

2. On the menu, select Pricing Maintenance.

3. In the Select Supplier dialog box, select a pricing warehouse.

4. Double-click the pricing warehouse, or click Open.

5. In the Pricing Maintenance dialog box, click the + signs to expand the
options in the navigation tree:

• Click + next to a material shape to view its grades.

• Click + next to a material grade to view its dimensions.
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6. Select the material dimension that you want to view or modify.

The properties of the selected material dimension appear on the right side of
the dialog box.

You can also see the shape and grade of the material dimension at the upper-
left corner, and the latest pricing updates at the upper-left corner.

Find shapes, grades, and dimensions in Pricing
Maintenance
You can use the Find Shape/Grade/Size command in the Pricing
Maintenance dialog box to find a particular material shape, grade, or
dimension.
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1. In the Pricing Maintenance dialog box, click Find Shape/Grade/Size.

2. In the Find dialog box, do one of the following:

• Type the name of the material shape, grade, or dimension in the
related field.

• Click the arrow on the right side of the related field, and select the
desired material shape, grade, or dimension in the list.

3. Click Find.

The shape, grade, or dimension is selected in the shape list on the left side of
the Pricing Maintenance dialog box.

Manage material dimensions in pricing
You can manage material dimensions in the pricing database in several ways:
you can add material dimensions either one by one or as groups, copy
dimensions from one material grade to another, or remove unnecessary
material dimensions from the pricing database.

For more information, see the following links:

Add a single material dimension to pricing (page 202)

Add material dimensions to pricing (page 203)

Copy material dimensions from one grade to another (page 203)

Delete material dimensions from pricing (page 204)

Add, modify, and delete material lengths and pricing information for a
dimension (page 205)

Add a single material dimension to pricing
By default, only the most commonly used shapes are available in Pricing
Maintenance. However, you can add new shapes that you need when
combining materials in Tekla PowerFab.

NOTE Only material dimensions that are available in the material database
(page 161) can be added to pricing.

1. Go to Maintenance --> Pricing Maintenance. 

The Select Supplier dialog box opens.

2. Select a supplier and click Open. 

The Pricing Maintenance dialog box opens.

3. Below the Shape list in the Pricing Maintenance dialog box, click Add.
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4. In the Shape list, select the shape whose dimensions you want to add and
click OK.

5. Select the Grade and click OK.

6. Double-click the dimension that you want to add.

7. Ensure that the grade in the Grade list is correct. If not, select the correct
grade in the Grade list.

8. Click OK.

The shape, grade, and size are added to the navigation tree and the pricing
database.

Now, you can add lengths and pricing information for the newly added
dimension. For more information, see Add, modify, and delete material
lengths and pricing information for a dimension (page 205).

Add material dimensions to pricing
By default, only the most commonly used shapes are available in the pricing
database and the Pricing Maintenance dialog box. However, you can add
new material dimensions to the pricing database, if needed.

NOTE Only material dimensions that are available in the material database
(page 161) can be added to pricing.

1. Below the Shape list in the Pricing Maintenance dialog box, click Add.

2. In the Shape list in the Select Shape dialog box, select the shape whose
dimensions you want to add.

3. In the Grade list in the Select Grade dialog box, select the material grade
whose dimensions you want to add.

4. In the Select the sizes to add dialog box, click the arrow buttons to move
the dimensions that you want to add to the Included list.

5. Click OK.

The selected dimensions are added to the pricing database and appear in the
Pricing Maintenance dialog box. Next, you need to add lengths and pricing
information for the added dimensions (page 205).

Copy material dimensions from one grade to another
Use the Copy Sizes command to copy a list of dimensions and their pricing
information from one material grade to another.

1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.

2. On the menu, select Copy Sizes.

3. In the Select the sizes to copy dialog box, click the arrow buttons to
move the dimensions that you want to add to the Included list.
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4. Click OK.

5. In the New Grade list, select the material grade to which the dimensions
will be copied.

6. Click OK.

7. If the new grade already has dimensions in the current supplier
warehouse, select if you want to overwrite the existing dimensions (Yes)
or only add dimensions that do not yet exist in the supplier warehouse
(No). 

A message appears, telling you that the selected dimensions have been
copied to the new grade.

8. Click OK to close the message.

The pricing of the dimensions in the new material grade matches the pricing of
the original material grade. If necessary, update the pricing either item by item
or by using the Global Edit command. For more information, see Add, modify,
and delete material lengths and pricing information for a dimension
(page 205) or Modify the pricing of multiple items (page 208).

Delete material dimensions from pricing
You can permanently delete unnecessary material dimensions and their
pricing information from the pricing database.

1. Go to Maintenance --> Pricing Maintenance. 

The Select Supplier dialog box opens.

2. Select a supplier and click Open. 

The Pricing Maintenance dialog box opens.

3. In the Shape list, do one of the following: 

• To delete one dimension, select the dimension.

• To delete all dimensions of a particular grade, select the grade.

• To delete all dimensions of a particular shape, select the shape.

4. Below the Shape list, click Delete.

5. To permanently delete the dimensions and their pricing information from
the pricing database, click Yes in the confirmation dialog box.

NOTE The dimensions and the material grade are not automatically deleted
from the material database. They need to be separately deleted. For
more information, see Delete dimensions (page 195) and Add, modify,
and delete grades (page 182).
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Modify lengths and pricing
You can add, modify, and delete material lengths and pricing information in
two ways: either one dimension at the time, or by selecting multiple grades
and dimensions of a shape. If necessary, you can also add special prices for
lengths.

For more information, see the following links:

Add, modify, and delete material lengths and pricing information for a
dimension (page 205)

Add a special price (page 208)

Modify the pricing of multiple items (page 208)

Add, modify, and delete material lengths and pricing information for a
dimension
You can add new purchasable material lengths or modify the existing lengths
in Pricing Maintenance. Ensure that you add all lengths that you need when
combining materials in the Tekla PowerFab modules. When adding lengths, it
is important to also define the pricing. Otherwise, Tekla PowerFab will consider
the material free. You can also delete any unnecessary lengths from the
pricing database.
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NOTE To make wholesale changes to multiple dimensions by shape, use the Global
Edit command. For more information, see Modify the pricing of multiple
items (page 208).

Add a material length and its pricing information

1. In the shape list in the Pricing Maintenance dialog box, select a shape
and a dimension. 

The existing lengths of the dimension are shown in the length list on the
right side of the Pricing Maintenance dialog box.

2. Below the length list, click New.

3. If only limited quantities of the material dimension are available, type a
value in the Quantity field. 
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Otherwise, leave the Quantity field blank.

If you do not define a quantity, the Quantity column for the lengths of the
material dimension will show an asterisk (*). This means that Tekla
PowerFab allows an unlimited number of lengths.

4. In the Length field, type the material length. 

For some shapes, you may also need to define the material width.

5. In the Normal Price field, type a price for the dimension. 

TIP You can right-click the Normal Price field to change or convert the
pricing units and currencies.

6. If necessary, type a price in the Special Price field and click Save. 

Note that the price in the Special Price field overrides the price in the
Normal Price field.

7. To determine that the selected dimension is always bought from the
current supplier, select the Always Buy This Size From [Supplier]
checkbox. 

If you select the Always Buy This Size From [Supplier] checkbox for the
material dimension in another supplier warehouse, the Always Buy This
Size From [Supplier] checkbox is automatically cleared in the previous
supplier warehouse.

8. Click Add.

The length and price are added for the selected dimension.

Modify a material length and its pricing information

1. In the shape list in the Pricing Maintenance dialog box, select a shape
and a dimension. 

The existing lengths of the dimension are shown in the length list on the
right side of the Pricing Maintenance dialog box.

2. Select a length in the length list.

3. Modify the length, the quantity, and the pricing properties according to
your needs.

4. To save the changes, click Edit below the length list.

Delete a material length and its pricing information

1. In the shape list in the Pricing Maintenance dialog box, select a shape
and a dimension. 

The existing lengths of the dimension are shown in the length list on the
right side of the Pricing Maintenance dialog box.

2. Select a length in the length list.
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3. Below the length list, click Delete.

4. To permanently delete the selected length and its pricing information
from this supplier in the pricing database, click Yes in the confirmation
dialog box.

Add a special price
If you have selected the Use Special Price option for the selected supplier,
you can add a special price for a material dimension. Note that the special
price overrides the normal price that you have defined for the dimension.

TIP If you want to add the same special price for multiple dimensions at one
go, use the Global Edit command. For more information, see Modify the
pricing of multiple items (page 208).

1. In the shape list in the Pricing Maintenance dialog box, select a shape
and a dimension. 

The existing lengths of the dimension are shown in the length list on the
right side of the Pricing Maintenance dialog box.

2. Type a price in the Special Price field.

3. Under the length information, click Edit.

The special price is saved for the selected material dimension. Note that the
special price will be used instead of the normal price until you remove the
special price.

Modify the pricing of multiple items
Use the Global Edit command to modify pricing, available lengths for linear
items and available lengths and widths for nested items, and to select whether
a material dimension is always bought from a particular supplier.

NOTE When you are using multiple supplier warehouses in Pricing
Maintenance, you need to maintain the pricing of shapes in each
warehouse separately.

The pricing information is used for multing and nesting material in
multiple Tekla PowerFab modules. You can still combine the items
with updated pricing to any inventory or purchase order items, or
manually combine the items in a requisition.

If you are combining material items to the specific supplier warehouse
and the items in the modules do not match with the items that are
available in the supplier's data set, Tekla PowerFab cannot combine
the materials.

1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.

2. On the menu, select Global Edit.
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3. In the Shape list at the top of the Pricing Global Edit dialog box, select
the shape whose grades and dimensions you want to modify. 

The grades and dimensions of the shape appear in the dialog box.

4. In the Grades section, click the arrow buttons to move the grades that you
want to modify to the Included list.

5. In the Dimensions section, click the arrow buttons to move the
dimensions that you want to modify to the Included list.

6. In the Operation list in the lower-light corner, select an option: 

• Increase By Percentage: Increases the prices of the selected items by
a specific percentage.

• Decrease By Percentage: Decreases the prices of the selected items
by a specific percentage.

• Increase By Amount: Increases the prices of the selected items by a
certain sum.

• Decrease By Amount: Decreases the prices of the selected items by a
certain sum.

• Set Amount: Sets the prices of the selected items to a specific sum.

• Set Quantity: Allows Tekla PowerFab to only use a specific number of
the selected lengths.
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• Set Lengths: Allows you to add lengths for the selected items either
one by one or as a range.

• Set Lengths (No Price): Allows you to add lengths for the selected
items either one by one or as a range. No pricing information is added.

• Set Always Buy: Allows you to determine that the selected dimensions
are always bought from the current supplier. To do so, select the
Always Buy From [Supplier] checkbox.

If you select the Always Buy From [Supplier] checkbox for the same
dimensions in another supplier warehouse, the Always Buy From
[Supplier] checkbox is automatically cleared in the previous supplier
warehouse.

When you have selected the operations, the applicable fields are shown at
the bottom of the dialog box.

7. Depending on the operation you selected, modify the pricing information. 

TIP You can right-click the Amount field to change or convert the pricing
units and currencies.

8. Click Save.

Example: Set lengths

1. Select the Set Lengths option.

A length list appears on the left side of the dialog box.

2. Click New.

3. Do one of the following:

To Do this
Add lengths one by one a. If the lengths only apply to a fixed

quantity of items, type the
quantity in the Quantity field.

b. Define the length and the normal
price.

You can right-click the Normal
Price field to change or convert
the pricing units and currencies.

c. Click Add to add the length and
its pricing information to the list.

Add multiple lengths with the same
interval

a. Click Add Range.

b. In the Add Range dialog box,
define the start and end lengths.

c. Define the interval length.
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To Do this
d. If necessary, define the quantity

of items to which the range will
apply.

e. Define the normal price.

TIP You can right-click the
Normal Price field to
change or convert the
pricing units and
currencies.

f. Click Add Range.

4. When you have added all necessary lengths and pricing information, click
Save.

The length and pricing of the selected items are updated.

Create pricing forms
Use the Global Edit Form command to apply group-specific pricing for
different material dimensions. For example, when updating pricing for groups
of HSS shapes, the shapes that are either smaller or larger than the commonly
used dimensions may need different pricing updates. By creating and using
pricing forms, you can update each group of HSS shapes accordingly. You can
create one pricing form that contains multiple shapes whose pricing you want
to update in the current supplier warehouse, or pricing data set.

Creating pricing forms becomes even more efficient when you update the
pricing from a requisition or a purchase order, as you can update multiple
shapes and dimensions at one go.

1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.

2. On the menu, select Global Edit Form.

3. At the bottom of the Global Edit Form dialog box, click New Form.

4. Type a name for the new form and click OK.

5. If another form already exists and you want to copy its content, click Yes
in the confirmation dialog box.

6. On the right side of the Global Edit Form dialog box, click New Price.

7. In the Shape list, select a shape.

8. Click the Start field, and double-click the smallest dimension to which the
new price applies.
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9. Click the End field, and double-click the largest dimension to which the
new price applies.

10. In the Price field, type the price. 

TIP To change the units for the price, right-click the Price field and select
a suitable option.

11. To save the changes, click Save Form. 

Repeat steps 6 to 11 for different dimensions of the selected shape and
other shapes. You can see an example pricing form in the following image.

12. When you have added all the necessary forms and prices, click Perform
Global Edit.

The pricing of the selected items is updated. The pricing forms that you
created are saved for later use.

Create and manage pricing lists
You can view, email, or print the information in a supplier pricing database as a
pricing list. You can filter the pricing list by shape to see a list of pricing for all
dimensions of the selected shape, or leave the pricing list unfiltered to create a
list containing all pricing information.
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Create a pricing list
1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. If you only want to display selected items in the report, select a filter type
in the Type list, and click Select.

4. In the Filter dialog box, click the arrow buttons to move the items that you
want to include in the pricing list to the Included list.

5. Click OK.

6. Click Make Report.

Tekla PowerFab creates the pricing list, and the Report Selection dialog box
opens. Here, you can view, print, or export the pricing list.

View the pricing list
1. In the Report Selection dialog box, click View.

2. In Tekla PowerFab Report Viewer, do any of the following according to
your needs: 

To Do this
Move between pages • Click the arrows at the top of

Tekla PowerFab Report Viewer.
Go to a specific page of the report • Type the page number in the

empty field at the top of Tekla
PowerFab Report Viewer.

Find a text in the report a. Click the binocular icon.

b. In the blank field, type the text
that you want to find.

c. Click Find Next.

Any matching text is highlighted
with a red box.

Zoom in or out • Click the magnifying glass icon and
select the zoom value in the list.

Print the pricing list
1. In the Report Selection dialog box, change the number of printed copies

by clicking the + and - buttons.

2. If necessary, click Select Printer, select which device you want to use for
printing, and click OK. 

You can also select Default Printer to always use the default printer with
this report, or No Printer to reset the used printer.
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3. Click Print.

4. Click Yes.

Export the pricing list
1. Click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

7. To open the file after exporting it, select the Open Exported Document
checkbox.

8. To export the pricing list and save it to the selected location, click Export.

Email the pricing list as an Excel worksheet or a PDF file
Note that the Email Excel and Email PDF commands only allow you to send
the pricing list via Microsoft Outlook email. If you use some other email
service, you need to export the pricing list and attach it to an email manually.

1. In the Report Selection dialog box, click View.

2. In the upper-right corner of Tekla PowerFab Report Viewer, click either
Email Excel or Email PDF. 

When the report is ready, the Microsoft Outlook icon appears at the
bottom of the screen.

3. Click the icon to open Microsoft Outlook.

4. Modify the email according to your needs.

5. Send the email.

Import a pricing list
You can import a pricing list that has been revised by a supplier or that has
user-modified pricing. Pricing lists can be imported either from Microsoft Excel
or from an XML file. During the import, Tekla PowerFab overwrites the current
pricing of the material items in the imported file. The pricing of material items
that are not included in the file does not change.

We recommend that you start by exporting the pricing list from Tekla
PowerFab, modifying it, and importing it back to Tekla PowerFab. By doing so,
you can ensure that the format and header information will match the
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headers in Tekla PowerFab when you import the modified pricing list back to
Tekla PowerFab.

Note that the format of the pricing list that you import needs to match the
pricing format in the pricing list or in the pricing Pricing Maintenance dialog
box.

Import a pricing list from Microsoft Excel

1. Click the Maintenance ribbon tab.

2. On the menu, select Pricing Maintenance.

3. In the Select Supplier dialog box, click the Pricing ribbon tab.

4. On the menu, go to Import Pricing --> Import Pricing From Excel File.

5. In the Open dialog box, browse to find the Microsoft Excel worksheet that
contains the pricing list.

6. Select the file and click Open. 

Tekla PowerFab reads the Microsoft Excel worksheet. Once the reading is
finished, the Verify Excel Import Data dialog box opens.

7. Review the items being imported, and click OK. 
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The Import Field Map dialog box opens.

In the Import Field Map dialog box, the headings of the Microsoft Excel
worksheet need to be mapped to the standard Tekla PowerFab fields.

8. If the values of an item in the Import Field and Tekla PowerFab Field
columns are different, do the following:

a. Select the unmatched Import Field value.

b. On the right side of the dialog box, select a suitable field in the Tekla
PowerFab Field list.

c. Click Set Field Mapping.

Repeat steps a to c for all import fields that are not matched.

9. Click OK to continue.

10. In the Select Supplier dialog box, select the supplier warehouse for which
the new pricing list is imported.

11. Click Import. 

The Import dialog box opens, and Tekla PowerFab continues importing
the information from the Microsoft Excel worksheet.

When the import is finished, the Import dialog box states that the import
is completed. A copy of the import log is automatically saved in the log file
location determined in the Default Directories dialog box.

12. To close the Import dialog box, click the Close button (X) in the upper-
right corner.
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Import from an XML file

1. Click the Maintenance ribbon tab.

2. On the menu, select Pricing Maintenance.

3. In the Select Supplier dialog box, click the Pricing ribbon tab.

4. On the menu, go to Import Pricing --> From XML File.

5. In the Open dialog box, browse to find the XML file that contains the
pricing list.

6. Select the XML file and click Open.

7. In the Select Supplier dialog box, select the supplier warehouse for which
the new pricing list is imported.

8. Click Import. 

Tekla PowerFab imports the items from the XML file. The import process
may take some time.

When the import is finished, the Import dialog box states that the import
is completed. A copy of the import log is automatically saved in the log file
location determined in the Default Directories dialog box.

9. To close the Import dialog box, click the Close button (X) in the upper-
right corner.

Add a supplier warehouse
Use the Pricing Type Maintenance command to add a supplier warehouse,
or pricing set, to the pricing database.

Note that you can also modify and delete existing supplier warehouses in the
Pricing Type Maintenance dialog box.

1. Click the Maintenance ribbon tab.

2. On the menu, select Pricing Maintenance.

3. In the Select Supplier dialog box, click the Pricing ribbon tab.

4. On the menu, select Pricing Type Maintenance.

5. At the bottom of the Pricing Type Maintenance dialog box, click New.

6. In the Description field, type the name of the new supplier. 
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7. If you want the supplier warehouse to allow adding special prices for
material dimensions, select the Use Special Price checkbox.

8. To allow pricing material dimensions in an estimate that do not exist in
the selected supplier warehouse, select the Use next larger size if no
exact match checkbox.

9. If you are using multiple currencies in Tekla PowerFab, in the Currency
list, select the currency that the new supplier warehouse will use.

10. Select the Copy Data From checkbox, and select which existing supplier
you want to use as the basis of the new supplier warehouse.

11. Click Add. 

The new supplier is added to the list.

12. To close the Pricing Type Maintenance dialog box, click the Close button
(X) in the upper-right corner.

The new supplier warehouse is now available in the Select Supplier dialog
box, and you can modify the pricing of the new supplier warehouse according
to your needs.

See also

Manage material dimensions in pricing (page 202)
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Modify lengths and pricing (page 204)

Create pricing forms (page 211)

4.9 Job status maintenance
Job status has various functions. It allows you to group jobs, which makes
reporting more effective. It also allows you to drill down selections, control
automated events, and restrict the availability of jobs in Tekla PowerFab Go.

You can create as many statuses as you want in Tekla PowerFab, but any
status applied to a job has one of the two purposes:

• Open: Active jobs

• Closed: Jobs that are no longer active.

Manage job statuses
You can add, edit, and delete job statuses.

1. Go to Maintenance --> Job Status Maintenance. 

The Job Status Maintenance dialog box opens.
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2. Do one of the following: 

To Do
Add a new status a. Click New.

b. Type in a description.

c. Select purpose.

d. Click Save.
Edit a status a. Select the status that you want to

modify.

b. Modify the status as needed:

• Change the description or
purpose.

• To deactivate the status if it is
no longer required or
applicable, unselect Active.
The status is then not
available when setting the job
status.

c. Click Save.
Delete a status a. Select the status that you want to

delete.

b. Click Delete.

c. To confirm, click Yes.

4.10 Manage taxes and currencies
Before you start working in Tekla PowerFab, you should set the necessary tax
rates and currencies. You can also create tax groups that contain multiple tax
rates.

For more information, see the following links:

Create, modify, or delete tax rates (page 220)

Create, modify, or delete tax groups (page 222)

Add, modify, or delete currencies (page 223)

Create, modify, or delete tax rates
Use the Tax Rates dialog box to define all individual taxes used in your
projects. For example, the state sales tax may consists of a city tax rate and a
county tax rate, and you should enter each tax rate separately. If necessary,
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you can group the associated tax rates into tax groups. In addition to adding
tax rates, you can modify and delete existing tax rates.

1. Click the Maintenance ribbon tab.

2. On the menu, select Tax Rates.

3. In the Tax Rate Maintenance dialog box, do any of the following: 

To Do this
Add a new tax rate a. Click New.

b. In the Abbreviation field, type an abbreviation
code.

The abbreviation code is visible in lists where
you can select the tax rate to be applied.

c. In the Description field, type a description for
the tax rate.

d. Define the state, county, city, and tax rate.

e. In the Tax Rate Applies To section, select what
the tax rate is applied to.

You can also define an up to amount and
select whether the tax rate is cascading.

f. To save the new tax rate, click Add.
Modify a tax rate a. Select the tax rate that you want to modify.

b. Modify the abbreviation, description, state,
county, city, and tax rate according to your
needs.

c. In the Tax Rate Applies To section, select what
the tax rate is applied to.

You can also define an up to amount and
select whether the tax rate is cascading.

d. Click Edit to save the changes.
Delete a tax rate Note that you cannot delete tax rates that are used

somewhere in Tekla PowerFab.

a. Select the tax rate that you want to delete.

b. Click Delete.

c. To permanently delete tax rate, click Yes.

4. When you are finished, do either of the following according to your needs:

• To close the dialog box, click the Close button (X) in the upper-right
corner.

• To group the existing tax rates, click Tax Group Maintenance at the
lower-right corner of the dialog box.
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See also

Create, modify, or delete tax groups (page 222)

Create, modify, or delete tax groups
Creating tax groups that contain multiple tax rates can be helpful for record
keeping. For example, city, county, and state tax rates can be combined into
one group. Tax groups are available in the Purchasing and Order Entry
modules. Creating tax groups is optional, so if you wish, you can define and
use single tax rates instead.

1. To access Tax Group Maintenance, do one of the following:

• Click the Maintenance ribbon tab and in the menu, select Tax Groups.

• At the bottom right corner of the Tax Rate Maintenance dialog box,
click Tax Group Maintenance.

2. In the Tax Group Maintenance dialog box, do any of the following: 

To Do this
Create a new tax group a. Click New.

b. In the Abbreviation field, type an abbreviation
code.

The abbreviation code will be used in lists
where you can select the tax group.

c. In the Description field, type a description for
the tax group.

d. If necessary, type the state, country, or city
that the tax group applies to.

e. Click Add to save the tax group and add it to
the list.

The new tax group is automatically selected.

f. To select the tax rates that you want to add to
the tax group, click Included Tax Rates.

g. Click the arrow buttons to move the tax rates
that you want to include in the tax group to
the Included list.

h. Click OK.

The selected tax rates are added to the selected
tax group.

Modify a tax group a. Select a tax group in the list.
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To Do this
b. Modify the abbreviation, description, state,

county, and city according to your needs.

c. If necessary, click Included Tax Rates to
modify the tax rates included in the tax group.

d. Click the arrow buttons to move the tax rates
that you want to include in the tax group to
the Included list.

e. Click Edit to save the changes.
Delete tax groups Note that you cannot delete tax groups that are

used somewhere in Tekla PowerFab.

a. Select a tax group in the list.

b. Click Delete.

c. To permanently delete tax group, click Yes in
the confirmation dialog box.

3. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Create, modify, or delete tax rates (page 220)

Add, modify, or delete currencies
In the Currencies dialog box, you can add currencies that you need to use in
Tekla PowerFab. You can also set the default currency, modify or delete
existing currencies, and modify exchange rates.

To manage the available currencies, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Currencies.

The Currencies dialog box opens.

Add a currency
1. In the Currencies dialog box, click New.
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2. Define the currency properties: 

Option Description
Abbreviation The abbreviation of the currency. For example, EUR

is the abbreviation for euros.

The abbreviation is used in lists where you need to
select a currency.

Type the abbreviation in the Abbreviation field.
Description The currency name. For example, Euros.

Type the currency name in the Description field.
Display Prefix The currency code or symbol that is displayed

before the sum.

Type the currency code in the Display Prefix field.
Display Suffix The currency code or symbol that is displayed after

the sum.

Type the currency code in the Display Suffix field.
Decimal Places The number of decimal places in the currency.

Type the number in the Decimal Places field.

3. If you want to make the new currency the default currency option, select
the Default Currency checkbox.

4. Click Add.

The new currency is added to the list.

Now, you can modify the exchange rate of the new currency to other
currencies.

Modify an exchange rate
1. In the Currencies dialog box, select the currency whose exchange rates

you want to modify. 

The exchange rates of the selected currency are displayed in the lower-
right corner of the dialog box.

2. Double-click the exchange rate that you want to modify.

3. In the Currency Exchange Rate dialog box, define the exchange rates
from and to the selected currency. 

You can also only define the first exhange rate and automatically calculate
the second one by selecting the Calculate Inverse checkbox.
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4. Click Save.

Repeat steps 1 to 5 for all necessary exchange rates.

Set the default currency
By default, the default currency in Tekla PowerFab is US dollars. However, you
can change the default currency according to your needs.

1. In the Currencies dialog box, select the currency that you want to set as
the default option.

2. Select the Default Currency checkbox.

3. Click Edit to save the changes.

The selected currency is set as the default option.

Note that the Default Currency column of the selected currency now says
Yes.

Modify a currency
1. In the Currencies dialog box, select the currency that you want to modify.

2. Modify the currency properties according to your needs: 

Option Description
Abbreviation The abbreviation of the currency. For example, EUR

is the abbreviation for euros.

The abbreviation is used in lists where you need to
select a currency.

Type the abbreviation in the Abbreviation field.
Description The currency name. For example, Euros.

Type the currency name in the Description field.
Display Prefix The currency code or symbol that is displayed

before the sum.

Type the currency code in the Display Prefix field.
Display Suffix The currency code or symbol that is displayed after

the sum.

Type the currency code in the Display Suffix field.
Decimal Places The number of decimals in the currency.

Type the number in the Decimal Places field.

3. Click Edit to save the changes..
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Delete a currency
Note that deleting a currency is permanent and cannot be undone.

You cannot delete currencies that are currently used somewhere in Tekla
PowerFab.

1. In the Currencies dialog box, select the currency that you want to delete.

2. Click Delete.

3. To permanently delete the selected currency, click Yes in the confirmation
dialog box.

4.11 Import files to Tekla PowerFab
You can import various types of files to Tekla PowerFab. You can import jobs,
requisitions, purchase orders, companies or contacts to the address book,
inventory or inventory history information, assemblies, material dimensions,
labor, and pricing information.

You can import the following file types:

• ASCII files

• BIF files

• IFC files

• ifcZIP files

• KISS files

• KSTK files

• Microsoft Excel worksheets

• SSC files

• txt files

• XML files

NOTE The file types that you can import depend on the location and module into
which you are importing the files.

Importing files
1. Go to File --> Import. 
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The Import dialog box opens.

2. In the navigation tree on the left, select the location where you want to
import a file.

3. Below the location, select the file type that you want to import. 

If a file type is not available below the selected location, you cannot
import that type of a file to the selected location.

For additional help on some import options, you can click the Help button
in the Import dialog box.

4. Click the ... button.

5. In the Open dialog box, browse to find the file that you want to import,
and select it.

6. Double-click the file, or click Open.

7. To import the file, click Import. 

Some import locations have a Test Import button. By clicking Test
Import, you can preview the effects of the import.

What happens next depends on the imported file and the information
within it. You may need to translate shapes and grades, modify the job
information, or select if the new information replaces the information in
an existing job.

If any import errors occur, you can see the error details at the bottom of
the Import dialog box.
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See also Manage changes to a production control job in Tekla PowerFab User
Guide.

Example: Import a new production control job
For information on change management, see Manage changes to a production
control job in Tekla PowerFab User Guide.

1. In the File ribbon tab, open the Import dialog box.

2. In the navigation tree, select Production Control and the file type that
you want to import.

3. Click Import.

4. In the Production Control Job Edit, type the job number and define other
necessary job information. 
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If you want to import drawings along with the production control job, you
can either select an existing job in the Project Management Job list, or
create a new project management job in step 6.

TIP When you first import a job, type a release number in the Release #
field. This way, if you import new items into the job later, Tekla
PowerFab will increase the initial release number.

5. Click Save

6. If you want to create a related project management job with the same job
number, click Yes in the confirmation dialog box. 

If you do not want to create a related project management job, click No.

If you do not create or link a related project management job to the
imported production control job, you will not be able to import any
related drawings.
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If you have selected the Prompt to confirm import fields option in the
Company Standards dialog box in the Production Control module, a
dialog box opens, allowing you to select the information that is imported.

7. Click the arrow buttons to move the information that you want to import
to the production control job to the Included list. 

8. Click OK

9. In the Import dialog box, click ... to select the drawing folder and CNC file
folder, and define the drawing file prefix and suffix, and the CNC file
extension. 

NOTE If you do not define a drawing file prefix or suffix, Tekla PowerFab
expects that the drawing file names match the Tekla PowerFab
drawing numbers exactly. If you use some text in the drawing file
name before or after the drawing number, you should write this
text as the drawing file prefix or the drawing file suffix.

For example, if you use the job number before the drawing number in job
C23487, you should define the drawing name prefix as C23847-. This way,
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Tekla PowerFab can recognize the drawing by matching the remaining
part of the file name. For example, the file name of drawing 100 would be
C23847-100.pdf.

You can also use the wildcard character (*) if the prefix or suffix is not
exactly the same for every file. For example, when importing drawing
revisions, the revision number changes. The first revision of a file might be
C23847-100-r1.pdf, but later revisions of the drawing could also be
imported at the same time. In this case, it could be useful to define the
drawing file suffix as r*.

Note that if you did not create or link a related project management job
(page 844) to the imported production control job, drawings cannot be
imported.

10. Click OK. 

The import begins. Tekla PowerFab alerts you if any files, such as
drawings, are missing.

Note that CNC files are not stores as individual files, but in a table within
the Tekla PowerFab database. If you export CNC files with nesting results
or nesting requests, the CNC files are recreated from the database.

You can see the number of the successfully and unsuccessfully imported
items in the Import dialog box.

Import assemblies and parametric assemblies
Besides labor time, you can also import assemblies and parametric
assemblies. To be imported, the assemblies and parametric assemblies need
to be saved as text files. You can use the imported assemblies and parametric
assemblies in any estimating job.

1. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.
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2. On the File menu, select Import.

3. In the navigation tree on the left side of the Import dialog box, select one
of the following depending on the assembly type:

• Assemblies --> Assemblies

• Assemblies --> Parametric Assemblies

4. Click the ... button.

5. In the Open dialog box, browse to find the text file that you want to
import.

6. Select the file and click Open.

7. Click Import.

8. View the status of the import process. 

If necessary, you can view the import details and errors in a text file by
clicking the Open Import Log button.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

Translate unknown shapes and grades
When you are importing files, such as drawings, to Tekla PowerFab, sometimes
the shapes and grades in the imported files do not match the shapes and
grades in Tekla PowerFab. In these cases, Tekla PowerFab does not recognize
the shapes and grades. To solve the issue, you need to create an item
association that allows Tekla PowerFab to identify the shapes and grades.

We recommend that your administrator sends a list of shapes and grades
used in Tekla PowerFab to the detailers, so that you can ensure that the same
abbreviations are used in the shop detail drawing bill of materials.

If you need to create an item association during the import process, the
Translate Shapes/Grades dialog box opens automatically.

1. In the Translate Shapes/Grades dialog box, select the item that needs to
be translated.

2. Click the arrow on the right side of the New Shape list, and select the
shape abbreviation used in Tekla PowerFab.

3. If necessary, click the arrow on the right side of the New Grade list, and
select the grade abbreviation used in Tekla PowerFab.

4. Click Set Shape/Grade. 

Repeat steps 1 to 4 for all items that are listed in the Translate Shapes/
Grades dialog box.

If you save a shape or grade abbreviation, the shape or grade will not
appear in the Translate Shapes/Grades dialog box when you import files
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in the future. You should only save the shape and grave abbreviations if
the detailer has no intention of conforming to the abbreviations used in
Tekla PowerFab.

5. When you have translated all necessary shapes and grades, click OK to
close the dialog box and continue the import.

NOTE The dimensions matching the properties of the shape are added for
the shape during the import. Remember to review the dimensions
that are added during the import to ensure that the properties of the
shape are completely defined in the Shapes/Grades/Sizes database.

See also

Import files to Tekla PowerFab (page 226)

4.12 Create, modify, and delete automated events
By creating automated events, you can have Tekla PowerFab perform
operations either on demand or automatically according to a set schedule. For
example, you can create automatic reports to stay up to date on the progress
of a project.

1. Click the Maintenance ribbon tab.

2. On the menu, select Automated Events.

The Automated Events dialog box opens.
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Note that the Tekla PowerFab Remote Server must be running in order for
automated events to run as scheduled. For more information on starting the
Tekla PowerFab Remote Server, see Set up Tekla PowerFab Remote Server for
Tekla PowerFab Go (page 41).

If the Tekla PowerFab Remote Server is running normally, the message at the
top of the dialog box is black.

If the Tekla PowerFab Remote Server is not running, the message at the top of
the dialog box is highlighted in red and warns you that automated events will
not be run as scheduled.

Define the outgoing email settings
You need to define the outgoing email settings to receive automatic reports or
failure notifications by email.

1. In the Automated Events dialog box, click the Automated Events ribbon
tab.

2. On the menu, select Outgoing Email Settings.

3. On the Outgoing SMTP Server tab of the Automated Event Email
Settings dialog box, select the Enable Outgoing Email checkbox.

4. Define the host, port, username, password, and sender name and email
address.

5. To test the outgoing email server settings, click Test.

6. On the Failure Notifications tab, type the email addresses to which you
want to send failure notifications.

7. Click Save to save the settings.

Create a report event
1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Report.

4. If you have created a report event, define the event properties as follows:

a. Click the Event Properties button. 
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The Report Event Properties dialog box opens.

b. In the Report Group list at the top of the Report Event Properties
dialog box, select the group to which the reports that you want to
save or send belong.

c. Select the report list that contains the desired report.

d. Click the Select Reports button.

e. In the Select Reports dialog box, click the arrow buttons to move the
reports that you want to include in the automated event to the
Included list.

f. Click OK. 

The selected reports are added to the list on the left.

g. To filter the reports to only include particular items, click Set Filters.

h. To add fields that are not included in the report, click Additional
Report Parameters, and type the missing field names and their
values. 

The format for adding fields is FieldName=Value. For example, to
add a field for cost center and set the value to A123, type 
CostCode=A123.

Note that you need to separate each parameter with a semicolon (;).

i. To change the name of the report file, click Set Export Filename, type
the desired name, and click OK. 

You can view the placeholders available for file names and folders on
the Save to Directory of the Report Event Properties dialog box.
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You can use these placeholders in the file names of reports to ensure
that other files are not overwritten and that the event does not fail
because a report with the same file name is open.

j. At the bottom of the dialog box, select if you want to show the
company logo in the report files, and if you want to compress the
reports into a .zip file.

k. In the Export Format list, select if you want to send or save the
reports as PDF files, Microsoft Excel worksheets, or text files.

l. To send the report by email, on the Send Email tab, select firm type,
company name, and contact person, and click Add Recipient. 

You can add more recipients by selecting a new firm type, company
name, and contact person, and clicking Add Recipient again.

Note that the company and contact person need to exist in the
Address Book. The contact person also needs to have an email
address in the Address Book.

m. To save the report in a folder, on the Save to Directory tab, click
the ... button, select the folder where you want to save the file, and
click OK.

n. To save the settings of the report event, click OK at the bottom of the
Report Event Properties dialog box.

5. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.

Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select checkboxes next to the days when you
want to run the automated event.
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To Do this
e. In the Run At lists, select the time when you

want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

6. To allow Tekla PowerFab to perform the event automatically, ensure that
the Event Enabled checkbox is selected.

7. Click Save to create the automated event.

Create an automated Trimble Connect synchronization
event
1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Publish to Trimble Connect.

4. To send an email if publishing the information to Trimble Connect fails:

a. Click Failure Notifications.
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b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email checkbox and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated database optimization
fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. Click Event Properties.

6. Select which actions happen when the automated event is run: 

• Publish to Organizer: Publish jobs to Trimble Connect Organizer.

• Publish to Status Sharing: Publish jobs to Trimble Connect Status
Share.

• Push Projects: Publish project management jobs to the selected
applications.

You can select which jobs should be published by clicking Set Filter.

• Push Estimates: Publish estimating jobs to the selected applications.

You can select which jobs should be published by clicking Set Filter.

• Push Production Control Jobs: Publish production control jobs to the
selected applications.

You can select which jobs should be published by clicking Set Filter.

7. Click Save to save the actions to be published and the applied filters.

8. To allow Tekla PowerFab to perform the event automatically, ensure that
the Event Enabled checkbox is selected.

9. Click Save to save the automated event.

Create an automated database optimization event
1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Optimize Database Tables.

4. To send an email if the database optimization fails:

a. Click Failure Notifications.
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b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email checkbox and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated database optimization
fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.

Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select checkboxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.
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To Do this
particular day of the
month

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

6. To allow Tekla PowerFab to perform the event automatically, ensure that
the Event Enabled checkbox is selected.

7. Click Save to create the automated event.

Create an automated database backup
Before you start, check the default folder for saving the backup files. See
Default directories (page 38).

1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Database Backup.

4. To send an email if the database backup fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email checkbox and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated database backup fails. 

Note that you need to type each email address on a separate line.
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d. Click Save.

5. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.

Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select checkboxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.
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To Do this
e. In the Run At lists, select the time when you

want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

6. To allow Tekla PowerFab to perform the event automatically, ensure that
the Event Enabled checkbox is selected.

7. Click Save to create the automated event.

Create an automated inventory sync event
Inventory can be synchronized to Tekla PowerFab from either ProNest or
SigmaNest.

1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select ProNest Inventory Sync or SigmaNest
Inventory Sync .

4. To send an email if the automated inventory sync fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email checkbox and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated inventory sync fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

Configure and use Tekla PowerFab 242 Create, modify, and delete automated events



To Do this
c. In the Value field, type the number of hours,

days, or weeks.
Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select checkboxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

6. To allow Tekla PowerFab to perform the event automatically, ensure that
the Event Enabled checkbox is selected.

7. Click Save to create the automated event.
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Create an automated cut list import event
Inventory can be synchronized to Tekla PowerFab from ProNest, SigmaNest, or
Peddinghaus Raptor.

1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select of the following based on the software you
use: 

• ProNest Cut List Import

• SigmaNest Cut List Import

• Peddinghaus iDSTV+ Cut List Import

4. To send an email if the automated cut list import fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email checkbox and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the automated cut list import fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. If you selected the Peddinghaus iDSTV+ Cut List Import option, click
Event Properties, and browse to find and select the directory from which
you want to import iDSTV+ files that contain cut information.

6. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.
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To Do this
Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select checkboxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

7. To allow Tekla PowerFab to perform the event automatically, ensure that
the Event Enabled checkbox is selected.

8. Click Save to create the automated event.
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Create a production status export event
You can export the production statuses of particular projects from Tekla
PowerFab to another Tekla product, SDS/2, or Advance Steel.

1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select Production Status Export.

4. To send an email if the automated production status export fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email checkbox and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the production status export fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. To define the details of the automated event, click Event Properties.

6. If you want to export the production statuses of only particular projects,
set filters:

a. Click Set Filter.

b. In the Project Management Report Filters dialog box, select a filter
type in the Type list, and click Select.

c. In the Filter dialog box, click the arrow buttons to move the jobs or
job groups whose statuses you want to export to the Included list.

d. Click OK to save the filter. 

Repeat steps a to b to d to set all necessary filters.

e. When you have set all necessary filters, click OK to apply the filters.

7. In the Export Recipient list, select the software to which you want to
export the production status information.

8. Click ... on the right side of the Export Directory field, browse to and
select the folder where you want to export the production status
information, and click OK.

9. If you want to include a time stamp in the file name, select Include
Timestamp in Export Filename checkbox.

10. Click Save to save the event details.
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11. Set the reporting frequency: 

To Do this
Create an automated
event that repeats with a
particular interval

a. In the Repeat Type list, select Interval.

The Interval tab opens, allowing you to define
the desired interval.

b. In the Interval Units list, select if the interval
is measured in hours, days, or weeks.

c. In the Value field, type the number of hours,
days, or weeks.

Create an automated
event that repeats on
particular days of the
week

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens on the bottom half
of the dialog box, allowing you to define the
schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Week.

The Day of Week tab opens.

d. Select checkboxes next to the days when you
want to run the automated event.

e. In the Run At lists, select the time when you
want to run the report.

f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

Create an automated
event that repeats on a
particular day of the
month

a. In the Repeat Type list, select Scheduled.

The Scheduled tab opens, allowing you to
define the schedule.

b. Click Add.

c. In the Schedule on list at the top of the
Automated Event Schedule, select Day of
Month.

The Day of Month tab opens.

d. Define the day number.

If you type 31, the automated event runs on
the last date of each month, including the
months with less than 31 days.

e. In the Run At lists, select the time when you
want to run the report.
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To Do this
f. Click Save to save the event schedule.

The Automated Event Schedule dialog box
closes.

12. To allow Tekla PowerFab to perform the event automatically, ensure that
the Event Enabled checkbox is selected.

13. Click Save to create the automated event.

Create an API log check event
Several Tekla PowerFab integrations call for the API. The commands in these
integrations are recorded in the API log. The API Log Check event searches the
API log to find any failed commands since the last log check, and sends an
email with the failed entries to the selected email addresses.

1. In the Automated Events dialog box, click New Event.

2. In the Automated Event Details dialog box, type a title and a description
for the event.

3. In the Event Type list, select API Log Check.

4. To send an email if the API log check fails:

a. Click Failure Notifications.

b. If you have not yet defined the outgoing email settings, do so on the
Outgoing SMTP Server tab. 

You need to select the Enable Outgoing Email checkbox and define
the host, port, user name, password, sender name, and sender email
address. You can also test the outgoing email server settings by
clicking Test.

c. On the Failure Notifications tab, type the email addresses to which
you want to send a message if the API log check fails. 

Note that you need to type each email address on a separate line.

d. Click Save.

5. To send a list of failed entries in the API log in an email:

a. Click Event Properties.

b. Type the email addresses to which you want to send the list of failed
entries in the API log. 

Note that you need to type each email address on a separate line.

c. Click Save.

6. To allow Tekla PowerFab to perform the event automatically, ensure that
the Event Enabled checkbox is selected.
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7. Click Save to create the automated event.

Run an automated event manually
1. In the Automated Events dialog box, select the automated event that you

want to run.

2. Click Run Event Now.

3. To confirm running the event, click Yes in the confirmation dialog box. 

The event is run. Note that the event ID is highlighted with yellow in the
Automated Events dialog box.

The Status dialog box opens, showing the progress of the event.

4. When the event has been run, click OK to close the Status dialog box.

If the event has been run successfully, the Last Run column displays the latest
run time on a green background.

You can view the details of the last run by clicking the Last Event Status
button.

Copy an automated event
1. In the Automated Events dialog box, select the automated event that you

want to copy.

2. Click Copy Event.

3. In the Automated Event Details dialog box, type a title and a description
for the copied event.

4. Modify any other event properties according to your needs.

5. Click Save to save the properties of the copied event.

Modify an automated event
1. In the Automated Events dialog box, select the automated event that you

want to modify.

2. Click Event Properties.

3. In the Automated Event Details dialog box, modify the title and the
description for the event.

4. In the Event Type list, change the type of event according to your needs.
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5. Modify the event properties and the reporting frequency as needed. 

For example, if you do not want Tekla PowerFab to perform the event
automatically, clear the Event Enabled checkbox.

6. Click Save to update the automated event.

View the run history of an automated event
1. In the Automated Events dialog box, select the automated event whose

entire run history you want to view.

2. Click Event Properties.

3. In the Automated Event Details dialog box, click Result History.

4. In the Results dialog box, review the result history of the automated
event. 

If an error has occurred during a run, the Error Message column of the
run is highlighted in red, and a brief description of the error is displayed.

5. To view more details about a particular run and its errors, select the run
and click Details.

6. To close the Results dialog box, click the Close button (X) in the upper-
right corner.

Delete an automated event
Note that deleting an automated event is permanent and cannot be undone.

1. In the Automated Events dialog box, select the automated event that you
want to delete.

2. Click Delete Event.

3. To permanently delete the automated event, click Yes in the confirmation
dialog box.

4.13 Customize Tekla PowerFab
You can customize different information in Tekla PowerFab, including the
display and input fields in various dialog boxes, the menu options for
contextual ribbon tabs, report lists, and reports. You can also create module-
wide filters that can be used for all jobs in a particular Tekla PowerFab module.

See also

Customize display fields (page 251)

Customize input fields (page 253)
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Customize menu options (page 256)

Create and modify module-wide filters (page 261)

Create customized report lists (page 263)

Create user-defined reports for customizing (page 268)

Select metric or imperial mode (page 262)

Customize display fields
You can customize the fields in the display area of Combining, Estimating,
Inventory, Project Management, Production Control, and Purchasing
dialog boxes. For example, you can change the column names and locations,
move columns up and down, or adjust the column width or alignment.

For some modules, you can modify the display fields of the dialog boxes
separately. For example, in the Purchasing module, you can customize the
display fields separately for purchase orders and requisitions. Similarly, in
Project Management, you can modify the display fields of drawings, change
orders, RFIs, and journal entries separately.

1. Click the Maintenance ribbon tab.

2. On the menu, go to the desired module and select a suitable Edit Display
Fields option.

3. In the Display Fields dialog box, click Edit Types.

4. In the left-hand list, select the set of settings that you want to modify.

5. Click the arrow buttons to move the fields that you want to show to the
Included list. 

The fields marked with an asterisk (*) are required fields that need to
always be in the Included list.

6. According to your needs, do any of the following. 

Note that all options may not be available when customizing the display
fields in different modules.

To Do this
Change the
order of the
display fields

a. In the Included Fields list, select the field that you want
to move.

b. Click the Move Up and Move Down buttons to change
the position of the field.

Note that the top item in the list will be the column to
the far left of the display area in the module.

Change the
sort order of

a. In the Included Fields list, select the field whose sort
order you want to change.
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To Do this
the display
fields

b. Click the Sort Order + and Sort Order - to increase or
decrease the sort value of the field.

Modify display
field names,
widths, and
alignment

NOTE Be careful when customizing the names of display
fields. Significant changes to the field names can
prevent you from following the instructions given in
the user guide or by the Tekla PowerFab support.

a. In the Included Fields list, select the field that you want
to modify.

b. Click Properties.

c. Type the desired values in the Display Name and Field
Width fields.

The display name appears in the column header, and
the field width defines the width of the associated
column.

d. Select an alignment option in the Alignment list.

The alignment affects the text alignments within the
associated column.

e. Click OK to save the changes.
Highlight the
input field
corresponding
the selected
display field

• At the top of the dialog box, select the Highlight Input
of Clicked Cell checkbox.

When you work in a dialog box and click a display field, the
corresponding input field is highlighted.

Select how
main pieces are
highlighted in
the Production
Control
module

• At the top of the dialog box, select an option in the
Highlight Main Piece list.

For example, if you select Bold & Italic, you can quickly
identify main pieces at a glance. If you do not want main
pieces to be highlighted in any way, select None.

Add display
types

a. In the lower-left corner of the dialog box, click New.

b. Enter a name for the new set of settings in the
Description field.

c. Click Add.

d. In the left-hand list, select the new set of settings.

e. Modify the settings according to your needs.

f. Click Save.

The changes you made are saved to the new set of
settings.
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To Do this
Revert to the
default settings

• At the bottom of the dialog box, click Set to Default.

7. Click Save to save the changes and then, click the Close button (X) in the
upper-right corner to close the dialog box. 

The fields of the dialog box are updated and will be shown the next time
you open the module.

8. In the Type list, select which settings you want to use by default in the
associated dialog box. 

For example, you can select a set of personalized settings that you have
created.

9. Click Save.

See also

Customize input fields (page 253)

Customize input fields
You can customize the fields in the input area of the Combining, Estimating,
Inventory, Project Management, Production Control, and Purchasing
dialog boxes according to your needs. For example, you can change the places
of input fields, modify their names, change the field widths, and skip fields or
preserve the value of fields when adding more items.

For some modules, you can modify the input fields of the dialog boxes
separately. For example, in the Purchasing module, you can customize the
input fields separately for purchase orders and requisitions. Similarly, in
Project Management, you can modify the input fields of drawings, change
orders, RFIs, and journal entries separately.

1. Click the Maintenance ribbon tab.

2. On the menu, go to the desired module and select a suitable Edit Input
Fields option.

3. In the Input Fields dialog box, click Edit Types.

4. In the left-hand list, select the set of settings that you want to modify.

5. Click the arrow buttons to move the fields that you want to show to the
Included list. 

The fields marked with an asterisk (*) are required fields that need to
always be in the Included list.
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6. According to your needs, do any of the following: 

To Do this
Select if you want to
confirm all changes

• At the top of the dialog box, select the Prompt on
Edit checkbox.

Whenever you make changes in the associated
dialog box, a confirmation dialog box appears and
asks you to confirm the changes. If you do not want
to have to confirm all changes, do not select the
checkbox.

Change the order of
the input fields

a. In the Included Fields list, select the field that you
want to move.

b. Click the Move Up and Move Down buttons to
change the position of the field.

The item at the top of the list will be the top field
in the dialog box.

Change the input
field names NOTE Be careful when customizing the names of

input fields. Significant changes to the field
names can prevent you from following the
instructions given in the user guide or by the
Tekla PowerFab support.

a. In the Included Fields list, select the field that you
want to modify.

b. Click Set Display Name.

c. Type a new name in the field.

d. Click OK to save the new name.
Skip input fields
when using the tab
key in input

a. In the Included Fields list, select the field that the
users can skip.

b. Select the Skip Field checkbox.

The selected field can now be skipped when
inputting information using the tab key. In order to
add information to a skipped field, you need to
click the field.

Preserve the value of
a field when a new
item is added

a. In the Included Fields list, select the field whose
value you want to preserve for new items.

b. Select the Carry Over checkbox.

For example, if you allow carrying over the Shape
field, Tekla PowerFab uses the same shape for new
items until you manually select a different one.
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To Do this

NOTE Some fields cannot be carried over
because the data in these fields is unique
for each item.

To clear the field when adding new items, clear the
Carry Over checkbox.

Keep the additional
labor when a new
item is added

Note that the Carry Over Additional Labor checkbox
is only available when customizing the input fields in
the Estimating module.

• At the top of the dialog box, select the Carry Over
Additional Labor checkbox.Tekla PowerFab uses
the same additional labor for new items until you
manually select a different one.

Keep the standard
clips when a new
item is added

Note that the Carry Over Standard Clips checkbox is
only available when customizing the input fields in the
Estimating module.

• At the top of the dialog box, select the Carry Over
Standard Clips checkbox.

Tekla PowerFab uses the same standard clips for
new items until you manually select a different one.

Change the font size
of the input fields

• In the Font Size field, type a new font size.

Change the input
area width

• In the Input Area Width field, type the width in
pixels.

Change the
navigation tree
width

• In the Navigation Tree Width field, type the width
in pixels.

To make the navigation tree narrower, type a value
that is smaller than the current one, and to make it
wider, type a greater value.

Add input types a. In the lower-left corner of the dialog box, click
New.

b. Enter a name for the new set of settings in the
Description field.

c. Click Add.

d. In the left-hand list, select the new set of settings.

e. Modify the settings according to your needs.

f. Click Save.

The changes you made are saved to the new set of
settings.
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To Do this
Revert to the default
settings

• At the bottom of the dialog box, click Set to
Default.

7. Click Save to save the changes and then, click the Close button (X) in the
upper-right corner to close the dialog box. 

The fields of the dialog box are updated and will be shown the next time
you open the module.

8. In the Type list, select which settings you want to use by default in the
associated dialog box. 

For example, you can select a set of personalized settings that you have
created.

9. Click Save.

See also

Customize display fields (page 251)

Customize menu options
You can customize the drop-down menu options available in the Combining,
Estimating, Inventory, Production Control, and Purchasing modules. For
example, you can add or modify the options visible in the menu, and define
shortcuts to access the different menu commands.

For the Purchasing module, you can customize the menu items separately for
purchase orders and requisitions.

NOTE Be careful when customizing the menu options. Significant changes to
the menu options can prevent you from following the instructions
given in the user guide or by the Tekla PowerFab support.

1. Click the Maintenance ribbon tab.

2. On the menu, go to the desired module and select Menu Setup .

3. In the Menu Setup Types dialog box, select the menu setup that you
want to customize, and click Edit Types.

4. To create personalized menu setup settings, click New. 

With personalized menu setup settings, you can use a menu setup that
meets your personal needs, while the default settings remain untouched.

5. In the Description field, type a name for the personalized settings.

6. To start customizing the menu, click Save.
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7. According to your needs, do any of the following: 

To Do this
Add an existing
item to the
menu setup

a. In the Not Included list, select the item that you want
to add.

b. Click > to include the item to the customized menu
setup.

Remove an item
from the menu
setup

a. In the Included list, select the item that you want to
remove.

b. Click < to remove the item from the customized menu
setup.

Add a text item
to the menu

Text items serve as headings under which you can place
action items, or items that are marked with an asterisk (*).

a. In the Included list, select the item under which you
want to add a text item.

b. Click Add Text Item.

c. Type text for the item.

This text will be visible in the drop-down menu.

d. Click the new text item in the Included list to select it.

e. To add action items under the text item, click an action
item in the Not Included list to select it.

f. Click > to add the item under the new text item.

The action item is moved under the text item.
Add a line to
separate text
items in the
menu

a. In the Included list, select the text item under which
you want to add the line.

b. Click Add Line.

Change the
order of the
menu items

a. In the Included list, select the item that you want to
move in the menu.

b. Click the Up and Down buttons to move the menu
item.

Add a shortcut a. In the Included list, select the item to which you want
to add a shortcut.

b. In the Shortcut list, select a shortcut that you want to
use to access the menu item.

c. Click Update.
Change the
name of a menu
item

a. In the Included list, select the menu item that you
want to rename.

b. Click the Edit Text button.

c. Type a new name for the menu item.
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To Do this
d. Click OK.

8. Click Save to save the changes and then, click the Close button (X) in the
upper-right corner to close the dialog box.

9. In the Type list, select the settings that you want to use when working in
the associated module.

10. Click Save.

The customized menu setup settings are now used.

Customize the layout of a dialog box
You can customize the dialog boxes to display information that is relevant to
you. For example, you can add and remove data columns, change the column
headers and column placement, and add spaces between rows and columns.
It is also possible to create different layouts for different purposes.

1. Open the desired dialog box.

2. Right-click anywhere in the display area of the dialog box. 

A context menu opens.

3. Click Customize grid. 
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The Grid Layout dialog box opens.

4. To create a customized layout, click New Layout.

5. Type a description for the layout.

6. Modify the following properties as needed: 

Option Description
Grid Mode Allows you to select if you want the job list to have

a fixed width or an automatically scaling width.

Click the arrow on the right side of Grid Mode
field, and select a suitable option in the list.

Number of rows per
record

Allows you to have more than one row for each
job, or record. By adding rows, you can place the
job information on multiple rows.

Type the desired number of rows in the Number
of rows per record field.

Default for all users When selected, the layout that you are adding or
modifying will be used as the default layout for all
Tekla PowerFab users.

Current row The row on which you are adding fields. The
Current row only applies if the value in the
Number of rows per record field is greater than 1.

Click the arrow on the right side of Current row
field, and select a row number in the list.

Fixed Columns Allows you to freeze a desired number of columns
from the top of the list, so that you can see them
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Option Description
all the time when you scroll across different
columns.

Type the number of columns that you want to
freeze in the Fixed Columns field.

7. In the Available Fields list, select the columns that you want to include in
the dialog box, and click the arrow buttons to move them to the Included
Fields list.

8. Do any of the following: 

To Do this
Add an empty column • On the right side of the dialog box, click Add

Empty.

An empty entry appears at the bottom of the
list. This means that the empty column is the
rightmost column in the selection dialog box.

If necessary, you can still modify the location of
the empty column.

To remove the empty field, move it to the
Available Fields list.

Change the order of
columns

a. In the Included Fields list, click the column
that you want to move left or right.

b. Click the Move Up and Move Down buttons to
move the column according to your needs.

Note that the top field represents the leftmost
column in the selection dialog box. Similarly,
the bottom field represents the rightmost
column in the dialog box.

Change the sort order of
columns

a. In the Included Fields list, click the column
whose sort order you want to change.

b. Click the Sort Order + and Sort Order - to
increase or decrease the sort value of the field.

Modify the column
name, width, style, and
alignment

a. In the Included Fields list, click a column to
select it.

b. Click Properties.

c. Type the desired values in the Display Name
and Width fields.

The display name appears in the column
header and the field width defines the width
of the associated column.
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To Do this
d. To modify the style of the column header, in

the Style section, select any checkboxes
according to your preferences.

e. Select an alignment option in the Alignment
list.

The alignment affects the text alignments
within the associated column.

f. If you want to hide all values in the column,
select the Hide Display checkbox.

g. Click OK to save the changes.

9. To save the customized layout, click Save Layout.

10. To use the layout in the selection dialog box, click Apply Layout. 

You can revert to the default layout or the current layout at any time by
clicking the Use Default State and Use Current State buttons.

Create and modify module-wide filters
You can create module-wide filters that are available for all jobs in a particular
Tekla PowerFab module. Module-wide filters are available for the Combining,
Estimating, Production Control, Project Management, and Purchasing
modules. In the Purchasing module, you can create module-wide filters
separately for requisitions and purchase orders.

To start managing module-wide filters:

1. Click the Maintenance ribbon tab.

2. On the menu, go to the desired module or job type, and select Global
Filter Types. 

For example, to create filters for requisitions, select Requisitions -->
Global Filter Types.

The Filter Types dialog box opens.

Create module-wide filters
1. In the Filter Types dialog box, click New.

2. In the Filter Type Description field, type a description for the filter.

3. Select a filter type in the Type list, and click Select.

4. Click the arrow buttons to move the items that you want to include in the
filter to the Included list.
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5. Click OK. 

Repeat steps 3 to 5 to define all values that you want to include in the
filter.

6. When you have added all necessary values, click Add.

The new filter is saved for the related Tekla PowerFab module.

To use the filter:

1. In an open job, click the contextual ribbon tab.

For example, in an estimating job, click the Estimating ribbon tab.

2. On the menu, select Filter.

3. In the Filter Types list, select the new filter.

Modify module-wide filters
1. In the Filter Type list, select the filter that you want to modify.

2. If necessary, change the description in the Filter Type Description field.

3. Select a filter type in the Type list, and click Select.

4. Click the arrow buttons to move the items that you want to include in the
filter to the Included list.

5. Click OK. 

Repeat steps 3 to 5 to define all values that you want to include in the
filter.

6. When you have made the necessary changes, click Save.

Delete module-wide filters
1. In the Filter Type list, select the filter that you want to delete.

2. Click Delete.

3. To permanently delete the filter, click Yes.

Select metric or imperial mode
You can choose to display material dimensions, lengths, weights, prices, or all
previously mentioned information in either imperial or metric units in various
dialog boxes in Tekla PowerFab.

1. In Combining/Estimating/Inventory/Production Control/Purchasing,
open a job/requisition/purchase order.

2. Click the module-specific ribbon tab to open the context menu. 
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3. On the menu, select Switch To Metric/Imperial Mode.

4. On the extended menu, click an item whose mode you want to switch. 

If you select the Switch To Metric Mode or Switch To Imperial Mode
option, all information in the dialog box is switched to the mode that is
not currently active.

Create customized report lists
You can create customized report lists for different Tekla PowerFab users, so
that each user can view their most used reports by default. You can also add
user-defined reports in the report lists.

Note that report lists need to be created separately for each Tekla PowerFab
module.

1. In any Tekla PowerFab job, click the associated ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include particular information in the reports, in the Report Filters
dialog box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the information that you want to
include to the Included list.
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• Type the maximum and minimum values for the items that you want
to include.

5. Click OK.

6. Depending on the dialog box that opens, do the following:

• In the Report Selection dialog box, click Edit Report Types.

• In the Report Progress dialog box, click Edit.

The Report Types dialog box opens.

Create a report list
1. At the bottom of the Report Types dialog box, click New.

2. Type a description for the report type list. 

For example, you can type the user's name.

3. If you have created multiple companies in the Company Information
dialog box, click the arrow on the right side of the Company Setup list
and select the company that you want to include when creating reports.

4. Click the arrow buttons to move the reports that you want to include in
the report list to the list on the right side of the dialog box. 

The reports on the left side of the dialog box are not displayed in the
report list.

5. To modify the reports in the list, do any of the following: 
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To Do this
Change the report name The report name determines what the report is

called in the Report Selection or the Report
Progress dialog box.

a. Select the report in the list on the right side of
the dialog box.

b. Click Set Name.

c. In the Enter Value dialog box, type a new
name for the report.

d. Click OK to save the new report name.
Change the report title The report title is displayed at the top of the report

when you view, print, or export the report.

a. Click Set Title.

b. In the Enter Value dialog box, type a new
name for the report.

c. Click OK to save the new report title.
Move the report up or
down in the report list

a. Click the Move Up and Move Down buttons
until the report is in the desired location in the
report list.

Change the default
number of printed
copies

a. Select the report in the list on the right side of
the dialog box.

b. Click the + and - buttons until the report has
the desired number of copies.

Change the printer used
when printing the report

a. Select the report in the list on the right side of
the dialog box.

b. Click Select Printer.

c. In the Select Printer dialog box, click a printer
to select it.

d. Click OK to save the printer settings.
Create a custom report
and add it to the report
list

a. Click User-Defined Reports.

b. In the User-Defined Reports dialog box, click
New.

c. Select the report that you want to use as the
basis of the user-defined report.

d. Click Select Base Report.
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To Do this
e. Define the report name and title.

The report name determines what the report
is called in the Report Selection or the
Report Progress dialog box.

The report title is displayed at the top of the
report when you view, print, or export the
report.

f. Click Add.

g. To close the User-Defined Reports dialog
box, click the Close button (X) in the upper-
right corner.

h. Click the arrow buttons to move the custom
report to the list on the right side of the
Report Types dialog box.

6. Click Add.

The report list can now be selected in the left-side pane of the Report
Selection dialog box or the Report List list in the Report Progress dialog box.

Set the default report list
A default report list is the report list initially displayed in the Report Selection
or Report Progress dialog box. To change the default report list, do the
following:

1. In the left-hand pane of the Report Types dialog box, select the report list
that you want to set as the default option.

2. Click Set as Default.

3. To confirm using the selected report list as the default option, click Yes in
the confirmation dialog box.

Modify a report list
1. In the left-hand pane of the Report Types dialog box, select the report list

that you want to modify.

2. If you have created multiple companies in the Company Information
dialog box, click the arrow on the right side of the Company Setup list
and select the company that you want to include when creating reports.

3. Click the arrow buttons to move the reports that you want to include in
the report list to the list on the right side of the dialog box. 

The reports on the left side of the dialog box are not displayed in the
report list.
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4. To modify the reports in the list, do any of the following: 

To Do this
Change the report name The report name determines what the report is

called in the Report Selection or the Report
Progress dialog box.

a. Select the report in the list on the right side of
the dialog box.

b. Click Set Name.

c. In the Enter Value dialog box, type a new
name for the report.

d. Click OK to save the new report name.
Change the report title The report title is displayed at the top of the report

when you view, print, or export the report.

a. Click Set Title.

b. In the Enter Value dialog box, type a new
name for the report.

c. Click OK to save the new report title.
Move the report up or
down in the report list

a. Click the Move Up and Move Down buttons
until the report is in the desired location in the
report list.

Change the default
number of printed
copies

a. Select the report in the list on the right side of
the dialog box.

b. Click the + and - buttons until the report has
the desired number of copies.

Change the printer used
when printing the report

a. Select the report in the list on the right side of
the dialog box.

b. Click Select Printer.

c. In the Select Printer dialog box, click a printer
to select it.

d. Click OK to save the printer settings.

5. Click Edit to save the changes.

To create customized reports and add them to report lists in Tekla PowerFab,
see Create user-defined reports for customizing (page 268).

Delete a report list
Note that deleting a report list is permanent and cannot be undone.

1. In the left-hand pane of the Report Types dialog box, select the report list
that you want to delete.
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2. Click Delete.

3. To permanently delete the report list, click Yes in the confirmation dialog
box.

Customize reports
Reports are template files that are used to display the filtered information
from the Tekla PowerFab database. You can customize not only the reports
themselves, but also the reports that individual users see.

You can add a customized report to Tekla PowerFab by selecting an existing
report that you want to use as the basis of the new report and adding a new
template file name in Tekla PowerFab. You can also edit existing reports.

Adding a user-defined report for customizing ensures future access to the
default reports in the program. Copying the report file to the Custom Report
directory replaces the existing report within the program instead of adding a
new report.

Tekla PowerFab automatically looks for the template first in the Custom
Report folder set in the Default Directories dialog box, and after that, in the
C:\Program Files (x86)\Tekla PowerFab\Reports folder.

You can create either Crystal or Stimulsoft reports. Information on the editor
can be found on the report types website. For more information, see:

• Crystal Reports

• Stimulsoft

See also

Create user-defined reports for customizing (page 268)

Customize and manage Stimulsoft reports (page 271)

Create user-defined reports for customizing
In Tekla PowerFab you can customize the reports themselves and the reports
that individual users see.

1. In the module of your selection, go to the active drop-down menu, select
Reports and click Make Report

2. In the upper-left corner of the dialog box, click Edit Report Types.

3. At the lower-right corner of the Report Types, click User-Defined
Reports. 
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4. In the User-Defined Reports dialog box, click New.

5. In the Select Base Report dialog box, double-click the report that you
want to use as the basis of the new report. 

The base report contains all the correct tables and information for the
new report. Therefore, select an existing report and modify it.

If another party creates a user-defined report from within the program,
the report template file name that you have received indicates which base
report you must select.
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When you have selected the base report, the file name of the base report
appears at the bottom of the User-Defined Reports dialog box.

6. Type the desired name and title for the new report.

7. In the Filename field, type the desired file name for the new report.

8. Click Add.

9. To close the User-Defined Reports dialog box, click the Close button (X)
in the upper-right corner.

10. In the Report Types dialog box, click the > button to move the customized
report to the Included list.
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11. Click Edit to save the changes.

12. If the file was created from an outside source, save the new report
template in the Custom Report folder with the file name that you defined
in the User-Defined Reports dialog box. 

This overwrites the report file name created for the new report that was
displayed in the User-Defined Reports dialog box.

The customized report is now available in Tekla PowerFab.

See also

Create customized report lists (page 263)

4.14 Customize and manage Stimulsoft reports
The Stimulsoft report designer in Tekla PowerFab allows you to edit reports
without the need to own a Crystal Reports application.

Before modifying existing reports it is worth considering creating a new user-
defined report to work with to learn the basics of the editor. See Create user-
defined reports for customizing (page 268).

For full documentation of the report editor, see Stimulsoft User Manual.

Open the report editor
1. Open a job/requisition/purchase order. The module-specific ribbon tab

appears.

2. On the drop-down menu, select Reports. 

3. Select filters and click Make Report. 
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The Report Selection dialog box opens.

4. To open the report editor, click Design. 

NOTE The button is enabled only if the report has been converted to
Stimulsoft.

Modify report properties
There are two tabs with settings that are related to editing and designing
reports.

1. Go to File --> Options.
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2. On the Main tab, we recommend selecting Show 'Insert' Tab. 

3. On the Design tab, we recommend the following options: 
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Show Headers: Displays report headers and footers

Show Rulers: Displays the ruler at the top of the design page

Show Order: Order is the sequence in which elements in a band are
processed. The order of processing can affect results for items that rely on
each other.

Show Grid: Turn grid on and off

Align to Grid: When selected, controls are automatically aligned to the
nearest grid lines when they are moved.

Set up toolbox
1. Go to Insert --> Setup Toolbox 
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2. Select the items that you want to appear in the toolbox and on the Insert
ribbon tab.

Report panels
The three available report panels provide several tools for modifying reports.

1. When editing a report, go to Page --> Panels. 

2. Select one of the panels to modify the properties.

Properties
You can edit the properties for the currently selected item on the report. Each
type of component has its own selection of properties that are available for
editing.

In the settings for Properties, you can select between Basic, Standard, and
Professional.
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Dictionary
The Dictionary provides a tree-view control that provides access to the
following:

• The data tables which are used to generate the report.

• The system and custom variables, to store custom data and calculations.
See Stimulsoft report variables (page 287)

• Functions, which are used for calculations and formatting of data.

Report tree
Report Tree allows you to navigate between the elements in a report. You can
select report headers, groupings, and subreports. It can also be used to find
any named elements in the report.

By default, Report Tree displays components and events. Components are
elements in the report such as page headers, text fields, and labels. The events
shown here are managed on the Events tab of the Report Tree panel.

The report tree in the image shows both components, such as Page 1 and
PageHeaderBand1.

The Before Print event of the PageHeaderBand1 control also contains code.
When you double-click the event, it opens the text editor for the event.
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Modify Stimulsoft report appearance
On the toolbar, you can select various formatting options for the text fields.

1. To format text fields, go to the Home ribbon tab. 

a. Select an item on the report. 

To apply changes to multiple items at once, hold down Shift and
select the items you want to modify.

b. Select a formatting option on the toolbar. 

For example, you can select font, font size and style, text alignment,
and background and foreground colors. You can also specify borders
using the toolbar for single or multiple controls.

2. To align components when moving fields and labels, go to the Layout
ribbon tab.

a. Select multiple components. 

The first component that you select determines the position of the
other components.

b. Click Align. 
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c. Select an option on the drop-down menu.

You can also modify the position, appearance, behavior, and design of the
components on the Properties tab in Page --> Panels --> Properties.

Manage Stimulsoft report fields
You can add new fields to a Stimulsoft report, and move existing fields and
adjust their size.

Move and modify existing fields

To Do this
Move an existing field Select and drag the field to a new

location.

By default, components snap to the
displayed grid for easy alignment.

Adjust field size and alignment Select a field and adjust its alignment
and dimensions in the Position
section in Page --> Panel -->
Properties.

Add a new field
To add a new field, do the following:

1. Select an existing component.

2. Do one of the following:

• Copy and paste:

a. Right-click the component and select Copy on the context menu.

b. To paste the component, select the new location, right-click to
display the context menu, and select Paste.

• On the Insert ribbon tab, select a component and drag it to the
desired location.

• Select a component, press Ctrl, and drag a copy of the selected
component to the desired location.

3. To move the component, click the new location.

4. To rename the component, select a component, and do either of the
following:

• Double-click the component and enter a new name in the editor that
appears.
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• Right-click the component, select Design on the context menu, and
enter a new name in the editor that appears.

Ensure that the Expression option is selected

View data fields
To display the data available to the report, do the following:

1. Select an existing component and right-click it.

2. Select Design on the context menu. 

The editor opens.

3. Go to the Data Column tab.

The data available to the report is displayed.

Data field examples

It is important to understand the data relationships that are displayed.
Relations are links to other tables defined by matching record data from one
table to the other so that the correct records are associated to each other.

To retrieve data, not in the data source but in a relation created to other
tables, you need to start in the data source assigned to the detail band in the
report.

Example 1:
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In this example, to retrieve the shape description that is not in the
RequisitionItems data source, expand the RequisitionItems table. Then
expand the associated data relation for Shapes2. Then you can select the
description for the shape.

When you click Expression, the the above is displayed as 
{RequisitionItems.Shapes2.Description}
Example 2 for a Production Control project:

The report is based on the table ProductionControlItems.

It is possible to use the links for this table to link to other tables and pieces of
other information.

The use of these navigation properties makes it possible to use a link from the
ProductionControlItems table to get to the table ProductionControlJobs,
and then access fields in that table that are not present in the
ProductionControlItems table.

When you click Expression, the above is displayed as 
{ProductionControlItems.ProductionControlJobs.JobNumber}.

Combine text and data components
It is possible to combine label text and a data field. Braces identify the portion
of the expression that is a formula or components of the data source. Items
outside the braces are treated as pure text
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In the above example the Expression would be the following:

Req#: {RequisitionItems.Requisitions.RequisitionNumber}
When the report is run, this shows the text ‘Req#:’ and then the requisition
number.

Stimulsoft report data band
Each report needs a data band, which must have a data source specified. This
is the main data table that is used to iterate through the records.

You do not need to have any components in the data band, the report will still
process each record without one.

Filter data
1. Do either of the following:

• Right-click the data band and select Design in the context menu..

• On the data band, click the Filters button and select Design.

2. Click Filters.

3. Click Add Filter. 

Configure and use Tekla PowerFab 281 Customize and manage Stimulsoft reports



4. Select the appropriate values. 

See example:

Field Is = Value

Data Type = Numeric (because the chosen field is a numeric field)

Column = Quantity (field chosen from the list of fields from the data band
data table)

Selected ‘greater than’ from the list.

0 as the value

This filter specifies that only data rows with a quantity greater than zero
are shown.

To remove any unneeded filters, click  in the upper-right corner of the filter.

Stimulsoft report group headers and footers
Group headers group and sort the data by a specified field. A group header
should always have a corresponding footer and both should be named to keep
the report manageable.

For a bill of material report, for example, you can create a group header for
Shape, Dimensions, Grade, Width, and Length each. In the report, you then
have a table that displays the material by these groupings.

You can also use group headers to specify page breaks. You can, for example,
start a new page for each material shape or project.

Group headers and footers are the place to put summarized data. For
example, a Dimensions footer can be set to show the material quantity and
weight totals for each material size.

Specify a data field for Condition
A group header needs to have a data field specified for its Condition property.

To specify the data field, do the following:

1. Select the header and right-click it. 

A context menu opens.

2. Select Design.

3. On the Data Column tab, select the data field.
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For more information on properties, see Report panels in Customize and
manage Stimulsoft reports (page 271).

Add a Group header
To add a Group header, do either of the following

• On the Insert tab, click Bands.

1. On the drop-down menu, select and hold Group Header.

2. Drag the new header to its location.

• On the Insert tab, click Setup Toolbox.

1. Select Group Header. Group Header appears in the toolbar.

2. Select and hold Group Header and drag it to its location.

To reverse the sort order for the group, select Descending in Sort Direction in
the Data section of properties.

Stimulsoft Sub-Reports
A Sub-Report is a secondary report within the current report. It allows the
secondary report to be run with data from another table but linked to the
current item in the main data band.

You can create subreports with all the components of a regular report, that is,
group headers and footers, and filters on the data band.

Create a Sub-Report
1. On the Insert ribbon tab, select Component --> Sub-Report. 
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2. To place the Sub-Report on the current report, click a suitable location. 

A new tab appears for the subreport.

3. To name the subreport, double-click the tab, and type a name in the
Name field. 
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4. Click OK.

5. On the new subreport tab, to add a data band, click Insert --> Bands -->
Data. 

See also Stimulsoft report data band (page 281).

6. Right-click the new data band and select Design.

7. On the Data Source tab, specify which table this report is using.

8. On the Relation tab, specify the relation to the parent data table.

9. The Master Component tab specifies the parent data band.

Sub-Report example
The Production Control report Bill of Material (ProductionControl001.mrt)
uses a subreport to display the sequencing information for each main mark.

The SequenceSubReport is only enabled if the piece is flagged as a MainPiece
in the BeforePrint Event of the DataBand.

The SequenceSubReport handles the formatting of the displayed sequencing.

Add images and watermarks to a Stimulsoft report
You can add images and watermarks to your Stimulsoft report.
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Add images
You can add company logos or user signatures as image files to the report.

1. Do either of the following:

• On the Insert ribbon tab, select Components --> Image.

• In the tooldbar, click Image.

If you do not have the button, click Setup Toolbox and select Image.

2. Select a location for the image.

3. Select an existing image from the Gallery or load an image from a file. 

Use the property File to specify where to load the file from. Ensure that
this location is available to other users if needed.

Add a watermark
1. On the Page ribbon tab, click Watermark. 

2. Type a text or add an image. 

To adjust the text and image properties, click More Options.

The watermark appears on all pages of the report.

Stimulsoft report events
Many reports use code within events in the program to calculate custom
variables for the report or to provide formatting of data.

Events use code in the C# language.

Display events with code
The report editor displays which components have code related to them and
also which event the code is located in.
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1. To enable this display, do either of the following:

• On the File ribbon tab, select Options.

a. On the Quick Info tab, select Show Events.

b. Click OK.

• On the Page ribbon tab, select Panels --> Report Tree.

a. Click the lightning symbol to Show Events.

This displays all events that contain code.

2. To view events with code, go to Page --> Panels --> Properties.

In this example, PageHeaderBand1 has code in the BeforePrint event.

3. To access the code, do the following:

a. Select the component (here: PageHeaderBand1).

b. In Page --> Panels --> Properties, click the three-dot ellipsis. 

The Event Editor opens.

Code within an event can use comments to provide documentation.
Comments start a line with : //

Stimulsoft report variables
You can use variables in reports. Variable is a value that can be modified and
reused. There are various types of values such as string, date, number, and
array.
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Variables need a unique name, a description, and a data type. Once a variable
is declared for the report, it can be accessed from anywhere within the report.

A variable can be created within an event using the C# language, but that
variable can only be used within that event.

Variables can be used as the data source of a label, and then use code within
an event to set the value of the variable.

View and edit variables
Reports can prepare values for report-level variables that can be used to
display fields.

Variables are stored in the data dictionary. To find the variables, do the
following:

1. Go to Page --> Panels --> Dictionary.

2. To see the variables used on the report, expand the Variables and
FabSuite nodes.

3. To edit an existing variable, do either of the following:

• Double-click it in the tree view.

• Right-click it and select Edit.

The Edit Variable dialog box opens.

System variables
Each report has a list of built-in variables that can be used in the components
on the report.

To view the system variables, go to Page --> Panels --> Dictionary.
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Example: Convert data type using variables
This is an example of code for taking the string data type for the Load
Category of a Load and changing it to a decimal.

Code within an event can use comments that start a line with : //

Example:
// Set an interim variable.
decimal lnLoadCat1;

// Get the value from the data- i.e.
ProductionControlTrucks.LoadCategory1, and try convert to a
decimal.
// if TryParse is successful - the value is in "lnLoadCat1"
// if TryParse is not successful - the value is set to be 1.0
- a dummy multiplier.

if (!Decimal.TryParse( ProductionControlTrucks.LoadCategory1,
out lnLoadCat1)) {
//The row could not be parsed as a decimal.
lnLoadCat1 = 1.0m; }

_LoadCat1 = lnLoadCat1;
At this point, the variable _LoadCat1 can be used within the event. If it is
needed outside the event, you must create and use a report variable.

Record count for tables in Stimulsoft reports
To get a count of the number of rows in a table within the data source, use 
{Count()}.

Example:

ProductionControlItems.Count ;

See also

Customize and manage Stimulsoft reports (page 271)

Create a row for each quantity in Stimulsoft reports
You can print a report row for each quantity of an item. If an item has a
quantity of 5, it is possible to print 5 rows of data for that item.
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1. Create a new data band beneath the required item. 

We recommend that you provide it with a name similar to ‘instance’ to
denote that this shows instances of an item.

2. Right-click the new band and select Design.

3. Select Master Component and the parent data band. 

Example:

In this example, the parent data band is the table
ProductionControlItems. The new data band is named
DataBandInstance and it has no data source.

4. In the BeforePrint event of the ProductionControlItemDataBand, add
the following code: 

DataBandInstance.CountData =
ProductionControlItems.Quantity ;
This line of code specifies that the number of rows for the data band is
equal to quantity for the item.

The fields in the Instance data band still reference the
ProductionControlItems table, for example:

{ProductionControlItems.Dimensions}.

See also Stimulsoft report events (page 286)

Add a checkbox in a Stimulsoft report
Short description of the topic.

1. On the Insert ribbon tab, select Components.

2. In the drop-down menu, select Check Box and drag to the desired
location.

3. To modify the properties, right-click the checkbox and select Properties. 

The Checked property defines the source.

4. To open the editor, click the three-dot ellipsis.

5. Specify the control source. 

The control source must be a logical data field or variable.

6. To further define the checkbox, select values from the drop-down menus. 
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Conditional formatting of a Stimulsoft report
You can use conditional formatting to change the design of components.

Once a component has been allocated a condition, an icon is displayed for it in
the report editor.

You can view existing conditions on the Property panel for the selected item.

Add a simple condition
A simple condition is good for setting threshold values where the report can
highlight unexpectedly high or low values.

You can change the color of text based on values to indicate if a value is less
than zero or a drawing that is on hold, for example.

1. To change the visual style of a component, select it do either of the
following:

• Click Conditions on the toolbar.

• Click the three-dot ellipsis for Conditions in the Appearance section in
Properties.
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2. To add a Highlight Condition, click Add Condition. 

Example:

If the line item is not a MainPiece, unselect Component is Enabled. This
sets the enable flag of the label to false. Then the label is shown only
when the item is a MainPiece.

If you keep Component is Enabled selected, the label will still show and it
is possible to add a highlight to the field, select a border, and use a
different font, for example.
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Add icons
You can add icons to identify components with specific conditions.

The following procedure provides an example for part weight.

1. Select the component displaying the part weight.

2. Add a condition.

• Click Conditions on the toolbar.

• Click the three-dot ellipsis for Conditions in the Appearance section in
Properties.

3. Click Add Condition.

4. Select Icon Set Condition.

5. In Color Scale Type, select 3-Color Scale.

6. Specify the data field. 

7. To reverse the icons, click Reverse.

8. Specify values for each icon.

As a result, you can see the value and the icon for each row of data.

ODBC data source in Stimulsoft reports
For items that are in the database but not included in the report, you can add
a data source to provide that information to the report template.

There are several things to consider when adding data sources:

• It is always best to make these kinds of design changes in a new user-
defined report. See Create user-defined reports for customizing (page 268).
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• If the item that you are adding is universally used, you should send a
development request to include the field in the default data source for the
report.

• It is important for the organization of the report to use a consistent naming
pattern when adding items. Observing the methods already in use is a
good starting point.

• Due to the amount of data in the source, it may be necessary to apply a
filter to the source.

• There needs to be a way to link the source data to provide the proper
relationship so that the correct data is provided for the record or summary
being displayed. This may require that multiple tables are added.

For example, if you want to include the job status description, you may
need to add both the “projects” table to get the “jobstatusid” for the project
and the “jobstatuses” to be able to link the “jobstatusid” to the correct
description.

NOTE When you are adding the ODBC data source, you must open the program
directly through the application shortcut or files. You cannot use MySQL
Service Manager to open the program to successfully add the ODBC data
source.

Add an OBDC data source
1. Open the report in the Designer.

2. Go to Page --> Panels --> Dictionary.

3. Right-click Data Sources. 
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4. Select Data Source. 

The New Data Source dialog box opens.

5. Select OBDC. 

The New OBDC Connection dialog box opens.

6. Click OK. 

Do not change the name.

The Select Data dialog box opens.

7. Click OK.

8. Save and close the report.

Add tables to the ODBC data source
1. Open the report in the Designer.

2. Go to Page --> Panels --> Dictionary.

3. In the navigation tree, right-click ODBC[ODBC].

4. Select Data Source. 

The New Data Source dialog box opens.

5. Select OBDC. 

The New OBDC Connection dialog box opens.

6. Click OK. 

The Select Data dialog box opens.

7. Select all the required tables and click OK.

The selected tables are available in the navigation tree under the
ODBC[ODBC] source.

Add relation to the detail data band source
1. Open the report in the Designer.

2. Go to Page --> Panels --> Dictionary.

3. Right-click the detail data band source and select New Relation. 

The New Relation dialog box opens.

4. Complete the following: 

• Name in Source

• Name

• Alias

5. Select the Parent data source that is being linked from the drop-down list.
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6. Select the data source field in the Parent data source.

7. Select the data source field in the Child data source that links to that field.

The name of the relation is now available in the Child data source and the
records are linked based on the fields set in the relation.

NOTE This process to add the proper relations may need to be repeated to
provide relations to the required data through multiple tables.

Have the relation populated with the data from the added source
1. Open the report in the Designer.

2. Go to Page --> Panels --> Properties.

3. At the top of the panel, click the first item on the drop-down list. 

It will be labeled as Report.

4. In the Data section ensure that Cache All Data is set to True.

5. Save the report.

The data that has been added and related to the data source for the report is
available.

4.15 Set the user preferences
You can enable sounds, and change the way the highlight colors are displayed
in grid views such as Production Status.

1. Click the User Preferences ribbon tab.

2. In the User Preferences dialog box, select the grid highlight color. 

• Contrast

• Pale

3. In the User Preferences dialog box, select whether sounds are on or off.
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4.16 Set the default printer
You can set or change the default printer for the current workstation. Setting a
default printer for a workstation is optional.

1. On the File menu, select Default Printer. 

The Default Printer dialog box opens.

2. To select or change the default printer, click Change. 

The Select Printer dialog box opens.

3. Select a printer.

4. Click OK. You return to the Default Printer dialog box.

5. To confirm using the selected printer as the default printer, click OK.

4.17 Contact support
You can contact support directly from Tekla PowerFab using the support tool.
You can launch the tool directly from an error dialog or from the About dialog
box.

In the tool, you can describe the issue, and attact error logs, and database
backups.

If there is a crashing error, the tool automatically launches the ticket-creation
dialog box.

Create a support ticket
This step-by-step procedure instructs you how to contact support using the
About dialog box. You can also contact support directly from an error dialog.

1. Click the About ribbon tab. 

The About dialog box opens.

2. Click Create Support Ticket. 
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The Contact support dialog box opens.

3. Type the details of your issue or questions and click Next >. 

In the description, include the version of the program, if it is on the server
or client, and if the issue is occurring on multiple machines.

4. Select the attached information and click Next >.

5. Check the Case summary.

6. If you are satisfied with your ticket, click Create case. 

Otherwise, click Back, and modify your ticket as desired.
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5 Combining

You can create and import advance bills of materials, or combining jobs in the
Tekla PowerFab Combining module.

You can either add combining jobs manually or import them as Microsoft Excel
worksheets, KISS, or IFC files. The information in the imported files is
automatically transferred into the applicable fields of the Combining module.

Once the materials have been entered in the Combining module, you can
combine and recombine them using different material lengths. Then, you can
compare the different combinations.

You can also send the combining materials to a requisition for pricing, or to a
purchase order. Tekla PowerFab then marks the items that are sent to
purchasing, so that they cannot be sent to purchasing again.

NOTE • Before you start working in the Combining module, remember to set up
the module (page 300) according to your needs.

• While you have the Combining module with jobs for advanced bill of
materials, combining is also a function used for material optimization in
Combining, Estimating, Production Control, and Requisitions in Tekla
PowerFab.

The combining function mults linear material and nests plate-type material to
assign item records in the job to inventory or purchasable material. This
creates a copy of the item record and appends it to the inventory item or item
from pricing maintenance that can be purchased. Material that is in inventory
or in pricing maintenance (suppliers) is considered available material.

5.1 Set up the Combining module
In Combining Maintenance, you can create and modify the settings used
when working in the Combining module. For example, you can set up the
display and the input order listing views in Combining Maintenance. In
addition to setting custom views, you can modify the menu setup and add
keyboard shortcuts to make working more efficient.
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See also

Define company standard settings for Combining (page 301)

Manage combining jobs (page 308)

Define company standard settings for Combining
For each module, you can define company-level settings that are the default
for all new jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Combining --> Company Standards. 

The Company Standards dialog box opens.

3. Modify the settings as needed. 

Option Description
Job # Increment Allows you to select the default option for automatic

job numbering. The options are:

• Increment from Last Job #: When you create a
new job, Tekla PowerFab uses the next available
job number after the latest job number created.

• Increment from Largest Job #: Tekla PowerFab
uses the next available job number after the
largest job number created.

• Don't Increment: Automatic job numbering is not
used.

You can modify the job number when you create a
new job.

Mark Input Type Allows you to select which format is used when
defining mark numbers.

The Any Input and Any Input - Logical Sort options
allows you to use any format when defining marks.
The difference between the two options is that the
Any Input - Logical Sort sorts the items in a different
way.

Auto-Increment When selected, Tekla PowerFab automatically
populates the new mark number with the next largest
available mark number when you are adding items in
the Combining dialog box.

Auto-Increment
From Last Entered
Value

When selected, Tekla PowerFab automatically
populates the new mark number with the next mark
number from the latest added mark number when
you are adding items in the Combining dialog box.
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Option Description
Allow Blank When selected, Tekla PowerFab allows blank mark

numbers.
Allow Duplicate When selected, Tekla PowerFab allows duplicate mark

numbers.
Keep Job Selection
Screen Open

When selected, the Select <Module> Job dialog box
stays open after a job has been opened.

Otherwise, the dialog box closes when you open a job.
Open to Filter
Selection

When selected, the <Module> Filters dialog box
automatically opens when you open a job. In the
dialog box, you can set filters to only show the items
that you want to see in the job.

The job opens when you have set the filters.
Automatically
Create Document
Index Directories

When selected, the Document Index directories
defined in Maintenance --> Document Index -->
Standard Categories are created automatically under
the base document index directory when a job is
created. See Set the standard categories for attached
documents (page 150).

Item Increment Sets the autoincrement for item numbers.

The default autoincrement of 10 allows items to be
added in the list as needed, without having to
renumber the other items in the job.

For example, if items should be numbered as 10, 20,
30, ..., set the input increment to 10. If the
autoincrement of item numbers is not necessary, type
1.

Job # Regular
Expression

Allows the use of regular expressions to enforce a
desired format for the job numbers.

For more details on regular expressions, click Regular
Expression Help.

4. Click Save. 

Saving the settings closes the Company Standards dialog box.

The changes you made are saved. You can further modify the company
standards by clicking the Input/Display Units, Combining Optimizations,
and Suppliers buttons.

See also

Modify a combining job (page 327)
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Define default input and display units for Combining
You can define standard input and display units for the company. You can
select either metric or imperial units and the units of measurement for a
piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

1. Go to Maintenance --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Input/Display Units. 

The Input/Display Units dialog box opens.

3. Select the measurement system and the units of measurement on the
drop-down menus.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

5. Click Save.

The input and display units are saved as defaults.

You can also adjust the units used in individual jobs. For more information, see
Create a combining job (page 313).

Define default combining optimizations for Combining
You can define company-level settings for material optimization.

1. To define company-level settings, go to Maintenance --> <Module>
Company Standards.

The <Module> Company Standards dialog box opens.
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2. The Combining Setup dialog box opens.

3. Modify the settings on the various tabs as needed.

See also

Combine materials in the Combining module (page 335)

Define the general settings

1. Go to the General Settings tab.

2. Modify the settings as needed. 

Option Description
Use Grade Substitutions Select to check for material in

inventory that has an alternative
grade to the one specified.

Only grades of an equal or higher
rating will be used as set in
Maintenance --> Shapes/Grades/
Sizes --> Shape/Grade/Size
Maintenance dialog box.

If the grade substitutions are not set,
the material grades in the combining
run and in the supplier pricing data
set or the inventory need to match
each other exactly.
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Option Description
Optimizations Not Included/
Optimizations Included

Allows you to select the optimization
options that you want to use by
moving them to the Optimizations
Included list using the arrow buttons.

Inventory Exact-Match (In Stock) Use this option for inventory items in
stock that are an exact match without
the use of kerf or clamp allowance.

Inventory Exact-Match (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that are an
exact match without the use of kerf or
clamp allowance.

Inventory Least-Scrap (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that will
provide the least amount of scrap.

Inventory Least-Scrap (In Stock) Use this option for inventory items in
stock that will provide the least
amount of scrap.

Warehouse Least-Scrap Use this option to give preference to
warehouse items that will provide the
least amount of scrap. Warehouse
items will only be used when they
provide less scrap than the available
inventory items or no inventory
exists.

Warehouse Force Inventory Use this option to force the use of
inventory items if available regardless
of the amount of scrap, no matter
where it is located in the
Optimizations Included list. This
option is the opposite of Warehouse
Least-Scrap.

Note that you can only include
Warehouse Least-Scrap or
Warehouse Force Inventory, not
both.

3. Modify the order of the optimizations by using the Move Up and Move
Down buttons 

The order is important when you are performing a combining run.

4. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.
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• Continue to add or modify properties.

Define multing settings

1. Go to the Mult Settings - Linear Material tab.

2. Modify the settings as needed. 

Option Description
Multing Software Select the multing software that you

are using.
Apply Kerf Select if you want to apply the

material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Allow Split T's Select to allow split tees.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define plate nesting settings

1. Go to the Plate Nesting Settings tab.

2. Modify the settings as needed. 

Option Description
Plate Nesting Software Select the software that you are using.
Shear Cut Optimization Select a suitable shear cut option. The

selected option determines the plate
allowance to be used with the
combining:

• None: Use when cutting plate on a
burn table.

• Shear Cut - First Cut Along
Length or Shear Cut - First Cut
Along Width: Use to alert Tekla
PowerFab that the nesting needs
to allow for that type of cut first.
Then, the nesting will allow for all
subsequent cuts to be made with
that condition.

Apply Kerf Select if you want to apply the
material kerf settings defined in
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Option Description
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Rotate Plates for Best Fit Select if the material grain direction is
unimportant and you want Tekla
PowerFab to create the best possible
optimization of a plate.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

When you click Save, the Combining optimizations settings are saved.

See also

Define combining optimizations for a combining job (page 316)

Troubleshoot combining issues (page 1110)

Define default suppliers for Combining
You can define default suppliers, or pricing data sets, for angles, beams, plates,
rods, tubes, and other material. This way, you can use material pricing from
the selected supplier pricing data sets for each material group.

To make suppliers available in the Suppliers dialog box, you must first add the
suppliers in Maintenance --> Pricing Maintenance.

1. Go to Maintenance --> <Module> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Suppliers. 

The Suppliers dialog box opens.

3. Select suppliers for each material group on the drop-down lists.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

5. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the supplier settings are updated.
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See also

Define company standard settings for Combining (page 301)

Define suppliers for a combining job (page 320)

Manage combining jobs
You can manage existing jobs in many ways in the Job Maintenance dialog
box. The options available depend on the module. You can, for instance, copy
and delete jobs.

To access the Job Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

3. Select the job that you want to modify. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

4. At the bottom of the dialog box, click any of the available buttons. 

See also

Delete combining jobs (page 308)

Copy a combining job (page 309)

Export combining jobs (page 309)

Merge combining jobs (page 310)

Renumber combining page items (page 310)

Set job groups for combining jobs (page 311)

Set job statuses for combining jobs (page 311)

Delete combining jobs
You can delete any unnecessary jobs. Note that the jobs are deleted
permanently. To use the jobs for reference later, export them before deleting
them.

For information on exporting jobs, see Export combining jobs (page 309).

NOTE When you delete jobs, Tekla PowerFab saves them in the database as
KISS files. Users with administrative rights can recover the deleted jobs
within 30 days from deleting them.
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1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to delete. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Delete.

4. To delete the job, click Yes in the Confirm dialog box.

The job is permanently deleted.

See also

Manage combining jobs (page 308)

Export combining jobs (page 309)

Recover deleted files (page 114)

Copy a combining job
You can copy an existing job to use it as the base of a new similar job. Copying
an existing job makes creating the new job quicker, as you do not have to set
all properties manually or create items one by one.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to copy.

3. At the bottom of the dialog box, click Copy. The Enter Value dialog box
opens.

4. Type a number for the new job.

5. Click OK.

Tekla PowerFab creates a new job based on the selected job. You can modify
the properties of the new job by using the Edit functionality in the module.

See also

Manage combining jobs (page 308)

Export combining jobs
Export jobs to move jobs from one database to another.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to export. 
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To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Export. 

The Save As dialog box opens.

4. Browse to the folder where you want to save the file. 

Use the automatically generated name or type a new one.

5. Click Save.

The job is saved as a Tekla PowerFab-specific type of a KISS file. This type of file
will only import back into Tekla PowerFab.

The file is exported to the selected location.

See also

Manage combining jobs (page 308)

Merge combining jobs
You can create a new job by merging two existing jobs.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the jobs that you want to merge. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Merge. 

The Enter Value dialog box opens.

4. Type a number for the new job.

5. Click OK.

The selected jobs are merged into one new job.

See also

Manage combining jobs (page 308)

Renumber combining page items
You can change the existing page item numbering and their increments.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to renumber.
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3. At the bottom of the dialog box, click Renumber. 

The Select the pages to renumber dialog box opens.

4. Click the arrow buttons to move the pages that you want to renumber to
the Included list.

5. Click OK. 

The Enter Value dialog box opens.

6. Type the desired starting item number in the Starting item # dialog box.

7. Click OK. 

The Enter Value dialog box opens.

8. Type the desired item increment in the Item increment dialog box.

9. Click OK.

See also

Manage combining jobs (page 308)

Set job groups for combining jobs
Job groups allow you to identify and classify jobs that are similar. This makes
filtering and reporting easier when you have a long list of jobs.

You can, for example, record the client and industry sector, but you can create
your own system to best suit your needs.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the jobs for which you want to create a job group. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Set Group Name.

4. Select if you want to add or update the primary group or the secondary
group name.

5. Type a name for the group.

You can find the job groups in the navigation tree in the module and use them
for filtering jobs.

See also

Manage combining jobs (page 308)
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Set job statuses for combining jobs
Job status determines if a job is still in progress (Open) or finished (Closed). By
setting job statuses for jobs, you can filter and view only the current jobs in the
job selection dialog box in Tekla PowerFab and in Tekla PowerFab Go.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job whose status you want to change. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. Select the desired job status in the list.

4. Click OK.

You can filter jobs by selecting status in the module navigation tree.

See also

Manage combining jobs (page 308)

Job status maintenance (page 219)

5.2 Open the Combining module
To create advance bills of material, open the Combining module.

• At the top of the Tekla PowerFab window, click the the Combining button. 

The Select Combining Job dialog box opens. You can view all existing jobs
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NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs checkbox.

Next, you can create a new job, open or modify an existing job, or view and
modify the documents attached to a job.

Create a combining job
To create a new job, you need to define a few properties. If you do not define
job-specific properties, Tekla PowerFab uses the default properties in
Company Standards.

1. Open the module.

The Select <Module> Job dialog box opens.

2. Click Add.

The <Module> Job Edit dialog box opens.
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Continue to defining the properties on the tabs.

By clicking the buttons, you can find more settings. Modifying them overrides
the settings defined in Maintenance --> Company Standards.

NOTE Defining job-specific properties is optional. If you do not define job-specific
properties, Tekla PowerFab uses the default properties defined in
Maintenance --> Company Standards.

Define general settings
1. In the <Module> Job Edit dialog box, select the General tab.

2. Add or modify the properties as needed. 

Option Description
Job Date * The date on which the bid is due.

Tekla PowerFab automatically uses the date when
you create the job, but you can select a different
date in the associated calendar.

Job # A unique number for the job.

Note that the job number cannot be modified after
the job has been created.
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Option Description
Shipping Date * The date on which the job will be shipped.

Tekla PowerFab automatically uses the date when
you create the job, but you can select a different
date in the associated calendar.

Job Description The description of the job.
Job Status The job is either still in progress (Open) or it has

been finished (Closed).

You can filter the Select <Module> Job dialog box
by Job Status, so that only open jobs are shown.

Job Location The town or city where the job takes place.
Job Group Job groups allow you to identify and classify jobs

that are similar. This makes filtering and reporting
easier when you have a long list of jobs.

Either type a job group directly in the blank field, or
click the arrow on the right side of the field to
select an existing job group.

Comment Any additional comments on the job.
Project Management
Job

The project management job that is linked to the
job.

By linking the job in this module and project
management jobs to each other, you can share
nesting results with the Project Management
module. This way, you can save data transfer time.

3. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

Define customer settings
1. In the <Module> Job Edit dialog box, select the Customer tab.

2. Add or modify the properties as needed.

3. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.
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Define input options
You can define how information is entered in the job.

1. In the <Module> Job Edit dialog box, select the Input Options tab.

2. Add or modify the properties as needed. 

Option Description
Mark Input Type Allows you to select which format is

used when defining mark numbers.

The Any Input and Any Input -
Logical Sort options allow you to use
any format when defining marks. The
difference between the two options is
that the Any Input - Logical Sort
sorts the items in a different way.

Auto-Increment When selected, Tekla PowerFab
automatically populates the new
mark number with the next available
mark number when you are adding
items in the Combining dialog box.

Auto-Increment From Last Entered
Value

When selected, Tekla PowerFab
automatically populates the new
mark number with the next mark
number from the last added mark
number.

Allow Blank When selected, Tekla PowerFab allows
blank mark numbers.

Allow Duplicate When selected, Tekla PowerFab allows
duplicate mark numbers.

3. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the changes you made are saved. You can further modify
the job properties by clicking the buttons.

See also

Define combining optimizations for a combining job (page 316)

Define suppliers for a combining job (page 320)

Define input and display units for a combining job (page 321)
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Define combining optimizations for a combining job
You can define job-specific settings for material optimization.

You are in the Combining module. You are either creating a new job or
modifying an existing job in the Combining Job Edit dialog box.

1. Click Combining Optimizations.

The Combining Setup dialog box opens.

2. Modify the settings on the various tabs as needed.

Define the general settings

1. Go to the General Settings tab.

2. Modify the settings as needed. 

Option Description
Use Grade Substitutions Select to check for material in

inventory that has an alternative
grade to the one specified.

Only grades of an equal or higher
rating will be used as set in
Maintenance --> Shapes/Grades/
Sizes --> Shape/Grade/Size
Maintenance dialog box.

If the grade substitutions are not set,
the material grades in the combining
run and in the supplier pricing data
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Option Description
set or the inventory need to match
each other exactly.

Optimizations Not Included/
Optimizations Included

Allows you to select the optimization
options that you want to use by
moving them to the Optimizations
Included list using the arrow buttons.

Inventory Exact-Match (In Stock) Use this option for inventory items in
stock that are an exact match without
the use of kerf or clamp allowance.

Inventory Exact-Match (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that are an
exact match without the use of kerf or
clamp allowance.

Inventory Least-Scrap (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that will
provide the least amount of scrap.

Inventory Least-Scrap (In Stock) Use this option for inventory items in
stock that will provide the least
amount of scrap.

Warehouse Least-Scrap Use this option to give preference to
warehouse items that will provide the
least amount of scrap. Warehouse
items will only be used when they
provide less scrap than the available
inventory items or no inventory
exists.

Warehouse Force Inventory Use this option to force the use of
inventory items if available regardless
of the amount of scrap, no matter
where it is located in the
Optimizations Included list. This
option is the opposite of Warehouse
Least-Scrap.

Note that you can only include
Warehouse Least-Scrap or
Warehouse Force Inventory, not
both.

3. Modify the order of the optimizations by using the Move Up and Move
Down buttons 

The order is important when you are performing a combining run.

4. Do either of the following:
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• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define multing settings

1. Go to the Mult Settings - Linear Material tab.

2. Modify the settings as needed. 

Option Description
Apply Kerf Select if you want to apply the

material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Allow Split T's Select to allow split tees.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define plate nesting settings

1. Go to the Plate Nesting Settings tab.

2. Modify the settings as needed. 

Option Description
Shear Cut Optimization Select a suitable shear cut option. The

selected option determines the plate
allowance to be used with the
combining:

• None: Use when cutting plate on a
burn table.

• Shear Cut - First Cut Along
Length or Shear Cut - First Cut
Along Width: Use to alert Tekla
PowerFab that the nesting needs
to allow for that type of cut first.
Then, the nesting will allow for all
subsequent cuts to be made with
that condition.

Apply Kerf Select if you want to apply the
material kerf settings defined in
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Option Description
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Rotate Plates for Best Fit Select if the material grain direction is
unimportant and you want Tekla
PowerFab to create the best possible
optimization of a plate.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

When you click Save, the Combining optimizations settings are saved.

See also

Define default combining optimizations for Combining (page 303)

Troubleshoot combining issues (page 1110)

Define suppliers for a combining job
You can define job-specific suppliers, or pricing data sets, for angles, beams,
plates, rods, tubes, and other material.

You are in the Combining module. You are either creating a new job or
modifying an existing job in the Combining Job Edit dialog box.

To make suppliers available in the Suppliers dialog box, you must first add the
suppliers in Maintenance --> Pricing Maintenance.

1. Click Suppliers. 

The Suppliers dialog box opens.

2. Select suppliers for each material group on the drop-down lists.

3. Click OK.

4. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the changes you made are saved. You can further modify
the job properties by clicking the buttons.

See also

Create a combining job (page 313)
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Modify a combining job (page 327)

Define default suppliers for Combining (page 307)

Define input and display units for a combining job
You can define input and display units for individual jobs. You can select either
metric or imperial units and the units of measurement for a piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

You are in the Combining module. You are either creating a new job or
modifying an existing job in the Combining Job Edit dialog box.

1. Click Input/Display Units. 

The Input/Display Units dialog box opens.

2. Select the measurement system and the units of measurement on the
drop-down menus.

3. Click OK. You return to the <Module> Job Edit dialog box.

4. Do either of the following:

• Click Save

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the changes you made are saved.

See also

Create a combining job (page 313)

Modify a combining job (page 327)

Define default input and display units for Combining (page 302)

Find a combining job
You can search to find a specific job.
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1. In the Select Combining Job dialog box, click the Combining ribbon tab.

2. Select Find Job or press Ctrl+F on the keyboard. 

The Enter Value dialog box opens.

3. Select the job in the drop-down menu or enter the job number in the
search box.

4. Click OK.

The selected job is highlighted. To open the job, double-click it or click Open.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs checkbox.

Open a combining job
To view the details and add new items to a combining job, you need to open it
in the Combining dialog box.

1. At the top left corner of the Tekla PowerFab window, click Combining. 
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2. In the Select Combining Job dialog box, click the job that you want to
open in the navigation tree on the left, or use the Find Job command. 

NOTE Jobs whose statuses are set to Closed are not shown by default.
To show closed jobs, select the Show Closed Jobs checkbox.

3. Double-click the job, or select it and click Open.

The combining job opens in the Combining dialog box.

The materials are listed in the display area at the center of the dialog box.
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You can add or modify information for items in the input area on the right
side.

To customize the Combining dialog box according to your preferences, see the
instructions in Define company standard settings for combining (page 301).

See also

Find a combining job (page 321)

Filter information in the Combining dialog box
In addition to using the navigation tree for filtering items, you can set filters
that determine which items are shown in the Combining dialog box.

If the Open to Filter Selection checkbox has been selected in Maintenance --
> <Module> --> Company Standards, the <Module> Filters dialog box opens
automatically when you open a job.

If the Open to Filter Selection checkbox has not been selected, open the
<Module> Filters dialog box as follows:

1. In an open Combining job, click the Combining ribbon tab.

2. On the menu, select Filter. 

The <Module> Filters dialog box opens.

3. Select a filter type in the Type list and click Select. 
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The Filter dialog box opens.

For some filter types, you can also click Find and type the desired value in
the search box to use it. This way, you do not have to scroll through all the
available items.

4. Click the arrow buttons to move the items that you want to display to the
Included list.

5. Click OK. 

If you want to further filter the information displayed , repeat steps 3 to 5
for different items. Note that only items that match the items in the
Included list will be available when setting more filters.

If you want to clear all filter settings, click Reset.

6. Click Apply Filter.

The <Module> Filters dialog box closes, and the items are filtered according
to the settings you made.

To display all information again, click Clear Filters in the upper-left corner.

To create and save commonly used filters, see Create and modify module-wide
filters (page 261).

View all changes in a combining job
To see all changes that have been made to the data in a combining job, you
can create a specific type of report, called List Of Changes.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date filter

type and click Select.

b. Do one of the following:

• Enter the start (Minimum)
and end (Maximum) dates.

• Select the Expression
checkbox for the start or end
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To Do this
date. Then, select the base
date and select how many
more or less days will be
taken into account.

c. Click OK.

4. Click Make Report.

5. In the Report Progress dialog box, do one of the following: 

To Do this
View the list of changes • Click View.

The report opens in Tekla PowerFab Report
Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.
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To Do this
h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Manage files for a combining job
Document Index is a place for storing files to be shared among other users.
In Document Index, you can store various kinds of documents for reference,
and modify, delete, open, and email these files.

• To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production Control,
and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box related
to linked jobs.

The Document Index - By Category dialog box opens.

For further information and instructions, see

Document Index (page 149)

Modify a combining job
You can modify the properties of an individual job at any time, no matter if the
current properties have been set for all jobs in Company Standards or for an
individual job when creating it.

The changes override the company standard settings for the current job.

NOTE You cannot change the job number.

1. Open the module. 

The Select <Module> Job dialog box opens.

2. Select the job that you want to modify.

3. Click Edit.

4. Modify the information as needed. For details on the values, see the
following:

• Create a combining job (page 313)
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• Define combining optimizations for a combining job (page 316)

• Define suppliers for a combining job (page 320)

• Define input and display units for a combining job (page 321)

5. Click Save.

See also

Define company standard settings for Combining (page 301)

Create a combining job (page 313)

5.3 Manage combining items
You can manage combining items in many ways: add new ones, copy or
modify existing ones, and delete unnecessary ones. You can modify existing
combining items in a bill of materials either one by one or as a group. In
addition, you can choose to modify items of a certain shape, or select the
items to modify in the Combining dialog box. You can also copy a page of
combining items onto a new page in the job.

For more information, see the following links:

Add a combining item (page 328)

Modify a single combining item (page 331)

Modify multiple combining items (page 332)

Modify the selected combining items (page 332)

Modify the shape, grade, dimensions, or length of combining items (page 333)

Modify the shape, grade, dimensions, or length of the selected combining
items (page 334)

Copy a page of combining items (page 335)

Add a combining item
To add a new material item to a combining job:

1. At the bottom of the Combining dialog box, click New.

2. Define the item properties. 

NOTE The visible input fields and their order depend on the settings
that you have defined inMaintenance --> Combining --> Edit
Input Fields.
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The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Allocated The items that have begun the purchasing

workflow.
Category, Sub-Category A class used for sorting items within a job. You

can use categories and subcategories for
filtering information.

You can create the available categories and
subcategories in Company Standards.

You can also assign quantity multipliers to
subcategories.

Select an existing Category or Sub-Category on
the drop-down menu or type in a new category.

Comment An optional comment that you can type for the
item.

Dimensions * The material dimension, or material size, of each
piece.

Depending on the shape, the dimension can also
be mandatory information.

Click the Dimensions field to select an available
material dimension, and double-click the desired
dimension in the list.

You can also use a custom material dimension.
Note that the dimension is not automatically
added to the material database.

To use a custom dimension:

a. 1. Click in the Dimensions field.

2. Click Add Size.

3. Define the dimension properties.

4. Click Save.

You can now select the dimension and
use it.

Grade * The material grade of each piece.

Depending on the shape, the grade can also be
mandatory information.

Either select the grade from the drop-down
menu or type the grade indicator in the field.
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Option Description
Item * The item number.

You can modify the item number manually or
use the item number automatically determined
by Tekla PowerFab.

Default item increments are set in Company
Standards, but you can modify them for each
job. We recommend leaving spaces between
items, so that you can later add items between
existing items.

You can reset the item number intervals in Job
Maintenance.

For more information, see Renumber combining
page items (page 310).

Length The length of each piece.

Default length input settings are set in Company
Standards, but you can modify them for each
job.

Main Pc When selected, indicates that the item is a main
piece in an assembly. When cleared, indicates
that the item is not a main piece.

Mark # The mark number of the item.

Enter a maximum of 25 characters. The
maximum number of characters also depends
on the Mark Input Type setting that you have
selected in the Combining Company Standards
dialog box.

Page The number of the page on which the item is
added.

Quantity * The number of pieces to be added.

Use the numeric keypad to add, multiply, divide,
or subtract number of items.

Reference # A reference number that links items in inventory
or purchasing to the production control job.

When you load materials from a combining job
to Purchasing, this reference number is used.
Later, when the purchased items are received
and imported to Production Control, they will
have the same reference number.

Type in the number. The maximum number of
characters is 255.
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Option Description
Sequence The sequence number assigned to the item..

Type in the number or select a number from the
drop-down menu.

Shape * The material shape of each piece.

Either select the shape from the drop-down
menu or type the shape indicator in the field (for
example, HSS).

3. Click Add.

See also

Manage combining items (page 328)

Modify combining items
You can either modify items one by one, or use the Global Edit commands to
modify multiple items at one go.

TIP If you cannot find the property you want to modify, check if you can add it in
Maintenance --> Combining --> Edit Input Fields.

For more information, see the following links:

Modify a single combining item (page 331)

Modify multiple combining items (page 332)

Modify the selected combining items (page 332)

Modify the shape, grade, dimensions, or length of combining items (page 333)

Modify the shape, grade, dimensions, or length of the selected combining
items (page 334)

Modify a single combining item
You can modify a single combining item in a bill of materials directly in the
Combining dialog box.

1. In the upper navigation tree or the display area, click the item that you
want to modify. 

The properties of the selected item appear on the right side of the dialog
box.

2. Modify the properties according to your needs. 

For example, you can select another category in the Category list or
change the number in the Quantity field.
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3. Click Edit to save the changes.

The properties of the selected combining item are saved and updated to the
Combining dialog box.

Modify multiple combining items
Use the Global Edit command to modify the properties of multiple items at
one go. This way, you can save time, as you do not need to change the
properties of each item individually.This way, you can save time, as you do not
need to change the properties of each item individually.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select Global Edit --> Global Edit. 

The Global Edit Filters dialog box opens.

3. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

4. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

5. Click OK. 

To further limit the item types that you want to modify, repeat steps 3 to
5.

6. Click OK. 

The Global Edit dialog box opens.

7. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

8. Click Update. 

The Confirm dialog box opens.

9. To confirm changing the properties of multiple items, click Yes.

The changes you made to the item properties are updated.

Modify the selected combining items
Use the Global Edit - Selected command to modify the properties of multiple
selected items at one go. This way, you can save time, as you do not need to
change the properties of each item individually.
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1. In the Combining dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Combining ribbon tab.

3. On the menu, select Global Edit --> Global Edit - Selected. 

The Global Edit - Selected dialog box opens.

4. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

5. Click Update.

The properties of the selected items are updated.

Modify the shape, grade, dimensions, or length of combining items
Use the Global Edit By Shape command to modify the shape, grade,
dimensions, or length of all or multiple items.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select Global Edit --> Global Edit By Shape . 

The Global Edit Filters dialog box opens.

3. Select a shape on the Shape drop-down menu. 
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4. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

5. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

6.

7. Click OK. 

To further limit the items that you want to modify, repeat steps 4 to 5.

8. Click OK. 

The Global Edit dialog box opens.

9. Select the properties that you want to update. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

10. Click Update. 

The Confirm dialog box opens.

11. To confirm changing the properties of multiple items, click Yes.

The changes you made to the item properties are updated.

Modify the shape, grade, dimensions, or length of the selected
combining items
Use the Global Edit Selected By Shape command to modify the shape, grade,
dimensions, or length of selected items.

1. In the Combining dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Combining ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected By Shape . 

The Global Edit - Selected dialog box opens.

4. Select the properties that you want to update. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.
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5. Click Update.

The changes you made to the item properties are updated.

5.4 Copy a page of combining items
Use the Copy Page command to copy all items on a page of the combining job
onto a new page.

1. In the Combining dialog box, select any item that is on the page that you
want to copy.

2. Click the Combining ribbon tab.

3. On the menu, select Copy Page.

4. In the Copy Page dialog box, type the new page number in the New Page
# field.

5. Click Copy.

The copied items are added to the Combining dialog box.

5.5 Combine materials in the Combining module
You can mult and nest materials using the Combine command. You can then
save and review the combining results.

1. In the Select Combining Job dialog box, open a job.

2. Click the Combining ribbon tab and select Combine. 

The Select Combining Run dialog box opens. When you are performing
the first combining run for a combining job, the list in the dialog box is
empty.

3. Click a desired combining option to select it. 

The options are:

• Mult: Combines linear items, like beams and angles.

• Nest: Combines items that have area, like plates or gratings.

• Mult & Nest: Combines all items.

The Combining Run Filters dialog box opens.

NOTE Filtering items is optional, so you can skip steps 4 to 7 if you do
not want to filter out items from the combining run.

4. To only combine specific types of materials, select a filter type in the Type
list, and click Select.
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5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to combine to
the Included list.

• Type the maximum and minimum values for the items that you want
to combine.

6. Click OK to apply the filter. 

Repeat steps 4 to 6 for each filter type that you want to set.

7. To ensure that you are using the correct settings, click the Optimizations,
INV Filter, and Suppliers buttons. 

You can modify the settings.

8. In the Combining Run Filters dialog box, click OK.

9. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4.

Tekla PowerFab combines the materials. After the combining process is
finished, the Combining Run Results dialog box opens.

• Piece mark items included with the selected stock lengths are displayed at
the lower-left section of the dialog box.

• Combining results are shown in both the display area and in the summary
grid at the lower-right section of the dialog box.

• The material cost represents the pricing of the materials in the pricing
database that was used in the combining run.

TIP You can save the combining run to view it later and compare it with
another combining run. To do so, click Save Combining Run at the
bottom of the Combining Run Results dialog box. No cut lists are
generated when you save the combining run.

Rename a combining run
When you save a combining run, Tekla PowerFab automatically uses the date/
time stamp as the combining run name. You can also rename the combining
run. Renaming the combining run makes it easier to identify a specific
combining run when you want to compare combining runs.

1. In the Combining Run Results dialog box, click the Run Description
button.

2. In the Enter Value dialog box, type a new name for the combining run.

3. Click OK.

The name is updated. You can see the combining run name in the Run
Description button at the bottom of the Combining Run Results dialog box.
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View combining run filter settings
You can view which filter settings are used in the current combining run. Note
that you cannot modify the filter settings of the combining run.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.

2. On the menu, select View Filters.

3. In the Combining Run Filters dialog box, do one or more of the following:

• To view the optimization settings used for the combining run, click
Optimizations.

• To view the combining run inventory filter setting used for the
combining run, click INV Filter.

• To view the supplier settings used for the combining run, click
Suppliers.

4. When you have viewed the settings, click the Close button (X) in the
upper-right corner of the dialog box. 

The Combining Run Filters dialog box closes.

Modify run-specific pricing information
After performing the first combining run, you can modify length options that
are only used in that specific combining job. For example, L 3 x 3 x ¼ materials
have 40'0 and 20'0 lengths. If you only want to combine the 20'0 lengths, you
need to delete the 40'0 lengths from Run-Specific Pricing Maintenance. Any
changes that you make will override the values in the global pricing database,
but only for the current combining run.

You can also modify a group of items in the combining run at one go. For more
information, see Modify a group of items in run-specific pricing maintenance
(page 339).

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.

2. On the menu, select Run-Specific Pricing Maintenance.

3. In the Pricing Maintenance dialog box, do any of the following according
to your needs: 

To Do this
Add material shapes,
grades and dimensions

a. At the bottom of the dialog box, click Add.

b. In the Shape list, select the shape.
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To Do this
c. Click the Dimensions field and select the

dimensions that you want to add.

d. In the Grade list, select the grades that you
want to add.

e. Click Save.

The shape, its dimensions, and grades are added
to the navigation tree.

Modify existing material
shapes, grades, and
dimensions

a. In the navigation tree, click the material
dimension that you want to modify.

b. At the lower-left corner of the dialog box, click
Edit.

c. In the Shape list, select the shape.

d. Click the Dimensions field, and select the new
dimensions in the dialog box that appears.

e. In the Grade list, select the new grades.

f. Click Save.

The shape, its dimensions, and grades are updated
to the navigation tree.

Add lengths or sizes a. In the navigation tree, click the material
dimension for which you want to add lengths.

b. Click New under the Normal Price field.

c. Type the length and price.

d. Click Add.

The length is added to the list of lengths.
Modify or delete lengths a. In the navigation tree, click the material

dimension that you want to modify or delete.

b. In the list of lengths, select a length.

c. Do one of the following:

• To modify the length, type a new length
and price, and click Edit.

• To permanently delete the length, click
Delete, and in the confirmation dialog box,
click Yes.

Change the pricing of a
length

a. In the navigation tree, select the material
dimension whose pricing you want too
change.

b. In the list on the right side of the dialog box,
select a length.
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To Do this
c. Do any of the following:

• To modify the special price, type a new
value in the Special Price field, and click
Save.

• To modify the normal price, type a new
value in the Normal Price field, and click
Edit.

You can also adjust the quantity and
lengths of the material. To change the
quantity to unlimited, type an asterisk (*) in
the Quantity field. Click Edit to save the
changes.

The pricing of the length is updated.
Delete unnecessary
material dimensions

a. In the navigation tree, select the material
dimension that you want to delete.

b. At the bottom of the dialog box, click Delete.

c. In the confirmation dialog box, click Yes to
confirm deleting the dimension.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

The changes are saved for the current combining run. Now, you need to
recombine the materials to update the combining results.

See also

Recombine all items (page 341)

Recombine items of a shape (page 342)

Recombine items of a material grade (page 342)

Recombine a material dimension (page 343)

Update combining information and recombine all items (page 343)

Modify a group of items in run-specific pricing maintenance
You can modify the properties of a group of items while you are in the Pricing
Maintenance dialog box. For example, you can only make certain lengths
available for combining by using the Set Lengths option. Any changes that you
make will override the values in the global pricing database, but only for the
current combining run.

For information on how to access the Pricing Maintenance dialog box, see
Modify run-specific pricing information (page 337).

1. In the Pricing Maintenance dialog box, click the Pricing ribbon tab.
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2. On the menu, select Global Edit.

3. In the Shape list at the top of the Pricing Global Edit dialog box, select
the shape whose grades and dimensions you want to modify. 

The grades and dimensions of the shape appear in the dialog box.

4. In the Grades section, click the arrow buttons to move the grades that you
want to modify to the Included list.

5. In the Dimensions section, click the arrow buttons to move the
dimensions that you want to modify to the Included list.

6. In the lower-right corner, select an option. 

The options are:

• Increase By Percentage: Increases the prices of the selected items by
a specific percentage.

• Decrease By Percentage: Decreases the prices of the selected items
by a specific percentage.

• Increase By Amount: Increases the prices of the selected items by a
certain sum.

• Decrease By Amount: Decreases the prices of the selected items by a
certain sum.

• Set Amount: Sets the prices of the selected items to a specific sum.

• Set Quantity: Allows Tekla PowerFab to only use a specific number of
the selected lengths.

• Set Lengths: Allows you to add lengths for the selected items either
one by one or as a range.

• Set Lengths (No Price): Allows you to add lengths for the selected
items either one by one or as a range. No pricing information is added.

New fields appear at the bottom of the dialog box.

7. Modify the values in the fields according to your needs.

8. Click Save.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

The changes are saved for all selected material grades and dimensions. Now,
you need to recombine the materials

Example: Change combining lengths of angles

In this example, we will modify all angles so that the only available length for
combining is 20 inches.

1. In the Shape list at the top of the Pricing Global Edit dialog box, select L.
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2. Click the double arrow buttons to move all grades and dimensions to the
Included list.

3. Select the Set Lengths option button.

4. Click New.

5. Leave the Quantity field blank to allow Tekla PowerFab to use an
unlimited quantity of the length.

6. Length field, enter 20'0".

7. In the Normal Price field, enter a price.

For example, set the price to $25,50/CWT.

8. Click Add.

9. Click Save

Now, the only angle length available in recombining is 20'0".

See also

Recombine all items (page 341)

Recombine items of a shape (page 342)

Recombine items of a material grade (page 342)

Recombine a material dimension (page 343)

Update combining information and recombine all items (page 343)

Recombine all items
If the combining results need to be changed to fit specific material
applications, such as different material lengths or plate sizes, you need to
recombine items. The Recombine All command recombines all items in the
previous combining run.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.

2. On the menu, select Recombine All.

3. In the first confirmation dialog box, click Yes to recombine all items.

4. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

Tekla PowerFab performs the combining run and reloads the information that
you selected. The materials recombine to the lengths changed in Run-Specific
Pricing Maintenance.
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Recombine items of a shape
To recombine materials after adding new items, use the Recombine Shape
command in the Combining Run Results dialog box.

1. In the Combined navigation tree, click the + sign to show available
material shapes.

2. Click the material shape to which you have added items. 

Only the items of the selected shape are shown.

3. Click the items that you want to recombine to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click the Combining Run ribbon tab.

5. On the menu, select Recombine Shape.

6. In the first confirmation dialog box, click Yes to recombine the selected
shape.

7. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

Tekla PowerFab recombines the selected items.

Recombine items of a material grade
To recombine materials after changes have been made to material grades, use
the Recombine Grade command in the Combining Run Results dialog box.

1. In the Combined navigation tree, click the + sign under a material shape
to show available material grades.

2. Click a material grade to select it. 

Only the selected material grade is shown.

3. Click the items that you want to recombine to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click the Combining Run ribbon tab.

5. On the menu, select Recombine Grade.

6. In the first confirmation dialog box, click Yes to recombine the selected
grade.
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7. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

Tekla PowerFab recombines the selected items.

Recombine a material dimension
When changes have been made to a material dimension in the combining
material list, use the Recombine Size command to recombine the dimension.
Note that you need to have the Combining Run Results dialog box open.

1. In the Combined navigation tree, click the + sign, and select a material
dimension. 

Only the selected material dimension is shown.

2. Click the Combining Run ribbon tab.

3. On the menu, select Recombine Size. 

A confirmation dialog box appears, asking if you want to recombine the
selected dimension.

4. In the first confirmation dialog box, click Yes to recombine the selected
dimension.

5. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

Tekla PowerFab recombines the selected material dimension.

Update combining information and recombine all items
When new materials have been added, or material pricing has changed, use
the Reload Information & Recombine All command. Tekla PowerFab will
then update the material and pricing information and perform a new
combining run.

Note that all run-specific information will be lost if you use the Reload
Information & Recombine All command.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.
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2. On the menu, select Reload Information & Recombine All. 

A confirmation dialog box appears, asking if you want to recombine all
items.

3. In the first confirmation dialog box, click Yes to confirm recombining all
items.

4. In the second confirmation dialog box, click Yes to save the previous
combining run or No to recombine materials without saving the
combining run. 

By saving the previous combining run, you can compare the differences
between the previous combining run and the new one.

5. In the third confirmation dialog box, click Yes to reload and update the
items to be recombined, or No to not reload and update the items.

6. In the fourth confirmation dialog box, click Yes to reload and update the
pricing information, or No to keep the current pricing information.

Tekla PowerFab performs the combining run and reloads the information that
you selected.

Compare combining runs
You can view and compare the changes that were made from one combining
run to another. This is useful for comparing drops for the use of different
stock lengths or pricing differences between two vendors.

Note that you must have saved a previous combining run to compare it with
the current combining run.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.

2. On the menu, select Compare With a Previously Saved Run.

3. In the Select Combining Run dialog box, click a previously saved
combining run in the list to select it.

4. Click Compare. 

The Combining Run Compare dialog box opens, displaying the
information of both combining runs. Any differences are marked with an
asterisk (*).

5. In the navigation tree in the left-hand pane, click a material size to select
it.

6. View the differences for the size in the different combining runs.

7. To close the comparison view, click the Close button (X) in the upper-right
corner of the Combining Run Compare dialog box.
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View, print, or export combining run reports
You can create different kinds of reports based on the combining run results.
You can then view, print, or export the reports according to your needs.

1. In the Combining Run Results dialog box, click the Combining Run
ribbon tab.

2. On the menu, select Reports.

3. To only include particular shapes, grades, or dimensions in the reports, in
the Combining Run Report Filters dialog box, select a filter type in the
Type list, and click Select.

4. In the Filter dialog box, click the arrow buttons to move the shapes,
grades, and dimensions that you want to include to the Included list.

5. Click Make Report.

6. In the Report Selection dialog box, select the report.

7. If you want to include your company's logo in the report, select Show
Company Logo.

8. Do any of the following according to your needs: 

To Do this
View the report • Click View.
Print the report a. In the Report Selection dialog box, change the

number of the printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the used printer.

c. Click Print.

d. Click Yes.
Export the report a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.
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To Do this
f. To attach the exported file to a Microsoft

Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. Click Export.

See also

Combine materials in the Combining module (page 335)

5.6 Load combining items into purchasing
Load materials in a bill of materials into a requisition or a purchase order, so
that they can be purchased. You can either load all combining items into a
requisition or a purchase order, or select the items that you want to load.

Note that Tekla PowerFab only allows you to load the same materials into
purchasing once.

When the materials are sent to purchasing, Tekla PowerFab populates the
reference number for both the combining job items and the purchasing items.
However, the combining items and the purchasing items are not linked.

See also

Load all combining items into a requisition (page 346)

Load selected combining items into a requisition (page 347)

Load all combining items into a purchase order (page 348)

Load the selected combining items into a purchase order (page 348)

Load all combining items into a requisition
To load all items in a bill of materials into a requisition, use the Load Material
Into Requisition command.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Requisition .

3. In the Select Requisition dialog box, select a requisition and click OK. 

If necessary, you can also create a new requisition and load the items into
it.

4. Click OK.
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5. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.

6. In the Import Items dialog box, click OK to return to the Combining
dialog box.

Items are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

Load selected combining items into a requisition
Use the Load Selected Material Into Requisition command to select the
items in a bill of materials that you want to load into a requisition.

1. In the Combining dialog box, select the items that you want to load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Combining ribbon tab.

3. On the menu, select Purchasing --> Load Selected Material Into
Requisition .

4. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

5. Click OK

6. Click OK to close the Import Items dialog box.

Items are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.
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Load all combining items into a purchase order
Use the Load Material Into Purchase Order command to load all items in a
bill of materials into a purchase order.

1. In the Combining dialog box, click the Combining ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Purchase
Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. Click OK

5. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.

6. Click OK to close the Import Items dialog box.

Items are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

Load the selected combining items into a purchase order
Use the Load Selected Material Into Purchase Order command to select the
items in a bill of materials that are loaded into a purchase order.

1. In the Combining dialog box, select the items that you want to load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.
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2. On the menu, select Purchasing --> Load Selected Material Into
Purchase Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. Click OK

5. Click OK to close the Import Items dialog box.

Items are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

5.7 Import an IFC file to a combining job
You can import IFC files to the Combining module to be used for a preliminary
list or for advance bills of materials.

As a comparison to Microsoft Excel worksheets, or KISS files, using IFC files
allows revised items to be updated, and you can report the changes (material
size, quantity, and so on) during the import process.

We recommend that you use the Steel fabrication view or 2x3 EM11 IFC
format, but the Coordination view or the standard IFC2x3 format works as
well.

Before you start importing, ensure that you have created preliminary marks
(PRELIM_MARK) in Tekla Structures, and included those in the IFC files. In Tekla
PowerFab, map at a minimum the PRELIM_MARK to Reference Number.
Other mapping is optional.

1. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.

2. On the File menu, select Import.

3. In the navigation tree of the Import dialog box, select IFC under
Combining.

4. Browse to find the file you want to import.

5. Click Import. 

The Import dialog box opens, and shortly after, the Combining Job Edit
dialog box.

6. Select the job to which import the IFC project and click Save. 

The Import Field Map dialog box opens.
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7. If the mapping is not automatically done, map the selected information
from the IFC file. 

We recommend you to map at a minimum PRELIM_MARK to Reference
Number. Other mapping is optional.

8. After selecting the field to be mapped to, for example to Reference
Number,click Set Field Mapping and OK. 

The Import log is displayed.

Ensure there are no errors, warnings, or unsuccessful files.

9. After a successful import, go to the Combining module. In the Select
Combining Job dialog box, select the job, and click Open to open the job. 

The job shows the imported records, as well as the mappings.

If you import the IFC file to the same job, you can use the Add & Replace
option.

If you have changed some fields in some of the records in the job, such as
quantities or grades, the import reverts the changes made in the job, and the
Import log shows that a number of items were updated.

5.8 Export a combining job to KISS
One way to save a combining job for later use is exporting it to KISS.

1. In the Combining dialog box, click the Combining ribbon tab.
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2. On the menu, select Export to KISS.

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

A copy of the file is saved in the KISS format.

5.9 View or print combining reports
You can view or print reports that show different information about the
combining job. You can create different kinds of reports and filter the items in
the reports in several ways.

1. In the Combining dialog box, click the Combining ribbon tab.

2. In the menu, select Reports. 

The Report Filters dialog box opens.

3. To only include specific materials in the reports, in the Report Filters
dialog box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, click the arrow buttons to move the material items
that you want to include in the reports to the Included list.

5. Click OK. 

To further limit the included items, repeat steps 3 to 5 for all necessary
filter types in the Report Filters dialog box.

6. Click Make Report.

7. In the Report Selection dialog box, click the report that you want to
create.

8. Do one or both of the following: 

To Do this
View the report • In the Report Selection dialog box, click View.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the report a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. Click Print.
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To Do this
c. In the Select Printer dialog box, click a printer

to select it.

d. Click OK.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Customize reports (page 268)
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6 Estimating

Use the Estimating module to create and modify estimates in Tekla PowerFab.
You can add different items to your estimates, including accessories and
assemblies. You can also mult and nest the material in an estimate, send
material to purchasing, or export the estimate to KISS, among many other
options.

NOTE Before you start working in the Estimating module, ensure that you have
adjusted estimating settings to meet the standards of your shop. For more
information, see Set up the Estimating module (page 353).

6.1 Set up the Estimating module
Before you start to create estimates and proposals in the Estimating module,
take the time to set it up carefully. Once you have created and adjusted all
necessary options, standard estimating items, and settings, working in the
Estimating module is easier and more efficient.

To access the different Estimating Maintenance commands, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, go to Estimating.

Define company standard settings for Estimating
For each module, you can define company-level settings that are the default
for all new jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Company Standards. 

The Company Standards dialog box opens.
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3. Modify the settings as needed. 

Option Description
Job # Increment Allows you to select the default option for

automatic job numbering. The options are:

• Increment from Last Job #: When you create a
new job, Tekla PowerFab uses the next available
job number after the latest job number created.

• Increment from Largest Job #: Tekla
PowerFab uses the next available job number
after the largest job number created.

• Don't Increment: Automatic job numbering is
not used.

You can modify the job number when you create a
new job.

Default Finish The most typical material finish for most
estimating jobs and items.

Item Increment Sets the autoincrement for item numbers.

The default autoincrement of 10 allows items to be
added in the list as needed, without having to
renumber the other items in the job.

For example, if items should be numbered as 10,
20, 30, ..., set the input increment to 10. If the
autoincrement of item numbers is not necessary,
type 1.

Keep Job Selection
Screen Open

When selected, the Select <Module> Job dialog
box stays open after a job has been opened.

Otherwise, the dialog box closes when you open a
job.

Open to Filter
Selection

When selected, the <Module> Filters dialog box
automatically opens when you open a job. In the
dialog box, you can set filters to only show the
items that you want to see in the job.

The job opens when you have set the filters.
Report Pricing -
Automatically Select
Last Combining Run

When selected, Tekla PowerFab automatically uses
the pricing used in the last saved combining run.

Imports - Use Piece
Mark as Part #

When selected, imported piece marks are
automatically used as part number items in the
estimating material list.

Automatically Create
Document Index
Directories

When selected, the Document Index directories
defined in Maintenance --> Document Index -->
Standard Categories are created automatically
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Option Description
under the base document index directory when a
job is created. See Set the standard categories for
attached documents (page 150).

Imports - Use as
Production Code

Select whether you want to use assembly main
marks, piece marks, drawing descriptions, or
assembly descriptions as production codes.

TIP If you use piece marks as production codes,
you can ensure that each item in a
production control job matches the same
item in a linked estimating job. This
guarantees that the corresponding items
have the same labor times.

IFC Import - Set status
of updated items to

The estimate status is used to verify the condition
or state of an estimate item. This controls the
status of an estimate item, should there be a
change to ensure that the item is properly
reviewed.

Production Code -
Default Aggregate
Units

Defines the default units of measure for labor
items within the production codes.

Job # Regular
Expression

Allows the use of regular expressions to enforce a
desired format for the job numbers.

For more details on regular expressions, click
Regular Expression Help.

Warn if accessory
quantity is not a
multiple of the main
piece quantity

When selected, Tekla PowerFab prompts the user
to confirm when adding or updating an accessory
and the quantity is not a multiple of the main piece
quantity.

Summary Information
to Excel - Prompt for
whether it is a
Canadian project

Select if the Summary Information to Excel
report option should prompt if it is a Canadian
project for the purposes of applying tax rates.

4. Click Save. 

Saving the settings closes the Company Standards dialog box.

When you click Save, the changes you made are saved.

You can find further company standard settings by clicking the buttons.
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Define default galvanizing settings
You can define default galvanizing costs and freight settings used in all
estimating jobs. Whenever an item in an estimating job is marked as
galvanized, these default costs are applied to it.

1. At the bottom of the Estimating Company Standards dialog box, click
Galvanizing. 

The Galvanizing dialog box opens.

2. Define the cost per pound, minimum cost, and freight cost.

3. In Trailer Capacity, type the trailer capacity. 

If you type 0 in the field, the freight cost value will be the total cost. If you
enter a greater value, the freight cost value will be the cost per truck.

4. Define the labor prep cost as price per pound.

5. In the Weight - Percent Added field, define the percentage of galvanizing
weight to be added for each galvanized item. 

The percentage is only used to calculate the galvanizing cost. It does not
affect the weights of galvanized items in the Estimating module or
reports.

6. Click OK.

7. In the Estimating Company Standards dialog box, click Save.

The default galvanizing settings are updated.

Note that you can also set job-specific galvanizing settings that override the
default galvanizing settings.

Define default categories and subcategories for Estimating
Categories are user-defined keywords that you can use for sorting, tracking,
and reporting. Creating categories also helps you to quickly identify the items
in your jobs. For example, you can categorize jobs by fabrication type.

In addition to manually creating categories, you can choose to use existing
categories used in Steel Erection Bid Wizard. To further filter items, you can
also add subcategories.

TIP You can also create new categories and subcategories manually when creating
or modifying a job.

Manage categories
You can add new categories and modify and delete existing categories

1. Go to Maintenance --> <Module> --> Company Standards. 

The <Module> Company Standards dialog box opens.
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2. Click Categories. 

The Company Categories dialog box opens.

3. Modify the settings as needed. 

To Do this
Add a new category
manually

a. Click New.

b. In the Category field, type a name for the
category.

For example, Skewed beam.

c. Click Add.

The new category is added to the Category
list.

Repeat steps a to c for all new categories.
Add categories used in
Steel Erection Bid Wizard

a. Click Add SEBW Categories.

b. Click the arrow buttons to move the categories
that you want to add to the Included list.

c. Click OK.

The categories are added to the Category list.
Modify a category a. Click a category name.

b. Click Edit, change the category name, and click
Edit again.

Delete a category a. Click a category name.

b. Click Delete.

c. Click Yes to confirm deleting the category.

4. Close the Company Categories dialog box.

5. In the <Module> Company Standards dialog box, click Save to update
the categories.

The changes in categories are saved.

Manage subcategories
You can add new subcategories and modify and delete existing subcategories

1. Go to Maintenance --> <Module> --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click the Sub-Categories button. 

The Company Sub-Categories dialog box opens.

3. To add add a subcategory, click New.

4. In the Sub-Category field, type a name for the subcategory.
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5. Click Add. 

The new subcategory is added to the Sub-Category list.

Repeat steps 1 to 4 for all new subcategories.

6. To modify or delete a subcategory, click a subcategory in the Company
Categories dialog box to select it and do either of the following:

• Click Edit, change the subcategory name, and click Edit again.

• Click Delete and then, click Yes to confirm deleting the subcategory.

7. Close the Company Sub-Categories dialog box.

8. In the <Module> Company Standards dialog box, click Save to update
the subcategories.

The changes in subcategories are saved.

Define default input and display units for Estimating
You can define standard input and display units for the company. You can
select either metric or imperial units and the units of measurement for a
piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

1. Go to Maintenance --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Input/Display Units. 

The Input/Display Units dialog box opens.

3. Select the measurement system and the units of measurement on the
drop-down menus.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

5. Click Save.

The input and display units are saved as defaults.

You can also adjust the units used in individual jobs. For more information, see
Define input and display units for an estimating job (page 467).

Define default combining optimizations for Estimating
You can define company-level settings for material optimization.

1. To define company-level settings, go to Maintenance --> <Module>
Company Standards.

2. Click Combining Optimizations.
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The Combining Setup dialog box opens.

3. Modify the settings on the various tabs as needed.

See also

Combine materials in the Estimating module (page 513)

Define the general settings

1. Go to the General Settings tab.

2. Modify the settings as needed. 

Option Description
Use Grade Substitutions Select to check for material in

inventory that has an alternative
grade to the one specified.

Only grades of an equal or higher
rating will be used as set in
Maintenance --> Shapes/Grades/
Sizes --> Shape/Grade/Size
Maintenance dialog box.

If the grade substitutions are not set,
the material grades in the combining
run and in the supplier pricing data
set or the inventory need to match
each other exactly.
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Option Description
Optimizations Not Included/
Optimizations Included

Allows you to select the optimization
options that you want to use by
moving them to the Optimizations
Included list using the arrow buttons.

Inventory Exact-Match (In Stock) Use this option for inventory items in
stock that are an exact match without
the use of kerf or clamp allowance.

Inventory Exact-Match (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that are an
exact match without the use of kerf or
clamp allowance.

Inventory Least-Scrap (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that will
provide the least amount of scrap.

Inventory Least-Scrap (In Stock) Use this option for inventory items in
stock that will provide the least
amount of scrap.

Warehouse Least-Scrap Use this option to give preference to
warehouse items that will provide the
least amount of scrap. Warehouse
items will only be used when they
provide less scrap than the available
inventory items or no inventory
exists.

Warehouse Force Inventory Use this option to force the use of
inventory items if available regardless
of the amount of scrap, no matter
where it is located in the
Optimizations Included list. This
option is the opposite of Warehouse
Least-Scrap.

Note that you can only include
Warehouse Least-Scrap or
Warehouse Force Inventory, not
both.

3. Modify the order of the optimizations by using the Move Up and Move
Down buttons 

The order is important when you are performing a combining run.

4. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.
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• Continue to add or modify properties.

Define multing settings

1. Go to the Mult Settings - Linear Material tab.

2. Modify the settings as needed. 

Option Description
Multing Software Select the multing software that you

are using.
Apply Kerf Select if you want to apply the

material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Allow Split T's Select to allow split tees.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define plate nesting settings

1. Go to the Plate Nesting Settings tab.

2. Modify the settings as needed. 

Option Description
Plate Nesting Software Select the software that you are using.
Shear Cut Optimization Select a suitable shear cut option. The

selected option determines the plate
allowance to be used with the
combining:

• None: Use when cutting plate on a
burn table.

• Shear Cut - First Cut Along
Length or Shear Cut - First Cut
Along Width: Use to alert Tekla
PowerFab that the nesting needs
to allow for that type of cut first.
Then, the nesting will allow for all
subsequent cuts to be made with
that condition.

Apply Kerf Select if you want to apply the
material kerf settings defined in
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Option Description
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Rotate Plates for Best Fit Select if the material grain direction is
unimportant and you want Tekla
PowerFab to create the best possible
optimization of a plate.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

When you click Save, the Combining optimizations settings are saved.

See also

Define combining optimizations for an estimating job (page 463)

Troubleshoot combining issues (page 1110)

Define default suppliers for Estimating
You can define default suppliers, or pricing data sets, for angles, beams, plates,
rods, tubes, and other material. This way, you can use material pricing from
the selected supplier pricing data sets for each material group.

To make suppliers available in the Suppliers dialog box, you must first add the
suppliers in Maintenance --> Pricing Maintenance.

1. Go to Maintenance --> <Module> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Suppliers. 

The Suppliers dialog box opens.

3. Select suppliers for each material group on the drop-down lists.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

5. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the supplier settings are updated.
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Manage estimating jobs
You can manage existing jobs in many ways in the Job Maintenance dialog
box. The options available depend on the module. You can, for instance, copy
and delete jobs.

To access the Job Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Job Maintenance .

3. In the Estimating Job Maintenance dialog box, select the jobs that you
want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. At the bottom of the dialog box, click any of the available buttons. 

See also

Delete estimating jobs (page 363)

Copy an estimating job (page 364)

Export estimating jobs (page 364)

Merge estimating jobs (page 365)

Renumber an estimating page item (page 365)

Set job groups for estimating jobs (page 366)

Set job statuses for estimating jobs (page 366)

Delete estimating jobs
You can delete any unnecessary jobs. Note that the jobs are deleted
permanently. To use the jobs for reference later, export them before deleting
them.

For information on exporting jobs, see Export estimating jobs (page 364).

NOTE When you delete jobs, Tekla PowerFab saves them in the database as
KISS files. Users with administrative rights can recover the deleted jobs
within 30 days from deleting them.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to delete. 
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To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Delete.

4. To delete the job, click Yes in the Confirm dialog box.

The job is permanently deleted.

See also

Manage estimating jobs (page 363)

Export estimating jobs (page 364)

Recover deleted files (page 114)

Copy an estimating job
You can copy an existing job to use it as the base of a new similar job. Copying
an existing job makes creating the new job quicker, as you do not have to set
all properties manually or create items one by one.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to copy.

3. At the bottom of the dialog box, click Copy. The Enter Value dialog box
opens.

4. Type a number for the new job.

5. Click OK.

Tekla PowerFab creates a new job based on the selected job. You can modify
the properties of the new job by using the Edit functionality in the module.

See also

Manage estimating jobs (page 363)

Export estimating jobs
Export jobs to move jobs from one database to another.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to export. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.
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3. At the bottom of the dialog box, click Export. 

The Save As dialog box opens.

4. Browse to the folder where you want to save the file. 

Use the automatically generated name or type a new one.

5. Click Save.

The job is saved as a Tekla PowerFab-specific type of a KISS file. This type of file
will only import back into Tekla PowerFab.

The file is exported to the selected location.

See also

Manage estimating jobs (page 363)

Merge estimating jobs
You can create a new job by merging two existing jobs.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the jobs that you want to merge. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Merge. 

The Enter Value dialog box opens.

4. Type a number for the new job.

5. Click OK.

The selected jobs are merged into one new job.

See also

Manage estimating jobs (page 363)

Renumber an estimating page item
You can change the existing page item numbering and their increments.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to renumber.

3. At the bottom of the dialog box, click Renumber. 

The Select the pages to renumber dialog box opens.
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4. Click the arrow buttons to move the pages that you want to renumber to
the Included list.

5. Click OK. 

The Enter Value dialog box opens.

6. Type the desired starting item number in the Starting item # dialog box.

7. Click OK. 

The Enter Value dialog box opens.

8. Type the desired item increment in the Item increment dialog box.

9. Click OK.

See also

Manage estimating jobs (page 363)

Set job groups for estimating jobs
Job groups allow you to identify and classify jobs that are similar. This makes
filtering and reporting easier when you have a long list of jobs.

You can, for example, record the client and industry sector, but you can create
your own system to best suit your needs.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the jobs for which you want to create a job group. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Set Group Name.

4. Select if you want to add or update the primary group or the secondary
group name.

5. Type a name for the group.

You can find the job groups in the navigation tree in the module and use them
for filtering jobs.

See also

Manage estimating jobs (page 363)

Set job statuses for estimating jobs
Job status determines if a job is still in progress (Open) or finished (Closed). By
setting job statuses for jobs, you can filter and view only the current jobs in the
job selection dialog box in Tekla PowerFab and in Tekla PowerFab Go.

Estimating 366 Set up the Estimating module



1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job whose status you want to change. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. Select the desired job status in the list.

4. Click OK.

Note that only open jobs are available in Tekla PowerFab Go.

You can filter jobs by selecting status in the module navigation tree.

See also

Job status maintenance (page 219)

Manage estimating jobs (page 363)

Open an estimating job (page 471)

Modify an estimating job (page 481)

Manage accessories
Accessories are frequently used items that can be added to any estimate. For
example, stiffeners, gussets, base and cap plates, and embeds are good
examples of accessories. We recommend that you create all necessary
accessories at once before starting to create estimates, so that working in the
Estimating module is as quick and efficient as possible.

We recommend that you create, modify, and delete accessories in Accessory
Maintenance. You can also create accessories in an estimating job, but these
job-specific accessories cannot be saved to the accessory library, so they
cannot be reused in other estimating jobs.

To access the Accessory Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Accessory Maintenance .

The Accessory Maintenance dialog box opens.
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Create an accessory
The information that you enter for the accessory identifies the accessory
together with the material cost and the required labor time.

1. Click New.

2. If necessary, type a part number for the accessory. 

Assigning part number allows you to add an accessory to an estimating
item simply by selecting it in the item properties. Part numbers also make
identifying accessories easier. However, note that if you add an item to
the estimate by selecting the part number, you cannot modify the
properties of the accessory in the estimating job.

3. Type a description for the accessory.

4. Determine the remaining properties of the accessory: 

Option Description
Quantity The number of accessories per item to which they

are added.
Shape The material shape of the accessory.
Dimensions The material size of the accessory.
Length The length of the accessory.
Grade The material grade of the accessory.
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Option Description
Type The labor code of the accessory.
Extra The estimate extras applied to the accessory.

To add estimate extras, double-click the Extra field.
Holes The number of holes in the accessory.
Web Holes The number of web holes in the accessory.
Stiffeners The number of stiffeners in the accessory.
Copes The number of copes in the accessory.
Hrs/Pc The number of hours spent on the accessory.
Manual Cost The cost for the accessory that you can enter

manually.

The manual cost is optional, and it overrides the
pricing information in the pricing database.

MainPc When selected, the item to which the accessory is
added is considered a main piece.

Comment An optional and additional comment on the
accessory.

Erect Hrs The number of hours spent on erecting the
accessory.

Erect Cost The cost of erecting the accessory.
Prod. Code The production code applied to the accessory.
Camber The camber size used with the accessory. For

example, the value can be 3/4" or 19 mm.
Holes w/o Bo The number of holes per piece in the accessory. No

bolts will be added.
Top Flg Holes, Bot Flg
Holes

The number of top flange holes or bottom flange
holes per accessory.

Welded Studs The number of welded studs per accessory.
Detailing Hrs The number of hours spent on erecting the

accessory.
Detailing Cost The amount of money used for erecting the

accessory.
Cost/Pc A cost per piece that is added to the material cost

of the accessory.

NOTE The visible input fields and their order partially depend on the
settings that you have defined in Estimating Maintenance. You
can modify the input fields and their order via Maintenance -->
Estimating --> Edit Input Fields .
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5. If necessary, select the linked material shapes and sizes to which the
accessory can be added by clicking Edit. 

Selecting linked material shapes and sizes is optional. However, limiting
the use of the accessory to the selected material shapes and sizes makes
working easier, as you do not need to scroll through all existing accessory
options whenever you want to add an accessory. If you do not select
linked material shapes, the accessory can be added to all material items.

6. In the Filter dialog box, click the arrow buttons to move the desired
material shapes and sizes to the Included list. 

Note that there are also lists at the bottom of the Filter dialog box that
allow you to select the material shapes.

7. Click OK.

8. Click Add to save the accessory.

Example: Create a stiffener for W12 beams

Note that the following example uses imperial units.

1. Click New.

2. Set the properties as follows:

a. Part #: W12m
b. Description: W12 Stiffener
c. Quantity: 1
d. Shape: PL
e. Dimensions: 5/16 x 4
f. Length: 0'-11
g. Grade: A36
h. Type: W (Baffle)

3. Click Edit and link the accessory to the range W 12 x 14 - W 12 x 152.

4. Click OK.

5. Click Add to save the accessory.

Copy accessories
1. In the accessory list, select the accessories that you want to copy. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

Estimating 370 Set up the Estimating module



2. Click Copy. 

Copies of the selected accessories are added to the list in the Accessory
Maintenance dialog box.

3. If necessary, define part numbers for the copied accessories.

4. Modify the properties of the copied accessories according to your needs.

5. Click Save to update the accessories.

Modify an accessory
1. In the accessory list, select the accessory that you want to modify.

2. Modify the properties according to your needs.

3. Click Save to update the accessory.

Modify multiple accessories at once
1. In the accessory list, select the accessories that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Global Edit - Selected 

The Accessory Global Edit dialog box opens.

3. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

4. Click Update.

The properties of the selected items are updated.

Delete an accessory
1. In the accessory list, select the accessories that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the accessories, click Yes in the confirmation dialog
box.

View, customize, print, and export accessory reports
Accessory reports show lists of existing accessories and accessory parts. You
can view the reports, print them, or export them to another file format. You
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can also create a customizable copy of the accessory reports and modify it
according to your needs.

1. In the Accessory Maintenance dialog box, click the Accessory
Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Selection dialog box, select the report that you want to
view, customize, print, or export.

4. Do one or more of the following: 

To Do this
View the report • In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report
Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Customize the report a. At the top right corner of the dialog box, click
Design.

A customizable copy of the report opens.

b. Customize the report according to your needs.
Print the report a. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. To confirm printing the selected report, click
Yes in the confirmation dialog box.

d. In the Select Printer dialog box, click a printer
to select it.

e. Click Print or press F2 on the keyboard.
Export the report a. In the Report Selection dialog box, click

Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Modify the file name according to your needs.

e. Browse to the location where you want to save
the exported file, and click Save.
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To Do this
f. To attach the exported file to a Microsoft

Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. In the Report Selection dialog box, click
Export.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Manage accessories (page 367)

Create and manage parametric assemblies
Parametric assemblies can be any fabricated items that may vary in height,
width, or length, or according to any other variables that you define. For
example, stairs, ladders, and handrails are common parametric assemblies
can be created in Tekla PowerFab. Existing parametric assemblies can be
added to an estimate while working in the Estimating dialog box.

See also

Create a parametric assembly (page 373)

Example parametric assembly: Roof ladder without cage (page 378)

Modify a parametric assembly (page 381)

Import assemblies and parametric assemblies (page 231)

Export parametric assemblies (page 382)

Delete a parametric assembly (page 383)

Create a parametric assembly
You can use parametric assemblies in any estimating job, and modify the
variable values according to your needs. Tekla PowerFab calculates the
parametric assembly according to the values you have given.

Note that all information entered in the Parametric Assembly dialog box will
be added to the estimate when the parametric assembly is selected.

TIP To see a concrete example of creating a parametric assembly, see Example
parametric assembly: Roof ladder without cage (page 378).

To create parametric assemblies, do the following:
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1. Create and name the assembly template

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Parametric Assembly
Maintenance . 

The Select Parametric Assembly dialog box opens.

3. Click Add.

4. Name the parametric assembly.
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5. To use an existing parametric assembly as the basis for the new one,
select the parametric assembly in the Template list. 

Copying the information from an existing parametric assembly speeds up
creating a parametric assembly. However, you can also create the
parametric assembly from scratch.

6. Click Add.

2. Create variables, items, and formulas

Variables define the parametric calculations to be used.

1. Go to Parametric Assembly Maintenance --> Maintenance -->
Estimating. 

The Select Parametric Assembly dialog box opens.

2. To open a parametric assembly, double-click it.

3. In the Parametric Assembly ribbon tab, select Parametric Assembly
Variables. The Parametric Assembly Variables dialog box opens.

4. In the dialog box, click New.

5. Enter a name and description for the variable.

6. Select a suitable variable type:

• Integer Number: a whole number. The Integer Number variable type
is normally used for quantity type calculations where no fractions are
required.

• Decimal Number: a decimal number. The Decimal Number variable
type has various uses.

• Length - Feet, Inches, Fractions - Meters: length. The correct input
format is determined in the name of the variable type.

• Length - Inches, Fractions - Millimeters: length. The correct input
format is determined in the name of the variable type.

• Length - Decimal Feet - Meters: length. The correct input format is
determined in the name of the variable type.

• Length - Inches, Fractions - Millimeters: length. The correct input
format is determined in the name of the variable type.

• Dimension: allows you to change the dimension of the material by
adding another variable. For example, you can have one material
dimension for a short span and one for a long span in the assembly.
The length applied to the span variable then determines which
dimension variable is used. The dimension variable can also be set
when adding the parametric assembly to an estimating job.

• Property from EST Line Item: uses the selected property of the
estimating item that was selected when the parametric assembly was
added to the estimating job.
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• Property from Assembly Line Item: uses the selected property of an
item within the parametric assembly. Note that you need to select the
desired property in the Property list, and type the item number in the
From Item # field.

7. If necessary, define a default value for the variable.

8. Click Add. 

Repeat steps 4 to 6 to add all necessary variables.

9. To close the Parametric Assembly Variables dialog box, click the Close
button (X) in the upper-right corner.

10. To add items to the parametric assembly, click New at the bottom of the
Parametric Assembly dialog box.

11. Create a comment as the first item in the parametric assembly:

a. Set Quantity to 1 and press Enter.

b. Set Shape to CO and press Enter.

c. In the Description field, type the parametric assembly name and
press Enter.

d. Click Add.

Adding a comment as the first item of the parametric assembly makes it
easier to recognize the parametric assembly in an estimating job.

12. To add another item, click New.

13. Enter properties for the item.

14. For properties that vary in the assembly, click the Formula button and
define a formula using the previously created variables. 

For more information on creating formulas, see Create formulas
(page 383).

15. If you need to add additional labor or clips to the item, click Additional
Labor & Clips and determine their properties. 

Additional labor operations could be, for example, welding, burning,
punching, or drilling. You can either determine the properties manually, or
use formulas to use conditions for the additional labor and clips.

Note that standard clips will be added according to the selected labor
code when you add the parametric assembly to an estimate.

16. Once you have determined all necessary properties for the item, click
Add. 

Repeat steps 9 to 12 to add the remaining items to the parametric
assembly.
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3. Test the parametric assembly

We recommend that you test all parametric assemblies that you have created
to verify that the calculations work as expected.

1. Go to Parametric Assembly Maintenance --> Maintenance -->
Estimating. 

The Select Parametric Assembly dialog box opens.

2. To open a parametric assembly, double-click it.

3. In the Parametric Assembly ribbon tab, select Test Parametric
Assembly. The Parametric Assembly Variables dialog box opens.

4. In the dialog box, enter a value for a variable and click Set Value. 

For example, you could set the Ladder Length variable created in our
example to 20'-0 and Ladder Width to 1'-6".

Repeat step 3 for each variable in the parametric assembly.

Estimating 377 Set up the Estimating module



5. Click Calculate Parametric Assembly. 

You can now see the results of the calculations. Verify that the information
is correct.

6. To view the additional labor and clips that were added for the selected
item when creating the parametric assembly, click Additional Labor &
Clips.

7. To close the results, click the Close button (X) in the upper-right corner.

8. Do one of the following:

• To re-test the calculations, set new values for the variables.

• To close the Parametric Assembly - Variables dialog box, click the
Close button (X) in the upper-right corner.

Example parametric assembly: Roof ladder without cage
The following example describes creating a roof ladder as a parametric
assembly in Tekla PowerFab. The example can be helpful when you are
learning to create parametric assemblies yourself.

1. Create a description for the parametric assembly

1. Click New and create an item with the following properties: 

• Shape: CO
• Description: Roof ladder (no cage)

2. Click Add.

2. Create variables for calculating the ladder length and the number of rungs
and collection clips

To create variables for calculating appropriate length, and the number of
rungs and connection clips for the ladder, do the following:

1. Click the Parametric Assembly ribbon tab.

2. On the menu, select Parametric Assembly Variables.

3. Create the following variables without adding default values: 

• Overall length of the ladder

• Variable Name and Variable Description: Ladder Length
• Variable Type: Length – Feet, Inches, Fractions –

Meters
• Overall width of the ladder

• Variable Name and Variable Description: Ladder Width
• Variable Type: Length – Feet, Inches, Fractions –

Meters
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4. To close the Parametric Assembly Variables dialog box, click the Close
button (X) in the upper-right corner.

3. Create side rails

1. Click New and create an item with the following properties: 

• Quantity: 2
• Shape: FB
• Dimensions: ½ x 3

2. To create a formula for calculating the length, click Formula next to
Length.

3. In the Formula dialog box, do the following:

a. Clear the existing text in the box at the top of the dialog box.

b. In the Additional Variables list, select Ladder Length.

c. Click Add Variable.

d. To have the ladder project beyond the landing elevation, type + and
the length in feet and inches without a space between. 

The formula should now read approximately: [Ladder Length]
+3'6.

e. Click OK to save the length formula and return to the Parametric
Assembly dialog box. 

Note that whenever a property is calculated with a formula, it is
marked with (F) in the Parametric Assembly dialog box.

4. Click Add.

4. Create the rungs

1. Click New.

2. To create a formula for calculating the number of rungs, click Formula
next to Quantity. 

We want to calculate the number of rungs determined by the ladder
length, starting 6 inches above the landing. The result should then be
divided by 1'-0.

3. In the Formula dialog box, do the following:

a. Clear the existing text in the box at the top of the dialog box.

b. In the Parametric Assembly Variables list, select Ladder Length.

c. Click Add Variable.

d. Type +6".

e. Add parentheses () around [Ladder Length]+6".
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f. Type /12" directly after the right parenthesis.

g. Click OK to save the length formula and return to the Parametric
Assembly dialog box.

4. Set the shape and dimension properties of the rungs as follows: 

• Shape: RD (round bar)

• Dimensions: ¾"
5. To create a formula for calculating the length of the rungs, click Formula

next to Length.

6. In the Formula dialog box, do the following:

a. Clear the existing text in the box at the top of the dialog box.

b. In the Parametric Assembly Variables list, select Ladder Width.

c. Click Add Variable.

d. Click OK to save the length formula and return to the Parametric
Assembly dialog box.

7. Click Add.

5. Create the connection clips

1. Click New.

2. To create a formula for calculating the number of clips , click Formula
next to Quantity. 

We want to calculate the number of clips based on the length of the
ladder.

3. In the Formula dialog box, do the following:

a. Clear the existing text in the box at the top of the dialog box.

b. Type CEILING.

c. Type the left parenthesis (.

d. In the Parametric Assembly Variables list, select Ladder Length.

e. Click Add Variable.

f. After the variable, type /6').

g. To calculate enough clips for both sides, type *2.

h. To include the first and last clips for both rails, type +2. 

The calculation should read CEILING([Ladder Length]/6’)*2+2.
This means that Tekla PowerFab calculates the total ladder length
divided by 6’-0, rounds it to the nearest foot, multiplies the result by 2,
and then adds 2 more connection clips.
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i. Click OK to save the length formula and return to the Parametric
Assembly dialog box.

4. Set the shape and dimension properties as follows: 

• Shape: FB
• Dimensions: 3/8 x 4

5. Click Add.

6. View the result

You can now view the result and test the parametric assembly.

For more information on testing a parametric assembly, see Create a
parametric assembly (page 373).

Modify a parametric assembly
Existing parametric assemblies can be modified later on. You can rename the
parametric assembly, or modify the items that form the parametric assembly
or the variables used in calculations.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Parametric Assembly
Maintenance . 

The Select Parametric Assembly dialog box opens.
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3. In the dialog box, select the desired parametric assembly that you want to
modify.

4. Do any of the following: 

To Do this
Change the name of the
parametric assembly

a. At the bottom of the Select Parametric
Assembly dialog box, click Set Name.

b. Type a new name for the assembly.

c. Click OK.
Modify items a. At the bottom of the Select Parametric

Assembly dialog box, click Open.

b. Select the item that you want to modify.

c. Modify the properties of the item according to
your needs.

Among other things, you can change the
quantity, shape, dimensions, or length of the
item.

d. Click Edit to save the changes.
Modify variables a. At the bottom of the Select Parametric

Assembly dialog box, click Open.

b. Click the Parametric Assembly ribbon tab.

c. On the menu, select Parametric Assembly
Variables.

d. Select the variable that you want to modify.

e. Modify the variable name, description, variable
type, and default value according to your
needs.

f. Click Edit to save the changes.

5. To close the Select Parametric Assembly dialog box, click the Close
button (X) in the upper-right corner.

See also

Create a parametric assembly (page 373)

Example parametric assembly: Roof ladder without cage (page 378)

Delete a parametric assembly (page 383)

Export parametric assemblies
You can export a parametric assembly as a text file.

1. Click the Maintenance ribbon tab.
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2. On the menu, select Estimating --> Parametric Assembly
Maintenance . 

The Select Parametric Assembly dialog box opens.

3. In the dialog box, select the parametric assembly that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click the Parametric Assembly ribbon tab.

5. On the menu, select Export Selected Parametric Assemblies.

6. In the Save As dialog box, browse to the location where you want to save
the text file.

7. Name the text file.

8. Click Save. 

The parametric assembly is saved in the selected location as a text file.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

Delete a parametric assembly
You can delete any parametric assemblies that you do not use. Note that
deleting a parametric assembly cannot be reversed, so a deleted assembly can
no longer be used in Tekla PowerFab.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Parametric Assembly
Maintenance . 

The Select Parametric Assembly dialog box opens.

3. In the dialog box, select the parametric assembly that you want to delete.

4. Click Delete.

5. To permanently delete the selected parametric assembly, click Yes in the
confirmation dialog box.

Create formulas
You can create formulas that Tekla PowerFab uses to calculate values. For
example, you can create a formula to define the size of an angle used in a
parametric assembly or to define the cost of an estimate extra.

Access Formula dialog box
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1. Access the Formula dialog box in one of the following ways:

• For estimate extras, do the following steps:

• a. Go to Maintenance --> Estimating --> Labor Maintenance -->
Estimate Extras.

• b. Click the Formula button on any of the tabs.

For more information, see Create estimate extras (page 402).

• For parametric assemblies, do the following steps:

• a. Go to Maintenance --> Estimating --> Parametric Assembly
Maintenance.

• b. Select a parametric assembly and click Open.

• c. Click the Formula icon  on the right side of any input field.

For more information, see Create and manage parametric assemblies
(page 373).

• For adjusting labor codes, do the following steps:

• a. Go to Maintenance --> Estimating --> Labor Maintenance -->
Labor Codes.

• b. Click the Labor Code Maintenance ribbon tab and select
Formula Maintenance.

• c. Click Edit Formula.

For more details, see Add, modify, and delete formulas in Adjust labor
codes (page 407)

The Formula dialog box opens.
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The formula functions allow you to add the following items to the formula:

• Standard Variables: The properties of a material item

• Add Variable: Any previously added variables related to the
parametric assembly or the estimate extra

• IF / THEN / ELSE / ENDIF: IF/THEN/ELSE/ENDIF statements

• The CEILING, FLOOR, ROUND: Rounding functions.

• CEILING always rounds up.

• FLOOR always rounds down.

• ROUND rounds up at half and down by less than half.

• Several trigonometry functions, such as SIN, COS, and HYP.
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Example formula: Calculate the cost of an estimate extra

In this example, we want the estimate extra to add a cost of $100 if the length
of the item is less than or equal to 40'. If the length is greater than 40', the
added cost should be $150.

In this case, we need the following formula:

IF ([Length] <= 40') THEN (100) ELSE (150) ENDIF
1. In the Estimate Extra dialog box, select the Cost Expression option, and

click Formula.

2. In the Formula dialog box, click the IF / THEN / ELSE / ENDIF button.

3. Go to the parenthesis after IF.

4. In the Additional Variables list, select Length.

5. Click Add Variable.

[Length] appears inside the parenthesis after IF.

6. Enter a space after [Length].

7. After the space, type <=40'
8. Go to the parenthesis after THEN.

9. Type 100
10. Go to the parenthesis after ELSE.

11. Type 150
The formula is now ready.

12. Click OK to close the Formula dialog box and use the formula in the
estimate extra.

TIP You can nest IF/THEN statements by adding additional IF/THEN statements in
the ELSE section. Example: IF (Length<=40') THEN (100) ELSE (IF
(<=60') THEN (150) ELSE (200) ENDIF) ENDIF.

Manage default cleaning types and clean systems
You can add and modify default cleaning types and costs, and create default
clean systems in Cleaning Maintenance.
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Create default cleaning types
In Cleaning Maintenance, you can view and modify the existing cleaning
types and cleaning costs, add new cleaning types, and set the default cleaning
type used in all future estimating jobs.

1. Go to Maintenance --> Estimating Maintenance --> Cleaning
Maintenance. The Cleaning Maintenance dialog box opens.

2. Modify the properties as needed. 

To Do this
Add a new cleaning type a. Click New.

b. In Cleaning Type, type an
abbreviation for the cleaning
type.

c. In Description, type a
description for the cleaning type.

d. In Clean Rate, type the cleaning
rate

e. In Abrasive Use, type the
amount of abrasive use.
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To Do this
f. To set the cleaning type as the

default cleaning type for new
estimating items, select the
Default checkbox.

g. Click Add.
Modify a cleaning type a. Select the cleaning type in the

list.

b. Modify the cleaning type
abbreviation, description,
cleaning rate, or amount of
abrasive use.

c. To set the cleaning type as the
default cleaning type for new
estimating items, select the
Default checkbox.

d. Click Save.
Delete a cleaning type a. Select the cleaning type in the

list.

b. Click Delete.

c. To permanently delete the
cleaning type, click Yes.

Note that you can create cleaning systems that contain various cleaning
types. For more information, see Manage default cleaning types and clean
systems (page 386).

Define cleaning costs
Cleaning costs, or the cost of surface preparation for finish, is a combination of
the labor hours and the required material.

1. Assign a Clean Rate to each cleaning type in Maintenance --> Estimating
--> Cleaning Maintenance.

2. Assign the labor rate to the Clean labor group in Maintenance -->
Estimating --> Labor Maintenance --> Labor Groups

3. Determine the cost of the hours by the Labor Rate assigned to the labor
group in Maintenance --> Estimating --> Labor Rates.

4. Set the cost of the abrasive material in the Cleaning - Abrasive Price field
in Maintenance --> Estimating --> Fabricator Information.
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Create default clean systems
Clean systems allow you to apply more than one cleaning type to estimating
items. You can create default cleaning system which can be used for all new
estimating jobs.

1. Go to Maintenance --> Estimating Maintenance --> Cleaning
Maintenance. The Cleaning Maintenance dialog box opens.

2. Click Clean Systems.

3. Click New Clean System. 

The Cleaning System Maintenance dialog box opens.

4. In Description, type a description for the cleaning system.

5. Use the arrow buttons to move the cleaning types that you want to
include in the clean system to the Cleans Included list.

6. To add or reduce the number of times each cleaning type requires, change
the value in the Quantity field.

7. If you only want to apply the cleaning system if cleaning is included in the
labor code of the item, select the Check Labor Code For Include
Cleaning checkbox.

8. To set the clean system as the default clean system used for new items,
select the Default checkbox.

9. Click Add Clean System.

Manage default paint types and paint systems
You can add, modify, and delete default paint types and paint systems in Paint
Maintenance.
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Create default paint types
In the Paint Maintenance dialog box, you can add paint types that are
regularly used in your shop. You can also modify, and delete these default
paint types.

NOTE You need to define the default paint type before before creating the
estimating jobs where you want to use it.

1. Go to Maintenance --> Estimating --> Paint Maintenance. 

The Paint Maintenance dialog box opens.

2. Select the Paints tab.

3. Add or modify the properties as needed. 

To Do this
Add a new paint type a. Click New Paint

b. Define the paint properties.

c. Click Add Paint.

The new paint type is added.
Modify a paint type a. Select the paint type.

b. Modify the properties.
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To Do this
c. Click Save Paint.

Your changes are saved.
Delete a paint type a. Select the paint type.

b. Click Delete Paint

c. To permanently delete the
selected paint type, click Yes.

The paint type is permanently
deleted.

The paints listed on the Paints tab are applied to all painted items by default
unless you assign a paint system to them.

Create default paint systems
You can define a default paint system that consists of one or more paint
products, for each of which you can define the number of coats needed. When
you select a paint system in an estimating job, Tekla PowerFab calculates the
applicable costs and adds them to the estimate.

NOTE • You need to define a default paint system before creating the
estimating jobs where you want to use it.

• If you do not assign a paint system to the items on the Paint
Systems tab, all paints listed on the Paints tab will be applied to all
painted items by default.

1. Go to Maintenance --> Estimating --> Paint Maintenance. 

The Paint Maintenance dialog box opens.

2. Select the Paint Systems tab.

3. Add or modify the properties as needed. 

To Do this
Add a new paint system a. Click New Paint System.

b. Type a description for the paint
system in the Description field.

c. Click the arrow buttons to move
the paint types that you want to
include to the Paints Included
list.

d. To change the number of coats,
select an included paint type and
type a new value in the Quantity
field.
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To Do this
e. To set the paint system as the

default paint system for new
estimating jobs, select the
Default checkbox.

f. Click Add Paint System.
Modify a paint system a. Select the paint system in the list.

b. Change the description, included
paints, or the number of paint
coats according to your needs.

c. To set the paint system as the
default paint system for new
estimating jobs, select the
Default checkbox.

d. Click Save Paint System.
Delete a paint system a. Select the paint system in the list.

b. Click Delete Paint System.

c. To permanently delete the paint
system, click Yes.

You can also create job-specific paint systems. For more information, see
Create an estimating job (page 454).

Modify freight pricing
In the Freight Maintenance dialog box, you can modify freight pricing used in
Estimating. The freight information that you set in the Freight Maintenance
dialog box can be applied to all estimates.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Freight Maintenance .
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3. To change the costs of inbound freight and purchased items, in the
Freight section of the Freight Maintenance dialog box, modify the trailer
capacity, jobsite freight costs, and minimum freight charges.

4. To update the inbound freight costs, click Save at the bottom of Freight
section.

5. Select or clear the Jobsite Freight $/CWT or Jobsite Freight $/KG
checkbox according to your needs:

When the Jobsite
Freight $/CWT or

Jobsite Freight $/KG
checkbox is...

It means that...

selected • Tekla PowerFab calculates freight as dollar per
hundredweight or per kilogram.

• When the total shipping weight is less than the
trailer capacity, the Freight Partial Truck
multipliers are added to the total calculation for
Freight Per CWT/KG.

cleared • Tekla PowerFab calculates freight as dollar per
mile (the Freight Per Mile value is used).

• When Freight Per Mile is less than Minimum
Freight Charge Per Job, the Minimum Freight
Charge Per Job is used instead.
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Add or update the weight range and multiplier for different load sizes
The Freight Partial Truck options are used together with the Jobsite Freight
$/CWT/Freight Per CWT/KG options when the Jobsite Freight $/CWT/Jobsite
Freight $/KG checkbox is selected.

The Freight Partial Truck pricing also initiates a multiplier to the Freight Per
Mile cost.

• Do any of the following: 

To Do this
Add a new weight range
and multiplier

1. In the Freight Partial Truck section, click
New.

2. Type the minimum and maximum weight.

3. In the Multiplier field, type the base load cost
multiplier.

The multiplier value is used to calculate the
Freight Per Mile cost for loads that fall within
the weight range.

4. Click Add.
Modify an existing
weight range and
multiplier

1. In the Freight Partial Truck section, click to
select a distance in the list.

2. Modify the weight range or the multiplier
value.

3. Click Edit to save the changes.

Add or update freight pricing per hundedweight or kilogram
• Do any of the following: 

To Do this
Add new pricing
for a distance

1. In the Freight Per CWT/KG section, click New.

2. Define values for minimum miles, maximum miles,
and cost.

3. Click Add.
Modify the pricing
of an existing
distance

1. In the Freight Per CWT/KG section, click to select a
distance in the list.

2. Modify the cost.

3. Click Edit to save the changes.
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Adjust labor information
Before you start working in the Estimating module, we recommend that you
view the information in the Tekla PowerFab labor database, including labor
groups, labor codes, and material-specific labor times. If necessary, you can
then adjust this information to reflect the labor data of your shop.

NOTE Before making changes to the labor information, we recommend that you
export the labor information and save it in a text file. This way, you can re-
import the information later, if necessary.

1. Click the Maintenance ribbon tab.

2. On the menu, go to Estimating --> Labor Maintenance .

3. Select the desired menu command.

Calculate labor time
The labor database consists of various elements that work together to
calculate accurate labor times.

Labor rates

Labor rates are hourly rates for specific fabrication functions, such as detailing,
erecting, and shop labor.

Labor rates are assigned to different labor groups.

For instructions on adjusting labor rates, see Create and modify labor rates
(page 445).
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Labor groups

Labor groups bring together the assigned labor times and the hourly labor
rates. A labor group can be described as a bucket where you put labor time
and assign a labor rate.

The labor group is assigned to the labor operations. The labor from the labor
operation is then summarized in the labor group, and a labor rate is applied.

For instructions on adjusting labor groups, see Create, modify, and delete
labor groups (page 411).

Labor operations

Labor operations bring together the labor group and the extrapolation factor.

A labor operation is assigned an extrapolation factor and the time defined in
the labor standard. Based on this information, Tekla PowerFab calculates the
amount of labor based on the properties of the material.

Labor operations can be assigned through labor codes, estimate extras, or in
some cases, additional labor.

To use a labor operation in an estimating job, you need to add it to a labor
code in Labor Codes.

The labor time used for each labor operation is determined in Labor
Standards Maintenance. For more information, see Adjust labor standards
(page 417).

For instructions on adjusting labor operations, see Create, modify, and delete
labor operations (page 414).

Labor codes

Labor codes are the primary method of applying labor timings to an estimate
item.

Labor codes group labor operations together with formulas that calculate
burn, drill, punch, and weld time, the material and labor for standard clips.

The estimating items that do not belong to any material group, such as
comments, hardware, and buy-out items, are not included in labor codes.

Labor codes also include the assignment of shop or field bolts, including the
cleaning and splicing when those operations are required.

For a visual representation of labor codes, see Labor codes (page 396).

Labor codes
This is a visual representation of the default labor codes in Tekla PowerFab.
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See also

Adjust labor codes (page 407)

Create assemblies
You can create a library of commonly used assemblies, or bid items, that you
can use in all estimating jobs. Assemblies can contain multiple items with
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different shapes, dimensions, finishes and categories, as well as accessories
and parametric assemblies. By adding an assembly to your estimating job, you
are actually adding all these items at once.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Assemblies .
The Select Assembly dialog box opens.

3. Click Add.

4. Type a name for the assembly, and click OK. 

The Assembly Maintenance dialog box opens.

(1) Summary:

• The quantity, length, weight, surface area, and work time in hours for
each of the selected items, all of the selected items, all items visible in
the job, and the entire job

• The pounds per hour and hours per ton calculations for the selected
items, all items visible in the job, and the entire job

(2) Find: Click to find items of a specific shape, material grade, or material
dimension, or a particular item in the assembly. For instructions, see Find
estimating items (page 496).

(3) Navigation tree: Filter to view specific items.

5. Click New to add the first item to the assembly.

6. Create a comment item as the header line of the assembly:

a. Set Shape to CO.
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b. Click the Dimensions field.

c. Type a description for the assembly, and press Enter.

d. Click Add

7. To add more items:

a. Click New.

b. Define the quantity, shape, dimensions, and other properties for the
item that you are adding.

c. Click Add.

8. To add additional labor and clips to an item:

a. Select the item in the item list.

b. Expand the Additional Labor and Clips section.

c. Click Edit.

d. In the Assembly Item dialog box, click New under Additional Labor
or Clips, depending on the type of item you are adding.

e. Define the item properties.

f. Click Add.

g. To close the dialog box, click the Close button (X) in the upper-right
corner.

9. To add accessories or parametric assemblies to the assembly: 

To Do this
Add an accessory a. Click the Assembly

Maintenance ribbon tab.

b. On the menu, select Add
Accessory.

c. In the Select Accessory dialog
box, select the accessory that you
want to add.

d. Use the checkboxes under the
accessory list to select if you want
to use the finish and category of
the original item, or set the
category as the accessory
description.

e. Click Add Selected.

The accessory is added to the
assembly.

Add a parametric assembly a. Click the Assembly
Maintenance ribbon tab.

Estimating 399 Set up the Estimating module



To Do this
b. On the menu, select Add

Parametric Assembly.

c. Double-click the parametric
assembly that you want to add.

d. If necessary, in the Parametric
Assembly - Variables dialog box,
set values for the variables.

e. Click Calculate Parametric
Assembly.

f. Click Add Parametric Assembly.

The parametric assembly is added to
the assembly.

10. When the assembly is ready, click the Close button (X) in the upper-right
corner.

The assembly is now available for all estimating jobs. You can also see the
assembly in the Select Assembly dialog box.

You can also create job-specific assemblies. For more information, see Add an
assembly (page 494).

See also

View, rename, copy, and delete assemblies (page 400)

View, rename, copy, and delete assemblies
You can view, rename, and delete both globally available and job-specific
assemblies in the Assembly Maintenance dialog box. Furthermore, you can
copy job-specific assemblies to the assembly library, so that they will be
available in all estimating jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Assembly
Maintenance . 

The Assembly Maintenance dialog box opens.

You can view the existing global assemblies in a list on the left side, and
the job-specific assemblies on the right side.

3. According to your needs, do any of the following: 

To Do this
Rename an assembly a. Select an assembly in either of the lists.

b. Type a new name in the empty field under the
list.
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To Do this
c. Click Rename.

Delete an assembly a. Select an assembly in either of the lists.

b. Click Delete under the list.

c. To permanently delete the assembly, click Yes
in the confirmation dialog box.

Copy a job-specific
assembly to the
assembly library

a. In the Job list, click to select the estimating job
from which you want to copy an assembly.

b. Select the assembly that you want to copy.

c. Click <Copy.

The assembly is now available for all estimating
jobs.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Create assemblies (page 397)

Adjust labor times for column splices
In Column Splices Maintenance, you can adjust the labor times for different
times of column splices. These labor times will be used in all estimates by
default. If necessary, create new column splice types or modify the existing
ones.

To use column splices, you need to add them to labor codes. For more
information, see Adjust labor codes (page 407).

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Column
Splices .

3. In the Column Splices Maintenance dialog box, do any of the following: 

To Do this
Create a new column
splice type

a. Click New.

b. In the Type field, enter a letter indicator.

c. Type a description and define the labor time in
hours.

d. Click Add.
Modify an existing
column splice type

a. Select a column splice type in the list.

b. Modify the letter indicator, description, and
labor time according to your needs.
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To Do this
c. Click Edit to save the changes.

Delete a column splice
type

a. Select a column splice type in the list.

b. Click Delete.

c. To permanently delete the column splice type,
click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Adjust labor times for copes, punches, and stiffeners
In Cope Punch Stiffener, adjust the default labor times for the layout of
copes, punches, and stiffeners. For stiffeners, you can also adjust the fit-up
time. The labor times that you define will be used in all estimating jobs.

• To define the labor time used for cutting the cope, see Adjust labor times
for burning (page 427).

• To modify cope and stiffener weld settings, see Modify labor operation
settings (page 442).

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Cope /
Punch / Stiffeners .

3. In the Cope Punch Stiffener dialog box, type labor times for the different
copes, punches, and stiffeners.

4. Click Save.

Create estimate extras
Create estimate extras to add costs and labor for commonly used special
items when there are no applicable labor codes in Tekla PowerFab. Estimate
extras allow you to add as much labor and cost to a single item in an
estimating job as needed. Estimate extras are often used for all labor done
outside of your shop. For example, you can create estimate extras for items
such as camber, rolling, and forming.

1. Click the Maintenance ribbon tab

2. On the menu, select Estimating --> Labor Maintenance --> Estimate
Extras .

The Estimate Extra dialog box opens.
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Create an estimate extra

1. In the Estimate Extra dialog box, click New. 

NOTE To create copy of an estimate extra and use it as the basis of a
new one, select the existing estimate extra in the list and click
New - Carry Over.

2. In the Code field, type an abbreviation that helps you identify the estimate
extra. 

The abbreviation will be shown when you apply estimate extras to
estimating items.

3. Type a description, group, and sub-group for the estimate extra. 

Groups and sub-groups are only used for filtering the estimate extras in
the dialog box.

4. Click Add.

5. Click the other tabs to enter more information about the estimate extra. 

According to your needs, see any of the following instructions:

Add labor code formulas

You can add new labor code formulas in the Labor Code Maintenance dialog
box. For more information, see Adjust labor codes (page 407).

For more information on creating formulas, see Create formulas (page 383).

1. Open the Labor Code Formulas tab.

2. Click New Formula.
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3. In the Formula list, select an existing labor code formula.

4. Do one of the following:

• In the Quantity field, enter the number of times the formula is used
for the estimate extra.

• Click Formula on the right side of the Quantity field and create a
quantity formula.

5. Click Add Formula. 

Add as many formulas as necessary to define the extra labor.

6. Click Save at the bottom of the dialog box.

Add child estimate extras

Child estimate extras allow you to add more than one labor operation to the
main estimate extra item. In practice, this means that you can group many
labor functions together into one estimate extra.

1. Open the Child Estimate Extras tab.

2. Click New Child Extra.

3. In the Child Estimate Extra list, select an existing estimate extra that you
want to add as a child item for the current estimate extra.

4. Do one of the following:

• In the Quantity field, enter the number of times the formula is used
for the estimate extra.

• Click Formula on the right side of the Quantity field and create a
quantity formula.

5. Click Add Child Extra.

6. Repeat steps 1 to 5 to add all necessary child estimate extras.

7. Click Save at the bottom of the dialog box.

Add costs

1. Open the Cost tab.

2. According to your needs, do any of the following: 

To Do this
Add a fixed cost a. Select the Cost Value option.

b. Type the cost in the Cost Value field.

TIP If you want to change the units, right-
click in the Cost Value field and select
the new units.
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To Do this
Enter a formula for
calculating the cost

a. Select the Cost Expression option.

b. Click Formula.

c. Build the formula by entering the necessary
elements and adding variables.

d. Click OK.

3. To assign the cost to a specific category, select an option in the Cost
Directed To list.

4. Click Save at the bottom of the dialog box.

Add labor times for a labor group

1. Open the Labor tab.

2. Click New Labor.

3. In the Labor Group list, select the labor group for which you want to add
labor times regarding the estimate extra.

4. Do any of the following: 

To Do this
Add a fixed amount of labor time a. Select the Hours Value option.

b. Type the labor time in the Hours
Value field.

TIP If you want to change the
units, right-click in the
Hours Value field and
select the new units.

Add an expression to calculate the
labor time

a. Click the Hours Expression
option.

b. Click Formula.

c. Build the formula by entering the
necessary elements and adding
variables.

d. Click OK.

5. Click Add Labor.

6. Click Save at the bottom of the dialog box.

Add welding, burning, punching, or drilling

1. Open the Additional Operations tab.
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2. Click New Operation.

3. In the Operation list, select the labor operation.

4. In the Type list, select if the operation is manual, semi-automatic, or
automatic.

5. Enter values or create formulas for Quantity, Thickness, and Length.

6. Click Add Operation.

7. Click Save at the bottom of the dialog box.

Add labor code operations

Labor code operations allow you to add the same operations for the selected
estimate extra that are used for labor codes.

1. Open the Labor Code Operations tab.

2. Click New Operation.

3. Select the material group and the operation in the appropriate lists.

4. Type a quantity in the Quantity field, or click Formula to define a formula
that calculates the quantity.

5. Click Add Operation.

6. Click Save at the bottom of the dialog box.

View extrapolation factors
Extrapolation factors are variables that Tekla PowerFab uses in calculating the
labor times when labor applied to the materials. Extrapolation factors work
together with labor operations and labor groups to properly apply labor times
listed in labor standards. Extrapolation factors are also specific to certain labor
operations.

You cannot create any additional extrapolation factors, but simply view the
existing ones.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance -->
Extrapolation Factors .

3. In the Extrapolation Factor Maintenance dialog box, view the
extrapolation factors.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Create, modify, and delete labor groups (page 411)

Create, modify, and delete labor operations (page 414)
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Adjust labor standards (page 417)

Adjust labor codes
Labor codes group labor operations together with formulas. You can also add
more labor codes for common labor, such as adding sloped clips for bolted
connections. In the Estimating module, you can use a labor code for an item
by selecting it in the Type list.

For a visual representation on the preloaded labor codes, see Labor codes
(page 396).

To access the Labor Code Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Labor
Codes .

The Labor Code Maintenance dialog box opens.

Labor codes are always used by certain material groups, or types of shapes.
You can view the labor codes by material group by scrolling the labor code list.

In the Operations section, you can set the number of times an operation is
done within the labor code, or how many times the labor data from labor
standards is entered for each item. When the Qty column is blank, the
operation does not belong to the selected labor code.

In the Formulas section, you can see the formulas applied to calculating weld,
burn, drill, and punch times, along with the labor times spent for standard
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clips. You can then set the number of times a formula is applied. When the
Qty column is blank, the formula is not applied.

Change the default labor code of a material group

1. Scroll to find the material group.

2. Scroll to find and select the labor code that you want to set as the default
option.

3. Select the Default Labor Code checkbox.

4. At the bottom of the dialog box, click Save.

The selected labor code is now used by default for the material group in the
Estimating module.

Add a new labor code

1. At the bottom of the Labor Code Maintenance dialog box, click New.

2. In the Material Group list, select the material for which the new code is
added. 

The labor code will only be available for the selected material group.

3. Type an abbreviation and description for the labor code.

4. If you want to add a column splice to the labor code, select an option in
the Column Splice list.

5. To include cleaning in the labor code, select the Include Cleaning
checkbox.

6. To set the new labor code as the default labor code for the material group,
select the Default Labor Code checkbox.

7. On the Operations tab, ensure that the necessary operations are
included to the labor code. 

If necessary, use the Quantity (+) and Quantity (-) buttons above the list
to add or subtract the number of operations.

8. On the Formula tab, ensure that the necessary formulas are applied. 

If necessary, use the Quantity (+) and Quantity (-) buttons above the list
to add or subtract the number of formulas.

9. Click Add.

The new labor code is created and is available in the Estimating module.

Add or subtract operations and formulas

1. Scroll to find and select the material group.

2. Scroll to find and select the labor code.
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3. Select the operation or formula whose quantity you want to modify in the
labor code.

4. Above the list, click Quantity (+) or Quantity (-) to change the quantity.

5. Click Save.

Add column splices to a labor code

You can apply column splices to any labor code. Tekla PowerFab calculates the
labor time used in the column splice automatically.

1. Scroll to find and select the material group.

2. Scroll to find and select the labor code.

3. In the Column Splice list, select the column splice type that you want to
use for the labor code.

4. Click Save.

Column splices are added to the labor code.

Note that the required splice materials need to be added manually in the
Estimating module.

Add cleaning to a labor code

1. In the Material Group list, select the material group.

2. In the Labor Code list, select the labor code.

3. Select the Include Cleaning checkbox.

4. Click Save.

Add, modify, and delete formulas

1. Click the Labor Code Maintenance ribbon tab.

2. On the menu, select Formula Maintenance. 

The Formula Maintenance dialog box opens. The existing formulas are
displayed in the list on the left of the dialog box.

Each formula type includes options for quantity, weld, thickness and
length.

3. Do any of the following: 

To Do this
Create a new formula a. Click New Formula.
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To Do this
b. In the Formula Type list, select an option.

The formula type that you select determines
the variables for which you need to enter
values on the right side of the dialog box.

For example, if you select Burn, you will need
to determine the quantity, burn operation,
thickness, and length.

c. For each variable, click the Edit Formula
button on the right side of the field, and type a
value or build a formula.

d. To save the formula, click Edit Formula at the
bottom of the dialog box.

Modify an existing
formula

a. Select the formula that you want to modify.

b. If necessary, in the Formula Type list, select a
different option.

c. For each variable, click the Edit Formula on
the right side of the field, and modify the value
or formula according to your needs.

d. To change the position of an operation in the
formula, select the operation, and move it by
clicking the Move Up and Move Down
buttons.

e. To save the changes, click Edit Formula at the
bottom of the dialog box.

Delete an existing
formula

Note that the formula will be permanently deleted
and cannot be used in any labor code.

a. Select the formula that you want to delete.

b. Click Delete.

c. To permanently delete the formula, click Yes in
the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

View and print a list of labor codes

1. Click the Labor Code Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include particular material groups or labor codes, in the Labor
Code Report Filters dialog box, select a filter type in the Type list, and
click Select.
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4. Click the arrow buttons to move the material groups or labor codes that
you want to include to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, do any of the following according to
your needs: 

To Do this
View the labor code
list

• Click View.

Print the labor code
list

a. In the Report Selection dialog box, change the
number of the printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the labor code
list

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. Click Export.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete labor groups
Labor groups define the different labor types being used in an estimating job.
All labor times, except for the erection and detailing times, defined in Tekla
PowerFab are assigned to a particular labor group. Tekla PowerFab already
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contains labor groups for labor types such as cutting, cleaning, or loading. You
can view and modify the existing labor groups in the Labor Group
Maintenance dialog box, or add new ones according to the needs of your
shop.

To access the Labor Group Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Labor
Groups .

The Labor Group Maintenance dialog box opens.

Create a labor group

1. Click New.

2. In the Labor Group field, type a number that is not used by any existing
labor group.

3. Type a description for the labor group.

4. In the Activity list, select which activity the new labor group is associated
to.

5. In the Labor Rate list, select which labor rate the new labor group is
associated to. 

The labor rates are created in Fabricator Information. For more
information, see Create and modify labor rates (page 445).

The cost of the labor appears on the right side of the Labor Rate list.
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6. Click Add.

The new labor group is created. You can now assign different labor times, such
as burn time or manual labor time, to the labor group.

Modify a labor group

1. Select the labor group that you want to modify.

2. Modify the labor group number, description, activity, and labor rate
according to your needs.

3. Click Edit to save the changes.

Delete a labor group

Deleting a labor group is permanent and cannot be undone.

1. Select the labor group that you want to delete.

2. Click Delete.

3. To permanently delete the labor group, click Yes in the confirmation
dialog box.

Modify miscellaneous labor groups

In the Miscellaneous Labor Group dialog box, you can determine in which
labor group specific operations, such as cleaning or manual labor, are
included.

1. Click the Labor Group Maintenance ribbon tab.

2. On the menu, select Miscellaneous Labor Groups.

3. In the available lists in the Miscellaneous Labor Group dialog box, select
to which labor groups the different labor times are assigned.

4. Click Save.

View, print, or export the labor group list

1. Click the Labor Group Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Selection dialog box, do any of the following according to
your needs: 

To Do this
View the labor group list • Click View.
Print the labor group list a. Change the number of printed copies by

clicking the + and - buttons.
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To Do this
b. If necessary, click Select Printer, select which

device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the labor group
list

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. To export the labor group list, click Export.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete labor operations
Labor operations are operations that take place in the fabrication process,
such as unloading, painting, or moving material. A labor operation is assigned
an extrapolation factor and the time in the labor standard, so that Tekla
PowerFab can calculate the amount of labor based on the properties of the
material. You can view and modify the existing labor operations in Operation
Maintenance. You can also create new labor operations according to the
needs of your shop.

To modify the burn, drill, punch, and weld settings for labor operations, see
Modify labor operation settings (page 442).

To access the Operation Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Labor
Operations .
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The Operation Maintenance dialog opens.

Create a labor operation

1. Click New.

2. In the Code field, type a number that is not in use by another labor
operation.

3. Type a description for the labor operation.

4. In the Labor Group list, click to select the labor group to which the labor
operation is assigned.

5. In the Extrapolation Factor list, click to select the variable used in
calculating labor times.

6. Click Add.

The new labor operation is created.

Note that before you can use the labor operation in estimating jobs, you need
to add it to a labor code in Labor Codes (page 407) and enter the labor time in
Labor Standard Maintenance (page 417).

Modify an existing labor operation

1. Select a labor operation in the list.

2. Modify the code, description, labor group, and extrapolation factor
according to your needs.

3. Click Edit to save the changes.

Delete a labor operation

Note that deleting a labor operation is permanent and cannot be undone.
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1. Select a labor operation in the list.

2. Click Delete.

3. To permanently delete the labor operation, click Yes in the confirmation
dialog box.

View, print, or export the labor operation list

The labor operation list shows how Tekla PowerFab applies labor for each
material group.

1. Click the Labor Operation Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include particular material groups in the labor operation list, in the
Labor Operation Report Filters dialog box, click Edit on the right side of
Material Group.

4. Click the arrow buttons to move the material groups that you want to
include to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, do any of the following according to
your needs: 

To Do this
View the labor operation
list

• Click View.

Print the labor operation
list

a. Change the number of printed copies by
clicking the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the labor
operation list

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.
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To Do this
e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. To export the labor operation list, click Export.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Adjust labor standards
In the Labor Standards Maintenance dialog box, you can view the labor time
spent in each material operation by material dimension and shape. You can
also modify the labor times, add new labor times, shapes and material
dimensions, and delete shapes and the applied labor time from Labor
Standards.

NOTE Before making changes to labor standards, we recommend that you create a
new shop setup based on the original labor database. Then, modify the new
shop setup, so that the original labor information remains untouched.

To access Labor Standards Maintenance, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Standards .

The Labor Standards Maintenance dialog box opens.
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(1) Navigation tree: You can browse the existing material shapes and
dimensions.

When you click a dimension in the navigation tree to select it, its labor times by
labor operation appear on the right side of the dialog box.

(2) The standard length and the number of standard clip holes of the selected
material dimension

View the compiled labor time of a dimension

NOTE Remember to view the compiled labor time by labor code before and
after making changes to the labor time by labor group.

1. Select the material dimension whose properties you want to view.

2. Click the Labor Standards Maintenance ribbon tab.

3. On the menu, select View Labor Code Labor Values. 

The Labor Code dialog box opens.

The total labor time is shown at the top of the dialog box. The information
on shop bolts, field bolts, weld cost, and weld weight are shown at the
bottom of the dialog box. All these properties are added to an estimate
when the labor code is added for an item.
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4. In the labor code list on the left, click a labor code to view the labor times
of the material dimension when that labor code is selected.

5. To view the labor operation times and the total hours without standard
clips, clear the Include Standard Clips checkbox.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

7. If necessary, make changes to the labor times in the Labor Standards
Maintenance dialog box.

Add shapes and dimensions

1. At the bottom of the dialog box, click Add.

2. In the Shape list, select a shape.

3. In the Select the sizes to add dialog box, click the arrow buttons to move
the dimensions that you want to add to the Included list.

4. Click OK. 

The dimensions are added for the shape.

5. Use the Global Edit - Operations command to add labor times for the
new dimensions. 

For more information, see Copy labor times to multiple material dimensions.

After the dimensions have been added, you also need to add their pricing and
combining length to the pricing database in Pricing Maintenance.

Modify the number of standard clip holes for a single dimension

1. In the shape list, select a shape and a material dimension.

2. In the Holes in Standard Clip field, type the desired number of holes.

3. Click Save.

Modify the number of standard clip holes for multiple dimensions

1. While in the Labor Standards Maintenance dialog box, click the Labor
Standards Maintenance ribbon tab.

2. On the menu, select Global Edit - Holes in Standard Clip.

3. To automatically filter which shapes and operations are modified, select a
filter in the Filter Group list, or click Edit Filter Groups to create a new
filter.

4. On the Shapes section, use the arrows to move shapes whose standard
clip holes you want to modify to the Included list.

5. On the Dimensions section, use the arrows to move the dimensions
whose standard clip holes you want to modify to the Included list.
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6. Click OK.

7. Type the desired number of holes in the Holes in Standard Clip field.

8. Click Save. 

The number of standard clip holes of the selected material shapes and
dimensions is updated.

Copy labor times to multiple dimensions

1. Change the labor times of labor operations for one dimension according
to your needs.

2. In the navigation tree, select the material dimension whose labor times
you want to copy to other dimensions.

3. Click the Labor Standards Maintenance ribbon tab.

4. On the menu, select Global Edit - Operations.

5. To automatically filter which shapes and operations are modified, select a
filter in the Filter Group list, or click Edit Filter Groups to create a new
filter.

6. On the Shapes section of the Global Edit - Operations dialog box, use
the arrows to move shapes whose labor times you want to modify to the
Included list.

7. On the Dimensions section, use the arrows to move the dimensions
whose labor times you want to modify to the Included list.

8. Click OK.

9. Click the arrow buttons to move the operations whose labor times you
want to copy to the Included list.

10. Click Save.

The labor times of the selected operations are copied for the material
dimensions that you selected.

Remove an individual material dimension

You can remove all labor standards connected to a material dimension. The
dimension will remain available in the Shapes / Grades / Sizes dialog box and
Pricing Maintenance, and you can add it back to Labor Standards
Maintenance at any time.

NOTE If you remove a dimension from Labor Standards Maintenance, you
will need to add labor times for all items of the dimension manually
when you use that dimension in an estimating job.

1. Select the dimension that you want to remove.

2. At the bottom of the dialog box, click Delete.
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3. To permanently delete the selected dimension, click Yes in the
confirmation dialog box.

Remove a shape and all of its dimensions

If necessary, you can remove all labor standards connected to a shape from
labor standards. The shape and dimensions will remain available in the
Shapes / Grades / Sizes dialog box and Pricing Maintenance. You can add
the shape and dimensions back to Labor Standards Maintenance at any
time.

NOTE If you remove a shape from Labor Standards Maintenance, you will
need to add labor times manually for all items that use the shape in
estimating jobs.

1. Select the shape that you want to remove.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the selected shape and all its dimensions, click Yes
in the confirmation dialog box.

Create labor standard reports

1. In the Labor Standards Maintenance dialog box, click the Labor
Standards Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only show specific shapes or dimensions, select a filter type in the Type
list, and click Select.

4. Click the arrow buttons to move the shapes and dimensions that you want
to modify to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, do any of the following according to
your needs: 

To Do this
View the labor standards list • In the Report Selection dialog box, click

View.
Print the labor standards list a. In the Report Selection dialog box,

change the number of the printed
copies by clicking the + and - buttons.
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To Do this
b. If necessary, click Select Printer, select

which device you want to use for
printing, and click OK.

You can also select Default Printer to
always use the default printer with this
report, or No Printer to reset the
current printer.

c. Click Print.

d. Click Yes.
Export the labor standards list a. Click Export.

b. In the Export Format list, select an
export format.

c. Click Browse.

d. Browse to the location where you want
to save the exported file, and click Save.

e. Modify the file name according to your
needs.

f. To attach the exported file to a
Microsoft Outlook email and send it to a
recipient, select the Attach to Email
checkbox.

g. To open the file after exporting it, select
the Open Exported Document
checkbox.

h. To export the labor group list, click
Export.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Adjust quantity and weight labor factors
Quantity and weight labor factors are used in extrapolation factors, which
affect the efficiency of labor for specific labor operations. For example, for
longer items, the efficiency may be greater than normal, and for heavy items,
the efficiency may decrease. In Quantity and Weight Labor Factor
Maintenance, you can add, modify, and delete these labor factors by material
group.

To see which labor operations use the quantity and weight labor factors, refer
to the Operation Maintenance dialog box.

To open the Quantity and Weight Labor Factor Maintenance dialog box:

1. Click the Maintenance ribbon tab.
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2. On the menu, select Estimating --> Labor Maintenance --> Quantity &
Weight Labor Factors .

The Quantity and Weight Labor Factor Maintenance dialog box opens.

The quantity labor factors are adjusted on the Quantity tab, whereas the
weight labor factors are adjusted on the Weight tab.

NOTE Quantity and weight labor factors are created separately for each shop setup
in Tekla PowerFab. To switch to another shop setup, see Change the active
shop setup (page 448). Remember to add the labor factors to each shop
where they are needed.

Add quantity or weight labor factors

Before you add labor factors, ensure that you are on the right tab. To add
quantity labor factors, you need to have the Quantity tab open. To add weight
labor factors, you need to have the Weight tab open.

1. In the Shop Setup list, select to which shop the labor factor will be added.

2. In the Material Group list, select the material group whose labor factors
you want to modify.

3. In the Quantity or Weight field, type a value. 

This value defines the area for efficiency.

4. In the Percentage field, type the efficiency percentage. 

Increasing the efficiency percentage lowers the applied labor time for an
operation that contains quantity and weight extrapolation factors.
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5. Click Add.

The new labor factor is added to the selected shop setup.

Modify quantity or weight labor factors

1. In either the Quantity or Weight list, select the labor factor that you want
to modify.

2. Modify the quantity or weight and percentage.

3. Click Save to update the labor factor.

Delete quantity or weight labor factors

1. On either the Quantity or Weight tab, select the labor factor that you
want to delete.

2. In the lower-right corner, click Delete.

3. To permanently delete the labor factor, click Yes in the confirmation
dialog box.

Manage standard clips
In Standard Clips Maintenance, you can modify existing standard clips, and
add material items and additional labor for weld, burn, drill, and punch to
standard clips. Note that standard clips are only used if you have selected the
Auto Clip-Angles checkbox in Fabricator Information. You can also modify
the standard clips on a job by job basis.

To access the Standard Clips Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Standard
Clips .

The Standard Clips Maintenance dialog box opens.
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(1) Labor time in hours

(2) Weight of the selected item

Modify the properties of standard clips

1. Go to Maintenance --> Estimating --> Labor Maintenance --> Standard
Clips. 

The Standard Clips Maintenance dialog box opens.

2. In the list on the left, select the standard clip.

3. On the right, modify the standard clip properties according to your needs. 

For example, you can change the material shape or the quantity of clips.
Note that even though the shape of the clip can be changed, you can only
change the shape within the original material group.

4. If you want to change the maximum number of holes in the clip, do the
following:

a. In the lower-left corner, click Set Max Clip Holes.

b. Type the maximum hole number.

c. Click Set Max Holes.
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d. Click Yes to confirm changing the maximum number of holes.

Note that you cannot reduce the maximum number of holes if the
selected clip is used in an estimating job.

5. To update the standard clip properties, click Save below the list of
standard clips.

Add additional labor or material items to a standard clip

1. Go to Maintenance --> Estimating --> Labor Maintenance --> Standard
Clips 

The Standard Clips Maintenance dialog box opens.

2. In the list on the left, select the standard clip.

3. Under the Additional Labor list, click New.

4. Determine the quantity, operation, thickness, operation type, and length.

5. Click Add.

6. To update the standard clip properties, click Save below the list of
standard clips.

The additional labor is added to the clip. You can see the labor time of the
additional labor at the bottom right corner of the dialog box.

Modify additional labor or material items

1. Go to Maintenance --> Estimating --> Labor Maintenance --> Standard
Clips 

The Standard Clips Maintenance dialog box opens.

2. In the list on the left, select the standard clip.

3. In the Additional Labor list, select the desired item.

4. Change the quantity, operation, thickness, operation type, or length.

5. To save the changes, click Save under the Additional Labor list.

6. To update the standard clip properties, click Save below the list of
standard clips.

Delete additional labor or material items

1. Go to Maintenance --> Estimating --> Labor Maintenance --> Standard
Clips 

The Standard Clips Maintenance dialog box opens.

2. In the list on the left, select the standard clip.

3. In the Additional Labor list, select the desired item.

4. Click Delete to permanently delete the item.
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5. To update the standard clip properties, click Save below the list of
standard clips.

Adjust labor times for burning
In Burn Maintenance, you can view, add, and modify burn time information
to match the time standards of your shop. If necessary, you can also add new
burn types or create a list of burn rates.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Burn .

3. In the Burn Maintenance dialog box, do any of the following: 

To Do this
Add new burn rate a. Click New.

b. In the Shop Setup list, select the
shop to which you want to add
the burn rate.

c. In the Burn Type list, select how
the burning process is executed:

• Use Automatic for
automated equipment.

• Use Semi-Automatic for
track burners.

• Use Manualfor burning by
hand torch.

d. Determine the thickness and rate
per hour.

e. Click Add.
Modify an existing burn rate a. Select a burn rate in the list.

b. Modify the thickness and rate per
hour.

c. Click Edit to save the changes.
Delete a burn rate a. Select a burn rate in the list.

b. Click Delete.

c. To permanently delete the burn
rate, click Yes in the confirmation
dialog box.

See also

Add burn types (page 428)
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View, print, or export a burn rate list (page 428)

Add burn types
If your shop uses other burn types than the existing ones, you can add the
missing burn types in Burn Type Maintenance. Then, you can use the new
burn types in your estimating jobs.

1. In the Burn Maintenance dialog box, click the Burn Maintenance ribbon
tab.

2. On the menu, select Burn Type Maintenance.

3. In the Burn Type Maintenance dialog box, click New.

4. Add a description and abbreviation for the burn type.

5. In the Labor Group list, select which labor group the burn type belongs
to. 

The selection determines where Tekla PowerFab saves the labor time
used in burning. Normally, burn times are saved to the Burn labor group.

6. Click Add. 

The new burn type is created and will be available in Burn Maintenance.

Note that the new burn type will only be visible and available for filtering
in the Burn Maintenance dialog box once you create a burn rate with the
new burn type.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for burning (page 427)

View, print, or export a burn rate list
When you are making changes to burn times in Burn Maintenance, having a
list of the existing burn rates organized by burn type can be helpful. You can
either view the burn rate list in the Tekla PowerFab Report Viewer, print the
list, or export the list to another file format.

1. In the Burn Maintenance dialog box, click the Burn Maintenance ribbon
tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. Do any of the following: 

To Do this
View the burn rate list • In the Report Selection dialog

box, click View.
Print the burn rate list a. In the Report Selection dialog

box, change the number of the
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To Do this
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export the burn rate list a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email checkbox.

g. To open the file after exporting it,
select the Open Exported
Document checkbox.

h. Click Export.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for burning (page 427)

Adjust labor times for drilling
In Drill Maintenance, you can view, add and modify drill time information to
match the time standards of your shop. You can also add new drill types or
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create a list of drill rates. The drill times set in Drill Maintenance are used
when you directly apply them to an estimating job as additional labor.

The labor time entered in Drill Maintenance maintenance will be applied
according to the drill settings determined in the Fabrication Information -
Operations dialog box. For more information, see Modify labor operation
settings (page 442). Note that when the thickness that you have defined for
punching is greater than the punch capacity, Tekla PowerFab automatically
switches to drill times.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Drill . 

The Drill Maintenance dialog box opens.

You can click an item in the navigation tree on the left to filter the drill
information that is displayed.

3. According to your needs, do any of the following: 

To Do this
Add a new drill rate a. Click New.

b. In the Shop Setup list, select the shop for
which you want to add the rate.

c. In the Drill Type list, select if drilling is done
automatically or manually.

d. Determine the thickness and the number of
holes per hour.

e. Click Add.

The new drill rate is added to the list.
Modify an existing drill
rate

a. Select the drill rate that you want to modify.

b. Modify the shop, drill type, thickness, and
holes per hour information.

c. Click Edit to save the changes.
Delete a drill rate a. Select the drill rate that you want to delete.

b. Click Delete.

c. To permanently delete the drill rate, click Yes
in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Add drill types (page 431)

View, print, or export the drill rate list (page 431)
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Add drill types
If your shop uses other drill types than automatic and manual, you can add
the necessary drill types to Tekla PowerFab. Then, you can use the new drill
types in any estimating job.

1. In the Drill Maintenance dialog box, click the Drill Maintenance ribbon
tab.

2. On the menu, select Drill Type Maintenance.

3. In the Drill Type Maintenance dialog box, click New.

4. Add a description and abbreviation for the drill type.

5. In the Labor Group list, select which labor group the drill type belongs to. 

The selection determines where Tekla PowerFab saves the labor time
used in drilling. Normally, drill times are saved to the Punch labor group.

6. Click Add. 

The new drill type is created and will be available in Drill Maintenance.

Note that the new drill type will only be visible and available for filtering in
the Drill Maintenance dialog box once you create a drill rate with the
new drill type.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for drilling (page 429)

View, print, or export the drill rate list
When you are making changes to drill times in Drill Maintenance, having a
list of the existing drill rates organized by drill type can be helpful. You can
either view the drill rate list in the Tekla PowerFab Report Viewer, print the
list, or export the list to another file format.

1. While in the Drill Maintenance dialog box, click the Drill Maintenance
ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. Do any of the following: 

To Do this
View the drill rate list • In the Report Selection dialog box, click

View.
Print the drill rate list a. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.
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To Do this
b. If necessary, click Select Printer, select

which device you want to use for printing,
and click OK.

You can also select Default Printer to
always use the default printer with this
report, or No Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export the drill rate list a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to
save the exported file, and click Save.

e. Modify the file name according to your
needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient,
select the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. Click Export.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for drilling (page 429)

Adjust labor times for punching
In Punch Maintenance, you can view, add, and modify punch time
information to match the time standards of your shop. If necessary, you can
also add new punch types or create a list of punch rates. The punch times set
in Punch Maintenance are used when you directly apply them to an
estimating job as additional labor.

Note that when the material thickness exceeds the punch capacity, Tekla
PowerFab automatically switches to drill times. You can modify the punch
capacity in the Fabrication Information - Operations dialog box. For more
information, see Modify labor operation settings (page 442).
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1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Punch
Maintenance .

3. In the Punch Maintenance dialog box, do any of the following according
to your needs. 

To Do this
Add a new punch rate a. Click New.

b. In the Shop Setup list, select the shop for which
you want to add the rate.

c. In the Drill Type list, select if punching is done
automatically or manually.

• Use Automatic for automated equipment.

• Use Manual for punch by an iron worker.

d. Determine the thickness and the number of
holes per hour.

e. Click Add.

The new punch rate is added to the list.
Modify an existing
punch rate

a. Select the punch rate that you want to modify.

b. Modify the shop, punch type, thickness, and
holes per hour information.

c. Click Edit to save the changes.
Delete a punch rate a. Select the punch rate that you want to delete.

b. Click Delete.

c. To permanently delete the punch rate, click Yes
in the confirmation dialog box.

See also

Add punch types (page 433)

View, print, or export the punch rate list (page 434)

Add punch types
If your shop uses other punch types than the existing ones, you can add the
missing punch types in Punch Type Maintenance. Then, you can use the new
punch types in any estimating job.

1. While in the Punch Maintenance dialog box, click the Punch
Maintenance ribbon tab.

2. On the menu, select Punch Type Maintenance.

3. In the Punch Type Maintenance dialog box, click New.
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4. Add a description and abbreviation for the punch type.

5. In the Labor Group list, select which labor group the punch type belongs
to. 

The selection determines where Tekla PowerFab saves the labor time
used in punching. Normally, punch times are saved to the Punch labor
group.

6. Click Add. 

The new punch type is created and will be available in Punch
Maintenance.

Note that the new punch type will only be visible and available for filtering
in the Punch Maintenance dialog box once you create a punch rate with
the new punch type.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for punching (page 432)

View, print, or export the punch rate list
When you are making changes to punch times in Punch Maintenance, having
a list of the existing punch rates organized by punch type can be helpful. You
can either view the punch rate list in the Tekla PowerFab Report Viewer,
print the list, or export the list to another file format.

1. While in the Punch Maintenance dialog box, click the Punch
Maintenance ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. Do any of the following according to your needs: 

To Do this
View the punch rate list • In the Report Selection dialog

box, click View.
Print the punch rate list a. In the Report Selection dialog

box, change the number of the
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
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To Do this
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export the punch rate list a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email checkbox.

g. To open the file after exporting it,
select the Open Exported
Document checkbox.

h. Click Export.

See also

Adjust labor times for punching (page 432)

Adjust labor times for welding
In Weld Maintenance, you can view, add, and modify weld time information
to match the time standards of your shop. If necessary, you can also add new
weld types or create a list of weld rates. Weld times are used when included in
an estimating job within a labor code, but they may also be directly applied to
an estimating job as additional labor.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Maintenance --> Weld .

3. In the Weld Maintenance dialog box, do any of the following according to
your needs: 

To Do this
Add a new weld rate a. Click New.
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To Do this
b. In the Shop Setup list, select the shop for

which you want to add the rate.

c. In the Weld Type - Process list, select the
weld type and process.

• Use Automatic options for automated
equipment.

• Use Semi-Automatic options for wire
feed machines.

• Use Manual options for stick welding.

d. Determine the thickness, rate per hour,
material weight per foot, and cost per pound.

e. Click Add.

The weld rate is added to the list.
Modify an existing weld
rate

a. Select the weld rate that you want to modify.

b. Modify the shop, weld type and process,
thickness, rate per hour, weight, and cost
information according to your needs.

c. Click Edit to save the changes.
Delete a weld rate a. Select the weld rate that you want to delete.

b. Click Delete.

c. To permanently delete the weld rate, click Yes
in the confirmation dialog box.

See also

Add weld types (page 436)

View, print, or export a weld rate list (page 437)

Add weld types
If your shop uses other weld types than the existing ones, you can add the
missing weld types in Weld Type Maintenance. Then, you can use the new
weld types in your estimating jobs.

1. While in the Weld Maintenance dialog box, click the Weld Maintenance
ribbon tab.

2. On the menu, select Weld Type Maintenance. 

The Weld Type Maintenance dialog box opens.

3. Click New.

4. Type a type description, a type abbreviation, a process description, and a
process abbreviation for the weld type. 
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The type description forms the first part of the weld type description,
while the process description forms the second part. The two parts of the
description are connected with a hyphen.

Similarly, the type abbreviation and the process abbreviation together
form the abbreviation of the weld type. The two parts of the abbreviation
are connected with a hyphen.

5. In the Labor Group list, select in which labor group the weld type belongs
to. 

The selection determines where Tekla PowerFab saves the labor time
used in welding. Normally, labor time spent on full penetration welding is
saved to the FpWeld labor group, while other weld times are saved to the
Weld labor group.

6. In the Weld Type Mapping field, type any weld descriptions that should
be mapped to this weld type when importing weld information. 

Type each additional weld description on a separate line.

7. Click Add. 

The new weld type is created and will be available in Weld Maintenance.

Note that the new weld type will only be visible and available for filtering
in the Weld Maintenance dialog box once you create a weld rate with the
new weld type.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for welding (page 435)

View, print, or export a weld rate list
When you are making changes to weld times in Weld Maintenance, having a
list of the existing weld rates organized by weld type can be helpful. You can
either view the weld rate list in the Tekla PowerFab Report Viewer, print the
list, or export the list to another file format.

1. While in the Weld Maintenance dialog box, click the Weld Maintenance
ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Progress dialog box, do one of the following: 

To Do this
View the weld rate
list

• In the Report Selection dialog box, click View.

Estimating 437 Set up the Estimating module



To Do this
Print the weld rate
list

a. In the Report Selection dialog box, change the
number of the printed copies by clicking the + and -
buttons.

b. If necessary, click Select Printer, select which device
you want to use for printing, and click OK.

You can also select Default Printer to always use the
default printer with this report, or No Printer to
reset the current printer.

c. Click Print.

d. Click Yes.
Export the weld
rate list

a. Click Export.

b. In the Export Format list, select an export format.

c. Click Browse.

d. Browse to the location where you want to save the
exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft Outlook
email and send it to a recipient, select the Attach to
Email checkbox.

g. To open the file after exporting it, select the Open
Exported Document checkbox.

h. Click Export.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Adjust labor times for welding (page 435)

Manage estimate statuses
Estimate statuses indicate the level of completion of estimate items. By using
estimate statuses, you can quickly view the situation of each estimating job.
You can also color-code the material items in an IFC model in Trimble Connect
for Windows according to their estimate statuses. Tekla PowerFab contains
four preloaded status indicators, but you can modify the list of statuses
according to your needs: you can add, modify, deactivate, and delete estimate
statuses.

1. Click the Maintenance ribbon tab.
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2. On the menu, select Estimating Maintenance --> Estimate Status
Maintenance .

3. In the Estimate Status Maintenance dialog box, do any of the following: 

To Do this
Add a new estimate
status

a. Click New.

b. Type a description for the status.

c. In the Purpose list, select a purpose for the
status.

d. Click Add.
Set the default estimate
status

a. Select a status in the list.

b. Select the Default checkbox.

c. Click Save.

The new default estimate status is marked with an
asterisk (*).

Deactivate an estimate
status

If you deactivate an estimate status, it will no
longer be available for estimates. However, you
can activate the status again at any time.

a. Select a status in the list.

b. Clear the Active checkbox.

c. Click Save.

To re-activate the estimate status, select the Active
checkbox again.

Modify an existing
estimate status

a. Select a status in the list.

b. Modify the description, purpose, and other
properties according to your needs.

c. Click Save.
Delete an existing
estimate status

a. Select a status in the list.

b. At the bottom of the dialog box, click Delete.

c. To permanently delete the estimate status,
click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Color-code estimating items in the IFC model (page 522)
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Adjust standard shop information
In Fabricator Information, you can adjust all standard shop information
according to your shop's actual hourly rates, pricing, equipment capacity, and
efficiency. When you set the standard shop information correctly, Tekla
PowerFab will be able to make more accurate calculations for your estimates.
The sub dialog boxes of Fabricator Information also allow you to modify
shop operations, labor rates, and markups percentages.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Fabricator Information . 

3. In the Fabricator Information dialog box, modify the settings to match
your shop standards. 

In the following table, see details on some of the shop standard settings:

Option Description Further information
Auto Clip-Angles When selected, Tekla

PowerFab uses the
standard clip settings,
automatically adding the
labor and materials for
them according to the
labor code.

To modify the standard
clips, see Manage
standard clips
(page 424).

Identify [Items] Longer
Than

The maximum length
allowed for the named
items.

When the item length
exceeds this value, Tekla
PowerFab will add it into
the Problem Summary
Sheet report.
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Option Description Further information
Maximum Quantity For
[Items]

The maximum number
allowed for the named
items.

When the item quantity
exceeds this value, Tekla
PowerFab will add it into
the Problem Summary
Sheet report.

Shop Efficiency The shop efficiecy
percentage used in all
future estimating jobs.

The shop efficiency
percentage affects the
labor time and can be
used in different ways.
For example, it may be
useful to set a lower
percentage if your shop
is fabricating
miscellaneous items
instead of structural
ones.

Note that the shop
efficiency can be
manually changed for
each job. Existing
estimating jobs are not
affected by changing the
efficiency percentage.

If necessary, the
percentage can exceed
100 percent. For
example, changing the
shop efficiency to 125%
will reduce the standard
labor time by 20%,
whereas using the shop
efficiency of 75% will add
33% to the standard
labor time.

4. Modify labor operations according to your needs, or define markup
percentages.

NOTE Do not click Save until you have modified the labor operations and
markup percentages. Saving the settings closes the Fabricator
Information dialog box.

For more information, see the following links:

Modify labor operation settings (page 442)

Define default markup percentages (page 443)
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Modify labor operation settings
In the Fabricator Information Operation Form dialog box, you can modify
the punch and drill type and capacity for different items to match those of
your shop. You can also determine how copes are burned and stiffeners are
executed.

Setting an operation as automated or manual directly affects the labor time in
Tekla PowerFab.

1. In the lower-left corner of the Fabricator Information dialog box, click
Operations.

2. At the top of the Fabricator Information Operation Form dialog box, do
one of the following according to your needs: 

• To consider the operation rate thickness as the minimum value of the
range, select he Consider the Burn/Drill/Punch/Weld rate thickness
as the minimum of the range checkbox.

• To consider the operation rate thickness as the maximum value of the
range, clear the Consider the Burn/Drill/Punch/Weld rate thickness
as the minimum of the range checkbox.

3. On the Angles, Beams, Plates, Tubes, and Other tabs, do the following:

a. In the Punch list, select if punching is done automatically or manually.

b. In the Punch Capacity field, type the thickness of the material. 
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If an estimate requires a greater capacity, Tekla PowerFab uses the
drill time information instead.

If the material group does not have a punch process, type 0/16 to
ensure that the drill operation is used instead.

c. In the Drill list, select if drilling is done automatically or manually.

4. On the Copes tab, use the Burn list to select if the burn process of copes
is manual, automated, or semi-automated.

5. On the Stiffeners tab, use the Weld list to select how the weld process of
stiffeners is handled.

6. Click OK.

The changes are saved, and the Fabricator Information Operation Form
dialog box closes.

See also

Adjust standard shop information (page 439)

Define default markup percentages
While defining the standard shop information, you can also determine the
markup percentages that you want to use in Tekla PowerFab.

There are three levels of markup: overheads, administration, and profit.

1. Go to Maintenance --> Estimating --> Fabricator Information The
Fabricator Information dialog box opens.

2. Click Markups. 
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The Markup dialog box opens.

O.H. %: Overheads percentage
S,G&A %: Sales, general, and administration percentage
Profit %: Profit percentage
The list on the left: Cost groups. Every cost that you have applied to
the estimate is assigned to one of these groups.

3. Modify the markup percentages in either of the following ways: 

To Do this
Add or modify
percentages one by one

a. Click the field that you want to modify.

b. Type a new value.
Apply the same markup
percentage to multiple
items at once

a. In the lower-right corner of the dialog box,
click Global Edit.

b. Click the arrow buttons to move the items that
you want to modify to the Included list.

c. Click OK.

d. Type the markup percentage that you want to
apply to all the selected items.
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To Do this
e. Click OK.

The markup percentages of the selected items
are updated.

4. Click OK. 

The Markup dialog box closes.

5. Once you have finished modifying the properties, click Save.

The changes are saved, and the Fabricator Information dialog box closes.

See also

Adjust standard shop information (page 439)

Define markups for an estimating job (page 468)

Create and modify labor rates
We recommend that you create different labor rates that match the fabrication
functions and rates of your shop. By modifying labor rates to match those of
your shop, you can ensure that Tekla PowerFab calculates the prices in your
estimates as accurately as possible.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Labor Rates.

3. In the Labor Rates dialog box, do any of the following: 

To Do this
Add a new labor rate a. Click New.

b. Type a description and a price per hour.

c. Click Add.
Modify an existing labor
rate NOTE The Detailing and Erecting labor codes

cannot be renamed or deleted.

a. Select a labor rate in the list.

b. Modify the description and price per hour.

c. Click Edit to save the changes.
Delete a labor rate

NOTE The Detailing and Erecting labor codes
cannot be renamed or deleted.

a. Select a labor rate in the list.
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To Do this
b. Click Delete.

c. To permanently delete the labor rate, click Yes
in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

To modify where each labor rate is used, see Create, modify, and delete labor
groups (page 411).

The labor rate assignments will be used on all summary reports that show the
labor cost. For a breakdown of the labor rates, use the Labor Rate Summary
or the Summary Information - to Excel report option.

Create and modify shop setups
If your company has multiple shops, you can create additional labor
databases, called shop setups, in Tekla PowerFab. We also recommend that
you create an additional test shop if you are still learning to use Tekla
PowerFab, so that you do not accidentally make changes to the original shop.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Labor Maintenance --
> Shop Setup Maintenance . 
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3. To create a new shop setup, in the Shop Setup Maintenance dialog box,
click New.

4. In the Description field, type a name for the shop setup.

5. If you want to use an existing shop setup as the base of the new setup,
select it in the Copy From Shop Setup list.

6. Click Add.

The new shop setup is added to the list. You can now customize all the shop
settings according to your needs.

TIP To modify the name of an existing shop setup, select the shop setup,
rename it, and click Edit.

See also

Change the active shop setup (page 448)
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Change the default shop setup (page 448)

Change the active shop setup
If you have created multiple shop setups, also called labor databases, in Tekla
PowerFab, you can modify the Estimating Maintenance properties of each
shop separately. If you want to modify a shop setup, you need to activate it
first.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Current Shop Setup . 

You can see the active shop setup in the Estimating Maintenance menu
after the Current Shop Setup text.

The Select Shop Setup dialog box opens.

3. Select a shop setup in the list.

4. Click OK.

The shop setup, or the labor database, is changed.

If necessary, you can also change the shop setup of an individual estimating
job while working in the Estimating module.

See also

Create and modify shop setups (page 446)

Change the default shop setup (page 448)

Change the default shop setup
The default shop setup is the default shop database used for all future
estimating jobs created in Tekla PowerFab. You can change the default shop
setup in Shop Setup Maintenance. Note that changing the default shop setup
does not change the settings of existing estimating jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Labor Maintenance --
> Shop Setup Maintenance . 
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The Shop Setup Maintenance dialog box opens.

The current default shop setup is marked with an asterisk (*).

3. Select a shop in the list.

4. Click Set as Default.

5. To change the default shop setup, click Yes in the confirmation dialog box.

The default shop setup is updated. The new default shop is marked with an
asterisk (*).

See also

Change the active shop setup (page 448)

Create and modify shop setups (page 446)
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Delete shop setups
You can delete any unnecessary shop setups in Shop Setup Maintenance. For
example, you can delete a test shop database that you no longer use.

NOTE You cannot delete the current default shop, but you need to select a
new shop setup first.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating Maintenance --> Labor Maintenance --
> Shop Setup Maintenance . 

3. In the Shop Setup Maintenance dialog box, select the shop that you
want to delete.

4. Click Delete.

5. To permanently delete the shop, click Yes in the confirmation dialog box.
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See also

Create and modify shop setups (page 446)

Create a standard proposal setup
You can customize the content of bid proposals in Proposal Setups.

Among other things, you can create different sections for the proposals and
add entries for each section. We also recommend that you modify the existing
entries and delete unnecessary entries according to your needs.

You can also change the order of sections, and modify the titles and styles in
the proposal. The sections and entries that you have set up are used for
creating an individual bid proposal based on each estimate.

1. Click the Maintenance ribbon tab.

2. On the menu, select Estimating --> Proposal Setups . 

The Proposal Setups dialog box opens.

Main Setups tab: Controls details that affect the entire proposal

Sections tab: Represents different sections of the proposal

3. On the Main Setups tab, fill in the signature name or title, price prefix,
price suffix, and weight units.

4. Click Save.

5. Do any of the following according to your needs: 

Option Description
Modify the appearance
of the proposal

a. On the Main Setups tab, click Open
Template.

The proposal template opens in Microsoft
Word. The items marked with << >> pull
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Option Description
information from Tekla PowerFab and can be
adjusted there, but the other information and
font types can be changed in Microsoft Word.

b. Make the necessary changes to the template.

c. In the Microsoft Word window, click File -->
Save .

d. Save the modified proposal as a custom report
in the default folder that your company uses
for custom reports.

To verify the default folder, go to File -->
Default Directories.

Note that any changes made to the proposal
document outside of Tekla PowerFab are not
available in Tekla PowerFab.

Add a new entry a. On the Sections tab, select the section in
which you want to add the new entry.

b. At the bottom of the dialog box, click New.

c. Type the desired text in the space the bottom
of the dialog box.

d. Click Add.
Modify an entry a. On the Sections tab, select the section in

which you want to modify an entry.

b. Select the entry that you want to modify.

c. Change the entry text according to your needs.

d. Click Edit to save the changes.
Move an entry up or
down in the proposal

a. On the Sections tab, select the section in
which the desired entry is located.

b. Select the entry that you want to move.

c. To move the entry, click Move Up and Move
Down.

Change the indentation
of an entry

a. On the Sections tab, select the section in
which the desired entry is located.

b. Select the entry that you want to move.

c. Click Move Left and Move Right to shift the
position of the item in the proposal.

Delete an entry a. On the Sections tab, select the section from
which you want to delete an entry.

b. Select the entry that you want to delete.
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Option Description
c. Click Delete.

d. To permanently delete the entry, click Yes in
the confirmation dialog box.

Change the titles or
headings of the proposal

a. On the Sections tab, select the section whose
titles or headings you want to change.

b. Do any of the following:

• To change the main title of the section, type
a new title in the Title field and click Set
Title.

• To change the style of the headings, click
Attributes and select appropriate styles in
the lists. Then, click Save.

• To add a subtitle, click Attributes and type
a title in the Subtitle field. Then, click Save.

The subtitle appears under the title in the
proposal.

Add a section a. On the Sections tab, click Add.

b. Type a title for the section.

c. Click OK.

The new tab is added at the end of the
proposal setup.

Delete a section a. On the Sections tab, select the section that
you want to delete.

b. Click Delete.

c. To permanently delete the section, click Yes in
the confirmation dialog box.

Move a section forward
or backward in the
proposal

a. On the Sections tab, select the section that
you want to move.

b. Click Move Forward or Move Backward.

6. Click Save.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

6.2 Open the Estimating module
To start creating estimates, open the Estimating module.

• At the top of the Tekla PowerFab window, click the Estimating button. 
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The Select Estimating Job dialog box opens. You can view all existing jobs

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs checkbox.

Next, you can create a new job, open or modify an existing job, or view and
modify the documents attached to a job.

Create an estimating job
To create a new job, you need to define a few properties.

1. Open the module.

The Select <Module> Job dialog box opens.

2. Click Add

The <Module> Job Edit dialog box opens.
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Continue to defining the properties on the tabs.

By clicking the buttons, you can find more settings.

NOTE Defining job-specific properties is optional. If you do not define job-specific
properties, Tekla PowerFab uses the default properties defined in
Maintenance --> Company Standards.

Define general settings
1. In the <Module> Job Edit dialog box, select the General tab.

2. Add or modify the properties as needed. 

Option Description
Estimator The name of the estimator.

You can sort estimating jobs based on
the estimator.

Date The date on which the bid is due.

Tekla PowerFab automatically uses
the date when you create the job, but
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Option Description
you can select a different date in the
associated calendar.

Job Name The description of the job.
Location The town or city where the job takes

place.
Job Status The job is either still in progress

(Open) or it has been finished
(Closed).

You can filter the Select <Module>
Job dialog box by Job Status, so that
only open jobs are shown.

ERP Job # The accounting system job number.

Typing the accounting system job
number in the ERP Job # field allows
you to link material items properly
when you export information to an
accounting system, such as Trimble
Viewpoint.

Job Group Job groups allow you to identify and
classify jobs that are similar. This
makes filtering and reporting easier
when you have a long list of jobs.

Either type a job group directly in the
blank field, or click the arrow on the
right side of the field to select an
existing job group.

Comment Any additional comments on the job.
Distance To Job The distance to the job site.

Tekla PowerFab uses the distance to
calculate freight costs if you have
selected the Freight Per Mile option
in Freight Maintenance. For more
information, see Modify freight
pricing (page 392).

Shop Drawing Cost The total cost of the shop drawings.

The value is used in the fabrication
summary report.

Shop Drawing Hrs The total labor hours used in shop
detail drawings.

The value is used in the fabrication
summary. Costs automatically include
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Option Description
the Detailing labor rate set in Labor
Rates.

Shop Efficiency The efficiency percentage of the shop,
used for calculating labor times. Shop
efficiency is calculated by dividing the
labor times accordingly.

For example, typing 75% would
increase overall labor times by 33.3%,
whereas entering 125% would reduce
the labor times by 20%.

Note that shop efficiency cannot be
set to 0.

Default Finish The default finish used for new items
in the estimating job.

You can change the finish item by
item.

Item Increment Sets the autoincrement for item
numbers.

The default autoincrement of 10
allows items to be added in the list as
needed, without having to renumber
the other items in the job.

For example, if items should be
numbered as 10, 20, 30, ..., set the
input increment to 10. If the
autoincrement of item numbers is not
necessary, type 1.

Auto Clip-Angles When selected, Tekla PowerFab adds
standard clips in the estimating items
according to their labor codes.

When cleared, standard clips are not
used.

Project Management Job The project management job that is
linked to the job.

By linking the job in this module and
project management jobs to each
other, you can share nesting results
with the Project Management
module. This way, you can save data
transfer time.
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Option Description
Edit: Trimble Connect Project The Trimble Connect project that is

linked to the current estimating job.

To link the estimating job to a Trimble
Connect project, click Link, select a
project in the Link Project to Trimble
Connect dialog box, and click Link
Project. For more information, see
Use Trimble Connect with an
estimating job (page 520).

3. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

Define paint settings
On the Paints tab, you can create and edit the paints used for an estimating
job.

For information on creating default paint settings, see Manage default paint
types and paint systems (page 389).

1. In the Estimate Job Edit dialog box, select the Paints tab. 
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2. Add or modify the properties as needed. 

To Do this
Add a new paint type a. Click New Paint

b. Define the paint properties.

c. Click Add Paint.

The new paint type is added.
Modify a paint type a. Select the paint type.

b. Modify the properties.

c. Click Save Paint.

Your changes are saved.
Delete a paint type a. Select the paint type.

b. Click Delete Paint

c. To permanently delete the
selected paint type, click Yes.

The paint type is permanently
deleted.
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3. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

The paints listed on the Paints tab are applied to all painted items by default
unless you assign a paint system to them.

Define paint systems
You can define a default paint system that consists of one or more paint
products, for each of which you can define the number of coats needed. When
you select a paint system in an estimating job, Tekla PowerFab calculates the
applicable costs and adds them to the estimate.

If you do not assign a paint system to the items on the Paint Systems tab, all
paints listed on the Paints tab will be applied to all painted items by default.

NOTE To use job-specific paint types in paint systems, you first need to
define them on the Paints tab in the Estimate Job Edit dialog box.

For information on creating default paint systems, see Manage default paint
types and paint systems (page 389).

1. In the Estimate Job Edit dialog box, select the Paint Systems tab.

2. Click New Paint System. 
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3. Add or modify the properties as needed. 

To Do this
Add a new paint system a. Click New Paint System.

b. Type a description for the paint
system in the Description field.

c. Click the arrow buttons to move
the paint types that you want to
include to the Paints Included
list.

d. To change the number of coats,
select an included paint type and
type a new value in the Quantity
field.

e. To set the paint system as the
default paint system for new
estimating jobs, select the
Default checkbox.

f. Click Add Paint System.
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To Do this
Modify a paint system a. Select the paint system in the list.

b. Change the description, included
paints, or the number of paint
coats according to your needs.

c. To set the paint system as the
default paint system for new
estimating jobs, select the
Default checkbox.

d. Click Save Paint System.
Delete a paint system a. Select the paint system in the list.

b. Click Delete Paint System.

c. To permanently delete the paint
system, click Yes.

4. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

Define clean systems
You can create and modify job-specific clean systems.

For information on creating default clean systems, see Manage default
cleaning types and clean systems (page 386).

1. In the Estimate Job Edit dialog box, select the Clean Systems tab.

2. Click New Clean System.

3. Type a description for the cleaning system.

4. Use the arrow buttons to move the cleaning types that you want to
include in the clean system to the Included list.

5. To add or reduce the times each cleaning type requires, change the value
in the Quantity field.

6. If you only want to apply the cleaning system if cleaning is included in the
labor code of the item, select the Check Labor Code For Include
Cleaning checkbox.

7. To set the clean system as the default clean system used for new items,
select the Default checkbox.

8. Click Add Clean System.
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See also

Define combining optimizations for an estimating job (page 463)

Define suppliers for an estimating job (page 466)

Define input and display units for an estimating job (page 467)

Define galvanizing settings for an estimating job (page 468)

Link an estimating job to a project management job (page 470)

Define combining optimizations for an estimating job
You can define job-specific settings for material optimization.

You are in the Estimating module. You are either creating a new job or
modifying an existing job in the Estimate Job Edit dialog box.

1. Click Combining Optimizations.

The Combining Setup dialog box opens.

2. Modify the settings on the various tabs as needed.

Define the general settings

1. Go to the General Settings tab.
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2. Modify the settings as needed. 

Option Description
Use Grade Substitutions Select to check for material in

inventory that has an alternative
grade to the one specified.

Only grades of an equal or higher
rating will be used as set in
Maintenance --> Shapes/Grades/
Sizes --> Shape/Grade/Size
Maintenance dialog box.

If the grade substitutions are not set,
the material grades in the combining
run and in the supplier pricing data
set or the inventory need to match
each other exactly.

Optimizations Not Included/
Optimizations Included

Allows you to select the optimization
options that you want to use by
moving them to the Optimizations
Included list using the arrow buttons.

Inventory Exact-Match (In Stock) Use this option for inventory items in
stock that are an exact match without
the use of kerf or clamp allowance.

Inventory Exact-Match (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that are an
exact match without the use of kerf or
clamp allowance.

Inventory Least-Scrap (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that will
provide the least amount of scrap.

Inventory Least-Scrap (In Stock) Use this option for inventory items in
stock that will provide the least
amount of scrap.

Warehouse Least-Scrap Use this option to give preference to
warehouse items that will provide the
least amount of scrap. Warehouse
items will only be used when they
provide less scrap than the available
inventory items or no inventory
exists.

Warehouse Force Inventory Use this option to force the use of
inventory items if available regardless
of the amount of scrap, no matter
where it is located in the
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Option Description
Optimizations Included list. This
option is the opposite of Warehouse
Least-Scrap.

Note that you can only include
Warehouse Least-Scrap or
Warehouse Force Inventory, not
both.

3. Modify the order of the optimizations by using the Move Up and Move
Down buttons 

The order is important when you are performing a combining run.

4. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define multing settings

1. Go to the Mult Settings - Linear Material tab.

2. Modify the settings as needed. 

Option Description
Apply Kerf Select if you want to apply the

material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Allow Split T's Select to allow split tees.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define plate nesting settings

1. Go to the Plate Nesting Settings tab.

2. Modify the settings as needed. 

Option Description
Shear Cut Optimization Select a suitable shear cut option. The

selected option determines the plate
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Option Description
allowance to be used with the
combining:

• None: Use when cutting plate on a
burn table.

• Shear Cut - First Cut Along
Length or Shear Cut - First Cut
Along Width: Use to alert Tekla
PowerFab that the nesting needs
to allow for that type of cut first.
Then, the nesting will allow for all
subsequent cuts to be made with
that condition.

Apply Kerf Select if you want to apply the
material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Rotate Plates for Best Fit Select if the material grain direction is
unimportant and you want Tekla
PowerFab to create the best possible
optimization of a plate.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

When you click Save, the Combining optimizations settings are saved.

See also

Define default combining optimizations for Estimating (page 358)

Troubleshoot combining issues (page 1110)

Define suppliers for an estimating job
You can define job-specific suppliers, or pricing data sets, for angles, beams,
plates, rods, tubes, and other material.

You are in the Estimating module. You are either creating a new job
ormodifying an existing job in the Estimate Job Edit dialog box.

To make suppliers available in the Suppliers dialog box, you must first add the
suppliers in Maintenance --> Pricing Maintenance.

1. Click Suppliers. 

The Suppliers dialog box opens.
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2. Select suppliers for each material group on the drop-down lists.

3. Click OK.

4. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the changes you made are saved. You can further modify
the job properties by clicking the buttons.

See also

Create an estimating job (page 454)

Modify an estimating job (page 481)

Define default suppliers for Estimating (page 362)

Define input and display units for an estimating job
You can define input and display units for individual jobs. You can select either
metric or imperial units and the units of measurement for a piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

You are in the Estimating module. You are either creating a new job or
modifying an existing job in the Estimate Job Edit dialog box.

1. Click Input/Display Units. 

The Input/Display Units dialog box opens.

2. Select the measurement system and the units of measurement on the
drop-down menus.

3. Click OK. You return to the <Module> Job Edit dialog box.

4. Do either of the following:

• Click Save

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the changes you made are saved.

See also

Create an estimating job (page 454)

Modify an estimating job (page 481)

Define default input and display units for Estimating (page 358)
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Define galvanizing settings for an estimating job
In the Galvanizing dialog box, you can modify the pricing, minimum costs and
freight information that is applied to a galvanized item in a specific estimating
job. If you do not want to modify these settings for a single estimating job,
Tekla PowerFab will automatically use the galvanizing settings that you defined
in Estimating Company Standards.

1. In the Select Estimating Job dialog box, do one of the following:

• To define or modify galvanizing settings of a new estimating job, click
New.

• To define or modify galvanizing settings of an existing estimating job,
select the job in the list, and click Edit.

2. At the bottom of the Estimate Job Edit dialog box, click the Galvanizing
button.

3. In the Galvanizing dialog box, modify the galvanizing costs, the trailer
capacity, the labor prep costs per pound, and the weight percent added.

4. Click OK to save the changes.

5. Click Save in the Estimate Job Edit dialog box.

The changes that you made to galvanizing settings are saved for the selected
estimating job.

See also

Define default galvanizing settings (page 355)

Define markups for an estimating job
There are three levels of markup: overheads, administration, and profit.

You are in the Estimating module. You are either creating a new job or
modifying an existing job in the Estimate Job Edit dialog box.

1. Click Markups. 
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The Markup dialog box opens.

O.H. %: Overheads percentage
S,G&A %: Sales, general, and administration percentage
Profit %: Profit percentage
The list on the left: Cost groups. Every cost that you have applied to
the estimate is assigned to one of these groups.

2. Modify the markup percentages in either of the following ways: 

To Do this
Add or modify
percentages one by one

a. Click the field that you want to modify.

b. Type a new value.
Apply the same markup
percentage to multiple
items at once

a. In the lower-right corner of the dialog box,
click Global Edit.

b. Click the arrow buttons to move the items that
you want to modify to the Included list.

c. Click OK.

d. Type the markup percentage that you want to
apply to all the selected items.

Estimating 469 Open the Estimating module



To Do this
e. Click OK.

The markup percentages of the selected items
are updated.

3. Click OK. 

The Markup dialog box closes.

4. Once you have finished modifying the properties, click Save.

The changes you made for the job are saved.

You return to the Select Estimating Job dialog box.

See also

Create an estimating job (page 454)

Define default markup percentages (page 443)

Link an estimating job to a project management job
By linking an estimating job to a project management job, you can share the
labor and material information with the Project Management and
Production Control modules. This allows you to compare the estimate
information with the actual production information.

1. At the top of the Tekla PowerFab window, click the Estimating button.

2. In the Select Estimating Job dialog box, select the estimating job that you
want to link to a project management job.

3. Click Edit.

4. In the Estimate Job Edit dialog box, click the arrow on the right side of the
Project Management Job list, and select the desired project management
job in the list. 

The project names and job numbers do not need to match.

5. Click Save.

Note that you also need to link the production control job to the project
management job.

NOTE To unlink an estimating job from a project management job:

1. Erase the job number in the Project Management Job field.

2. Click Save.

See also

Link a production control job to an estimating job and a project management
job (page 844)
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Find an estimating job
You can search to find a specific job.

NOTE Sometimes sorting estimating jobs by estimator, bid date, or other
properties in the navigation tree of the Select Estimating Job dialog
box can be quicker than using the Find Job command.

1. In the Select Estimating Job dialog box, click the Estimating ribbon tab.

2. Select Find Job or press Ctrl+F on the keyboard. 

The Enter Value dialog box opens.

3. Select the job in the drop-down menu or enter the job number in the
search box.

4. Click OK.

The selected job is highlighted. To open the job, double-click it or click Open.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs checkbox.

Open an estimating job
To open an existing estimating job, do the following:

1. At the top of the Tekla PowerFab window, click the Estimating button.

2. In the Select Estimating Job dialog box, select the job that you want to
open. 

NOTE Jobs whose statuses are set to Closed are not shown by default.
To show closed jobs, select the Show Closed Jobs checkbox.

3. Double-click the job, or click Open.
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The Estimating dialog box opens.

(1) Summary:

• The quantity, length, weight, surface area, and work time in hours for each
of the selected items, all of the selected items, all items visible in the job,
and the entire job.

• Pounds per hour and hours per ton calculations for the selected items, all
items visible in the job, and the entire job.

(2) Find: Click to find items in the job. You can select if you want to find items
of a specific shape, material grade, or material dimension, or a particular item
in the job. For more information, see Find estimating items (page 496).

You can now continue to adding new items, or modifying and deleting existing
items.

See also

Filter information in the Estimating dialog box (page 472)

Filter information in the Estimating dialog box
In addition to using the navigation tree for filtering items, you can set filters
that determine which items are shown in the Estimating dialog box. For
example, you can view labor totals by category to check averages, or view the
totals for items with a specific finish. You can also save the filter settings for
later use.

If the Open to Filter Selection checkbox has been selected in Maintenance --
> <Module> --> Company Standards, the <Module> Filters dialog box opens
automatically when you open a job.

If the Open to Filter Selection checkbox has not been selected, open the
<Module> Filters dialog box as follows:

1. In an open Estimating job, click the Estimating ribbon tab.
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2. On the menu, select Filter. 

The <Module> Filters dialog box opens.

3. Select a filter type in the Type list and click Select. 

The Filter dialog box opens.

For some filter types, you can also click Find and type the desired value in
the search box to use it. This way, you do not have to scroll through all the
available items.

4. Click the arrow buttons to move the items that you want to display to the
Included list.

5. Click OK. 

If you want to further filter the information displayed , repeat steps 3 to 5
for different items. Note that only items that match the items in the
Included list will be available when setting more filters.

If you want to clear all filter settings, click Reset.

6. Click Apply Filter.

The <Module> Filters dialog box closes, and the items are filtered according
to the settings you made.

To display all information again, click Clear Filters in the upper-left corner.

To create and save commonly used filters, see Create and modify module-wide
filters (page 261).
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View estimating job details
You can view various details regarding an estimating job, including the labor
times of each material item and all changes made in the estimating job. You
can also create estimating reports that show the details of the job, and view,
email, or export the reports.

See also

View the labor times of items (page 474)

View all changes in an estimating job (page 476)

View, email, export, and print estimating reports (page 478)

View the labor times of items
Use the View Labor Details command to easily review the labor time of an
item or a group of items, as well as the labor time of the entire estimating job.
If necessary, you can override the labor time calculated by Tekla PowerFab and
enter the labor time manually instead.

1. In the Estimating dialog box, select the items whose labor details you
want to view. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

3. On the menu, select View Labor Details. 

The Labor Details dialog box opens.

The labor estimated time used on the selected items, the displayed items,
and the total estimating job are viewed in a table, categorized by labor
group.

4. If you want to enter labor time manually, do the following:

a. In the table, select and right-click the labor time that you want to
override.

b. In the context menu, click Set Manual Override.

c. Select if you want to enter the labor time in hours or minutes.

d. Enter the desired labor time in the Manual Override field.

e. Click Set Manual Override.

The items whose values have changed are highlighted with yellow. Other
items affected by the change are highlighted with blue.

If you want to remove the manual override and revert to the labor time
calculated by Tekla PowerFab, right-click the item and select Remove
Manual Override.
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5. To close the dialog box, click the Close button (X) in the upper-right
corner.

To print, email, or export the information in the Labor Details dialog box,
create a Labor Detail report. For more information on creating reports, see
View, email, export, and print estimating reports (page 478).

View and modify the labor time of an item
In the Labor Diagnostic dialog box, you can view and modify the labor time of
an item. The labor time is divided into categories based on the different labor
operations used for the item.

1. In the Estimating dialog box, double-click the item whose labor time you
want to view. 

The Labor Diagnostic dialog box opens, displaying all labor time used on
the selected item.

In the navigation tree on the left, you can view all labor operations that
the selected item goes through. These labor operations are defined by the
labor code that is used. Each labor operation has buttons that allow you
to access the settings that affect how the labor operation is calculated.

2. In the navigation tree, select a labor operation to view the labor operation
details.

3. According to your needs, do any of the following: 

To Do this
Add a labor time manually a. Right-click the labor time that you

want to modify.

b. In the context menu, click Set
Manual Override.

c. Select if you want to enter the
labor time in hours or minutes.
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To Do this
d. Enter the desired labor time in

the Manual Override field.

e. Click Set Manual Override.

The manual override is created. Note
that the override only applies to the
selected item, not other items of the
same shape, grade and size.

If you want to remove the manual
override and revert to the labor time
calculated by Tekla PowerFab, right-
click the item and select Remove
Manual Override.

View and modify labor codes, labor
operations, labor standards, or labor
factors

NOTE Modifying the following
settings will affect all new
estimating jobs.

• Click one of the buttons on the
right side of the dialog box:

• Click Labor Codes to modify
labor codes.

• Click Labor Operations to
modify the labor operations.

• Click Labor Standards to view
and modify labor times for
different material dimensions
and shapes.

• Click Labor Factors to modify
the extrapolation factors used
for specific labor operations.

4. Click Recalculate. 

Tekla PowerFab applies the changed values.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

6. In the Estimating dialog box, click the Estimating ribbon tab.

7. On the menu, select Recalculate Estimate. 

Tekla PowerFab recalculates the current estimating job to ensure accurate
total values. The changes you made are applied to the estimating job.
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View all changes in an estimating job
Tekla PowerFab records every change made in the system. This is useful
because you can view all changes made in the current estimating job at once.
You can filter the information to see changes made by a particular user, or on
a particular date. You can also print or export the list of changes.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date filter

type and click Select.

b. Do one of the following:

• Enter the start (Minimum)
and end (Maximum) dates.

• Select the Expression
checkbox for the start or end
date. Then, select the base
date and select how many
more or less days will be
taken into account.

c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do one of the following: 

To Do this
View the list of changes • Click View.

The report opens in Tekla PowerFab Report
Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.
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To Do this
b. If necessary, click Select Printer, select which

device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

View, email, export, and print estimating reports (page 478)

View, email, export, and print estimating reports
You can create multiple types of reports based on your estimating jobs. Some
examples of available reports are estimates, fabrication summaries, job
summaries, and material pricing reports. Once you have selected which report
you want to create, you can view, email, export, or print it.

To create estimating reports, do the following:

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only display certain items in the report, in the Report Filters dialog
box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:
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• Click the arrow buttons to move the items that you want to include in
the reports to the Included list.

• Type the maximum and minimum values for the items that you want
to include in the reports.

5. Click OK.

Repeat steps 3 to 5 for every filter type that you want to use.

6. In the Use Pricing Data From list, select which pricing information you
want to use.

7. Click Make Report.

The Report Selection dialog box opens.

Note the purpose of the following buttons:

• If you want to include your company logo in the report, select the
Show Company Logo checkbox.

• If you want to modify the filters you set for the reports, click Change
Filters.

• If you want to modify the design of a report, select it and click Design.

• If you want to create a customized report list, click Edit Report Types.

According to your needs, see any of the following instructions:

View or email estimating reports

1. Select the report that you want to view. 

To select more than one report at a time, hold down the Ctrl key while
clicking reports in the list.

2. In the Report Selection dialog box, click View.

3. In the Tekla PowerFab Report Viewer window, view the report.

4. If you want to attach the report to a Microsoft Outlook email, click either
Email Excel or Email PDF at the top of the window. 

Microsoft Outlook automatically opens and creates a new email. You can
then modify the message, add the recipient, and send the email.

5. Once you have viewed all necessary report details, click Close in the
upper-right corner of the Tekla PowerFab Report Viewer.

Print estimating reports

1. Select the report that you want to print. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the + and - buttons to increase or decrease the number of copies.
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3. Click Print.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Tekla PowerFab prints the report.

Export estimating reports

1. Select the report that you want to export. 

To select more than one report at a time, hold down the Ctrl key while
clicking reports in the list.

2. In the Report Selection dialog box, click Export.

3. In the Export Format list, select an export format.

4. Click Browse.

5. Modify the file name according to your needs.

6. Browse to the location where you want to save the exported file, and click
Save.

7. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

8. To open the file after exporting it, select the Open Exported Document
checkbox.

9. In the Report Selection dialog box, click Export.

Tekla PowerFab saves the report to the selected location in the selected file
format.

See also

Customize reports (page 268)

Calculate an estimating job
Use the Calculate Material Cost command to view the total material cost of
the displayed or selected estimating items, or use the Recalculate Estimate
command to update the estimating job value after making changes to the
labor or material databases.

See also

Calculate an estimating job (page 480)

Recalculate an estimate (page 481)

Calculate the total material cost
To view the current total material cost of the displayed or selected items, use
the Calculate Material Cost command. Note that the total material cost does
not contain costs that have been applied to items by adding estimate extras.
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1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Calculate Material Cost. 

The Material Cost dialog box opens and displays the total material cost of
selected, displayed, and all items in the estimating job.

3. View the material costs.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Recalculate an estimate
By recalculating the entire estimating job, you can ensure accurate total value
even after making multiple changes to the labor and material databases.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Recalculate Estimate.

3. To recalculate the estimate, click Yes in the confirmation dialog box.

Manage files for an estimating job
Document Index is a place for storing files to be shared among other users.
In Document Index, you can store various kinds of documents for reference,
and modify, delete, open, and email these files.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

You can now edit document categories, add, edit, and delete document
references, and open and email files.

For further information and instructions, see

Document Index (page 149)
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Modify an estimating job
You can modify the properties of an individual job at any time, no matter if the
current properties have been set for all jobs in Company Standards or for an
individual job when creating it.

The changes override the company standard settings for the current job.

NOTE You cannot change the job number.

1. Open the module. 

The Select <Module> Job dialog box opens.

2. Select the job that you want to modify.

3. At the bottom of the dialog box, click Edit. 

The Estimate Job Edit dialog box opens.

4. Add or modify the properties as needed. 

For details on the properties, see Create an estimating job (page 454).
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5. Click Save.

The Estimate Job Edit dialog box closes. The estimating job is updated to
match the changes that you made.

See also

Create an estimating job (page 454)

Define combining optimizations for an estimating job (page 463)

Define suppliers for an estimating job (page 466)

Define default input and display units for Estimating (page 358)

Define galvanizing settings for an estimating job (page 468)

Define markups for an estimating job (page 468)

Set up the Estimating module (page 353)

6.3 Manage estimating items
You can manage the material items in an estimating job in different ways.

For more information, see the following links:

Add materials to an estimating job (page 483)

Copy and multiply estimating items (page 499)

Modify estimating items (page 497)

Delete an estimating item (page 502)

Manage production codes (page 502)

Add materials to an estimating job
In addition to manually added estimating items, you can add accessories,
assemblies, and parametric assemblies to estimating jobs.

See also

Add an estimating item (page 483)

Add an accessory (page 492)

Add an assembly (page 494)

Add a parametric assembly (page 495)
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Add an estimating item
To add a new item to an estimating job, do the following:

1. At the bottom of the Estimating dialog box, click New.

2. Define the item properties. 

NOTE The visible input fields and their order depend on the settings
that you have defined in Maintenance --> Estimating --> Edit
Input Fields.

The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Camber A text field for camber size, that is, curvature in an

item so as to compensate for deflection induced by
loads.

Type the labor time used in cambers in the Hrs/Pc
field.

Do not define the cost of cambers in the Manual
Cost field. The cost entered in the Manual Cost
overrides the material cost of cambers. Instead,
you can type the cost in the Cost/Pc field.

Category, Sub-Category A class used for sorting items within a job. You can
use categories and subcategories for filtering
information.

You can also use them for color-coding or filtering
items in Trimble Connect.

You can create the available categories and
subcategories in Company Standards.

You can also assign quantity multipliers to
subcategories.

Select an existing Category or Sub-Category on
the drop-down menu or type in a new category.

Clean System The clean system applied to the item.

Click the arrow on the right side of the Clean
System field to select an existing clean system.

For more information, see Manage default cleaning
types and clean systems (page 386).

Comment An optional comment that you can type for the
item.
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Option Description
Copes The number of copes per piece.

When you define the number of stiffeners, Tekla
PowerFab automatically calculates and adds the
labor time spent on copes to the item.

Cost code The cost code assigned to the item.

Select a cost code from the drop-down menu.

For more information about cost codes, see Create,
modify, or delete cost codes (page 973).

Cost/Pc A cost per piece that is added to the material cost
of the item.

Detailing Cost The amount of money used for erecting the item.

The Detailing Cost field is identical with the Erect
Cost field.

Detailing Hrs The number of hours spent on erecting the item.

The Detailing Hrs field is identical with the Erect
Hrs field.

Item * The item number.

You can modify the item number manually or use
the item number automatically determined by
Tekla PowerFab.

Default item increments are set in Company
Standards, but you can modify them for each job.
We recommend leaving spaces between items, so
that you can later add items between existing
items.

You can reset the item number intervals in Job
Maintenance.

For more information, see Renumber an
estimating page item (page 365).

Grade * The material grade of each piece.

Depending on the shape, the grade can also be
mandatory information.

Either select the grade from the drop-down menu
or type the grade indicator in the field.

Dimensions * The material dimension, or material size, of each
piece.

Depending on the shape, the dimension can also
be mandatory information.
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Option Description
Click the Dimensions field to select an available
material dimension, and double-click the desired
dimension in the list.

You can also use a custom material dimension.
Note that the dimension is not automatically
added to the material database.

To use a custom dimension:

a. Click in the Dimensions field.

b. Click Add Size.

c. Define the dimension properties.

d. Click Save.

You can now select the dimension and use it.
Erect Hrs The number of hours spent on erecting the item.
Erect Cost The amount of money used for erecting the item.
Extra The estimate extra applied to the item. Estimate

extras are additional costs and labor that you can
add to an estimating item. Estimate extras can also
contain formulas that calculate the additional costs
and labor.

To apply estimate extras to the item, do one of the
following:

• To apply one estimate extra to the item, click
the arrow on the right side of the Extra field to
select the extra that you want to apply.

• To apply multiple extras to the item, double-
click in the Extra field, and click the arrow
buttons to move the desired extras to the
Included list.

Finish The finish type of the item. The default options are
Painted, Unpainted, and Galvanized.

Select the finish type from the drop-down menu.

The finish type can be used to color-code or filter
items in Trimble Connect. For more information,
see Use Trimble Connect with an estimating job
(page 520).

You can apply paint systems to an item whose
finish type is Painted to use other finishes than
the standard ones.

Holes, Web Holes, Top
Flg Holes, Bot Flg Holes

The number of the holes, web holes, top flange
holes, or bottom flange holes per piece. Bolts are
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Option Description
automatically added for beams and tubes with
holes.

When you define the number of holes, Tekla
PowerFab automatically adds the labor time spent
on holes to the item.

Holes w/o Bo The number of holes per piece. No bolts will be
added.

When you define the number of holes, Tekla
PowerFab automatically adds the labor time spent
on holes to the item.

Hrs/Pc The number of hours per piece.

This time will be added to the labor time already
calculated by Tekla PowerFab.

Length The length of each piece.

Default length input settings are set in Company
Standards, but you can modify them for each job.

MainPc When selected, indicates that the item is a main
piece in an assembly. When cleared, indicates that
the item is not a main piece.

Marking items as main pieces allows you to
consider whole assemblies in fabrication. If you
use main pieces, you can create reports that show
the properties for each main piece, or assembly.

Selecting the MainPc checkbox is optional, but be
consistent: Either select the checkbox for all main
pieces in the estimating job or do not select it for
any of them.

Manual Cost A cost that replaces the material cost of the item in
reports.

If necessary, you can change and convert the units
by right-clicking in the Manual Cost field. Select a
suitable option in the context menu.

Page * The number of the page on which the item is
added.

The page number can be used to color-code or
filter items in Trimble Connect. For more
information, see Use Trimble Connect with an
estimating job (page 520).

You can modify the page number manually or use
the page number automatically determined by
Tekla PowerFab.
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Option Description
Paint System The paint system applied to an item whose finish

type is Painted.

Click the arrow on the right side of the Paint
System field to select an existing clean system.

If no paint system is selected for a painted item,
the default paints defined in the Estimate Job Edit
dialog box are applied. For more information, see
Modify an estimating job (page 481).

To modify the available paint systems, see Manage
default paint types and paint systems (page 389).

Part # The part number that identifies the accessory item.

The selected part number populates the applicable
fields with the information from Accessory
Maintenance. The applicable fields need to be
modified in the Accessory Maintenance dialog
box.

PRC Unit Cost, PRC
Cost, PRC Date

Fields that show the current pricing information of
the selected item from the selected supplier.

If no date is displayed in the PRC Date field, the
material does not exist in the selected supplier's
pricing data set.

Double-click one of the fields to open the Pricing
Maintenance dialog box and enter pricing
information.

Prod. Code The production code applied to the item.

Production codes group items so that you can
apply man hour per ton and per labor group
percentages to items in the linked production
control job.

The production code applied to the item.

Production codes group similar items together
within jobs.

Production codes group items so that you can
apply hour per ton and per labor group
percentages to items in the linked production
control job.

The production code can be used to color-code or
filter items in Trimble Connect. For more
information.
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Option Description
For more information, see Use Trimble Connect
with an estimating job (page 520).

Select a production code from the drop-down
menu or type in a new code.

Quantity * The number of pieces to be added.

Use the numeric keypad to add, multiply, divide, or
subtract number of items.

Sequence The sequence number assigned to the item.

The sequence can be used to color-code or filter
items in Trimble Connect.

For more information, see Use Trimble Connect
with an estimating job (page 520).

Select a sequence number from the drop-down
menu or type in the number.

Shape * The material shape of each piece.

Either select the shape from the drop-down menu
or type the shape indicator in the field (for
example, HSS).

Status The estimate status of the item. The status
indicates the level of completion of the item.

The status can be used to color-code or filter items
in Trimble Connect. For more information, see Use
Trimble Connect with an estimating job (page 520).

Stiffeners The number of stiffeners per piece.

When you define the number of stiffeners, Tekla
PowerFab automatically calculates and adds the
labor time spent on stiffeners to the item.

Note that you need to add the material for the
stiffeners separately because such material is not
added automatically.

Type The labor code that is applied to the item. Note
that the available labor codes depend on the
material group of the selected shape.

The labor code can be used to color-code or filter
items in Trimble Connect.

Select a labor code from the drop-down menu or
type the labor code abbreviation in the field.
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Option Description
Welded Studs The number of welded studs per piece.

The price per welded stud is defined in Fabricator
Information for a typical stud price.

You can also add welded studs as separate items.
Tekla PowerFab will then price them accordingly.

3. If necessary, apply additional labor and clips to the item. 

For more information, see Apply additional labor and clips (page 490).

4. Click Add.

The item is added to the display area.

See also

Apply additional labor and clips (page 490)

Modify a single estimating item (page 497)

Copy estimating items (page 499)

Delete an estimating item (page 502)

Apply additional labor and clips
You can apply additional labor operations, such as welding or burning, or
standard clips to an estimating item.

To apply additional labor and clips, do the following:

1. In the Estimating dialog box, select the item to which you want to apply
additional labor or clips.

2. In the lower-right corner of the dialog box, expand the Additional Labor
and Clips section.

3. Click Edit, or press Shift+F4.

The Estimating Item dialog box opens.

You can add additional labor on the left side of the dialog box, and clips on the
right side of the dialog box. To apply additional labor or clips, see the following
sets of instructions.

Apply additional labor

1. In the Additional Labor section of the dialog box, click New.

2. In the Quantity field, enter the number of operations that you want to
add.

3. In the Operation list, select which labor operation you want to add.

4. To define the material thickness, do either of the following:

• Type the desired material thickness in the Thickness field.
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• In the list on the right side of the Thickness field, select Thickness to
apply the thickness defined in the material dimensions.

Note that the available options for thickness depend on the shape of the
selected item. If the selected item is a beam, the list on the right side of
Thickness allows you to select if the applied thickness is the flange
thickness or the web thickness.

5. Select the operation type in the Type list.

6. If necessary to define the length, do either of the following:

• Type the desired length in the Length field.

• In the list on the right side of the Length field, select an option to
apply a value defined in the material dimensions.

Note that the available options for length depend on the shape of the
selected item. If the selected item is a beam, the list on the right side of
Length allows you to select if the applied thickness is the flange thickness
or the web thickness.

7. Click Add. 

The additional labor operations are added to the list and applied to the
selected item.

You can view the labor time, cost, and weight associated with the
additional labor at the bottom of the Additional Labor section in the
Estimating Item dialog box.

8. To close the Estimating Item dialog box, click X in the upper-right corner.

Apply clips

The available clips are standard clips defined in Standard Clips Maintenance.
For more information, see Manage standard clips (page 424).

1. In the Clips section of the dialog box, click New.

2. In the Quantity field, enter the number of clips that you want to add.

3. Select the shape, clip, and finish in the available list.

4. If you set the clip finish to Painted, select the paint system in the Paint
System list.

5. If necessary, select a cleaning system for the clip in the Clean System list.

6. Click Add. 

The clips are added to the list and applied to the selected item.

You can view the labor time associated with the clips and the clip weights
in the list at the bottom of the Clips section in the Estimating Item dialog
box.

7. To close the Estimating Item dialog box, click X in the upper-right corner.
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Add an accessory
Accessories are commonly used items that you can add to items in your
estimating jobs. You can create accessories for items such as stiffeners, base
plates, or embeds. Accessories can also be linked to specific material shapes
and sizes, so that they can only be added to items of that shape and size. To
add an accessory to an item, use the Add Accessory command.

NOTE You can also add an accessory by typing the part number of the
accessory in the Part # field.

1. In the Estimating dialog box, select the item for which you want to add an
accessory.

2. Click the Estimating ribbon tab.

3. On the menu, select Add Accessory. 

The Select Accessory dialog box opens.

If the accessory list is empty, there are no accessories linked to the
selected material shape and size. In these cases, you can either create a
new accessory in (page 367), or create a job-specific accessory (page 492).

4. In the accessory list, select the accessory that you want to add.

5. Select or clear the checkboxes at the bottom of the dialog box according
to your needs.

6. Click Add Selected.

The Select Accessory dialog box closes.

The accessory is added as the last item of the selected page in the Estimating
dialog box.

Note that accessories have the same input fields and properties as other
estimating items. In addition, accessories have a description.

Create a job-specific accessory
You can create accessories that are only used within the current estimating
job. Remember that all labor and material costs associated with the accessory
will be added to the estimating job.

NOTE We recommend that you create, modify, and delete accessories in
Accessory Maintenance. You can also create accessories in an
estimating job, but these job-specific accessories cannot be saved to
the accessory library, so they cannot be reused in other estimating
jobs.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Job-Specific Accessory Maintenance.

3. In the Accessory Maintenance dialog box, click New.
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4. If you want to use the accessory multiple times in the current estimating
job, enter a part number.

5. Type a description for the accessory.

6. Enter the remaining properties for the accessory: 

Option Description
Quantity The number of accessories per item to which they

are added.
Shape The material shape of the accessory.
Dimensions The material size of the accessory.
Length The length of the accessory.
Grade The material grade of the accessory.
Type The labor code of the accessory.
Extra The estimate extras applied to the accessory.

To add estimate extras, double-click the Extra field.
Holes The number of holes in the accessory.
Web Holes The number of web holes in the accessory.
Stiffeners The number of stiffeners in the accessory.
Copes The number of copes in the accessory.
Hrs/Pc The number of hours spent on the accessory.
Manual Cost The cost for the accessory that you can enter

manually.

The manual cost is optional, and it overrides the
pricing information in the pricing database.

MainPc When selected, the item to which the accessory is
added is considered a main piece.

Comment An optional and additional comment on the
accessory.

Erect Hrs The number of hours spent on erecting the
accessory.

Erect Cost The cost of erecting the accessory.
Prod. Code The production code applied to the accessory.
Camber The camber size used with the accessory. For

example, the value can be 3/4" or 19 mm.
Holes w/o Bo The number of holes per piece in the accessory. No

bolts will be added.
Top Flg Holes, Bot Flg
Holes

The number of top flange holes or bottom flange
holes per accessory.

Welded Studs The number of welded studs per accessory.
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Option Description
Detailing Hrs The number of hours spent on erecting the

accessory.
Detailing Cost The amount of money used for erecting the

accessory.
Cost/Pc A cost per piece that is added to the material cost

of the accessory.

7. Click Add. 

The accessory is added to the list, and you can add it in the current
estimating job.

You can also use the other buttons at the bottom of the Accessory
Maintenance to modify the job-specific accessories:

• Click Edit to modify the selected accessory.

• Click Copy to create a new accessory based on the selected accessory.

• Click Delete to permanently delete the selected accessory.

• Click Global Edit Selected to modify the properties of multiple
selected accessories at once.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

9. Add the accessory to an item in the estimating job. 

For more information, see Add an accessory (page 492).

Add an assembly
Assemblies are commonly used bid items that can contain multiple pieces with
different shapes, labor codes, finishes, and other properties, as well as
accessories and parametric assemblies. By adding the assembly to your
estimating job, you can add all these pieces at once. We recommend that you
add assemblies at the end of the page in an estimating job.

NOTE Assemblies often begin with a comment line that describes and labels
the assembly. This makes it easier to recognize assemblies.

1. Scroll to the end of the page in the Estimating dialog box.

2. Click the Estimating ribbon tab.

3. On the menu, select Add Assembly.

4. In the Add Assembly dialog box, type the number of assemblies you want
to add in the Quantity field.
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5. If you want to be able to select from assemblies that are available for all
jobs, ensure that the Show Global Assemblies checkbox is selected. 

If the Show Global Assemblies checkbox is not selected, you can only
select assemblies that have been added in the current estimating job.

6. Do one of the following:

• In the Assembly list, select the assembly that you want to add.

If you have selected the Show Global Assemblies checkbox, the
Assembly list contains all assemblies that are available in Assembly
Maintenance.

• If you want to create a new assembly, click New, type a name for the
assembly, and click OK. For further instructions, see Create assemblies
(page 397).

NOTE The new assembly will initially only be available in the current
estimating job, but you can later add it to the assembly library.
For instructions, see View, rename, copy, and delete
assemblies (page 400).

• If you want to modify an existing assembly, select the assembly in the
Assembly list, and click Edit.

7. If you want to assign a sub-category to the assembly, select the Set Sub-
Category checkbox, and select an option in the Sub-Category list. 

Assigning a sub-category to the assembly allows you to easily identify and
filter assemblies.

8. Click Add Assembly.

The Add Assembly dialog box closes, and the assembly is added at the end of
the item list in the current estimating job.

Add a parametric assembly
Use the Add Parametric Assembly command to add assemblies with
variables to an estimating job. These assemblies, called parametric assemblies,
may vary in height, width or length, so you can use them in different
situations. When you define the variable values, Tekla PowerFab calculates the
parametric assembly according to the defined values.

We recommend that you add assemblies at the end of the page in an
estimating job.

Note that parametric assemblies often begin with a comment line that
describess and labels the assembly.

1. Scroll to the end of the page in the Estimating dialog box.

2. Click the Estimating ribbon tab.
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3. On the menu, select Add Parametric Assembly. 

The Select Parametric Assembly dialog box opens, displaying all
parametric assemblies.

4. Select the parametric assembly that you want to add.

5. Click OK. 

The Parametric Assembly - Variables dialog box opens, displaying all
variables in the parametric assembly.

6. Select a variable in the list.

7. In the Value field, type a value for the variable.

8. Click Set Value. 

Repeat steps 6 to 8 for all variables.

9. Click Calculate Parametric Assembly. 

Tekla PowerFab calculates the parametric assembly. When the calculation
process is finished, the Parametric Assembly - Results dialog box opens.

10. Verify that the calculations are correct.

11. If you want to assign a sub-category to the parametric assembly, click the
arrow button on the right side of the Sub-Category list and select a sub-
category. 

Assigning a sub-category to the assembly allows you to easily identify and
filter assemblies.

12. Click Add Parametric Assembly.

The parametric assembly is added at the end of the estimating job.

Find estimating items
Use the Find button in to quickly find estimating items. You can search for
items by material shape, grade, and dimensions, or by page and item number.

1. In an open estimating job, click Find.

2. Do one of the following: 

To Do this
Find all items that have a particular
shape, grade, and dimensions

a. In the Find menu, select Find
Shape/Grade/Size.

b. In the Find dialog box, select the
right shape, grade, and
dimensions in the available lists.

You can also start typing the
shape, grade, or dimensions.

Estimating 496 Manage estimating items



To Do this
Tekla PowerFab will suggest
options that match what you
have typed.

c. Click Find.

The Find dialog box closes. Only the
items that match your search are now
shown in the Estimating dialog box.

Find the right item on a particular
page of the estimating job

a. In the Find menu, select Find
Item.

b. In the Find dialog box, select the
right page number and item
number in the available lists.

You can also start typing the page
number or item number. Tekla
PowerFab will suggest options
that match what you have typed.

c. Click Find.

The Find dialog box closes. Only the
items that match your search are now
shown in the Estimating dialog box.

See also

Manage estimating items (page 483)

Modify estimating items
You can either modify items one by one, or use the Global Edit commands to
modify multiple items at one go.

TIP If you cannot find the property you want to modify, check if you can add it in
Maintenance --> Estimating --> Edit Input Fields.

For instructions, see Customize input fields (page 253).

For more information, see the following links:

Modify a single estimating item (page 497)

Modify multiple estimating items (page 498)

Modify the selected estimating items (page 499)
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Modify a single estimating item
You can modify a single estimating item directly in the Estimating dialog box.

1. In the Estimating dialog box, select the item that you want to modify.

2. On the right side of the dialog box, modify the item properties. 

For example, change the quantity, adjust the labor time, or add additional
labor and clips.

3. Click Edit to save the changes.

See also

Modify multiple estimating items (page 498)

Modify the selected estimating items (page 499)

Modify multiple estimating items
Use the Global Edit command to modify the properties of multiple items at
one go. This way, you can save time, as you do not need to change the
properties of each item individually.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Global Edit --> Global Edit. 

The Global Edit Filters dialog box opens.

3. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

4. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

5. Click OK. 

To further limit the item types that you want to modify, repeat steps 2 to 5
for all necessary filter types.

6. Click OK. 

The Global Edit dialog box opens.

7. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

8. Click Update. 

The Confirm dialog box opens.
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9. To confirm changing the properties of multiple items, click Yes.

The changes you made to the item properties are updated.The properties of
the selected items are updated.

Modify the selected estimating items
Use the Global Edit - Selected command to modify the properties of multiple
selected items at one go. This way, you can save time, as you do not need to
change the properties of each item individually.

1. In the Estimating dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

3. On the menu, select Global Edit --> Global Edit - Selected. 

The Global Edit - Selected dialog box opens.

4. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

5. Click Update.

The properties of the selected estimating items are updated to the Estimating
dialog box.

Copy and multiply estimating items
Creating an estimate becomes quicker when you use the available commands
for copying and multiplying items. By doing so, you can avoid having to enter
the same items one by one on different pages, and modifying the quantities of
items one by one.

For more information, see the following links:

Copy estimating items (page 499)

Copy a page of estimating items (page 500)

Copy and multiply a group of estimating items (page 500)

Multiply the quantity of the selected estimating items (page 501)

Multiply the quantity of all estimating items in a sub-category (page 501)

Copy estimating items
You can copy estimating items in the Estimating dialog box and use them as
the basis of a similar item. Then, modify the properties of the new items
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according to your needs. By copying items, you can save time and avoid
entering the same information multiple times in an estimating job.

1. In the Estimating dialog box, select the items that you want to copy. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Copy. 

Copies of the selected items appear at the bottom of the current page.

3. Adjust the properties of the new items according to your needs.

4. Click Edit to save the changes.

See also

Copy a page of estimating items (page 500)

Copy and multiply a group of estimating items (page 500)

Copy a page of estimating items
Use the Copy Page command to copy all items on a page of the estimating job
onto a new page.

1. In the Estimating dialog box, select any item on the page that you want to
copy.

2. Click the Estimating ribbon tab.

3. On the menu, select Copy Page.

4. In the Copy Page dialog box, type the new page number in the New Page
# field.

5. Click Copy.

Copy and multiply a group of estimating items
Use the Copy Special to copy a group of items on a page and multiply their
quantity while copying. You can either copy the items on the same page or on
another page.

1. In the lower navigation tree of the Estimating dialog box, select a page.

2. In the display area, select the items that you want to copy. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click Estimating.

4. On the menu, select Copy Special.
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5. In the Qty Multiplier field, type a number by which all selected items will
be multiplied.

6. In the New Page # field, type a page name.

7. Click Copy.

The items are copied at the end of the selected page, and their quantity is
multiplied. To view the items, click the page number in the lower navigation
tree.

See also

Copy a page of estimating items (page 500)

Multiply the quantity of the selected estimating items
Use the Selected Items Multiplier command to multiply specific items in the
estimating job. This is a quick way to you can increase the quantity of multiple
estimating items at once.

1. In the Estimating dialog box, select the items that you want to multiply.

2. Click the Estimating ribbon tab.

3. On the menu, select Selected Items Multiplier.

4. In the Multiplier field, type the number by which you want to multiply the
selected items.

5. Click Save.

The quantities of the selected items are multiplied.

See also

Multiply the quantity of all estimating items in a sub-category (page 501)

Multiply the quantity of all estimating items in a sub-category
Use the Sub-Category Multipliers command to multiply the quantity of all
items that are associated with a specific sub-category in an estimating job.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Sub-Category Multipliers. 

The Sub-Category Multipliers dialog box opens.

3. In the list, select a sub-category.

4. In the Multiplier field, type the number by which you want to multiply the
quantity of items.

5. Click Save. 

The quantity of each item in the sub-category is multiplied.
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6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Note that the quantity of the items in the Quantity field of the Estimating
dialog box remains the same. The multiplication factor appears on the right
side of the Quantity field.

See also

Multiply the quantity of the selected estimating items (page 501)

Delete an estimating item
You can delete one or multiple unnecessary items from an estimating job.
Note that deleting the items is permanent and cannot be undone.

1. In the Estimating dialog box, select the item that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete or press F2 on the keyboard.

3. To permanently delete the items, click Yes in the confirmation dialog box.

Manage production codes
Use production codes to group similar items together within estimating jobs. If
necessary, you can then override the hours of all items in that production
code. Production codes also allow you to link estimating items to production
control job items. This way, the Production Control module can use estimate
information, such as hours, and you can view project details and parts easily.

Production codes can be as broad or as specific as you like. For example, you
can use one production code for the entire estimating job to add the labor
estimates to the production control job. The hours will then be calculated
based on all the work that must be done for the entire job. However, you can
also set every piece mark to have its own production code, so that hours in the
estimating job and in the production control job match for each item.

To access the Production Codes dialog box, do the following:

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Production Codes.

The Production Codes dialog box opens.
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You can filter the production codes that are displayed by selecting an option in
the Show Production Codes list at the top of the dialog box. The options are:

• Global: production codes that can be used in all jobs in both Production
Control and Estimating.

• Estimate-Specific: production codes that can only be used within a specific
estimating job and the linked production control job. These are the
production codes that you can create in the current dialog box.

• In Use: production codes that are used.

You can also create a report that lists all production codes used in an
estimating job. The report is called Production Code Summary. For more
information on creating reports, see View, email, export, and print estimating
reports (page 478).

According to your needs, see any of the following instructions:

Create a production code
Note that you can only create production codes for the current estimating job
in the Production Codes dialog box. Globally available production codes are
created in Global Production Code Maintenance.

1. At the bottom of the dialog box, click New.

2. Name the production code and type a description.

3. Do any of the following: 
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To Do this
Use the estimated labor
times of items within
the production code in
Production Control

The hours associated with the production codes are
only used in Production Control. Production codes
do not affect or apply labor to estimating items.
The purpose of the hours is to pull labor
information from the estimate in the form of hours
per ton and labor percentages by labor group.

• In the Aggregate Units list, select a calculation
option.

Override the estimated
labor time of items
within the production
code in Production
Control

NOTE Manually overriding hours applies an
aggregate unit, hours per ton, that can be
applied to production control items.
However, if the manual override is used,
the labor information does not include
labor group percentages. Therefore, the
labor group percentages cannot be applied
to any production control stations. Further,
the information cannot be applied to tasks
in the project schedule and to resources
that feed information to the production
schedule. Manually overriding hours can
also prevent you from comparing the
linked production control job with the
estimating job.

a. Select the Override Hours checkbox.

b. Type the labor time in the field on the right
side of the checkbox.

TIP To change the units, right-click in the field
and select a suitable option in the context
menu.

4. Click Add.

Modify a production code
1. Select the production code that you want to modify.

2. Modify the production code properties according to your needs.

3. Click Save to update the production code properties.

Delete a production code
1. Select the production code that you want to delete.
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2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
production code.

Apply a production code
You can apply an existing production code to the estimating job.

1. Ensure that you have the Prod. Code display and input fields visible in the
Estimating dialog box. 

If not, do the following:

a. Go to Maintenance --> Estimating --> Edit Display Fields .

b. Move the Production Code field to the Included Fields list.

c. Click Save.

d. Go to Maintenance --> Estimating --> Edit Input Fields and repeat
steps b and c.

e. Re-open the estimating job.

2. Click the Estimating ribbon tab.

3. On the menu, select Global Edit --> Global Edit .

4. To only apply the production code to specific types of items, in the
Estimating Global Edit Filters dialog box, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, click the arrow buttons to move the items whose
properties you want to modify to the Included list.

6. Click OK to apply the filter.

7. In the Estimating Global Edit Filters dialog box, click OK-

8. In the Global Edit dialog box, select the checkbox on the left side of Prod.
Code.

9. In the Prod. Code list, select the production code that you want to use for
the selected item types.

10. Click Update.

11. To update the production code for the selected items, click Yes in the
confiramtion dialog box.

12. Repeat steps 2 to 10 to assign a production code for each item in the
estimating job.

See also

Manage production codes (page 502)
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Load estimating materials to other jobs
You can load the material items in an estimate to another estimate, a
requisition or a purchase order, or a production control job.

See also

Load materials into another estimate (page 509)

Load estimating materials into purchasing (page 506)

Load materials into Production Control (page 511)

Load estimating materials into purchasing
You can load material items in an estimating job into a purchase order or a
requisition. Either send material items into a purchase order in order to
purchase the items, or send material items to a requisition in order to get
pricing information from suppliers and apply the received pricing to the
estimating items.

You can either load all estimating items into a requisition or a purchase order,
or select the items that you want to load to purchasing.

See also

Load all estimating items into a requisition (page 506)

Load all estimating items into a purchase order (page 507)

Load the selected estimating items into a requisition (page 508)

Load the selected estimating items into a purchase order (page 509)

Load all estimating items into a requisition
Use the Load Material Into Requisition command to load all material in an
estimating job into a requisition. This way, you can get pricing information
from a supplier and apply it to the estimate-specific pricing. You can either add
the items into an existing requisition or create a new one.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Requisition .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
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To Do this
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.

5. Click OK to close the Import Items dialog box. the Estimating dialog box.

Items are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

See also

Load all estimating items into a purchase order (page 507)

Load the selected estimating items into a requisition (page 508)

Load all estimating items into a purchase order
Use the Load Material Into Purchase Order command to load all estimating
material items into a purchase order. You can either add the items into an
existing purchase order or create a new one.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Purchase
Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.
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To Do this
c. Click the arrow buttons to move the items that you want

to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.

5. Click OK to close the Import Items dialog box. the Estimating dialog box.

Items are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

See also

Load all estimating items into a requisition (page 506)

Load the selected estimating items into a purchase order (page 509)

Load the selected estimating items into a requisition
Use the Load Selected Material Into Requisition command to select the
items in an estimating job that are loaded into a requisition. This way, you can
get pricing information from a supplier and apply it to the estimate-specific
pricing. You can either add the items into an existing purchase order or create
a new requisition.

1. In the Estimating dialog box, select the items that you want to load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

3. On the menu, select Purchasing --> Load Selected Material Into
Requisition .

4. In the Select Requisition dialog box, select a requisition and click OK. 

If necessary, you can also create a new requisition and load the items into
it.

5. Click OK to close the Import Items dialog box. the Estimating dialog box.

Items are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

See also

Load all estimating items into a requisition (page 506)

Load the selected estimating items into a purchase order (page 509)
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Load the selected estimating items into a purchase order
Use the Load Selected Material Into Purchase Order command to select the
items in an estimating job that are loaded into a purchase order. You can
either add the items into an existing purchase order or create a new one.

1. In the Estimating dialog box, select the items that you want to load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

3. On the menu, select Purchasing --> Load Selected Material Into
Purchase Order .

4. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

5. Click OK to close the Import Items dialog box. the Estimating dialog box.

Items are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

See also

Load all estimating items into a purchase order (page 507)

Load the selected estimating items into a requisition (page 508)

Load materials into another estimate
Use the Load Material Into Estimate and Load Selected Material Into
Estimate commands to copy material from an estimating job to either
another existing estimating job or to a new one. These commands are
particularly useful when more than one person is working on a bid, or when
you are making pricing breakouts on adds or deducts. You can load all items
into another estimating job or select the items that you want to load manually.

NOTE To create pricing for the added material, you need to delete the copied items
manually from the original location. Tekla PowerFab does not automatically
remove items from any estimate.

Load all or filtered items into an estimate

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Load Material --> Load Material Into Estimate .

3. In the Select Estimating Job dialog box, do either of the following: 
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To Do this
Load the material into
an existing estimating
job

• Double-click the estimating job to which you
want to load the material.

Load the material into a
new estimating job

a. Click Add.

b. In the Estimate Job Edit dialog box, type a job
number.

c. Define any other necessary properties for the
new estimating job.

Note that you can also change the estimating
job properties later.

d. Click Save.

e. Double-click the new estimating job in the
Select Estimating Job dialog box.

4. In the New Page # field, type the page where you want to copy the
material.

5. Click OK.

6. To only load specific types of items, in the Estimating Import Filters
dialog box, select a filter type in the Type list, and click Select.

7. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to load to the
Included list.

• Type the maximum and minimum values for items that you want to
load.

8. Click OK. 

To further limit the items to be loaded, repeat steps 6 to 9 for the
necessary filter types.

9. Click Import.

Tekla PowerFab loads all or filtered items into the selected estimating job. You
can see the progress of the process in the Import Items dialog box. After
loading the material has finished, click OK to close the Import Items dialog
box.

Load selected items into an estimate

1. In the Estimating dialog box, select the items that you want to load to
another estimate. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.
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2. Click the Estimating ribbon tab.

3. On the menu, select Load Material --> Load Selected Material Into
Estimate .

4. In the Select Estimating Job dialog box, do either of the following: 

To Do this
Load the material into
an existing estimating
job

• Double-click the estimating job to which you
want to load the material.

Load the material into a
new estimating job

a. Click Add.

The Estimate Job Edit dialog box opens.

b. Type a job number.

c. Enter any other necessary properties for the
new estimating job.

Note that you can also change the estimating
job properties later.

d. Click Save.

e. Double-click the new estimating job in the
Select Estimating Job dialog box.

5. In the New Page # field, enter the page where you want to copy the
material.

6. Click OK.

Tekla PowerFab loads the selected items into the selected estimating job. You
can see the progress of the process in the Import Items dialog box. After
loading the material has finished, click OK to close the Import Items dialog
box.

Load materials into Production Control
You can send items from the currently open estimating job to a new or existing
production control job by using the Load Material Into Production Control
and Load Selected Material Into Production Control commands.

Load all items into a production control job

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Load Material Into Production Control.

3. In the Select Production Control Job dialog box, do one of the following: 
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To Do this
Load the items to an
existing production
control job

• Select the production control job in the list.

Load the items to a new
production control job

a. Click Add.

b. In the Production Control Job Edit dialog box,
type a job number.

c. Modify the other properties of the production
control job according to your needs.

Note that you can also modify the properties
later.

d. Click Save.

e. To create the production control job, click Yes
in the confirmation dialog box.

The Production Control Job Edit dialog box
closes.

f. Select the new production control job in the
list.

4. If you want to use the item number as the piece mark in the production
control job, select the Use Item # as Piece Mark checkbox at the bottom
of the dialog box.

5. Click OK. 

The Estimating Import Filters dialog box opens.

6. To only load specific types of items, in the Estimating Import Filters
dialog box, select a filter type in the Type list, and click Select.

7. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to load to the
Included list.

• Type the maximum and minimum values for items that you want to
load.

8. Click OK. 

To further limit the items to be loaded, repeat steps 6 to 9 for the
necessary filter types.

9. Click Import.

The material is loaded into the selected production control job. After the
process is finished, click OK to close the Import Items dialog box.
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Load selected items into a production control job

1. In the Estimating dialog box, elect the items that you want to load to a
production control job. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Estimating ribbon tab.

3. On the menu, select Load Selected Material Into Production Control.

4. In the Select Production Control Job dialog box, do one of the following: 

To Do this
Load the items to an
existing production
control job

• Select the production job in the list.

Load the items to a new
production control job

a. Click Add.

b. In the Production Control Job Edit dialog box,
type a job number.

c. Modify the other properties of the production
control job according to your needs.

Note that you can also modify the properties
later.

d. Click Save.

e. To create the production control job, click Yes
in the confirmation dialog box.

f. Select the production job in the list.

5. If you want to use the item number as the piece mark in the production
control job, select the Use Item # as Piece Mark checkbox at the bottom
of the dialog box.

6. Click OK.

The material is loaded into the selected production control job. After the
process is finished, click OK to close the Import Items dialog box.

6.4 Combine materials in the Estimating module
You can mult and nest materials using the Combine command. You can then
save and review the combining results.

1. In the Select Estimating Job dialog box, open a job.
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2. Click the Estimating ribbon tab. and select Combine 

The Select Combining Run dialog box opens. When you are performing
the first combining run for a combining job, the list in the dialog box is
empty.

3. Click a desired combining option to select it. 

The options are:

• Mult: Combines linear items, like beams and angles.

• Nest: Combines items that have area, like plates or gratings.

• Mult & Nest: Combines all items.

The Combining Run Filters dialog box opens.

NOTE Filtering items is optional, so you can skip steps 4 to 7 if you do
not want to filter out items from the combining run.

4. To only combine specific types of materials, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to combine to
the Included list.

• Type the maximum and minimum values for the items that you want
to combine.

6. Click OK to apply the filter. 

Repeat steps 4 to 6 for each filter type that you want to set.

7. To ensure that you are using the correct settings, click the Optimizations,
INV Filter, and Suppliers buttons. 

You can modify the settings.

8. In the Combining Run Filters dialog box, click OK.

9. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4.

Tekla PowerFab combines the materials. After the combining process is
finished, the Combining Run Results dialog box opens.

• Piece mark items included with the selected stock lengths are displayed at
the lower-left section of the dialog box.

• Combining results are shown in both the display area and in the summary
grid at the lower-right section of the dialog box.

• The material cost represents the pricing of the materials in the pricing
database that was used in the combining run.
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TIP You can save the combining run to view it later and compare it with
another combining run. To do so, click Save Combining Run at the
bottom of the Combining Run Results dialog box. No cut lists are
generated when you save the combining run.

See also

Rename a combining run (page 336)

Compare combining runs (page 344)

View combining run filter settings (page 337)

Modify run-specific pricing information (page 337)

Recombine all items (page 341)

Recombine items of a shape (page 342)

Recombine items of a material grade (page 342)

Recombine a material dimension (page 343)

Update combining information and recombine all items (page 343)

Export materials for combining (page 90)

Troubleshoot combining issues (page 1110)

6.5 Import files to and export files from the Estimating
module
Use the import commands to import useful files to the Estimating module.
The compatible file types contain IFC files, CIS2 files, KISS files, Bluebeam files,
and Microsoft Excel worksheets. You can also export an estimating job to the
KISS format to save a copy of it before making any changes due to pricing
changes or revisions, or export labor database information to view the
currently set labor times.

See also

Export an estimating job to KISS (page 517)

Export labor information (page 517)

Import files to the Estimating module
You can import IFC, KISS, and Bluebeam files, and Microsoft Excel worksheets
to the Estimating module. IFC is the recommended format.

IFC files allow revised items to be updated, and you can report the changes
(material size, quantity, and so on) during the import process. Bluebeam CSV
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files, Microsoft Excel worksheets, or KISS files do not have this ability, and will
create new instances for all the items in the files.

When exporting to IFC from Tekla Structures, the EPM_Burns or EPM_Copes
Additional Property sets should be included. These provide a more complete
set of information into the Estimating module.

Importing files
1. Go to File --> Import.

2. In the navigation tree of the Import dialog box, click the desired import
option under Estimating. 

3. To browse to the file that you want to import, click ... in the upper right
corner of the dialog box.

4. Select the file, and click Open.

5. Click Import. 

NOTE You can click the Test Import button to test importing a KISS file
before actually importing it. This way, you can ensure that all
information will be imported successfully.

What happens next depends on the type of file that you are importing. For
example, when you are importing an Microsoft Excel worksheet, the
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Import Field Map dialog box asks you to connect the Microsoft Excel
columns with the Tekla PowerFab standard fields.

NOTE You should only save your field mapping selections if you are
absolutely sure that you will continue to use the same mapping.
This is because the Import Field Map dialog box may not open in
the future when you import new files that match the previously
saved mapping.

After you have done so, the import continues.

Once the import is completed, a message appears at the bottom of the
Import dialog box.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Export an estimating job to KISS
Exporting an estimating job to KISS allows you to archive a copy of the
estimating job.

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Export to KISS.

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

A copy of the file is saved in the KISS format.

See also

Import files to the Estimating module (page 515)

Export labor information
Use the Export Labor command to create a text file with the values set in a
labor database. Exporting labor information allows you to view the currently
set labor times.

1. Click the File ribbon tab in the upper-left corner of the Tekla PowerFab
window.

2. On the File menu, select Export Labor.

3. If you have created multiple labor databases, in the Shop Setup dialog
box, select the shop whose labor information you want to export.
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4. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

5. If necessary, change the file name.

6. Click Save.

The labor database information is converted to a text file and saved in the
selected location.

If necessary, you can import the labor information to a different Tekla
PowerFab database.

See also

Import labor information to Tekla PowerFab (page 518)

Import labor information to Tekla PowerFab
To import labor information from a text file to Tekla PowerFab, do the
following:

1. Go to File --> Import. 

The Import dialog box opens.

2. In the navigation tree on the left, select Labor --> ASCII . 
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3. Click ....

4. In the Open dialog box, browse to find the text file that you want to
import.

5. Select the file and click Open.

6. Click Import.

7. If you have created multiple labor databases, in the Select Shop Setup
dialog box, select the labor database to which you want to import the
labor information.

8. Click OK.

9. In the confirmation dialog box, do one of the following:

• To confirm deleting the current labor information and replacing it
entirely with the imported information, click Yes.

• To only replace the information included in the imported file, click No.

Use this option to import text files that only contain part of the labor
information.

10. In the Import dialog box, view the status of the import process. 

If necessary, you can view the import details and errors in a text file by
clicking the Open Import Log button.
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11. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Export labor information (page 517)

6.6 Use Trimble Connect with an estimating job
You can view the estimating job information in IFC models using Trimble
Connect. You can interact with the model in several ways. For example, you
can color-code items in IFC models, or select the same items simultaneously in
an IFC model and in the estimating job.

We recommend that you start the estimating job by importing an IFC file from
Tekla Structures. The IFC file includes GUIDs, unique identifiers that match the
identifiers in the IFC model. The necessary IFC settings for Tekla Structures can
be downloaded from Tekla Warehouse.

Before you can view the job information in Trimble Connect, your Tekla
PowerFab administrator needs to set up the Trimble Connect integration
settings.

See also

Link an estimating job to Trimble Connect (page 520)

Color-code estimating items in the IFC model (page 522)

Select the same items in the estimating job and in the IFC model (page 523)

Visualize jobs with Trimble Connect Organizer and Trimble Connect Content
Browser (page 937)

Link an estimating job to Trimble Connect
Before you can view the estimating job information in Trimble Connect for
Windows, you need to link the job to a Trimble Connect project. You can either
link the job to an existing project or create a new project.

Note that if an estimating job is linked to a project management job, the
Trimble Connect project is managed through the project management job. In
this case, you need to link the project management job to Trimble Connect.
The link is then applied to any linked estimating jobs. The Trimble Connect
project cannot be modified when you access it through the estimating job.

1. In the Estimating dialog box, right-click anywhere in the display area.

2. In the context menu, click Model Interface. 

A message appears, telling you that the current job is not linked to a
Trimble Connect project.
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3. Click OK to close the message. 

4. In the Link Project to Trimble Connect dialog box, do one of the
following: 

To Do this
Link the job to an
existing Trimble Connect
project

a. To display the available Trimble Connect
projects, click Sync Projects.

b. Select the desired project, and click Link
Project.

Create a new Trimble
Connect project and link
the job to it

a. Click Add Project to Trimble Connect.

b. In the Add Users to Project dialog box, click
the arrow buttons to move the users that
participate in the project to the Included list.

c. Click OK.

Tekla PowerFab creates a Trimble Connect
project with the same name and information
as the current job.
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To Do this
d. In the Status dialog box, review the creation

process of the Trimble Connect project.

A message appears, telling you that the project
has been created successfully.

e. Click OK to close the message.

f. In Trimble Connect for Windows, press the
Back button to exit the empty 3D view.

g. In the Explorer side pane on the left, click the
Add File button.

h. In the Add Files dialog box, browse to find the
IFC model.

i. Select the IFC model and click Open.

The IFC model is imported to Trimble Connect for
Windows.

The estimating job and the Trimble Connect project are now linked.

Unlink an estimating job from Trimble Connect
1. In the Select Estimating Job dialog box, select the job that you want to

unlink.

2. At the bottom of the dialog box, click Edit.

3. In the Estimate Job Edit dialog box, click Link on the right side of the
Trimble Connect Project field.

4. In the Link Project to Trimble Connect dialog box, click Unlink project.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

6. In the Estimate Job Edit dialog box, click Save.

Color-code estimating items in the IFC model
To color-code items in the IFC model according to their properties, use the
Colorize command in the Model Viewer Interface dialog box. For example,
you can color-code items according to their category or finish. You can also set
filters to only color-code particular items in the model. By using a filter, for
example, you could first filter the items by their category, and then color-code
the items in that category by their finish.

1. In the Estimating dialog box, right-click anywhere in the display area.

2. In the context menu, click Model Interface.
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3. If necessary, in the Model Viewer Interface dialog box, filter the items
that you want to color-code:

a. Click Set Filters.

b. In the Estimating Filters dialog box, select a filter type in the Type
list, and click Select.

c. In the Filter dialog box, do one of the following depending on the
filter type: 

• Click the arrow buttons to move the items that you want to display
in the model to the Included list.

• Type the maximum and minimum values for the items that you
want to display in the model.

d. Click OK. 

Repeat steps b to d for all filter types that you want to set.

e. Click Apply Filter.

4. Click the arrow on the right side of the Colorize By list and select a
property in the list.

5. Click Colorize.

The items in the IFC model are color-coded according to the selected property.

To revert to the original colors in the IFC model, click Reset in the Model
Viewer Interface dialog box.

See also

Select the same items in the estimating job and in the IFC model (page 523)

Select the same items in the estimating job and in the IFC
model
When you have linked an estimating control job to Trimble Connect, you can
select an item that is selected in one of the software simultaneously in the
other one. Do the following:

1. In the Estimating dialog box, right-click anywhere in the display area.

2. In the context menu, do one of the following:

• To select the item that is selected in the estimating job also in the IFC
model, select Select in Model.

• To select the item that is selected in the IFC model also in the
estimating job, select Select from Model.

See also

Color-code estimating items in the IFC model (page 522)
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6.7 Create a proposal
Once you are happy with the estimate, you can create a proposal out of it.
Proposals are estimating bid letters whose setups you can modify according to
your needs. You can then save the proposals on your computer as Microsoft
Word documents, and print or send them to your client. After creating the first
proposal, you can also create revisions according to your client's needs.

Note that you can set the default proposal setup in Maintenance -->
Estimating --> Proposal Setups .

1. In the Estimating dialog box, click the Estimating ribbon tab.

2. On the menu, select Proposal. 

The Estimating Proposals dialog box opens. Here, you can create new
proposals, modify existing proposals, or delete unnecessary proposals.

3. To create a new proposal, click New.

4. Type a revision number, select date, and click Add.

5. Type a name for the proposal in Title. 

NOTE Steps 6 to 10 only apply when you are creating a first proposal
based on the estimating. When you create revisions, you can skip
these steps.

6. In the available lists, select the firm type of the recipient company and the
recipient company. 

You can only select recipient companies that have already been added to
the Address Book.

7. Click Add.

8. In the Select Sections dialog box, click the arrow buttons to move the
sections that you want to include in the proposal to the Included list.

9. Click OK. 

A dialog box appears, asking you to select which text items you want to
include in a section of the proposal.

10. Click the arrow buttons to move the items that you want to include in the
proposal to the Included list..

11. Click OK. 

Repeat steps 9 to 10 for all sections that you included.

The Estimating Proposal Setups dialog box opens.
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12. In the Estimating Proposal Setups, do any of the following according to
your needs: 

To Do this
Display the price and
weight of the project in
the proposal

a. On the Main Setups tab, select the Show Price
and Show Weight checkboxes.

b. Type the price and weight in the fields on the
right side of the checkboxes.

Modify the appearance
of the proposal

a. On the Main Setups tab, click Open Template.

The proposal template opens in Microsoft
Word. The items marked with << >> pull
information from Tekla PowerFab and can be
adjusted there, but the other information and
font types can be changed in Microsoft Word.

b. Make the necessary changes to the template.

c. In the Microsoft Word window, click File -->
Save .

d. Save the modified proposal as a custom report
in the default folder that your company uses for
custom reports.

To verify the default folder, go to File -->
Default Directories.

Add a new entry a. On the Sections tab, select the section in which
you want to add the new entry.

b. At the bottom of the dialog box, click New.

c. Type the desired text in the space the bottom of
the dialog box.
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To Do this
d. Click Add.

Modify an entry a. On the Sections tab, select the section in which
you want to modify an entry.

b. Select the entry that you want to modify.

c. Change the entry text according to your needs.

d. Click Edit to save the changes.
Move an entry up or
down in the proposal

a. On the Sections tab, select the section in which
the desired entry is located.

b. Select the entry that you want to move.

c. To move the entry, click Move Up and Move
Down.

Change the indentation
of an entry

a. On the Sections tab, select the section in which
the desired entry is located.

b. Select the entry that you want to move.

c. Click Move Left and Move Right to shift the
position of the item in the proposal.

Delete an entry a. On the Sections tab, select the section from
which you want to delete an entry.

b. Select the entry that you want to delete.

c. Click Delete.

d. To permanently delete the entry, click Yes in the
confirmation dialog box.

Change the titles or
headings of the
proposal

a. On the Sections tab, select the section whose
titles or headings you want to change.

b. Do any of the following:

• To change the main title of the section, type
a new title in the Title field and click Set
Title.

• To change the style of the headings, click
Attributes and select appropriate styles in
the lists. Then, click Save.

• To add a subtitle, click Attributes and type a
title in the Subtitle field. Then, click Save.

The subtitle appears under the title in the
proposal.

Add a section a. On the Sections tab, click Add.

b. Type a title for the section.
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To Do this
c. Click OK.

The new tab is added at the end of the proposal
setup.

Delete a section a. On the Sections tab, select the section from
which you want to delete an entry.

b. Select the entry that you want to delete.

c. Click Delete.

d. To permanently delete the entry, click Yes in the
confirmation dialog box.

Move a section forward
or backward in the
proposal

a. On the Sections tab, select the section that you
want to move.

b. Click Move Forward or Move Backward.

13. Click Save.

14. Click Make Proposal.

15. In the Save As dialog box, browse to the folder where you want to save
the proposal.

16. If necessary, change the file name.

17. Click Save.

18. To close the dialog box, click the Close button (X) in the upper-right
corner.

We recommend that you save the exported proposals in the estimating
Document Index for future reference. For more information, see Manage files
for an estimating job (page 481).
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7 Inventory

The Inventory module in Tekla PowerFab consists of two separate parts:
inventory and inventory history. In Inventory, you can take items from stock,
return them to stock, reserve items for a customer order, and so on. In
Inventory History, you can view the entire history of items in the inventory.

Any item in Tekla PowerFab becomes an inventory item when it is loaded into
a purchase order. Note that you cannot modify the properties of these types
of items as long as the items have not yet been received.

7.1 Define the default inventory settings
Before you start using the Inventory module for making orders, taking
material from stock, and so on, we recommend that you define default
settings for the Inventory module.

Define the company standard settings, the countries of origin, and a set list of
primary and secondary locations, adjust the visible input and display fields of
both Inventory and Inventory History, and customize the drop-down menu
commands in the Inventory module.

For more information, see the following links:

Define company standard settings for Inventory (page 528)

Define the countries of origin (page 531)

Restrict inventory locations (page 531)

Define company standard settings for Inventory
For each module, you can define company-level settings that are the default
for all new jobs.

1. Click the Maintenance ribbon tab.
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2. On the menu, select Inventory --> Company Standards. 

The Company Standards dialog box opens.

3. Modify the settings as needed. 

Option Description
Auto-Calc Part # When selected, Tekla PowerFab automatically

enters a part number for each item when new
material is received. When cleared, you need to
enter the part number manually.

Part # Format The part number format.

To change the part number format, click the arrow
on the right side of the Part # Format field, and
select an option in the list.

The options are:

• [PO#]-[Item#]-[Receive Count]-[RTS Count]:

The part number consists of the purchase order
number, purchase order item number, receive
count, and return to stock count.

Note that the receive count number does not
refer to the quantity received, but the
occurrence of receiving the material. The
returned to stock count number indicates how
many times the material has been cut.

For example, if the purchase order number was
123, the item number 50, quantity 5, and 2 are
received, the part number would be 123-50-1-0.
When the remaining 3 pieces were received, the
part number would be 123-50-2-0. If the length
of the material was 40’-0 and you took 25’-0 and
returned 15’-0 to inventory, the part number
would be 123-50-1-1.

• Sequential, Increments each receipt:

The part numbering starts from 00001, and
each time an item is received on a purchase
order, the item is assigned an incremented part
number (for example, 00002).

• Sequential, Increments each receipt, with
RTS count:

The part number consists of a sequential
number and the returned to stock count.

The part numbering starts from 00001, and
each time an item is received on a purchase

Inventory 529 Define the default inventory settings



Option Description
order, the item is assigned an incremented part
number (for example, 00002). The returned to
stock count indicates how many times the
material has been cut.

An example part number could be 00003-1.
Inventory History -
Default number of
days to view (0 for all)

Allows you to set a filter that defines the number of
days that items remain visible in the Inventory
History dialog box.

Note that you can clear the filter in the Inventory
History dialog box to display all items in the
inventory history again.

Enter a number in the field. To always display all
items in the Inventory History dialog box, enter 0.

Open to Filter
Selection

When selected, the <Module> Filters dialog box
automatically opens when you open a job. In the
dialog box, you can set filters to only show the
items that you want to see in the job.

The job opens when you have set the filters.

4. Click Save.

The default settings of the Inventory module are updated.

Define default input and display units for Inventory
You can define standard input and display units for the company. You can
select either metric or imperial units and the units of measurement for a
piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

1. Go to Maintenance --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Input/Display Units. 

The Input/Display Units dialog box opens.

3. Select the measurement system and the units of measurement on the
drop-down menus.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

5. Click Save.

6. Do either of the following:

Inventory 530 Define the default inventory settings



• Click Save

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

Define the countries of origin
In the Countries dialog box, you can add new countries of origin for items in
the inventory. If necessary, modify or delete any existing countries to match
the countries used by your company.

1. Click the Maintenance ribbon tab.

2. On the menu, select Inventory --> Countries of Origin .

3. In the Countries dialog box, do any of the following according to your
needs: 

To Do this
Add a new country a. Click New.

b. Type the country and an abbreviation for it.

Only the abbreviation will be shown when you
set a country of origin for an item in the
Inventory dialog box.

c. Click Add.

The new country is now available in the Inventory
dialog box.

Modify an existing
country

a. Select the country that you want to modify.

b. Modify the country and its abbreviation.

c. Click Edit to save the changes.
Delete a country a. Select the country that you want to delete.

b. Click Delete.

c. In the confirmation dialog box, click Yes to
permanently delete country.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Restrict inventory locations
You can restrict the possible primary and secondary locations to ensure that
everyone uses the same location information. Note that these settings will not
affect any existing locations already in use.
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1. Click the Maintenance ribbon tab.

2. On the menu, select Inventory > Location Restrictions.

3. In the Location Restrictions dialog box, click New.

4. Type the primary location in the Location box.

5. Type the secondary location in the Secondary Location box.

6. If you want to allow any location either for the primary or secondary
location, select the corresponding checkbox. 

For example, you might want to allow any primary location but only some
secondary locations. Note that if you add a restriction and then add
another line that allows any location, the restriction will not be effective.

7. Click Add.

7.2 Open the Inventory module
To maintain your inventory, open the Inventory module.

• At the top of the Tekla PowerFab window, click the Inventory icon. 
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The Inventory dialog box opens.

(1) Summary grid: Shows the quantities, weights, and valuations of items in
stock and on order.

(2) Navigation tree: Lists the items you can view by shape, job, and inventory
location, for instance.

Click > to expand the list. Then, click the items that you want to view in the
display area.

(3) Display area: Lists all material items in the inventory.

(4) The leftmost unnamed column: The statuses of different material items.
The abbreviations indicate the following statuses:

• PO: Items are on a purchase order

• O: Items are on order (not yet received)

• R: Items are reserved for a job

• C: Items have been combined

For example, items labeled PO-O-R-C have been combined and are on a
purchase order, have been reserved for a job, and have not yet been received.

Items without any status indicator in this column are open stock items and
were entered manually.

(5) Zero quantity items: Placeholders for items that have been received on a
purchase order, but have not been finalized yet. Zero quantity items cannot be
modified in the inventory, and the combining details table below the input
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area does not display any information about whether items are properly
linked to production control jobs.

Using zero quantity items in the inventory allows Tekla PowerFab to properly
modify the base pricing if the pricing in the purchase order is modified after
the materials have been received and split into different line items.

You can hide the zero quantity items by creating and saving a filter that
excludes these items. This way, you will not mistake them for additional
material items in the inventory. For more information, see Filter information in
the Inventory dialog box (page 534).

(6) Input area: Allows you to add information for existing or new items. It also
displays the properties of an item selected in the display area.

Note that properties of items that are on a purchase order or that are
placeholders with zero quantity cannot be modified, so the input fields
become inactive if you select them in the display area.

You can modify the available fields in the Edit Input Fields dialog box.

(7) Combining details: The parts to be cut from the item selected in the display
area.

NOTE Under the combining details table, you can see if the items that are
combined to the selected inventory item are properly linked to a
production control job.

Filter information in the Inventory dialog box
In addition to using the navigation tree for filtering items, you can set filters
that determine which items are shown in the Inventory dialog box.

NOTE Using filters only affects the way you see the Inventory dialog box, so
you cannot accidentally change other users' settings.

If the Open to Filter Selection checkbox has been selected in Maintenance --
> <Module> --> Company Standards, the <Module> Filters dialog box opens
automatically when you open a job.

If the Open to Filter Selection checkbox has not been selected, open the
<Module> Filters dialog box as follows:

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Filter. 
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The <Module> Filters dialog box opens.

3. Select a filter type in the Type list and click Select. 

The Filter dialog box opens.

For some filter types, you can also click Find and type the desired value in
the search box to use it. This way, you do not have to scroll through all the
available items.

4. Click the arrow buttons to move the items that you want to display to the
Included list.

5. Click OK. 

If you want to further filter the information displayed , repeat steps 3 to 5
for different items. Note that only items that match the items in the
Included list will be available when setting more filters.

If you want to clear all filter settings, click Reset.

The <Module> Filters dialog box closes, and the items are filtered according
to the settings you made.

To display all information again, click Clear Filters in the upper-left corner.

To create and save commonly used filters, see Create and modify module-wide
filters (page 261).
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Search for items in the Inventory dialog box
Use the different Find commands in the Inventory dialog box to quickly find
the needed material items. You can search for items by material shape, grade,
or size, heat number, or serial number.

Search for items by material shape, grade, or size
1. At the top of the Inventory dialog box, click Find Shape/Grade/Size, or

press Ctrl+F5.

2. Select the material shape, and optionally grade and dimensions in the
appropriate lists. 

You can also type the shape, grade, and dimensions in the appropriate
fields.

3. Do any of the following:

• To find items with the selected material shape, click Find Shape.

• To find items with the selected material shape and grade, click Find
Grade.

• To find items with the selected material shape and dimensions, click
Find Size.

Only items that match your search are displayed in the Inventory dialog box.
The selected material shape, grade, and dimensions are shown above the
navigation trees on the left side of the dialog box.

To view all items again, click All Items in the upper navigation tree.

Search for an item by heat number
1. At the top of the Inventory dialog box, click Find Heat #.

2. Select the heat number in the list, or type it in the field.

3. Click Find Heat #.

The item with the selected heat number is selected the Inventory dialog box.

Search for an item by serial number
1. At the top of the Inventory dialog box, click Find Serial #.

2. Select the serial number in the list, or type it in the field.

3. Click Find Serial #.

The item with the selected serial number is selected the Inventory dialog box.
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Open Inventory History
In the Inventory History dialog box, you can view all material that has been
taken from stock for a job.

1. While in the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Inventory History. 

TIP If you hold down Shift when selecting the Inventory History
command, the Inventory History opens in a new dialog box. This
way, you can view the inventory and the inventory history at the
same time.

The Inventory History dialog box opens.

TIP Use the navigation trees on the left of the dialog box to filter which items
are visible. For example, to only show items in a specific job, click a job
number in the lower navigation tree.

To return to the Inventory dialog box, do the following:

1. Click the Inventory ribbon tab.
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2. On the menu, select Inventory.

7.3 Manage files for inventory
Document Index is a place for storing files to be shared among other users.
In Document Index, you can store various kinds of documents for reference,
and modify, delete, open, and email these files.

• To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production Control,
and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box related
to linked jobs.

The Document Index - By Category dialog box opens.

See also

Document Index (page 149)

7.4 Manage inventory items
You can manage inventory items in multiple ways. After adding the necessary
inventory items, you can copy and modify the items according to your needs.
You can also take material from stocks and return the remaining material to
stock, reserve or send inventory items to customer orders, combine inventory
items, or delete unnecessary inventory items.

For more information, see the following links:

Add an item to the inventory (page 538)

Copy an inventory item (page 548)

Modify inventory items (page 545)

Take material from stock and return material to stock (page 549)

Add inventory items to Order Entry (page 553)

Combine inventory items manually (page 556)

Delete inventory items (page 555)
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Add an item to the inventory
You can add new items manually to the inventory.

1. In the Inventory dialog box, click New.

2. Define the item properties. 

NOTE The visible input fields and their order depend on the settings
that you have defined inMaintenance --> Inventory --> Edit
Input Fields.

The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Base Price The base price of the material item.

We recommend that you use base
prices to create more detailed
reports.

Type in the base price.

To change the base price units and to
convert the current price to the
selected units, right-click the Base
Price field, and select an appropriate
option in the context menu.

B/L # The bill of lading number or the
shipment number that the material
item was received on.

Type in the number.
Category

Sub-Category

A class used for sorting items within a
job. You can use categories and
subcategories for filtering
information.

We recommend that you do not type
any information in this field when you
add inventory items manually.

Note that if you type any information
manually in the field, the information
will be overwritten if you combine or
link material from Production
Control to the inventory item.
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Option Description
Country The country of origin of the material

item.

Click the arrow on the right side of the
Country field, and select a country in
the list.

The available countries can be
modified in the Countries dialog box.
For more information, see Define the
countries of origin (page 531).

Date Delivered The date when the material item has
arrived to inventory.

Do one of the following:

• Type in the date.

The acceptable formats are
YYYY/MM/DD, YY/MM/DD,
MM/DD/YYYY, and MM/DD/YY.

• Select the delivery date in the
calendar.

Note that the Date Delivered field is
only available if the On Order
checkbox is cleared.

Dimensions The material dimension, or material
size, of each piece.

Depending on the shape, the
dimension can also be mandatory
information.

Click the Dimensions field to select
an available material dimension, and
double-click the desired dimension in
the list.

You can also use a custom material
dimension. Note that the dimension
is not automatically added to the
material database.

To use a custom dimension:

a. Click in the Dimensions field.

b. Click Add Size.

c. Define the dimension properties.
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Option Description
d. Click Save.

You can now select the
dimension and use it.

Grade The material grade of each piece.

Depending on the shape, the grade
can also be mandatory information.

Either select the grade from the drop-
down menu or type the grade
indicator in the field.

Heat # The heat number of the material
item.

Type in the number.

Note that you need to type a heat
number for a material item before
attaching documents to it in
Document Index.

Heat SN A property that ensures that heat
numbers are not duplicated.
However, duplications are extremely
rare, so using the Heat SN field is
optional.

If necessary, type a value in the Heat
SN field.

Job No. Type in the number.

For example, you can use the Job No.
field to reserve material for the shop
or maintenance, so that it cannot be
used elsewhere.

Length The length of each piece.

Default length input settings are set in
Company Standards, but you can
modify them for each job.

Loc. 1 The inventory location of the material
item.

Click the arrow on the right side of the
Location field and select a location in
the list, or type a new location in the
Location field.
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Option Description
Loc. 2 The secondary inventory location of

the material item.

Click the arrow on the right side of the
Secondary Loc field and select a
location in the list, or type a new
secondary location in the Secondary
Loc field.

For example, you can use secondary
locations to represent the inventory
sites or the date the location was
verified.

You can also use the Secondary Loc
field to provide a temporary location
for storing some pieces of a material
item. This way, you can split the
quantity of the material item without
affecting the location.

Lot # The lot identification number of the
material item.

See Manage the sequences and lots
of selected production control items
(page 904)

We recommend that you do not type
any information in this field when you
add inventory items manually.

Note that if you type any information
manually in the field, the information
will be overwritten if you combine or
link material from Production
Control to the inventory item.

Mill of Origin A firm identified as a mill of origin.
See Modify company or contact
properties (page 146).

On Order When selected, the material item is
on order and has not yet been
received. When cleared, the material
item is marked as received.

Items that are on order are marked
with an O in the leftmost column of
the Inventory dialog box.
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Option Description
Original Date * The date on which the item has

originally been added to inventory.

Click the arrow on the right side of the
Original Date field and select a date
in the calendar.

Original Price The base price at which it was first
put on a purchase order or added to
the inventory.

Part Number The part number of the material item.

Type the part number in the Part
Number field.

To adjust part number settings, see
Define the default inventory settings
(page 528).

P.O. # The number of the purchase order
that contains the material item.

Type in the number.

Note that you need to type a
purchase order number for a material
item before attaching documents to it
in Document Index.

Quantity * The number of pieces to be added.

Use the numeric keypad to add,
multiply, divide, or subtract number
of items.

Reference # A reference number that links items
in inventory or purchasing to the
production control job.

The reference number can be
different depending on the case:

• If an item is sent from Production
Control to Purchasing or
Inventory, Tekla PowerFab
creates a copy of the record, and
the item is linked to include the
reference number.

• If the item is sent to Purchasing
later in the process, the reference
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Option Description
number is the mark or piece mark
number.

However, if the reference number
has been assigned in the
production control job, that
reference number is maintained in
the inventory as well.

We recommend that you do not type
any information in this field when you
add inventory items manually.

Remarks Any comments or remarks that you
want to add about the item.

Type in the remarks or select an
existing remark in the list.

Reorder Any reordering information about the
item.

Type any information in the Reorder
field.

Use the Stock/Reorder command to
set stock quantities to be maintained.
See Add, modify, and delete stock
quantities to be maintained
(page 558).

Reserved Indicates if the item is reserved for a
customer order. See Add inventory
items to Order Entry (page 553).

Serial # The serial number of the material
item.

To add a serial number, click the
Serial # button. For more
information, see Define serial
numbers for an inventory item
(page 546).

Sequence The sequence number assigned to
the item.

See Manage the sequences and lots
of selected production control items
(page 904)
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Option Description
We recommend that you do not type
any information in this field when you
add inventory items manually.

Note that if you type any information
manually in the field, the information
will be overwritten if you combine or
link material from Production
Control to the inventory item.

Shape * The material shape of each piece.

Either select the shape from the drop-
down menu or type the shape
indicator in the field (for example,
HSS).

Supplier The supplier of the material item.

Either type in a supplier or select the
supplier from the drop-down list.

Note that you need to type a supplier
for a material item before attaching
documents to it in Document Index.

Stock Any stock information about the item.

Type any information in the Stock
field.

Use the Stock/Reorder command to
set stock quantities to be maintained.
See Add, modify, and delete stock
quantities to be maintained
(page 558).

3. Click Add.

The new material item is added to the list in the Inventory dialog box.

Modify inventory items
You can either modify items one by one, or use the Global Edit commands to
modify multiple items at one go.

NOTE Inventory items that are on a purchase order or that are placeholders with
zero quantity cannot be modified, so the input fields become inactive if you
select them in the display area.

TIP If you cannot find the property you want to modify, check if you can add it in
Maintenance --> Inventory --> Edit Input Fields.
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For more information, see the following links:

Modify multiple inventory items (page 547)

Modify selected inventory items (page 548)

Define serial numbers for an inventory item
You can add serial numbers for a material item in the Inventory dialog box.
Note that you can only add a serial number for items that have been marked
as received, and are not on order.

1. In the Inventory dialog box, click a material item to select it.

2. On the right side of the dialog box, click Serial # under the Reference
Number field.

3. In the Serial Numbers dialog box, do one of the following:

• To assign a different serial number for each piece of the material item,
select the Serialized option.

If you use or plan to use bar codes, do not select the Serialized option.
Using the Serialized option prevents displaying serial numbers in
some reports.

• To use the same serial number for all pieces of the material item,
select the Non-Serialized option.

4. Click Update.

5. Click New to define a new serial number.

6. Enter the serial number in the Serial # field.

7. Click Add. 

Repeat steps 5 to 7 for each serial number that you want to create.

If necessary, you can:

• Modify a serial number, and update it by clicking Save.

• Delete a serial number by clicking Delete, and then, clicking Yes to
confirm.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

The serial numbers appear under the Serial # button in the Inventory dialog
box.

Modify a single inventory item
You can modify the properties of a single inventory item directly in the
Inventory dialog box.

Note that if you only want to modify some pieces in an item, you need to split
the item first. You can do so by either moving the desired quantity of pieces to
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a different location or secondary location, or changing the reservation of the
quantity.

1. In the Inventory dialog box, select the item that you want to modify.

2. On the right side of the dialog box, modify the item properties according
to your needs.

3. Click Edit to save the changes.

See also

Modify selected inventory items (page 548)

Modify multiple inventory items (page 547)

Modify multiple inventory items
Use the Global Edit command to modify the properties of multiple items at
one go. This way, you can save time, as you do not need to change the
properties of each item individually.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Global Edit --> Global Edit. 

The Global Edit Filters dialog box opens.

3. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

4. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

5. Click OK. 

To further limit the items to modify, repeat steps 3 to 5 for all necessary
filter types.

6. Click OK. 

The Global Edit dialog box opens.

7. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

8. Click Update. 

The Confirm dialog box opens.
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9. To confirm changing the properties of multiple items, click Yes.

The changes you made to the item properties are updated.

See also

Modify selected inventory items (page 548)

Modify selected inventory items
Use the Global Edit - Selected command to modify the properties of multiple
selected items at one go. This way, you can save time, as you do not need to
change the properties of each item individually.

1. In the Inventory dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Inventory ribbon tab.

3. On the menu, select Global Edit --> Global Edit - Selected. 

The Global Edit - Selected dialog box opens.

4. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

5. Click Update.

The properties of the selected items are updated.

See also

Modify multiple inventory items (page 547)

Copy an inventory item
Copy a material item in the Inventory dialog box and use it as the basis of a
similar item. Then, adjust any properties according to your needs. By copying
items, you can save time and avoid entering the same data multiple times.

1. In the Inventory dialog box, click the material item that you want to copy.

2. At the bottom of the dialog box, click Copy.

The item is copied and added in the list.

Note that not all values in the leftmost column are copied. For example, PO
indicates that the item has been sent to a purchase order, so it is not used for
new, manually added inventory items.
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Take material from stock and return material to stock
To take materials from stock and cut them, use the TFS command. Then, use
the RTS command to return the remaining lengths to stock.

1. In the Inventory dialog box, click items to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click TFS, or press Shift+F7. 

Depending on whether the items are linked or combined to a job, one of
the following happens:

• If the items are not linked or combined to a job or you have selected
multiple items that are linked or combined to a job, the Take From
Stock dialog box opens.

• If a single item is selected and it is linked or combined to a job, a
confirmation dialog box appears.

3. Do one of the following: 

NOTE The steps may vary slightly depending on the item properties,
such as the item quantity, links to production control jobs, and the
multing and nesting status.

To Do this
Take from stock one or
multiple items that are
not linked or combined
to a job

a. In the Take From Stock dialog box, type the
quantity of pieces and the job number.

Note that if you have selected multiple items,
Tekla PowerFab automatically takes all
available pieces from stock.

b. If necessary, modify the category, sub-
category, sequence, lot number, and release
number.

c. Click TFS to take the material from stock.

d. In the RTS section of the dialog box, type the
quantity, width, length, location, and job
number of items that you want to return to
stock.

e. Click RTS to return the remaining material
lengths to stock.

f. Click Apply.
Take from stock multiple
items that are linked or
combined to a job

a. In the Take From Stock dialog box, type the
job number.
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To Do this
b. If necessary, modify the category, sub-

category, sequence, lot number, and release
number.

c. To return all drop left from cutting to stock,
select the Return Drop of Combined Items
to Stock checkbox.

d. Click TFS to take the material from stock.
Take from stock a single
item that is linked or
combined to a job

a. To update the linked production control jobs
when taking the material from stock, click Yes
in the confirmation dialog box.

b. If necessary, in the Take From Stock dialog
box, click the arrow buttons to move the
quantity to take from stock to the Included
list.

c. In the Enter Value dialog box, do one of the
following:

• Type the date in the Enter Value field.

The accepted formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the
Date Required field and select the date in
the calendar.

d. Click OK.

e. In the Select Jobs to TFS dialog box, click the
arrow buttons to move the jobs that you want
to update to the Included list.

f. Click OK.

g. To confirm taking the material item from stock,
click Yes in the confirmation dialog box.

h. In the TFS/RTS dialog box, click New to add a
pieces that will be returned to stock. Then,
define the size of the piece, and click Add.

Repeat step h to add all necessary pieces.

i. Click OK.

The TFS dialog box shows the progress of the
take from stock process.

j. After the take from stock process has finished,
do one of the following:

• To close the TFS dialog box and return to
the Inventory dialog box, click Close.To
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To Do this
view or print TFS reports, click Reports.For
more information, see View and print TFS
reports (page 573).

Take selected materials from stock
Use the TFS - Selected command to take selected inventory items from stock,
cut them, and move the cut lengths into the inventory history. The remaining
drop remains in the inventory. Once the materials have been taken from stock,
you can view or print different reports for the materials.

1. In the lower navigation tree of the Inventory dialog box, select a job
number. 

Only the items within the selected job are displayed in the display area.

2. Click the Inventory ribbon tab.

3. On the menu, select Production Control --> TFS - Selected . 

The Enter Value dialog box opens.

4. Enter a date for taking the materials from stock.

5. Click OK.

6. To take the selected materials from stock, click Yes in the confirmation
dialog box. 

The selected items are taken from stock. You can see the progress in the
TFS dialog box. Wait until the process is completed.

7. Do any of the following: 

To Do this
View or print a report on
the TFS process

a. Click Reports.

The Report Progress dialog box opens.

b. Select the report that you want to print or
view.

c. Do any of the following:

• To view the report, click View.

• To print the report, click Print, select the
printer, and click OK.

d. To close the Report Progress dialog box, click
the Close button (X) in the top right corner.

Close the TFS dialog box • Click Close.
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Add inventory to load
You can add items to a load directly from inventory. The inventory is then
taken from stock and the weight of the materials is included in the overall
weight of the load. The shipping ticket report displays the additional inventory
items.

1. Take an item from stock:

a. In the Inventory dialog box, click items to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

b. Click TFS or press Shift+F7. 

The Take From Stock dialog box opens.

2. Type in the quantity and job number. 

Load # appears in the dialog box. It lists all the unshipped loads for the
selected job.

3. Select the load number.

4. Click TFS.
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The inventory is assigned to the load and taken from stock.

The inventory materials are listed on the Additional tab in Production
Control --> Load Properties, and they will also be displayed on the shipping
ticket reports.

NOTE • You can also add inventory to a load in Tekla PowerFab Go. See Add
inventory to load in Tekla PowerFab Go User Guide.

• If you delete inventory from the load, you are prompted to confirm
if you wish to perform a reverse take from stock.

Move an item to another inventory location
Use the Move command to move a single inventory item to another inventory
location.

1. In the Inventory dialog box, select the item whose location you want to
change.

2. Click Move, or press Shift+F8. 

The Move dialog box opens.

3. In the Quantity field, enter the number of pieces that you want to move.

4. Click the arrow on the right side of the Location list and select the new
location.

5. If necessary, click the arrow on the right side of the Sec Location list to
select a secondary location.

6. Click Move, or press F4.

The selected quantity of items is moved to the selected location.
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Add inventory items to Order Entry
Use the Add Selected to Order and Quick Quote commands to add items to
Order Entry. The Add Selected to Order command reserves the selected
items for a customer order, whereas the Quick Quote command adds the
selected items directly into a quote or a customer order. Note that you can
only add unreserved items to Order Entry.

Reserve items for a customer order
1. In the Inventory dialog box, select the items that you want to load to a

customer order. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Inventory ribbon tab.

3. On the menu, select Order Entry --> Add Selected to Order .

4. In the Select Quote/Order dialog box, select the customer order to which
you want to load the items.

5. Click OK.

The Select Quote/Order dialog box closes. The items are reserved for the
selected customer order.

Send items to a customer order
1. In the Inventory dialog box, select the items that you want to add to a

quote or customer order. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Inventory ribbon tab.

3. On the menu, select Order Entry --> Quick Quote . 

The Quick Quote dialog box opens. The properties of the selected items
are visible in the Details section of the dialog box.

4. In the Customer Name list, select the customer company. 

Note that the customer must already be saved in the Address Book.

Tekla PowerFab automatically fills in the customer code and the default
contact.

5. If necessary, in the Contact list, select another contact person.

6. According to your needs, do any of the following: 
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To Do this
Send items to an existing quote or
customer order

a. Click Save to Quote/Order.

The Select Quote/Order dialog
box opens.

b. Select the quote or order to
which you want to send the
items.

c. Click OK.

The items are sent to the selected
quote or order.

Send items to a new quote a. Click Save to New Quote.

b. To create a new quote and send
the selected items to it, click Yes
in the confirmation dialog box.

c. In the Quote dialog box, modify
the quote according to your
needs.

For more information, see Create
a quote or an order (page 1092).

d. Click Save Quote Information.

e. To close the dialog box, click the
Close button (X) in the upper-
right corner.

Send items to a new customer order a. Click Save to New Order.

b. To create a new order and send
the selected items to it, click Yes
in the confirmation dialog box.

c. In the Order dialog box, modify
the order according to your
needs.

For more information, see Create
a quote or an order (page 1092).

d. Click Save Order Information.

e. To close the dialog box, click the
Close button (X) in the upper-
right corner.

7. To close the Quick Quote dialog box, click the Close button (X) in the
upper-right corner.
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Delete inventory items
You can delete unnecessary material items from inventory. Note that deleting
the items is permanent and cannot be undone.

You can still view the deleted items in the transaction history. For more
information, see View the transaction history in the Inventory module
(page 568).

1. In the Inventory dialog box, click the items that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the inventory item, click Yes in the confirmation
dialog box.

Combine inventory items manually
You can manually combine items in the Inventory dialog box by activating the
manual combine mode. You can select pieces to combine them into a stock
length, or uncombine pieces from a stock length.

Switch to the manual combine mode
1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Switch to Manual Combine Mode.

The Inventory dialog box changes to the manual combine mode. New buttons
appear at the bottom of the dialog box to enable adding and removing
combined items from the selected inventory item.

You can now combine inventory items manually.

Combine materials
Use the Add Items command to combine materials into a selected stock
length.

1. In the Inventory dialog box, click a stock length to select it.

2. At the bottom of the dialog box, click Add Items. 

The Add Item dialog box opens. You can see all available uncombined
materials that can be combined to the selected stock length. If the dialog
box is blank, no materials are available to be combined to the selected
stock length.

Note that the available materials come from requisitions. If the items that
you want to combine are in a production control job, you need to add
them to a requisition before you can combine them manually.
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3. In the Add Item dialog box, click an uncombined item to select it.

4. If necessary, modify the quantity of inventory items that you are
combining materials to. 

If the quantity is greater than 1, the materials should be multiples of that
quantity in order to be displayed and selected in the Add Item dialog box.

5. To allow material grade substitutions, select the Use Grade Substitutions
checkbox.

6. Click Add.

The selected material items are combined to the selected stock length.

Uncombine materials
Use the Remove Item to uncombine material items from a selected stock
length.

1. In the Inventory dialog box, click a stock length to select it.

2. At the bottom of the dialog box, click Remove Item. 

If the selected stock length is not combined, the Remove Item button is
not available.

3. In the Remove Item dialog box, use the arrow buttons to move the
materials that you want to uncombine to the Included list. 

To only move one piece of the selected item, click the Qty 1 buttons.

4. Click OK.

5. In the confirmation dialog box, do one of the following:

• To simply uncombine the pieces, click No.

Select the No option if you are removing items to clear the material of
items that are no longer linked.

• To uncombine the pieces and return the items to the requisition from
which they were loaded to a purchase order, click Yes.

The items are held in the requisition to be recombined and purchased,
or combined into a different stock length.

If the requisition no longer exists or the material item was never on a
requisition, Tekla PowerFab asks you to select a requisition or add a
new one.

The confirmation dialog box and the Remove Item dialog box close. The
pieces are uncombined from the selected stock length.

Switch back to the input mode
1. Click the Inventory ribbon tab.
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2. On the menu, select Switch to Input Mode.

The Inventory dialog box changes back to the input mode.

7.5 Add, modify, and delete stock quantities to be
maintained
In the Stock/Reorder dialog box, you can add, modify, and delete stock
quantities that should always be maintained in inventory. This way, Tekla
PowerFab can alert you when you need to reorder items.

To access the Stock/Reorder dialog box, do the following:

• At the top of the Inventory dialog box, click Stock/Reorder.

The Stock/Reorder dialog box opens, displaying previously created records.

Note that the items in the Stock/Reorder dialog box are color-coded:

• Green items are equal or above the required stock quantity.

• Yellow items are below the required stock quantity.

• Red items are below both the required stock quantity and the required
reorder quantity.

Add a new stock record
1. At the bottom of the Stock/Reorder dialog box, click Add New Record. 

The Stock/Reorder - Add dialog box opens.

2. Select the shape, dimensions, grade, and length to be ordered.

3. If necessary, in the Location list, select the location where the items will
be stored. 

Note that if you select a location, the record only applies to the quantities
of items in the assigned location.

4. In the Stock Qty field, enter the stock quantity that should be maintained.

5. In the Reorder Qty, enter the quantity at which Tekla PowerFab prompts
you to reorder the item.

6. Click Add.

The Stock/Reorder - Add dialog box closes, and the new record is added to
the list in the Stock/Reorder dialog box.
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Modify stock records
1. In the list in the Stock/Reorder dialog box, click the record that you want

to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Modify the values in the Stock Qty and Reorder Qty fields according to
your needs.

3. Click Save.

Delete stock records
1. In the list in the Stock/Reorder dialog box, click the record that you want

to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete Selected.

3. To permanently delete the record, click Yes in the confirmation dialog box.

Load stock items to a requisition
1. In the list in the Stock/Reorder dialog box, click the items that you want

to send to a requisition. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Requisition.

3. In the Select Requisition dialog box, do one of the following according to
your needs: 

To Do this
Add the items into a new
requisition

a. Click Add.

b. Modify the requisition number and description
according to your needs.

c. If necessary, modify other requisition
properties.

d. Click Save.

e. Select the new requisition in the list.

f. Click OK.
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To Do this
Add the items into an
existing requisition

a. Select a requisition in the list.

b. Click OK.

The items are loaded to the selected requisition.

Load stock items to a purchase order
1. In the list in the Stock/Reorder dialog box, click the items that you want

to send to a purchase order. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Purchase Order.

3. In the Select Purchase Order dialog box, do any of the following
according to your needs: 

To Do this
Add the items into a new
requisition

a. Click Add.

b. Modify the purchase order number according
to your needs.

c. Add vendor details for the purchase order.

d. If necessary, modify other purchase order
properties.

e. Click Save.

f. Select the new purchase order in the list.

g. Click OK.
Add the items into an
existing requisition

a. Select a purchase order in the list.

b. Click OK.

The items are loaded to the selected purchase order. In the Stock/Reorder
dialog box, the items are color-coded to reflect the purchase activity.

7.6 View inventory details
You can view different details of inventory materials, including the heat
documents attached to items, the location of barcoded materials, the total
value of inventory materials, and the transaction history. You can also view TFS
report and inventory reports, and print or export them according to your
needs.
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For more information, see the following links:

View heat documents attached to inventory items (page 561)

View the location of barcoded materials (page 563)

View the value of inventory materials (page 565)

View the transaction history in the Inventory module (page 568)

View and print TFS reports (page 573)

View, print, and export inventory reports (page 573)

View heat documents attached to inventory items
Use the Check Heat Documents command to view if inventory items have
heat documents attached to them. You can also save or print the available
heat documents, or create reports on the items that have or do not have heat
documents.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Check Heat Documents.

3. To limit the item types whose heat documents you want to check, in the
Inventory - Check Heat Documents dialog box, select a filter type in the
Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the items whose heat documents
you want to view to the Included list.

b. Type the maximum and minimum values for the items whose heat
documents you want to view.

5. Click OK. 

To further limit the item types, repeat steps 3 to 5 for all necessary filter
types.

6. Click Check Heat Documents. 

All inventory items that match the filters that you set are displayed. If an
item has attached heat documents, you can see the number of the heat
documents in the Docs column. If an item does not have attached heat
documents, the Docs column is highlighted with red.

7. According to your needs, do any of the following: 

To Do this
Update heat document
information

• Click Refresh.

Any new or modified information is updated.
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To Do this
Add, modify, and delete
heat documents in
Document Index

a. Click Open Document Index.

Document Index opens. For more information,
see Manage files for inventory (page 538).

Save heat documents a. Do one of the following:

• To only save particular heat documents,
click the item whose documents you want
to save, and click Save Documents -->
Save Documents - Selected .

• To save all available heat documents, click
Save Documents --> Save Documents -
All .

b. In the Browse For Folder dialog box, browse
to an empty folder where you want to save the
heat document information.

c. Click OK.

A report of the heat documents opens.
Print heat documents a. Do one of the following:

• To only print particular heat documents,
click the items whose documents you want
to print, and click Print Documents -->
Print Documents - Selected .

• To print all available heat documents, click
Print Documents --> Print Documents -
All .

b. In the Select Printer dialog box, click a printer
to select it.

c. Click OK.

All or the selected heat documents are printed.
Create reports a. Do one of the following:

• To create a report only containing
particular items, click the items to select
them, and click Reports --> Reports -
Selected .

• To create a report containing all items, click
Reports --> Reports - All .

b. In the Report Selection dialog box, click the
report that you want to create.

c. Do one of the following:

• To view the report, click View.
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To Do this
• To print the report, change the number of

copies by clicking the + and - buttons, and
click Print.

• To export the report, click Export, modify
the export format, file name, and location,
and click Export again.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

View the location of barcoded materials
Use the Location Sweep command to create location sweep reports, which
show the location of yard materials that have been identified by barcodes.
Note that the Location Sweep command is only available for items with serial
numbers.

To access the Inventory Location Sweeps dialog box, do the following:

1. While in the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Barcode --> Location Sweep .

The Inventory Location Sweeps dialog box opens.

According to your needs, do any of the following.

View the location of barcoded materials
1. Click New Location Sweep.

2. To only view locations of specific types of materials, select a filter type in
the Type list, and click Select.

3. In the Filter dialog box, click the arrow buttons to move the materials that
you want to include in the location sweep to the Included list. 

To further limit the materials included, you can repeat steps 2 to 3 for all
necessary filter types.

4. Click Make Report.

5. In the Report Selection dialog box, select the report that you want to
view.

6. In the Report Selection dialog box, click View. 

The location sweep report opens in Tekla PowerFab Report Viewer.

Inventory 563 View inventory details



Delete a location sweep
1. Select an existing location sweep in the Inventory Location Sweeps

dialog box.

2. Click Delete Location Sweep.

3. To permanently delete the location sweep, click Yes in the confirmation
dialog box.

Cancel remaining items from a location sweep
1. Select an existing location sweep in the Inventory Location Sweeps

dialog box.

2. Click Cancel Remaining.

3. To cancel the remaining items, click Yes in the confirmation dialog box.

Complete the location sweep and move remaining items
1. Select an existing location sweep in the Inventory Location Sweeps

dialog box.

2. Click Complete - Move Remaining.

3. To complete the location sweep and move the remaining items, click Yes
in the confirmation dialog box.

View, print or export reports of an existing location sweep
1. Select an existing location sweep in the Inventory Location Sweeps

dialog box.

2. Click Reports - Selected.

3. In the Report Selection dialog box, select the report that you want to
view, print, or export.

4. According to your needs, do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.
Print the report a. In the Report Selection dialog

box, change the number of the
printed copies by clicking the +
and - buttons.

b. Click Print.

c. In the Select Printer dialog box,
click a printer to select it.
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To Do this
d. Click OK.

Export the report a. In the Report Selection dialog
box, click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email checkbox.

g. To open the file after exporting it,
select the Open Exported
Document checkbox.

h. In the Report Selection dialog
box, click Export.

The location sweep report is saved to
the selected location.

View the value of inventory materials
Use the Valuation command to view the value of materials in inventory. You
can view the value either by date and time, by date, or by archive.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Valuation and one of the following options:

• Valuation by Date/Time: shows the current value of materials in stock
or on order, or the value of materials on a specific date and time.

• Valuation by Date: shows the value of material on a specific date.

• Valuation from Archive: shows the valuation of materials in an
archive file.

According to your needs, see one of the following sets of instructions.
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View the current material value in inventory or the material value on a
specific date and time
1. On the menu, select Valuation --> Valuation by Date/Time .

2. In the Archive Date/Time dialog box, do one of the following:

• To view the material values on a specific date and time, select the date
and time in the appropriate lists, and click OK.

• To view the current material values, click Use Current Inventory.

3. To only include specific types of items in the valuation report, in the
Inventory Report Filters dialog box, select a filter type in the Type list,
and click Select.

4. click the arrow buttons to move the item types that you want to include to
the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view, print, or export.

8. According to your needs, do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.

The Tekla PowerFab Report
Viewer opens.

Print the report a. In the Report Selection dialog
box, change the number of the
printed copies by clicking the +
and - buttons.

b. Click Print.

c. In the Select Printer dialog box,
click a printer to select it.

d. Click OK.
Export the report a. In the Report Selection dialog

box, click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.
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To Do this
e. Modify the file name according to

your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email checkbox.

g. To open the file after exporting it,
select the Open Exported
Document checkbox.

h. In the Report Selection dialog
box, click Export.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

View the material value on a specific date
1. On the menu, select Valuation --> Valuation by Date . 

The Inventory Valuation dialog box opens, showing the valuation of
material in stock and on order on the current date.

2. In the Date list, select the date whose inventory valuation you want to
view.

3. Click OK. 

The valuation on the bottom of the dialog box updates.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

View the value from an archive file
1. On the menu, select Valuation --> Valuation from Archive .

2. In the Open dialog box, browse to find and click to select the archive file
that you want to use.

3. Click Open.

4. In the Select dialog box, select if you want to view inventory reports or
inventory location reports.

5. In the Report Selection dialog box, select the report that you want to
view, print, or export.
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6. According to your needs, do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.

The Tekla PowerFab Report
Viewer opens.

Print the report a. In the Report Selection dialog
box, change the number of the
printed copies by clicking the +
and - buttons.

b. Click Print.

c. In the Select Printer dialog box,
click a printer to select it.

d. Click OK.
Export the report a. In the Report Selection dialog

box, click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email checkbox.

g. To open the file after exporting it,
select the Open Exported
Document checkbox.

h. In the Report Selection dialog
box, click Export.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.
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View the transaction history in the Inventory module
You can view all transactions made in the Inventory dialog box using the
Transaction History dialog box. You can also view further transaction details
and item history, and view or print different transaction history reports.

View the transaction history of an item
1. In either the Inventory or Inventory History dialog box, click the

Inventory ribbon tab.

2. On the menu, select Transaction History. 

The Transaction History dialog box opens with the Transaction List tab
open.

3. To filter the transactions shown in the list:

a. In the Filters section of the Transaction History dialog box, click Edit
next to a filter type. 

The available filter types are the transaction date, the user that made
the transaction, the transaction type, and the operation type.

You can also click Find to search for the right user, transaction type,
or operation type.

b. Do one of the following: 

• For transaction date, enter the start and end dates to define a
range within which the transactions have taken place.

• For user, transaction type, and operation type, use the arrow
buttons to move the desired items to the Included list.

c. Click OK.

4. To view more information about a transaction, do the following:

a. Click to select the transaction in the list on the Transaction List tab.

b. Click the Transaction Details tab to view the details of the selected
transaction.

c. Click the Item History tab to view the item history of the selected
transaction.

Find a transaction by transaction number
1. On the Transaction List tab, click Find Transaction #.

2. Enter the transaction number in the field.
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3. Click OK.

The transaction with the selected transaction number is selected on the
Transaction List tab.

Create transaction history reports
1. Click the Transaction History ribbon tab.

2. On the menu, select Reports.

3. To only include specific items in the transaction history report, select a
filter type in the Type list, and click Select.

4. Do one of the following:

• For dates, select the start and end dates in the calendar to define a
range within which the transactions have taken place.

You can also select the Expression checkbox to create expressions
that allow you to set the base date and the number of days before or
after that date.

• For other filter types, use the arrow buttons to move the desired items
to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view or print.

8. Do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.
Print the report a. In the Report Selection dialog

box, change the number of the
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
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To Do this
Export the report a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email checkbox.

g. To open the file after exporting it,
select the Open Exported
Document checkbox.

h. Click Export.

View all changes in the transaction history
Tekla PowerFab records every change made in the system. This is useful
because you can view all changes made in the transaction history of items in a
purchase order. You can then filter the information to see changes made by a
particular user or on a particular date. If necessary, you can also print the list
of changes.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Click Edit on the right side of the

Date section.

b. Enter the start (Min) and end
(Max) dates.
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To Do this
c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do any of the following: 

To Do this
View the list of changes • Click View.

The report opens in Tekla PowerFab Report
Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.
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View and print TFS reports
Use the TFS - Reports Only command to view and print reports for items that
have been or could be taken from stock. TFS reports show the cut details, but
no items are actually cut or taken from stock when you use the TFS - Reports
Only command.

1. In the lower navigation tree of the Inventory dialog box, select a job
number. 

Only the items within the selected job are displayed in the display area.

2. Click the Inventory ribbon tab.

3. On the menu, select Production Control --> TFS - Reports Only .

4. In the TFS dialog box, click Reports.

5. In the Report Progress dialog box, select the report that you want to view
or print.

6. According to your needs, do any of the following: 

To Do this
View the report • In the Report Selection dialog box, click View
Print the report a. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. In the Select Printer dialog box, click a printer
to select it.

d. Click OK.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Take material from stock and return material to stock (page 549)

Take selected materials from stock (page 551)

View, print, and export inventory reports
You can create different inventory reports, such as subtotal reports, shape
summaries, or receiving tickets.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.
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3. In the Inventory Report Filters dialog box, select either the Inventory
Report or Inventory Location Report option according to your needs.

4. To only include specific items in the report, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, click the arrow buttons to move the items that you
want to include in the report to the Included list.

6. Click OK.

7. If you want to view the inventory situation of a previous date in the
reports, do the following:

a. Click From Archive.

b. Select the archive date and time in the applicable lists.

c. Click OK.

8. To view barcode audit reports in the Report Selection dialog box, select
the Barcode Audit checkbox.

9. Click Make Report.

10. In the Report Selection dialog box, click the report that you want to view,
print, or export.

According to your needs, see one of the following sets of instructions.

View inventory reports
1. In the Report Selection dialog box, click View. 

The Tekla PowerFab Report Viewer dialog box opens, displaying the
selected report.

2. In Tekla PowerFab Report Viewer, do any of the following according to
your needs: 

To Do this
Move between pages • Click the arrows at the top of

Tekla PowerFab Report Viewer.
Go to a specific page of the report • Type the page number in the

empty field at the top of Tekla
PowerFab Report Viewer.

Find a text in the report a. Click the binocular icon.

b. In the blank field, type the text
that you want to find.

c. Click Find Next.

Any matching text is highlighted
with a red box.
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To Do this
Zoom in or out • Click the magnifying glass icon and

select the zoom value in the list.

Print inventory reports
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer to select it.

4. Click OK.

Export inventory reports
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

7. To open the file after exporting it, select the Open Exported Document
checkbox.

8. In the Report Selection dialog box, click Export.

The report is saved to the selected location.

See also

Customize reports (page 268)

7.7 Import and export inventory information
You can import inventory information or a cut list to Tekla PowerFab, or export
inventory information from Tekla PowerFab to KSTK, ProNest, Timberline, and
XML format.

Importing information can be useful when inventory has previously been
maintained in another system, and exported in a common file format. The
import will only add material to inventory it does not compare and reconcile
the existing inventory.
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For more information, see the following links:

Export inventory information to the KSTK format (page 576)

Export inventory transactions to Timberline (page 576)

Export inventory to SigmaNest (page 577)

Export inventory information to XML (page 577)

Synchronize inventory information with ProNest (page 578)

Import inventory information from an HTML file (page 578)

Import ProNest cut lists to Tekla PowerFab (page 578)

Archive jobs (page 579)

Export inventory information to the KSTK format
Use the Export to KSTK command to save inventory information in the KSTK
format.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export to KSTK.

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save. 

A message opens, showing where the inventory information was saved.

6. Click OK to close the message.

Export inventory transactions to Timberline
You can export inventory information to the Timberline accounting software
by using the Export Inventory Transactions to Timberline command.

NOTE Timberline must be open to receive the inventory information.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export Inventory Transactions to Timberline. 

The Export Inventory Transactions to Timberline dialog box opens.

3. In the Export From Transaction # and To (leave blank for all) fields,
enter the numbers of the first and last transactions that you want to
export.
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4. In the Job # Export Option list, select how you want the job number to be
exported.

5. Enter the general ledger code.

6. To not export material that has been received directly to inventory history,
select the Ignore material received directly to inventory history
checkbox.

7. Click Export Transactions.

The selected transactions are exported to Timberline.

Export inventory to SigmaNest
We recommend that you regularly export the Tekla PowerFab inventory to
SigmaNest to keep the Tekla PowerFab inventory and SigmaNest in sync.

Before you can export inventory information to SigmaNest, you need to set up
Tekla PowerFab to work with SigmaNest. For more information, see SigmaNest
Integration.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export --> Export to SigmaNest. 

NOTE If you cannot see the Export to SigmaNest option, ensure that
you have enabled SigmaNest:

a. On the Maintenance menu, select Integration Settings -->
SigmaNest.

b. In the SigmaNest Settings dialog box, ensure that the
Enable SigmaNest for Plate Nesting checkbox is selected.

The inventory information in Tekla PowerFab is exported to SigmaNest.
You can view the process in the Status dialog box.

3. When the synchronization process is completed, click OK to close the
Status dialog box.

Export inventory information to XML
Use the Export to XML command to save inventory information in an XML file.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export --> Export to XML .

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.
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4. If necessary, change the file name.

5. Click Save. 

The Status dialog box opens, showing the status of the export process.

6. When the export is completed, click OK to close the Status dialog box.

The file is saved to the location you selected.

Synchronize inventory information with ProNest
Use the Sync with ProNest command to synchronize Tekla PowerFab
inventory information with ProNest and update the cut lists in ProNest. We
recommend that you synchronize the two software regularly.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Export --> Sync with ProNest . 

The inventory information in Tekla PowerFab is exported to ProNest to
synchronize the two software. You can view the process in the Status
dialog box.

3. When the synchronization process is completed, click OK to close the
Status dialog box.

You can now view the inventory information exported from Tekla PowerFab in
ProNest.

Import inventory information from an HTML file
Use the Inventory From HTML command to import inventory information
from an HTML file to Tekla PowerFab.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Import --> Inventory From HTML .

3. In the Open dialog box, browse to find and select the HTML file that you
want to import.

4. Click Open.

The inventory information is imported to Tekla PowerFab.
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Import ProNest cut lists to Tekla PowerFab
You can import cut lists available in the ProNest nesting software to Tekla
PowerFab. By importing cut lists, you receive information on the scrap of a
ProNest nesting process to inventory.

Before sending cut lists to Tekla PowerFab, send the nest to CNC in ProNest.

1. In the Inventory dialog box, click the Inventory ribbon tab.

2. On the menu, select Import --> ProNest Cut List . 

Tekla PowerFab imports the cut lists that are available in ProNest.

3. When the import is completed, click Open Import Log to view, print, or
save the import log.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Once a cut list is imported, it can be cut in Tekla PowerFab. This way, you can
remove the used plate from inventory and add the proper scrap.

See also

Synchronize inventory information with ProNest (page 578)

Import inventory information from Microsoft Excel
You can import material from Microsoft Excel.

The import will only add material to the inventory. We recommend that this
functionality is used to import an initial inventory audit.

1. Go to File --> Import.

2. In the navigation tree on the left, select Inventory --> Excel.

3. To select the file, click the ellipsis button (…) and select the Excel file you
want to import.

4. Click Open.

5. Click Import.

6. Click Yes to confirm.

7. When asked to delete existing inventory, click No. 

The material listed on the Microsoft Excel file is imported into inventory. If
there are any issues with the information in the file, it is displayed in the
import log.

8. Once the import has completed, close the Import dialog box.
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Archive jobs
Use the Archive Jobs command to export jobs from Inventory History and
save them as KSTK or TXT files.

1. In the Inventory History dialog box, click the Inventory History ribbon
tab.

2. On the menu, select Export --> Archive Jobs .

3. In the Select Jobs to Archive dialog box, click the arrow buttons to move
the jobs that you want to archive to the Included list.

4. If you want to delete the jobs from inventory history after archiving them,
select Yes in the Purge Archived Jobs list.

5. Click OK.

6. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

7. If necessary, change the file name.

8. If necessary, select another file format in the Save as type list.

9. Click Save. 

A message opens, showing you the location and the file where the
archived jobs have been saved.

10. Click OK to close the message.

Inventory 580 Import and export inventory information



8 Project Management

The Project Management module brings together all information regarding
the project: the information from the related estimating jobs or combining
jobs, and the materials, hours, weight, sequencing and tracking from the
related production control job. You can bring information from multiple
estimating jobs, combining jobs, and production control jobs to the project
management job. In Project Management, you can add drawings and journal
entries, create transmittals or requests for information, and assign tasks to
Tekla PowerFab users.

NOTE Before you start working in the Project Management module, ensure that
you have adjusted the project management settings according to your needs.
For more information, see Set up the Project Management module
(page 581).

8.1 Set up the Project Management module
Before you start to use the Project Management module, take the time to
customize the properties and available items. Once you have created and
modified all necessary items and settings, working in the Project
Management module is easier and more efficient.

When setting up the Project Management module, you can:

• Customize the display and input fields in the Drawing Log, Transmittals,
RFIs, Journal, and Change Orders dialog boxes.

• Create, modify, and delete the resources that are available in the
production schedule.

• View and filter the production schedule.

• Create, modify, and delete calendars that are available for the project
schedule.

• Modify the project schedule settings.
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• Create templates that you can apply to quickly create a baseline for the
project schedule.

• Define the standard settings used in the Project Management module.

• Create, modify, and delete approval statuses available for drawings.

• Create, modify, and delete common steps that are available for all project
management jobs.

• Delete project management jobs.

• Rename project management jobs.

• Set job groups for project management jobs.

• Create, modify, and delete methods that are available for sending
documents.

• Create, modify, and delete items that are commonly used in transmittals.

• Create, modify, and delete commonly used purposes for transmittals.

• Create, modify, and delete pieces of text that are commonly used in
transmittals.

• Create reports for all or a group of project management jobs.

Many of the settings and selections can be saved by user. This way, each user
can adjust Tekla PowerFab to meet their individual needs and preferences
without changing the default settings.

For more information, see the following links:

Create, modify, and delete schedule calendars (page 595)

Modify the project schedule settings (page 586)

Manage schedule templates (page 587)

Define company standard settings for Project Management (page 582)

Manage approval statuses for drawings (page 800)

Create, modify, and delete common steps for project management jobs
(page 599)

Manage project management jobs (page 600)

Create, modify, and delete methods for sending documents (page 603)

Create, modify, and delete transmittal items (page 604)

Create, modify, and delete transmittal purposes (page 605)

Create, modify, and delete commonly used text items for transmittals
(page 606)

View, print, or export project reports (page 609)
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Define company standard settings for Project Management
For each module, you can define company-level settings that are the default
for all new jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Company Standards. 

The Company Standards dialog box opens.

3. Modify the settings as needed. 

Option Description
Job # Increment Allows you to select the default option

for automatic job numbering. The
options are:

• Increment from Last Job #: When
you create a new job, Tekla
PowerFab uses the next available
job number after the latest job
number created.

• Increment from Largest Job #:
Tekla PowerFab uses the next
available job number after the
largest job number created.

• Don't Increment: Automatic job
numbering is not used.

You can modify the job number when
you create a new job.

Drawing Number Input Type Allows you to select the input format
for drawing numbers.

Drawing File Prefix By default, Tekla PowerFab expects
that the names of drawing files match
the drawing numbers. The Drawing
File Prefix option allows you to
determine the prefix that appears in
the names of all drawing files that are
imported.

Determining a drawing file prefix is
optional. However, the drawing file
prefix can help you to ensure that the
correct files are imported from the
selected folder.

For example, drawing files might
consist of the job number followed by
a dash and the drawing number. In
this case, drawing 100 could be
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Option Description
named C12345-100.pdf. In
consequence, the drawing file prefix
would be C12345-.

If the drawing file prefix varies, you
can use an asterisk (*) as a wildcard
character. For example, if the prefix of
some drawing files that you want to
import was not C12345, you could set
the drawing file prefix to *-.

Type the acceptable prefix in the
Drawing File Prefix field.

Drawing File Suffix By default, Tekla PowerFab expects
that the names of drawing files match
the drawing numbers. The Drawing
File Suffix option allows you to
determine the suffix that appears in
the names of all drawing files that are
imported.

Determining a drawing file suffix is
optional. However, the drawing file
suffix can help you to ensure that the
correct files are imported from the
selected folder.

For example, drawing files might
include a revision number after the
drawing number. In this case, the file
name of the first revision of drawing
100 could be C12345-100-r1.pdf.
In consequence, the drawing file
suffix would be -r1.

If the drawing file suffix varies, you
can use an asterisk (*) as a wildcard
character. For example, if some
drawing files had different revision
numbers, you could set the drawing
file suffix to -r*.

Type the acceptable suffix in the
Drawing File Suffix field.
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Option Description
Transmittal Recipients Available Allows you to select the companies

that can be selected as transmittal
recipients.

Click the arrow on the right side of the
Transmittal Recipients Available list
and select an option.

Transmittal Recipient Selection Allows you to select which
information is displayed for the
companies in the Recipient list.

Click the arrow on the right side of the
Transmittal Recipient Selection list
and select either the firm code or the
firm name.

Keep Job Selection Screen Open When selected, the Select <Module>
Job dialog box stays open after a job
has been opened.

Otherwise, the dialog box closes
when you open a job.

Update Production Control
Approval Status

When selected, the approval statuses
of shop drawings that are used in
Production Control are automatically
updated.

Resources - Use Period Ending Date When selected, the date that is shown
in production schedules for resources
is the last date of a period. This
option only applies when the scale of
the schedule is set to week or month.
For example, February 2019 would be
shown as 2/28/2019 in the mm/dd/
yyyy format.

When cleared, the date that is shown
is the first date of a period. In this
case, February 2019 would be shown
as 2/1/2019 in the mm/dd/yyyy
format.

For more information, see Modify
resource capacity (page 889).

Automatically Create Document
Index Directories

When selected, the Document Index
directories defined in Maintenance --
> Document Index --> Standard
Categories are created automatically
under the base document index
directory when a job is created. See
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Option Description
Set the standard categories for
attached documents (page 150).

Job # Regular Expression Allows the use of regular expressions
to enforce a desired format for the
job numbers.

For more details on regular
expressions, click Regular Expression
Help.

ERP Job # Regular Expression Allows the use of regular expressions
to enforce a desired format for the
job numbers.

Allows the use of regular expressions
to create the requisition number.

For more details on regular
expressions, click Regular Expression
Help.

4. Click Save. 

Saving the settings closes the Company Standards dialog box.

When you click Save, the changes you made are saved.

Set up schedules
Before creating project and production schedules, we recommend that you
adjust the schedule settings according to your needs. You can also create the
necessary schedule calendars and schedule templates, and modify or delete
the existing ones.

For more information, see the following links:

Modify the project schedule settings (page 586)

Create, modify, and delete schedule calendars (page 595)

Manage schedule templates (page 587)

Modify the project schedule settings
In the Schedule Settings dialog box, you can set the default settings for
project schedules. You can define settings for accessing and remaining in the
edit mode, and set the default project breakdown levels and fields.

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Schedule Settings .
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3. On the Edit Mode tab of the Schedule Settings dialog box, adjust the
following settings: 

Option Description
Edit Mode
Timeout

The number of seconds that a user can be in the edit
mode without making changes before the edit mode
times out.

The edit mode ensures that Tekla PowerFab users do not
make conflicting changes if they work on the project
schedule simultaneously.

Type the desired number of seconds in the Edit Mode
Timeout field.

Auto-Acquire
Edit Mode

When selected, Tekla PowerFab no longer asks you if you
want to access the edit mode when making changes. This
means that all changes to the project schedule are made
without confirmation, provided that no other Tekla
PowerFab users are currently in the edit mode and
modifying the same project schedule.

4. Click the Project Breakdown tab to open it.

5. To define the available breakdown levels and fields, click the arrows next
to the breakdown fields, and select suitable options in the list. 

By default, two levels of breakdown items (sequences and lot numbers)
are available. To make more levels available, select options in the Default
Breakdown Field 3, Default Breakdown Field 4, and Default
Breakdown Field 5 lists. If you do not want a breakdown level to be
available, select None.

For example, to enable categories as the breakdown level below lots,
select Category in the Default Breakdown Field 3 list.

6. Click Save.

The changes you made are saved as default settings for all new project
schedules. If necessary, you can adjust the breakdown levels and fields on a
job by job basis.

See also

View and adjust the project schedule (page 702)

Manage schedule templates
In the Schedule Templates dialog box, you can create, modify, and delete
templates that are used as the basis of project schedules with pre-determined
tasks and settings. Creating schedule templates saves time when creating
project schedules, because you can easily apply the template to any project
schedule. When the template is applied to the project schedule, you can
modify the tasks according to your needs.
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To access the Schedule Templates dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Schedule Templates .

Create a schedule template

1. Go to Maintenance --> Project Management --> Schedule Templates. 

The Schedule Templates dialog box opens.

2. Click New Template.

3. In the Template Description field, type a name for the new template.

4. Click Add Template. 

The template is added to the list on the left side of the dialog box.

5. To add tasks to the template, do the following:

a. Click New Task. 
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b. In the Schedule Template Task dialog box, type a description for the
task.

c. Modify the task properties according to your needs: 

Option Description
Parent Task If the task you are creating is a sub-task, for an

existing task, you need to select the main task.

Click the arrow on the right side of Parent Task
field, and select a task in the list. If you are creating
a top-level task, select None.

Note that you cannot modify the task type,
duration, or original estimate time of a main task if
you add a sub-task.

Task Type Specifies the behavior of the task on the Gantt
Chart tab. The available task types are:

• Start/End: an action to be performed over a
period of time. Properties include the start
date, end date, and duration.

Start/end tasks can be directly re-sized an
moved on the Gantt Chart tab.

• Summary: takes the aggregate values from its
sub-tasks. The start date of a summary task is
automatically set to the earliest date of the sub-
tasks. The end date is set to the latest sub-task
end date, and the percent completed is
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Option Description
aggregated based on the status summary
method.

Summary tasks cannot be re-sized on the Gantt
Chart tab directly. However, the sub-tasks can
be re-sized and moved, and the summary main
task will re-sized and moved accordingly.

• Milestone: an event in the schedule. For
example, a project kickoff meeting can be a
milestone task. The end date and the start date
are always the same, and the duration is set to
one day.

Apply Breakdown Links When selected, the links set in the project schedule
are added between sub-tasks. For example, any
links set between sequences 1, 2, and 3 would be
added.

Duration The expected number of working days to complete
a task.

The duration can only be adjusted if the task type
is set to Start/End.

Type the number of days in the Duration field.
Original Estimate The time originally estimated for the entire main

task or a sub-task. The hours will automatically be
distributed among the sub-tasks on the Gantt
chart.

Type the time in hours in the Original Estimate
field.

Status Link The information that affects the status of the task
when the project schedule is updated. The
available options are:

• Drawings Approved: the number of drawings
with the Approved status.

• Material Purchased: the production material
that is linked to material that is either in stock
or on order.

• Material Received: the production material
that is linked to material that is in stock.

• TFS: the production material that has been cut.

• Production Completed: the production
material that has been assigned a route and
has completed all stations in that route.
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Option Description
• Production Progress: the production material

that has been assigned a route and has
completed some stations in that route.

• Station Progress: the production material that
has been assigned a route that includes the
selected station and has completed that
station.

• Shipping Destination Progress: the
production material that has been assigned a
shipping route that includes the selected
destination and has completed that destination.

• Shipping Completed: the production material
that has completed all assigned shipping
destinations.

Status Summary
Method

The method that determines how the percentage
completed of a main task will be calculated from
the sub-tasks. Each option specifies the weight that
is given to each sub-task in the calculation. The
available options are:

• No Factor: no weight is given to the individual
sub-tasks. The percentage completed of the
main task is an average of the sub-tasks.

• By Quantity: the percentage completed is
weighed by the quantity of each sub-task.

• By Weight: the percentage completed is
weighed by the weight of each sub-task.

• By Duration: the percentage completed is
weighed by the duration of each sub-task.

Resource An object with a time-based capacity to be added
on a production schedule, and the resource by
which station work will be executed.

Linking a task from the project schedule to a
resource connects the project and production
schedules.

Click the arrow on the right side of Resource list,
and select a resource in the list.

d. Click Add.

e. Select the new task in the navigation tree.

f. In the Link Tasks section of the dialog box, define dependencies
between two tasks. 
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By creating links, you can make the schedule cascade from one task
to another.

NOTE • A task cannot link to itself.

• A link cannot be created between a task and one of its
sub-tasks.

• Duplicate links are not allowed. There can be only one link
between a pair of tasks.

• Link cycles are not allowed. For example, if a link is
created from task 1 to task 2, a link cannot be created
from task 2 to task 1.

• When you use links, and the duration of an item changes,
the positions of all linked items also changes. Do not link
items that need to remain static, or are independent from
other items in the schedule.

Do any of the following:

To Do this
Add a link that ends with
the current given task

Note that if a previous snapshot is displayed
instead of the current project schedule
information, you cannot add a predecessor link.

1. Click New Predecessor Link.

2. Click the arrow on the right side of Link From
list, and in the list, select the starting task of
the link.

3. Click the arrow on the right side of upper
Position field, and in the list, select if the link
originates from the start or end of the starting
task.

4. Click the arrow on the right side of lower
Position field, and in the list, select if the link
ends at the start or finish of the second task.

5. In the Minimum Interval field, type the
minimum number of working days between
the two tasks.

The minimum interval is enforced in the Gantt
chart. The later task cannot be moved earlier
in the Gantt chart than the value in the
Minimum Interval field determines.

6. Click Add.
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To Do this
7. In the confirmation dialog box, click Yes.

For example, to define that shipping must start
when the fabrication is finished, select Shipping
and set the link a follows:

• Link From: Fabrication

• Upper Position: Finish

• Lower Position: Start

• Minimum Interval: 0 days
Add a link that begins
with the current task

Note that if a previous snapshot is displayed
instead of the current project schedule
information, you cannot add a successor link.

1. Click New Successor Link.

2. Click the arrow on the right side of the upper
Position field, and in the list, select if the link
originates from the start or end of the starting
task.

3. Click the arrow on the right side of the Link To
field, and in the list, select the task that is the
ending point of the link.

4. Click the arrow on the right side of the lower
Position field, and in the list, select if the link
ends at the start or finish of the second task.

5. In the Minimum Interval field, type the
minimum number of working days between
the two tasks.

The minimum interval is enforced in the Gantt
chart. The later task cannot be moved earlier
in the Gantt chart than the value in the
Minimum Interval field determines.

6. Click Add.

7. In the confirmation dialog box, click Yes.

For example, to define that shipping must start
when the fabrication is finished, select Fabrication
and set the link a follows:

• Upper Position: Finish

• Link To: Shipping

• Lower Position: Start

• Minimum Interval: 0 days
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To Do this
View and modify link
properties

1. Click Link Properties.

2. Modify the starting task, ending task, the task
positions, and interval according to your
needs.

3. Click Save to update the link properties.
Delete a link 1. Click a link in the list to select it.

2. Click Delete Link.

3. In the confirmation dialog box, click Yes to
permanently delete the links.

g. To save the links, click Save.

h. To close the Schedule Template Task dialog box, click the Close
button (X) in the upper-right corner.

Repeat steps a to i for all tasks that you want to add to the template.

6. In the Schedule Templates dialog box, click Save Template.

Modify a schedule template

1. In the list on the left of the Schedule Templates dialog box, select the
template that you want to modify.

2. Do any of the following: 

To Do this
Add a task to the
schedule template

See Create a schedule template.

Modify an existing task a. In the Template Tasks list, select the task that
you want to modify.

b. Click Properties.

c. In the Schedule Template Task, modify the
task description, properties, and links
according to your needs.

For more information on task properties and
links, see Create a schedule template.

d. Click Save to save the changes.
Move a task earlier or
later in the schedule
template

a. In the Template Tasks list, select the task that
you want to move earlier or later in the
schedule template.

b. Click the Move Up and Move Down to change
the location of the task.
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To Do this
Delete a task from the
schedule template

Note that deleting a task from the schedule
template is permanent and cannot be undone.

a. In the Template Tasks list, select the task that
you want to delete.

b. Click Delete Task.

c. To permanently delete the task, click Yes in the
confirmation dialog box.

3. Click Save Template to save the changes.

Delete a schedule template

Note that deleting a schedule template is permanent and cannot be undone.

1. In the list on the left of the Schedule Templates dialog box, select the
template that you want to delete.

2. Click Delete Template.

3. To permanently delete the schedule template, click Yes in the
confirmation dialog box.

Create, modify, and delete schedule calendars
Schedule calendars determine the working days in a project schedule. By
default, Tekla PowerFab uses a schedule calendar with a five-day working week
from Monday to Friday, excluding national holidays. If necessary, in the
Schedule Calendars dialog box, you can create additional schedule calendars.
For example, this can be useful if your shop has a seven-day working week.
You can also modify or delete the existing schedule calendars, and select
which schedule calendar is used as the default option.

To access the Schedule Calendars dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Schedule Calendars .

You can view the existing schedule calendars on the left side of the Schedule
Calendars dialog box.

Create a schedule calendar

1. Click New.

2. In the Calendar Description field, type a name for the new calendar.

3. Select the checkbox next to each weekday that you want to mark as a
working day. 

Note that in the calendar at the bottom of the dialog box, the non-working
days are bolded.
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4. Click Add.

The new schedule calendar is added to the list on the left side of the dialog
box. If necessary, you can now add working day exceptions to the schedule
calendar.

Add working day exceptions

If necessary, you can add working day exceptions to a schedule calendar. For
example, you can set national holidays as non-working days, or set a particular
Saturday or Sunday as a working day.

1. In the list on the left side of the Schedule Calendars dialog box, click the
calendar to which you want to add working day exceptions.

2. At the bottom of the dialog box, click Working Day Exceptions.

3. In the Schedule Calendar - Working Day Exceptions dialog box, click
New.

4. Type a description for the working day exception.

5. If you want the date to be a working day, select the Is Working Day
checkbox.

6. Select the exception date in the calendar.

7. Click Add.

The working day exception is added to the list on the left side of the Schedule
Calendar - Working Day Exceptions dialog box.

If necessary, you can select a working day exception in the list, and then either:

• Modify the working day exception by changing its properties and clicking
Edit.

• Delete the working day exception by clicking Delete, and then Yes to
confirm.

Set a schedule calendar as the default option

The current default schedule calendar is marked with an asterisk (*) in the list
on the left side of the Schedule Calendars dialog box. If you want to use
another calendar as the default option, do the following:

1. In the list on the left side of the Schedule Calendars dialog box, click the
calendar that you want to set as the default option.

2. Click Set as Default.

3. In the confirmation dialog box, click Yes to set the selected calendar as the
default option in all new project schedules.

The selected calendar is set as the default option and marked with an asterisk
(*).
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Modify a schedule calendar

1. In the list on the left side of the Schedule Calendars dialog box, click the
calendar that you want to modify.

2. In the Calendar Description field, modify the name of the calendar.

3. Select the checkbox next to each weekday that you want to mark as a
working day.

4. Click Edit to save the changes.

Delete a schedule calendar

Deleting a schedule calendar is permanent and cannot be undone. Note that
the default calendar cannot be deleted.

1. In the list on the left side of the Schedule Calendars dialog box, click the
calendar that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
calendar.

Manage approval status for drawings
You can create, modify, or delete approval statuses for drawings in the
Approval Status dialog box.

To access the Approval Status dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Approval Status
Maintenance.

You can also access Approval Status from Maintenance --> Production
Control.

The Approval Status dialog box opens. You can view all existing approval
statuses.
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If you create new approval statuses, the only available purpose options
are Approved and Hold.

Approved means that drawings are ready for fabrication. The Approved
purpose is used as the status link in the project schedule.

Hold means that the drawings are not ready for fabrication. Items with
the Hold option can move through fabrication processes, but they will be
highlighted in red, and warning pop ups will appear during processing
updates. Any loads that contain items with the Hold purpose option
cannot be shipped.

Create an approval status option
1. Click New.

2. In the Approval Status field, type an abbreviation for the new approval
status.

3. In the Description field, type a description for the new approval status.

4. If you wish, in the Purpose list, select if items with the status option are
approved or on hold.

5. Click Add.

Modify an existing approval status
1. In the list, click the approval status that you want to modify.

2. Modify the approval status abbreviation, description, and purpose
according to your needs.
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3. Click Edit to save the changes.

Delete an approval status
Deleting an approval status is permanent and cannot be undone.

1. In the list, click the approval status that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
approval status.

Create, modify, and delete common steps for project
management jobs
In the Check List Item Maintenance dialog box, you can create, modify, and
delete check list items. Check list items are steps that are commonly
performed in project management jobs, such as receiving a signed contract
from the client. The check list items that you create in the Check List Item
Maintenance dialog box are automatically available for all future project
management jobs. However, you need to add them manually to existing
project management jobs.

To access the Check List Item Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Check List Item
Maintenance .

The check list items created in the Check List Item Maintenance dialog box
serve as reminders in each project management job. Tekla PowerFab also
records the date when each of these tasks are completed and the user who
performs the tasks.

Create a check list item
1. Click New.

2. In the Description field, type a description for the item. 

For example, Get signed contract from the client.

3. Click Add.

The check list item is now available for all project management jobs, and you
can be assigned it to particular users' task lists within the projects.

To add the new check list item to an existing project management job, you
need to do the following:

1. Open the project management job.
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2. Click the Project Management ribbon tab.

3. On the menu, select Check List.

4. In the Check List dialog box, click the Check List ribbon tab.

5. On the menu, select Add Additional Check List Items.

6. In the Add Check List Items dialog box, click the arrow buttons to move
the items that you want to add to the Included list.

7. Click Add.

8. In the Check List dialog box, click Save.

Modify a check list item
1. In the list, select the check list item that you want to modify.

2. Modify the item description according to your needs.

3. Click Edit to save the changes.

Change the position of a check list item
1. In the list, select the check list item that you want to move up or down in

the list of tasks.

2. Click the Position (+) and Position (-) buttons to move the item to the
desired position.

Delete a check list item
Note that deleting a check list item is permanent and cannot be undone.

1. In the list, select the check list item that you want to delete.

2. Click Delete.

3. To permanently delete the check list item, click Yes in the confirmation
dialog box.

Manage project management jobs
You can manage existing jobs in many ways in the Job Maintenance dialog
box. The options available depend on the module. You can, for instance, copy
and delete jobs.

To access the Job Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.
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3. Select the job that you want to modify. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

4. At the bottom of the dialog box, click any of the available buttons. 

See also

Delete project management jobs (page 601)

Rename a project management job (page 601)

Set job groups for project management jobs (page 602)

Set job statuses for project management jobs (page 603)

Delete project management jobs
You can delete any unnecessary jobs. Note that the jobs are deleted
permanently.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to delete. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Delete.

4. To delete the job, click Yes in the Confirm dialog box.

The job is permanently deleted.

See also

Manage project management jobs (page 600)

Rename a project management job
You can rename an existing project management job.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Project Maintenance dialog box opens.

2. Select the job that you want to rename.

3. At the bottom of the dialog box, click Rename. 

The Enter Value dialog box opens.

4. Type a new name for the job.
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5. Click OK.

The job is renamed.

Set job groups for project management jobs
Job groups allow you to identify and classify jobs that are similar. This makes
filtering and reporting easier when you have a long list of jobs.

You can, for example, record the client and industry sector, but you can create
your own system to best suit your needs.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the jobs for which you want to create a job group. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Set Group Name.

4. Select if you want to add or update the primary group or the secondary
group name.

5. Type a name for the group.

You can find the job groups in the navigation tree in the module and use them
for filtering jobs.

See also

Manage project management jobs (page 600)

Edit job groups for project management jobs
You can change the group name or remove a job from a group.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to change or remove from the group.

3. At the bottom of the dialog box, click Set Group Name.

4. Select if you want to update or remove the primary group or the
secondary group name. The Enter Value dialog box opens.

5. Do either of the following:

• To change the group name, type in the new name.

• To remove the job from the group, remove the name from the dialog
box.

6. Click OK.
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Set job statuses for project management jobs
Job status determines if a job is still in progress (Open) or finished (Closed). By
setting job statuses for jobs, you can filter and view only the current jobs in the
job selection dialog box in Tekla PowerFab and in Tekla PowerFab Go.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job whose status you want to change. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. Select the desired job status in the list.

4. Click OK.

You can filter jobs by selecting status in the module navigation tree.

See also

Job status maintenance (page 219)

Manage project management jobs (page 600)

Set up transmittals
Before you start creating transmittals, we recommend that you create the
necessary methods for sending documents, transmittal items, transmittal
purposes, and commonly used text for transmittals.

For more information, see the following links:

Create, modify, and delete methods for sending documents (page 603)

Create, modify, and delete transmittal items (page 604)

Create, modify, and delete transmittal purposes (page 605)

Create, modify, and delete commonly used text items for transmittals
(page 606)

Create, modify, and delete methods for sending documents
In the Sent Via Maintenance dialog box, you can create, modify, and delete
methods for sending documents. Sending methods allow you to mark how a
document was sent to the recipient when you are creating transmittals. For
example, documents can be sent via email, fax, or mail. You can also set the
default method for sending documents.

To access the Sent Via Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.
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2. On the menu, select Project Management --> Sent Via Maintenance .

Create a sending method

1. Click New.

2. Type a description for the sending method.

3. Click Add.

Modify a sending method

1. In the list, select the sending method that you want to modify.

2. Modify the description according to your needs.

3. Click Edit to save the changes.

Set the default sending method

The current default sending method is marked with an asterisk (*). Note that
you can also select another sending method for each document that you send.

1. In the list, select the sending method that you want to set as the default
option.

2. Click Set as Default.

3. To confirm using the sending method as the default option, click Yes in
the confirmation dialog box.

The selected sending method is set as the default option and marked with an
asterisk (*).

Delete a sending method

Note that deleting a sending method is permanent and cannot be undone.

1. In the list, select the sending method that you want to delete.

2. Click Delete.

3. To permanently delete the sending method, click Yes in the confirmation
dialog box.

Create, modify, and delete transmittal items
In the Transmittal Item Maintenance dialog box, you can create, modify, and
delete commonly used items that are sent with a transmittal. These items also
appear in the transmittal document. Creating transmittal items saves time,
because you do not have to type each item manually when you create a
transmittal in the Transmittals dialog box. Instead, you can select existing
transmittal items in the Items list.

To access the Transmittal Item Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.
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2. On the menu, select Project Management --> Transmittal Item
Maintenance .

Create a transmittal item

1. Click New.

2. Type a description for the transmittal item.

3. Click Add.

Modify a transmittal item

1. In the list, select the transmittal item that you want to modify.

2. Modify the item description.

3. Click Edit to save the changes.

Delete a transmittal item

Note that deleting a transmittal item is permanent and cannot be undone.

1. In the list, select the transmittal item that you want to delete.

2. Click Delete.

3. To permanently delete the transmittal item, click Yes in the confirmation
dialog box.

Create, modify, and delete transmittal purposes
In the Transmittal Purpose Maintenance dialog box, you can create, modify,
and delete commonly used purposes for sending transmittals. The purpose of
the transmittal appears on the transmittal document and informs the recipient
why the document has been sent. Creating transmittal purposes saves time,
because you do not have to type the purposes manually each time that you
create a transmittal in the Transmittals dialog box. Instead, you can select
existing transmittal purposes in the Purpose list.

To access the Transmittal Purpose Maintenance dialog box, do the
following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Transmittal Purpose
Maintenance .

Create a transmittal purpose

1. Click New.

2. Type a description fot the transmittal purpose.

3. Click Add.
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Modify a transmittal purpose

1. In the list, select the transmittal purpose that you want to modify.

2. Modify the purpose description according to your needs.

3. Click Edit to save the changes.

Delete a transmittal purpose

Note that deleting a transmittal purpose is permanent and cannot be undone.

1. In the list, select the transmittal purpose that you want to delete.

2. Click Delete.

3. To permanently delete the transmittal purpose, click Yes in the
confirmation dialog box.

Create, modify, and delete commonly used text items for transmittals
In the Transmittal Standard Text Maintenance dialog box, you can create,
modify, and delete commonly used text items that can be added to transmittal
documents. For example, a text item can contain information on how quickly
the recipient should react to the transmittal. Creating text items saves time,
because you do not need to type the text each time you create a similar
transmittal in the Transmittals dialog box. Instead, you can select an
applicable text item in the Standard Text list.

Note that you can only add one text item per transmittal.

To access the Transmittal Standard Text Maintenance dialog box, do the
following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Transmittal Standard
Text Maintenance .

See any of the following sets of instructions according to your needs.

Create a text item

1. Click New.

2. In the Description field, type a name for the text item. 

This name will appear in the Standard Text list of the Transmittals dialog
box.

3. In the Standard Text field, type the text that you want to include in the
text item.

4. Click Add.

Modify a text item

1. In the list, select the text item that you want to modify.
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2. Modify the description and text according to your needs.

3. Click Edit to save the changes.

Delete a text item

Note that deleting a standard text item is permanent and cannot be undone.

1. In the list, select the text item that you want to delete.

2. Click Delete.

3. To permanently delete the text item, click Yes in the confirmation dialog
box.

Manage default drawing logs
Drawing logs help to manage and control the drawings in the project. You can
create your own default drawing logs for different drawing types, such as
general arrangement drawings or part drawings. You can also modify existing
drawing logs, or delete unnecessary drawing logs from Tekla PowerFab.

NOTE The default drawing logs that you set up are available for all new project
management jobs.

If you need to adjust the drawing logs used in an existing project management
job, see and Manage drawing logs for a job (page 623).

To start managing drawing logs:

1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Global Drawing Log
Maintenance.

The Drawing Log Maintenance dialog box opens.
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Add a drawing log
1. At the bottom of the Drawing Log Maintenance dialog box, click New.

2. Add properties in the dialog box. 

Option Description
Drawing Type Type the drawing type.
Drawing Log Name Type a name for the drawing log.
PDC Link Select the field in Production Control

to which the drawings are connected.

Note that the PDC Link setting only
applies to drawing log types with
assemblies or materials that have
counterparts in Production Control.

Subdirectory Path Type the path to the subfolder under
the drawing default folder where the
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Option Description
drawings in that drawing log are
stored.

For example, type Detail\Erection
drawings.

The default folder for storing
drawings is set in File --> Default
Directories.

Drawing Log Mapping (one per line) Type which drawing types to direct to
the selected drawing log.

Tekla PowerFab determines the
drawing log where imported drawings
are stored based on the drawing
types assigned to the drawings in the
XML file created with Tekla PowerFab
Plugin for Tekla Structures, or with the
Data Transfer tool in SDS/2.

By default, the drawing types in Tekla
PowerFab match the drawing types in
Tekla Structures.

Note that you need to type each
drawing type on a separate line.

3. Click Add.

Modify a drawing log
1. In the Drawing Log Maintenance dialog box, select the drawing log that

you want to modify.

2. Change the drawing log settings according to your needs.

3. Click Save.

Delete a drawing log
1. In the Drawing Log Maintenance dialog box, select the drawing log that

you want to delete.

2. Click Delete.

3. To permanently delete the drawing log, click Yes.

See also

Manage drawings (page 621)
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View, print, or export project reports
You can create reports that contain information from a group of project
management jobs by using the Project Reports command. You can either
view or print the reports, or export the reports to another file format.

Create a project report
1. Click the Maintenance ribbon tab.

2. On the menu, select Project Management --> Project Reports .

3. In the Select Project dialog box, click the arrow buttons to move the
projects that you want to include in the report to the Included list.

4. To only include particular types of items in the report, in the Project
Management Report Filters dialog box, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to include to
the Included list.

• Type the maximum and minimum values for the items that you want
to include.

6. Click OK.

7. In the Report On section of the dialog box, select checkboxes on the right
side of the information for which you want to create reports. 

For example, to create a drawing list, select the Drawings checkbox.

8. Click Make Report.

9. In the Report Selection dialog box, select the report that you want to
create.

View the report
In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.
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3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

7. To open the file after exporting it, select the Open Exported Document
checkbox.

8. In the Report Selection dialog box, click Export.

8.2 Open the Project Management module
To start adding and modifying the information in a project, open the Project
Management module.

• At the top of the Tekla PowerFab window, click the Project Management
button. 
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The Select Project Management Job dialog box opens. You can view all
existing jobs

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs checkbox.

Next, you can:

• View, add, and modify task list reminders.

• Create a new project management job.

• Open or modify an existing project management job.

• Attach document to a project management job in Document Index.

• View and modify the project schedule of the selected project management
jobs.

Create a project management job
To create a new job, you need to define a few properties.

1. Open the module. 

The Select <Module> Job dialog box opens.

2. Click Add 
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The Project: [New] dialog box opens.

3. Define the properties of the new job. 

The properties marked with an asterisk (*) are mandatory.

Option Description
Job Number * A unique number for the job.

Note that the job number cannot be modified after
the job has been created.

Job Date The job date is used as the initial start date of the
project in the project schedule.

Tekla PowerFab automatically uses the date when
you create the job, but you can select a different
date in the associated calendar.

For example, you can select the date when your
company received the job, or the shipping date.

Description The description of the job.
Location The town or city where the job takes place.
Customer PO # The purchase order number of the customer

company, or the contract number.
Job Status The job is either still in progress (Open) or it has

been finished (Closed).

You can filter the Select <Module> Job dialog box
by Job Status, so that only open jobs are shown.

ERP Job # The accounting system job number.

Typing the accounting system job number in the
ERP Job # field allows you to link material items

Project Management 613 Open the Project Management module



Option Description
properly when you export information to an
accounting system, such as Trimble Viewpoint.

Job Group Job groups allow you to identify and classify jobs
that are similar. This makes filtering and reporting
easier when you have a long list of jobs.

Either type a job group directly in the blank field, or
click the arrow on the right side of the field to
select an existing job group.

4. If necessary, modify the drawing settings of the new job: 

For information on job-specific settings, see Define drawing settings for a
job (page 621) and Manage drawing logs for a job (page 623).

For information on default settings, see Define company standard settings
for Project Management (page 582).

5. In the Project Contacts section, add all companies related to the new job
and their contact persons. 

For information on project contact settings, see Manage companies in the
project (page 644)

6. To create the job, click Save Project settings (F4).

You can now open the project and start modifying it.

NOTE You can link a project management job to a matching production
control job.

See also

Manage project information (page 619)

Open a project management job (page 616)

Link a production control job to an estimating job and a project management
job (page 844)

Add a project contact
To share project information with the other parties in the project, you need to
add the parties to the project management job.

NOTE It is important that the first contact in the project is the job site contact
or the correct /Ship To/Bill To as this can populate the Sold To/Ship
To information that populates the shipping ticket information for the
job.

1. In the Project Contacts section of the Project dialog box, click Add
Contact. 
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The Contact Properties dialog box opens.

2. Add properties in the dialog box. 

Option Description
Type Select the contact type.
Name If the company is in the Address

Book, select the name.

To add a new company

a. Type the name of the company.
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Option Description
b. Press Enter on the keyboard.

c. To add the contact, click Yes

Note:You need to add the contacts
for the new company manually. To do
so, click Edit on the right side of the
Name field. Include also the shipping
and mailing addresses. For detailed
instructions, see Add contacts to the
address book (page 145) and Add
companies to the address book
(page 143).

Title Type the title or function of your
contact person.

Ship To Address Select the shipping address.
Bill To Address Select the billing address.
Contact Select the contact that you want to

add.

3. Click OK.

See also

Manage companies in the project (page 644)

Find a project management job
You can search to find a specific job.

1. In the Select Project Management Job dialog box, click the Project
Management ribbon tab.

2. Select Find Project or press Ctrl+F. 

The Enter Value dialog box opens.

3. Select the job in the drop-down menu or enter the job number in the
search box.

4. Click OK.

The selected job is highlighted. To open the job, double-click it or click Open.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs checkbox.
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Open a project management job
To open a project management job:

1. At the top of the Tekla PowerFab window, click the Project Management
button.

2. In the Select Project Management Job dialog box, select the job that you
want to open. 

NOTE Jobs whose statuses are set to Closed are not shown by default.
To show closed jobs, select the Show Closed Jobs checkbox.

3. Double-click the job, or click Open.

Project Management 617 Open the Project Management module



The Project Management dialog box opens.

On the Project Settings tab, you can adjust the project details and contacts.

On the Summary tab, you can see an overview of the different areas in the
project.

You can start managing different project areas on either tab.

See also

Manage drawings (page 621)

Manage transmittals (page 646)

Manage requests for information (page 661)

Manage the project journal (page 676)

Manage change orders (page 683)

Manage the project task list (page 693)

Manage the project check list (page 698)

Manage contract and invoicing information (page 751)

View, print, or export the project summary (page 765)
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Manage files for a project management job
Document Index is a place for storing files to be shared among other users.
In Document Index, you can store various kinds of documents for reference,
and modify, delete, open, and email these files.

Note that all project management jobs have their own document references.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

For further information and instructions, see

Document Index (page 149)

8.3 Manage project information
You can add different types of information for projects, including drawings,
transmittals, requests for information (RFIs), journal entries, change orders,
tasks, and check lists. You can also modify the existing project information
according to your needs.

Manage and assign project tasks
In the Task List Reminders dialog box, you can view all existing tasks in the
selected project and assign project tasks to Tekla PowerFab users. You can also
manage the project tasks according to your needs: add new tasks, and modify
or delete project tasks. Check list items can also be moved to the task list and
assigned to users.

To access the Task List Reminders dialog box, do the following:

1. In the lower-left corner of the Select Project Management Job dialog
box, click Task List Reminders.

The Task List Reminders dialog box opens, displaying the existing project
tasks.
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According to your needs, see any of the following sets of instructions.

Create a project task
1. Click New.

2. Click the arrow on the right side of Job Number list and select a project
management job in the list.

3. Click the arrow on the right side of Author list and select the creator of
the project task in the list. 

The list contains all Tekla PowerFab users in your company.

4. Click the arrow on the right side of Assigned To list and select the user to
which you want to assign the task. 

The list contains all Tekla PowerFab users in your company.

When a task has been assigned to a user, the Task List Reminders dialog
box automatically opens when the user signs in to Tekla PowerFab. When
the task is marked as completed, the Task List Reminders dialog box no
longer opens when the user signs in.

5. Click the arrow on the right side of Date Required list, and select the
deadline of the task in the calendar.

6. If necessary, click the arrow on the right side of the Date Completed list,
and select the date when the task was completed. 

Tekla PowerFab records the date and time when each task is completed.

7. Type a description for the task.

8. Click Add.
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Modify a project task
You might need to modify an existing task later. For example, you can assign
the task to a different Tekla PowerFab user, or mark the task as completed.

1. In the list, select the project task that you want to modify.

2. Modify the job number, author, assignee, date required, date completed,
and description according to your needs.

3. Click Save.

Delete a project task
Note that deleting a project task is permanent and cannot be undone.

1. In the list, select the project task that you want to delete.

2. Click Delete.

3. To permanently delete the task, click Yes in the confirmation dialog box.

Manage drawings
You can create customized drawing logs, add drawings, search for and filter
drawings, view or print drawings, and create drawing reports, for example.

Define drawing settings for a job
You can define and modify the drawing settings related to the current project
management job in the Drawing Setup dialog box.

The changes that you make in the Drawing Setup dialog box are only saved
for the current project management job. For setting default properties, see
Define company standard settings for Project Management (page 582) and
Manage default drawing logs (page 607).

1. Open the Project Management module. 

You are either creating a new job or modifying an existing job in the
Project dialog box.

2. Click Drawing Setups. 
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The Drawing Setup dialog box opens.

3. On the Drawing Settings tab, define any of the following settings: 

Option Description
Drawing Number Input Type Allows you to select the input format

for drawing numbers.
Drawing File Prefix/Drawing File
Suffix

By default, Tekla PowerFab expects
that the names of drawing files match
the drawing numbers.

Drawing File Prefix/Suffix allows you
to determine the prefix/suffix that
appears in the names of all drawing
files that are imported.

Determining a Drawing File Prefix/
Suffix is optional. However, it can
help you to ensure that the correct
files are imported from the selected
folder.

Prefix example: Drawing files may
consist of the job number followed by
a dash and the drawing number. In
this case, drawing 100 could be
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Option Description
named C12345-100.pdf. In
consequence, the drawing file prefix
would be C12345-.

Suffix example: Drawing files may
include a revision number after the
drawing number. In this case, the file
name of the first revision of drawing
100 could be C12345-100-r1.pdf. In
consequence, the suffix would be -r1.
Note that the file name extension is
not included in the drawing file suffix.

If the drawing file prefix/suffix varies,
you can use an asterisk (*) as a
wildcard.

Prefix example: If the prefix of some
drawing files that you want to import
was not C12345, you could set the
drawing file prefix to *-.

Suffix example: If some drawing files
had different revision numbers, you
could set the drawing file suffix to -r*.

Update Production Control
Approval Status

When selected, the approval statuses
of shop drawings that are used in
Production Control are automatically
updated.

4. To save the settings and close the dialog box, click OK.

To create and modify job-specific drawing logs, see Manage drawing logs for a
job (page 623).

See also

Create a project management job (page 612)

Manage default drawing logs (page 607)

Manage drawing logs for a job
Drawing logs help to manage and control the drawings in the project. You can
create and manage job-specific logs.

For information on managing default drawing logs applied to all jobs, see
Manage default drawing logs (page 607).

1. Open the Project Management module.

You are either creating a new job or modifying an existing job in the
Project dialog box.

Project Management 623 Manage project information



2. Click Drawing Setups.

The Drawing Setup dialog box opens.

Add a drawing log

1. On the Drawing Logs tab, click New. 

Define the following settings:

Option Description
Drawing Type Type the drawing type.
Drawing Log Name Type a name for the drawing log.
PDC Link Select the field in Production Control

to which the drawings are connected.

Note that the PDC Link setting only
applies to drawing log types with
assemblies or materials that have
counterparts in Production Control.

Subdirectory Path Type the path to the subfolder under
the drawing default folder where the
drawings in that drawing log are
stored.
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Option Description
For example, type Detail\Erection
drawings.

The default folder for storing
drawings is set in File --> Default
Directories.

Drawing Log Mapping (one per line) Type which drawing types to direct to
the selected drawing log.

Tekla PowerFab determines the
drawing log where imported drawings
are stored based on the drawing
types assigned to the drawings in the
XML file created with Tekla PowerFab
Plugin for Tekla Structures, or with the
Data Transfer tool in SDS/2.

By default, the drawing types in Tekla
PowerFab match the drawing types in
Tekla Structures.

Note that you need to type each
drawing type on a separate line.

2. Click Add.

Modify a drawing log

1. On the Drawing Logs tab, select the drawing log that you want to modify.

2. Change the drawing log settings according to your needs.

3. Click Save.

The changes are saved to the current project management job.

Delete a drawing log

1. On the Drawing Logs tab, select the drawing log that you want to delete.

2. Click Delete.

3. To permanently delete the drawing log from the current project
management job, click Yes.

View a drawing log
Drawing logs help to manage and control the drawings in the project..

1. Open the project management job whose drawing log you want to view.
The Project dialog box of the selected job opens.

2. Click Drawing Log. 
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3. In the context menu, select which drawing log you want to open. 

All Drawing Logs opens the drawing log with no filter applied.

The selected drawing log opens.

The Drawing Log ribbon tab appears in the main window.
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See also

Manage drawings (page 621)

Add, modify, and delete drawings (page 628)

Find a drawing (page 627)

Copy drawing files to another location (page 637)

Update the links to a drawing log (page 640)

Find a drawing
Use the Find Drawing command to quickly find the desired drawing.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

NOTE The All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so if you select that option, you
can find any drawing regardless of the drawing log where the
drawing is stored.

3. In the open drawing log, click the Drawing Log ribbon tab.
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4. On the menu, select Find Drawing.

5. In the Enter Value dialog box, click the arrow on the right side of the
Select drawing # field.

6. Start typing the drawing number in the Select drawing # field. 

Tekla PowerFab suggests drawings whose drawing numbers start in the
same way.

7. Press Enter to use the suggested drawing number.

8. Click OK, or press Enter again.

Tekla PowerFab selects the related drawing in the current drawing log.

NOTE

The drawings available to find are restricted by the selected filter.

View a drawing
Use the Drawing Files command to open and view a specific drawing.

NOTE Only drawings that have files attached to them can be viewed.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

3. In the drawing log, select the drawing.

4. Do one of the following:

• Double-click the drawing to open the latest revision.

• Click the Drawing Log ribbon tab, and in the menu, select Drawing
Files.

5. If the file has multiple revisions, in the Files dialog box, click the arrow on
the right side of the Revision list and select the revision that you want to
open. 

If you double-clicked a drawing to open it, the latest revision of the
selected drawing is automatically opened.

6. Click OK to open the drawing.

Add, modify, and delete drawings
Use drawing logs to manage and save the project drawings or PDF files. You
can add, modify, and delete drawings, or view the files attached to the stored
drawings. You can also attach drawings to transmittals and send them to
project parties.

To access drawing logs:

1. On the right side of an open project management job, click Drawing Log.
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2. In the context menu, select the drawing log.

NOTE The All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so if you select that option, you
can find any drawing regardless of the drawing log where the
drawing is stored.

Add a drawing
By following these instructions, you can add one drawing at a time.

To add multiple drawings at one go and to attach files to the drawings while
adding them, see Add a batch drawings with PDF attachments to a drawing log
(page 631) and Add a batch of drawings without PDF attachments to a
drawing log (page 630).

Note that the available input fields in the drawing log depend on the set input
fields. For more information, see Customize input fields (page 253).

1. Click New. 

The drawing number field is automatically populated with the next
available number.

2. Modify the drawing number according to your needs. 

The drawing number can contain a maximum of 25 characters, depending
on the Mark Input Type option that you have selected in the Project
Company Standards dialog box.

3. Enter the drawing properties: 

Option Description
Description A written description of the drawing.

The description can contain a
maximum of 255 characters.

Approval Status The approval status of the drawing.
The available options are set in
Approval Status Maintenance.

Detailed By The person who has detailed the
drawing.

Drawing Date The date when the drawing has been
created.

Date Received The date when the drawing has been
received.

Category A category that can be used for
filtering drawings in the drawing log.
For example, you can create
categories for architectural or
structural drawings. You can then use
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Option Description
the drawing categories to filter which
drawings are visible in the drawing
log.

You can either select a category in the
Category list, or type a new category
in the Category field.

Re-Submit If you are re-submitting a drawing for
approval, select the Re-Submit
checkbox.

If you are submitting the drawing for
the first time, ensure that the Re-
Submit is not selected.

Issue Date The shop issue date of the drawing.
Package # The package number of the drawing.
Orig Rel# The original release number of the

drawing.

4. Click Add.

The correct drawing file is automatically attached to the drawing when it is
added to the default drawing folder in the correct job folder and revision
folder. The default drawing folder is C:\Users\Public\Documents\Tekla
PowerFab\Drawing.

For more information on the folder structure, see Default directories (page 38)
and Install Tekla PowerFab on a client (page 46).

Modify a drawing

1. In the list, select the drawing that you want to modify.

2. On the right side of the dialog box, modify the drawing properties
according to your needs. 

To add revisions, see Add, modify, and delete drawing revisions
(page 634).

3. Click Save.

Delete a drawing

Note that deleting a drawing is permanent and cannot be undone.

1. In the list, select the drawing that you want to delete.

2. Click Delete.

3. To permanently delete the drawing, click Yes in the confirmation dialog
box.
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Add a batch of drawings without PDF attachments to a drawing log
You can add multiple drawings at one go to any one of your drawing logs. Use
the Batch Insert command to add multiple drawings without attachments.

Text here

1. Open project management job and click Drawing Log.

2. In the context menu, select the drawing log. 

The All Drawing Logs option opens a drawing log that lists all drawings
that you have added. If you select the All Drawing Logs option, you can
add drawings to any drawing log.

3. Click the Drawing Log ribbon tab.

4. On the menu, select Batch Insert. 

The Insert Drawings dialog box opens.

5. Go to the Add Range tab.

6. Enter the prefix and suffix of the drawing file names to be added. For
example, if your project name was C23847, the revision number was 1,
and the drawing number was 100, your drawing name could be 
C23487-100-r1.pdf. In this drawing name, the file prefix would be 
C23847-, and the file suffix would be -r1. Note that the file extension is
not part of the file suffix.

7. In the Start Number field, type the number of the first drawing that you
want to add.

8. In the End Number field, type the number of the last drawing that you
want to add.

9. Define any other properties for the drawings.

10. Click Add Drawings.

The drawings are added to the drawing log.

NOTE You need to add any PDF attachments to the drawings manually.

See also

Manage drawings (page 621)

Add a batch drawings with PDF attachments to a drawing log
You can add multiple drawings at one go to any one of your drawing logs. Use
the Batch Insert - From Files command to add multiple drawings with PDF
attachments.

1. Open project management job and click Drawing Log.
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2. In the context menu, select the drawing log. 

The All Drawing Logs option opens a drawing log that lists all drawings
that you have added. If you select the All Drawing Logs option, you can
add drawings to any drawing log.

3. Click the Drawing Log ribbon tab.

4. On the menu, select Batch Insert - From Files. 

The Insert Drawings dialog box opens.

5. Do either of the following:

• To add all drawings with a particular prefix and suffix, go to the Add
Drawings tab.

• To add revisions to particular drawings, go to the Add Revisions tab.

6. On the right side of the Directory field, click ... 

The Browse For Folder dialog box opens.

7. Select the folder from which you want to import the attachments.

8. Click OK.

9. To save copies of the drawings in the \Tekla PowerFab Documents
\Drawing folder, select the Copy Files into Drawing Directory checkbox.

By copying the drawings to the \Tekla PowerFab Documents\Drawing
folder, you can ensure that Tekla PowerFab always finds the attached files,
even if you change their location on your computer.

10. Enter the prefix and suffix of the drawing file names to be added. For
example, if your project name was C23847, the revision number was 1,
and the drawing number was 100, your drawing name could be 
C23487-100-r1.pdf. In this drawing name, the file prefix would be 
C23847-, and the file suffix would be -r1. Note that the file extension is
not part of the file suffix.

11. Define any other properties for the drawings.

12. Click Add From Files.

The drawings and their attachments are added to the drawing log. Notice that
in the File column for each drawing, Yes appears indicating that the drawings
have PDF files attached to them.

Modify multiple drawings
You can modify the properties of multiple drawings at one go with the Global
Edit command.

1. Open project management job and click Drawing Log.
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2. In the context menu, select the drawing log. 

The All Drawing Logs option opens a drawing log that lists all drawings
that you have added. If you select the All Drawing Logs option, you can
add drawings to any drawing log.

3. Click the Drawing Log ribbon tab.

4. On the menu, select Global Edit. 

The Global Edit Filters dialog box opens.

5. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

6. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

7. Click OK. 

To further limit the drawing types that you want to modify, repeat steps 5
to 7 for all necessary filter types.

8. Click OK. 

The Global Edit dialog box opens.

9. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

10. Click Update. 

The Confirm dialog box opens.

11. To confirm changing the properties of multiple items, click Yes.

Modify the selected drawings
You can modify the properties of selected drawings at one go with the Global
Edit - Selected command.

1. Open project management job and click Drawing Log.

2. In the context menu, select the drawing log. 

The All Drawing Logs option opens a drawing log that lists all drawings
that you have added. If you select the All Drawing Logs option, you can
add drawings to any drawing log.

3. In the open drawing log, select the drawings that you want to modify. 
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To select multiple drawings, hold down Ctrl.

To select a range of subsequent drawings, hold down Shift.

4. Click the Drawing Log ribbon tab.

5. On the menu, select Global Edit - Selected 

The Global Edit - Selected dialog box opens.

6. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

7. Click Update.

The modified drawing properties are updated in the drawing log.

Add, modify, and delete drawing revisions
You can add revisions for your drawings in any one of your drawing logs. You
can also modify existing revisions according to your needs, or delete
unnecessary revisions.

Add a single drawing revision

To add multiple drawing revisions, see Add a batch drawings with PDF
attachments to a drawing log (page 631) and Add a batch of drawings without
PDF attachments to a drawing log (page 630).

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

NOTE The All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can add revisions to any
drawing.

3. In the drawing list, select the drawing for which you want to add a
revision.

4. At the bottom of the drawing log, click Add Revision.

5. In the Drawing Revisions dialog box, click New.

6. Type the revision number and a description of the revision.

7. Type appropriate names in the Revised By and Checked By fields.

8. Click the arrow on the right side of Date Revised and Date Received
fields, and select dates in the calendars.

9. Click the arrow on the right side of Date Checked field, and select a date
in the calendar.

10. Type a release number for the revision.
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11. Click Save to add the revision.

The new drawing revision is added to the revision list. You can view the details
of all of the drawing's revisions by clicking Revision Details.

Note that because you did not attach a PDF file to the drawing revision, the
File column says No. If a PDF file has been attached to the drawing revision,
the File column has Yes in it, and you can double-click the drawing to view the
attached PDF file.

The correct PDF file will automatically be attached to the revision when it is
added to the default drawing folder (by default, C:\Users\Public
\Documents\Tekla PowerFab\Drawing) in the correct job folder and
revision folder.

Modify a drawing revision

Note that you can only modify one drawing revision for one drawing at a time.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

NOTE The All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can add revisions to any
drawing.

3. In the drawing list, select the drawing whose revisions you want to modify.

4. At the bottom of the drawing log, click Revision Details.

5. In the Drawing Revisions dialog box, select the revision that you want to
modify.

6. Modify the revision properties according to your needs.

7. Click Save to save the changes.

Modify multiple drawing revisions

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawings are
stored. 

NOTE The All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can add revisions to any
drawing.

3. In the drawing log, select the drawings whose revisions you want to
modify. 
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To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click the Drawing Log ribbon tab.

5. In the menu, select Global Edit Revisions.

6. In the Global Edit - Revisions dialog box, select which revisions you want
to update: 

• To update all revisions of the selected drawing, select Update All
Revisions.

• To update the latest revision of the selected drawing, select Update
Latest Revision.

• To update a particular revision number, select Update Revision #, and
type the revision number in the Revision # field.

7. Select the checkboxes next to the properties that you want to update.

8. Modify the selected properties according to your needs. 

For example, select a Date Checked date and type a name in the
Checked By field.

9. Click Update.

Delete a drawing revision

Note that deleting a drawing revision is permanent and cannot be undone.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawing is stored.

NOTE The All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can add revisions to any
drawing.

3. In the drawing list, select the drawing whose revisions you want to modify.

4. At the bottom of the drawing log, click Revision Details.

5. In the Drawing Revisions dialog box, select the revision that you want to
delete.

6. Click Delete.

7. To permanently delete the selected revision, click Yes in the confirmation
dialog box.

Delete multiple drawing revisions

1. On the right side of an open project management job, click Drawing Log.
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2. In the context menu, select the drawing log in which the drawings are
stored. 

NOTE The All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so you can add revisions to any
drawing.

3. In the drawing log, select the drawings whose revisions you want to
delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click the Drawing Log ribbon tab.

5. In the menu, select Delete Revisions.

6. In the Delete Drawing Revision - Batch dialog box, select one of the
following options: 

• To delete the latest revisions of the selected drawings, select Delete
Latest Revision.

• To delete particular revisions of the selected drawings, select Delete
Revision #, and type the revision number in the Revision # field.

7. Click Delete.

8. To permanently delete the revisions, click Yes.

Copy drawing files to another location
Use the Copy Drawing Files and Copy Drawing Files - Selected commands to
copy the attached drawing files to another location, so that they can be issued
to the shop or field, or be printed.

To open a drawing log:

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log whose attached files you want
to copy. 

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added, so if you select that option, you can copy
any drawing files regardless of the drawing log where they are stored.

Copy all drawing files in the current drawing log

1. In the open drawing log, click the Drawing Log ribbon tab.

2. On the menu, select Copy Drawing Files.

3. To only copy particular drawing files, in the Copy Files Filter dialog box,
select a filter type in the Type list, and click Select.
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4. In the Filter dialog box, do one of the following depending on the filter
type: 

• Click the arrow buttons to move the drawings whose attached files you
want to copy to the Included list.

• Type the maximum and minimum values for the drawings whose
attached files you want to copy.

5. Click OK.

6. In the Browse For Folder dialog box, browse to and select the folder
where you want to copy the drawing files. 

The default location is the drawing default folder that has been set in the
Default Directories dialog box.

7. Click OK. 

The file-list text file opens in Microsoft Notepad, showing the drawing
files that were copied to the selected location.

8. Ensure that all necessary drawings and files are listed in the file-list
text file.

9. To close Microsoft Notepad and return to the drawing log, click the Close
button (X) in the upper-right corner.

Copy drawing files attached to the selected drawings

1. In the open drawing log, select the drawings whose attached files you
want to copy. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Drawing Log ribbon tab.

3. On the menu, select Copy Drawing Files - Selected.

4. In the Browse For Folder dialog box, browse to and select the folder
where you want to copy the drawing files. 

The default location is the drawing default folder that has been set in the
Default Directories dialog box.

5. Click OK. 

The file-list text file opens in Microsoft Notepad, showing the drawing
files that were copied to the selected location.

6. Ensure that all necessary drawings and files are listed in the file-list
text file.

7. To close Microsoft Notepad and return to the drawing log, click the Close
button (X) in the upper-right corner.
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Print drawings
You can print one or multiple drawings that are stored in a drawing log.

NOTE You can only print drawings that have attached files.

1. In the Project Management module, open a job.

2. In the Document area, click Drawing Log. 

A context menu opens.

3. Select a drawing log type. 

The Drawing dialog box opens.

4. Select the drawing or drawings that you want to print. 

To select multiple drawings, hold down Ctrl.

To select a range of subsequent drawings, hold down Shift.

5. Click the Drawing Log ribbon tab.

6. On the menu, select Print Drawings - Selected. 
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The Select Printer dialog box opens.

7. Select a print and click OK.

8. In the Enter Value dialog box, type the number of the printed copies.

9. To print the drawings, click OK.

Update the links to a drawing log
Use the Refresh command to update the links to the drawing log. If you have
recently attached files to drawings manually, you can also use the Refresh
command to see the newly attached files in the drawing log. The attached files
are also updated when you close and re-open a drawing log.
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1. In the Select Project Management Job dialog box, double-click the job of
your selection. 

The Project dialog box opens.

2. On the right side, in the Document area, click Drawing Log.

3. In the context menu, select the drawing log. 

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added.

4. In the open drawing log, click the Drawing Log ribbon tab.

5. On the menu, select Refresh.

The links to the current drawing log are updated.

View the issue history of selected drawings
Use the Issue History - Selected command to view the entire activity history
of the selected drawings. Among other things, the issue history shows the
transmittals in which the drawings are included.

1. On the right side of an open project management job, click Drawing Log.

2. In the context menu, select the drawing log in which the drawings are
stored. 

Note that the All Drawing Logs option opens a drawing log that lists all
drawings that you have added.

3. In the open drawing log, select the drawings.

4. Click the Drawing Log ribbon tab.

5. On the menu, select Issue History - Selected.

6. In the Drawing Issue History dialog box, view the activity of the selected
drawings.

7. To close the dialog box, click the Close button (X) in the upper-right
corner.

View, print, or export drawing reports
You can create reports based on the information in drawing logs. For example,
you can create a drawing list, or a report on the drawing issue history. You can
then view, print, or export the created reports.

Use the Reports command to create a report on all drawings in the drawing
log or on the drawings that match specific filters, or use the Reports -
Selected command to create a report on the drawings that you select in the
drawing log.
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Create a drawing report

1. In the Project Management module, double-click a job to open it.

2. On the right, click Drawing Log.

3. In the context menu, select the drawing log whose information you want
to include in the report. 

Note that the All Drawing Logs option opens a drawing log that contains
the information of all drawings that you have added.

4. In the drawing log, do one of the following: 

To Do this
Create reports on all
drawings or on specific
drawing types

a. Click the Drawing Log ribbon tab.

b. On the menu, select Reports.

c. To only create drawing reports, at the bottom
of the Project Management Report Filters
dialog box, ensure that only the Drawings
checkbox is selected.

d. To only include specific types of drawings in
the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

e. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the
drawing properties that you want to
include in the report to the Included list.

• Type the maximum and minimum values
for the drawings that you want to include.

f. Click OK.

To further limit the types of drawings that are
included in the reports, repeat steps c to f for
all necessary filter types.

g. Click Make Report.
Create reports on the
currently selected
drawings

a. In the drawing log, select the drawings that
you want to include in the reports.

To select multiple items, hold down Ctrl.

To select a range of subsequent drawings, hold
down Shift.

b. Click the Drawing Log ribbon tab.

c. On the menu, select Reports - Selected.
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5. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View a drawing report

To create a report, follow the steps in Create a drawing report (page 641).

• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the drawing report

To create a report, follow the steps in Create a drawing report (page 641).

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the drawing report

To create a report, follow the steps in Create a drawing report (page 641).

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

6. To open the file after exporting it, select the Open Exported Document
checkbox.

7. In the Report Selection dialog box, click Export.

Set drawings on hold
You can set drawings on hold. They are highlighted so that they are easy to
spot.

Before you start, make sure you have the appropriate settings. See Define
settings for drawings on hold (page 777).

1. In the Production module, double-click to open a job.
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2. In the Production Control ribbon tab, select Drawing Log.

3. Select the drawing or drawings that you want to put on hold.

4. In Approval Status, select H for Hold.

5. Click Save and close the Drawing dialog box.

The drawings that are on hold are highlighted in red.

You can also see the status in Tekla PowerFab Go.

Manage companies in the project
To share project information with the other parties of the project, you need to
add the parties to the project management job. Use the Add Contact
command to add the necessary companies and contacts to the project. You
can also modify the existing companies and contact persons, or remove any
unnecessary companies from the project.
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Add a company contact
1. In the Project Contacts section of the Project dialog box, click Add

Contact.

2. In the Contact Properties dialog box, select the company type in the
Type list.

3. Do any of the following: 

To Do this
Add a company that has
been saved in the
Address Book

• In the Name list, select the company.

Add a new company a. In the Name field, type the name of the new
company.

b. Press Enter on the keyboard.

c. To add the new company in the Address
Book, click Yes.

Note that you need to add the contacts for the new
company manually. To do so, click Edit on the right
side of the Name field. For detailed instructions,
see Add contacts to the address book (page 145).

4. If necessary, type the title of your contact person in the Title field.

5. In the Ship To Address and Bill To Address lists, select the right shipping
and billing addresses.

6. In the Contact list, select the contact that you want to add. 

Note that the contact needs to be saved in the Address Book.

7. Click OK.

Modify a contact
1. In the Project Contacts section of the Project dialog box, select the

contact.

2. Click Properties.

3. If necessary, change the company by selecting another company in the
Name list.

4. If necessary, change the title of your contact person in the Title field.

5. In the Ship To Address and Bill To Address lists, select the right shipping
and billing addresses.

6. In the Contact list, select the contact person that you want to use. 
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Note that the contact needs to be saved in the Address Book.

If you want to change the contact details of a contact person, you need to
do so in the Address Book.

7. Click OK.

Remove a company from the project
Removing a company from the project is permanent and cannot be undone. If
you remove a company, you will no longer be able to send project documents
to the company.

1. In the Project Contacts section of the Project dialog box, select the
contact.

2. Click Remove Contact.

3. To permanently delete the contact from this project, click Yes.

Manage transmittals
Transmittals are cover sheets to which drawings can be attached in order to be
sent. Tekla PowerFab records the time when a drawing has been issued and is
to be returned, and marks drawings that are overdue or outstanding.

To access the Transmittal dialog box, do any of the following:

• On the right side of the Project dialog box, click the Transmittals button.

• On the Summary tab of the Project dialog box, click + in the upper-right
corner of the Transmittals section, and select which transmittals you want
to see.
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The Transmittal dialog box opens.

For more information, see the following links:

Create, modify, and delete transmittals (page 647)

View transmittals (page 656)

Print transmittals (page 657)

Mark drawings in a transmittal as received (page 657)

Send a transmittal via email (page 658)

Create, modify, and delete transmittals
Use the Transmittal dialog box to manage transmittals. You can create new
transmittals, attach drawings and files to transmittals, modify the properties of
existing transmittals, or delete unnecessary transmittals.

Project Management 647 Manage project information



Create a transmittal
Before you start creating transmittals, we recommend that you create the
necessary methods for sending documents, transmittal items, transmittal
purposes, and commonly used text for transmittals.

See Set up transmittals (page 603).

1. In Project Management, to open a project, double-click it. The Project
dialog box opens.

2. Click Transmittals 

The Transmittal dialog box opens.

3. At the bottom of the dialog box, click New. 

The next available transmittal number is populated in the Transmittal #
field.

4. If necessary, modify the transmittal number.

5. Define the properties for the transmittal. 

The items that are marked with an asterisk (*) in the following table are
mandatory.

Option Description
Date * The date of the transmittal.

Click the arrow on the right side of the Date field,
and select the date in the calendar.
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Option Description
Recipient * The company and contact person that will receive

the transmittal once it is ready.

Note that the available companies and contact
persons are set in the Project Company
Standards dialog box.

Click the arrow on the right side of the leftmost
Recipient list, and select the recipient company in
the list.

Title * The title that will appear at the top of the
transmittal.

In the Title field, type a title for the transmittal.
Sending * Allows you to define how the drawings are sent to

the recipient.

Click the arrow on the right side of the Sending list,
and select one of the following options:

• Enclosed: the drawings are sent enclosed in the
transmittal.

• Under Separate Cover: the drawings are sent
under a separate cover.

Type * Allows you to define if the recipient needs to return
the drawings.

Click the arrow on the right side of the Type list,
and select one of the following options:

a. To Be Returned: the recipient needs to return
the drawings by a specific date.

b. For Issue Only: the recipient does not need to
return the drawings.

Items * The types of the items that are sent with the
transmittal. If necessary, you can select multiple
options.

The options are set in the Transmittal Item
Maintenance dialog box.

To add items to the transmittal, do the following:

a. Click the Items field.

b. In the Select Items dialog box, click the arrow
buttons to move the types of items to be
included in the transmittal to the Included list.

c. Click OK.
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Option Description
Purpose * The purposes of sending the transmittal. For

example, transmittals can be sent to be approved
or for pricing. If necessary, you can select multiple
purposes.

The options are set in the Transmittal Purpose
Maintenance dialog box.

The Select Purposes dialog box opens
automatically when you click OK in the Select
Items dialog box. In the dialog box, do the
following:

a. Click the arrow buttons to move the purposes
for sending the transmittal to the Included
list.

b. Click OK.
# of Prints The number of prints included in the transmittal.

Type a number in the # of Prints field.
Prints to Return If Type is set to To Be Returned, define the

number of prints to be returned.

Type a number in the Prints to Return field.
# of Sepias The number oincluded in the transmittal.

Type a number in the # of Sepias field.
Sepias to Return If Type is set to To Be Returned, define the

number of sepias to be returned.

Type a number in the Sepias to Return field.
Sent By The sender of the transmittal.

Do one of the following:

• Click the arrow on the right side of the Sent By
list, and select a previously defined sender in
the list.

• Type a new sender name in the Sent By field.

The name is saved and will be available for
future transmittals.

Copy To The people who receive a copy of the transmittal.

Do one of the following:

• Click the arrow on the right side of the Copy To
list, and select a previously defined name in the
list.
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Option Description
• Type a new name in the Sent By field.

The name is saved and will be available for
future transmittals.

Remarks Any remarks that you want to add to the
transmittal.

Type the remarks in the Remarks field.
Standard Text The text items that you want to include in the

transmittal. You can only select one option.

The text items are set in the Transmittal Standard
Text Maintenance dialog box.

Click the arrow on the right side of the Standard
Text list, and select an option in the list.

Return Date * If Type is set to To Be Returned, define the date by
which the drawings should be returned.

Remember to add a return date for returned
drawings, so that they do not appear as overdue.

Click the arrow on the right side of the Return
Date field, and select a date in the list.

6. To attach drawings to the new transmittal, do the following:

a. At the bottom of the dialog box, click Drawings.

b. At the bottom of the Transmittal Drawings dialog box, click Add
Drawings.

c. In the Add Transmittal Drawings dialog box, click the arrow buttons
to move the drawings that you want to attach to the Included list. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

d. Click Add.

e. To close the dialog box, click the Close button (X) in the upper-right
corner.

You can see the attached drawings in the lower-right corner of the
Transmittal dialog box.

7. To attach files to the new transmittal, do the following:

a. Click Attached Files --> New. 

The Document Index dialog box opens.

b. Do either of the following: 

• To add an existing file, click either Find by Directory or Search
and find the desired file.
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• To add a new file, click either Add File, Add Outlook Email, or
Add Outlook Attachments, select the file you want to add, and
click Open.

c. In Select Directory, click Browse to select the directory in which you
want to save the file.

d. Click Add File. 

The added file shows in the list in the Transmittal dialog box. You can
add a description for the file in the Description field.

e. Click Save and close the window to return to the Transmittal dialog
box.

Modify a transmittal

Modify a transmittal to change its properties. For example, you should add a
return date for returned drawings, so that they do not appear as overdue.

1. In Project Management, to open a project, double-click it. The Project
dialog box opens.

2. Click Transmittals 

The Transmittal dialog box opens.

3. Select the transmittal that you want to modify.

4. Modify the properties for the transmittal. 

The items that are marked with an asterisk (*) in the following table are
mandatory.

Option Description
Date * The date of the transmittal.

Click the arrow on the right side of the Date field,
and select the date in the calendar.

Recipient * The company and contact person that will receive
the transmittal once it is ready.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Recipient lists.

Click the arrow on the right side of the leftmost
Recipient list, and select the recipient company in
the list.

Click the arrow on the right side of the rightmost
Recipient list, and select the contact person in the
list.

Project Management 652 Manage project information



Option Description
Title * The title that will appear at the top of the

transmittal.

In the Title field, type a title for the transmittal.
Sending * Allows you to define how the drawings are sent to

the recipient.

Click the arrow on the right side of the Sending list,
and select one of the following options:

• Enclosed: the drawings are sent enclosed in the
transmittal.

• Under Separate Cover: the drawings are sent
under a separate cover.

Type * Allows you to define if the recipient needs to return
the drawings.

Click the arrow on the right side of the Type list,
and select one of the following options:

a. To Be Returned: the recipient needs to return
the drawings by a specific date.

b. For Issue Only: the recipient does not need to
return the drawings.

Items * The types of the items that are sent with the
transmittal. You can select multiple options.

The options are set in the Transmittal Item
Maintenance dialog box.

To add items to the transmittal, do the following:

a. Click the Items field.

b. In the Select Items dialog box, click the arrow
buttons to move the types of items to be
included in the transmittal to the Included list.

c. Click OK.
Purpose The purposes of sending the transmittal. For

example, transmittals can be sent to be approved
or for pricing. If necessary, you can select multiple
purposes.

The options are set in the Transmittal Purpose
Maintenance dialog box.

The Select Purposes dialog box opens
automatically when you click OK in the Select
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Option Description
Items dialog box. In the dialog box, do the
following:

a. Click the arrow buttons to move the purposes
for sending the transmittal to the Included
list.

b. Click OK.
# of Prints The number of prints included in the transmittal.

Type a number in the # of Prints field.
Prints to Return If Type is set to To Be Returned, define the

number of prints to be returned.

Type a number in the Prints to Return field.
# of Sepias The number of prints included in the transmittal.

Type a number in the # of Sepias field.
Sepias to Return If Type is set to To Be Returned, define the

number of sepias to be returned.

Type a number in the Sepias to Return field.
Sent By The sender of the transmittal.

Do one of the following:

• Click the arrow on the right side of the Sent By
list, and select a previously defined sender in
the list.

• Type a new sender name in the Sent By field.

The name is saved and will be available for
future transmittals.

Copy To The people who receive a copy of the transmittal.

Do one of the following:

• Click the arrow on the right side of the Copy To
list, and select a previously defined name in the
list.

• Type a new name in the Sent By field.

The name is saved and will be available for
future transmittals.

Remarks Any remarks that you want to add to the
transmittal.

Type the remarks in the Remarks field.
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Option Description
Standard Text The text items that you want to include in the

transmittal. You can only select one option.

The text items are set in the Transmittal Standard
Text Maintenance dialog box.

Click the arrow on the right side of the Standard
Text list, and select an option in the list.

Return Date * If Type is set to To Be Returned, define the date by
which the drawings should be returned.

Remember to add a return date for returned
drawings, so that they do not appear as overdue.

Click the arrow on the right side of the Return
Date field, and select a date in the calendar.

5. To attach drawings to the new transmittal, do the following:

a. At the bottom of the dialog box, click Drawings.

b. In the Transmittal Drawings dialog box, do any of the following: 

• To add new drawings, click Add drawings, select the drawings,
and click Add.

• To set shop issue date, select the drawings and click Set Shop
ISsue Date. Then, select the date in the calender and click OK.

• To return drawings, select the drawings and click Return. Then,
select the approval status and return date, and click Update.

Note that if this is not the first time that these drawings have been
returned, you should select the Re-Submit checkbox.

• To cancel returning drawings, select the drawings and click Un-
Return. Then, select the approval status and click OK.

• To remove drawings from the transmittal, select the drawings and
click Remove Selected drawings.

c. To close the dialog box, click the Close button (X) in the upper-right
corner.

You can see the attached drawings in the lower-right corner of the
Transmittal dialog box.

6. Click Save.

7. To attach files to the transmittal or to delete files from the transmittal,
click Attached Files. 

To add new files, click New or to delete files, click Delete.
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Delete transmittals

1. In Project Management, to open a project, double-click it. The Project
dialog box opens.

2. Click Transmittals 

The Transmittal dialog box opens.

3. Select the transmittals that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click Delete.

5. To permanently delete the transmittals, click Yes in the confirmation
dialog box.

View transmittals
You can view the selected transmittals by using the View Selected
Transmittals command in the Tekla PowerFab Report Viewer.

1. In the Transmittal dialog box, select the transmittals that you want to
view. 

To select multiple transmittals, hold down Ctrl.

To select a range of subsequent transmittals, hold down Shift.

2. Click the Transmittal ribbon tab.

3. On the menu, select View Selected Transmittals.

4. In the View Transmittal dialog box, select or clear the following
checkboxes: 

To Do this
Show Company Logo (If
Exists)

When selected, your company logo is visible in the
transmittal.

Combine Drawings When selected, consecutive drawing numbers are
combined, so that the drawing numbers are
displayed as 1–3, instead of 1, 2, 3.

To be combined, the drawings need to have the
same dates, revisions, and descriptions, and be in a
series.

5. In the Report Selection dialog box, click View.

The transmittal opens in the Tekla PowerFab Report Viewer.

In the Tekla PowerFab Report Viewer, you can email the transmittal as a
Microsoft Excel worksheet or a PDF file, export it to another file format, or
print it.
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Print transmittals
Use the Print Selected Transmittals to print one or multiple transmittals
related to the current project management job.

1. In the Transmittal dialog box, select the transmittals that you want to
print. 

To select multiple transmittals, hold down Ctrl.

To select a range of subsequent transmittals, hold down Shift.

2. Click the Transmittal ribbon tab.

3. On the menu, select Print Selected Transmittals.

4. On the Report Settings tab of the Print Transmittal dialog box, select or
clear the following checkboxes: 

To Do this
Show Company Logo (If
Exists)

When selected, your company logo is visible in the
transmittal.

Combine Drawings When selected, consecutive drawing numbers are
combined, so that the drawing numbers are
displayed as 1–3, instead of 1, 2, 3.

To be combined, the drawings need to have the
same dates, revisions, and descriptions, and be in a
series.

5. On the Printer Settings tab, type the number of copies in the Copies
field.

6. To set the printer, click Change Printer.

7. In the Select Printer dialog box, click a printer to select it.

8. Click OK.

9. Click Print.

Mark drawings in a transmittal as received
When the recipient of the transmittal has returned the drawings, mark the
drawings as received in the Transmittal dialog box.

NOTE You can only receive drawings in transmittals whose type is To Be
Returned.

1. In the Transmittal dialog box, click the transmittal whose drawings you
want to receive.

2. At the bottom of the dialog box, click Drawings.
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3. In the Selected Drawings dialog box, click the arrow buttons to move the
returned drawings to the Included list.

4. Click Receive.

5. In the Receive Drawings dialog box, click the arrow on the right side of
the Date Returned field, and select the date in the calendar.

6. Click the arrow on the right side of Approval Status list, and select the
approval status of the drawings in the list.

7. If the drawings have been resubmitted for approval, select the Re-Submit
checkbox.

8. Click OK.

9. In the Selected Drawings dialog box, select all drawings in the Included
list. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

10. Click Set Shop Issue Date of Included Drawings.

11. Click the arrow on the right side of the date field, and select a date in the
calendar.

12. Click OK.

13. To close the Selected Drawings dialog box, click OK.

Send a transmittal via email
You can send the selected transmittals via email directly using the Email
Selected Transmittal command in the Transmittal dialog box.

NOTE The Email Selected Transmittal command only works with Microsoft
Outlook, so you need to have Microsoft Outlook open before trying to
send a transmittal by email.

1. In the Transmittal dialog box, select the transmittals that you want to
send via email. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Transmittal ribbon tab.

3. On the menu, select Email Selected Transmittal. 

The Email Transmittal dialog box opens.

Note that the people who were marked as recipients of the transmittal are
automatically included in the Recipients Included list.
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4. In the Email Transmittal dialog box, click the arrow buttons to move
additional recipients to the Recipients Included list.

5. If some of the recipients do not have an email address saved in the
Address Book, do the following:

a. Select the recipient in the Recipients Included list.

b. Click Contact Details.

c. Type the email address in the Email Address field.

d. Click Save.

6. Select or clear the following checkboxes according to your needs: 

Option Description
Attach Drawing Files When selected, the drawing files that match the

items and purposes defined in the Transmittals
dialog box are attached to the transmittal.

Compress Drawing
Files

When selected, the drawing files are compressed
into a .zip package. The drawings are still separate
PDF files within the .zip package.

Note that the size of a .zip package may prevent
Microsoft Outlook from sending the transmittal via
email.

Show Company Logo (If
Exists)

When selected, your company logo is visible in the
transmittal.

Combine Drawings When selected, consecutive drawing numbers are
combined, so that the drawing numbers are
displayed as 1–3, instead of 1, 2, 3.

7. Click Email to send the email.

View, print, and export transmittal reports
You can create reports based on the transmittals related to the current project.
For example, you can create a report containing all existing transmittals or all
overdue transmittals. You can then view, print, or export the created reports.

Use the Reports command to create a report on all transmittals or
transmittals that match specific filters, or use the Reports - Selected
command to create a report on the transmittals that are currently selected in
the Transmittals dialog box.

Create a transmittal report

1. In the Transmittal dialog box, click the Transmittal ribbon tab.

2. Do either of the following: 
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To Do this
Create reports on all
transmittals or specific
types of transmittals

a. On the menu, select Reports.

b. To only create transmittal reports, at the
bottom of the Project Management Report
Filters dialog box, ensure that the
Transmittals checkbox is selected.

c. To only include specific types of transmittals in
the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

d. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the
transmittal properties that you want to
include in the report to the Included list.

• Type the maximum and minimum values
for the transmittals that you want to
include.

For example, select the earliest and latest
drawing date for the transmittals.

e. Click OK.

To further limit the transmittals that are
included in the reports, repeat steps b to d for
all necessary filter types.

f. To combine the drawing numbers of drawings
with the same dates, revisions, and
descriptions, select the Transmittal -
Combine Drawings checkbox.

g. Click Make Report.
Create reports on the
currently selected
transmittals

a. On the menu, select Reports - Selected.

3. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the transmittal report

• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.
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Print the transmittal report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the transmittal report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

6. To open the file after exporting it, select the Open Exported Document
checkbox.

7. In the Report Selection dialog box, click Export.

Manage requests for information
Official requests for information, or RFIs, allow you to log the flow of
information between parties in construction projects. RFIs can be used to
clarify the design intent, get missing information, receive approval for
alternate methods or materials, get approved fixes for any conflicts in the field,
or get any other critical information to ensure that the project conforms to the
intent of the design team. You can save all RFIs and their responses to Tekla
PowerFab, so that everyone in the current project can keep track of the project
easily.

• Do any of the following: 

• On the right side of the Project dialog box, click the RFIs button.

• On the Summary tab of the Project dialog box, click + in the upper-
right corner of the RFIs section, and select which requests for
information you want to see.

Project Management 661 Manage project information



The Request For Information dialog box opens.

For more information, see the following links:

Create, modify, and delete requests for information (page 662)

View requests for information (page 670)

Print requests for information (page 671)

Import or export requests for information (page 672)

Save a request for information as a Microsoft Word document (page 673)

Send a request for information via email (page 673)

View, print, or export RFI reports (page 674)

Create, modify, and delete requests for information
Use the Request For Information dialog box to manage requests for
information, or RFIs. You can create new requests, add recipients for the
requests, attach files or emails to requests, modify the properties of existing
requests, or delete unnecessary requests.
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Note that requests by either your company or any other party in the project
can be recorded in the Request For Information dialog box.

Create a request

1. In the Request For Information dialog box, click New.

2. Define the properties of the request. 

The items that are marked with an asterisk (*) in the following table are
mandatory.

Option Description
Originator * The party that initiated the original

request.

Click the arrow on the right side of the
upper Originator list, and in the list,
select the originator company.

Click the arrow on the right side of the
lower Originator list, and in the list,
select the contact person that
initiated the request.

Note that only the companies that
have been added for the project in
the Project Management dialog box
and their contact persons are
available in the Originator lists.
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Option Description
Orig RFI # * The number of the original request

that was sent to your company.

Note that the Orig RFI # is only
available and mandatory if the
originator of the request is some
other party than your company.

Type the request number in the Orig
RFI # field.

Orig RFI Date * The date when the original request
was sent to your company.

Note that the Orig RFI Date is only
available and mandatory if the
originator of the request is some
other party than your company.

Click the arrow on the right side of the
Orig RFI Date list, and select a date in
the calendar.

RFI # * The number of the request or
response that you are sending.

Note that an RFI number can only be
used once.

Type the request number in the RFI #
field.

RFI Date * The date when you sent the request.

Click the arrow on the right side of the
RFI Date list, and select a date in the
calendar.

RFI Status Indicates if all necessary information
regarding the request has been
received.

Remember to close requisitions once
they have been responded to.

Click the arrow on the right side of RFI
Status list, and select one of the
following options:

• Open: all necessary information
has not been received.

• Closed: all necessary information
has been received.
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Option Description

NOTE Setting the RFI status as
Closed does not close the
request, so the request can
still be shown as overdue.

To actually close the request,
you need to define a
response date when you have
received all necessary
information from the primary
recipient of the request.

Request Date * The date by which the requested
information should be received.

Click the arrow on the right side of
Request Date list, and select a date
in the calendar.

Subject * The subject of the request.

Type a subject in the Subject field.
Body * The body text of the request.

Type the text of the request in the
Body field.

3. To add recipients for the request, do the following:

a. Click anywhere in the Recipient table.

b. In the Recipients dialog box, click one of the following buttons: 

• New Primary Recipient: creates a primary recipient.

• New Carbon Copy Recipient: creates a recipient that receives a
copy of the original request.

c. Define the recipient properties: 

Option Description
To The recipient company and person.

Click the arrow on the right side of the leftmost To
list, and select the recipient company in the list.

Click the arrow on the right side of the rightmost
To list, and select the recipient in the list.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Originator lists.
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Option Description
Their RFI # The recipient's request number.

Type a number in the Their RFI # field.
Date Sent The date when the request was sent to the

recipient.

Click the arrow on the right side of the Date Sent
field, and select a date in the calendar.

Sent Via The method with which the request was sent.

The available methods are set in Sent Via
Maintenance.

Click the arrow on the right side of the Sent Via
list, and select a sending method in the list.

Date Received The date when the first response from the
recipient was received.

Click the arrow on the right side of the Date
Received field, and select a date in the calendar.

Response Date The date when all necessary information was
received, and the request status could be set to
Closed.

The response date is included in RFI reports.

Click the arrow on the right side of the Response
Date field, and select a date in the calendar.

Response Details Any information regarding the response. The
response details are included in RFI reports.

Type details in the Response Details field.

d. To add the recipient, depending on the recipient type, click Add PR or
Add CC. 

Repeat steps b to d for all necessary recipients.

e. To close the Recipients dialog box, click the Close button (X) in the
upper-right corner.

4. In the Request For Information dialog box, click Add to create the
request.

5. To attach files to the new request, do the following:

a. Select the request in the list.

b. Click Attached Files.

c. In the RFI Files dialog box, click New.

d. In the Document Index - Add Document Reference dialog box, add
a file, a Microsoft Outlook email, or Microsoft Outlook email
attachments. 
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e. Click the arrow on the right side of the leftmost RFI list, and select the
related request in the list.

f. Click the arrow on the right side of the rightmost RFI list, and select if
the attachment is a request or a response.

g. Type a description for the attached file.

h. Click Add Document Reference. 

Repeat steps c to h for all necessary attachments.

i. In the RFI Files dialog box, click Save.

j. To close the RFI Files dialog box, click the Close button (X) in the
upper-right corner.

Modify a request

Modify a request to change its properties. For example, you should close a
request after receiving all necessary information.

1. In the Request For Information dialog box, select the request that you
want to modify.

2. Modify the request properties according to your needs: 

Option Description
Originator The party that initiated the original

request.

Click the arrow on the right side of the
upper Originator list, and in the list,
select the originator company.

Click the arrow on the right side of the
lower Originator list, and in the list,
select the contact person that
initiated the request.

Note that only the companies that
have been added for the project in
the Project Management dialog box
and their contact persons are
available in the Originator lists.

Orig RFI # The number of the original request
that was sent to your company.

Note that the Orig RFI # is only
available and mandatory if the
originator of the request is some
other party than your company.

Type the request number in the Orig
RFI # field.
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Option Description
Orig RFI Date The date when the original request

was sent to your company.

Note that the Orig RFI Date is only
available and mandatory if the
originator of the request is some
other party than your company.

Click the arrow on the right side of the
Orig RFI Date list, and select a date in
the calendar.

RFI # The number of the request or
response that you are sending.

Note that an RFI number can only be
used once.

Type the request number in the RFI #
field.

RFI Date The date when you sent the request
or a response to the request.

Click the arrow on the right side of the
RFI Date field, and select a date in the
calendar.

RFI Status Indicates if all necessary information
regarding the request has been
received.

Remember to close requisitions once
they have been responded to.

Click the arrow on the right side of the
RFI Status list, and select one of the
following options:

• Open: all necessary information
has not been received.

• Closed: all necessary information
has been received.

Request Date The date by which the requested
information should be received.

Click the arrow on the right side of the
Request Date list, and select a date
in the calendar.

Subject The subject of the request.

Type a subject in the Subject field.

Project Management 668 Manage project information



Option Description
Body The body text of the request.

Type the text of the request in the
Body field.

3. To add recipients for the request, do the following:

a. Click anywhere in the Recipient table.

b. In the Recipients dialog box, modify the recipient properties
according to your needs: 

Option Description
To The recipient company and person.

Click the arrow on the right side of the leftmost To
list, and select the recipient company in the list.

Click the arrow on the right side of the rightmost
To list, and select the recipient in the list.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Originator lists.

Their RFI # The recipient's request number.

Type a number in the Their RFI # field.
Date Sent The date when the request was sent to the

recipient.

Click the arrow on the right side of the Date Sent
field, and select a date in the calendar.

Sent Via The method with which the request was sent.

The available methods are set in Sent Via
Maintenance.

Click the arrow on the right side of the Sent Via
list, and select a sending method in the list.

Date Received The date when the first response from the
recipient was received.

Click the arrow on the right side of the Date
Received field, and select a date in the calendar.

Response Date The date when all necessary information was
received, and the request status could be set to
Closed.

The response date is included in RFI reports.

Click the arrow on the right side of the Response
Date field, and select a date in the calendar.
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Option Description
Response Details Any information regarding the response. The

response details are included in RFI reports.

Type details in the Response Details field.

c. Click Edit to save the changes. 

If necessary, you can also delete recipients by selecting them, clicking
Delete, and clicking Yes to confirm.

d. To close the Recipients dialog box, click the Close button (X) in the
upper-right corner.

4. To modify the files that are attached to the request, do the following:

a. Select the request in the list.

b. Click Attached Files.

c. In the RFI Files dialog box, select an attachment and modify its
description according to your needs.

d. If necessary, click the arrow on the right side of the list that is next to
the description, and select if the attachment is related to a request or
a response.

e. Click Save. 

If necessary, you can also delete attached files by selecting them,
clicking Delete, and clicking Yes to confirm.

f. To close the RFI Files dialog box, click the Close button (X) in the
upper-right corner.

Delete a request

Note that deleting a request is permanent and cannot be undone.

1. In the Request For Information dialog box, select the request that you
want to delete.

2. Click Delete.

3. To permanently delete the request, click Yes in the confirmation dialog
box.

View requests for information
You can open the currently selected requests for information (RFI) in Tekla
PowerFab Report Viewer by using the View Selected RFIs command.

1. In the Request For Information dialog box, select the requests that you
want to view. 

To select multiple requests, hold down Ctrl.

To select a range of subsequent requests, hold down Shift.
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2. Double-click one of the selected requests.

3. In the View RFI dialog box, select or clear the following checkboxes: 

Option Description
Show Company Logo (If
Exists)

When selected, your company logo is visible in the
requests.

Include Impact Text When selected, Tekla PowerFab includes text
regarding the importance of the requested
information and the delay that may be caused if
the response is not sent on time.

4. If necessary, in the Additional Pages field, type the number of pages you
want to add to the request for the attachments to be included.

5. In the Author field, type the name of the author. 

If you do not type a name in the Author field, Tekla PowerFab uses the
name of your company instead.

6. To view the request, click View Request.

The selected requests open in Tekla PowerFab Report Viewer.

In the Tekla PowerFab Report Viewer window, you can send the requests via
email either as PDF files or Microsoft Excel worksheets, print the requests, or
export the requests and save them in another file format.

See also

Print requests for information (page 671)

Send a request for information via email (page 673)

Print requests for information
Use the Print Selected RFIs command to print one or multiple requests for
information.

1. In the Request For Information dialog box, select the requests that you
want to print. 

To select multiple requests, hold down Ctrl.

To select a range of subsequent requests, hold down Shift.

2. Click the Request For Information ribbon tab.

3. On the menu, select Print Selected RFIs.

4. In the Print RFI dialog box, select or clear the following checkboxes: 

Option Description
Show Company Logo (If
Exists)

When selected, your company logo is visible in the
requests.
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Option Description
Include Impact Text When selected, Tekla PowerFab includes text

regarding the importance of the requested
information and the delay that may be caused if
the response is not sent on time.

5. If necessary, in the Additional Pages field, type the number of pages you
want to add to the request for the attachments to be included.

6. In the Author field, type the name of the author. 

If you do not type a name in the Author field, Tekla PowerFab uses the
name of your company instead.

7. In the Copies field, type the number of printed copies.

8. Click Change Printer.

9. In the Select Printer dialog box, click a printer to select it.

10. Click OK.

11. Click Print RFI.

See also

Send a request for information via email (page 673)

Import or export requests for information
You can import or export requests for information. Use the XML file format
when exporting requests, so that the requests can easily be imported back to
Tekla PowerFab by another party in the current project.

Import requests

1. In the Request For Information dialog box, click the Request For
Information ribbon tab.

2. On the menu, select Data Exchange --> Import .

3. In the Open dialog box, browse to find the file that you want to import.

4. Double-click the file that you want to import, or click Open.

5. In the Import Tekla PowerFab Exchange File dialog box, review the
import progress.

6. When the import process is completed, click Close.

Export requests

1. In the Request For Information dialog box, click the request that you
want to export.

2. On the menu, select Data Exchange --> Export Selected RFIs .
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3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

Save a request for information as a Microsoft Word document
Use the Make Word Document command to save a request for information
as a Microsoft Word document.

1. In the Request For Information dialog box, select the request that you
want to save as a Microsoft Word document.

2. Click the Request For Information ribbon tab.

3. On the menu, select Make Word Document.

4. In the Save As dialog box, browse to the folder where you want to save
the file.

5. If necessary, change the file name.

6. Click Save.

See also

Import or export requests for information (page 672)

Send a request for information via email
You can send the currently selected request for information (RFI) via email by
using the Email Selected RFI command.

NOTE The Email Selected RFI command only works with Microsoft Outlook,
so you need to have Microsoft Outlook open before trying to send a
transmittal by email.

1. In the Request For Information dialog box, select the requests that you
want to send via email.

2. Click the Request For Information ribbon tab.

3. On the menu, select Email Selected RFI. 

The Email RFI dialog box opens.

Note that the recipients and attachments defined in the Request For
Information are automatically added to the Recipients Included list.

4. Click the arrow buttons to move additional recipients to the Recipients
Included list.

5. If some of the recipients do not have an email address saved in the
Address Book, do the following:
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a. Select the recipient in the Recipients Included list.

b. Click Contact Details.

c. Type the email address in the Email Address field.

d. Click Save.

6. Click the arrow buttons to move the attachments that you want to include
in the email to the Attachments Included list.

7. Select or clear the following checkboxes: 

Option Description
Attach Tekla PowerFab
data exchange file

When selected, the request information is
converted to an XML file, which another Tekla
PowerFab user can import to Tekla PowerFab. This
can be useful if other parties in the project use
Tekla PowerFab as well.

Show Company Logo (If
Exists)

When selected, your company logo is visible in the
request.

Note that the Show Company Logo (If Exists)
checkbox is only available if the Attach PDF
export of the RFI checkbox is selected.

Include Impact Text When selected, Tekla PowerFab includes a notice
regarding the importance of the requested
information and the delay that may be caused if
the response is not sent on time.

Note that the Show Company Logo (If Exists)
checkbox is only available if the Attach PDF
export of the RFI checkbox is selected.

8. If necessary, in the Additional Pages field, type the number of pages you
want to add to the request for the attachments to be included. 

NOTE The Additional Pages field is only available if the Attach PDF
export of the RFI checkbox is selected.

9. In the Author field, type the name of the author. 

If you do not type a name in the Author field, Tekla PowerFab uses the
name of your company instead.

10. Click Email.

See also

Save a request for information as a Microsoft Word document (page 673)

Import or export requests for information (page 672)
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View, print, or export RFI reports
You can create reports based on the existing requests for information (RFI). For
example, you can create a report containing all the overdue RFIs or the RFI
details. You can then view, print, or export the created reports.

You can use the Reports command to create a report on all requests or
requests that match specific filters, or use the Reports - Selected command to
create a report on the requests that you select in the Request For
Information dialog box.

Create an RFI report

1. In the Request For Information dialog box, click the Request For
Information ribbon tab.

2. Do either of the following: 

To Do this
Create reports on all RFIs
or specific types of RFIs

a. On the menu, select Reports.

b. To only create RFI reports, at the bottom of the
Project Management Report Filters dialog
box, ensure that only the RFIs checkbox is
selected.

c. To only include specific types of requests in
the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

d. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the
request properties that you want to include
in the report to the Included list.

• Type the maximum and minimum values
for the requests that you want to include.

For example, you can define the earliest
and latest date for the requests that you
want to include.

e. Click OK.

To further limit the requests that are included
in the reports, repeat steps b to d for all
necessary filter types.

f. Click Make Report.
Create reports on the
currently selected RFIs

a. On the menu, select Reports - Selected.
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3. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the RFI report

• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the RFI report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the RFI report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

6. To open the file after exporting it, select the Open Exported Document
checkbox.

7. In the Report Selection dialog box, click Export.

Manage the project journal
The project journal allows you to keep a chronological record of the project. In
the Journal dialog box, you can add journal entries regarding emails,
telephone conversations, or any other project information that needs to be
recorded. By adding journal entries, you can ensure that everyone in the
project knows the relevant details about the project.

• To open the project journal, on the right side of the Project dialog box, click
the Journal Entries button.
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The Journal dialog box opens.

For more information, see the following links:

Add, modify, and delete journal entries (page 677)

View, print, and export project journal reports (page 681)

Add, modify, and delete journal entries
Use the Journal dialog box to manage and record journal entries related to
the project. You can add new journal entries, attach files or emails to journal
entries, modify existing journal entries, or delete journal entries.
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Add a journal entry

1. In the Journal dialog box, click New.

2. Define the properties of the journal entry: 

The items that are marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Entry # * The number of the journal entry.

Tekla PowerFab automatically populates the Entry
# field with the next available entry number.

If necessary, type a different number in the Entry
# field.

Entry Date * The date of the recorded event.

By default, Tekla PowerFab suggests the current
date.

If necessary, click the arrow on the right side of the
Entry Date field, and select a date in the calendar.

Entry Time * The time of the recorded event.

By default, Tekla PowerFab suggests the current
time.

If necessary, type another time in the Entry Time
fields.
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Option Description
Author * The creator of the journal entry.

Click the arrow on the right side of the Author list,
and select a user in the list.

Note that only Tekla PowerFab users in your
company are available in the list.

Contact The project party related to the recorded event.
For example, the contact person with whom you
had a telephone conversation and their company.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Contact lists.

Click the arrow on the right side of the leftmost
Contact list, and select the related company in the
list.

Click the arrow on the right side of the rightmost
Contact list, and select the contact person in the
list.

Subject * The subject of the journal entry.

Type the subject in the Subject field.
Body The details of the journal entry.

Type any relevant information in the Body field.

3. Click Add.

4. To attach a file to the new journal entry, do the following:

a. Select the new journal entry.

b. Click Attached Files.

c. In the Journal Entry Files dialog box, click New.

d. In the Document Index - Add Document Reference dialog box, add
a file, a Microsoft Outlook email, or Microsoft Outlook email
attachments. 

For more information, see Add document references (page 153).

e. Click the arrow on the right side of the leftmost Journal Entry list,
and select the journal entry to which you want to attach the file.

f. Type a description for the attached file.

g. Click Add Document Reference. 

Repeat steps c to g for to add all necessary attachments.

h. In the Journal Entry Files dialog box, click Save.
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i. To close the Journal Entry Files dialog box, click the Close button (X)
in the upper-right corner.

Modify a journal entry

1. In the Journal dialog box, select the journal entry that you want to modify.

2. Modify the journal entry properties according to your needs: 

Option Description
Entry # The number of the journal entry.

Tekla PowerFab automatically populates the Entry
# field with the next available entry number.

If necessary, type a different number in the Entry
# field.

Entry Date The date of the recorded event.

By default, Tekla PowerFab suggests the current
date.

If necessary, click the arrow on the right side of the
Entry Date field, and select a date in the calendar.

Entry Time The time of the recorded event.

By default, Tekla PowerFab suggests the current
time.

If necessary, type another time in the Entry Time
fields.

Author The creator of the journal entry.

Click the arrow on the right side of the Author list,
and select a user in the list.

Note that only Tekla PowerFab users in your
company are available in the list.

Contact The project party related to the recorded event.
For example, the contact person with whom you
had a telephone conversation and their company.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the Contact lists.

Click the arrow on the right side of the leftmost
Contact list, and select the related company in the
list.

Click the arrow on the right side of the rightmost
Contact list, and select the contact person in the
list.
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Option Description
Subject The subject of the journal entry.

Type the subject in the Subject field.
Body The details of the journal entry.

Type any relevant information in the Body field.

3. Click Edit to save the changes.

4. To modify the files that are attached to the journal entry, do the following:

a. Select the journal entry whose attached files you want to modify.

b. Click Attached Files.

c. In the Journal Entry Files dialog box, select an attachment and
modify its description according to your needs.

d. Click Save. 

If necessary, you can also delete attached files by selecting them,
clicking Delete, and clicking Yes to confirm.

e. To close the Journal Entry Files dialog box, click the Close button (X)
in the upper-right corner.

Delete journal entries

1. In the Journal dialog box, select the journal entries that you want to
delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the journal entries, click Yes in the confirmation
dialog box.

View, print, and export project journal reports
You can create reports based on the existing journal entries. For example, you
can create a report containing all journal entries, or the authors of journal
entries. You can then view, print, or export the created reports.

Use the Reports command to create a report on all journal entries or journal
entries that match specific filters, or use the Reports - Selected command to
create a report on the journal entries that are currently selected in the Journal
dialog box.

Create a project journal report

1. In the Journal dialog box, click the Journal ribbon tab.

2. Do either of the following: 
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To Do this
Create reports on all
journal entries or
specific types of journal
entries

a. On the menu, select Reports.

b. To only create journal reports, at the bottom
of the Project Management Report Filters
dialog box, ensure that only the Journal
Entries checkbox is selected.

c. To only include specific types of journal entries
in the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

d. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the journal
entry properties that you want to include in
the report to the Included list.

• Type the maximum and minimum values
for the journal entries that you want to
include.

For example, define the earliest and latest
date for the journal entries that you want
to include.

e. Click OK.

To further limit the journal entries that are
included in the reports, repeat steps b to d for
all necessary filter types.

f. Click Make Report.
Create reports on the
currently selected
journal entries

a. On the menu, select Reports - Selected.

3. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the journal report

• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the journal report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.
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2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the journal report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

6. To open the file after exporting it, select the Open Exported Document
checkbox.

7. In the Report Selection dialog box, click Export.

Manage change orders
Change orders can be any changes made to the original contract that affect
the project schedule and costs. You can manage the change orders related to
the current project management project in the Change Order dialog box.

1. To open the Change Orders dialog box, do any of the following: 

• On the right side of the Project dialog box, click the Change Orders
button.

• On the Summary tab of the Project dialog box, click + in the upper-
right corner of the Change Orders section, and select which change
orders you want to see.
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The Change Order dialog box opens.

For more information, see the following links:

Create, modify, and delete change orders (page 684)

View change orders (page 690)

Print change orders (page 691)

View, print, or export change order reports (page 692)

Create, modify, and delete change orders
You can manage and record changes requested and made to the original
contract by using the Change Order dialog box. You can create new change
order requests, attach files or emails to change order requests, modify existing
change order requests, or delete change order requests.

NOTE The items in the Change Order dialog box are not change orders for contract
purposes. Instead, the items represent the change order requests made
regarding the project.
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Create a change order

1. At the bottom of the Change Order dialog box, click New.

2. Define the properties of the change order. 

The items that are marked with an asterisk (*) in the following table are
mandatory.

Option Description
CO # * The number of the change order.

Tekla PowerFab automatically populates the CO #
field with the next available number. You can
change the number, if needed.

CO Date * The date when the change order was sent.

Click the arrow on the right side of the CO Date
field, and select a date in the calendar.

To * The recipient company and person of the change
order.

Click the arrow on the right side of the leftmost To
list, and select the recipient company in the list.

Click the arrow on the right side of the rightmost
To list, and select the recipient in the list.

Note that only the companies that have been
added for the project in the Project Edit dialog box
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Option Description
and their contact persons are available in the To
lists.

Supplier The supplier that is affected by the change order.

Click the arrow on the right side of the Supplier
list, and select a supplier in the list.

Note that only the companies with the firm type
Supplier that have been added for the project in
the Project Management dialog box are available
in the Supplier lists.

Since the supplier is normally the fabricator, you
may need to copy your company as a supplier in
the project. For more information, see Manage
companies in the project (page 644).

Subject * The subject of the change order, visible in the
change order document.

Type the subject in the Subject field.
Description Of Change The description of the change that should be

made.

Type a description in the Description Of Change
field.

Change Has Added The number of calendar days, work days, weeks, or
months that the change has added to the project
duration. The time entered here will be displayed
in the project schedule.

In the Change Has Added field on the left, type the
desired number.

Then, right-click the Change Has Added field, and
select the unit of time in the list.

Change Will Cause The total sum that making the change will add to
the project costs or subtract from the project costs.

Type the costs in the Change Will Cause field.
Change Requested By The source that requested making the change. For

example, this can be a party in the project, a
document, or a response to an RFI.

Type a value in the Change Requested By field.
Request Date The date when the change was requested.

Click the arrow on the right side of Request Date
field, and select a date in the calendar.
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Option Description
Answered Date The date when the supplier has replied to the

change order.

Click the arrow on the right side of Answered Date
field, and select a date in the calendar.

Approved When selected, the change order has been
approved.

Remember to select the Approved checkbox when
the change order has been approved. When you
do so, the change order is sent to Contract &
Invoicing.

Sent Via * The method with which the change order has been
sent.

The options available in the Sent Via list are set in
the Sent Via Maintenance dialog box.

Click the arrow on the right side of the Sent Via
list, and select a sending method in the list.

Author * The Tekla PowerFab user who created the change
order.

Click the arrow on the right side of the Author list,
and select a user in the list.

Only the Tekla PowerFab users in your company
are available in the Author list.

Contract Item The item in the project contract that the change
order is linked to. For more information, see Add
and modify contract information (page 752).

The Contract Item field is not included in the
Change Orders dialog box by default. You can add
the Contract Item field by modifying the input
fields for change orders.

Click the arrow on the right side of Contract Item
list, and select the contract item.

3. To attach files to the new change order, do the following:

a. At the bottom of the dialog box, click Attached Files.

b. In the Change order dialog box, click New.

c. In the Document Index - Add Document Reference dialog box, add
a file, a Microsoft Outlook email, or Microsoft Outlook email
attachments. 

d. Click the arrow on the right side of the Change Order list, and select
the change order to which you want to attach the file.

e. Type a description for the attached file.
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f. Click Add Document Reference. 

Repeat steps c to g for all necessary attachments.

g. Click Save.

h. To close the Change order dialog box, click the Close button (X) in
the upper-right corner.

You can see the number of attached files in the upper-right corner of the
Change Order dialog box.

4. Click Save.

Modify a change order

1. In the Change Order dialog box, select the change order that you want to
modify.

2. Modify the properties of the change order: 

Option Description
CO # The number of the change order.

Tekla PowerFab automatically populates the CO #
field with the next available number. You can
change the number according to your needs.

CO Date The date when the change order was sent.

Click the arrow on the right side of the CO Date
field, and select a date in the calendar.

To The recipient company and person of the change
order.

Click the arrow on the right side of the leftmost To
list, and select the recipient company in the list.

Click the arrow on the right side of the rightmost
To list, and select the recipient in the list.

Note that only the companies that have been
added for the project in the Project Management
dialog box and their contact persons are available
in the To lists.

Supplier The supplier that is affected by the change order.

Click the arrow on the right side of the Supplier
list, and select a supplier in the list.

Note that only the companies with the firm type
Supplier that have been added for the project in
the Project Management dialog box are available
in the Supplier lists.
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Option Description
Subject The subject of the change order, visible in the

change order document.

Type the subject in the Subject field.
Description Of Change The description of the change that should be

made.

Type a description in the Description Of Change
field.

Change Has Added The number of calendar days, work days, weeks, or
months that the change has added to the project
duration. The time entered here will be displayed
in the project schedule.

In the Change Has Added field on the left, type the
desired number.

Then, click the arrow on the right side of the
Change Has Added list, and select the unit of time
in the list.

Change Will Cause The total sum that making the change will add to
the project costs or subtract from the project costs.

Type the costs in the Change Will Cause field.
Change Requested By The party that requested making the change.

Type a name in the Change Requested By field.
Request Date The date when the change was requested.

Click the arrow on the right side of the Request
Date field, and select a date in the calendar.

Answered Date The date when the supplier has approved or
rejected the change order.

Click the arrow on the right side of the Answered
Date field, and select a date in the calendar.

Approved When selected, the change order has been
approved.

Remember to select the Approved checkbox when
the change order has been approved, so that Tekla
PowerFab will not mark the change order as
overdue.

Sent Via The method with which the change order has been
sent.

The options available in the Sent Via list are set in
the Sent Via Maintenance dialog box.

Click the arrow on the right side of the Sent Via
list, and select a sending method in the list.
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Option Description
Author The Tekla PowerFab user who created the change

order.

Click the arrow on the right side of the Author list,
and select a user in the list.

Only the Tekla PowerFab users in your company
are available in the Author list.

3. To modify the files attached to the change order, do the following:

a. Select the change order.

b. At the bottom of the dialog box, click Attached Files.

c. In the Change order dialog box, select an attachment and modify its
description according to your needs.

d. Click Save to save the changes. 

If necessary, you can also delete attached files by selecting them,
clicking Delete, and clicking Yes to confirm.

To attach new files, see Create a change order.

e. To close the Change order dialog box, click the Close button (X) in
the upper-right corner.

Delete change orders

Note that deleting change orders is permanent and cannot be undone.

1. In the Change Order dialog box, select the change orders that you want
to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the change orders, click Yes in the confirmation
dialog box.

View change orders
You can view the currently selected change orders in Tekla PowerFab Report
Viewer by using the View Selected Change Orders command.

1. In the Change Order dialog box, select the change orders that you want
to view. 

To select multiple change orders, hold down Ctrl.

To select a range of subsequent change orders, hold down Shift.

2. Click the Change Orders ribbon tab.
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3. On the File menu, select View Selected Change Orders.

4. To display your company logo in the change order, in the View Change
Order dialog box, select the Show Company Logo (If Exists) checkbox. 

To add a company logo, see Manage Tekla PowerFab company
information (page 74).

5. Click View.

The selected change orders open in Tekla PowerFab Report Viewer.

In the Tekla PowerFab Report Viewer window, you can send the change
orders via email as either PDF files or Microsoft Excel worksheets, print the
change orders, or export the change orders and save them in another file
format.

See also

Print change orders (page 691)

View, print, or export change order reports (page 692)

Print change orders
You can print one or multiple change orders at one go using the Print
Selected Change Orders.

1. In the Change Order dialog box, select the change orders that you want
to print. 

To select multiple change orders, hold down Ctrl.

To select a range of subsequent change orders, hold down Shift.

2. Click the Change Orders ribbon tab.

3. On the menu, select Print Selected Change Orders.

4. On the Report Settings tab of the Print Change Order dialog box, select
the Show Company Logo (If Exists) checkbox to display your company
logo in the change order.

5. On the Printer Settings tab, type the number of copies to be printed in
the Copies field.

6. To set the printer, click Change Printer.

7. In the Select Printer dialog box, click a printer to select it.

8. Click OK.

9. In the Print Change Order dialog box, click Print.

See also

View, print, or export change order reports (page 692)
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View, print, or export change order reports
You can create reports based on the existing change orders. For example, you
can create a report of all change orders or a report on overdue change orders.
You can then view, print, or export the created reports.

Use the Reports command to create a report on all change orders or change
orders that match specific filters, or use the Reports - Selected command to
create a report on the change orders that are currently selected in the Change
Order dialog box.

Create a change order report

1. In the Change Order dialog box, click the Change Orders ribbon tab.

2. Do either of the following: 

To Do this
Create reports on all
change orders or specific
types of change orders

a. On the menu, select Reports.

b. To only create change order reports, at the
bottom of the Project Management Report
Filters dialog box, ensure that only the
Change Orders checkbox is selected.

c. To only include specific types of change orders
in the reports, in the Project Management
Report Filters dialog box, select a filter type in
the Type list, and click Select.

d. In the Filter dialog box, do one of the
following depending on the filter type:

• Click the arrow buttons to move the change
order properties that you want to include
in the report to the Included list.

• Type the maximum and minimum values
for the change orders that you want to
include.

For example, define the earliest and latest
dates for the change orders that you want
to include.

e. Click OK.

To further limit the change orders that are
included in the reports, repeat steps b to d for
all necessary filter types.

f. Click Make Report.
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To Do this
Create reports on the
currently selected
change orders

a. On the menu, select Reports - Selected.

3. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the change order report

• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the change order report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the change order report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

6. To open the file after exporting it, select the Open Exported Document
checkbox.

7. In the Report Selection dialog box, click Export.

Manage the project task list
The task list items in the Task List dialog box serve as reminders for the user
that they have been assigned project tasks. The items on your task list can also
be assigned to other users. If you have unfinished tasks on your task list, the
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Task List dialog box opens automatically when you sign in to Tekla PowerFab.
You can also access the Task List dialog box manually:

• Do either of the following: 

• On the right side of the Project dialog box, click the Task List button.

• On the Summary tab of the Project dialog box, click + in the upper-
right corner of the Task List section, and select which task list items you
want to see.

For more information, see the following links:

Create, modify, and delete task list items (page 694)

View, print, and export task list reports (page 696)

Create, modify, and delete task list items
Use the Task List dialog box to create, modify, and delete task list items. You
can add completion dates for tasks that have been completed, or re-assign
tasks to other Tekla PowerFab users.

Create a task list item

1. In the Task List dialog box, click New.

2. Define the task list item properties. 
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The items that are marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Author The Tekla PowerFab user that created the task list

item.

Click the arrow on the right side of the Author list,
and select a user in the list.

Assigned To The Tekla PowerFab user to whom the task list item
is assigned.

Click the arrow on the right side of the Assigned To
list, and select a user in the list.

Date Required The date by which the task list item should be
completed.

Click the arrow on the right side of the Date
Required field, and select a date in the calendar.

Date Completed The date when the task was completed.

Click the arrow on the right side of the Date
Completed field, and select a date in the calendar.

Description * The description of the task list item.

Type the task description in the Description field.

3. Click Add.

Modify a task list item

By modifying a task list item, you can change its properties. For example, add
completion dates for tasks that have been completed.

1. In the Task List dialog box, select the task list item that you want to
modify.

2. Modify the task list item properties: 

Option Description
Author The Tekla PowerFab user that created the task list

item.

Click the arrow on the right side of the Author list,
and select a user in the list.

Assigned To The Tekla PowerFab user to whom the task list item
is assigned.

Click the arrow on the right side of the Assigned To
list, and select a user in the list.
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Option Description
Date Required The date by which the task list item should be

completed.

Click the arrow on the right side of the Date
Required field, and select a date in the calendar.

Date Completed The date when the task was completed.

Click the arrow on the right side of the Date
Completed field, and select a date in the calendar.

Description The description of the task list item.

Type the task description in the Description field.

3. Click Edit to save the changes.

Delete task list items

Note that deleting task list items is permanent and cannot be undone.

1. In the Task List dialog box, select the task list items that you want to
delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click Delete.

3. To permanently delete the task list items, click Yes in the confirmation
dialog box.

View, print, and export task list reports
You can create a report out of the task list by using the Reports command in
the Task List menu. You can decide to include all tasks list items in the current
project, or only overdue or open task list items.

Create a task list report

1. In the Task List dialog box, click the Task List ribbon tab.

2. On the menu, select Reports.

3. To only create task list reports, at the bottom of the Project Management
Report Filters dialog box, ensure that only the Task List checkbox is
selected.

4. To only include specific types of task list items in the reports, in the
Project Management Report Filters dialog box, select a filter type in the
Type list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:
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• Click the arrow buttons to move the task list item properties that you
want to include in the report to the Included list.

• Type the maximum and minimum values for the task list item that you
want to include.

6. Click OK 

To further limit the task list items that are included in the reports, repeat
steps 3 to 5 for all necessary filter types.

7. Click Make Report.

8. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View, print, and export task list reports
You can create a report out of the task list by using the Reports command in
the Task List menu. You can decide to include all tasks list items in the current
project, or only overdue or open task list items.

View the task list report

• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the task list report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the task list report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.
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6. To open the file after exporting it, select the Open Exported Document
checkbox.

7. In the Report Selection dialog box, click Export.

Manage the project check list
Use the project check list to ensure that all steps in the current project are
completed. In the Check List dialog box, you can add previously created steps
to the project, or delete unnecessary steps.

• To access the project check list, do either of the following: 

• On the right side of the Project dialog box, click the Check List button.

• On the Summary tab of the Project dialog box, click + in the upper-
right corner of the Check List section, and select which check list items
you want to see.

For more information, see the following links:

Add check list items (page 698)

Modify a check list item (page 699)

Send check list items to the task list (page 699)

Delete check list items from a project (page 700)

View, print, or export check list reports (page 701)
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Add check list items
Use the Add Additional Check List Items to add previously created check list
items to the check list of the current project.

Note that to add new check list items, the items need to be created in the
Check List Item Maintenance dialog box.

1. In the Check List dialog box, click the Check List ribbon tab.

2. On the menu, select Add Additional Check List Items.

3. In the Add Check List Items dialog box, click the arrow buttons to move
the items that you want to include in the check list to the Included list.

4. Click Add.

The selected check list items are added to the Check List dialog box.

Now, you can modify the properties of the new check list items, such as its
status and required date.

See also

Modify a check list item (page 699)

Delete check list items from a project (page 700)

Send check list items to the task list
If necessary, you can send items in the project check list to the task list of a
Tekla PowerFab user that participates in the current project.

1. In the Check List dialog box, select the check list items that you want to
send to the task list. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Check List ribbon tab.

3. On the menu, select Move Selected Check List Items to Task List.

4. Click the arrow on the right side of the Assign To list in the Move To Task
List and select to which user you want to assign the check list items.

5. Click Move.

The items are moved to the task list of the selected user.

The Notes fields of the items show that the items have been sent to the task
list of the selected user.

See also

Manage the project task list (page 693)
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Modify a check list item
You can modify the properties of a check list item according to your needs. For
example, you might need to mark a check list item as completed, or modify
the date by which the item should be completed.

1. In the Check List dialog box, select the check list item that you want to
modify.

2. Modify the check list item properties: 

Option Description
Date Required The date by which the check list item should be

completed.

Click the arrow on the right side of the Date
Required field, and select a date in the calendar.

Status The completion status of the check list item. The
options are Completed, Not Completed, and N/A
(not applicable).

Click the arrow on the right side of the Status list,
and select a status option in the list.

Completed By The Tekla PowerFab user who completed the check
list item.

Click the arrow on the right side of the Completed
By list, and select a user in the list.

Date Completed The date when the check list item was completed.

Click the arrow on the right side of the Date
Completed field, and select a date in the calendar.

Notes Any relevant notes about the check list item.

Type any information in the Notes field.

3. Click Save.

See also

Add check list items (page 698)

Delete check list items from a project (page 700)

Delete check list items from a project
Use the Delete Selected Check List Items command to delete check list
items that are not necessary for the current project.

1. In the Check List dialog box, select the check list items that you want to
delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.
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2. Click the Check List ribbon tab.

3. On the menu, select Delete Selected Check List Items.

4. To permanently delete the check list items, click Yes in the confirmation
dialog box.

View, print, or export check list reports
You can create various check list reports by using the Reports command. For
example, you can create reports that show the statuses of the check list items
or the dates when the check list items have been completed.

Create a check list report

1. In the Check List dialog box, click the Check List ribbon tab.

2. On the menu, select Reports.

3. To only create check list reports, at the bottom of the Project
Management Report Filters dialog box, ensure that only the Check List
checkbox is selected.

4. To only include specific types of check list items in the reports, in the
Project Management Report Filters dialog box, select a filter type in the
Type list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the check list item properties that you
want to include in the report to the Included list.

• Type the maximum and minimum values for the check list items that
you want to include.

For example, define the earliest and latest completion date for the
check list items that you want to include.

6. Click OK 

To further limit the types of check list items that are included in the
reports, repeat steps 3 to 5 for all necessary filter types.

7. Click Make Report.

8. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the check list report

• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.
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Print the check list report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the check list report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

6. To open the file after exporting it, select the Open Exported Document
checkbox.

7. In the Report Selection dialog box, click Export.

8.4 View and adjust the project schedule
You can create, view, and modify the project schedule of the current project in
the Project Schedule dialog box.

To access the Project Schedule dialog box, do one the following:

To Do this
Access the project
schedule from the
Project Management
module

At the bottom of the Project Management dialog
box, click Project Schedule.

Access the project
schedule from the
Production Control
module

1. In the Production Control dialog box, click the
Production Control ribbon tab.

2. On the menu, select Project Schedule.
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NOTE You can access the Project Schedule dialog box from a production control job
only if you have linked the production control job to a project management
job.

The Project Schedule dialog box opens. The Schedule Tasks dialog box opens
at the same time as well.

The Project Schedule dialog box contains multiple tabs:

• Baseline Plan: Set and modify the current project baseline

• Schedule Tasks: Add, modify, move, and delete tasks that are on the
project schedule

• Project Breakdown: Divide a project into sub-tasks. Usually done by
sequence or lot number, but it can also be done by category, sub-category,
or pay category.

• Gantt Chart: View and modify the dates and completion percentages of
different tasks

Switch edit mode on and off
When working in the Project Schedule dialog box, you can only make changes
when you have the edit mode on. The edit mode ensures that Tekla PowerFab
users do not make conflicting changes if they work on the project schedule
simultaneously. While one has the edit mode on, no other user can make
changes to the project schedule of the same project. Other users can still view
the schedule.
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Any time that you try to make changes to a project schedule after the timeout
time has been reached, a confirmation dialog box will open, asking if you want
to enter edit mode.

You can also switch the edit mode on or off by using a keyboard shortcut. Do
the following:

• To switch the edit mode on, press Ctrl+E on the keyboard.

The edit mode will stay on until you press Ctrl+E again or the timeout time is
reached. The timeout ensures that a user does not lock out others from
making changes to the project schedule for a long period of time.

Create, modify, and delete baseline plans
A baseline plan is a listing of schedule tasks, dependencies, and estimated
dates, that demonstrates the intent of a project. The actual progress is
compared against the baseline plan.

A project can have multiple baseline plans, so that you can explore different
scenarios that show the effect that a change would have on the schedule. You
can set any baseline plan as the current plan of the project at any time.

You cannot create, modify, or delete baselines if you are viewing a snapshot.
For more information about snapshots, see View changes in the project
schedule and add savepoints (page 710).

Create a baseline plan
1. In the Project Schedule dialog box, go to the Baseline Plan tab.

2. Click New Baseline. 
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3. In the Description field, type a description for the baseline plan. 

The first baseline plan will automatically be named as Initial
Baseline, but you can modify the name according to your needs.

4. If you want to use the baseline plan as the current baseline plan, select
the Is Current Baseline Plan checkbox.
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5. If you want to assign resources to the baseline plan and include the
baseline plan in the production schedule, select the Include on
Production Schedule checkbox. 

If you do not want the baseline plan to be shown in the production
schedule and resource capacity, clear the Include on Production
Schedule checkbox. For example, this might be the case if the production
schedule is created only for quoting.

6. Click Add. 

The baseline is created. You can now further modify its properties.

7. To select the calendar that determines the working days and non-working
days in the project, click the arrow on the right side of the Calendar field
and select a calendar in the list. 

To modify the available calendars, go to Maintenance --> Project
Management --> Schedule Calendars .

8. Modify the remaining baseline properties according to your needs. 

Option Description
Assembly Quantity The total number of assemblies in the project. This

value is automatically updated when you update
the status of the project schedule.

Type the total number of assemblies in the
Assembly Quantity field.

Part Quantity The total number of parts in the project.

This value is automatically updated when you
update the status of the project schedule.

Type the total number of parts in the Part
Quantity field.

Weight The total weight of the materials in the project.
This value is automatically updated when you
update the status of the project schedule.

Type the total weight in the Weight field.

9. To define the available breakdown levels, click the arrows next to the
breakdown fields in the Project Breakdown section of the dialog box. 

By default, two levels of breakdown items (sequences and lot numbers)
are available. To make more levels available, select options in the
Breakdown Field 3, Breakdown Field 4, and Breakdown Field 5 lists. If
you do not want a breakdown level to be available, select None.

For example, to enable categories as the breakdown level below lots,
select Category in the Breakdown Field 3 list.

10. Click Save.
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Copy the current schedule status to baseline
When you have set a preliminary project schedule, you can set that as the
initial baseline.

1. On the Baseline Plan tab, click Set Baseline. 

2. In the confirmation dialog box, click Yes to set the baseline values.

The baseline is saved, and the baseline dates update in the blank columns.

See also 3. Set the baseline (page 738).
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Change the current baseline plan

• On the Baseline Plan tab, click the arrow on the right side of the Select a
Baseline Plan field, and select the desired baseline in the list.

The new baseline plan is displayed in the Project Schedule dialog box.

View the total values and breakdown information of the project
• To display the total values of the project, on the Baseline Plan tab, click the

arrow on the left side of Summary Totals.

• To display the breakdown information of a task, select a task on Baseline
Plan tab, and the click the arrow on the left side of Breakdown Summary. 

The number of breakdown items and the average assembly quantity, part
quantity, and weight are displayed for the selected task.

• To select if actual total values, baseline total values, or both are displayed
for the totals and the breakdown summary, click the arrow on the right side
of the Show Totals list, and select an option in the list.

Modify a baseline plan

1. On the Baseline Plan tab, click Baseline Properties.

2. In the Baseline Plan dialog box, modify the baseline plan properties
according to your needs. 
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For more information on the properties, see Create a baseline plan.

3. Click Save to save the changes.

Delete a baseline plan
Deleting a baseline plan is permanent and cannot be undone.

NOTE You need to have more than one baseline to delete one.

1. On the Baseline Plan tab, click the baseline plan that you want to delete.

2. Click Delete Baseline.
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3. In the confirmation dialog box, click Yes to permanently delete the
baseline.

View changes in the project schedule and add savepoints
Snapshots represent the baseline plan at previous points in time. Each time
you make a change to the project schedule, Tekla PowerFab automatically
takes a snapshot. You can then use the snapshots to compare the project
schedule at two different points in time and view the impacts of changing the
schedule. You can also load existing snapshots to view the project schedule at
a particular point in time. If you want to mark the snapshot as a particularly
important point in time, you can record it as a savepoint.

1. Click the arrow on the left side of Snapshots to expand the Snapshots
section. 

You can see the currently displayed snapshot after Currently Viewing
Snapshot. If you are viewing the current project schedule, the value will
be [Current].

2. Do any of the following: 

To Do this
Load a snapshot a. Click the arrow on the right side of the

Schedule Snapshot field, and select a
snapshot in the list.

If you only want the list to display the
savepoints that have been recorded, select the
Only Show Savepoints checkbox.

b. Click Load Snapshot.

The Project Schedule dialog box displays the
project schedule at the selected point in time.

To view the current project schedule again, in the
Schedule Snapshot list, select [Current].

Record a savepoint a. In the Project Schedule dialog box, make any
changes.

b. Click Record Savepoint.

c. In the first confirmation dialog box, click Yes to
save the changes you made.

d. In the second confirmation dialog box, click
Yes to confirm entering edit mode.

When you are in the edit mode, other users
cannot make conflicting changes to the project
schedule.

e. In the Snapshot: Edit Mode dialog box, type a
description for the savepoint.
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To Do this
f. Ensure that the Is Savepoint checkbox is

selected.

g. Click Save.

h. In the third confirmation dialog box, click Yes
to confirm entering edit mode.

This way, no other user can make conflicting
changes to the project schedule at the same
time.

Manage schedule tasks
Schedule tasks are events that occur or actions that are taken during a project.
In the Schedule Tasks dialog box, you can add, modify, and delete schedule
tasks. Tasks can be organized into a hierarchy that contains main tasks and
sub-tasks. In this case, the statuses of the main tasks are aggregated from the
sub-tasks.

Add a task to the project schedule
1. In Project Management, open a project. 

The Project dialog box opens.

2. Click Project Schedule. 

The Project Schedule dialog box opens.

3. Go to the Schedule Tasks tab.

4. Click New. 

The Schedule Tasks dialog box opens. The tasks already in the schedule
are displayed in the navigation tree on the left-hand pane.

5. Type a description for the new task.

6. Modify the task properties according to your needs: 

The available properties are:

Project Management 711 View and adjust the project schedule



Option Description
Parent Task If the task you are creating is a sub-task, for an

existing task, you need to select the main task.

Click the arrow on the right side of Parent Task
field, and select a task in the list. If you are creating
a top-level task, select None.

Note that you cannot modify the task type,
duration, or original estimate time of a main task if
you add a sub-task.

Task Type Specifies the behavior of the task on the Gantt
Chart tab. The available task types are:

• Start/End: an action to be performed over a
period of time. Properties include the start
date, end date, and duration.

Start/end tasks can be directly re-sized an
moved on the Gantt Chart tab.

• Summary: takes the aggregate values from its
sub-tasks. The start date of a summary task is
automatically set to the earliest date of the sub-
tasks. The end date is set to the latest sub-task
end date, and the percent completed is
aggregated based on the status summary
method.

Summary tasks cannot be re-sized on the Gantt
Chart tab directly. However, the sub-tasks can
be re-sized and moved, and the summary main
task will re-sized and moved accordingly.

• Milestone: an event in the schedule. For
example, a project kickoff meeting can be a
milestone task. The end date and the start date
are always the same, and the duration is set to
one day.

Sequence, Lot #, and
other breakdown
category checkboxes

When selected, the task is divided into sub-tasks by
the breakdown category. This means that you have
to add the breakdown category for all items when
adding them.

Note that the project breakdown checkboxes
cannot be selected or cleared when the task has
been added.

Apply Breakdown Links When selected, the links set in the project schedule
are added between sub-tasks. For example, any
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Option Description
links set between sequences 1, 2, and 3 would be
added.

When cleared, the links set between sub-tasks are
not added, even if they have been set in the project
schedule.

Duration The expected number of working days to complete
a task.

The duration can only be adjusted if the task type
is set to Start/End.

Type the number of days in the Duration field.
Original Estimate The time originally estimated for the entire main

task or a sub-task. The hours will automatically be
distributed among the sub-tasks on the Gantt
chart.

Type the time in hours in the Original Estimate
field.

Status Link The information that affects the status of the task
when the project schedule is updated. The
available options are:

• Drawings Approved: the number of drawings
with the Approved status.

• Material Purchased: the production material
that is linked to material that is either in stock
or on order.

• Material Received: the production material
that is linked to material that is in stock.

• TFS: the production material that has been cut.

• Production Completed: the production
material that has been assigned a route and
has completed all stations in that route.

• Production Progress: the production material
that has been assigned a route and has
completed some stations in that route.

• Station Progress: the production material that
has been assigned a route that includes the
selected station and has completed that
station.

• Shipping Destination Progress: the
production material that has been assigned a
shipping route that includes the selected
destination and has completed that destination.
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Option Description
• Shipping Completed: the production material

that has completed all assigned shipping
destinations.

Click the arrow on the right side of Status Link
field, and select an option in the list.

Status Summary
Method

The method that determines how the percentage
completed of a main task will be calculated from
the sub-tasks. Each option specifies the weight that
is given to each sub-task in the calculation. The
available options are:

• No Factor: no weight is given to the individual
sub-tasks. The percentage completed of the
main task is an average of the sub-tasks.

• By Quantity: the percentage completed is
weighed by the quantity of each sub-task.

• By Weight: the percentage completed is
weighed by the weight of each sub-task.

• By Duration: the percentage completed is
weighed by the duration of each sub-task.

Click the arrow on the right side of Status
Summary Method field, and select a calculation
method in the list.

Resource An object with a time-based capacity to be added
on a production schedule, and the resource by
which station work will be executed.

Linking a task from the project schedule to a
resource connects the project and production
schedules.

Click the arrow on the right side of Resource list,
and select a resource in the list.

Assigned To The Tekla PowerFab user that who task is assigned
to.

7. Click Add.

8. Select the new task in the navigation tree.

9. In the Link Tasks section of the dialog box, define dependencies between
two tasks. 

By creating links, you can make the schedule cascade from one task to
another.

NOTE • A task cannot link to itself.
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• A link cannot be created between a task and one of its sub-
tasks.

• Duplicate links are not allowed. There can be only one link
between a pair of tasks.

• Link cycles are not allowed. For example, if a link is created
from task 1 to task 2, a link cannot be created from task 2 to
task 1.

• When you use links, and the duration of an item changes, the
positions of all linked items also changes. Do not link items
that need to remain static, or are independent from other
items in the schedule.

Do any of the following:

To Do this
Add a link that ends with
the current given task

Note that if a previous snapshot is displayed
instead of the current project schedule
information, you cannot add a predecessor link.

a. Click New Predecessor Link.

b. Click the arrow on the right side of Link From
list, and in the list, select the starting task of
the link.

c. Click the arrow on the right side of upper
Position field, and in the list, select if the link
originates from the start or end of the starting
task.

d. Click the arrow on the right side of lower
Position field, and in the list, select if the link
ends at the start or finish of the second task.

e. In the Minimum Interval field, type the
minimum number of working days between
the two tasks.

The minimum interval is enforced in the Gantt
chart. The later task cannot be moved earlier
in the Gantt chart than the value in the
Minimum Interval field determines.

f. Click Add.

g. In the confirmation dialog box, click Yes.

For example, to define that shipping must start
when the fabrication is finished, select Shipping
and set the link a follows:

• Link From: Fabrication
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To Do this
• Upper Position: Finish

• Lower Position: Start

• Minimum Interval: 0 days
Add a link that begins
with the current task

Note that if a previous snapshot is displayed
instead of the current project schedule
information, you cannot add a successor link.

a. Click New Successor Link.

b. Click the arrow on the right side of the upper
Position field, and in the list, select if the link
originates from the start or end of the starting
task.

c. Click the arrow on the right side of the Link To
field, and in the list, select the task that is the
ending point of the link.

d. Click the arrow on the right side of the lower
Position field, and in the list, select if the link
ends at the start or finish of the second task.

e. In the Minimum Interval field, type the
minimum number of working days between
the two tasks.

The minimum interval is enforced in the Gantt
chart. The later task cannot be moved earlier
in the Gantt chart than the value in the
Minimum Interval field determines.

f. Click Add.

g. In the confirmation dialog box, click Yes.

For example, to define that shipping must start
when the fabrication is finished, select Fabrication
and set the link a follows:

• Upper Position: Finish

• Link To: Shipping

• Lower Position: Start

• Minimum Interval: 0 days
View and modify link
properties

a. Click Link Properties.

b. Modify the starting task, ending task, the task
positions, and interval according to your
needs.

c. Click Save to update the link properties.
Delete a link a. Click a link in the list to select it.
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To Do this
b. Click Delete Link.

c. In the confirmation dialog box, click Yes to
permanently delete the links.

10. To save the links, click Save.

11. If necessary, add notes about the task:

a. In the navigation tree on the left-hand pane, click the task to which
you want to add notes.

b. At the bottom of the dialog box, click Notes.

c. In the Notes dialog box, click New.

d. Type any notes about the task.

e. Click Add.

f. In the confirmation dialog box, click Yes.

g. Click the Close button (X) to close the Notes dialog box.

Repeat the process for each task that you want to add.

Move a task earlier or later in the schedule
1. Select the task that you want to move.

2. Click the Move Up and Move Down buttons to move the task earlier or
later.

Modify a task
1. In the navigation tree on the left-hand pane, click the task that you want

to modify.

2. Modify the task properties and links according to your needs. 

For more information on the properties and links, see Add a link to the
project schedule.

3. Click Save to save the changes.

Delete a task
1. In the navigation tree on the left-hand pane, click the task that you want

to delete from the schedule.

2. Click Delete Task.

3. In the confirmation dialog box, click Yes to permanently delete the task.
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Save schedule tasks as a schedule template
Schedule templates can contain all of the schedule items and attributes
required for a typical setup. By saving a set of schedule tasks as a schedule
template, you can apply the same schedule tasks in multiple jobs. The times
and other details can be modified for each project, but the tasks, child tasks,
and links remain the same.

1. In the Schedule Tasks dialog box, modify the schedule tasks to meet your
needs. 

For more information, see Manage schedule tasks (page 711).

2. Click the Schedule Tasks ribbon tab.

3. On the menu, select Save As Template.

4. Type a description for the template.

5. Click OK to save the template. 

A message opens, telling you that the template is saved.

6. Click OK to close the message.

Add, modify, and delete breakdown items
Schedule breakdown items allow you to divide a project into sub-tasks to
schedule and track the completion of tasks. Sequences and lots are often used
as breakdown items, so that tasks can be performed for each sequence and
lot separately. You can add new breakdown items, modify existing ones,
change the priorities of breakdown items, and delete any unnecessary
breakdown items.
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Add a new breakdown item
Note that if you cannot add new breakdown items if you are currently viewing
a snapshot. For more information, see View changes in the project schedule
and add savepoints (page 710)

1. On the Project Breakdown tab of the Project Schedule dialog box, click
New. 

2. In the Schedule Breakdown Item dialog box, define properties for the
new breakdown item. 

Option Description
Parent Breakdown
Item

If the breakdown item you are creating is a sub-
item for another existing breakdown item, you
need to select the main breakdown item.

Click the arrow on the right side of Parent
Breakdown Item field, and select a breakdown
item in the list. If you are creating a top-level
breakdown item, select None.

Note that the main breakdown item cannot be
changed after the breakdown item is added.

Sequence, Lot #,
Category, Sub-
Category, Pay Category

The breakdown value that associates the
breakdown item with the relevant project data.

Note that the breakdown value must match the
project data exactly. For example, the sequence
number in the Sequence field must be exactly the
same as in the production control job. Otherwise,
the project data cannot be updated properly.

Type the breakdown value in the field.
Description The description of the breakdown item. For

example, First floor beams and columns.

Type a description in the Description field.
Include in Task
Description

When selected, the breakdown item description
will be included in the task description in addition
to the breakdown value.

For example, if the description of sequence 6 is
Third Floor Beams, and the Include in Task
Description checkbox is selected, the description
of the resulting task in the Gantt chart will be
Sequence: 6 - Third Floor Beams. Instead, if
the Include in Task Description checkbox is
cleared, then the description of the task in the
Gantt chart will be Sequence: 6.
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Option Description
Assembly Quantity The total number of assemblies associated with

the breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total number of assemblies in the
Assembly Quantity field.

Part Quantity The total number of parts associated with the
breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total number of parts in the Part
Quantity field.

Weight The total material weight associated with the
breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total weight in the Weight field.

3. Click the Apply to Tasks tab to open it.

4. To select the schedule tasks to which the breakdown item is applied, do
one of the following:

• To apply the breakdown item to all schedule tasks, select the All
checkbox.

• To only apply the breakdown item to specific schedule task, click
Select, use the arrow buttons to move the desired tasks to the
Included list, and click OK.

When you apply the breakdown item to a task, the task becomes a
summary task with sub-tasks automatically created under it for each sub-
item.

5. Do any of the following to determine which links will be applied between
the sub-tasks:

a. According to your needs, do one of the following: 

• To create a link from the previous breakdown item to the current
one, select the Link from Previous Breakdown Item checkbox.

The Link from Previous Breakdown Item cannot be selected if
the current breakdown item is the first breakdown item or the first
sub-item under a main breakdown item.

• To create a link from any previous breakdown item with the same
main breakdown item to the current one, click the arrow on the
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right side of the Link from Specific Breakdown Item field, and
select a breakdown item in the list.

Links will be created from the sub-task associated with that
breakdown item.

b. Click the arrow on the right side of the Link Type field and select a
link type in the list. 

The options are:

• Start-Start

• Finish-Start

• Start-Finish

• Finish-Finish

c. In the Minimum Interval field, type the minimum number of
working days between the two sub-tasks.

For example, to create a link from the start of a sequence to the start of a
second sequence, the second sequence starting 5 working days after the
previous one, you should set the link details as follows:

• Link Type: Start-Start

• Minimum Interval: 5 days
6. Click Add.

The breakdown item and its link details are added to the project schedule. You
can see the breakdown item in the navigation tree on the left side of the dialog
box.

Modify a breakdown item
You cannot modify breakdown items if you are currently viewing a snapshot.
For more information, see View changes in the project schedule and add
savepoints (page 710).

1. On the Project Breakdown tab of the Project Schedule dialog box, click
the breakdown item that you want to modify.

2. Click Properties.

3. Modify the properties of the breakdown item according to your needs: 

Option Description
Sequence, Lot #,
Category, Sub-
Category, Pay Category

The breakdown value that associates the
breakdown item with the relevant project data.

Note that the breakdown value must match the
project data exactly. For example, the sequence
number in the Sequence field must be exactly the
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Option Description
same as in the production control job. Otherwise,
the project data cannot be updated properly.

Type the breakdown value in the field.
Description The description of the breakdown item. For

example, First floor beams and columns.

Type a description in the Description field.
Include in Task
Description

When selected, the breakdown item description
will be included in the task description in addition
to the breakdown value.

For example, if the description of sequence 6 is
Third Floor Beams, and the Include in Task
Description checkbox is selected, the description
of the resulting task in the Gantt chart will be
Sequence: 6 - Third Floor Beams. Instead, if
the Include in Task Description checkbox is
cleared, then the description of the task in the
Gantt chart will be Sequence: 6.

Assembly Quantity The total number of assemblies associated with
the breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total number of assemblies in the
Assembly Quantity field.

Part Quantity The total number of parts associated with the
breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total number of parts in the Part
Quantity field.

Weight The total material weight associated with the
breakdown item. This value is automatically
updated when you update the project schedule
status.

Type the total weight in the Weight field.

4. Click the Apply to Tasks tab to open it.

5. To modify the schedule tasks to which the breakdown item is applied, do
one of the following:

• To apply the breakdown item to all schedule tasks, select the All
checkbox.
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• To only apply the breakdown item to specific schedule task, click
Select, use the arrow buttons to move the desired tasks to the
Included list, and click OK.

6. Do the following to modify which links will be applied between the sub-
tasks:

a. Do one of the following: 

• To create a link from the previous breakdown item to the current
one, select the Link from Previous Breakdown Item checkbox.

The Link from Previous Breakdown Item cannot be selected if
the current breakdown item is the first breakdown item or the first
sub-item under a main breakdown item.

• To create a link from any previous breakdown item with the same
main breakdown item to the current one, click the arrow on the
right side of the Link from Specific Breakdown Item field, and
select a breakdown item in the list.

Links will be created from the sub-task associated with that
breakdown item.

b. Click the arrow on the right side of the Link Type field and select a
link type in the list. 

The options are:

• Start-Start

• Finish-Start

• Start-Finish

• Finish-Finish

c. In the Minimum Interval field, type the minimum number of
working days between the two sub-tasks.

7. Click Save to update the breakdown item properties.

Change the priority of a breakdown item
Moving breakdown items up or down in the list changes their priority. If you
move a breakdown item up, its priority is swapped with the previous
breakdown item, whereas if you move a breakdown item down, its priority is
swapped with the following breakdown item. For example, moving an item
with the priority 1.3 up would change its priority to 1.2.

You cannot move breakdown items up or down if you are currently viewing a
snapshot. For more information, see View changes in the project schedule and
add savepoints (page 710).

1. On the Project Breakdown tab of the Project Schedule dialog box, click
the breakdown item that you want to move.
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2. Click the Move Up and Move Down buttons.

3. In the confirmation dialog box, click Yes to confirm moving the breakdown
item.

Delete a breakdown item
Note that deleting a breakdown item is permanent and cannot be undone. All
sub-items of the selected breakdown item are deleted as well.

You cannot delete a breakdown item if you are currently viewing a snapshot.
For more information, see View changes in the project schedule and add
savepoints (page 710).

1. On the Project Breakdown tab of the Project Schedule dialog box, click
the breakdown item that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
breakdown item.

Modify the Gantt chart
The chart on the Gantt Chart tab of the Project Schedule dialog box gives
you a visual representation of the schedule. You can modify the view of the
Gantt chart according to your needs by including and excluding items, and
scaling the chart. You can also move the tasks in the Gantt chart to move them
earlier or later in the project schedule.

To modify the Gantt chart, do the following:

1. In the Project Schedule dialog box, click the Gantt Chart tab to open it.
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2. To enable modifying the information, click Enter Edit Mode in the lower-
left corner, or press Ctrl+E on the keyboard.

In the Gantt chart, you can see the following information:

• The left side of the tab shows the properties of schedule tasks.

• The right side of the tab shows the schedule tasks visually as bars on the
time line.

The tasks look different and behave differently depending on their task
type:

• Summary tasks (or main tasks) are displayed as orange bars. A
summary task cannot be re-sized directly. Instead, you can re-size and
move the sub-tasks to change the duration or dates of the summary
task. When a summary task is moved earlier or later, the sub-tasks are
moved by the same number of days.

• Start/End tasks are displayed as blue bars. Start/End tasks can be re-
sized and moved in the Gantt chart.

• Milestone tasks are displayed as blue diamonds. Milestones can be
moved in the Gantt chart, but they cannot be re-sized.

• Links between tasks are represented by arrows from the predecessor tasks
to the successor tasks.

• Any cells that are highlighted with yellow can be modified.

Right-click anywhere in the Gantt chart to find shortcuts to more commands:

• Goto Task zooms to the beginning of the bar of the selected task.
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• Time Tracking Summary opens the Time Tracking Summary dialog box.
For more information, see Manage time-tracking information (page 741).

• Time Tracking Detail opens the Time Tracking Detail dialog box. For
more information, see Manage time-tracking information (page 741).

• Time Tracking Input opens the New Time Tracking Record dialog box.
For more information, see Manage time-tracking information (page 741).

• Production Schedule allows you to view the production schedule. For
more information, see View the production schedule (page 886).

• Date Filter allows you to select a date range that you want to see in the
Gantt chart. When you apply the filter, tasks that are at least partially within
the entered date range will be visible.

• Scale chart to options: scale the Gantt chart to day, week, or month,
according to your needs.

• Show Links/Hide Links shows or hides the links between tasks.

• Show Overview/Hide Overview shows or hides the overview section
above the Gantt chart.

• Expand All expands all summary tasks so that all sub-tasks are visible.

• Expand Summary expands the task hierarchy so that all summary tasks
are visible. Sub-tasks are not displayed.

• Expand Level expands the selected task and other tasks with the same
main task.

• Collapse All collapses all summary tasks.

• Save Image allows you to save the Gantt chart as a single image file.

Modify the dates of tasks
1. Do one of the following:

• Click the Start or End cell of the task, and select a date in the calendar.

• Click the task bar, hold down the left mouse button, drag the task
earlier or later in the schedule, and release the left mouse button.

Note that:

• If the task has one or more predecessor links, the bar cannot be
moved earlier than the predecessor tasks and link intervals determine.

• If the task has one or more successor links, when the task is moved
later, the successor tasks will also be moved later, if that is necessary
to maintain the link interval.

Repeat this process for all tasks to move them in the correct locations.

2. Click Save.
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Modify the duration of tasks
1. Do one of the following:

• Click the Duration cell of the task and type a new value in the cell.

• Move the mouse pointer over the beginning or the end of the task bar
until a two-headed arrow appears, drag the start or end position of the
bar earlier or later, and release the mouse button.

Note that:

• If the task has one or predecessor links, the bar cannot be changed to
start earlier than the predecessor tasks and link intervals determine.

• If the task has one or more successor links, when the task is changed
to end earlier, any successor tasks will be moved earlier by the same
number of days in order to keep their relative position the same.

• If the task has one or more successor links, when the task is changed
to end later, the successor tasks will be moved later, if that is
necessary to maintain the link interval.

2. Click Save.

Modify task properties
On the left side of the Gantt chart, you can modify the task properties, such as
the duration, completion percentage, or used resource.

Note that only cells that are highlighted with yellow can be modified.

1. On the left side of the dialog box, click a cell of the task.

2. Modify the value in the cell according to your needs.

3. Click Save to update the project schedule.

Modify display settings
1. Click the arrow on the right side of Gantt Chart Display Settings to

expand the display settings. 

2. Modify the following options according to your needs: 
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Option Description
Task ID The unique identifier of the task in the project

schedule.
Baseline Start Date,
Baseline End Date

The start and end dates of the task when the
baseline was set.

If the baseline has not been set, the BL Start and
BL End cells are blank.

Baseline Duration The duration of the task when the baseline was
set.

If the baseline has not been set, the BL Duration
cells are blank.

Baseline Quantity The quantity of the task when the baseline was set.

If the baseline has not been set, the BL Quantity
cells are blank.

Baseline Weight The weight of the task when the baseline was set.

If the baseline has not been set, the BL Weight
cells are blank.

Baseline Planned
Hours

The total planned hours of the task when the
baseline was set.

If the baseline has not been set, the BL Hours cells
are blank.

Actual Start Date The actual start date of the task in the project
schedule.

To change the start date, click the arrow on the
right side of the Start cell, and select a date in the
calendar.

When you change the start date, the task will move
to the selected date in the Gantt chart. The
duration of the task will remain the same, so the
task will not be resized.

Actual End Date The actual end date of the task in the project
schedule.

To change the end date, click the arrow on the right
side of the End cell, and select a date in the
calendar.

When you change the end date, the duration of the
task will change accordingly in the Gantt chart, and
the task will be re-sized.
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Option Description
Actual Duration The actual duration of the task in the project

schedule.

To change the duration, type a new value in the
Duration cell.

When you change the duration, the end task of the
task will change accordingly in the Gantt chart, and
the task will be re-sized.

Actual Quantity The quantity related to the task in the bill of
materials.

This value is set when you update the project
schedule (page 733).

Actual Weight The weight related to the task in the bill of
materials.

This value is set when you update the project
schedule (page 733).

Percent Completed The percentage of the task that is completed.

To change the percentage, click the % Comp cell
and type a percentage in the cell.

When you change the percentage, the percentage
completed of the main tasks will automatically be
updated based on the summary status method
task setting. For more information, see Manage
schedule tasks (page 711).

Original Estimate The number of original estimate hours applied to
the task.

If the task is divided by sequences, lots, or other
breakdown fields, the hours will be distributed to
the resulting tasks on the Gantt Chart, weighed by
duration.

To adjust the original estimate hours, click the
Orig. EST cell and type the number of hours in the
field.

When you adjust the original estimate hours, the
adjusted number of hours will appear in italics in
the Gantt Chart. The remaining hours will be
redistributed among the tasks that have not been
manually adjusted. You can return to the
automatic distribution of hours by clearing the
value in the Orig. EST cell.
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Option Description
Unreleased Hours The number of original estimate hours that have

not yet been released, calculated by the Percent
Released value.

For example, if the original estimate is 500 hours
and the task is 20% released, the number of
unreleased hours will be 400.

Planned Hours (Base
Hours)

The planned hours that have been released.

Tasks that have the Status Link option selected
will have this field updated automatically when the
project schedule status is updated (page 733). For
more information, see Manage schedule tasks
(page 711).

Adjustment Hours Allows you to manually adjust the planned hours.

To adjust the number of planned hours, click the
Adjustment cell, and type a value.

Percent Released The percentage of the original estimate hours that
have been released and that appear in the Base
Hours field. This field will update automatically
when the planned hours are updated.

For example, if the original estimate is 500 hours
and the planned hours is updated to 100 hours,
the percentage released is 20%. This will in turn
update the unreleased hours to 400.

Once all material associated with a task has been
released, the percent released may need to be
manually adjusted, so that no further unreleased
hours are included in the total planned hours. Let's
say that a task is broken out into 4 sequences and
the original estimate is 2,000 hours. If all 4
sequence tasks have the same duration, each one
will receive 500 of the original estimate hours. The
drawings are submitted for sequence 1, and after
the next status update, the planned hours are set
to 100 hours, which will update the percent
released to 20%. Since Tekla PowerFab does not
know if all of sequence 1 has been received, the
remaining unreleased hours will still be included in
the total planned hours calculation. If everything
has in fact been received for sequence 1, you can
manually set the percent to 100%, so that no
further unreleased hours will be included in the
total planned hours.

To adjust the percentage, click in the % Released
cell, and type a percentage in the cell. When you
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Option Description
manually adjust the released hours, the number
will appear in italics. When you have manually
adjusted the percentage released, the value will
not be automatically adjusted according to any
changes made to the planned hours. To return to
the automatic calculated value, clear the value in
the cell.

Total Planned Hours
(Plan Hours)

The total number of the unreleased hours, planned
hours, and adjustment hours for the task.

Linked Hours The number of hours updated according to the
Status Link option. For example, the Production
Progress, Production Completed, and Station
Progress options will update the linked Linked
Hours with the hours entered in Piece Tracking.
For more information, see Manage schedule tasks
(page 711).

To adjust the number of linked hours, click the
Linked Hours cell, and type the number of hours.

Regular Hours The regular hours associated with the task, entered
in time tracking. For more information, see Manage
time-tracking information (page 741).

Overtime Hours The overtime and double overtime hours
associated with the task, entered in time tracking.
For more information, see Manage time-tracking
information (page 741).

Total Hours The total hours worked on the task, coming from
either the linked hours or the regular and overtime
hours from time tracking.

To ensure that the time is not duplicated, the time
tracking hours override the linked hours. If the
number of either regular or overtime hours is
greater than zero, the total hours will be set to the
regular hours plus the overtime hours. If the
number of both regular and overtime hours is
zero, the total hours will be set to the linked hours.

Utilization Percent The utilization percentage is calculated as the
percentage of the total hours compared to the
total planned hours.

For example, if the number of total planned hours
is 500 and the number of total hours is 200, the
utilization percentage will be 40%.

If the utilization percentage is over 5% greater than
the percentage of the task completed, the
utilization percentage will be highlighted in red. In
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Option Description
this example, if the percent completed is 35% or
less, the utilization percentage of 40% will be
highlighted in red.

Assigned to User The user who is responsible for the task. For more
information, see Manage schedule tasks
(page 711).

To change the assigned user, click the arrow on the
right side of the Assigned To cell and select a user
in the list.

Resource The resource that the task has been assigned to for
production scheduling purposes. For more
information, see Manage schedule tasks (page 711)
andView the production schedule (page 886).

To change the resource, click the arrow on the right
side of the Resource cell and select a resource in
the list.

Predecessors The linked tasks that are immediate predecessors
of the task.

Successors The linked tasks that are immediate successors of
the task.

Show Links When selected, Tekla PowerFab shows task links as
arrows in the Gantt chart.

Show Overview When selected, Tekla PowerFab shows the
overview section above the Gantt chart.

Show Baseline Bars When selected, Tekla PowerFab shows the baseline
dates as a yellow bar on the Gantt chart as set
when the baseline was set.

The baseline overlay bars will not be shown if:

• The baseline has not been set.

• The task has the same start and end dates as
the baseline dates.

• The task has been added after the baseline was
set.

3. Click Save to update the Gantt chart.

Print a Gantt chart report
You can create and print a report that is an exact copy of the Gantt chart. Note
that all content that you have selected in the Gantt Chart Display Settings
section will be visible in the report as well.

1. In the lower-right corner of the Gantt Chart tab, click Report.
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2. In the Print Review dialog box, click Setup... and adjust the paper size,
orientation, margins, and printer properties according to your needs.

3. Click Print.

4. When the report has been printed, click Close to close the Print Review
dialog box.

Apply a schedule template
Schedule templates can contain all of the schedule items and attributes
required for a typical setup. Existing schedules can be saved as templates, and
then applied to a new job using the Apply Template button. The schedule can
always be modified to fit the project requirements.

1. Open the Schedule Tasks dialog box.

2. In the lower-right corner, click Apply Template.

3. In the Enter Value dialog box, click the arrow on the right side of the field,
and select the schedule template that you want to use.

4. Click OK. 

The schedule template is now applied to the project schedule.

5. Click the Close button (X) to close the Schedule Tasks dialog box.
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Update the project schedule
When you update a project schedule, Tekla PowerFab collects all time and
progress status information on the current project in Production Control,
Project Management, and Purchasing. Once the update process is ready, all
activity is updated to the chart on the Gantt Chart tab. For example, if
drawings have been submitted and approved, the percentage completed for
drawing submittal will be updated.

You can see the last time the project schedule was updated in the upper-right
corner of the Project Schedule dialog box, after Last Status Update.

1. In the upper-right corner of the Project Schedule dialog box, click Update
Status. 

The Status Update dialog box opens, displaying the progress of the
update process.

2. Once the update is completed, click the Close button (X) to close the
Status Update dialog box.

Export the project schedule to XML format
You can export the project schedule and save it in the desired folder as an XML
file. You can select from two XML options: either the option used in Primavera,
or the option used in Microsoft Projects.

1. In the Project Schedule dialog box, click the Project Schedule ribbon tab.

2. On the menu, select Export, and then, select the preferred XML option.
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3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

The project schedule is saved in the selected location as an XML file.

Create a project schedule report
You can create different project schedule reports according to your needs. You
can either view the completion percentage and duration of the schedule tasks,
or compare the changes made to schedule tasks from one baseline plan to
another.

1. In the Project Schedule dialog box, click the Project Schedule ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. Click the arrow on the right side of the Baseline Plan field of the
Schedule Report dialog box, and select the baseline plan that you want to
use in the report.

4. If you wish, add a snapshot of the selected baseline plan to the report by
clicking the arrow on the right side of the Snapshot field, and selecting a
snapshot in the list. 

If you only want to select from snapshots marked as savepoints, select the
Only Show Savepoints checkbox.

5. If you want to compare two different versions of the project schedule, do
the following:

a. Select the Run Comparison Report checkbox.

b. Click the arrow on the right side of the lower Baseline Plan field, and
select a baseline plan in the list.

c. Click the arrow on the right side of the lower Snapshot list, and select
a snapshot in the list. 

To be able to compare two versions of a project schedule, ensure that
you select a different baseline plan and snapshot than in the lists
above.

6. Click Make Report.

7. In the Report Selection dialog box, click the report that you want to view,
print, or export. 

For comparison, click the Comparison Report to view the tasks that have
changed between the two baseline plans.

8. According to your needs, do any of the following: 
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To Do this
View the report • In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report
Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the report a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. In the confirmation dialog box, click Yes to
confirm printing the report.

d. In the Select Printer dialog box, click a printer
to select it.

e. Click OK.
Export the report a. In the Report Selection dialog box, click

Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. Click Save.

g. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

h. To open the file after exporting it, select the
Open Exported Document checkbox.

i. In the Report Selection dialog box, click
Export.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.
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Example: Create a project schedule
The following steps provide an example workflow for creating a project
schedule in the Project Schedule dialog box.

1. Apply a schedule template
Schedule templates can contain all of the schedule items and attributes
required for a typical setup. Existing schedules can be saved as templates, and
then applied to a new job using the Apply Template button. The schedule can
always be modified to fit the project requirements.

1. Open the Schedule Tasks dialog box.

2. In the lower-right corner, click Apply Template.

3. In the Enter Value dialog box, click the arrow on the right side of the field,
and select the schedule template that you want to use.

4. Click OK. 

The schedule template is now applied to the project schedule.

5. Click the Close button (X) to close the Schedule Tasks dialog box.

2. Modify the schedule dates
1. Open the Gantt Chart tab. 
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2. Click Enter Edit Mode. 

Any information that is highlighted with yellow can be modified.

3. To modify what is shown in the chart, click the arrows on the left side of
Gantt Chart Display Settings and select the checkboxes for items that
you want to show. 

For more information on the display settings, see Modify the Gantt chart
(page 724).

4. Click Save to update the view. 

You can also modify if the chart displays time as days, weeks, or months.
To do so, right-click anywhere in the chart, and select the suitable Scale
chart to option.

5. To modify the dates of tasks in the chart, do one of the following:

• Click the Start or End cell of the task, and select a date in the calendar.

• Click a task, hold down the left mouse button, drag the task to the right
location, and release the left mouse button.

Repeat this process for all tasks to move them in the correct locations.

6. Click Save.

3. Set the baseline
When tasks have been moved to the desired dates, you need to set the project
baseline. You can later compare the baseline duration to the actual duration
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during the project. The baseline also sends information to the production
schedule.

If you have modified the dates on the Gantt Chart tab, you can set the
baseline easily. Do the following:

1. Click the Baseline Plan tab to open it.

2. Click Set Baseline.

3. In the confirmation dialog box, click Yes to set the baseline values.

The baseline is saved, and the baseline dates update in the blank columns.

4. Add project breakdown information
Use the Project Breakdown to divide a project into sub-tasks in order to
schedule and track the completion of the task. For example, if your project has
sequences and lot numbers, they should be added as breakdown items. You
can also apply the breakdown items to the desired schedule tasks and link the
breakdown items to each other.

For more information, see Add, modify, and delete breakdown items
(page 718).

1. Open the Project Breakdown tab.

2. Click New.

3. In the Schedule Breakdown Item dialog box, enter the exact sequence
number in the Sequence field.
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4. If necessary, add a description or other information about the breakdown
item.

5. Click Add. 

Repeat steps 2 to 5 for all sequences.

6. To add a lot, do the following:

a. Click New.

b. Click the arrow on the right side of the Parent Breakdown Item field,
and select a sequence in the list.

c. In the the Lot # field, type the exact lot number.

d. Add a description or other information about the lot.

e. Click Add.

Repeat steps a to e for all necessary lots.

8.5 Define time-tracking settings
You can define the settings that control adding and modifying time-tracking
records in the Time Tracking Settings dialog box.

1. Click the Maintenance ribbon tab.

2. On the menu, select Time Tracking Settings.

3. On the Standard Fields tab of the Time Tracking Settings dialog box,
modify the included fields as follows:
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a. If you want to display a field when adding a time-tracking record and
allow the user to type information to the field, select the Show Field
checkbox next to the field.

b. If you want to make the field mandatory, select the Required
checkbox. 

The user needs to type information in a required field in order to add
a time-tracking record.

c. To change the title of the field in the New Time Tracking Record
dialog box, type a new name in the Title field.

Repeat steps a to c for all necessary fields.

4. On the User Defined Fields tab, define any custom fields as follows:

a. If you want to display a field when adding a time-tracking record and
allow the user to type information to the field, select the Show Field
checkbox next to the field.

b. If you want to make the field mandatory, select the Required
checkbox. 

The user needs to type information in a required field in order to add
a time-tracking record.

c. To name the field, type a name in the Title field.

Repeat steps a to c to create all necessary fields.

5. To enable adding a time-tracking record without start and end time, on
the Input Settings tab, select the Allow date entry only (without time)
checkbox.

6. On the Input Settings tab, select how Tekla PowerFab calculates the time:

• Compute start time from end time and hours: When you change
the times of an input record, the start time is automatically calculated
according to the end time and the total hours.

• Compute end time from start time and hours: When you change
the times of an input record, the end time is automatically calculated
according to the start time and the total hours.

• Compute hours from start time and end time: When you change
the start or end time, the regular hours are automatically calculated.

Note that you can select either Compute start time from end time and
hours or Compute end time from start time and hours, not both.

7. To save the time-tracking settings, click Save.
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8.6 Manage time-tracking information
You can add new time-tracking records to a project schedule, view and modify
the existing time-tracking records, and import time-tracking records.

To adjust the time-tracking settings, see Define time-tracking settings
(page 740).

Add a time-tracking record
1. To access time-tracking data , use one of the following methods:

• To enter information for any project, go to Maintenance --> Time
Tracking --> Time Tracking Input

• To enter information for a specific project, go to the Project
Management module:

a. Click Project Schedule.

The Select Project dialog box opens.

b. Select the project, use the arrow to move it to the Included box,
and click OK.

The Project Schedule dialog box opens.

c. In the Project Schedule ribbon tab, select Time Tracking Input

Alternative: On the Gantt Chart tab, select an item and right-click
it. In the menu that opens, select Time Tracking Input.

• You can also enter information for a specific project from the
Production Control module:

a. Select a project.

b. In the Production Control ribbon tab, select Project Schedule

c. In the Project Schedule ribbon tab, select Time Tracking Input

Alternative: On the Gantt Chart tab, select an item and right-click
it. In the menu that opens, select Time Tracking Input.
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The New Time Tracking Record dialog box opens.

2. In the dialog box, define the following properties: 

Option Description
Employee The Tekla PowerFab user who is adding the record.

Tekla PowerFab automatically uses the user that is
logged in, but you can select another user as well.

Note that the Employee field is optional. If you do
not want the hours entered to be applied to a
specific employee, you can leave the field blank.

Click the arrow on the right side of Employee field,
and select a user in the list.

Project The project management job for which you are
adding the time record.

Click the arrow on the right side of Project field,
and select a project management job in the list.

Task The schedule task for which you are adding the
time record.

The Task field is optional. If you leave the field
blank, the time record will be applied to the project
as a whole.

Click the arrow on the right side of Task field, and
select a schedule task in the list.
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Option Description
Station The station for which you are adding the time

record.

The Station field is optional. If you leave the field
blank, the time record will be applied to the project
as a whole.

Click the arrow on the right side of Station field,
and select a station in the list.

Sequence The sequence for which you are adding the time
record.

The Sequence field is optional. If you leave the
field blank, the time record will be applied to the
project as a whole.

Click the arrow on the right side of Sequence field,
and select a sequence in the list.

Lot # The lot for which you are adding the time record.

The Lot # field is optional. If you leave the field
blank, the time record will be applied to the project
as a whole.

Click the arrow on the right side of Lot # field, and
select a lot number in the list.

3. Click the arrows on the right side of the Start and End fields, and select
the start and end dates and times in the calendar. 

Tekla PowerFab automatically calculates the number of working hours.
The calculation method that is used can be set in Time Tracking Settings.

4. If necessary, modify the working hours according to your needs:

a. In the Regular field, type the time that will be logged as regular hours
for the project, task, station, sequence, or lot.

b. In the OT and OT2 fields, type the time that will be logged as overtime
and double overtime hours for the project, task, station, sequence, or
lot.

c. In the Deduction field, type the time used for unpaid activities, such
as lunch. This time will not be logged against the project, task, station,
sequence, or lot.

If the start and end times and the hours that you added do not match,
you can adjust the difference by double-clicking the field where you added
hours. For example, if the difference between the start and end time is 2
hours and you enter 1.50 for regular hours, double-clicking the OT field
sets its value to 0.50.

If the total hours are less than the difference between the start and end
time, the difference is automatically added as deduction hours.
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5. Click Save.

The record is added.

NOTE Tekla PowerFab does not save the record if:

• Two time-tracking records marked to the same Tekla PowerFab
user overlap.

• A Tekla PowerFab user is selected and the total sum of regular,
overtime, and double overtime hours is greater than the difference
in the start and end time.

Modify or delete time-tracking records
1. To access existing time-tracking details, use one of the following methods:

• Go to Maintenance --> Time Tracking --> Time Tracking Detail.

• Access from the Project Management module as follows:

a. Click Project Schedule.

The Select Project dialog box opens.

b. Select the project, use the arrow to move it to the Included box,
and click OK.

The Project Schedule dialog box opens.

c. In the Project Schedule ribbon tab, select Time Tracking Detail

Alternative: On the Gantt Chart tab, select an item and right-click
it. In the menu that opens, select Time Tracking Detail.

• Access from the Production Control module as follows:

a. Open a project.

b. In the Production Control ribbon tab, select Project Schedule

c. In the Project Schedule ribbon tab, select Time Tracking Detail.

Alternative: On the Gantt Chart tab, select an item and right-click
it. In the menu that opens, select Time Tracking Detail.

The Time Tracking Filters dialog box opens.
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2. Select the minimum and maximum start and end dates in the calendars
by clicking the arrows on the right side of the fields in the Start Date and
End Date sections.

3. To only view and modify specific time-tracking records, click the available
filtering buttons.

4. In the filter dialog box, click the arrow buttons to move the values that you
want to include to the Included list.

5. Click OK.

6. Click Apply Filter. 

The Time Tracking Detail dialog box opens, displaying all previously
created time- tracking records.

To only view records that match particular criteria, you can select items in
the navigation tree on the left.

7. Do either of the following: 

To Do this
Modify a time-tracking
record

a. Click Properties.

b. Modify the properties of the time-tracking
record.

For more information, see Add a time-tracking
record (page 742).

c. Click Save to update the time-tracking record.
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To Do this
Delete time-tracking
records NOTE Deleting time-tracking records is

permanent and cannot be undone.

a. In the Time Tracking Detail dialog box, click
the time-tracking records that you want to
delete.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold
down Shift.

b. Click the Time Tracking Detail ribbon tab.

c. On the menu, select Delete Selected Records.

d. In the first confirmation dialog box, click Yes.

e. In the second confirmation dialog box, click
Yes to permanently delete the tracking
records.

Import time-tracking records
1. Access the Time Tracking Detail dialog box using one of the following

methods:

• Go to Maintenance --> Time Tracking --> Time Tracking Detail.

• Access from the Project Management module as follows:

a. Click Project Schedule.

The Select Project dialog box opens.

b. Select the project, use the arrow to move it to the Included box,
and click OK.

The Project Schedule dialog box opens.

c. In the Project Schedule ribbon tab, select Time Tracking Detail

Alternative: On the Gantt Chart tab, select an item and right-click
it. In the menu that opens, select Time Tracking Detail.

Alternative: On the Gantt Chart tab, select an item and right-click it. In
the menu that opens, select Time Tracking Detail.

2. Click Apply Filter. 

The Time Tracking Detail dialog box opens.

3. In the Time Tracking Detail ribbon tab, select Import Time Tracking
Records - Excel
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4. In the Open dialog box, select the file that you want to import. 

See below for an example. You can also find a sample file here.

The minimum required fields are the Start Date/Time and End Date/
Time. If not included in the file, you are prompted to select a project.

5. Double-click the file name. 

The Verify Excel Import Data dialog box opens showing the column
headings in the Excel file.

6. Verify the time-tracking information. 

TIP If you want to exclude a row in Microsoft Excel, hold down Alt and
double-click a row.

7. Click OK. The Import Field Map dialog box opens.

8. To set mapping, select an Import Field in the list, select the
corresponding field in the Tekla PowerFab Field list, and click Set Field
Mapping. 
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You can also use regular expressions to map items to fields and to ignore
records based on a pattern. For more information, see Regular
expressions (page 750).

9. To import, click OK. 

The import starts.

If you have not included the required fields, the program prompts you to
select the items that you are going to import into. Select the correct item
and click Add --> Proceed With Import.

If there are records that fail to import, the program asks if you want to
export them to a separate text file that is saved to the Log directory.

10. When the import is completed, click Open Import Log and view the
import details.

11. To close the import log and the Import dialog box, click the Close button
(X).

View a time-tracking summary
1. In the Project Schedule dialog box, click the Project Schedule ribbon tab.

2. On the menu, select Time Tracking Summary.

3. In the upper-left corner of the Time Tracking Filters dialog box, select the
fields that you want to view in the time-tracking summary. 

The selected fields will be columns in the summary.

4. Click the arrows on the right side of the fields in the Start Date and End
Date sections, and select the minimum and maximum start and end
dates in the calendars.
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5. To only view and modify specific time-tracking records, click the available
filtering buttons.

6. In the filter dialog box, click the arrow buttons to move the values that you
want to include to the Included list.

7. Click OK.

8. Click Apply Filter. 

A dialog box opens, displaying a summary of the time-tracking records
created.

9. View the time-tracking information.

10. Do any of the following:

• To create a new time-tracking record, click New.

For more information, see Add a time-tracking record.

• To access the Time Tracking Detail dialog box, click Time Tracking
Detail.

For more information, see Modify, delete, or import time-tracking
records.

• To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Define time-tracking settings (page 740)

Regular expressions
You can use regular expressions to specify a pattern for importing multiple
fields or for ignoring records that you do not want to import.

For the syntax of regular expressions, see Regular Expressions.

The Expression option allows to extract multiple fields from a single value in
the import by specifying a regular expression with the field names as
placeholders in the expression.
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If you have a column with the Project # category and a sub-category
separated by slashes, for example, 22-012/CAT1/SUBCAT2, you can set the
expression to `Project`/`Category`/`Sub-Category`. As a result, the
individual values (Project=22-012, Category=CAT1, Sub-Category=SUBCAT2)
are extracted and used for those fields.

You can use Ignore Expression to indicate that a row must be ignored.

If you have a column with the Project # category, and the data set includes job
types that you do not want in Tekla PowerFab, for example, ones beginning
with the letter M, you set the Ignore Expression to M.*. As a result, any time-
tracking records projects beginning with an "M" are not be imported.

8.7 Manage contract and invoicing information
In the Contract & Invoicing dialog box, you can view the current contract and
invoice information, add new contract details and invoices, or modify contract
and invoice information. The values set in Contract & Invoicing are used in
the project schedule.

To access the contract and invoicing information:

• On the right side of the Project dialog box, click the Contract & Invoicing
button.

• On the Summary tab of the Project dialog box, click + at the upper-right
corner of the Contract & Invoicing section.
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In the Contract & Invoicing dialog box, you can view the total sum of the
contract, approved change orders included in the contract or not included in
the contract, the sum that has been invoiced, and the sum that has not yet
been invoiced.

For more information, see the following links:

Add and modify contract information (page 752)

Create and modify invoices (page 755)

Add and modify contract information
Use the Contract Items dialog box to add new contract items to either the
original contract or a change order. Contract items represent parts of the
contract, such as detailing or materials. You can also modify, move, or delete
existing contract items. Furthermore, you can define and adjust the properties
of the project contract.

To access the Contract Items dialog box, do the following:

• In the Contract & Invoicing dialog box, click Contract.

Add a contract item to the original contract
1. On the Contract Items tab of the Contract Items dialog box, click New

Contract Item.

2. In the Contract Item dialog box, type a description for the contract item. 

The description is used in project management reports.

3. Click the arrow on the right side of the Type list and select Original
Contract.

4. In the Amount field, type the costs of the contract item.
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5. Click the arrow on the right side of the Schedule Task list, and select the
project schedule task that you want to link to the new contract item. 

When you link a contract item to a schedule task, Tekla PowerFab
automatically finds the completion percentage of the contract item from
the project schedule. This allows you to automatically calculate the
amount to be invoiced based on the completion percentage.

6. Type any additional notes about the contract item.

7. Click Save.

The new contract item is added to the list on the left-hand pane.

The Contract & Invoicing dialog box now shows the totals for the contract
and the sum to be invoiced.

You can now create invoices for the contract item. For more information, see
Create and modify invoices (page 755).

All invoices related to the contract item are displayed in the Invoices section,
below the contract item properties.

Add a contract item to a change order
1. On the Contract Items tab of the Contract Items dialog box, click New

Contract Item.

2. In the Contract Item dialog box, type a description for the contract item. 

The description is used in project management reports.

3. Click the arrow on the right side of the Type list and select Change Order.

4. Click the arrow on the right side of the Schedule Task list, and select the
project schedule task that you want to link to the new contract item. 

When you link a contract item to a schedule task, Tekla PowerFab
automatically finds the completion percentage of the contract item from
the project schedule. This allows you to automatically calculate the
amount to be invoiced based on the completion percentage.

5. Type any additional notes about the contract item.

6. Click Save. 

The new contract item is added to the list on the left-hand pane.

7. To define the costs of the contract item, go back to the Project
Management dialog box, and click Change Orders.

8. In the Change Orders dialog box, select the change order that you want
to link to the contract item.

9. Click the arrow on the right side of the Contract Item list, and select the
new contract item.

10. Click Edit to save the changes.
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When you return to the Contract Item dialog box, you can see that the costs
of the selected change order are now used in the Amount field for the
contract item. The selected change order is displayed in the Change Orders
section, below the contract item properties.

The net amount of the change order will also be visible in the Contract &
Invoicing dialog box.

Modify a contract item
1. On the left-hand pane of the Contract Item dialog box, select the contract

item that you want to modify.

2. Modify the description, type, amount, schedule task, and notes according
to your needs.

3. Click Save to update the contract item properties.

Move a contract item up or down
1. On the left-hand pane of the Contract Item dialog box, select the contract

item that you want to move.

2. Click the Move Up and Move Down buttons to move the item to the
desired position.

Delete a contract item
Deleting a contract item is permanent and cannot be undone.

Note that the contract items that have been invoiced cannot be deleted.

1. On the left-hand pane of the Contract Item dialog box, select the contract
item that you want to delete.

2. Click Delete.

3. To permanently delete the contract item, click Yes in the confirmation
dialog box.

Adjust the contract properties
1. In the Contract Items dialog box, click the Other tab to open it.

2. Adjust the contract properties: 

Option Description
Contract # The contract number.

The contract number is displayed in the standard
AIA G702 invoice form.

Type the contract number in the Contract # field.
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Option Description
Contract For A brief description of the contract, displayed in the

standard AIA G702 invoice form.

Type a description in the Contract For field.
Retainage - Completed
Work

The percentage of the invoiced completed work
amount that is retained until the end of the
project. The default value is 10%.

Type a value in the Retainage - Completed Work
field.

Stored Materials The percentage of the invoiced stored materials
amount that is retained until the end of the
project. The default value is 10%.

Type a value in the Stored Materials field.
Notes Any additional notes or information about the

contract.

3. Click Save. 

A message appears, telling you that the information has been saved.

4. Click OK to close the message.

Create and modify invoices
In the Invoices dialog box, you can create new invoices for contract items,
modify or delete existing invoices, and create standard invoice documents or
invoice reports.

To access the Invoices dialog box, do the following:

• In the Contract & Invoicing dialog box, click Invoices.

Create an invoice
1. In the Invoices dialog box, click New Invoice.

2. At the top of the Invoices dialog box, define the invoice properties: 
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Properties marked with an asterisk (*) are mandatory information.

Option Description
Application # * An identification number used to identify the

invoice on the AIA G702 and AIA G703 reports.

When creating a new invoice, the Application #
field is automatically populated with the next
available number.

If necessary, type another number in the
Application # field.

Invoice # The invoice number used in your accounting
software.

Type the invoice number in the Invoice # field.
Date * The date when the invoice was created.

Click the arrow on the right side of the Date field,
and select a date in the calendar.

Period Start *, End * Dates that determine the date range during which
the worked that is billed on the invoice was
completed.

Click the arrows on the right side of the Period
Start and End fields, and select the start and end
dates in the calendars.

Retainage - Completed
Work

The retainage percent applied to the completed
work.

Type a value in the Retainage - Completed Work
field.

Note that when you create the final invoice, the
value needs to be set to 0%, so that the retainage
withheld from the previous invoices can be billed.

Stored Materials The retainage percent applied to the stored
materials.

Type a value in the Stored Materials field.

Note that when you create the final invoice, the
value needs to be set to 0%, so that the retainage
withheld from the previous invoices can be billed.

Created By * The Tekla PowerFab user who is creating the
invoice.

When creating a new invoice, the default user is
the one that is currently logged in to Tekla
PowerFab on the current workstation.

If necessary, click the arrow on the right side of the
Created By list and select another user.
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Option Description
Invoice To * The company and contact person that will receive

the invoice.

Click the arrow on the right side of the leftmost
Invoice To list and select the company.

Click the arrow on the right side of the rightmost
Invoice To list and select the contact person.

Notes Any additional notes or information about the
invoice.

Type any information in the Notes field.

3. In the list in the middle of the Invoices dialog box, select the contract item
for which you want to create the invoice. 

Note that the properties at the bottom of the dialog box change according
to the selected contract item. If the contract item is linked to a schedule
task, the % Complete field is populated automatically.

4. Do one of the following:

• To apply the sum that is to be invoiced to the completed work
according to the completion percentage, click Apply to Completed
Work.

• To apply the sum that is to be invoiced to the stored materials
according to the completion percentage, click Apply to Stored
Materials.

• To manually determine the sum to be invoiced and apply it to the
completed work or the stored materials, type the sum in either the
Current - Completed Work field or the Stored Materials field.

• To set the sum to the full amount remaining, double-click the Current -
Completed Work field or the Stored Materials field.

The next material in the list of contract items is selected.

If necessary, to add the currently selected contract item to the invoice,
repeat step 4.

5. Click Save to save the invoice.

Modify an invoice
1. In the Invoices dialog box, select the invoice that you want to modify.

2. Click Properties.
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3. At the top of the Invoices dialog box, modify the invoice properties: 

Option Description
Application # An identification number used to identify the

invoice on the AIA G702 and AIA G703 reports.

When creating a new invoice, the Application #
field is automatically populated with the next
available number.

If necessary, type another number in the
Application # field.

Invoice # The invoice number used in your accounting
software.

Type the invoice number in the Invoice # field.
Date The date when the invoice was created.

Click the arrow on the right side of the Date field,
and select a date in the calendar.

Period Start, End Dates that determine the date range during which
the work that is billed on the invoice was
completed.

Click the arrows on the right side of the Period
Start and End fields, and select the start and end
dates in the calendars.

Retainage - Completed
Work

The retainage percent applied to the completed
work.

Type a value in the Retainage - Completed Work
field.

Note that when you create the final invoice, the
value needs to be set to 0%, so that the retainage
withheld from the previous invoices can be billed.

Stored Materials The retainage percent applied to the stored
materials.

Type a value in the Stored Materials field.

Note that when you create the final invoice, the
value needs to be set to 0%, so that the retainage
withheld from the previous invoices can be billed.

Created By The Tekla PowerFab user who is creating the
invoice.

When creating a new invoice, the default user is
the one that is currently logged in to Tekla
PowerFab on the current workstation.

If necessary, click the arrow on the right side of the
Created By list and select another user.
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Option Description
Invoice To The company and contact person that will receive

the invoice.

Click the arrow on the right side of the leftmost
Invoice To list and select the company.

Click the arrow on the right side of the rightmost
Invoice To list and select the contact person.

Notes Any additional notes or information about the
invoice.

Type any information in the Notes field.

4. If necessary, do either of the following:

• To change if the invoiced amount is applied to the completed work or
the stored materials, click either Apply to Completed Work or Apply
to Stored Materials.

• To manually change the amount to be invoiced, type a new value in the
Current - Completed Work or the Stored Materials field.

5. Click Save to save the invoice.

Delete an invoice
Deleting an invoice is permanent and cannot be undone.

1. In the Invoices dialog box, select the invoice that you want to delete.

2. Click Properties.

3. In the lower-right corner of the Invoices dialog box, click Delete.

4. To permanently delete the invoice, click Yes in the confirmation dialog
box.

View, print, or export invoice documents or invoice reports
1. In the Invoices dialog box, click the Invoice ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Selection dialog box, select the desired invoice report. 

The AIA G702 and AIA G703 reports are standard forms for creating
invoices.
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4. Do any of the following: 

To Do this
View the invoice
document or invoice
report

• In the Report Selection dialog box, click View.

The selected report or document opens in Tekla
PowerFab Report Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the invoice
document or invoice
report

a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. To confirm printing the document or report,
click Yes in the confirmation dialog box.

d. In the Select Printer dialog box, click a printer
to select it.

e. Click OK.
Export the invoice
document or invoice
report

a. In the Report Selection dialog box, click
Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Modify the file name according to your needs.

e. Browse to the location where you want to save
the exported file, and click Save.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. In the Report Selection dialog box, click
Export.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.
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8.8 Import and export project management information
You can import drawing status information as an XML file, or export the
production status to an XML file or to Trimble Connect.

See also

Import drawing status information (page 761)

Export the production status to Tekla Structures or Advance Steel (page 944)

Export the production status to SDS/2 (page 945)

Publish the production status to Trimble Connect (page 763)

Import drawing status information
Use the Import command to import drawing status from an XML file to Tekla
PowerFab.

1. In the Project Management dialog box, click the Project Management
ribbon tab.

2. On the menu, select Import.

3. In the Open dialog box, browse to find the XML file that you want to
import.

4. Click the XML file to select it.

5. Click Open.

6. In the Import Tekla PowerFab Exchange File dialog box, view the import
status.

7. When the import process is completed, click the Close button to close the
Import Tekla PowerFab Exchange File dialog box.

Export the production status to Tekla Structures or
Advance Steel
You can export the production status of the current job as an XML file to either
Tekla Structures or Advance Steel.

The menu options for Advance Steel can be found only if the import file is
from that software.

1. In the Project Management dialog box, click the Project Management
ribbon tab.

2. On the menu, select either of the following:

• Data Exchange --> Export Production Status to XML - Tekla
Structures
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• Data Exchange --> Export Production Status to XML - Advance
Steel

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

The production status is saved in the selected location as an XML file.

Export the production status to SDS/2
You can export the production status of the current job to SDS/2 as an XML
file.

The menu options for SDS/2 can be found only if the import file is from that
software.

1. In the Project Management dialog box, click the Project Management
ribbon tab.

2. On the menu, select Data Exchange --> Export Production Status to
XML - SDS/2 .

3. In the SDS/2 Settings dialog box, define SDS/2 import settings as follows:

a. Click New Field.

b. In the SDS/2 Object list, select the SDS/2 object type.

c. In the SDS/2 Category list, select a software solution for member
properties.

d. In the SDS/2 Field list, select the field to which the information is
exported in SDS/2.

e. In the Tekla PowerFab Field list, select the Tekla PowerFab field from
which the information is exported to the selected SDS/2 field.

f. Click New Field.

Repeat steps a to f to match all necessary SDS/2 and Tekla PowerFab fields
to each other.

If you want to save the SDS/2 import settings for later use, type a
description for the settings in the Description field, and click Save.

4. Click OK.

5. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.
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6. If necessary, change the file name.

7. Click Save.

Publish the production status to Trimble Connect
Use the Publish Status to Trimble Connect command to update the status of
a production control job manually to Trimble Connect.

You can also create a Publish to Trimble Connect automated event
(page 233) to update the production status to Trimble Connect automatically.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Export --> Publish Status to Trimble Connect .

The production status is updated to Trimble Connect.

8.9 View, print, or export project management reports
You can create various reports containing information about the current
project management job. For example, you can create a list of transmittals, a
notice informing the recipient about overdue drawings, or a standard invoice.

Create a project management report
1. In the Project Management dialog box, click the Project Management

ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include specific items in the report, in the Project Management
Report Filters dialog box, select a filter type in the Type list, and click
Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to include in
the report to the Included list.

• Type the maximum and minimum values for the items that you want
to include in the report.

5. Click OK.
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6. At the bottom of the Project Management Report Filters dialog box,
select checkboxes depending on which kind of reports you want to create.

For example, to only create drawing reports, select the Drawings
checkbox only.

7. Click Make Report.

8. In the Report Selection dialog box, select the report that you want to
view, print, or export.

View the report
In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

6. To open the file after exporting it, select the Open Exported Document
checkbox.

7. In the Report Selection dialog box, click Export.
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See also

Customize reports (page 268)

View, print, or export the project summary
Use the Project Summary command to view the project summary report of
project management jobs that are linked to one or more of the following
modules: Production Control, Combining, Estimating, and Purchasing.

By creating the project summary, you can:

• Compare the materials used in Production Control with the estimated
materials and the pre-purchased materials in Combining.

• View the total values for purchased materials, materials moved from other
jobs, and materials moved to scrap.

• View the current production status: see which materials are listed on a
purchase order and have not yet been received, which materials are in
stock but have not been processed, and which have been charged to the
job and taken from stock.

Create a project summary report
1. In the upper-right corner of the Project Management dialog box, click

Project Summary. 

The Report Selection dialog box opens.

2. Select the desired project summary report. 
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The Full Project Summary report provides a snapshot of the current
status of the project and the module components that are currently linked
to each other. It contains:

• A shape summary, which allows you to compare materials by shape.
The job progress is displayed by weight and cost. All items entered into
the bill of materials in Production Control appear in the Production
Control column.

• A purchase order summary, which shows all the purchase orders
associated with the project management jobs.

• An inventory transfer summary, which shows materials transferred
from a different job into the current project management job.

• The production and shipping status summary report, which shows the
quantity of pieces that have been processed. The items are sorted by
the route assigned in Production Control. The production and
shipping status information is automatically updated when changes
are made.

The project summary reports also have reports for all the breakdown
areas, but these reports are not displayed by default. To customize the
displayed reports, click Edit Report Types in the Report Selection dialog
box.

View the project summary report
In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the project summary report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the report, click Yes in the confirmation dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the project summary report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.
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4. Browse to the location where you want to save the exported file, and click
Save.

5. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

6. To open the file after exporting it, select the Open Exported Document
checkbox.

7. In the Report Selection dialog box, click Export.
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9 Production Control

The Production Control module handles the entire fabrication process:
pulling the material from Purchasing and inventory cut lists, tracking the
production in the shop, filing quality control reports, and shipping materials.

Before you start working in the Production Control module, remember to
adjust the production control settings according to your needs. For more
information, see Set up the Production Control module (page 768).

9.1 Set up the Production Control module
Before you start to manage the fabrication process in the Production Control
module, we recommend that you take the time to customize the properties
and items according to your needs. Once you have created and modified all
necessary items and settings, working in the Production Control module is
easier and more efficient.

When setting up the Production Control module, you can:

• Define the company standard settings used in the Production Control
module.

• Modify the available display and input fields in the Production Control
dialog box.

• Modify the menu setup of the Production Control menu and create
shortcuts for menu items.

• Set up stations and routes for piece tracking.

• Enter information for piece tracking and loading trucks.

• View production status reports for either a single job or a group of jobs.

• View and print cut lists.

• View and print station summary reports and shipping lists.

• View and print different kinds of production control and purchasing reports
for either a single job or a group of jobs.
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Define company standard settings for Production Control
For each module, you can define company-level settings that are the default
for all new jobs.

1. Click the Maintenance ribbon tab..

2. On the menu, select Production Control --> Company Standards

The Company Standards dialog box opens.

3. Modify the settings on the various tabs as needed.

You can find further company standard settings by clicking the buttons.

Define general settings
1. On the General tab, modify the following properties: 

Option Description
Job # Increment Allows you to select the default option for

automatic job numbering. The options are:

• Increment from Last Job #: When you create a
new job, Tekla PowerFab uses the next available
job number after the latest job number created.

• Increment from Largest Job #: Tekla
PowerFab uses the next available job number
after the largest job number created.

• Don't Increment: Automatic job numbering is
not used.

You can modify the job number when you create a
new job.

Keep Job Selection
Screen Open

When selected, the Select <Module> Job dialog
box stays open after a job has been opened.

Open to Filter
Selection

When selected, the <Module> Filters dialog box
automatically opens when you open a job. In the
dialog box, you can set filters to only show the
items that you want to see in the job.

The job opens when you have set the filters.
Job # Regular
Expression

Allows the use of regular expressions to enforce a
desired format for the job numbers.

For more details on regular expressions, click
Regular Expression Help.

When changes to PDC
break links to
combined INV material

Allows you to select how Tekla PowerFab handles
situations where a material link is broken between
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Option Description
Production Control and Inventory while
importing a revised or modified bill of materials.

Tekla PowerFab automatically unlinks all changed
material. This prevents cutting materials to
incorrect lengths.

The options are:

• Prompt to Uncombine the Unlinked INV
Material: Tekla PowerFab asks the user if the
materials should be immediately uncombined
or not, which is the first step of automatically
correcting cut lists. This is the default option.

• Always Uncombine the Unlinked INV
Material: Tekla PowerFab automatically
uncombines the unlinked materials.

• Never Uncombine the Unlinked INV
Material: Tekla PowerFab does not uncombine
the unlinked material, but leaves the combining
result as is. Instead, the user should perform
the necessary corrections manually.

Click the arrow on the right side of When changes
to PDC break links to combined INV material
field, and click a suitable option in the list to select
it.

TFS - Drop Job Reserve Allows you to select how Tekla PowerFab handles
drop material when a take from stock operation
has been performed. Note that you can select a
different option for an individual job, if necessary.

The options are:

• Keep reserved for the TFS job: Tekla PowerFab
keeps all drop material saved for the job until
you unreserve it manually. This is the default
option.

• Prompt for the new job reserve: In the Cut
Lists dialog box, Tekla PowerFab asks you if you
want to reserve the drop material for a job.

• Prompt to unreserve: Tekla PowerFab asks
you if you want to unreserve the drop material
or not.

• Always unreserve: Tekla PowerFab
automatically unreserves all drop material and
moves it to open inventory, immediately
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Option Description
available for use. Scrap length materials go to
inventory history.

Allow Cut List Grade
Substitution

When selected, Tekla PowerFab can use inventory
stock materials with another material grade in cut
lists.

Note that Tekla PowerFab only allows grade
substitutions that have previously been set up in
the Shape/Grade/Size Maintenance dialog box.
For more information, see Add grade substitutions
(page 184).

Warn when creating a
cut list if parts are
missing CNC files

When selected, Tekla PowerFab alerts you when
saving a cut list that contains parts without CNC
files.

Cut List Screens - Show
Date/Time Changed

When selected, the Cut Lists dialog box shows the
date and time when the cut lists were last changed.

Allow manual
alteration of external
nest remnants

When selected, allows the user to manually
override the remnant information that would
otherwise come in from external nesting
integrations.

Automatically Create
Document Index
Directories

When selected, the Document Index directories
defined in Maintenance --> Document Index -->
Standard Categories are created automatically
under the base document index directory when a
job is created. See Set the standard categories for
attached documents (page 150).

2. Click Save. 

Saving the settings closes the Company Standards dialog box.

Define input settings
On the Input Settings tab, select how Tekla PowerFab interprets and displays
the information in the Production Control module, if the information is from
an imported bill of materials, or directly entered in the Production Control
dialog box.

1. On the Input Settings tab, modify the following properties. 

Option Description
Main Mark Input Type Allows you to select the input format for main

marks.

Select a suitable option on the drop-down menu.
We recommend selecting the Any Input - Logical
Sort option.
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Option Description
Piece Mark Input Type Allows you to select the input format for piece

marks.

Select a suitable option on the drop-down menu.
We recommend selecting the Any Input - Logical
Sort option.

Drawing Number Input
Type

Allows you to select the input format for drawing
numbers.

Note that the input format of drawing numbers in
a production control job needs to match the input
format set in the linked project management job.
Otherwise, the drawings will not be available in the
Production Control module or in Tekla PowerFab
Go.

Select a suitable option on the drop-down menu.
We recommend selecting the Any Input - Logical
Sort option.

Sequence Input Type Allows you to select the input format for
sequences.

Select a suitable option on the drop-down menu.
We recommend selecting the Any Input - Logical
Sort option.

Use Lot Numbers When selected, you can divide a sequence or
phase into subcategories within a production job
by using lot numbers.

It is highly recommended to select the Use Lot
Numbers option.

Note that selecting or clearing the Use Lot
Numbers checkbox only applies to new production
control jobs automatically. If necessary, the Use
Lot Numbers checkbox can be manually selected
or cleared for existing jobs as well.

Main Piece Case Allows you to select uppercase or lowercase letters,
or both, for main mark numbers. This makes
recognizing the main pieces easier.

Accessory Piece Case Allows you to select uppercase or lowercase letters,
or both, for piece mark numbers. This makes
recognizing the piece marks easier.

Main Member Instance
Tracking

When selected, the history of each individual
instance, or piece, within an item can be identified
and tracked through all production steps.

If you select the Main Member Instance Tracking
checkbox, instance tracking will be activated for all
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Option Description
new production control jobs. However, existing
jobs will not be affected. You can still activate or
deactivate the instance tracking of main piece
marks for each production job individually.

Accessory Part
Instance Tracking

When selected, the history of each individual
instance, or piece, within an item can be identified
and tracked through all production steps.

If you select the Accessory Part Instance
Tracking checkbox, instance tracking will be
activated for all new production control jobs.
However, existing jobs will not be affected. You can
still activate or deactivate the instance tracking of
piece mark items for each production job
individually.

Piece Mark Force Same
Info

When selected, the same information is forced to
accessories with the same piece marks. Selecting
the Piece Mark Force Same Info checkbox
prevents adding or importing items with the same
piece mark but different material information to
the production control job.

Note that the Piece Mark Force Same Info option
is connected to the Edit Line Item - Update
accessories with the same piece mark list. You
cannot select an option in the Edit Line Item -
Update accessories with the same piece mark
unless the Piece Mark Force Same Info checkbox
is selected.

Edit Line Item - Update
accessories with the
same piece mark

Allows you to select how Tekla PowerFab
accessories with the same piece mark are updated
when you make changes to a line item. The options
are:

• Prompt to update the other line items: Tekla
PowerFab alerts the user that there are other
accessories in the job that may need to be
updated, and allows you to update the other
accessories. This is the default option.

• Always update the other line items: Tekla
PowerFab automatically updates the other
accessories to match the changes you made.

• Never update the other line items: Tekla
PowerFab never updates the other accessories
to match the changes you made.

AutoCalc Drawing
Number

When selected, Tekla PowerFab enters a drawing
number into the drawing number field based on
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Option Description
the main mark. This option works correctly if the
first number of each shop detail drawing main
piece is the drawing number.

If the marking system that you use does not have
the drawing number as the first number of the
main mark, do not select the AutoCalc Drawing
Number checkbox.

Default Finish The default finish for items.

The available finish options are set in the Finish
Maintenance dialog box.

You can change the finish for each main mark item
in a production control job. The finish of the main
mark item is also applied to all of the included
accessories.

Click the arrow on the right side of Default Finish
field, and click a suitable default option in the list to
select it.

Trailer Capacity The maximum weight that can be added on a
trailer.

The trailer capacity can be changed for individual
loads, if needed. You can also modify the capacities
of specific trailers in the Load Tracking Settings
dialog box. For more information on the load
tracking settings, see Define load tracking settings
(page 787).

Piece Tracking by Time When selected, allows you to make piece tracking
entries in that include the completion time, so that
you can tell in which shift an item was completed.

The completion time is also visible in piece tracking
reports.

Production Code -
Default Aggregate
Units

Defines the default units of measure for labor
items within the production codes.

2. Click Save. 

Saving the settings closes the Company Standards dialog box.
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Define import settings
On the Import Settings tab, set the default settings used when importing a
bill of materials into Production Control.

1. On the Import Settings tab, modify the follolwing properties: 

Option Description
When assembly has no
part with a piece mark
matching the main
mark

Allows you to select how Tekla PowerFab applies
comment lines in rare cases where a bill of
materials is imported to Production Control and
Tekla PowerFab cannot identify a main mark. The
options are:

• Don't add a comment line as the main piece:
Tekla PowerFab never adds the comment line
as the main piece. This is the default option
because most often, the main mark item in the
bill of materials is the largest single piece,
whereas the piece marks are the items that
attach to the main piece.

• Prompt to add a comment line as the main
piece: Tekla PowerFab asks you if you want to
add a comment line as the main piece. This
allows you to use the name of the item for main
marks instead of the material size.

• Always add a comment line as the main
piece: Tekla PowerFab always adds a comment
line as the main piece. This allows you to use
the name of the item for main marks instead of
the material size.

When there are
validation errors

Allows you to select how Tekla PowerFab handles
validation errors regarding shop detail drawings
when a bill of materials is imported to Production
Control. The options are:

• Continue the import without prompting the
user: Tekla PowerFab continues the import
process without notifying you about the
validation errors. However, you can view the
validation errors in the import log. This is the
default option, and it is useful when the user
performing the import process does not need
to know or make decisions on validation errors.

• Prompt the user to continue the import:
Tekla PowerFab asks you how the validation
errors should be handled while continuing the
import.
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Option Description
• Don't continue the import: Tekla PowerFab

stops the import immediately when a validation
error is found. The user can then review the
drawings for issues by themselves.

Use as Production
Code

Allows you to select if you want to use assembly
main marks, piece marks, drawing descriptions,
assembly descriptions, reference numbers, or
none of the above as product codes.

Click the arrow on the right side of the Use as
Production Code field, and select a suitable option
in the list.

Use Piece Mark as
Production Code

When selected, Tekla PowerFab automatically
assigns piece marks as production codes.

Note that if you select the Use Piece Mark as
Production Code checkbox for a production
control job, you also need to use piece marks as
production codes in the estimating job that is
linked to the production control job.

Prompt to confirm
import fields

When selected, Tekla PowerFab asks you to
confirm the import fields while importing a bill of
material into Production Control.

By selecting the Prompt to confirm import fields
checkbox, you can exclude any fields whose values
you do not want to import.

Show supplemental
import file selection
(KISS, CIS/2, BIF)

When selected, Tekla PowerFab allows you to
import multiple supplementary files, such as bolt
lists, from a detailing software.

2. Click Save. 

Saving the settings closes the Company Standards dialog box.

Define report settings
1. On the Report Settings tab, modify the following properties: 

Option Description
Prompt for weight type (net/gross) Select if you want to select whether to

use net or gross weight of materials
for each report.

The gross weight is the system weight
as dimensioned in Tekla PowerFab,
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Option Description
whereas the net weight is loaded
from the CNC files added for items.

If CNC files have not been added for
the items included in the report, net
weight cannot be used in the report.
Gross weight is used instead.

Cut List - Prompt to split cutting
details to a quantity of one

Select if you want to create cut list
reports that show each quantity of
inventory listed separately.

If the checkbox is cleared, multiple
inventory pieces with the same exact
cutting details are shown as a single
inventory item in reports.

Default Select if you want to split cutting
details to the quantity of one by
default.

Define settings for drawings on hold
You can flag drawings that are put on hold for Production and Purchasing.

When flagged for Production, people working on assemblies can stop and wait
to see if changes are coming.

When flagged for Purchasing, you can make sure that materials from drawings
that have been put on hold in the requisition stage do not move forward in the
process.

1. Go to Maintenance --> Production Control --> Company Standards.

2. Go to the Hold Settings tab. 
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Allow: The system keeps acting as usual even if drawings are on hold.

Prompt: Gives you options for further action to select from

Prevent: Prevents the drawings on hold from moving forward

3. Select the phase which you want to adjust and select the suitable hold
setting. 

Example:

A combining run when Prompt is selected for Production:

4. Click Save.
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See also

Manage approval statuses for drawings (page 800)

Manage drawings (page 621)

Define default input and display units for Production Control
You can define standard input and display units for the company. You can
select either metric or imperial units and the units of measurement for a
piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

1. Go to Maintenance --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Input/Display Units. 

The Input/Display Units dialog box opens.

3. Select the measurement system and the units of measurement on the
drop-down menus.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

5. Click Save.

The input and display units are saved as defaults.

You can also adjust the units used in individual jobs. For more information, see
Modify a production control job (page 851).

See also

Define company standard settings for Production Control (page 769)

Define default combining optimizations for Production Control
You can define company-level settings for material optimization.

1. To define company-level settings, go to Maintenance --> <Module>
Company Standards.

2. Click Combining Optimizations.

The Combining Setup dialog box opens.
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3. Modify the settings on the various tabs as needed.

See also

Combine materials in the Production Control module (page 917)

Define the general settings

1. Go to the General Settings tab.

2. Modify the settings as needed. 

Option Description
Use Grade Substitutions Select to check for material in

inventory that has an alternative
grade to the one specified.

Only grades of an equal or higher
rating will be used as set in
Maintenance --> Shapes/Grades/
Sizes --> Shape/Grade/Size
Maintenance dialog box.

If the grade substitutions are not set,
the material grades in the combining
run and in the supplier pricing data
set or the inventory need to match
each other exactly.

Combine Only Within Sequence Select if you want to mult and nest
only materials that are in the same
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Option Description
sequence onto the inventory items or
purchasable lengths.

The selection of Combine Only
Within Sequence uses additional
material for each sequence. This may
be desirable in some cases, but it may
also lead to excess drop amounts.

Optimizations Not Included/
Optimizations Included

Allows you to select the optimization
options that you want to use by
moving them to the Optimizations
Included list using the arrow buttons.

Inventory Exact-Match (In Stock) Use this option for inventory items in
stock that are an exact match without
the use of kerf or clamp allowance.

Inventory Exact-Match (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that are an
exact match without the use of kerf or
clamp allowance.

Inventory Least-Scrap (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that will
provide the least amount of scrap.

Inventory Least-Scrap (In Stock) Use this option for inventory items in
stock that will provide the least
amount of scrap.

Warehouse Least-Scrap Use this option to give preference to
warehouse items that will provide the
least amount of scrap. Warehouse
items will only be used when they
provide less scrap than the available
inventory items or no inventory
exists.

Warehouse Force Inventory Use this option to force the use of
inventory items if available regardless
of the amount of scrap, no matter
where it is located in the
Optimizations Included list. This
option is the opposite of Warehouse
Least-Scrap.

Note that you can only include
Warehouse Least-Scrap or
Warehouse Force Inventory, not
both.
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3. Modify the order of the optimizations by using the Move Up and Move
Down buttons 

The order is important when you are performing a combining run.

4. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define multing settings

1. Go to the Mult Settings - Linear Material tab.

2. Modify the settings as needed. 

Option Description
Multing Software Select the multing software that you

are using.
Apply Kerf Select if you want to apply the

material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Allow Split T's Select to allow split tees.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define plate nesting settings

1. Go to the Plate Nesting Settings tab.

2. Modify the settings as needed. 

Option Description
Plate Nesting Software Select the software that you are using.
Shear Cut Optimization Select a suitable shear cut option. The

selected option determines the plate
allowance to be used with the
combining:

• None: Use when cutting plate on a
burn table.

• Shear Cut - First Cut Along
Length or Shear Cut - First Cut
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Option Description
Along Width: Use to alert Tekla
PowerFab that the nesting needs
to allow for that type of cut first.
Then, the nesting will allow for all
subsequent cuts to be made with
that condition.

Apply Kerf Select if you want to apply the
material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Rotate Plates for Best Fit Select if the material grain direction is
unimportant and you want Tekla
PowerFab to create the best possible
optimization of a plate.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

When you click Save, the Combining optimizations settings are saved.

See also

Define company standard settings for Production Control (page 769)

Define combining optimizations for a production control job (page 839)

Troubleshoot combining issues (page 1110)

Define default suppliers for Production Control
You can define default suppliers, or pricing data sets, for angles, beams, plates,
rods, tubes, and other material. This way, you can use material pricing from
the selected supplier pricing data sets for each material group.

To make suppliers available in the Suppliers dialog box, you must first add the
suppliers in Maintenance --> Pricing Maintenance.

1. Go to Maintenance --> <Module> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Suppliers. 

The Suppliers dialog box opens.

3. Select suppliers for each material group on the drop-down lists.

4. Click OK. 

You return to the <Module> Company Standards dialog box.
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5. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the supplier settings are updated.

See also

Define company standard settings for Production Control (page 769)

Define suppliers for a production control job (page 843)

Define default categories and sub-categories for Production Control
Categories are user-defined keywords that you can use for sorting, tracking,
and reporting. Creating categories also helps you to quickly identify the items
in your jobs. For example, you can categorize jobs by fabrication type. You can
add new categories and modify and delete existing categories. You can add
new subcategories and modify and delete existing subcategories

To further filter items, you can also add subcategories.

TIP You can also create new categories and subcategories manually when creating
or modifying a job.

Manage categories
You can add new categories and modify and delete existing categories

Categories are considered a main breakdown item for project summaries and
project schedules.

1. Go to Maintenance --> <Module> --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Categories. 

The Company Categories dialog box opens.

3. Modify the settings as needed. 

To Do this
Add a new category manually a. Click New.

b. In the Category field, type a
name for the category.

For example, Skewed beam.

c. Click Add.
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To Do this
The new category is added to the
Category list.

Repeat steps a to c for all new
categories.

Modify a category a. Click a category name.

b. Click Edit, change the category
name, and click Edit again.

Delete a category a. Click a category name.

b. Click Delete.

c. Click Yes to confirm deleting the
category.

4. Close the Company Categories dialog box.

5. In the <Module> Company Standards dialog box, click Save to update
the categories.

The changes in categories are saved.

Manage subcategories
You can add new subcategories and modify and delete existing subcategories

Subcategories are considered a main breakdown item for project summaries
and project schedules.

1. Go to Maintenance --> <Module> --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click the Sub-Categories button. 

The Company Sub-Categories dialog box opens.

3. To add add a subcategory, click New.

4. In the Sub-Category field, type a name for the subcategory.

5. Click Add. 

The new subcategory is added to the Sub-Category list.

Repeat steps 1 to 4 for all new subcategories.

6. To modify or delete a subcategory, click a subcategory in the Company
Categories dialog box to select it and do either of the following:

• Click Edit, change the subcategory name, and click Edit again.

• Click Delete and then, click Yes to confirm deleting the subcategory.

7. Close the Company Sub-Categories dialog box.
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8. In the <Module> Company Standards dialog box, click Save to update
the subcategories.

The changes in subcategories are saved.

Define default pay categories for Production Control
Create pay categories to assign unit costs to fabricated items per weight unit.
You can use pay categories as report filters to help you to sort information in
reports. Tekla PowerFab also contains specific shipping reports that are
designed to be used with pay categories.

Pay categories are considered a main breakdown item for project summaries
and project schedules.

1. Go to Maintenance --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Pay Categories.

3. Modify the properties in the dialog box. 

To Do this
Create a new pay
category

a. Click New.

b. In the Pay Category field, type the pay
category name.

For example, Beams, Columns, or Bracing.

c. Type a description for the pay category.

For example, Light, Medium, or Heavy.

d. In the Lower Bound Unit Weight field, type
the lowest weight that is applicable to the pay
category.

e. In the Unit Price field, type a pricing per
hundredweight that is applicable for the
material type.

f. Click Add.

g. Click Save.
Modify an existing pay
category

a. In the list, click the pay category that you want
to modify.

b. Modify the pay category type, description, unit
weight, and unit price according to your needs.

c. Click Save.

Production Control 786 Set up the Production Control module



To Do this
Delete a pay category Note that deleting a pay category is permanent

and cannot be undone.

a. In the list, click the pay category that you want
to delete.

b. Click Delete.

c. In the confirmation dialog box, click Yes to
permanently delete the pay category.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

5. In the Company Standards dialog box, click Save to update the pay
categories.

The Company Standards dialog box closes. The pay categories are available
in the Production Control module.

See also

Define company standard settings for Production Control (page 769)

Define load tracking settings
You can manage which fields and options are available when adding loads in
the Load Tracking dialog box by using the Load Tracking Settings dialog
box, .

NOTE Any changes made in the Load Tracking Settings dialog box are
applied to both new and existing production control jobs.

Access Load Tracking Settings

1. Go to Maintenance --> Production Control --> Company Standards.

2. Click the Load Tracking Settings button.

The Load Tracking Settings dialog box opens.

Click the tabs at the top of the dialog box to modify the visibility of different
items in the Load Tracking Settings dialog box.

Adjust trailer number settings

1. Click the Trailer # tab to open it.

2. If you want to allow adding a trailer number in the Trailer # field, select
the Show Field checkbox. 

The Trailer # field will be available in the Load Tracking dialog box.
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3. In the Title field, type the name that you want to use for the Trailer #
field.

4. If you want the trailer number to be mandatory information, select the
Value Required checkbox. 

The user cannot add a load without entering a trailer number.

5. To add trailer numbers that can be selected, do the following:

a. If necessary, select the Restrict to Preset List checkbox. 

Selecting the Restrict to Preset List prevents the users from typing
new values, and forces them to select a value in the list.

Leaving the Restrict to Preset List checkbox unselected allows the
users to type a new value or select a value in the list.

b. To create a new value, click New.

c. Type the value in the Trailer # field.

d. Type the trailer capacity weight in the Capacity field.

e. Click Add. 

Repeat steps b to e for all values that you want to add.

You can also select an existing value in the list and use the Edit and
Delete buttons to modify or delete the value.

Adjust the load tracking fields

The Carrier, Load Category 1, Load Category 2, Load Category 3, and
Shipped From tabs each represent a user-defined field that you can add to
the Load Tracking dialog box. The fields can be re-named and adjusted, so
that you get all the necessary fields and options.

1. Click one of the previously mentioned tabs to open it.

2. If you want to show the field and allow adding information to it, select the
Show Field checkbox.

3. In the Title field, type the name that you want to use for the field.

4. If you want the field to be mandatory, select the Value Required
checkbox. 

When the Value Required checkbox is selected, the user cannot add a
load without entering information in the field.

5. To add options that can be selected for the field, do the following:

a. If necessary, select the Restrict to Preset List checkbox. 

Selecting the Restrict to Preset List prevents the users from typing
new values, and forces them to select an existing value.

Leaving the Restrict to Preset List checkbox unselected allows the
users to either type a new value or select an existing value.
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b. To create a new value, click New.

c. Type the desired value in the related field.

d. Click Add. 

Repeat steps b to d for all values that you want to add.

You can also select an existing value in the list and use the Edit and
Delete buttons to modify or delete the value.

Adjust receiving date settings

1. Click the Date Received tab to open it.

2. If you want to allow selecting a receiving date in the Date Received list,
select the Show Field checkbox. 

The Date Received list will be available in the Load Tracking dialog box.

3. In the Title field, type the name that you want to use for the Date
Received field.

Close the Load Tracking dialog box

• Click OK at the bottom of the dialog box, or click the Close button (X) in the
upper-right corner.

Manage production control jobs
You can manage existing jobs in many ways in the Job Maintenance dialog
box. The options available depend on the module. You can, for instance, copy
and delete jobs.

To access the Job Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

3. Select the job that you want to modify. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

4. At the bottom of the dialog box, click any of the available buttons. 

For more information, see the following links:

Delete production control jobs (page 790)

Copy a production control job (page 790)
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Export production control jobs (page 791)

Set job groups for production control jobs (page 791)

Set job statuses for production control jobs (page 792)

Delete production control jobs
You can delete any unnecessary jobs. Note that the jobs are deleted
permanently. To use the jobs for reference later, export them before deleting
them.

For information on exporting jobs, see Export production control jobs
(page 791).

NOTE When you delete jobs, Tekla PowerFab saves them in the database as
KISS files. Users with administrative rights can recover the deleted jobs
within 30 days from deleting them.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to delete. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Delete.

4. To delete the job, click Yes in the Confirm dialog box.

The job is permanently deleted.

See also

Export production control jobs (page 791)

Manage production control jobs (page 789)

Recover deleted files (page 114)

Copy a production control job
You can copy an existing job to use it as the base of a new similar job. Copying
an existing job makes creating the new job quicker, as you do not have to set
all properties manually or create items one by one.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to copy.

3. At the bottom of the dialog box, click Copy. The Enter Value dialog box
opens.
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4. Type a number for the new job.

5. Click OK.

Tekla PowerFab creates a new job based on the selected job. You can modify
the properties of the new job by using the Edit functionality in the module.

See also

Manage production control jobs (page 789)

Export production control jobs
Export jobs to move jobs from one database to another.

We recommend that you create backup copies of jobs to recover deleted jobs.
Users with administrator rights can recover deleted production control jobs.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job that you want to export. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Export. 

The Save As dialog box opens.

4. Browse to the folder where you want to save the file. 

Use the automatically generated name or type a new one.

5. Click Save.

The selected production control job is saved as a Tekla PowerFab-specific type
of KISS file. The exported KISS files contain load and piece tracking information
that KISS files do not normally contain.

See also

Manage production control jobs (page 789)

Set job groups for production control jobs
Job groups allow you to identify and classify jobs that are similar. This makes
filtering and reporting easier when you have a long list of jobs.

You can, for example, record the client and industry sector, but you can create
your own system to best suit your needs.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the jobs for which you want to create a job group. 
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To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Set Group Name.

4. Select if you want to add or update the primary group or the secondary
group name.

5. Type a name for the group.

You can find the job groups in the navigation tree in the module and use them
for filtering jobs.

See also

Manage production control jobs (page 789)

Set job statuses for production control jobs
Job status determines if a job is still in progress (Open) or finished (Closed). By
setting job statuses for jobs, you can filter and view only the current jobs in the
job selection dialog box in Tekla PowerFab and in Tekla PowerFab Go.

1. Go to Maintenance --> <Module> --> Job Maintenance. 

The Job Maintenance dialog box opens.

2. Select the job whose status you want to change. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. Select the desired job status in the list.

4. Click OK.

You can filter jobs by selecting status in the module navigation tree.

See also

Job status maintenance (page 219)

Manage production control jobs (page 789)

Open a production control job (page 846)

Modify a production control job (page 851)

Define critical length and width differences
If any change to a production control item is greater than the inventory record
linked to the production control item, the change is automatically considered
critical and will break the link to the inventory item. If the change is less than
the linked inventory record, you can allow the link to the inventory item to
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remain up to the critical length and width differences that you set in the
Purchasing Standards dialog box.

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Purchasing Standards .

3. In the Purchasing Standards dialog box, enter the maximum acceptable
width and length differences.

4. Click Save.

The maximum acceptable width and length differences are saved. These
values are used in two types of situations:

Example 1: Comparing two bills of materials

At the beginning of a project, the steel detailer may send an advanced bill of
materials to be imported to the Combining module. The materials in the bill
of materials are then combined and purchased.

Later in the project, when the bill of materials is imported from the shop detail
drawings to Production Control, you can compare the two lists for material
differences. Tekla PowerFab will use the maximum values defined in the
Purchasing Standards dialog box to recognize critical differences, and
highlight them in red.

Example 2: Automatic linking of materials

When importing a revised bill of materials into an existing Production Control
job, Tekla PowerFab uses the maximum values defined in the Purchasing
Standards dialog box to determine which materials can be linked
automatically. Tekla PowerFab stops the automatic process of linking materials
if the differences exceed the maximum values.

Tekla PowerFab then alerts you that there are changes that have switched off
the automatic linking of materials, so that the you can manually review the
affected purchased items and make adjustments accordingly.

Manage stations and routes
Production stations and routes define the steps that an item in production
goes through in the fabrication process. Stations and routes are also used for
tracking labor time, the date a station is completed, and the batch ID for parts
to be fabricated in the job.

A station is typically a specific operation or area of the production workflow
that you wish to record as each assembly or part passes through. This allows
you to record who did the work, when it was done, and how long it took them.

Assigning labor groups to a station can help you apply your own specific
determinations for labor applications. When you assign labor groups to a
station, Tekla PowerFab assigns all labor time from the assigned labor groups
in the linked estimating job to the station.
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For example, if the labor time for cutting includes bringing the material into
the shop, labor groups GetPc (get piece) and Move can be assigned to the
Cut/Saw station. In this case, Tekla PowerFab would gather the labor time for
all these labor groups from the linked estimating job and use the labor time in
the project schedule.

A route is a specific list of stations that determine what work is required and
the order in which it should be done in a particular set of circumstances.
Routes are applied to the production control bill of materials, which in turn
dictates what stations a given assembly or part is required to pass through in
order for it to be complete.

You can create new routes and stations, or modify and delete the existing
ones.

See also

Create, modify, and delete routes (page 797)

Manage stations (page 794)

Manage stations
In the Stations dialog box, you can create new stations, or modify or delete
the existing ones. You can also change how the stations are displayed when
creating routes.

To access the Stations dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Station and Route Setup .

The Stations dialog box opens.

Production Control 794 Set up the Production Control module



On the left-hand pane, you can view the existing stations.

On the right side of the dialog box, you can drag and drop the stations to
change the layout that is used in the Routes dialog box.

Create a station

1. Go to Maintenance --> Production Control --> Station and Route Setup
--> . The Stations dialog box opens.

2. Click New. The Station Details dialog box opens.

3. Modify the automatically generated station number according to your
needs.

4. Type a description for the new station. 

For example, Iron worker.

5. In the Type list, select Production or Field. 

• Production: Production steps that happen within the workshop, such
as cutting.

• Field: Production steps that happen outside the workshop, such as
erecting.

6. To assign labor groups to the new station, do the following:

a. Click the Select Labor Groups button.

b. In the Select labor groups to associate with this station dialog box,
click the arrow buttons to move the desired labor groups to the
Included list.
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c. Click OK.

7. Click Save. 

You return to the Stations dialog box.

The new station is added to the list on the left-hand pane and a box
representing the station appears in the graphical area.

8. To resize the newly created station in the graphical area, use the mouse to
drag the outlinesof the box until the size matches the other boxes.

9. Use the mouse to drag the new station to the desired position.

10. Click Save Layout.

NOTE You must add the new station to a route to be able to track it.

To do so, see Create, modify, and delete routes (page 797).

Modify a station

1. Go to Maintenance --> Production Control --> Station and Route Setup
--> . The Stations dialog box opens.

2. In the left-hand pane, click the station that you want to modify.

3. Click Properties.

4. Modify the station number and description according to your needs.

5. On the Routes tab, view the routes that contain the selected station. 

To modify the routes, double-click the desired route. For detailed
instructions on modifying routes, see Create, modify, and delete routes
(page 797).

6. To modify the labor groups assigned to the station, do the following:

a. Click the Labor Group tab to open it.

b. Click the Select Labor Groups button.

c. In the Select labor groups to associate with this station dialog box,
click the arrow buttons to move the desired labor groups to the
Included list.

d. Click OK.

7. Click Save to update the station properties.

Delete a station

Note that deleting a station is permanent and cannot be undone. If a station is
used in a production control job or a route, it cannot be deleted.

1. Go to Maintenance --> Production Control --> Station and Route Setup
--> . The Stations dialog box opens.
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2. In the left-hand pane, click the station that you want to delete.

3. Click Delete.

4. In the confirmation dialog box, click Yes to permanently delete the station.

Create, modify, and delete routes
Production stations and routes define the steps that an item goes through in
the fabrication process. Often, items with different finishes have different
routes. You can create new routes, and modify or delete existing ones in the
Routes dialog box.

NOTE You need to create all the necessary stations before you can add them to
routes.

To access the Routes dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Station and Route Setup.

3. In the Stations dialog box, click Route Maintenance.

You can see the existing routes on the left-hand pane of the Routes dialog
box.

On the right side of the dialog box, you can see all available stations. Yellow
arrows show the order of the stations on the route.
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Create a new route

1. Click New.

2. In the Route field, type an abbreviation for the route. 

For example, you can abbreviate the route for painted parts as P.

3. Type a description for the route.

4. Click the arrow on the right side of TFS Station list, and select the station
that is used for cutting and charging materials to the production control
job. 

In reports, this station is where the material cutting is completed and the
drops are sent to their assigned location. This station will be marked as
completed when you take the item from stock.

5. If you track production with the Tekla PowerFab Go dashboard, expand
the Dashboard Productivity Station section, and select the stations after
which the item is considered complete. 

If you have both production and field stations on the selected route, there
are two lists: Production list for the station where the production is
considered complete, and Field list for the station where the field work is
considered complete.

6. In the Route Type list, select which items can be assigned to the route: 

• Assembly: only main marks, or assemblies, can be assigned to the
route

• Part: only part marks, or accessory parts, can be assigned to the route

• Assembly & Part: both assemblies and accessories can be assigned to
the route.

7. If you selected Part or Assembly & Part as the route type, in the Join
With Assembly Option list, select when accessory parts should join the
assembly to which they belong: 

• Join with assembly for first station: The accessory part follows the
assembly route starting from the first station.

Note that if the part route and the assembly route have the same first
station, selecting Join with assembly for first station will mean that
the accessory part goes through the same station twice.

• Join with assembly for...: The accessory part joins the assembly route
before this station. Select the station in the list below.

• Join with assembly after...: The accessory part joins the assembly
route after this station. Select the station in the list below.

• Join with assembly after TFS station: The accessory part joins the
assembly route after the station that you selected in the TFS Station
list.

8. Select the included stations and adjust their order: 
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• Click the Not in Route tab to see the stations that are not included in
the route, and double-click all stations that you want to include in the
order that they should appear in the route.

• Open the In Route tab to see the stations that are included in the
route.

To move a station earlier or later in the route, select the station and
click the Move Up and Move Down buttons.

9. If you require a particular station to be completed before an assembly or
part can move on to the next station, select the station and then select the
Complete Previous Station First checkbox. Repeat this step for all
stations in the route.

10. Click Add.

The new route is now available for all production control jobs.

Modify a route

1. In the list on the left side of the Routes dialog box, select the route that
you want to modify.

2. Modify the route abbreviation, description, TFS station, route type, or join
with an assembly option.

3. To modify the included stations and their order, do the following: 

• Click the Not in Route tab to see the stations that are not included in
the route, and double-click all stations that you want to include in the
order that they should appear in the route.

• Open the In Route tab to see the stations that are included in the
route.

To move a station earlier or later in the route, select the station and
click the Move Up and Move Down buttons.

• If you require a particular station to be completed before an assembly
or part can move on to the next station, select the station and then
select the Complete Previous Station First checkbox.

4. If you track production with the Tekla PowerFab Go dashboard, expand
the Dashboard Productivity Station section, and select the stations after
which the item is considered complete. 

If you have both production and field stations on the selected route, there
are two lists: Production list for the station where the production is
considered complete, and Field list for the station where the field work is
considered complete.

5. Click Save to update the route.

Production Control 799 Set up the Production Control module



Delete a route

Note that deleting a route is permanent and cannot be undone.

1. In the left-hand pane, select the route that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
selected route.

Manage approval statuses for drawings
You can create, modify, or delete approval statuses for drawings in the
Approval Status dialog box.

To access the Approval Status dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Approval Status
Maintenance.

You can also access Approval Status from Maintenance --> Project
Management.

The Approval Status dialog box opens. You can view all existing approval
statuses.

If you create new approval statuses, the only available purpose options are
Approved and Hold.
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Approved means that drawings are ready for fabrication. The Approved
purpose is used as the status link in the project schedule.

Hold means that the drawings are not ready for fabrication. Items with the
Hold option can move through fabrication processes, but they will be
highlighted in red, and warning pop ups will appear during processing
updates. Any loads that contain items with the Hold purpose option cannot be
shipped.

Create an approval status option
1. Click New.

2. In the Approval Status field, type an abbreviation for the new approval
status.

3. In the Description field, type a description for the new approval status.

4. If you wish, in the Purpose list, select if items with the status option are
approved or on hold.

5. Click Add.

Modify an existing approval status
1. In the list, click the approval status that you want to modify.

2. Modify the approval status abbreviation, description, and purpose
according to your needs.

3. Click Edit to save the changes.

Delete an approval status
Deleting an approval status is permanent and cannot be undone.

1. In the list, click the approval status that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
approval status.

Create, modify, and delete material finish options
In the Finish Maintenance dialog box, you can create, modify, or delete
material finish options. You can also select the shipping routes used for each
finish option.

To access the Finish Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.
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2. On the menu, select Production Control --> Finish Maintenance .

Create a new finish option
1. Click New.

2. Type an abbreviation and a description for the new finish option.

3. If necessary, click the arrow on the right side of the Shipping Route list
and select the shipping route that you want to use for production control
items with the new finish option. 

Setting a shipping route for the finish is optional.

For more information on shipping routes, see Manage default shipping
routes (page 817).

4. Click Add.

Modify an existing finish option
1. Click the finish option that you want to modify to select it.

2. Modify the abbreviation, description, and shipping route according to your
needs.

3. Click Save.

The properties of the finish option are updated.

Delete a finish option
Note that deleting a finish option is permanent and cannot be undone.

1. Click the finish option that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the finish
option.

Create, modify, and delete global production codes
In the Global Production Code Maintenance dialog box, you can create,
modify, and delete production codes that are available in all production
control and estimating jobs. Production codes group similar items in
estimating or production control jobs, so that Tekla PowerFab calculates the
labor times based on the production code. This means that using production
codes allows you to plan production more accurately.

Note that you can only adjust production codes in the Global Production
Code Maintenance dialog box, not labor times. Tekla PowerFab automatically
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calculates the labor times for the items that have been assigned a production
code.

We recommend that you assign matching production codes to parts in both
Estimating and Production Control. This way, you can view the planned and
executed labor times in the project schedule.

To access the Global Production Code Maintenance dialog box, do the
following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Global Production Code
Maintenance .

The Global Production Code Maintenance dialo box opens.

Create a production code
Note that you can only create production codes for the current estimating job
in the Production Codes dialog box. Globally available production codes are
created in Global Production Code Maintenance.

1. At the bottom of the dialog box, click New.

2. Name the production code and type a description.

3. Do any of the following: 

To Do this
Use the estimated labor
times of items within
the production code in
Production Control

The hours associated with the production codes are
only used in Production Control. Production codes
do not affect or apply labor to estimating items.
The purpose of the hours is to pull labor
information from the estimate in the form of hours
per ton and labor percentages by labor group.

• In the Aggregate Units list, select a calculation
option.

Override the estimated
labor time of items
within the production
code in Production
Control

NOTE Manually overriding hours applies an
aggregate unit, hours per ton, that can be
applied to production control items.
However, if the manual override is used,
the labor information does not include
labor group percentages. Therefore, the
labor group percentages cannot be applied
to any production control stations. Further,
the information cannot be applied to tasks
in the project schedule and to resources
that feed information to the production
schedule. Manually overriding hours can
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To Do this

also prevent you from comparing the
linked production control job with the
estimating job.

a. Select the Override Hours checkbox.

b. Type the labor time in the field on the right
side of the checkbox.

TIP To change the units, right-click in the field
and select a suitable option in the context
menu.

4. Click Add.

Modify a production code
1. Select the production code that you want to modify.

2. Modify the production code properties according to your needs.

3. Click Save to update the production code properties.

Delete a production code
1. Select the production code that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
production code.

Manage cut lists
You can create, modify, and delete cut lists for production control jobs. You can
also lock cut lists and create cut list reports.

When you have ordered all the material for a production control job, you can
create cut lists to communicate how each bar and sheet should be cut in the
workshop.

To create a cut list, the production control job items must be combined and
linked to the material in inventory on order or in stock. Material that is on a
requisition can have a cut list report printed, but it is not saved to prepared or
saved cut lists. If material is On Order, you cannot perform the take from
stock (TFS). When you receive the material, its cut list status shows as Ready
and you can perform the TFS.
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Access Cut Lists dialog box
You can select if you want to manage and view cut lists for a specific job or for
multiple jobs at time.

• To access the Cut Lists dialog box, do either of the following:

• To view and manage several Cut Lists at a time, do the following:

1. Go to Maintenance --> Production Control --> Cut Lists.

The Select Production Control Jobs dialog box opens.

2. Select the job or jobs in the list and move to Included.

3. Click OK.

• To view and manage a job-specific cut list, do the following:

1. In the Production Control module, open a job.

2. In the Production Control ribbon tab, select Review --> Cut Lists.
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The Cut Lists dialog box opens.

Create a cut list
You can create cut lists for the current production control job in the Cut Lists
dialog box or from the purchasing reports.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Click New Cut List. 

The Production Control Purchasing Report Filters dialog box opens.

3. Select the items that you want to include in the cut list: 

When you are creating a new cut list, Tekla PowerFab by default filters the
items in the new cut list so that only items that are not yet assigned to a
cut list are included.

a. In the Production Control Purchasing Report Filters dialog box,
click Reset to reset the default filter.

b. To limit the items included in the cut list, select a filter type in the
Type list, and click Select. 

The Filter dialog box opens.

c. Click the arrow buttons to move the items that you want to include to
the Included list.

d. Click OK. 

You return to the Production Control Purchasing Report Filters
dialog box.

4. Click Make Report. 
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The Report Selection dialog box opens. You can view, print, or export the
report to view the cut list filter results.

a. Select the report that best suits your needs and click View. 

Tekla PowerFab Report Viewer opens.

Before you save the cut list, view the cut list report to check that it
contains the required materials. If the cutting details contain items
that do not match the current filter, they are highlighted in italics and
strikethrough on the reports.

b. View the report and close it.

5. In the Report Selection dialog box, click Save Cut List. 

Production Control 807 Set up the Production Control module



The Save Cut List dialog box opens.

6. Select values for Cut List Description and Date Required, and select
Share Cut List, and Lock Cut List as needed. 

Cut List Description: You can select an existing cut list to save the filtered
items there or type a new description.

Share Cut List availability depends on the selection of integrations.

7. Click Save To Cut List. 

If the combined details are not a complete match for the filter, for next
steps see Save cut list - partially matched filter (page 808). Otherwise, do
the next step.

8. When prompted, click OK to return to the Report Selection dialog box.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

The saved cut list records the selected items to be cut based on the filter.

See also

Manage cut lists (page 804)

Save cut list - partially matched filter
When you are saving the cut list, and the combined details are not a complete
match for the filter, you need to decide, what you want to include.
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1. Click one of the following: 

Include all items saves all combined items as being cut when processed
to the cut list.

Include only items matching the current filter saves only the
combined items matching the filter as being cut when processed. The
items not matching the filter remain combined to the drop and returned
to inventory when processed.

• If you select this, you are prompted to confirm your selection. Click Yes
to continue.

Don’t save partially matched cutting details to the cut list saves only
the inventory items whose combining details completely match the set
filter.

Cancel exits the dialog box without saving.

NOTE Inventory items that are already saved to a cut list are not saved
to another cut list even if they match the filter and can be viewed
on the report.

You get a confirmation that the cut list was saved.

2. To close the message, click OK.

See also

Manage cut lists (page 804)

View the details of a cut list item
You can view the details of a cut list item in the Cut Lists dialog box. You can
also cut or delete a cut list item.

From the initial cut lists window details provides you with the the list of
inventory items on the cut list. From that list of the inventory items the details
will provide the production item details being cut from the inventory item. "*"
items in the production items list do not match the filter as saved for the cut
list.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Select the cut list whose details you want to view.
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3. Click Details. 

The Cut Lists dialog box opens. It provides you with the the list of
inventory items on the cut list.

4. Perform any of the available actions.

• To view the details of the production items that are being cut from the
inventory item, click Details. Items marked with an asterisk (*) do not
match the filter as saved for the cut list.

• To cut a cut list item, see Cut a cut list item (page 811).

• To permanently delete a cut list item, click Delete and confirm by
clicking Yes.

• To swap material, see Swap a cut list item (page 810)

5. When you have viewed the item details, click the Close button (X) to close
the item details.

See also

Manage cut lists (page 804)

Swap a cut list item (page 810)

Cut a cut list item (page 811)

Swap a cut list item
Before cutting an item, it is possible to select an alternative from the inventory,
if the original item is not available.

Items with no combining details of different lengths are available along with all
inventory items that are the same length. Items of different length that have
combining details are not available for selection. Once you have chosen, the
new bar length is displayed as the material to cut in Tekla PowerFab and Tekla
PowerFab Go.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Open a cut list.

3. Click Swap Material. 

The Available to Swap dialog box opens.

4. Select the desired item and set the quantity. 

Optionally, select Use Grade Substitutions to use other suitable grades.

5. To complete the swap, click Swap.

See also

Manage cut lists (page 804)
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Cut a cut list item
You can define the cut properties and cut a cut list item in the Cut Lists dialog
box.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Select the cut list whose details you want to view.

3. Click the cut list item whose details you want to view. 

NOTE The required materials need to be in stock.

4. Click Cut. 
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A new Cut Lists dialog box opens.

5. In the Material used, define properties for the used material.

6. In the Drop section, define the drop properties.

7. In the Piece Tracking section, define the user who cut the item, the hours
used, and the batch ID.

8. Click TFS. 

The item is taken from stock and cut according to the properties that you
defined. The production control job is updated with the date/time stamp
of the cut, and the Status column is highlighted with green.

See also

Manage cut lists (page 804)

Update a cut list
You can change the name or required date of a cut list and share or lock a cut
list.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Select the cut list that you want to modify.
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3. Click Update Cut List.

4. Do any of the following: 

To Do this
Change the name of the
cut list

a. Select Set Description.

The Enter Value dialog box opens.

b. Type a new name for the cut list.

c. Click OK.

The cut list name is updated in the Cut List
column.

Change the required
date of the cut list

a. Select Set Date Required.

The Enter Value dialog box opens.

b. To open a calendar for selecting a date, click
the arrow on the right side of the field.

c. Select the new required date in the calendar.

d. Click OK.

The required date is updated in the Date Req
column.

Share or unshare a cut
list with other users

Do either of the following

• Select Share.

• Select Unshare.
Lock or unlock a cut list Locking a cut list prevents additional material from

being nested onto the expected drop of stock used
on that cut list.

Do either of the following

• Select Lock.

• Select Unlock.

See also

Manage cut lists (page 804)

Validate or revalidate cut list items
When material changes occur, you may need to validate or revalidate cut list
items.

Validate cut list items
When material changes occur, items in the Val Req column may be highlighted
with yellow. This means that you need to verify that the items still work with
the cutting details, or validate the cut list.
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1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Double-click the cut list that contains items that need to be validated.

3. Select the items that you want to validate.

4. At the bottom of the dialog box, click Validate.

Revalidate cut list items
If the Inval column is highlighted with red, you need to revalidate cut list
items.

Revalidating parts consists of uncombining the purchased materials and
recombining them to correct the cutting details. Depending on the changes
that have occurred, you may need to combine the items to a different or
additional stock length of materials.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Double-click the cut list that contains items that need to be revalidated.

3. Select the items that you want to revalidate.

4. At the bottom of the dialog box, click Re-Validate.

See also

Manage cut lists (page 804)

Lock or unlock a cut list
Locking a cut list prevents additional material from being nested onto the
expected drop of stock used on that cut list.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Do either of the following:

• To lock a cut list, select the cut list and click Update Cut List --> Lock.

When a cut list is locked, its name in the Cut List column is highlighted
with red.

• To unlock a locked cut list, select the cut list and click Update Cut List
--> UnLock.

See also

Manage cut lists (page 804)
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Share or unshare a cut list
You can share a cut list with other users.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Do either of the following:

• To share a cut list to other users, select the cut list and click Update
Cut List --> Share.

• To stop sharing a cut list to other users, select the cut list and click
Update Cut List --> Unshare.

See also

Manage cut lists (page 804)

Export a cut list to DSTV +
If you have enabled the DSTV+ integration, you can export cut list information
as a .zip package of CNC files that follow the DSTV+ file standard.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Select the cut list that you want to export.

3. Click DSTV+ Export.

4. Browse to and select the folder where you want to export the files.

5. If necessary, change the file name.

6. Click Save. 

The cut list information is exported to the selected folder. You can see the
export status in the Status dialog box.

7. To close the Status dialog box, click OK.

Next, you can extract the files from the .zip package and import the files to
the relevant machine, so that the machine will know how to cut the related
parts.

See also

Manage cut lists (page 804)

View, print, or export cut list reports
You can create reports for cut lists. After creating a report, you can print or
export it.
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1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Select the cut lists for which you want to create reports. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click Cut List Report.

4. In the Report Selection dialog box, click the report that you want to view
or print.

5. Do any of the following: 

To Do this
View the cut list report In the Report Selection dialog box,

click View.

The selected reports opens in Tekla
PowerFab Report Viewer.

Print the cut list report a. In the Report Selection dialog
box, change the number of the
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
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To Do this
send it to a recipient, select the
Attach to Email checkbox.

g. To open the file after exporting it,
select the Open Exported
Document checkbox.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Manage cut lists (page 804)

Delete a cut list
Deleting a cut list is permanent and cannot be undone.

1. Access the Cut Lists dialog box. 

See Access Cut Lists dialog box (page 804).

2. Click the cut list that you want to delete.

3. Click Delete Cut List.

4. In the confirmation dialog box, click Yes to permanently delete the cut list.

See also

Manage cut lists (page 804)

Manage default shipping routes
You can create, modify, and delete shipping routes that are available for all
production control jobs in the Shipping Route Maintenance dialog box.

Shipping routes can be used to send items within a job to multiple shipping
destinations, including intermediate destinations, such as sending material to
an external galvanizer. Items can only be shipped from their current location
to the next assigned destination, not to the final destination.

The initial location of all items is the shop location. If no shipping route is
assigned for items, the items will be shipped from the shop to the jobsite.
Items can either be returned to the shop and be added to another load with
other material items, or shipped from the intermediate destination directly to
the jobsite or next destination.
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Create a shipping route
1. Go to Maintenance --> Production Control --> Global Shipping Route

Maintenance. 

The Shipping Route Maintenance dialog box opens.

2. Click New. 

The Shipping Route dialog box opens.

Shipping Route Description: Type a description for the shipping route.

Join with Assembly Option: Select if and when the weight of an
accessory part is included in the shipping weight of the assembly.

• None: The weight of the accessory is not included in the shipping
weight of the assembly. If the Jobsite destination is in the shipping
route, select the None option.

• Join with assembly for first destination: The weight of the accessory
is joined to the shipping weight of the assembly for all of its
destinations except for the first one.

• Join with assembly for...: The weight of the accessory is included in
the shipping weight of the assembly for the destination that you select
in the Join with Assembly For list, and for any other destinations after
that one.
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• Join with assembly after...: The weight of the accessory is included in
the shipping weight of the assembly for all destinations after the
destination you select in the Join With Assembly After list.

3. To add, modify, or remove destinations, see Manage shipping destinations
(page 820). 

NOTE The shipping route can have any number of destinations, or no
destinations at all. If the Jobsite destination is present, it is always
the last destination on the shipping route. The Jobsite destination
is the Ship To address defined for each production control job in
the Production Control Job Edit dialog box.

4. To change the order of destinations in the shipping route, do the
following:

a. Select the destination that you want to move to an earlier or later
position on the shipping route.

b. Click the Move Up and Move Down buttons as needed..

5. Click Save Route.

The new shipping route is now available in all production control jobs.

Copy a shipping route
You can copy an existing shipping route to create a new shipping route.

1. Go to Maintenance --> Production Control --> Global Shipping Route
Maintenance . 

The Shipping Route Maintenance dialog box opens.

2. In the list, select the shipping route that you want to use as the basis of a
new shipping route.

3. Click Copy. 

The Shipping Route dialog box opens.

4. In Shipping Route Description dialog box, type a description for the new
shipping route.

5. Modify the shipping route properties as needed.

6. Click Save Route.

Modify a shipping route
1. Go to Maintenance --> Production Control --> Global Shipping Route

Maintenance . 

The Shipping Route Maintenance dialog box opens.

2. Select the shipping route that you want to modify.
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3. Click Properties. Deleting a shipping route is permanent and cannot be
undone.

4. Modify the shipping route properties as needed.

5. Click Save Route to save the changes.

Delete a shipping route

NOTE Deleting a shipping route is permanent and cannot be undone.

1. Go to Maintenance --> Production Control --> Global Shipping Route
Maintenance . 

The Shipping Route Maintenance dialog box opens.

2. Select the shipping route that you want to delete.

3. Click Delete.

4. Click Yes to permanently delete the shipping route.
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Manage shipping destinations
You can add a new destination to a shipping route, modify the properties of an
existing destination, and delete destinations.

You are either managing default shipping routes in Maintenance -->
Production Control or creating or modifying a production control job and
defining shipping route properties in the Production Control module.

Add a new destination
You can add new destinations to a shipping route and modify and delete
existing ones.

To add a new destination in the shipping route, do the following:

1. Click Add. 

The Shipping Destination Properties dialog box opens.

2. In the Destination Group field, do either of the following: 

• To create a new destination group, type a description for it in the
Destination Group field.

• To modify an existing destination group, select a destination group in
the list.

Destination groups provide a list of available destinations and are often
best used by containing all the similar destinations in a single group. If
shipping tickets are required from a destination back to the shop, it is

Production Control 821 Set up the Production Control module



recommended not to use the shop as an additional group because that
location is already assigned a function, and using the shop as a group may
cause confusion.

Note that you cannot modify the firms in the Jobsite destination group.

3. Modify the firms in the destination group: 

• To add a firm, click Add Firm, select the firm type and firm name, and
click OK.

You can only select firms that are already saved in the Address Book.

• To remove a firm from the destination, click the firm, click Remove
Firm, and click Yes to confirm deleting the firm.

• To set a firm as the primary firm, click the firm, and click Set Firm as
Primary.

The primary firm will have the remaining totals reported against it in
production statuses, production control reports, and project summary
reports. However, parts assigned to the shipping route can be shipped
for any of the firms that you have added.

4. Click Save Destination.

Modify a destination

To modify a destination, do the following:

1. In the Destination list, click the destination that you want to modify.

2. Click Properties.

3. Modify the firms of the destination as needed

4. Click Save Destination.

Delete a destination

1. In the Destination list, click the destination that you want to remove from
the shipping route.

2. Click Delete.

3. Click Yes to confirm deleting the destination from the shipping route.

See also

Manage default shipping routes (page 817)

Manage shipping routes for a production control job (page 878)

Add, modify, and delete top text items for shipping tickets
In the Shipping Top Text Maintenance dialog box, you can create standard
memos, notes, or other text items to be added at the top of shipping tickets.
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1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Shipping Top Text
Maintenance .

Create a top text item
1. At the bottom of the Shipping Top Text Maintenance dialog box, click

New.

2. In the Description field, type a name for the top text item.

3. In the Top Text field, type the information to be added at the top of the
shipping tickets.

4. Click Add.

Modify a top text item
1. In the Shipping Top Text Maintenance dialog box, select the top text

item that you want to modify.

2. In the Description field, modify the item name according to your needs.

3. In the Top Text field, modify the top text according to your needs.

4. Click Edit to save the changes.

Delete a top text item
1. In the Shipping Top Text Maintenance dialog box, select the top text

item that you want to delete.

2. Click Delete.

3. To permanently delete the top text item, click Yes in the confirmation
dialog box.

Add piece tracking and load tracking information and loads
to production control jobs
You can add information to any product control job in the Production/
Shipping Entry dialog box in Tekla PowerFab. You can add piece tracking
information and loads, ship and unship loads, and add piece marks to trucks.

NOTE The Production/Shipping Entry dialog box only allows you to add one item
at a time.

To open the Production/Shipping Entry dialog box, do the following:

1. Click the Maintenance ribbon tab.
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2. On the menu, select Production Control --> Production/Shipping Entry .

The Production/Shipping Entry dialog box opens on the Piece Tracking
tab.

Add piece tracking information
In the Production/Shipping Entry dialog box do the following:

1. In the Action list, select the action that you want to perform. You can add
or delete items.

2. In the Job # list, select the production control job for which you want to
perform the action.
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3. Select the main mark, piece mark, sequence, lot number, station, the
employee who is adding the information, and date. 

NOTE The employee must be a Tekla PowerFab user.

4. In the Quantity field, enter the number of pieces being worked on.

5. In the Hours field, enter the hours used for working on the item.

6. To perform the action, click Add or Delete.

The action is updated to the selected job. The action also appears in the
History list at the bottom of the Production/Shipping Entry dialog box.

Add loads, ship loads, and unship loads
In the Production/Shipping Entry dialog box, do the following:

1. Click the Trucks tab to open it.

2. In the Action list, select the action that you want to perform. 

You can add or validate, ship, or unship trucks.

3. In the Job # list, select the production job for which you want to perform
the action.

4. Select the load number, shipping date, and destination in the appropriate
lists.

5. If necessary, click View to view the items assigned to the selected load.

6. If the load needs to be returned, select the To Be Returned checkbox. 

The load must be returned even if the materials will not be physically
returned. Returning the loaded items allows the piece marks to be loaded
onto a new shipping ticket that contains items delivered to the job site.
This way, Tekla PowerFab can keep accurate records of when parts were
received and shipped.

7. To perform the action, click Add/Validate, Ship, or Un-Ship. 

The action is updated to the selected production control job. The action
also appears in the History list at the bottom of the Production/Shipping
Entry dialog box.

8. If needed, create and view the shipping ticket:

a. Click Shipping Ticket.

b. In the Report Selection dialog box, select the report that you want to
view, print, or export.

c. Do any of the following: 

To Do this
View the shipping ticket • Click View.
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To Do this
Print the shipping ticket 1. To change the number of the printed copies,

click + or -.

2. Click Print.

The Select Printer dialog box opens.

3. Select a printer.

4. Click OK.
Export the shipping
ticket

1. Click Export.

The Export Options dialog box opens.

2. Select the Export Format

3. To browse to the location where you want to
save the file, click Browse and select the
location.

4. Click Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

7. To open the file after exporting it, select the
Open Exported Document checkbox.

8. Click Export.

Add piece marks to trucks
In the Production/Shipping Entry dialog box, do the following:

1. Click the Load Tracking tab to open it.

2. In the Action list, select the action that you want to perform. 

You can add, delete, return, or unreturn items.

3. Select the main mark, piece mark, sequence, lot number, load number,
and date.

4. If necessary, click View to view the items assigned to the selected load.

5. In the Quantity field, enter the number of pieces that are worked on.

6. Click Add, Delete, Return, or Un-Return. 

The action is updated to the selected production control job. The action
also appears in the History list at the bottom of the Production/Shipping
Entry dialog box.

7. If necessary, view the shipping ticket:
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a. Click Shipping Ticket.

b. In the Report Selection dialog box, select the report that you want to
view, print, or export.

c. Do any of the following: 

To Do this
View the shipping ticket In the Report Selection dialog box, click View
Print the shipping ticket 1. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer
to select it.

4. Click OK.
Export the shipping
ticket

1. In the Report Selection dialog box, click
Export.

2. In the Export Format list, select an export
format.

3. Click Browse.

4. Browse to the location where you want to save
the exported file, and click Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

7. To open the file after exporting it, select the
Open Exported Document checkbox.

8. In the Report Selection dialog box, click
Export.

Review production statuses of jobs
You can view the current production station of items in a single production
control job or a group of jobs by using the Production Status command.

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Production Status .
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3. In the left-hand pane of the Production Status Filters dialog box, select
checkboxes next the summary fields to include the related properties as
columns in the summary of the production statuses. 

Selecting summary field checkboxes can make it easier to view the overall
production progress of multiple jobs.

4. To only view the status of specific types of items, select a filter type in the
Type list, and click Select. 

For example, to only view particular jobs, select Job # and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to view to the
Included list.

• Type the maximum and minimum values for the items that you want
to view.

6. Click OK. 

To further limit the visible items, repeat steps 3 to 5 for all necessary filter
types.

7. At the bottom of the Production Status Filters dialog box, select
checkboxes next to the information that you want to show in the
production status summary. 

You can select to show the TFS status, weight, gross weight, assembly
weight, or gross assembly weight.

8. Click OK to view the production statuses of selected items.

The Production Status dialog box opens, displaying a summary of the
production statuses of items in the selected production control jobs.

If necessary, you can export the production status summary to Microsoft Excel
to save the production status information. Right-click in the display are of the
Production Status dialog box, and in the context menu, select Export to
Excel.

Create global production control reports
Global production control reports contain information from multiple
production control jobs. You can create either purchasing reports or
production reports.

See also

Craete purchasing reports for all jobs (page 828)

Create production reports for all or several jobs (page 830)
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Craete purchasing reports for all jobs
You can create, view, and print purchasing reports involving all production
control jobs in the Purchasing Reports dialog box.

Create a purchasing report

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Purchasing Reports .

3. In the Select Production Control Jobs dialog box, click the arrow buttons
to move the production control jobs that you want to include in the
reports to the Included list. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

4. Click OK.

5. To limit the items that are included in the reports, in the Production
Control Purchasing Report Filters dialog box, select a filter type in the
Type list, and click Select.

6. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the items whose heat documents
you want to view to the Included list.

b. Type the maximum and minimum values for the items whose heat
documents you want to view.

7. Click OK. 

To further limit the items in the reports, repeat steps 5 to 7 for all
necessary filter types.

8. Click the arrow on the right side of Weight Type field, and select the
weight type that you want to use in the report. 

Note that the Weight Type list is only visible if you have selected it on the
Report Settings tab of the Company Standards dialog box.

The net weight option is only available if CNC files have been loaded for
the items included in the report.

9. Click Make Report.

10. In the Report Progress dialog box, click the report that you want to view
or print. 

To modify the visible reports, click the Edit Report Types button.

View the report

• In the Report Selection dialog box, click View.
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The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer to select it.

4. Click OK.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Save a cut list

1. Click Save Cut List.

2. In the Job # list, select the job.

3. In the Cut List Description field, either enter a description directly in the
field, or click the arrow on the right side of the field to select an option in
the list.

4. Click the arrow on the right side of the Date Required field, and click a
date in the calendar to select it.

5. If you do not want anyone to make changes to the cut list, select the Lock
Cut List checkbox.

6. Click Save To Cut List. 

Tekla PowerFab saves the cut list. You can view and modify the cut list in
the selected production control job and in the Tekla PowerFab Go web
application.

7. Click OK to close the Message dialog box.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create production reports for all or several jobs
You can view, print, or export reports that include information from all or
several production control jobs. The available reports include master shipping
lists and station summaries.

To create production control reports, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Production Control --> Reports .
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3. In the Select Production Control Jobs dialog box, click the arrow buttons
to move the jobs that you want to include in the reports to the Included
list..

4. Click OK.

5. To only include specific types of items in the reports, in the Production
Control Report Filters dialog box, select a filter type in the Type list, and
click Select.

6. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to include in
the reports to the Included list.

• Type the maximum and minimum values for the items that you want
to include in the reports.

7. Click OK.

8. Click Make Report.

9. In the Report Selection dialog box, select the report that you want to
view, print, or export.

You can modify the visible report types by clicking Edit Report Types.

View a report

• In the Report Selection dialog box, click View.

The selected report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print a production report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer to select it.

4. Click OK.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Export a production report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.
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4. Browse to the location where you want to save the exported file, and click
Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

7. To open the file after exporting it, select the Open Exported Document
checkbox.

8. In the Report Selection dialog box, click Export.

9.2 Open the Production Control module
To manage the production process, open the Production Control module.

• At the top of the Tekla PowerFab window, click the Production Control
button. 

The Select Production Control Job dialog box open. You can view all existing
jobs

Production Control 832 Open the Production Control module



NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs checkbox.

Next, you can create a new job, open or modify an existing job, or view and
modify the documents attached to a job.

Create a production control job
To create a new job, you need to define a few properties.

1. Open the module.

The Select <Module> Job dialog box opens.

2. Click Add

The <Module> Job Edit dialog box opens.

Continue to defining the properties on the tabs.

By clicking the buttons, you can find more settings.

NOTE Defining job-specific properties is optional. If you do not define job-specific
properties, Tekla PowerFab uses the default properties defined in
Maintenance --> Company Standards.
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Define general settings
1. In the <Module> Job Edit dialog box, select the General tab.

2. Add or modify the properties as needed. 

Option Description
Job Date The date your company received the job. Tekla

PowerFab automatically uses the current date.
Job # A unique number for the job.

Note that the job number cannot be modified after
the job has been created.

Shipping Date The estimated shipping date of the job.
Job Description The description of the job.
Job Location The town or city where the job takes place.
Job Status The job is either still in progress (Open) or it has

been finished (Closed).

You can filter the Select <Module> Job dialog box
by Job Status, so that only open jobs are shown.

ERP Job # The accounting system job number.

Typing the accounting system job number in the
ERP Job # field allows you to link material items
properly when you export information to an
accounting system, such as Trimble Viewpoint.

Job Group Job groups allow you to identify and classify jobs
that are similar. This makes filtering and reporting
easier when you have a long list of jobs.

Either type a job group directly in the blank field, or
click the arrow on the right side of the field to
select an existing job group.

Comment Any additional comments on the job.
Shipping Comment Comments on the shipping of the job.

For example, you can add information on shipping
restrictions.

Project Management
Job

Select the project management job that you want
to link to the production control job. Linking allows
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Option Description
you to import useful information from the selected
project management job.

The project management job needs to be linked to
the production control job to access the drawings
in the Production Control module.

To load general and client contact information
from the selected project management job to the
production control job, click Load Info.

Estimate Select the estimating job that you want to link to
the production control job. Linking allows you to
apply the labor from the estimating job to the
production control job.

To load general information from the estimating
job the production control job. Tekla PowerFab will
fill the related fields on the General tab with
information from the selected estimating job.

To load information from the selected estimating
job, click Load Info.

3. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

Define client details (Sold To/Ship To)
On the Sold To/Ship To tab, you can define buyer contact information for the
job.

1. <Module> Job Edit dialog box, select the Sold To/Ship To tab. 
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2. Add or modify the properties as needed. 

Option Description
Sold To Select the buyer in the list.

Note that only companies and
contacts that have already been
saved in the Address Book as Client
can be selected.

Ship To Select the receiver in the list.

The contact information is automatically added to the blank fields. You
can modify the details as needed.

3. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

Define input settings
On the Input Settings tab, select how Tekla PowerFab interprets and displays
the information in the Production Control module, if the information is from
an imported bill of materials, or directly entered in the Production Control
dialog box.
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For information on defining default input settings, see Define default input
and display units for Production Control (page 779).

1. Click the Input Settings tab to open it.

2. Modify the settings as needed. 

Option Description
Main Mark Input Type Allows you to select the input format for main

marks.

Select a suitable option on the drop-down menu.
We recommend selecting the Any Input - Logical
Sort option.

Piece Mark Input Type Allows you to select the input format for piece
marks.

Select a suitable option on the drop-down menu.
We recommend selecting the Any Input - Logical
Sort option.

Drawing Number Input
Type

Allows you to select the input format for drawing
numbers.

Note that the input format of drawing numbers in
a production control job needs to match the input
format set in the linked project management job.
Otherwise, the drawings will not be available in the
Production Control module or in Tekla PowerFab
Go.

Select a suitable option on the drop-down menu.
We recommend selecting the Any Input - Logical
Sort option.

Sequence Input Type Allows you to select the input format for
sequences.

Select a suitable option on the drop-down menu.
We recommend selecting the Any Input - Logical
Sort option.

Use Lot Numbers When selected, you can divide a sequence or
phase into subcategories within a production job
by using lot numbers.

It is highly recommended to select the Use Lot
Numbers option.

Note that selecting or clearing the Use Lot
Numbers checkbox only applies to new production
control jobs automatically. If necessary, the Use
Lot Numbers checkbox can be manually selected
or cleared for existing jobs as well.
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Option Description
Main Piece Case Allows you to select uppercase or lowercase letters,

or both, for main mark numbers. This makes
recognizing the main pieces easier.

Accessory Piece Case Allows you to select uppercase or lowercase letters,
or both, for piece mark numbers. This makes
recognizing the piece marks easier.

Main Member Instance
Tracking

When selected, the history of each individual
instance, or piece, within an item can be identified
and tracked through all production steps.

If you select the Main Member Instance Tracking
checkbox, instance tracking will be activated for all
new production control jobs. However, existing
jobs will not be affected. You can still activate or
deactivate the instance tracking of main piece
marks for each production job individually.

Accessory Part
Instance Tracking

When selected, the history of each individual
instance, or piece, within an item can be identified
and tracked through all production steps.

If you select the Accessory Part Instance
Tracking checkbox, instance tracking will be
activated for all new production control jobs.
However, existing jobs will not be affected. You can
still activate or deactivate the instance tracking of
piece mark items for each production job
individually.

Piece Mark Force Same
Info

When selected, the same information is forced to
accessories with the same piece marks. Selecting
the Piece Mark Force Same Info checkbox
prevents adding or importing items with the same
piece mark but different material information to
the production control job.

Note that the Piece Mark Force Same Info option
is connected to the Edit Line Item - Update
accessories with the same piece mark list. You
cannot select an option in the Edit Line Item -
Update accessories with the same piece mark
unless the Piece Mark Force Same Info checkbox
is selected.

AutoCalc Drawing
Number

When selected, Tekla PowerFab enters a drawing
number into the drawing number field based on
the main mark. This option works correctly if the
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Option Description
first number of each shop detail drawing main
piece is the drawing number.

If the marking system that you use does not have
the drawing number as the first number of the
main mark, do not select the AutoCalc Drawing
Number checkbox.

Default Finish The default finish for items.

The available finish options are set in the Finish
Maintenance dialog box.

You can change the finish for each main mark item
in a production control job. The finish of the main
mark item is also applied to all of the included
accessories.

Click the arrow on the right side of Default Finish
field, and click a suitable default option in the list to
select it.

TFS - Drop Job Reserve Select the way of dealing with the drop from a cut.
You can keep the remnants in the job, reserve
them for a different job, or unreserve them.

Allow Cut List Grade
Substitution

When selected, allows you to choose items with
subsitutable grades while processing a cut list.

Piece Tracking by Time When selected, allows you to make piece tracking
entries in that include the completion time, so that
you can tell in which shift an item was completed.

The completion time is also visible in piece tracking
reports.

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the changes you made are saved.

You can find and define further job-specific settings by clicking the buttons.

Define combining optimizations for a production control job
You can define job-specific settings for material optimization.

You are in the Production Control module. You are either creating a new job
or modifying an existing job in the Production Control Job Edit dialog box.

1. Click Combining Optimizations.

The Combining Setup dialog box opens.
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2. Modify the settings on the various tabs as needed.

Define the general settings

1. Go to the General Settings tab.

2. Modify the settings as needed. 

Option Description
Use Grade Substitutions Select to check for material in

inventory that has an alternative
grade to the one specified.

Only grades of an equal or higher
rating will be used as set in
Maintenance --> Shapes/Grades/
Sizes --> Shape/Grade/Size
Maintenance dialog box.

If the grade substitutions are not set,
the material grades in the combining
run and in the supplier pricing data
set or the inventory need to match
each other exactly.

Combine Only Within Sequence Select if you want to mult and nest
only materials that are in the same
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Option Description
sequence onto the inventory items or
purchasable lengths.

The selection of Combine Only
Within Sequence uses additional
material for each sequence. This may
be desirable in some cases, but it may
also lead to excess drop amounts.

Optimizations Not Included/
Optimizations Included

Allows you to select the optimization
options that you want to use by
moving them to the Optimizations
Included list using the arrow buttons.

Inventory Exact-Match (In Stock) Use this option for inventory items in
stock that are an exact match without
the use of kerf or clamp allowance.

Inventory Exact-Match (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that are an
exact match without the use of kerf or
clamp allowance.

Inventory Least-Scrap (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that will
provide the least amount of scrap.

Inventory Least-Scrap (In Stock) Use this option for inventory items in
stock that will provide the least
amount of scrap.

Warehouse Least-Scrap Use this option to give preference to
warehouse items that will provide the
least amount of scrap. Warehouse
items will only be used when they
provide less scrap than the available
inventory items or no inventory
exists.

Warehouse Force Inventory Use this option to force the use of
inventory items if available regardless
of the amount of scrap, no matter
where it is located in the
Optimizations Included list. This
option is the opposite of Warehouse
Least-Scrap.

Note that you can only include
Warehouse Least-Scrap or
Warehouse Force Inventory, not
both.
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3. Modify the order of the optimizations by using the Move Up and Move
Down buttons 

The order is important when you are performing a combining run.

4. To define the inventory material available for combining, click Default
Inventory Filter and select the filters.

5. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define multing settings

1. Go to the Mult Settings - Linear Material tab.

2. Modify the settings as needed. 

Option Description
Apply Kerf Select if you want to apply the

material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Allow Split T's Select to allow split tees.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define plate nesting settings

1. Go to the Plate Nesting Settings tab.

2. Modify the settings as needed. 

Option Description
Shear Cut Optimization Select a suitable shear cut option. The

selected option determines the plate
allowance to be used with the
combining:

• None: Use when cutting plate on a
burn table.

• Shear Cut - First Cut Along
Length or Shear Cut - First Cut
Along Width: Use to alert Tekla

Production Control 842 Open the Production Control module



Option Description
PowerFab that the nesting needs
to allow for that type of cut first.
Then, the nesting will allow for all
subsequent cuts to be made with
that condition.

Apply Kerf Select if you want to apply the
material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Rotate Plates for Best Fit Select if the material grain direction is
unimportant and you want Tekla
PowerFab to create the best possible
optimization of a plate.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

When you click Save, the Combining optimizations settings are saved.

See also

Define default combining optimizations for Production Control (page 779)

Troubleshoot combining issues (page 1110)

Define suppliers for a production control job
You can define job-specific suppliers, or pricing data sets, for angles, beams,
plates, rods, tubes, and other material.

You are in the Production Control module. You are either creating a new job
ormodifying an existing job in the Production Control Job Edit dialog box.

To make suppliers available in the Suppliers dialog box, you must first add the
suppliers in Maintenance --> Pricing Maintenance.

1. Click Suppliers. 

The Suppliers dialog box opens.

2. Select suppliers for each material group on the drop-down lists.

3. Click OK.

4. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.
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• Continue to add or modify properties.

When you click Save, the changes you made are saved. You can further modify
the job properties by clicking the buttons.

See also

Create a production control job (page 833)

Modify a production control job (page 851)

Define default suppliers for Production Control (page 783)

Define input and display units for production control jobs
You can define input and display units for individual jobs. You can select either
metric or imperial units and the units of measurement for a piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

You are in the Production Control module. You are either creating a new job
or modifying an existing job in the Production Control Job Edit dialog box.

1. Click Input/Display Units. 

The Input/Display Units dialog box opens.

2. Select the measurement system and the units of measurement on the
drop-down menus.

3. Click OK. You return to the <Module> Job Edit dialog box.

4. Do either of the following:

• Click Save

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the changes you made are saved.

See also

Create a production control job (page 833)

Modify a production control job (page 851)

Define default input and display units for Production Control (page 779)

Link a production control job to an estimating job and a project
management job
By linking a production control job to an estimating job and a project
management job, you can compare the estimated and actual working hours
and material information.
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1. At the top of the Tekla PowerFab window, click the Production Control
button.

2. In the Select Production Control Job dialog box, select the production
control job that you want to link to a project management job.

3. Click Edit.

4. In the Production Control Job Edit dialog box, click the arrow on the right
side of the Project Management Job list and select the desired project
management job. 

The project name and job number do not need to match.

5. To load general information from the selected project management job to
the production control job, click Load Info. 

Tekla PowerFab fills the related fields on the General tab with information
from the selected project management job, and loads the addresses from
the first company tab in the project management job onto the Sold To/
Ship To tab.

6. Click Save.

7. Re-open the Production Control Job Edit dialog box.

8. Click the arrow on the right side of the Estimate list and select the desired
estimating job in the list. 

The job numbers do not need to match.

9. To load general information from the selected estimating job to the
production control job, click Load Info. 

Tekla PowerFab fills the related fields on the General tab with information
from the selected estimating job.

10. Click Save.

Find a production control job
You can search to find a specific job.

1. In the Select Production Control Job dialog box, click the Production
Control ribbon tab.

2. Select Find Job or press Ctrl+F on the keyboard. 

The Enter Value dialog box opens.

3. Select the job in the drop-down menu or enter the job number in the
search box.
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4. Click OK.

The selected job is highlighted. To open the job, double-click it or click Open.

NOTE Jobs whose statuses are set to Closed are not shown by default. To
show closed jobs, select the Show Closed Jobs checkbox.

Open a production control job
To view or modify the items in an existing production control job, you need to
open the job.

1. In the Select Production Control Job dialog box, select the job that you
want to open. 

NOTE Jobs whose statuses are set to Closed are not shown by default.
To show closed jobs, select the Show Closed Jobs checkbox.

2. Double-click the job, or click Open.

The Production Control dialog box opens.
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NOTE If the Open to Filter Selection checkbox has been selected in
Maintenance --> Production Control --> Company Standards, the
Production Control Filters dialog box opens first.

See Filter information in the Production Control dialog box
(page 848).

(1) Navigation tree: Allows you to view items by drawing number, shape,
sequence, or load.

Click + to expand a category, and click a subcategory to only display items of
that category.

(2) Summary: By default, shows the quantity, length, area, and weight of each
item, the current item and assembly, the selected items, all items shown in the
display area, and the entire job.

You can click the checkbox in the upper-left corner of the summary to select
for which items you want to show the summary.

(3) Find: Use the button to find items of a specific shape, material grade, or
material dimension, or a specific item in the production control job. For
instructions, see Find production control items (page 849).

(4) Input section: Allows you to modify the information of new or selected
material items.

(5) Sequence: The section shows the sequences of the selected item, and the
Edit Sequences button allows you to manage the sequences. For instructions,
see Manage the sequences and lots of selected production control items
(page 904).
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(6) Information grid: allows you to view the overall situation of the material
item:

• REQ: The number of pieces that are on a requisition and have not yet been
combined or purchased.

• INV: The number of pieces that have been combined in the production
control job and are currently listed in a purchase order.

• TFS: The number of pieces that have been taken from stock and are being
worked in the shop.

(7) Links, Piece Tracking, Loads, and Production Status: The buttons allow
you to view and manage the item's station summary and the loading situation,
and view the production status and the linked material items in other
modules. If multiple items are selected, the information of the last selected
item is shown.

For instructions, see View material links (page 867), Track production by piece
mark (page 931), Create and manage loads (page 919), and Review the
production statuses of items (page 866).

See also

Filter information in the Production Control dialog box (page 848)

Filter information in the Production Control dialog box
In addition to using the navigation tree for filtering items, you can set filters
that determine which items are shown in the Production Control dialog box.
You can also save the filter settings for later use.

If the Open to Filter Selection checkbox has been selected in Maintenance --
> <Module> --> Company Standards, the <Module> Filters dialog box opens
automatically when you open a job.

If the Open to Filter Selection checkbox has not been selected, open the
<Module> Filters dialog box as follows:

1. In an open production control job, click the Production Control ribbon
tab.

2. On the menu, select Filter. 
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The <Module> Filters dialog box opens.

3. Select a filter type in the Type list and click Select. 

The Filter dialog box opens.

For some filter types, you can also click Find and type the desired value in
the search box to use it. This way, you do not have to scroll through all the
available items.

4. Click the arrow buttons to move the items that you want to display to the
Included list.

5. Click OK. 

If you want to further filter the information displayed , repeat steps 3 to 5
for different items. Note that only items that match the items in the
Included list will be available when setting more filters.

If you want to clear all filter settings, click Reset.

6. Click Apply Filter.

The <Module> Filters dialog box closes, and the items are filtered according
to the settings you made.

To display all information again, click Clear Filters in the upper-left corner.

To create and save commonly used filters, see Create and modify module-wide
filters (page 261).
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Find production control items
Use the Find button in to quickly find items in an open production control job.
You can search for items by material shape, grade, and dimensions, or by page
and item number.

1. In an open production control job, click Find.

2. Do one of the following: 

To Do this
Find all items that have a particular
shape, grade, and dimensions

a. In the Find menu, select Find
Shape/Grade/Size.

b. In the Find dialog box, select the
right shape, grade, and
dimensions in the available lists.

You can also start typing the
shape, grade, or dimensions.
Tekla PowerFab will suggest
options that match what you
have typed.

c. Click Find.

The Find dialog box closes. Only the
items that match your search are now
shown in the current production
control job.

Find the right item on a particular
page of the estimating job

a. In the Find menu, select Find
Item.

b. In the Find dialog box, select the
main mark and piece mark in the
available list.

You can also start typing the
main mark or piece mark. Tekla
PowerFab will suggest options
that match what you have typed.

c. Click Find.

The Find dialog box closes. Only the
items that match your search are now
shown in the Estimating dialog box.

See also

Manage production control items (page 895)
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Manage files for a production control job
Document Index is a place for storing files to be shared among other users.
In Document Index, you can store various kinds of documents for reference,
and modify, delete, open, and email these files.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

See also

Document Index (page 149)

Modify a production control job
You can modify the properties of an individual job at any time, no matter if the
current properties have been set for all jobs in Company Standards or for an
individual job when creating it.

The changes override the company standard settings for the current job.

NOTE You cannot change the job number.

1. Open the module. 

The Select <Module> Job dialog box opens.

2. Select the job that you want to modify.

3. Click Edit. 
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The <Module> Job Edit dialog box opens.

For details on the properties, see Create a production control job
(page 833)

4. Click Save .

The <Module> Job Edit dialog box closes. The job is updated to match the
changes that you made.

Create a production control job (page 833)

View the production dashboard
You can view and manage the Tekla PowerFab Go production productivity
dashboard and the shipping calendar for a job directly from Tekla PowerFab
desktop application.

For a user to be able to view the dashboard, the Administator must add the
user's PowerFab Go Site Address in File --> Administration. See Define Tekla
PowerFab administration settings (page 77).

For more information on the production dashboard, see Tekla PowerFab Go
User Guide.

• In Production Control, do either of the following:
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• To get an overview, in the Select Production Control Job dialog box,
click Dashboards.

• To open a dashboard for a job, in the Select Production Control Job
dialog box, open a job, click the Production Control ribbon tab, and
select Dashboards.

The Dashboard view opens.

To access other functionalities of Tekla PowerFab Go, you have to open
Tekla PowerFab Go in a browser.
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9.3 View production control job details
You can view multiple details regarding production control jobs, such as the
changes made to the jobs, and the production statuses and inspection
statuses of items. You can also view and adjust the project schedule and the
production schedule, or create production reports.

See also

View all changes in a production control job (page 860)

Manage production control job information (page 863)

View and adjust the project schedule (page 702)

View the production schedule (page 886)

View, print, and export job-specific production control reports (page 891)

Manage changes to a production control job
You can view and assess the impact of changes caused by importing new or
revised drawings or bills of materials into Tekla PowerFab.

Before the actual import, you can view a summary of changes and decide to
accept the changes, reject them, or save them for later.

When the changes are saved for later, they are put on hold so that another
person can review them and decide on the appropriate action. When a
drawing is on hold, it cannot be worked on until the change has been reviewed
and processed.

Import changes to a production control job
1. Go to File --> Import. 

The Import dialog box opens.

2. In the navigation tree on the left, select Production Control and the file
type that you want to import.

3. To select the file, click the ellipsis button (…) and select the file you want to
import.

4. Click Open.

5. Click Import. 

TIP You can also click Test Import, which simulates the import process
and checks for issues but does not actually import any material.

The Production Control Job Edit dialog box opens.

6. In Job #, type the name of the job you want to update.
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7. Click Save. 

The Import dialog box opens.

8. Select the desired option and click OK.

9. Click Yes to confirm. 

The Import log and Change Summary dialog boxes open.

View the summary of revisions
When you are importing files, and revisions are found, the Change Summary
dialog box opens.

(1) Navigation tree: You can narrow down the list of items shown.

• Object Type: Assembly (default), Drawing, All

• Change Type: Update (default), Addition, All

If there are no assembly updates in the job, you can see all changes to all
items.

(2) View: An alternative way of selecting the Object Type (default Assemblies)
and Change Type (default Updates)

(3) Grid: The list of changes

• Colors:

• Red: Update not possible

• Yellow: Highlights impacts if import performed

• Type: Change type

• Drawing #: Drawing number

• Main Mark: If the line represents a drawing, this cell is blank. Then the
approval status is shown. IH stands for "Import Hold".

• Buttons:
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• Linked: Yes appears if the material in the assembly in the production
control job is linked to a requisition, purchase orders or inventory, or a
cut list.

• Tracking: Yes appears if anything in the assembly has piece-tracking
entries.

• TFS: Yes appears if anything in the assembly has been taken from stock.

• Shipped: Yes appears if anything from the assembly is on a load.

• Hold: When selected, puts the selected item on hold and sets the Approval
Status to IH (Import Hold).

• Action: Allows you to select the desired action for the selected row

• Allow implements the changes once the import is completed. You can
select Allow only if the changes can be made. The changes are applied
to the Production Control bill of materials and the associated assembly
drawings are updated in the drawing log.

For changes that cannot be made, you can only select Save for Later or
Prevent.

• Save for Later saves the changes and puts the selected items on hold
so that they can be reviewed.

• Prevent rejects the changes.

TIP To customize the grid, right-click it, and select Customize grid.

(4) Quick edit items: Allow you to select and apply actions for multiple rows at
once.

• Set Selected on Hold: Allows you to place the selected items on hold.

• Set Selected Action: Allows you to select Allow, Save for Later or Save
for Later in the Action column for the selected items.

(5) Summary of changes

(6) Details regarding the changes.

Manage changes
When you are importing revised drawings or bills of materials, you can review
the changes and select the subsequent actions in the Change Summary
dialog box.

1. In the navigation tree or View menus, select the object type and change
type.

2. Select one or more changes. 
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TIP To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. To review the impact of a change, click one of the following buttons
(optional):

• Linked: Yes appears if the material in the assembly in the production
control job is linked to a requisition, purchase orders or inventory, or a
cut list.

Clicking this button opens the material Links dialog box

.

• Tracking:: Yes appears if anything in the assembly has piece-tracking
entries.

Clicking this button opens the Production Status dialog box.

• TFS: Yes appears if anything in the assembly has been taken from
stock. Clicking this button opens the Production Status dialog box.

• Shipped: Yes appears if anything from the assembly is on a load.

Clicking this button opens the Production Status dialog box.

4. Select one of the following in Actions:

• To implement the change, select Allow. This automatically removes the
Hold flag.

• To postpone implementing the change or have someone else to review
it, select Save for Later. The item is put on hold.

• To reject the change, select Prevent.

TIP If you have selected multiple items, you can put all items on hold by
selecting Set Selected on Hold or select an action for all of the
selected items in Set Selected Action.

5. To complete the import of the changes with the selected values, click
Continue. 

While you are importing, changes that affect the items being imported
may occur. Then the Continue button changes to Retry.

When you click Retry, this reloads all the changes and reports the new
status of the changes.

6. To confirm your action, select a suitable option.
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View change report
If you select View Report, the report opens in Tekla PowerFab Report
Viewer when you click Continue.

When you complete the import of changes by clicking Continue, a report on
the changes is automatically saved to the Document Index.

You can change the view in the report by clicking the hyperlinks.

Review and manage saved changes in a job
To get an overview of which jobs have pending changes, you can customize the
grid in Select Production Control Job to include the Has Pending Changes
column. See Customize the layout of a dialog box (page 258).

1. Open a job. 
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If there are changes that have been saved for later, the dialog box shows
the Review Pending Changes button.

Red color indicates items that have a hold placed on them. IH status in the
App column stands for "Import Hold".

2. To view changes that have been saved for later, do either of the following:

• Click Review Pending Changes.

• In the Production Control ribbon tab, go to Review > Pending
Changes.

The Pending Changes dialog box opens showing the change summary.

3. To review the impact of a change, click one of the following buttons
(optional):
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• Linked: Yes appears if the material in the assembly in the production
control job is linked to a requisition, purchase orders or inventory, or a
cut list. Clicking this button opens the material Links dialog box.

• Tracking:: Yes appears if anything in the assembly has piece-tracking
entries. Clicking this button opens the Station Summary dialog box.

You can change the piece tracking information for this assembly.

• TFS: Yes appears if anything in the assembly has been taken from
stock. Clicking this button opens the TFS Details dialog box.

You can reverse or update the TFS for this part.

• Shipped: Yes appears if anything from the assembly is on a load.
Clicking this button opens the Loads dialog box.

You can remove the part or assembly from the load.

4. Select one of the following in Actions.

• To implement the change, select Allow.

• To postpone implementing the change or have someone else to review
it, select Save for Later. The item remains in hold and in Pending
Changes.

• To remove the change, select Delete.

TIP If you have selected multiple items, you can put all items on hold by
selecting Set Selected on Hold or select an action for all of the
selected items in Set Selected Action.

View all changes in a production control job
Tekla PowerFab records every change made in the system. This is useful
because you can view all changes made in the current production control job
at once. You can then filter the information to see changes made by a
particular user or on a particular date. You can also print the list of changes.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select History of Changes --> List Of Changes .

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user, revision
number, category, sub-category, or
pay category

a. Select the right filter type and
click Select.

b. Click the arrow buttons to move
the values that you want to see in
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To Do this
the list of changes to the
Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date filter

and click Select.

b. Select the start (Min) and end
(Max) dates in the calendar.

You can also select the
Expression checkbox for the
dates. This way, you can select
the base date and define how
many days before or after are
taken into account in the list of
changes.

c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do any of the following: 

To Do this
View the list of changes • Click View.

The report opens in Tekla PowerFab Report
Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.
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To Do this
c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

View all changes since importing the bill of materials (page 862)

View, print, and export job-specific production control reports (page 891)

View all changes since importing the bill of materials
You can view and review all changes that have been made in a production
control job since a bill of materials has been imported. Use the History of
Changes command.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select History of Changes --> History of Changes .

3. In the History of Changes dialog box, select the items whose changes you
want to view in the available lists 

To view all items, clear all text from the lists.

4. Click OK.

5. To only include changes of specific properties, click the arrow buttons to
move the properties that you want to include to the Included list.

6. If necessary, filter the changes: 

To Do this
Filter changes by user a. In the Filters section, click Edit

on the right side of the User
filter.
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To Do this
b. Click the arrow buttons to move

the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. In the Filters section, click Edit

on the right side of the Date
filter.

b. Select the start (Min) and end
(Max) dates in the calendars.

c. Click OK.

7. In the lower-left corner of the dialog box, select checkboxes to indicate if
you want to include changes related to sequences, piece tracking, or load
tracking.

8. Click View History of Changes. 

The history of changes appears. The items in the dialog box are color-
coded to show any changes that have been made:

• Items highlighted with green have not been changed since they were
imported.

• Items highlighted with yellow have been changed since they were
imported. The Type column shows how the items have changed.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

View all changes in a production control job (page 860)

View, print, and export job-specific production control reports (page 891)

Manage production control job information
You view and adjust information on the current production control job using
the Review command that is found in the Production Control ribbon tab.

Manage job-specific cut lists
You can create, modify, and delete cut lists for the current production control
job in the Cut Lists dialog box. You can also lock cut lists, and create cut list
reports.

1. Access the Cut Lists dialog box. See Access Cut Lists dialog box (page 804)
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The items in cut lists are highlighted with green, yellow, or red:

• Green: Item completed

• Red: Item needs attention or is locked. For example, the item can be
past the assigned due date.

• Yellow: Item needs attention. For example, the item may be missing
information or need validation.

You can limit the visible cut lists by selecting a job, shape, main mark,
piece mark, sequence, or lot by clicking options in the navigation tree on
the left.

The combining result for which items have been purchased needs to be
reviewed to verify that the saved cutting patterns are still valid. Items may
need to be recombined. After recombining, the changes need to be saved
to the current cut list.

For instructions and details on the properties, see Manage cut lists (page 804).

See also

Create a cut list (page 806)

View the details of a cut list item (page 809)

Swap a cut list item (page 810)

Cut a cut list item (page 811)

Update a cut list (page 812)

Validate or revalidate cut list items (page 813)

Lock or unlock a cut list (page 814)

Share or unshare a cut list (page 814)

Export a cut list to DSTV + (page 815)
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View, print, or export cut list reports (page 815)

Delete a cut list (page 817)

Manage production codes used in a production control job
You can create new production codes for the production control job, or modify
and delete existing production codes in the PDC Production Codes dialog
box. You can override the estimated hours and use aggregate units to
calculate the planned labor time on a job. This labor time can then be used in
production schedules and project schedules.

To assign production codes to material items, use the Global Edit command.
For more information, see Modify multiple production control items
(page 902).

Open the PDC Production Codes dialog box

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Review --> Production Codes .

The PDC Production Codes dialog box opens.

Create a production code

1. In Production Control module, open a job and go to Production Control --
> Review --> Production Codes 

The PDC Production Codes dialog box opens.

2. Click New.

3. In the Production Code field, type an abbreviation for the production
code. 

For example, you can use B1 for beams or C1 for columns.

4. Type a description for the production code.

5. If you want to use aggregate units for the planned hours instead of the
original estimated hours, do the following:

a. Select the Override Hours checkbox.

b. Type the hours in the field.

c. To change the aggregate units used, right-click the field and select the
suitable units in the context menu.

The estimated hours are always created in the estimate. They are not
overwritten by the production code properties.

The planned hours that you define here are automatically used in the
project schedule. However, if you link the production control to a
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matching estimate, the estimated hours are automatically used in the
project schedule.

6. Click Add.

The new production code is added.

Modify a production code

1. In Production Control module, open a job and go to Production Control --
> Review --> Production Codes 

The PDC Production Codes dialog box opens.

2. Select the production code that you want to modify.

3. Modify the production code name, description, hours, and aggregate
units.

4. Click Save to update the properties.

Delete a production code

Note that deleting a production code is permanent and cannot be undone.

1. In Production Control module, open a job and go to Production Control --
> Review --> Production Codes 

The PDC Production Codes dialog box opens.

2. Select the production code that you want to delete.

3. Click Delete.

4. In the confirmation dialog box, click Yes to permanently delete the
production code.

Review the production statuses of items
You can review the production statuses of main mark items in the current
production control job in the Production Status dialog box.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Review --> Production Status .

3. To only review the production statuses of particular items, in the
Production Status Filters dialog box, select a filter type in the Type list,
and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the values that you want to review to
the Included list.
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• Type the maximum and minimum values for the items that you want
to review.

5. Click OK. 

To further limit the items that you want to review, repeat steps 3 to 5 for
all necessary filter types.

6. Click checkboxes next to the item properties that you want to view in the
left-hand pane and at the bottom of the dialog box.

7. If you do not want to view the production status of items without piece
tracking or load tracking, select the Exclude Accessories without Piece/
Load Tracking checkbox.

8. Click OK to view the production statuses of the selected items.

The Production Status dialog box opens, displaying the production stations,
field stations, and shipping conditions of items in the current production
control job.

The information is color-coded:

• Completed stations and operations are highlighted with green. The
completion date is also displayed.

• All work that is in progress is highlighted with yellow.

• If no progress has been made regarding the station or operation, items are
highlighted with red.

Note that you can export the production status information as a Microsoft
Excel worksheet. Right-click anywhere in the display area of the Production
Status dialog box, and in the context menu, select Export to Excel.

View material links
The Links button in production control jobs allows you to view the properties
of the requisition, inventory, and inventory history materials to which the
selected production control items are linked.

1. Select items in the Production Control dialog box. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Links button near the lower-right corner. 

The Links dialog box opens, showing a list of all the linked material items
in other Tekla PowerFab modules.

3. Select the item that you want to view in its own location in Tekla
PowerFab.

4. Click one of the following: 
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• Open Inventory or Open Inventory History

The name of the button changes depending on whether or not the
material is still in the inventory or has already been taken from stock.

• Open Purchase Order

• Open Cut List

TIP Alternatively, you can double-click any item to open the inventory or
inventory history.

See also

Manage production control job information (page 863)

Add, modify, and review inspection test records
You can run inspection tests and follow-up tests, or modify and view the
existing inspection test records in the Test Records dialog box. You can also
create reports that allow you to review if the inspection tests have been
successful or not.

To access the Test Records dialog box, do the following:

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Review --> Inspection Test Records .

The Test Records dialog box opens, displaying all existing inspection test
records.
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If you need to modify the setups of inspection tests, see Modify the setup of
an inspection test (page 873).

Add a new inspection test record

1. At the bottom of the dialog box, click Run Test.

2. Click the arrow on the right side of the Test Type, Category, and Test
Title fields, and select suitable options in the lists. 

The preloaded test types are:

• Assembly: the test subject is an assembly or a part flagged for piece
tracking in a production control job.

• Employee: the test subject is a Tekla PowerFab user.

• Environmental: a general test without a subject.

• Equipment: a general test without a subject.

• Fitting: a general test without a subject.

• General: a general test without a subject.

• Load: the test subject is a shipping load in a production control job.

• Part: the test subject is a part in a production control job.

• Training: a general test without a subject.

3. Click OK.

4. To determine the test subject, in the Test Subject section of the New
Inspection Test Record dialog box, do the following:
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a. Click the arrows on the right side of the available fields and select
suitable options in the lists.

b. Type values in the fields.

5. Define the inspection test record properties by using the available lists
and fields. 

The mandatory fields and lists depend on the test type that you selected.

6. If you want to save the same properties for the next records you add,
select the Carry Over checkbox in the lower-left corner. 

Note that if you close the New Inspection Test Record dialog box, you
can no longer use the properties of the latest inspection test record you
added.

7. Click Save.

The new inspection test record is added to the Test Records dialog box.

Add, modify, and review inspection test records
You can run inspection tests and follow-up tests, or modify and view the
existing inspection test records in the Test Records dialog box. You can also
create reports that allow you to review if the inspection tests have been
successful or not.

To access the Test Records dialog box, do the following:

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Review --> Inspection Test Records .

The Test Records dialog box opens, displaying all existing inspection test
records.
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If you need to modify the setups of inspection tests, see Modify the setup of
an inspection test (page 873).

Filter inspection test records

1. At the top of the dialog box, click Set Filters.

2. In the Test Record Filters dialog box, do any of the following:

• On the Test Record and Test Subject tabs, click the available filter
buttons, and click the arrow buttons to move the values that you want
to display to the Included list.

• Click the Test Date button, click the arrows on the right side of the
minimum and maximum date lists, and select dates in the calendars.

If necessary, you can also create an expression for the date.

• On the Field Filters tab, click Add Field Filter, and click the arrow
buttons to move the fields that you want to display at the top of the
Test Records dialog box to the Included list.

3. Click OK.

4. Click Apply Filter.

The Test Records dialog box now only displays the information that you
selected.

Run a follow-up test

To record a follow-up test for a failed test record, do the following:

1. Click the inspection test record for which you want to add a follow-up test.
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2. Click Run Follow-Up Test.

3. In the New Inspection Test Record dialog box, modify the test
properties.

4. Click Save.

The follow-up test is added to the list in the Test Records dialog box.

Modify an inspection test record

1. Click the inspection test record that you want to modify in the list.

2. At the bottom of the dialog box, click Inspection Test Properties.

3. Modify the inspection test properties according to your needs.

4. Click Save to update the properties.

View, print, and export inspection test reports

You can create various reports based on inspection tests. You can check if the
inspection tests have been successful and find the problems by creating
reports by worker, parts, assemblies, sequence, location, test, categories and
sub-categories.

1. In the Test Records dialog box, click the Test Records ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. In the Report Selection dialog box, click the report that you want to
create.

4. According to your needs, do any of the following: 

Option Description
View the report • In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report
Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the report a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. Click Print.

c. In the confirmation dialog box, click Yes to
print the selected report.

d. In the Select Printer dialog box, click a printer
to select it.
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Option Description
e. Click OK.

Export the report a. In the Report Selection dialog box, click
Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. In the Report Selection dialog box, click
Export.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Modify the setup of an inspection test
You can modify the testing requirements that the inspector will use for each
test in the Inspection Test Setup dialog box.

To access the Inspection Test Setup dialog box, do the following:

• At the bottom of the Test Records dialog box dialog box, click Inspection
Test Properties.

To modify the testing requirements, do all of the following:

1. Modify the test properties

1. At the top of the Inspection Test Setup dialog box, modify the test
properties according to your needs.

2. Click the arrow on the right side of Test Type field, and select the test type
in the list. The preloaded test types are:

• Assembly: The test subject is an assembly or a part flagged for piece
tracking in a production control job.

• Employee: The test subject is a Tekla PowerFab user.

• Environmental: a general test without a subject

• Equipment: a general test without a subject
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• Fitting: a general test without a subject

• General: a general test without a subject

• Load: The test subject is a shipping load in a production control job.

• Part: The test subject is a part in a production control job.

• Training: a general test without a subject

3. Type a unique title for the test. 

The title is automatically copied to the Category field.

4. In the Category field, do one of the following:

a. To create a new category, type the category name in the Category
field.

b. To use an existing category, click the arrow on the right side of the
Category field, and select an existing category in the list.

Categories are used to group similar tests together. For example, if you
have several weld tests, you can set the category to Weld for all of the
tests to make it easier to filter that group of tests.

5. Click the arrow on the right side of Production Station field, and select
the production station that will be marked as completed when a
successful or passed test record is added. 

Note that the Production Station option is only available if the test type
is set to Assembly.

6. If you only want main members to be used as test subjects, select the
Main Members Only checkbox. 

Note that the Main Members Only checkbox is only available if the test
type is set to Assembly.

7. In the Notes field, type any instructions for performing the test, or other
applicable notes. 

The text in the Notes field will be displayed when you add a new test
record.

8. Click Save Inspection Test to save the test setup.

2. Add new fields

1. In the Test Fields section of the Inspection Test Setup dialog box, click
New Field.

2. In the Field Name field of the Inspection Test Field Setup dialog box,
type the field name used in the test definition.

3. In the Title field, type the title of the field used in the New Inspection
Test Record dialog box.

Production Control 874 View production control job details



4. In the Abbreviation field, type the text used in the column header of the
Test Records dialog box.

5. In the Notes field, add any additional text or instructions regarding the
field.

6. Click the arrow on the right side of Field Type field and select a suitable
option:

• Boolean and Numeric are test types that require you to set pass and
fail criteria settings.

• Date, Text, Memo, and Drop-Down are test information options that
you can apply to the test types.

7. In the Number of Instances field, type the number of times the field will
be presented to the user when running the test.

8. In the Maximum Number of Instances field, type the maximum number
of times the field can be entered when running a test. 

If the value in Maximum Number of Instances is greater than the value
in Number of Instances, the user will have the option of adding
additional instances up to the maximum value.

9. If you only want the field to be used in follow-up test records, select the
Only for Follow-Up Test checkbox. 

For example, you can add a field whose type is Memo with the Only for
Follow-Up Test checkbox selected. This way, the inspector could type the
corrective action that was required to fix the problem in the field.

10. Click the different field type tabs in the middle of the dialog box to modify
their settings:

a. On the Boolean tab, select if entering information in the field will
indicate a failure or create a warning.

b. On the Numeric tab, select the minimum and maximum values that
may indicate a failure or create a warning, define the minimum and
maximum number of decimal places, define a prefix or a suffix for the
units of measure, and select if entering information in the field is
mandatory.

c. On the Date tab, select if entering information in the date field is
mandatory.

d. On the Text tab, select if entering information in the text field is
mandatory.

e. On the Memo tab, select if entering information in the memo field is
mandatory.

f. On the Drop-Down tab, select if the information is restricted to a list
of pre-defined options, if you want to use an existing data set as
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available options, if the available options depend on another list, or if
entering information in the field is mandatory. 

You can also add new options for the list, or modify or delete the
available options.

11. Click Save Field.

The field is added to the inspection test.

Repeat the process to create all necessary fields.

3. Modify, move, or delete fields

• In the Test Fields section of the Inspection Test Setup dialog box, do any
of the following according to your needs: 

To Do this
Modify an existing field 1. In the list, click the field that you want to

modify.

2. Click Properties.

3. In the Inspection Test Field Setup dialog box,
modify the field properties:

a. In the Field Name field, modify the field
name used in the test definition.

b. In the Title field, modify the title of the
field used in the New Inspection Test
Record dialog box.

c. In the field, type the text used in the
column header of the Test Records dialog
box.

d. In the Notes field, modify any additional
text or instructions regarding the field.

4. Click the arrow on the right side of Field Type
field and select a suitable option:

• Boolean and Numeric are test types that
require you to set pass and fail criteria
settings.

• Date, Text, Memo, and Drop-Down are
test information options that you can apply
to the test types.

5. Click the different tabs in the middle of the
dialog box, and adjust the settings according
to your needs.

6. Click Save Field.
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To Do this
Move a field up or down 1. In the list, click the field whose position you

want to change.

2. Click the Move Up and Move Down buttons to
change the location of the field.

Delete a field from the
test setup

Note that deleting a field from the test setup is
permanent and cannot be undone.

1. In the list, click the field that you want to
delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to
permanently delete the field from the test
setup.

4. Save the test and run a sample inspection test

When you have modified all necessary settings of the inspection test, save the
test and run a sample test by adding a test record. You can later delete the
sample test record.

1. Click Save Inspection Test.

2. In the Test Records dialog box, add a new test record by clicking Run
Test. 

For more information on adding a test record, see Add, modify, and review
inspection test records (page 868).

3. Ensure that the test works as intended. 

If the test does not work as intended, you can correct the errors by further
modifying the setup.

4. Click Save.

5. To delete the sample test, do the following:

a. Select the sample test in the list.

b. Click Test Record Details.

c. Click Delete.

d. In the confirmation dialog box, click Yes.

Review the inspection statuses of items
In the Inspection Status dialog box, you can view inspection records. If
necessary, you can also run inspection tests.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.
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2. On the menu, select Review --> Inspection Status . 

The Inspection Status dialog box opens, displaying a list of all main
members or accessories that have piece tracking enabled in the current
production control job. For main members, the Weight Each column
includes the weight of accessories that do not have piece tracking
enabled.

If an item belongs to multiple sequences or lots, it will appear in the list
once for each sequence/lot combination.

On the right side of the Weight Each column, there are columns for each
category of inspection tests that have been run in the current job. The
numbers in the cells of these columns indicate the number of tests that
have been run. Follow-up tests count as one regardless of how many
times they have been run.

Items highlighted with red have critical failures for which no follow-up
tests have been run.

3. View the statuses of production control items. 

To find particular items, expand and click items in the navigation tree on
the left-hand pane. You will only see items that match your selections.

4. If necessary, do one of the following:

• To view all inspection test records, click the Inspection Test Records
button at the bottom of the dialog box.

• To add a new inspection test record, click Run Test.

For more information on inspection test records, see Add, modify, and
review inspection test records (page 868).

Manage shipping routes for a production control job
You can view and modify the shipping routes used for load tracking in the
current production control job. You can also create new job-specific shipping
routes or delete existing ones.

Shipping routes can be used to send items within a job to multiple shipping
destinations, including intermediate destinations, such as sending material to
an external galvanizer. Items that are returned from one destination can then
be shipped to another destination.

Open the shipping routes dialog box

1. To open the Shipping Route Maintenance dialog box, do either of the
following:

• In the Select Production Control Job dialog box,

a. Double-click to open an existing job.

b. Click the Production Control ribbon tab.
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c. On the menu, select Review --> Shipping Routes .

• In the Select Production Control Job dialog box,

a. Either add a new job by clicking Add or modify an existing job by
selecting it and clicking Edit.

The Production Control Job Edit dialog box open.

b. Click Shipping Routes.

The Shipping Route Maintenance dialog box opens, displaying all shipping
routes created for an existing production control job.

Create a shipping route

You are in the Shipping Route Maintenance dialog box.

1. Click New. 

The Shipping Route dialog box opens.

2. Shipping Route Description: Type a description for the shipping route.

3. Join with Assembly Option: Select if and when the weight of an
accessory part is included in the shipping weight of the assembly. 

• None: The weight of the accessory is not included in the shipping
weight of the assembly. If the Jobsite destination is in the shipping
route, select the None option.
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• Join with assembly for first destination: The weight of the accessory
is joined to the shipping weight of the assembly for all of its
destinations except for the first one.

• Join with assembly for...: The weight of the accessory is included in
the shipping weight of the assembly for the destination that you select
in the Join with Assembly For list, and for any other destinations after
that one.

• Join with assembly after...: The weight of the accessory is included in
the shipping weight of the assembly for all destinations after the
destination you select in the Join With Assembly After list.

4. To add, modify, or remove destinations, see Manage shipping destinations
(page 820). 

NOTE The shipping route can have any number of destinations, or no
destinations at all. If the Jobsite destination is present, it is always
the last destination on the shipping route. The Jobsite destination
is the Ship To address defined for each production control job in
the Production Control Job Edit dialog box.

5. To change the order of destinations in the shipping route, do the
following:

a. Select the destination that you want to move to an earlier or later
position on the shipping route.

b. Click the Move Up and Move Down buttons as needed..

6. Click Save Route.

Copy a shipping route

You are in the Shipping Route Maintenance dialog box.

1. In the list, select the shipping route that you want to use as the basis of a
new shipping route.

2. Click Copy. 

The Shipping Route dialog box opens.

3. In Shipping Route Description dialog box, type a description for the new
shipping route.

4. Modify the shipping route properties as needed.

5. Click Save Route.

Modify a shipping route

You are in the Shipping Route Maintenance dialog box.

1. Select the shipping route that you want to modify.
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2. Click Properties. 

3. Modify the shipping route properties as needed.

4. Click Save Route to save the changes.

Delete a shipping route

You are in the Shipping Route Maintenance dialog box.

NOTE Deleting a shipping route is permanent and cannot be undone.

Job-specific shipping routes cannot be deleted if any parts are
assigned to them.

1. Select the shipping route that you want to delete.

2. Click Delete.

3. Click Yes to permanently delete the shipping route.

View and adjust TFS details
Performing the TFS (take from stock) process tells Tekla PowerFab that
materials have been cut. Use the TFS Details dialog box to view TFS reports,
save heat documents attached to items, and reverse the TFS status of an item
or a group of items.
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1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Review --> TFS Details .

3. To only view the TFS details of particular items, the TFS Filters dialog box,
select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the values that you want to view to
the Included list.

b. Enter the maximum and minimum values for items whose TFS details
you want to view.

5. Click OK.

6. Click Details. 

The TFS Details dialog box opens, displaying all heat documents attached
to the current job.

When heat documents are attached, the number of the documents is
displayed in the Docs column.

The items in the Docs column that are highlighted with red have no heat
documents attached.

7. In the TFS Details dialog box, do any of the following: 

To Do this
Update the information
in the TFS Details dialog
box

• Click Refresh.

View and attach
documents to items

• Click Open Document Index.

For more information on working in Document
Index, see Manage files for a production control
job (page 850).

Save attached
documents into a folder

a. Do one of the following:

• To save all documents attached to items in
the TFS Details dialog box, click Save
Documents --> Save Documents - All .

• To save the documents attached to
particular items, click the items for which
you want to create reports, and click Save
Documents --> Save Documents -
Selected .
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To Do this
b. Browse to and select the folder where you

want to save the documents, or click Make
New Folder to create a new one.

c. Click OK.

The attached documents are saved into the
selected folder.

Print attached
documents

a. Do one of the following:

• To print all documents attached to items in
the TFS Details details dialog box, click
Print Documents --> Print Documents -
All .

• To print documents attached to particular
items, click the items whose attached
documents you want to print, and click
Print Documents --> Print Documents -
Selected .

• In the Select Printer dialog box, click a
printer to select it.

• Click OK.
Create TFS reports a. Do one of the following:

• To create reports for all items in the TFS
Details dialog box, click Reports -->
Reports - All .

• To create a report for particular items, click
the items for which you want to create
reports, and click Reports --> Reports -
Selected .

b. In the Report Selection dialog box, click the
report that you want to view, print, or export.

c. Do one of the following:

• To view the report, click View.

You can use the Email Excel and Email
PDF buttons at the top of the Tekla
PowerFab Report Viewer window to
email the report via Microsoft Outlook.

• To print the report, click Print, click a
printer to select it, and click OK.

• To export the report, click Export, modify
the export properties, and click Export.
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To Do this
Reverse the TFS process Reversing the TFS process returns the selected

materials from inventory history to inventory. Note
that the materials will be returned as cut lengths,
not the original stock lengths.

a. Click the materials whose TFS process you
want to reverse.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold
down Shift.

b. In the first confirmation dialog box, click Yes
to remove any record of the TFS process from
the selected materials.

c. In the second confirmation dialog box, click
Yes to return the selected materials in
inventory history as cut lengths.

d. Type the number of materials to be returned
to inventory.

e. Click Reverse.

The materials are returned to inventory and
removed from the TFS Details dialog box.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Compare the materials in a production control job and a combining job
You can view if there are differences between the production control job
materials and a pre-purchased material list in the Combining module by using
the Compare to Combining Job command.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Review --> Compare to Combining Job .

3. In the Select Combining Job dialog box, double-click the combining job
that you want to use in the comparison. 

The Compare to Combining Job dialog box opens, displaying the
similarities and differences between the production control job and the
combining job.

Matching items in the production control job and the combining job are
highlighted with green.

Items that do not match in the combining job and the production control
job are highlighted with red.
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4. To adjust which comparison results are shown, do any of the following: 

• In the CMB Material Smaller than PDC Material section, define how
much smaller the combining job items can be compared to the
production control items without being considered critically different.

• In the CMB Material Larger than PDC Material section, define how
much larger the combining job items can be compared to the
production control items without being considered critically different.

• To only show items that differ in the production control job and the
combining job, select the Only Show Differences checkbox.

• To only show items that are greater than the maximum acceptable
length and width differences set at the top of the Compare to
Combining Job dialog box, select the Only Show Critical Differences
checkbox.

To update the comparison results, click Refresh.

5. To view the comparison results as a report, click View Report. 

The comparison report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the
Tekla PowerFab Report Viewer window to email the report via Microsoft
Outlook.

See also

Compare the labor hours in a production control job and an estimating job
(page 885)

Compare the labor hours in a production control job and an estimating
job
Use the Compare to Estimating Job command to view if there are differences
in the labor hours recorded in the current production control job and the labor
hours listed in an estimating job.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Review --> Compare to Estimating Job .

3. In the Select Estimating Job dialog box, double-click the estimating job
that you want to use in the comparison. 

The Compare to Estimate Job dialog box opens, displaying the labor
hours.

The labor hours of the estimate are displayed on the left, sorted by labor
group.
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The labor hours of the production control job are displayed on the right,
sorted by production station.

The total values appear at the bottom of the dialog box.

4. Review the comparison results.

5. To view the comparison results as a report, click View Report. 

The comparison report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the
Tekla PowerFab Report Viewer window to email the report via Microsoft
Outlook.

View the production schedule
Use the Production Schedule dialog box to view the projected hours for jobs
by week. The hours are loaded from the project schedule.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Production Schedule. 

The Production Schedule Filters dialog box opens.

3. Filter the production schedule information as needed:

a. Click the arrows on the right side of the Start and End fields, and
select suitable start and end dates in the calendars. 

The default time between the start and end dates is three months.

b. Click the arrow on the right side of the Scale field, and in the list,
select if you want to view the information by day, week, or month.

c. To only include particular resources in the production schedule, click
Resource, and click the arrow buttons to move the resources that you
want to include to the Included list.

d. To only include particular jobs in the production schedule, click Job #,
click the arrow buttons to move the jobs that you want to include to
the Included list.

4. Click Apply Filter. 
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The Production Schedule dialog box opens.

• On the left side, you can see the resources and any tasks assigned to
them. For each task assigned to a resource, the production schedule
shows the regular and overtime hours, the percentage completed, and
start and end dates. This information consists of the schedule task in
the project schedule and the production status information. To update
the information, click Update Status in the Project Schedule dialog
box.

• In the middle, you can view the default capacities of the resources and
the time for those resources by tasks. The default capacity for each
resource is displayed at the top in bold. Any hours highlighted with red
indicate that the station is over capacity. If necessary, you can modify
the resource capacity in the Resource Maintenance dialog box.

Below the resource, you can see the released and unreleased hours of
each task, and the regular and overtime hours. This information
reflects the information in the Resource Maintenance dialog box. To
update the information, click Update Status in the Project Schedule
dialog box.

• On the right side, the sections represent a block of time by the scale
that you selected in step 3. The columns on the top display the
capacity, the hours planned against the resource, the percentage of
the capacity that is planned, and the actual hours used.

5. If necessary, do any of the following: 
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To Do this
Change the filters or
scale of the production
schedule

Do either of the following:

• To change the filters that you set in step 3, click
the Set Filters button and modify the filters
according to your needs. Then, click Apply
Filter.

• Click  on the right side of the Resource / Task
column. Then, select the resources and tasks
that you want to see in the production
schedule, or type the resource or the task that
you want to see in the Filter For field.

View more or fewer
details about a resource
or a task

• On the left side of the dialog box, click + or - on
the left side of a resource or task.

When you click +, the task or the resource expands,
so that you can see the task or resource details by
the set project breakdown categories.

When you click -, the task or the resource collapses
and the details are hidden.

Collapse or expand all
tasks

a. Right-click anywhere in the production
schedule.

b. In the context menu, select Collapse All or
Expand All.

Modify a task a. Double-click a task at the lowest level of the
hierarchy.

b. In the Task Schedule dialog box, do any of the
following:

• To change the start or end date of the task,
click Set on the right side of the start or
end date, select a new date in the calendar,
and click OK.

• To move a task forward or backward in the
production schedule, click Move, select an
option in the menu, and click Yes to
confirm the changes.

• To modify the equally divided working
hours, click Manually Schedule, type the
number of manually scheduled hours, and
click OK.

Print the current
production schedule

a. Right-click anywhere in the production
schedule.
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To Do this
b. In the context menu, select Report.

The production schedule opens in the Print
Preview dialog box.

c. Adjust the printing settings according to your
needs, and click Print.

See also

Modify resource capacity (page 889)

View, print, and export job-specific production control reports (page 891)

Modify resource capacity
In the Resource Maintenance dialog box, you create, modify, and delete
resources used in the production schedule and the project schedule. You can
view and modify the applicable working hours per day, week, or month.

Open the Resource Maintenance dialog box

1. In the Production Schedule dialog box, click the Production Schedule
ribbon tab.

2. On the menu, select Resource Maintenance.

Add a resource

You can add resources in a variety of ways. It may be useful to have one
resource for the shop, or one for each of the several bays or shop sites.
Another task, like detailing, can have its own resource as well.

The capacity for each resource is entered by day and summarized by week or
by month.

When a task in the project schedule is assigned to a resource, the resource is
added to the production schedule with the same start and end dates. Planned
hours for the task are then distributed equally among the days in that
duration. You can change the distribution and allocation of the planned hours
manually.

1. Click New.

2. Type a description for the resource.

3. Click the arrow on the right side of the Calendar field and select a suitable
schedule calendar in the list.

4. In the Default Capacity field, type the number of hours available to this
resource during a standard working day.

Production Control 889 View production control job details



5. Click the arrow on the right side of Fixed Date field and select the date
after which adjustments to the schedule no longer affect the new
resource. 

For example, if the fixed date is set to Friday, any adjustments to the
schedule on the next Thursday will not affect it.

6. Click Add.

Modify a resource

1. In the list, select the resource that you want to modify.

2. Modify the description, calendar, default capacity, and fixed date
according to your needs.

3. In the Resource Utilization section, filter which capacity and utilization
information is displayed:

a. To modify the time range, click the arrows on the right side of the
start and end dates and select suitable dates.

b. Click the arrow on the right side of Scale field, and select if you want
to view the capacity and utilization information by day, week, or
month. When the scale is set to by week or month, the date displayed
for each record is by default the beginning date of each period. This
settings can be changed in Project Company Standards.

c. To update the view, click Reload.

d. If you want to open the production schedule for the selected
resource, click View.

4. To adjust the capacity of a date period, do the following:

a. In the Resource Utilization section, double-click a date.

b. In the Resource Capacity dialog box, select a date period. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

c. Type a new value in the Capacity field. 

If necessary, you can restore the default hours by clicking the Default
button.

d. To update the capacity of all selected date periods, click Update
Selected.

e. To close the dialog box, click the Close button (X) in the upper-right
corner.

5. In the Resource Maintenance dialog box, click Save to save the changes.
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Delete a resource

Deleting a resource is permanent and cannot be undone.

1. In the list, select the resource that you want to delete.

2. Click Delete.

3. In the confirmation dialog box, click Yes to permanently delete the
resource.

View, print, and export job-specific production control
reports
You can create various reports based on the information of the current
production control job, including cut lists, bills of materials, and master load
lists. Then, you can either view the report in Tekla PowerFab Report Viewer
and email it, print the report, or export the report to another file format.

NOTE Before creating a cut list, the materials need to be loaded into a purchase
order.

Create a report
1. In the Select Production Control Job dialog box, select a job and click the

Production Control ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.

3. To only include specific types of items in the report, in the Production
Control Report Filters dialog box, select a filter type in the Type list, and
click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to include in
the report to the Included list.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

• Type the maximum and minimum values for the items that you want
to include in the report.

5. Click OK. 

To further limit the items included in the report, repeat steps 3 to 5 for all
necessary filter types.

6. To include the full assemblies of all included parts in the report, select the
Include Full Assembly of Filtered Parts checkbox.
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7. Click the arrow on the right side of Weight Type field, and select the
weight type that you want to use in the report. 

Note that the Weight Type list is only visible if you have selected it on the
Report Settings tab of the Company Standards dialog box.

8. Click Make Report.

9. In the Report Selection dialog box, click the report that you want to view,
print, or export.

View the report
• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. In the confirmation dialog box, click Yes.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK to print the report.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

7. To open the file after exporting it, select the Open Exported Document
checkbox.
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8. In the Report Selection dialog box, click Export. 

The report is saved in the selected export format.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Customize reports (page 268)

Import, view, or delete CNC files
You can import CNC files to Tekla PowerFab, and view or delete the previously
loaded CNC files that are associated with the current production control job by
using the CNC Files dialog box.

To access the CNC Files dialog box, do the following:

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select CNC Files.

The CNC Files dialog box opens.

Note that:

• By default, only the latest versions of all CNC files are shown. If you want to
show all versions of CNC files, clear the Latest Only checkbox in the upper-
left corner.

• You can use the navigation tree on the left side of the dialog box to only
show particular CNC files. Click + on the left side of any category to expand
the category and select a sub-category, or expand the sub-category to
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further limit which files are shown. Only files that match the selected value
are shown.

Import CNC files
1. At the bottom of the dialog box, click Load CNC Files.

2. In the Import dialog box, click ... to set the folder from which CNC files are
imported.

3. Browse to and select the folder.

4. Click OK.

5. Type the file extension used for CNC files in the selected folder.

6. Click OK to import the CNC files.

7. In the Enter Value dialog box, type a name for the group of CNC files, and
click OK. 

Tekla PowerFab imports all CNC files from the folder that you selected.

8. Review the import results and click Close.

View CNC files
1. Select the CNC files that you want to view in the list. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. At the bottom of the dialog box, click View Selected Files.

Note that Windows may ask you to select the application with which you want
to open the CNC files.

Save CNC files to another location
To save CNC files from Tekla PowerFab to your computer or a shared drive:

1. Do any of the following: 

• To select which CNC files you want to save, select the files and click
Save Selected Files.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

• To save all files currently shown in the CNC Files dialog box, click Save
Displayed Files.

2. In the Browse for Folder dialog box, browse to and select the folder
where you want to save the files.
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3. Click OK.

The CNC files are saved in the selected folder.

Delete CNC files
Deleting CNC files from Tekla PowerFab is permanent and cannot be undone.
Note that all files imported from the same folder are deleted at once.

• Do any of the following: 

To Do this
Delete a group of CNC files 1. In the navigation tree, expand the

Group section, and select the
group that you want to delete.

2. At the bottom of the dialog box,
click Delete Group.

3. In the confirmation dialog box,
click Yes to permanently delete
the CNC files.

Delete selected CNC files 1. Select the CNC files that you want
to delete.

To select a range of subsequent
items, hold down Shift.

To select multiple items, hold
down Ctrl.

2. At the bottom of the dialog box,
click Delete Selected Files.

3. In the confirmation dialog box,
click Yes to permanently delete
the CNC files.

9.4 Manage production control items
You can manage production control items in many ways. add new production
control items, modify existing production control items, copy material items
from one drawing to another, take production control items from stock,
combine items, or send items to a purchase order or a requisition.

For more information, see the following links:

Add a production control item (page 896)

Modify production control items (page 901)

Copy materials from one drawing to another (page 906)
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Take production control items from stock (page 913)

Combine materials in the Production Control module (page 917)

Send production control items to purchasing (page 907)

Add a production control item
You can add an item to a production control job in the Production Control
dialog box.

1. At the bottom of the Production Control dialog box, click New.

2. Define the item properties. 

NOTE The visible input fields and their order depend on the settings
that you have defined in Maintenance --> Production Control -->
Edit Input Fields.

The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Approval Status The approval status of the item.

The available approval statuses are
set in the Approval Status dialog box
that you can access via Maintenance
--> Production Control --> Approval
Status Maintenance -

Select an approval status from the
drop-down menu.

Category, Sub-Category A class used for sorting items within a
job. You can use categories and
subcategories for filtering
information.

For example, you can create
categories based on the shop where
the item is created.

You can create the available
categories and subcategories in
Company Standards.

Select an existing Category or Sub-
Category on the drop-down menu or
type in a new category.

Camber A text field for camber size, that is,
curvature in an item so as to
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Option Description
compensate for deflection induced by
loads.

Dimensions * The material dimension, or material
size, of each piece.

Click the Dimensions field to select
an available material dimension, and
double-click the desired dimension in
the list.

You can also use a custom material
dimension. Note that the dimension
is not automatically added to the
material database.

To use a custom dimension:

a. Click in the Dimensions field.

b. Click Add Size.

c. Define the dimension properties.

d. Click Save.

You can now select the
dimension and use it.

Drawing Number A property that is used as the drawing
number and the drawing name. You
can use the main mark as the drawing
number.

Either select an existing drawing
number from the drop-down menu or
type in a new drawing number.

Finish The finish type of the item. The
default options are Painted,
Unpainted, and Galvanized.

Select the finish type from the drop-
down menu.

Grade * The material grade of each piece.

You can set the default grade of the
selected shape in Maintenance -->
Shapes/Grades/Sizes.

Either select the grade from the drop-
down menu or type the grade
indicator in the field.
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Option Description
Instance Tr When selected, instance tracking can

be used for the item. This allows you
to see more details about the item.

Selecting the Instance Tr checkbox
may be useful in, for example, nuclear
jobs.

Length The length of each piece.

Type in the length.
Load Tracking When selected, an accessory item can

be tracked by load and be viewed in
shipping reports. Main marks, or
assemblies, are tracked by default.

For more information on load
tracking, see Create and manage
loads (page 919).

Main Mark * The main mark of the item.

The main mark is the number of the
main member to which accessory
items can be attached.

If an item has an identical main mark
and piece marks, Tekla PowerFab
considers the item a main member.

Either select an existing main mark
from the drop-down menu or type in
the name of the new main mark. You
can enter a maximum of 25
characters, depending on the Mark
Input Type option that you have
selected in the Company Standards
dialog box.

Pay Category The pay category assigned to the
item. Pay categories can be used to
assign unit costs to fabricated items
per pound.

You can set Pay Categories in
Maintenance --> Production Control
--> Company Standards.
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Option Description
Piece Mark * The piece mark of the item.

Piece marks are used for the
accessory items that are attached to a
main member.

Type in the name of the piece mark.
You can enter a maximum of 25
characters, depending on the Mark
Input Type option that you have
selected in the Company Standards
dialog box.

Piece Tracking When selected, an accessory piece
within an item can be tracked by
piece mark. Main marks, or
assemblies, are tracked by default.

For more information on piece
tracking, see Track production by
piece mark (page 931).

Prod. Code The production code applied to the
item.

Production codes group similar items
together within jobs.

Production codes group items so that
you can apply hour per ton and per
labor group percentages to items in
the linked production control job.

The production code can be used to
color-code or filter items in Trimble
Connect. For more information.

For more information, see Use
Trimble Connect with a production
control job (page 933)

Select a production code from the
drop-down menu or type in a new
code.

Quantity * The number of pieces to be added.

Type in the number.
Reference Number A reference number that links items

in inventory or purchasing to the
production control job.

The reference number can be
different depending on the case:
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Option Description
• If an item is sent from Production

Control to Purchasing or
Inventory, Tekla PowerFab
creates a copy of the record, and
the item is linked to include the
reference number.

• If an item is sent to Purchasing
from an advanced bill of material,
the system mark number or a
combination of the page number
and the item number in the
combining job (for example, 1-30)
becomes the reference number.

• If the item is sent to Purchasing
later in the process, the reference
number is the mark or piece mark
number.

Type in the number. The maximum
number of characters is 255.

Remark Any comments or remarks that you
want to add about the item.

Type in the remarks or select an
existing remark in the list.

Revision # Drawing revision
Route The item route defines the stations

that the item goes through in the
fabrication process.

The available route options are set in
the Routes dialog box.

Click the arrow on the right side of the
Route field and select a route in the
list.

Shape * The material shape of each piece.
Shipping Route The shipping route assigned to the

item.

Shipping routes can be used to send
items within a job to multiple
shipping destinations, including
intermediate destinations, such as an
external galvanizer.

You can set shipping routes in
Maintenance --> Production Control
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Option Description
--> Global Shipping Route
Maintenance. For more information,
see Manage default shipping routes
(page 817).

Select a shipping route from the drop-
down menu.

TFS Quantity The quantity of the items that have
been processed on a cut list or taken
from stock manually from inventory
and are linked to an inventory history
record.

3. Click Add.

The new item is added to the list in the Production Control dialog box.

See also

Modify production control items (page 901)

Modify production control items
You can either modify items one by one, or use the Global Edit commands to
modify multiple items at one go.

TIP If you cannot find the property you want to modify, check if you can add it in
Maintenance --> Production Control --> Edit Input Fields.

For more information, see the following links:

Modify a single production control item (page 901)

Modify multiple production control items (page 902)

Modify the selected production control items (page 903)

Adjust sequences (page 903)

Modify a single production control item
You can modify a single production control item directly in the Production
Control dialog box.

1. In the Production Control dialog box, select the item that you want to
modify.
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2. On the right side of the dialog box, modify the item properties. 

For example, change the quantity, enable load tracking, or select a new
shipping route. For more information on the available properties, see Add
a production control item (page 896).

3. Modify the item's sequences and lots as needed. 

For more information, see Manage the sequences and lots of selected
production control items (page 904).

4. Click Save

See also

Modify multiple production control items (page 902)

Modify the selected production control items (page 903)

Adjust sequences (page 903)

Modify multiple production control items
Use the Global Edit command to modify the properties of multiple items at
one go. This way, you can save time, as you do not need to change the
properties of each item individually.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Modify Data --> Global Edit . 

The Global Edit Filters dialog box opens.

3. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

4. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

5. Click OK. 

To further limit the items to modify, repeat steps 3 to 5.

6. Click OK. 

The Global Edit dialog box opens.

7. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.
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8. Click Update. 

The Confirm dialog box opens.

9. To confirm changing the properties of multiple items, click Yes.

The changes you made to the item properties are updated.

See also

Modify the selected production control items (page 903)

Modify the selected production control items
Use the Global Edit - Selected command to modify the properties of multiple
selected items at one go. This way, you can save time, as you do not need to
change the properties of each item individually.

1. In the Production Control dialog box, click the items that you want to
modify to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Modify Data --> Global Edit Selected . 

The Global Edit - Selected dialog box opens.

4. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

5. Click Update.

The properties of the selected items are updated.

See also

Modify multiple production control items (page 902)

Adjust sequences
Using sequences and lots is a useful way to group, control, filter, and report on
items. Sequences and lots are also the most commonly used breakdown items
in project schedules. In Production Control, you can add items to different
sequences, and modify or update the sequences of items. You can also filter
the information in the Production Control dialog box by sequence.

For more information, see the following links:

Set and update sequences (page 904)

Manage the sequences and lots of selected production control items
(page 904)
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Remove all items from a sequence (page 905)

Add multiple items to a sequence (page 905)

Remove multiple items from sequences (page 906)

Set and update sequences
You can set and update the sequences of main mark items in a production
control job by using the Set Sequences command.

NOTE You should set sequences before combining materials for purchase.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Modify Data --> Set Sequences .

3. In the Set Sequences dialog box, click the arrow buttons to move the
items that you want to add to the same sequence to the right side of the
dialog box.

4. If you only want to add a specific number of pieces to the sequence, select
the item on the right side of the dialog box and type a new value in the
Quantity to Update field.

5. Select the Update Sequence checkbox and type the new sequence
number in the New Sequence field.

6. If you want to update the lot number as well, select the Update Lot #
checkbox and type the new lot number in the New Lot # field.

7. Click Update Sequences.

8. In the confirmation dialog box, click Yes to confirm setting the sequences. 

The sequences are set.

Repeat steps 3 to 8 for all items whose sequences you want to set.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

Manage the sequences and lots of selected production control items
You can add individual material items to a sequence, or remove some or all
pieces of a material from a sequence.

1. In the Production Control dialog box, select the main member of an item
whose sequences you want to modify.

2. In the lower-right corner of the dialog box, click Edit Sequences.

3. In the Set Sequences dialog box, use the arrow buttons to move the
items whose sequences you want to edit to the right side.

4. In the Quantity to Update field, define the number of pieces whose
sequence will be updated.
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5. Select the Update Sequence checkbox.

6. To adjust the item's sequence, do one of the following: 

• To add the item to an existing sequence, click the arrow on the right
side of the New Sequence field and select a sequence in the list.

• To add the item to a new sequence, type the number of the new
sequence in New Sequence field.

• To remove the item from a sequence, leave the New Sequence field
blank.

7. To adjust the item's lot, do one of the following: 

• To add the item to an existing lot, click the arrow on the right side of
the New Lot # field and select a lot in the list.

• To add the item to a new lot, type the number of the new lot in New
Lot # field.

• To remove the item from a lot, leave the New Lot # field blank.

8. To update the items' sequence and lot information, click Update
Sequences.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Remove all items from a sequence (page 905)

Remove all items from a sequence
Use the Unsequence All command to remove all pieces of a material item
from a sequence.

1. In the Production Control dialog box, select an item that has been
assigned to the sequence.

2. At the lower-right corner of the dialog box, click Edit Sequences.

3. In the Sequences dialog box, click Unsequence All.

4. In the confirmation dialog box, click Yes to remove all the sequenced
items from the sequence.

See also

Remove multiple items from sequences (page 906)

Add multiple items to a sequence
Use the Sequence All Selected to add mulitple selected production control
items to a sequence. Note that you can only use the Sequence All Selected
command if the items have not yet been added to another sequence.
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1. In the Production Control dialog box, select the items that you want to
add to a sequence.

2. Click the Production Control ribbon tab.

3. On the File menu, select Modify Data --> Sequence All Selected .

4. In the Sequence All dialog box, do one of the following:

• To add the items to an existing sequence, click the arrow on the right
side of the Sequence field, and select a sequence in the list.

• To add the items to a new sequence, type a new sequence number in
the Sequence field.

5. Click Sequence All.

The items are added to the selected sequence.

See also

Remove all items from a sequence (page 905)

Remove multiple items from sequences (page 906)

Remove multiple items from sequences
Use the Unsequence All Selected command to quickly remove the selected
production control items from sequences. Once the items have been removed
from the original sequences, you can add them to new sequences according to
your needs.

1. In the Production Control dialog box, select the items that you want to
remove from sequences. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Modify Data --> Unsequence All Selected .

4. In the confirmation dialog box, click Yes to unsequence the selected
items.

See also

Set and update sequences (page 904)

Remove all items from a sequence (page 905)

Copy materials from one drawing to another
Use the Copy Drawing command to copy materials from one drawing into
another drawing.
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1. In the Production Control dialog box, click the item whose drawing you
want to copy.

2. Click the Production Control ribbon tab.

3. On the menu, select Modify Data --> Copy Drawing .

4. In the Copy Drawing dialog box, type a number for the new drawing.

5. Click OK.

6. Review the new mark numbers and change them according to your needs:

a. In the list, select the mark that you want to change.

b. Type a new mark number. 

Repeat steps a to b for all mark numbers that you want to adjust.

7. Click Copy.

The Copy Drawing dialog box closes. The items in the original drawing are
copied to the new drawing.

Send production control items to purchasing
Use the Purchasing commands to send production control items to the
Purchasing module. You can send material items into requisitions or purchase
orders, link materials to requisitions or purchase orders, take materials from
stock in order to charge them to a job, create reports, and finalize the
production control job.

For more information, see the following links:

Load all production control items into a requisition (page 908)

Load all production control items into a purchase order (page 907)

Load the selected production control items into a requisition (page 910)

Load the selected production control items into a purchase order (page 909)

Link materials in Production Control to Purchasing (page 910)

Unlink materials between Production Control and Purchasing (page 911)

Verify material links between Production Control and Purchasing (page 912)

Check purchase orders for received materials (page 912)

Take production control items from stock (page 913)

Finalize a production control job (page 946)

Load all production control items into a purchase order
You can load all materials in a production control job into a purchase order by
using the Load Material Into Purchase Order command.
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1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Purchase
Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.

5. Click OK to close the Import Items dialog box. the Production Control
dialog box.

Materials are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

See also

Load the selected production control items into a purchase order (page 909)

Load all production control items into a requisition
Use the Load Material Into Requisition command to load all material items
in a production control job into a requisition.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Purchasing --> Load Material Into Requisition .
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3. In the Select Requisition dialog box, select a requisition and click OK. 

If necessary, you can also create a new requisition and load the items into
it.

4. In the Purchasing Import Filters, do one of the following: 

To Do this
Load all items • Click Import.
Filter out items
that you do
not want to
load

a. On the left side of the dialog box, select a filter type in
the Type list, and click Select.

b. Click Select.

c. Click the arrow buttons to move the items that you want
to load to the requisition to the Included list.

The items on the Not Included side will not be sent to
purchasing.

d. Repeat the process for different filter types until you
have filtered out all unnecessary items.

e. Click Import.

5. Click OK to close the Import Items dialog box. the Production Control
dialog box.

Materials are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

See also

Load the selected production control items into a requisition (page 910)

Load the selected production control items into a purchase order
Use the Load Selected Material Into Purchase Order command to select the
material items in a production control job that you want to load into a
purchase order.

1. In the Production Control dialog box, select the items that you want to
load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. On the menu, select Purchasing --> Load Selected Material Into
Purchase Order .

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.
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4. Click OK to close the Import Items dialog box. the Production Control
dialog box.

Materials are loaded into the selected purchase order. To view and use the
purchase order, go to the Purchasing module and open the Purchase Orders
tab.

See also

Load all production control items into a purchase order (page 907)

Load the selected production control items into a requisition
Use the Load Selected Material Into Requisition command to select the
materials in a production control job that you want to load into a requisition.

1. In the Production Control dialog box, select the items that you want to
load. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Purchasing --> Load Selected Material Into
Requisition .

4. In the Select Requisition dialog box, select a requisition and click OK. 

If necessary, you can also create a new requisition and load the items into
it.

5. If you only want to send the items in specific sequences or lots into the
requisition, in the Purchasing Import Filters dialog box, select a filter
type in the Type list, and click Select.

6. In the Filter dialog box, click the arrow buttons to move the sequences
and lots whose items you want to load into the requisition to the
Included list.

7. Click OK to close the Import Items dialog box. the Production Control
dialog box.

Materials are sent to the selected requisition. To view and use the requisition,
open the Purchasing module and go to the Requisitions tab.

See also

Load all production control items into a requisition (page 908)

Link materials in Production Control to Purchasing
Link materials in Production Control to pre-purchased advanced bill materials
by using the Link Job command. Tekla PowerFab uses reference numbers to
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match the materials across modules. Any unlinked materials, such as loose
pieces, will be loaded into a requisition or a purchase order to be purchased.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Purchasing --> Link Job .

3. To limit which materials are linked, in the Link Filters dialog box, select a
filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the items whose heat documents
you want to view to the Included list.

b. Type the maximum and minimum values for the items whose heat
documents you want to view.

5. Click OK.

6. If necessary, select the If updating a cut list item, exclude from being
cut checkbox. 

By selecting the checkbox, you can ensure that Tekla PowerFab does not
invalidate the entire cut list when an item in the cut list is updated.
Updated items will be saved in the inventory to be processed later.

7. Click Link.

8. In the Link Items dialog box, click if you want to load material information
to a requisition or a purchase order.

9. Click the desired requisition or purchase order.

10. Click OK to load the materials.

11. Click OK to close the Link Items dialog box.

See also

Unlink materials between Production Control and Purchasing (page 911)

Verify material links between Production Control and Purchasing (page 912)

Unlink materials between Production Control and Purchasing
Use the Un-Link Job command to unlink materials between Production
Control and Purchasing when you need to manually manage the materials.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Purchasing --> Un-Link Job .

3. To only unlink specific types of materials, in the Un-Link Filters dialog
box, select a filter type in the Type list, and click Select.
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4. In the Filter dialog box, do one of the following depending on the filter
type:

a. Click the arrow buttons to move the items whose heat documents
you want to view to the Included list.

b. Type the maximum and minimum values for the items whose heat
documents you want to view.

5. Click OK.

6. Click Un-Link.

7. In the Un-Link Items dialog box, review the un-linking results.

8. Click OK to close the dialog box.

See also

Link materials in Production Control to Purchasing (page 910)

Verify material links between Production Control and Purchasing
You can verify that all material in Production Control is currently linked to
purchasing by using the Verify Links command. This is a quick way to verify
that the material links between Production Control, Requisitions, and
Inventory are maintained. This command can be useful when importing
revised drawings, for example.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Purchasing --> Verify Links .

3. In the Verify Links dialog box, check that all material items are linked to
purchasing.

4. Click OK to close the dialog box.

See also

Link materials in Production Control to Purchasing (page 910)

Unlink materials between Production Control and Purchasing (page 911)

Check purchase orders for received materials
You can check purchase orders for received materials that will be used for
production control items by using the the Check Material For TFS and Check
Selected Material For TFS commands.

Check purchase orders for all materials

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.
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2. On the menu, select Purchasing --> TFS --> Check Material For TFS .

3. To only take specific materials from stock, in the TFS Filters dialog box,
select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the values that you want to take from
stock to the Included list.

• Type the maximum and minimum values for the items that you want
to take from stock.

5. Click OK.

6. Click TFS.

7. In the TFS dialog box, review the information and do any of the following:

• Click Close to close the dialog box.

• Click Reports and view or print TFS reports according to your needs.

For more information on viewing and printing reports, see View, print,
and export job-specific production control reports (page 891).

Check purchase orders for selected materials

1. In the Production Control dialog box, click the items whose availability
you want to check.

2. Click the Production Control ribbon tab.

3. On the menu, select Purchasing --> TFS --> Check Selected Material For
TFS .

4. In the TFS Filters dialog box, click TFS.

5. In the TFS dialog box, review the information and do one of the following:

• Click Close to close the dialog box.

• Click Reports and view or print TFS reports according to your needs.

For more information on viewing and printing reports, see View, print,
and export job-specific production control reports (page 891).

Take production control items from stock
You can take purchased material items from the inventory and charge the
purchased items to the current production control job. Use the TFS and TFS -
Selected commands.

If you only want to take one item from stock, see Take a single cut list item
from stock (page 915).
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Take all items from stock

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Purchasing --> TFS --> TFS .

3. To only take specific types of items from stock, in the TFS Filters dialog
box, select a filter type in the Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the values that you want to take from
stock to the Included list.

• Type the maximum and minimum values for the items that you want
to take from stock.

5. Click OK.

6. Click TFS.

7. In the Enter Value dialog box, click the arrow on the right side of the field,
and select a date in the calendar.

8. Click OK to check which items are linked and which items are actually
available to be taken from stock.

9. To confirm taking all of the remaining items from stock, click Yes in the
confirmation dialog box.

10. In the TFS dialog box, review the information and do one of the following:

a. To close the dialog box, click Close.

b. To view or print TFS reports, click Reports. For more information on
viewing and printing reports, see View, print, and export job-specific
production control reports (page 891).

Take the selected items from stock

Use the TFS - Selected command to only take selected items from stock in a
production control job. The purchased items will be taken from the inventory,
and the cost of the selected items will be charged to the current production
control job.

1. In the Production Control dialog box, click the items that you want to
take from stock to select them. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Purchasing --> TFS --> TFS - Selected .
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4. To select the sequence and lot of the items that you want to take from
stock, in the TFS Filters dialog box, select a filter type in the Type list, and
click Select.

5. In the Filter dialog box, click the arrow buttons to move the sequences or
lots whose items you want to take from stock to the Included list.

6. Click OK.

7. In the TFS Filters dialog box, click TFS.

8. In the Enter Value dialog box, click the arrow on the right side of the field,
and select a date in the calendar.

9. Click OK to take the material from stock.

10. If you have selected multiple items, click Yes in the confirmation dialog
box to take the items from stock.

11. In the TFS dialog box, review the information and do one of the following:

a. To close the dialog box, click Close.

b. To view or print TFS reports, click Reports. For more information on
viewing and printing reports, see View, print, and export job-specific
production control reports (page 891).

Take a single cut list item from stock
You can take a single cut list item from stock by using the TFS Entry command.
Tekla PowerFab will then process the cut list item and charge the purchased
materials to the job.

NOTE The necessary materials need to be received in the purchase order
before you can take them from stock.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select TFS Entry.

3. To filter which items are shown:

a. In the Production Control Purchasing Report Filters dialog box,
select a filter type in the Type list, and click Select.

b. In the Filter dialog box, click the arrow buttons to move the items
that you want to see to the Included list.

c. Click OK.

Repeat steps a to c to set all of the necessary filters.

4. Click Make Report.

5. In the TFS Entry, select the desired cut list in the Cut List Serial # list. 
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Only the items on the selected cut list are shown in the list below.

Note that if any changes are made to the cut list, its serial number will no
longer be valid.

If you want to check the details of the selected cut list using reports, you
can click Reports in the upper-right corner.

6. In the list of items, select the item that you want to take from stock.

7. Click TFS.

8. In the Cut Lists dialog box, define the cut list properties and add drop
lengths according to your needs.

9. Click TFS to take the selected item from stock.

The item is removed from the inventory and charged to the current production
control job.

See also

Take production control items from stock (page 913)

View or print job-specific purchasing reports
You can create purchasing reports for a particular production control job.

Create job-specific purchasing report

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Purchasing --> Reports .

3. To limit the items that are included in the reports, in the Production
Control Purchasing Report Filters dialog box, select a filter type in the
Type list, and click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the values that you want to include in
the reports to the Included list.

• Enter the maximum and minimum values for items that you want to
include in the reports.

5. Click OK. 

To further limit the items in the reports, repeat steps 5 to 7 for all
necessary filter types.

6. Click Make Report.

7. In the Report Progress dialog box, click the report that you want to view
or print.
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View the purchasing report

In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the purchasing report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer to select it.

4. Click OK.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

Save a cut list

1. Click Save Cut List.

2. In the Job # list, select the job.

3. In the Cut List Description field, either enter a description directly in the
field, or click the arrow on the right side of the field to select an option in
the list.

4. Click the arrow on the right side of the Date Required field, and click a
date in the calendar to select it.

5. If you do not want anyone to make changes to the cut list, click the Lock
Cut List checkbox to select it.

6. Click Save To Cut List. 

Tekla PowerFab saves the cut list. You can use it in the selected production
control job and with Remote Link.

7. Click OK to close the Message dialog box.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

9.5 Combine materials in the Production Control module
You can mult and nest materials using the Combine command. You can then
save and review the combining results.

1. In the Select Production Control Job dialog box, open a job.
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2. Click the Production Control ribbon tab and select Combine 

The Select Combining Run dialog box opens. When you are performing
the first combining run for a combining job, the list in the dialog box is
empty.

3. Click a desired combining option to select it. 

The options are:

• Mult: Combines linear items, like beams and angles.

• Nest: Combines items that have area, like plates or gratings.

• Mult & Nest: Combines all items.

The Combining Run Filters dialog box opens.

NOTE Filtering items is optional, so you can skip steps 4 to 7 if you do
not want to filter out items from the combining run.

4. To only combine specific types of materials, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to combine to
the Included list.

• Type the maximum and minimum values for the items that you want
to combine.

6. Click OK to apply the filter. 

Repeat steps 4 to 6 for each filter type that you want to set.

7. To ensure that you are using the correct settings, click the Optimizations,
INV Filter, and Suppliers buttons. 

You can modify the settings.

8. In the Combining Run Filters dialog box, click OK.

9. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4.

Tekla PowerFab combines the materials. After the combining process is
finished, the Combining Run Results dialog box opens.

• Piece mark items included with the selected stock lengths are displayed at
the lower-left section of the dialog box.

• Combining results are shown in both the display area and in the summary
grid at the lower-right section of the dialog box.

• The material cost represents the pricing of the materials in the pricing
database that was used in the combining run.
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TIP You can save the combining run to view it later and compare it with
another combining run. To do so, click Save Combining Run at the
bottom of the Combining Run Results dialog box. No cut lists are
generated when you save the combining run.

See also

Rename a combining run (page 336)

Compare combining runs (page 344)

View combining run filter settings (page 337)

Modify run-specific pricing information (page 337)

Recombine all items (page 341)

Recombine items of a shape (page 342)

Recombine items of a material grade (page 342)

Recombine a material dimension (page 343)

Update combining information and recombine all items (page 343)

Export materials for combining (page 90)

Troubleshoot combining issues (page 1110)

9.6 Create and manage loads
You can create new truck loads for the current production control job, assign
materials to loads, and select shipping routes in the Loads dialog box. You can
also modify and delete existing loads as needed.

NOTE Items and main marks can be shipped to multiple destinations.

To access the Loads dialog box, do the following:

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Load Tracking.

The Loads dialog box opens.
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See also Add inventory to load (page 551).

Add a new load
1. Click New Load. 
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The Load Properties dialog box opens.

2. On the Details tab, modify the load properties. 

NOTE The available fields are set in Maintenance --> Load Tracking
Settings. There may be additional fields that are not listed in the
following table. For more information, see Define load tracking
settings (page 787).

Option Description
From The initial location of the load.

Click the arrow on the right side of From field and
select an option in the list.

The available locations are set in Shipping Route
Maintenance. See Manage default shipping routes
(page 817) and Manage shipping routes for a
production control job (page 878)
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Option Description
Destination Group The available destinations for the load.

Click the arrow on the right side of Destination
Group field and select a destination in the list.

The available destinations are set in Shipping
Route Maintenance. Manage default shipping
routes (page 817) and Manage shipping routes for
a production control job (page 878)

Load # The number of the load.

The field auto-increments from the previous load
created on the job. You can also type in a new
number.

Trailer # The trailer number.

Click the arrow on the right side of Destination
Group field and select an option in the list, or type
the trailer number directly in the Trailer # field.

The available trailers are set in the Load Tracking
Settings dialog box. See Define load tracking
settings (page 787).

Carrier The transport company delivering the load.

Click the arrow on the right side of Carrier field
and select an option in the Carrier list, or type a
carrier name directly in the field.

The available carriers are set in the Load Tracking
Settings dialog box. See Define load tracking
settings (page 787).

Capacity The weight capacity.

Tekla PowerFab automatically adds the information
according to your other selections on the Details
tab.

Planned Ship Date The way when you presume that the load will be
shipped.

Select a date in the calendar.

3. On the Top Text tab, add top text to shipping tickets. 

See Add, modify, and delete top text items for shipping tickets (page 822)

4. Click Save.

The load is added to the list in the Loads dialog box. Next, you need to add
materials to the load.
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Preassign or add materials to a load

NOTE Only material that is available in the From location of the load and is
assigned to the next destination group can be added to a load.

Material items can also be preassigned to loads without actually loading the
items.

1. In the list in the Loads dialog box, select the load to which you want to
add material.

2. Click Add Material. 

The Loads - Add Material dialog box opens.

3. Click the arrows to move the materials that you want to load to the
Included list.

4. To only add some pieces of the item to the load, select a material in the
Included list and type the number of pieces to be loaded in the Qty field.

5. Modify the load number and loading date as needed

6. If you only want to preassign material items to the selected load and not
actually load the items, clear the Load on Assign checkbox in the lower-
left corner.

7. Click Add Material.

Ship a load
The loads that do not have a shipping date are highlighted in yellow in the
Loads dialog box. To ship a load, do the following:

1. In the list, click the load that you want to ship.
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2. Click Load Properties.

3. Click Ship. 

TIP If you accidentally ship a load, you can cancel the shipping by
clicking Un-Ship.

4. In the Enter Value dialog box, click the arrow on the right side of the
blank field, and select the shipping date in the calendar.

5. Click OK.

6. If necessary, add the receiving date by clicking the arrow on the right side
of the Date Received field, and select the receiving date in the calendar.

7. Click Save.

8. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create and view a shipping ticket
You can create a shipping ticket and view, print, and export it.

1. In the Loads dialog box, select a load and click Load Properties. 

The Load Properties dialog box opens.

2. Click Shipping Ticket. 

The Report Selection dialog box opens.

3. Select a report.

4. Do any of the following 

To Do this
View the shipping ticket • Click View.
Print the shipping ticket a. To change the number of the printed copies,

click + or -.

b. Click Print.

The Select Printer dialog box opens.

c. Select a printer.

d. Click OK.
Export the shipping
ticket

a. Click Export.

The Export Options dialog box opens.

b. Select the Export Format
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To Do this
c. To browse to the location where you want to

save the file, click Browse and select the
location.

d. Click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. Click Export.

See also Add, modify, and delete top text items for shipping tickets (page 822)

Modify a load
1. In the list, click the load that you want to modify.

2. Click Load Properties.

3. On the Details tab of the Load Properties dialog box, modify the load
properties according to your needs.

4. On the Top Text tab, modify the top text of shipping tickets according to
your needs.

5. On the Material tab, modify the materials in the load.

• To add new material to the load, click Add.

For more information, see Add materials to a load.

• To remove a material item from the load, click the material item, click
Remove, and click Yes to confirm.

• To load a material item, click Load.

6. On the Loaded tab, unload any material items fr by clicking Unload, and
then, clicking Yes to confirm.

7. If necessary, on the Additional tab, add additional items to the load: 

For example, a box of bolts can be added as an additional item.

a. Click Additional on Load.

b. Click New.

c. Type the description, quantity, weight per item, and the total weight.

d. Add any additional notes.
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e. Click Add. 

Repeat steps a to e for all additional items that you need to add.

8. To change the shipping status of the load, click Ship or Un-Ship at the
bottom of the dialog box. 

When shipping a load, select the shipping date and click OK.

9. Click Save to update the load properties.

View the materials on a load
1. In the list, click the load whose assigned materials you want to view.

2. Click View Material.

3. In the Loads - Material dialog box, review the assigned materials and
their shipping date.

4. Click the Close button (X) to close the Loads - Material dialog box.

View current load locations
1. At the bottom of the dialog box, click Current Locations.

2. In the Loads - Material Location dialog box, view the current location of
each material item in existing loads.

3. Click the Close button (X) to close the Loads - Material Location dialog
box.

Delete a load
Note that deleting a load is permanent and cannot be undone.

1. In the list, click the load that you want to delete.

2. Click Delete Load.

3. In the confirmation dialog box, click Yes to permanently delete the load.

Add production control items to loads
Use the Load All Selected command to add the selected production control
materials to a truck load.

1. In the Production Control dialog box, click the items that you want to
load to select them. 
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To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Production Control ribbon tab.

3. On the menu, select Modify Data --> Load All Selected .

4. In the Loads - Add Material dialog box, click the arrow buttons to move
the items that you want to load to the Included list.

5. If you only want to load a particular number of pieces, select the item in
the Included list and type the number of pieces to be loaded in the Qty
field.

6. Click the arrow on the right side of Load # field and click the load to which
you want to add the items. 

Note that you can only select loads that have already been added in the
Loads dialog box. For more information on adding loads, see Create and
manage loads (page 919).

The total capacity and weight of the load is displayed at the bottom of the
Loads - Add Material dialog box.

7. If necessary, click the arrow on the right side of the Date Loaded field,
and select another loading date in the calendar.

8. Click Add Material.

The items are added to the selected load. The items will be marked as loaded
in the Loads dialog box.

Add piece tracking and load tracking information and loads
to the current production control job
Use the Production/Shipping Entry dialog box to add information to the
current product control job. You can add piece tracking information and loads,
ship and unship loads, and add piece marks to trucks.

NOTE The Production/Shipping Entry dialog box only allows you to add one item
at a time.

To open the Production/Shipping Entry dialog box, do either of the following:

• Select Maintenance --> Production Control --> Production/Shipping
Entry.

• In the Production Control module, open a job and in the Production
Control ribbon tab, select Modify Data --> Production/Shipping Entry.

The Production/Shipping Entry dialog box opens on the Piece Tracking tab.
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Add piece tracking information
In the Production/Shipping Entry dialog box do the following:

1. In the Action list, select the action that you want to perform. You can add
or delete items.

2. In the Job # list, select the production control job for which you want to
perform the action.

3. Select the main mark, piece mark, sequence, lot number, station, the
employee who is adding the information, and date. 
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NOTE The employee must be a Tekla PowerFab user.

4. In the Quantity field, enter the number of pieces being worked on.

5. In the Hours field, enter the hours used for working on the item.

6. To perform the action, click Add or Delete.

The action is updated to the selected job. The action also appears in the
History list at the bottom of the Production/Shipping Entry dialog box.

Add loads, ship loads, and unship loads
In the Production/Shipping Entry dialog box, do the following:

1. Click the Trucks tab to open it.

2. In the Action list, select the action that you want to perform. 

You can add or validate, ship, or unship trucks.

3. In the Job # list, select the production job for which you want to perform
the action.

4. Select the load number, shipping date, and destination in the appropriate
lists.

5. If necessary, click View to view the items assigned to the selected load.

6. If the load needs to be returned, select the To Be Returned checkbox. 

The load must be returned even if the materials will not be physically
returned. Returning the loaded items allows the piece marks to be loaded
onto a new shipping ticket that contains items delivered to the job site.
This way, Tekla PowerFab can keep accurate records of when parts were
received and shipped.

7. To perform the action, click Add/Validate, Ship, or Un-Ship. 

The action is updated to the selected production control job. The action
also appears in the History list at the bottom of the Production/Shipping
Entry dialog box.

8. If needed, create and view the shipping ticket:

a. Click Shipping Ticket.

b. In the Report Selection dialog box, select the report that you want to
view, print, or export.

c. Do any of the following: 

To Do this
View the shipping ticket • Click View.
Print the shipping ticket 1. To change the number of the printed copies,

click + or -.
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To Do this
2. Click Print.

The Select Printer dialog box opens.

3. Select a printer.

4. Click OK.
Export the shipping
ticket

1. Click Export.

The Export Options dialog box opens.

2. Select the Export Format

3. To browse to the location where you want to
save the file, click Browse and select the
location.

4. Click Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

7. To open the file after exporting it, select the
Open Exported Document checkbox.

8. Click Export.

Add piece marks to trucks
In the Production/Shipping Entry dialog box, do the following:

1. Click the Load Tracking tab to open it.

2. In the Action list, select the action that you want to perform. 

You can add, delete, return, or unreturn items.

3. Select the main mark, piece mark, sequence, lot number, load number,
and date.

4. If necessary, click View to view the items assigned to the selected load.

5. In the Quantity field, enter the number of pieces that are worked on.

6. Click Add, Delete, Return, or Un-Return. 

The action is updated to the selected production control job. The action
also appears in the History list at the bottom of the Production/Shipping
Entry dialog box.

7. If necessary, view the shipping ticket:

a. Click Shipping Ticket.

b. In the Report Selection dialog box, select the report that you want to
view, print, or export.
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c. Do any of the following: 

To Do this
View the shipping ticket In the Report Selection dialog box, click View
Print the shipping ticket 1. In the Report Selection dialog box, change

the number of the printed copies by clicking
the + and - buttons.

2. Click Print.

3. In the Select Printer dialog box, click a printer
to select it.

4. Click OK.
Export the shipping
ticket

1. In the Report Selection dialog box, click
Export.

2. In the Export Format list, select an export
format.

3. Click Browse.

4. Browse to the location where you want to save
the exported file, and click Save.

5. Modify the file name according to your needs.

6. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

7. To open the file after exporting it, select the
Open Exported Document checkbox.

8. In the Report Selection dialog box, click
Export.

9.7 Track production by piece mark
You can add tracking information by piece mark in the Piece Tracking dialog
box . You can record the stations that the piece mark has completed, the date,
and the hours used. Piece tracking records can also be added if the station is
set as the TFS station in a route or assigned to an inspection.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Piece Tracking.

3. To record information for completed items, in the Station Summary
dialog box, click Add Completed. 

The Station - Add Completed dialog box opens.
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4. In the dialog box, select a station in the Station list. 

5. Click the arrow buttons to move the items that have completed the
selected station to the Included list. 

If you cannot see all items that should be available, try selecting the
Include If Previous Station Not Complete checkbox. When this
checkbox is selected, items that have not yet completed the previous
station on the route are also shown.

6. Click the arrow on the right side of the Completed By list and select the
user that is adding the piece tracking information.

7. Click the arrow on the right side of the Date field and select the
completion date in the calendar.

8. Type the number of working hours and minutes used, and select if they
are calculated by piece or as a total.

9. If necessary, type the batch ID of the selected items in the Batch ID field. 

Batch ID is a generic field for grouping piece tracking entry items to
provide more specific reporting.

For example, you can type the name of the employee who is adding the
piece tracking information.

10. To review the inspection test records of the items before completing
stations, click the Inspection button. For more information, see Add,
modify, and review inspection test records (page 868).

11. Click Add Material to save the piece tracking information.

12. To close the Station Summary dialog box, click the Close button (X) in the
upper-right corner.
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You can view the piece tracking information by creating a Production Status
dialog box. For more information, see Review the production statuses of items
(page 866).

You can also view piece tracking information by viewing any report with the
word Station or Stations in the title. For more information, see View, print,
and export job-specific production control reports (page 891).

9.8 Use Trimble Connect with a production control job
You can view the production control job information in an IFC model using
Trimble Connect. You can interact with the model in several ways: by sharing
the production status of items to Trimble Connect, color-coding items in the
IFC model, or selecting items in the IFC model or in the production control
jobs.

We recommend that you start the production control job by importing an XML
file from Tekla Structures. The XML file includes GUIDs, unique identifiers that
match the identifiers in the IFC model. The necessary IFC settings for Tekla
Structures plugin can be downloaded from Tekla Warehouse.

Before you can view the job information in Trimble Connect, your Tekla
PowerFab administrator needs to set up the Trimble Connect integration
settings.

See also

Link a production control job to Trimble Connect (page 933)

Color-code production control items in the IFC model (page 935)

Select the same items in the production control job and in the IFC model
(page 936)

Link a production control job to Trimble Connect
Before you can view the production control job information in Trimble Connect
for Windows, you need to link the job to a Trimble Connect project. You can
either link the job to an existing project or create a new project.

Note that if a production control job is linked to a project management job, the
Trimble Connect project is managed through the project management job. In
this case, you need to link the project management job to Trimble Connect.
The link is then applied to any linked production control and estimating jobs.
The Trimble Connect project cannot be modified when you access it through
the production control job.

1. In the Production Control dialog box, right-click anywhere in the display
area.
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2. In the context menu, click Model Interface. 

A message appears, telling you that the current job is not linked to a
Trimble Connect project.

3. Click OK to close the message. 

4. In the Link Project to Trimble Connect dialog box, do one of the
following: 

To Do this
Link the job to an
existing Trimble Connect
project

a. To display the available Trimble Connect
projects, click Sync Projects.

b. Select the desired project, and click Link
Project.

Create a new Trimble
Connect project and link
the job to it

a. Click Add Project to Trimble Connect.

b. In the Add Users to Project dialog box, click
the arrow buttons to move the users that
participate in the project to the Included list.
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To Do this
c. Click OK.

Tekla PowerFab creates a Trimble Connect
project with the same name and information
as the current job.

d. In the Status dialog box, review the creation
process of the Trimble Connect project.

A message appears, telling you that the project
has been created successfully.

e. Click OK to close the message.

f. In Trimble Connect for Windows, press the
Back button to exit the empty 3D view.

g. In the Explorer side pane on the left, click the
Add File button.

h. In the Add Files dialog box, browse to find the
IFC model.

i. Select the IFC model and click Open.

The IFC model is imported to Trimble Connect for
Windows.

The production control job and Trimble Connect project are now linked.

To unlink a production control job from the Trimble Connect project:

1. In the Select Production Control Job dialog box, select the job that you
want to unlink.

2. At the bottom of the dialog box, click Edit.

3. In the Production Control Job Edit dialog box, click Link on the right side
of the Trimble Connect Project field.

4. In the Link Project to Trimble Connect dialog box, click Unlink project.

5. To close the dialog box, click the Close button (X) in the upper-right
corner.

6. In the Production Control Job Edit dialog box, click Save.

See also

Use Trimble Connect with a production control job (page 933)

Color-code production control items in the IFC model (page 935)

Select the same items in the production control job and in the IFC model
(page 936)
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Color-code production control items in the IFC model
To color-code items in the IFC model according to their properties, use the
Colorize command in the Model Viewer Interface dialog box. For example,
you can color-code items according to their production status or sequence.
You can also set filters to only color-code particular items in the model. By
using a filter, for example, you could first filter the items by their sequence,
and then color-code the items in that sequence by their production status.

1. In the Production Control dialog box, right-click anywhere in the display
area.

2. In the context menu, click Model Interface.

3. If necessary, in the Model Viewer Interface dialog box, filter the items
that you want to color-code:

a. Click Set Filters.

b. In the Estimating Filters dialog box, select a filter type in the Type
list, and click Select.

c. In the Filter dialog box, do one of the following depending on the
filter type: 

• Click the arrow buttons to move the items that you want to display
in the model to the Included list.

• Type the maximum and minimum values for the items that you
want to display in the model.

d. Click OK. 

Repeat steps b to d for all filter types that you want to set.

e. Click Apply Filter.

4. Click the arrow on the right side of the Colorize By list and select a
property in the list.

5. Click Colorize.

The items in the IFC model are color-coded according to the selected property.

To revert to the original colors in the IFC model, click Reset in the Model
Viewer Interface dialog box.

See also

Select the same items in the production control job and in the IFC model
(page 936)
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Select the same items in the production control job and in
the IFC model
When you have linked a production control job to Trimble Connect, you can
select an item that is selected in one of the software simultaneously in the
other one. Do the following:

1. In the Production Control dialog box, right-click anywhere in the display
area.

2. In the context menu, do one of the following:

• To select the item that is selected in the production control job also in
the IFC model, select Select in Model.

• To select the item that is selected in the IFC model also in the
production control job, select Select from Model.

See also

Color-code production control items in the IFC model (page 935)

Visualize jobs with Trimble Connect Organizer and Trimble
Connect Content Browser
You can use Trimble Connect Organizer to visualize and group items on your
estimating jobs and production control jobs. You can select which fields in
Tekla PowerFab you want to use to categorize model objects that correspond
to your Tekla PowerFab items in the related IFC model, and highlight or color-
code model objects according to different criteria.

Prerequisites of using Trimble Connect Organizer:

• You need to have a Trimble Connect Business Premium license.

• Your estimating job and production control job need to be linked through
the Project Management module.

Note that your estimating job and production control job do not necessarily
need to be linked to the same Trimble Connect project.

• The jobs need to be linked to a Trimble Connect project.

Set up item categories for Trimble Connect Organizer
You can now set up the categories that you want to use in Trimble Connect
Organizer. The categories determine which criteria you can use to highlight
and color-code items in the linked estimating and production control jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Integration Settings --> Trimble Connect
Organizer.
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3. In the Trimble Connect Organizer Tree Mappings dialog box, create the
necessary item categories:

a. Click New.

b. In the Field Type list, select if you want to use a field from the
estimating job or the production control job.

c. In the Tekla PowerFab Field list, select the field that you want to use
as an item category in Trimble Connect Organizer.

d. In the Organizer Tree Name, type a name that Trimble Connect
Organizer will use for the item category. 

We recommend that you use clear names to ensure that you know
where the information in the category comes from. For example, if a
category contains the shapes in the estimating job, you could name
the category Tekla PowerFab Estimating - Shape.

e. Click Add.

For example, you can create a category for production sequences in the
linked production control job. All sequences within the linked production
control job will be shown under this category, and you can highlight
individual sequences in the 3D model view.

Repeat steps a to e to create all necessary field mappings.

4. To close the Trimble Connect Organizer Tree Mappings dialog box, click
the Close button (X) in the upper-right corner.

Publish job information manually to Trimble Connect Organizer
• To upload job information to Trimble Connect Organizer: 

From Do this
An estimating job 1. Open the estimating job.

2. Click the Estimating ribbon tab.

3. On the menu, select Publish to Trimble
Connect Organizer.

A production control job 1. Open the production control job.

2. Click the Production Control ribbon tab.

3. On the menu, select Export --> Publish to
Trimble Connect Organizer.

The item information is uploaded to Trimble Connect Organizer, and will be
visible in the Organizer side pane in Trimble Connect for Browser.

You can also create an automated event that uploads the item information to
Trimble Connect Organizer automatically as often as you want.
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Highlight selected items in Trimble Connect Organizer
1. To open Trimble Connect for Browser: 

• Go to https://3d.connect.trimble.com/.

• Click  Trimble Connect in the upper-right corner of Tekla
PowerFab Go.

2. Double-click the Trimble Connect project that is linked to the desired
estimating and production control jobs. 

The Trimble Connect project opens in the Trimble Connect 3D viewer.

3. To open the Organizer side pane, click  Organizer in the Trimble
Connect side pane. 

4. In the Organizer side pane, expand the necessary categories and select
the categories whose items you want to highlight. 

To select more than one category at a time, hold down Ctrl when selecting
categories.

For example, you can select the labor code B - Bolted Clips On Both Ends
and sequence 1 to highlight and zoom to all items with labor code B that
belong to the production sequence 1.
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Color-code items with Trimble Connect Content Browser

1. In the Trimble Connect side pane, click  Data Table.

2. To configure what information is shown in Content Browser: 

a. At the top of the Content Browser pane, click the  Columns
button. 

b. If necessary, remove the current columns by clicking Remove All on
the right side of the Visible Columns list.

c. Find a column that you want to show in the Content Browser pane by
scrolling the All Columns list, or by typing a search word in the Filter
Columns field.

d. Select the column.

e. Hold down the left mouse button, drag the column to the Visible
Columns list, and release the left mouse button. 
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Repeat steps c to e for all columns that you want to show.

f. To save your changes, click OK at the bottom of Column Picker.

3. To set how the items are grouped in the 3D model:

a. Select a column in Content Browser and hold down the left mouse
button.

b. Drag the column to the Group by box, and release the left mouse
button. 

The column name appears in the Group by box, and the objects are
sorted according to the selected criterion. By default, groups and
objects are shown in alphabetical order.

You can also drag another column to the Group by box. In this case,
the objects are sorted to both of the selected criteria.
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If you want to reverse the order of the objects, click the column name
in the Group by box.

4. To color-code the items in the 3D view, at the top of Content Browser, click

 Colorize.

The objects on all rows of Content Browser are color-coded in the 3D view. The
color that is used for each row is shown on the right side of the row title.

In the following image, you can see items grouped and color-coded by
production sequence.
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9.9 Export production control information
You can export production control information, including the production
status, to multiple file formats. You can save the current production control job
as a KISS or CIS/2 file, export the production status to an XML file, or push the
production status to Trimble Connect.

For more information, see the following links:

Export a production control job to KISS (page 943)

Export the production control job to a CIS/2 model (page 944)

Export the production status to Tekla Structures or Advance Steel (page 944)

Export the production status to SDS/2 (page 945)

Publish the production status to Trimble Connect (page 763)

Export a production control job to KISS
You can save the current production control job as a KISS file.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Export --> Export to KISS .

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.
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4. If necessary, change the file name.

5. Click Save.

The file is saved to the selected location as a KISS file.

Export the production control job to a CIS/2 model
You can export a production control job to CIS/2 file by using the Export to
CIS/2 Model command. Note that the Export to CIS/2 Model command is
only available if the production control job has originally been imported from a
CIS/2 file.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Export --> Export to CIS/2 Model .

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save. 

A message appears, showing the location where the CIS/2 file was saved.

Export the production status to Tekla Structures or
Advance Steel
You can export the production status of the current job as an XML file to either
Tekla Structures or Advance Steel.

The menu options for Advance Steel can be found only if the import file is
from that software.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select either of the following:

• Export --> Export Production Status to XML - Tekla Structures

• Export --> Export Production Status to XML - Advance Steel

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.
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5. Click Save.

The production status is saved in the selected location as an XML file.

See also

Export the production status to SDS/2 (page 945)

Export the production status to SDS/2
You can export the production status of the current job to SDS/2 as an XML
file.

The menu options for SDS/2 can be found only if the import file is from that
software.

1. In the Production Control dialog box, click the Production Control
ribbon tab.

2. On the menu, select Export --> Export Production Status to XML -
SDS/2 .

3. In the SDS/2 Field Map dialog box, define SDS/2 import settings as
follows:

a. Click New Field.

b. In the SDS/2 Object list, select the SDS/2 object type.

c. In the SDS/2 Category list, select a software solution for member
properties.

d. In the SDS/2 Field list, select the field to which the information is
exported in SDS/2.

e. In the Tekla PowerFab Field list, select the Tekla PowerFab field from
which the information is exported to the selected SDS/2 field.

f. Click New Field.

Repeat steps a to f to match all necessary SDS/2 and Tekla PowerFab fields
to each other.

If you want to save the SDS/2 import settings for later use, type a
description for the settings in the Description field, and click Save.

4. Click OK.

5. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

6. If necessary, change the file name.

7. Click Save.
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See also

Export the production status to Tekla Structures or Advance Steel (page 944)

9.10 Finalize a production control job
You can prevent any further changes to a production control job by using the
Finalize command. After finalizing the production control job, you can no
longer send material to purchasing.

The requisitioned items assigned to the job will be deleted, and inventory
items reserved for the job will be unreserved.

NOTE Finalizing a job is irreversible and cannot be undone.

1. In the Select Production Control Job dialog box, select a job and click the
Production Control ribbon tab.

2. On the menu, select Purchasing --> Finalize .

3. If you are sure that you want to finalize the job, inthe Finalize Job dialog
box, click Finalize.
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10 Purchasing

In the Purchasing module, you can create two types of jobs: requisitions and
purchase orders. Requisitions list the required materials for multiple jobs,
whereas purchase orders represent the individual orders that you make from
vendors.

Before you start creating requisitions and purchase orders in the Purchasing
module, remember to adjust the settings of the Purchasing module according
to your needs.

10.1 Set up the Purchasing module
The Purchasing module in Tekla PowerFab consists of two parts: requisitions
and purchase orders. Before starting to use Purchasing, we recommend that
you adjust the requisition and purchase order properties to meet the needs of
your company.

For more information, see the following links:

Define the requisition settings (page 947)

Define the purchase order settings (page 957)

Create, modify, or delete cost codes (page 973)

Define the requisition settings
Before you start to use the Purchasing module, you need to separately define
the default settings and options used for requisitions and purchase orders.

For more information, see the following links:

Define company standard settings for requisitions (page 948)

View, print, or export global requisition reports (page 954)

Manage requisitions (page 955)
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Define company standard settings for requisitions
For each module, you can define company-level settings that are the default
for all new jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Requisitions --> Company Standards 

The Company Standards dialog box opens.

3. Modify the settings as needed. 

Option Description
Requisition #
Increment

Allows you to select the default option for
automatic numbering of requisitions. The options
are:

• Increment from Last Requisition #: When you
create a new requisition, Tekla PowerFab uses
the next available number after the latest
requisition number created.

• Increment from Largest Requisition #: Tekla
PowerFab uses the next available number after
the largest requisition number created.

• Don't Increment: Automatic numbering is not
used.

You can modify the requisition number when you
create a new requisition.

Item Increment Sets the autoincrement for item numbers.

The default autoincrement of 10 allows items to be
added in the list as needed, without having to
renumber the other items in the job.

For example, if items should be numbered as 10,
20, 30, ..., set the input increment to 10. If the
autoincrement of item numbers is not necessary,
type 1.

Keep Purchasing
Selection Screen Open

When selected, the Select Requisition/Purchase
Order dialog box stays open after a requisition or
purchase order has been opened.

Otherwise, the dialog box closes when you open a
requisition or purchase order.

Automatically set base
price on manually
added line items

Automatically sets a base price on manually added
line items for the selected supplier.
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Option Description
Automatically Create
Document Index
Directories

When selected, the Document Index directories
defined in Maintenance --> Document Index -->
Standard Categories are created automatically
under the base document index directory when a
job is created. See Set the standard categories for
attached documents (page 150).

Job # Regular
Expression

Allows the use of regular expressions to create the
requisition number.

For more details on regular expressions, click
Regular Expression Help.

4. Click Save. 

Saving the settings closes the Company Standards dialog box.

When you click Save, the changes you made are saved.

You can find further company standard settings by clicking the buttons.

See also

Define default input and display units for requisitions (page 949)

Define default combining optimizations for requisitions (page 950)

Define default suppliers for requisitions (page 953)

Define default input and display units for requisitions
You can define standard input and display units for the company. You can
select either metric or imperial units and the units of measurement for a
piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

1. Go to Maintenance --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Input/Display Units. 

The Input/Display Units dialog box opens.

3. Select the measurement system and the units of measurement on the
drop-down menus.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

5. Click Save.

6. Do either of the following:
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• Click Save

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

The input and display units are saved as defaults.

Define default combining optimizations for requisitions
You can define company-level settings for material optimization.

1. To define company-level settings, go to Maintenance --> <Module>
Company Standards.

The <Module> Company Standards dialog box opens.

2. Click Combining Optimizations.

The Combining Setup dialog box opens.

3. Modify the settings on the various tabs as needed.

See also Combine materials in the Production Control module (page 917)

Define the general settings

1. Go to the General Settings tab.

2. Modify the settings as needed. 

Option Description
Use Grade Substitutions Select to check for material in

inventory that has an alternative
grade to the one specified.
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Option Description
Only grades of an equal or higher
rating will be used as set in
Maintenance --> Shapes/Grades/
Sizes --> Shape/Grade/Size
Maintenance dialog box.

If the grade substitutions are not set,
the material grades in the combining
run and in the supplier pricing data
set or the inventory need to match
each other exactly.

Combine Only Within Sequence Select if you want to mult and nest
only materials that are in the same
sequence onto the inventory items or
purchasable lengths.

The selection of Combine Only
Within Sequence uses additional
material for each sequence. This may
be desirable in some cases, but it may
also lead to excess drop amounts.

Optimizations Not Included/
Optimizations Included

Allows you to select the optimization
options that you want to use by
moving them to the Optimizations
Included list using the arrow buttons.

Inventory Exact-Match (In Stock) Use this option for inventory items in
stock that are an exact match without
the use of kerf or clamp allowance.

Inventory Exact-Match (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that are an
exact match without the use of kerf or
clamp allowance.

Inventory Least-Scrap (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that will
provide the least amount of scrap.

Inventory Least-Scrap (In Stock) Use this option for inventory items in
stock that will provide the least
amount of scrap.

Warehouse Least-Scrap Use this option to give preference to
warehouse items that will provide the
least amount of scrap. Warehouse
items will only be used when they
provide less scrap than the available
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Option Description
inventory items or no inventory
exists.

Warehouse Force Inventory Use this option to force the use of
inventory items if available regardless
of the amount of scrap, no matter
where it is located in the
Optimizations Included list. This
option is the opposite of Warehouse
Least-Scrap.

Note that you can only include
Warehouse Least-Scrap or
Warehouse Force Inventory, not
both.

3. Modify the order of the optimizations by using the Move Up and Move
Down buttons 

The order is important when you are performing a combining run.

4. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define multing settings

1. Go to the Mult Settings - Linear Material tab.

2. Modify the settings as needed. 

Option Description
Multing Software Select the multing software that you

are using.
Apply Kerf Select if you want to apply the

material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Allow Split T's Select to allow split tees.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.
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Define plate nesting settings

1. Go to the Plate Nesting Settings tab.

2. Modify the settings as needed. 

Option Description
Plate Nesting Software Select the software that you are using.
Shear Cut Optimization Select a suitable shear cut option. The

selected option determines the plate
allowance to be used with the
combining:

• None: Use when cutting plate on a
burn table.

• Shear Cut - First Cut Along
Length or Shear Cut - First Cut
Along Width: Use to alert Tekla
PowerFab that the nesting needs
to allow for that type of cut first.
Then, the nesting will allow for all
subsequent cuts to be made with
that condition.

Apply Kerf Select if you want to apply the
material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Rotate Plates for Best Fit Select if the material grain direction is
unimportant and you want Tekla
PowerFab to create the best possible
optimization of a plate.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

When you click Save, the Combining optimizations settings are saved.

See also

Define combining optimizations for a requisition (page 978)

Troubleshoot combining issues (page 1110)

Define default suppliers for requisitions
You can define requisition-specific suppliers, or pricing data sets, for angles,
beams, plates, rods, tubes, and other material.
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1. Go to Maintenance --> <Module> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Suppliers. 

The Suppliers dialog box opens.

3. Select suppliers for each material group on the drop-down lists.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

5. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the supplier settings are updated.

View, print, or export global requisition reports
Use the Reports command under Maintenance --> Requisitions to create
reports that include information from all or several requisitions jobs. The
available reports include requests for pricing and various lists of requisitions.
You can then either view or print a report, or export a report and save it in
another file format.

To create requisition reports, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Requisitions --> Reports .

3. To only include specific requisitions in the reports, in the Requisition
Report Filters dialog box, select a filter type in the Type list, and click
Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the requisition properties that you
want to include in the reports to the Included list.

• Type the maximum and minimum values for the requisition properties
that you want to include in the reports.

5. Click OK. 

To further limit the requisitions included in the reports, repeat steps 3 to 5
for all filter types.

6. Click Make Report.
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7. In the Report Selection dialog box, select the report that you want to
view, print, or export. 

To change the reports that are displayed in the Report Selection dialog
box, click Edit Report Types.

According to your needs, see any of the following instructions:

View the requisition report

• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the requisition report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the requisition report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

7. To open the file after exporting it, select the Open Exported Document
checkbox.

8. In the Report Selection dialog box, click Export.

Manage requisitions
You can delete or copy existing requisitions in the Requisition Maintenance
dialog box.

1. Click the Maintenance ribbon tab.
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2. On the menu, select Requisitions --> Requisition Maintenance . 

The Requisition Maintenance dialog box opens.

3. Select the requisition that you want to modify. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

4. At the bottom of the dialog box, click any of the available buttons. 

See also

Copy a requisition (page 956)

Delete requisitions (page 956)

Delete requisitions
You can delete any unnecessary requisitions in Requisition Maintenance.

1. Maintenance --> Requisitions --> Requisition Maintenance 

The Requisition Maintenance dialog box opens.

2. Select the requisition that you want to delete. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.

3. At the bottom of the dialog box, click Delete.

4. To delete the requisition, click Yes in the Confirm dialog box.

The requisition is deleted permanently.

See also

Manage requisitions (page 955)

Copy a requisition
You can copy an existing requisition to use it as the base of a new similar
requisition. Copying an existing requisition makes creating the new requisition
quicker, as you do not have to set all properties manually or create items one
by one.

1. Maintenance --> Requisitions --> Requisition Maintenance 

The Requisition Maintenance dialog box opens.

2. Select the requisition that you want to copy. 

To select multiple jobs, hold down Ctrl.

To select a range of subsequent jobs, hold down Shift.
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3. At the bottom of the dialog box, click Copy. The Enter Value dialog box
opens.

4. Type a number for the new requisition.

5. Click OK.

6. Define new numbers for the jobs whose items are sent to the original
requisition:

a. In the New Job # field, type a new number for the job.

b. Click Set to save the new job number.

Tekla PowerFab creates a new requisition based on the selected requisition.
You can modify the properties of the new requisition using the Edit
functionality in the module.

Define the purchase order settings
Before you start to use the Purchasing module, you need to separately define
the default settings and options used for requisitions and purchase orders.

For more information, see the following links:

Define company standard settings for purchase orders (page 957)

View, print, or export global receiving reports (page 965)

Add, modify, or delete purchase order types (page 967)

Add, modify, and delete shipping methods for purchase orders (page 968)

Add, modify, or delete payment terms for purchase orders (page 970)

Add, modify, or delete top text items (page 972)

Define company standard settings for purchase orders
For each module, you can define company-level settings that are the default
for all new jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Company Standards .

3. Modify the settings on the various tabs as needed.
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Define general settings

1. On the General tab, modify the following properties: 

Option Description
P.O. # Increment Allows you to select the default option for

automatic numbering of purchase orders. The
options are:

• Increment from Last P.O. #: When you create
a new purchase order, Tekla PowerFab uses the
next available number after the latest purchase
order number created.

• Increment from Largest P.O. #: Tekla
PowerFab uses the next available number after
the largest purchase order number created.

• Don't Increment: Automatic numbering is not
used.

You can modify the purchase order number when
you create a new purchase order.

'Purchase Order' Text Allows you to replace the word 'Purchase order' in
Tekla PowerFab with an alternative text. The
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Option Description
alternative text will be used wherever 'Purchase
order' is currently used in Tekla PowerFab.

Note that you need to close and re-open Tekla
PowerFab to update the purchase order text.

Type the desired text in the 'Purchase Order' Text
field.

'P.O.' Text Allows you to replace the abbreviation 'P.O.' in
Tekla PowerFab with an alternative text. The
alternative text will be used wherever 'P.O.' is
currently used in Tekla PowerFab.

Note that you need to close and re-open Tekla
PowerFab to update the P.O. text.

Type the desired text in the 'P.O.' Text field.
Item Increment Sets the autoincrement for item numbers.

The default autoincrement of 10 allows items to be
added in the list as needed, without having to
renumber the other items in the job.

For example, if items should be numbered as 10,
20, 30, ..., set the input increment to 10. If the
autoincrement of item numbers is not necessary,
type 1.

Keep Purchasing
Selection Screen Open

When selected, the Select Requisition/Purchase
Order dialog box stays open after a requisition or
purchase order has been opened.

Otherwise, the dialog box closes when you open a
requisition or purchase order.

Generate Barcode
Images

When selected, Tekla PowerFab generates the
necessary barcode images for the Barcode
Checklist report.

Note that you only need to select Generate
Barcode Images if you are using a customized
version of the Barcode Checklist report designed
with Crystal Reports.

If you are using another version of the Barcode
Checklist report, the barcodes are automatically
generated as a part of the report, whether or not
the Generate Barcode Images checkbox is
selected.

QuickBooks - Export
PO Summary Only

When selected, purchase order items are exported
as a whole without any line item details.
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Option Description
Automatically set base
price on manually
added line items

Automatically sets a base price on manually added
line items for the selected supplier.

Automatically Create
Document Index
Directories

When selected, the Document Index directories
defined in Maintenance --> Document Index -->
Standard Categories are created automatically
under the base document index directory when a
job is created. See Set the standard categories for
attached documents (page 150).

P.O. # Regular
Expression

Allows the use of regular expressions to create the
purchase order number.

For more details on regular expressions, click
Regular Expression Help.

2. Do either of the following:

• Click Save.

The dialog box closes.

• Continue to add or modify properties.

Define company standard settings for purchase orders
For each module, you can define company-level settings that are the default
for all new jobs.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Company Standards .

3. Modify the settings on the various tabs as needed.

Define receiving settings
On the Receiving tab, select the checkboxes next to the properties that you
want to define when receiving material items.
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1. On the Receiving tab, select the properties that you want to show in the
Receive dialog box: 

Option Description
Substitute Grade When selected, you can select a

substitute grade for the purchase
order item. When cleared, Tekla
PowerFab always uses the original
grade of the item instead of a
substitute grade.

If necessary, select the Substitute
Grade checkbox, and click the arrow
on the right side of the related field to
select the substitute grade.

Location Location of the material items.
Secondary Location The secondary location of the

material items.
Bill of Lading # The bill of lading number or the

shipment number that the material
items were received on.
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Option Description
Heat Serial # The heat serial number of the

material items. Ensures that heat
numbers are not duplicated.

Mill of Origin When selected, you can select mill
locations for materials, both when
receiving from a purchase order and
when adding to or editing inventory.

Country of Origin The country of origin of the material
items.

You can modify the available
countries in Maintenance -->
Inventory --> Countries of Origin.
See Define the countries of origin
(page 531).

2. Do either of the following:

• Click Save.

The dialog box closes.

• Continue to add or modify properties.

Define default remarks
On the Default Remarks tab, you can define the remarks added for all new
purchase orders by default.

1. To define the remarks, do either of the following t

• Type the necessary remarks in the available fields.

• Click the arrow buttons on the right side of the available fields and
select previously set remarks.

For more information about managing remarks, see Add, modify, or
delete purchase order remarks (page 971).

2. Do either of the following:

• Click Save.

The dialog box closes.

• Continue to add or modify properties.

Define default top text
On the Default Top Text tab, you can define the top text added to all new
purchase orders by default.

1. To define default top text, do either of the following:

• Type a name for the top text item in the Description field, and type
any necessary information in the Top Text field.
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• Click the arrow button on the right side of the Description list, and
select a previously set top text item.

For more information about managing top text items, Add, modify, or
delete top text items (page 972).

2. Do either of the following:

• Click Save.

The dialog box closes.

• Continue to add or modify properties.

Define default input and display units for Purchasing
You can define standard input and display units for the company. You can
select either metric or imperial units and the units of measurement for a
piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

1. Go to Maintenance --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Input/Display Units. 

The Input/Display Units dialog box opens.

3. Select the measurement system and the units of measurement on the
drop-down menus.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

5. Click Save.

6. Do either of the following:

• Click Save

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

The input and display units are saved as defaults.

See also

Define company standard settings for purchase orders (page 957)

Create a purchase order (page 1014)
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Import, view, or delete advance shipment notices
In the Advance Shipment Notice dialog box, you can import advance
shipment notices from XML files to Tekla PowerFab. You can also view the
shipment details of an advance shipment notice, or delete any unnecessary
advance shipment notices.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Advance Shipment Notices .

The Advance Shipment Notice dialog box opens.

Import an advance shipment notice

1. At the bottom of the Advance Shipment Notice dialog box, click Load
ASN.

2. In the Open dialog box, browse to find the XML file that you want to
import.

3. Select the file and click Open. 

If the order number in the XML file does not match any existing purchase
orders, the Enter Value dialog box opens.

4. Click the arrow on the right side of the list, and select the purchase order
to which you want to import the XML file.

5. Click OK.

6. In the Load Advance Shipment Notice dialog box, view the progress of
the import process.
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7. When the import is completed, click Close at the bottom of the dialog box.

The advance shipment notice has now been imported for the selected
purchase order. If necessary, you can view the details of the advance shipment
notice.

View the details of an advance shipment notice

1. In the Advance Shipment Notice dialog box, select the advance
shipment notice whose details you want to view.

2. Click Details.

3. View the advance shipment notice. 

Click the various tabs and buttons to show different details about the
advance shipment notice.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Delete an advance shipment notice

Note that deleting an advance shipment notice is permanent and cannot be
undone. This means that you need to re-import the XML file to view the
advance shipment notice again.

1. In the Advance Shipment Notice dialog box, select the advance
shipment notice that you want to delete.

2. Click Delete ASN.

3. To permanently delete the advance shipment notice, click Yes in the
confirmation dialog box.

View, print, or export global receiving reports
You can create receiving reports that contain information from all or various
purchase orders. You can then view or print the reports, or export the reports
and save them in another file format. For example, you can create a purchase
order summary, or a receiving list.

To create receiving reports, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Receiving Reports .

3. To only include particular purchase orders in the reports, in the Purchase
Order Report Filters dialog box, select a filter type in the Type list, and
click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the purchase order properties that
you want to include in the report to the Included list.
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• Type the maximum and minimum values for the purchase orders that
you want to include in the report.

5. Click OK. 

To further limit the properties of purchase orders that are included in
reports, repeat steps 3 to 5 for all necessary filter types.

6. To save commonly used filters, do the following:

a. Click Filter Types in the lower-left corner.

b. Click New.

c. Type a description for the filter type.

d. Create the filter settings. 

For more information, see steps 3 to 5.

e. Click Add.

f. To close the dialog box, click the Close button (X) in the upper-right
corner. 

The newly created filter type is selected in the Filter Types list.

g. To apply the filter type, click Set.

Note that if you save a filter type in the Purchase Order Report Filters
dialog box, the saved filter type will also be available as a filter in the PO #
dialog box for all purchase orders.

7. Click Make Report.

8. In the Report Selection dialog box, select the report that you want to
view, print, or export. 

Note that all available receiving reports are not displayed by default. You
can customize the reports that are displayed in the Report Selection
dialog box by clicking Edit Report Types.

9. If you want to include the company logo and vendor code in the report,
select the Show Company Logo and Show Vendor Code checkboxes. 

When the checkboxes are cleared, the information is not included in the
report.

According to your needs, see any of the following instructions:

View the report

• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Purchasing 966 Set up the Purchasing module



Print the report

1. In the Report Selection dialog box, change the number of the printed
copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report

1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

7. To open the file after exporting it, select the Open Exported Document
checkbox.

8. In the Report Selection dialog box, click Export.

Add, modify, or delete purchase order types
In the PO Type Maintenance dialog box, you can create new purchase order
types that meet the needs of your company. For example, recurring purchase
orders can have their own purchase order type. You can also select the default
purchase order type, modify existing purchase order types, and delete
unnecessary purchase order types.

To access the PO Type Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> PO Type Maintenance .

The PO Type Maintenance dialog box opens.

According to your needs, see any of the following instructions:

Create a purchase order type

1. At the bottom of the PO Type Maintenance dialog box, click New.

2. Type a description for the purchase order type.

Purchasing 967 Set up the Purchasing module



3. Click Add.

Set a purchase order type as default

1. In the PO Type Maintenance dialog box, select the desired purchase
order type.

2. Click Set as Default.

3. To confirm setting the selected purchase order type as the default option,
click Yes in the confirmation dialog box.

Modify a purchase order type

1. In the PO Type Maintenance dialog box, select the purchase order type
that you want to modify.

2. Modify the description according to your needs.

3. Click Edit to save the changes.

Delete a purchase order type

Note that deleting a purchase order type is permanent and cannot be undone.

1. In the PO Type Maintenance dialog box, select the purchase order type
that you want to delete.

2. Click Delete.

3. To permanently delete the purchase order type, click Yes in the
confirmation dialog box.

Add, modify, and delete shipping methods for purchase orders
In the Shipping Method Maintenance dialog box, you can add, modify, and
delete shipping method options that are available for the purchase orders
created in Purchasing. You can also select which shipping method you want to
use as the default option.

1. Click the Maintenance ribbon tab.

2. In the menu, select Purchase Orders --> Shipping Method
Maintenance .

3. In the Purchase Order Payment Term Maintenance dialog box, do any
of the following according to your needs: 

To Do this
Add a new shipping
method

a. Click New.

b. In the Description field, describe the new
shipping method.
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To Do this
c. Click Add to save the new shipping method

and add it to the list.
Set a default shipping
method

a. Select the desired shipping method.

b. Click Set as Default.

c. To confirm using the selected shipping method
as the default option, click Yes in the
confirmation dialog box.

The default shipping method is marked with
an asterisk (*). The same shipping method will
be used by default in the Purchasing module.

Modify a shipping
method

a. Select the shipping method that you want to
modify.

b. Modify the description.

c. Click Edit to save the changes.
Delete a shipping
method

a. Select a shipping method in the list.

b. Click Delete.

c. To permanently delete the shipping method,
click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add, modify, or delete FOB shipping destinations
In the Purchase Order FOB Maintenance dialog box, you can create, modify,
and delete FOB (Free on Board) shipping destinations. You can also set a
default FOB shipping destination. The destinations set in the Purchase Order
FOB Maintenance dialog box are available for all purchase orders.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> FOB Maintenance .

The Purchase Order FOB Maintenance dialog box opens.

According to your needs, see any of the following instructions:

Create a FOB shipping destination

1. At the bottom of the Purchase Order FOB Maintenance dialog box, click
New.

2. Type a description for the shipping destination.

3. Click Add.
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Set the default FOB shipping destination

The current FOB shipping method is marked with an asterisk (*). To change the
default option, do the following:

1. In the Purchase Order FOB Maintenance dialog box, select the desired
shipping destination.

2. Click Set as Default.

3. To confirm setting the selected shipping destination as the default option,
click Yes in the confirmation dialog box.

The new FOB shipping method is marked with an asterisk (*).

Modify a FOB shipping destination

1. In the Purchase Order FOB Maintenance dialog box, select the shipping
destination that you want to modify.

2. Modify the description according to your needs.

3. Click Edit to save the changes.

Delete a FOB shipping destination

Note that deleting a FOB shipping destination is permanent and cannot be
undone.

1. In the Purchase Order FOB Maintenance dialog box, select the shipping
destination that you want to delete.

2. Click Delete.

3. To permanently delete the shipping destination, click Yes in the
confirmation dialog box.

Add, modify, or delete payment terms for purchase orders
You can add, modify, or delete the payment term options that are available for
all purchase orders created in Purchasing. In addition, you can set the default
payment term that will be used for all future purchase orders by default.

1. Click the Maintenance ribbon tab.

2. In the menu, select Purchasing --> Payment Term Maintenance .

3. In the Purchase Order Payment Term Maintenance dialog box, do any
of the following according to your needs: 

To Do this
Add a new payment
term

a. Click New.

b. In the Description field, type a description for
the payment term.
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To Do this
c. If necessary, in the Discount field, type a

discount percentage for the payment term.

d. Click Add to save the new payment term and
add it to the list.

Set a default payment
term

a. Select a payment term in the list.

b. Click Set as Default.

c. To confirm using the selected payment term
as the default option, click Yes in the
confirmation dialog box.

The default payment term is marked with an
asterisk (*). The same payment term will be
used by default for all future purchase orders.

Modify a payment term a. Select a payment term in the list.

b. Modify the description and the discount
percentage according to your needs.

c. Click Edit to save the changes.
Delete a payment term a. Select a payment term in the list.

b. Click Delete.

c. To permanently delete the payment term, click
Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add, modify, or delete purchase order remarks
In the Purchase Order Remark Maintenance dialog box, you can create
remarks for purchase orders. You can also modify existing remarks or delete
any unnecessary remarks. The remarks set in the Purchase Order Remark
Maintenance dialog box are available for all purchase orders that you create
or modify.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Remark Maintenance .

The Purchase Order Remark Maintenance dialog box opens.

According to your needs, see any of the following instructions:

Create a remark

1. At the bottom of the Purchase Order Remark Maintenance dialog box,
click New.
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2. In the Description field, type the remark. 

For example, MTRs required.

3. Click Add.

Modify a remark

1. In the Purchase Order Remark Maintenance dialog box, select the
remark that you want to modify.

2. In the Description field, modify the text according to your needs.

3. Click Edit to save the changes.

Delete a remark

1. In the Purchase Order Remark Maintenance dialog box, select the
remark that you want to delete.

2. Click Delete.

3. To permanently delete the remark, click Yes in the confirmation dialog
box.

Add, modify, or delete top text items
Top text items are pieces of text that can be added at the top of purchase
orders. In the Purchase Order Top Text Maintenance dialog box, you can
add new top text items, or modify and delete existing top text items.

1. Click the Maintenance ribbon tab.

2. On the menu, select Purchase Orders --> Top Text Maintenance .

The Purchase Order Top Text Maintenance dialog box opens.

The top text items created in the Purchase Order Top Text Maintenance can
be set as default options that are added for all nex purchase orders. For more
information, see Define company standard settings for purchase orders
(page 957).

Create a top text item

1. At the bottom of the Purchase Order Top Text Maintenance dialog box,
click New.

2. In the Description field, type a name for the top text item.

3. In the Top Text field, type the information to be added at the top of the
purchase orders.

4. Click Add.
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Modify a top text item

1. In the Purchase Order Top Text Maintenance dialog box, select the top
text item that you want to modify.

2. In the Description field, modify the item name according to your needs.

3. In the Top Text field, modify the top text according to your needs.

4. Click Edit to save the changes.

Delete a top text item

1. In the Purchase Order Top Text Maintenance dialog box, select the top
text item that you want to delete.

2. Click Delete.

3. To permanently delete the top text item, click Yes in the confirmation
dialog box.

Create, modify, or delete cost codes
You can use cost codes to keep track of specific costs and set them to match
your accounting system. In the Cost Code Maintenance dialog box, you can
create cost codes that are available for items in all requisitions and purchase
orders. You can also modify the existing cost codes, and delete unnecessary
ones.

To access the Cost Code Maintenance dialog box, do the following:

1. Click the Maintenance ribbon tab.

2. On the menu, select either Requisitions --> Cost Codes or Purchase
Orders --> Cost Codes .

The Cost Code Maintenance dialog box opens.

According to your needs, see any of the following instructions:

Create a cost code
1. At the bottom of the Cost Code Maintenance dialog box, click New.

2. Type an abbreviation for the cost code.

3. Type a description for the cost code. 

For example, Structural fabrication.

4. Click Add.
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Modify a cost code
1. In the Cost Code Maintenance dialog box, select the cost code that you

want to modify.

2. Modify the abbreviation and description according to your needs.

3. Click Edit to save the changes.

Delete a cost code
Note that deleting a cost code is permanent and cannot be undone. After
deleting the cost code, you cannot use the cost code for requisition items.

1. In the Cost Code Maintenance dialog box, select the cost code that you
want to delete.

2. Click Delete.

3. To permanently delete the cost code, click Yes in the confirmation dialog
box.

10.2 Create and manage requisitions
The purpose of creating requisitions is having a list of the required materials
for multiple jobs, so that you can optimize the use of similar materials. By
creating requisitions, you can quote the required materials from vendors and
attach the material items to purchase orders or existing inventory.

Requisitions also hold a copy of the production control record that is attached
to the stock materials. You can manually move the records to and from stock
items.

You can use and organize requisitions in different ways according to your
needs. To illustrate, you can either use a single requisition for all required
materials, or create separate requisitions for each phase and material type in
each job.

We recommend that you plan the numbering of requisitions carefully to help
you organize the requisitions in the future.

You can create and modify requisitions and material items within them on the
Requisitions part of the Purchasing module.

In requisitions, you can:

• Combine all or selected material items.

• Load material items into a purchase order.

• View the purchase history or change history of the requisition.

• Update the pricing information.

• Create an export requests for pricing.
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• Import pricing information for requisitions.

• Create requisition reports.

For more information, see the following links:

Create a requisition (page 975)

Open a requisition (page 983)

Modify a requisition (page 985)

Manage files for a requisition (page 986)

Add a requisition item (page 986)

Copy a requisition item (page 994)

Modify requisition items (page 990)

Delete requisition items (page 995)

View the pricing history of a requisition item (page 995)

View all changes in a requisition (page 997)

Load requisition items into a purchase order (page 998)

Export a request for pricing (page 1000)

Import pricing information to a requisition (page 1002)

Update pricing information (page 1005)

Combine items in the Requisition # dialog box (page 1007)

View, print, or export requisition-specific reports (page 1009)

Delete requisitions (page 1012)

View Document Index history of changes (page 161)

Create a requisition
To create a new requisition where you can load and store material items, you
need to define a few properties.

1. Open the module. 

The Select Requisition/Purchase Order dialog box opens.

2. Select the Requisitions tab.

3. Click Add. 
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The Requisition Edit dialog box opens.

4. On the General tab, define the following properties: 

The properties marked with an asterisk (*) are mandatory information.

Option Description
Requisition Date * The date of the requisition.

Tekla PowerFab automatically uses the current
date. To change the date, do one of the following:

• Type the date in the Requisition Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

•
Requisition # Do either of the following to define the requisition

number:

• Type the desired requisition number in the
Requisition # field.

• To use the next available number from a prefix
as the requisition number, type the desired
prefix, double-click the Requisition # field, and
click Yes to confirm using the prefix.

For example, you can use a related job number
as the prefix.
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Option Description
We recommend that you plan the numbering of
requisitions carefully to help you organize the
requisitions in the future.

Note that the requisition number cannot be
changed later.

All other requisition information can be modified
later.

Description A description of the requisition.
Requisition Group The groups where the requisition belongs to.

Setting requisition groups for the requisition helps
you to sort requisitions in the Select Requisition/
Purchase Order dialog box.

To set requisition groups, do one of the following:

• Type new requisition group names in the
Requisition Group fields.

• Click the arrows on the right side of the
Requisition Group fields, and select existing
requisition groups in the lists.

Item Increment Sets the autoincrement for item numbers.

The default autoincrement of 10 allows items to be
added in the list as needed, without having to
renumber the other items in the job.

For example, if items should be numbered as 10,
20, 30, ..., set the input increment to 10. If the
autoincrement of item numbers is not necessary,
type 1.

5. On the Notes tab, type any notes about the requisition.

6. Click Save to create the requisition.

The Requisition Edit dialog box closes. The new requisition is added to the
Select Requisition/Purchase Order dialog box.

By clicking the buttons, you can find more settings.

NOTE Defining job-specific properties is optional. If you do not define job-
specific properties, Tekla PowerFab uses the default properties
defined in Maintenance --> Company Standards.

See also

Define combining optimizations for a requisition (page 978)

Define suppliers for a requisition (page 981)
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Define input and display units for a requisition (page 982)

Modify a requisition (page 985)

Manage files for a requisition (page 986)

Delete requisitions (page 1012)

Define company standard settings for requisitions (page 948)

Define combining optimizations for a requisition
You can define requisition-specific settings for material optimization.

You are in the Purchasing module. You are either creating a new job or
modifying an existing job in the Requisition Edit dialog box.

1. Click Combining Optimizations.

The Combining Setup dialog box opens.

2. Modify the settings on the various tabs as needed.

Define the general settings

1. Go to the General Settings tab.

2. Modify the settings as needed. 

Option Description
Use Grade Substitutions Select to check for material in

inventory that has an alternative
grade to the one specified.
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Option Description
Only grades of an equal or higher
rating will be used as set in
Maintenance --> Shapes/Grades/
Sizes --> Shape/Grade/Size
Maintenance dialog box.

If the grade substitutions are not set,
the material grades in the combining
run and in the supplier pricing data
set or the inventory need to match
each other exactly.

Combine Only Within Sequence Select if you want to mult and nest
only materials that are in the same
sequence onto the inventory items or
purchasable lengths.

The selection of Combine Only
Within Sequence uses additional
material for each sequence. This may
be desirable in some cases, but it may
also lead to excess drop amounts.

Optimizations Not Included/
Optimizations Included

Allows you to select the optimization
options that you want to use by
moving them to the Optimizations
Included list using the arrow buttons.

Inventory Exact-Match (In Stock) Use this option for inventory items in
stock that are an exact match without
the use of kerf or clamp allowance.

Inventory Exact-Match (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that are an
exact match without the use of kerf or
clamp allowance.

Inventory Least-Scrap (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that will
provide the least amount of scrap.

Inventory Least-Scrap (In Stock) Use this option for inventory items in
stock that will provide the least
amount of scrap.

Warehouse Least-Scrap Use this option to give preference to
warehouse items that will provide the
least amount of scrap. Warehouse
items will only be used when they
provide less scrap than the available

Purchasing 979 Create and manage requisitions



Option Description
inventory items or no inventory
exists.

Warehouse Force Inventory Use this option to force the use of
inventory items if available regardless
of the amount of scrap, no matter
where it is located in the
Optimizations Included list. This
option is the opposite of Warehouse
Least-Scrap.

Note that you can only include
Warehouse Least-Scrap or
Warehouse Force Inventory, not
both.

3. Modify the order of the optimizations by using the Move Up and Move
Down buttons 

The order is important when you are performing a combining run.

4. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define multing settings

1. Go to the Mult Settings - Linear Material tab.

2. Modify the settings as needed. 

Option Description
Apply Kerf Select if you want to apply the

material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Allow Split T's Select to allow split tees.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

Define plate nesting settings

1. Go to the Plate Nesting Settings tab.
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2. Modify the settings as needed. 

Option Description
Shear Cut Optimization Select a suitable shear cut option. The

selected option determines the plate
allowance to be used with the
combining:

• None: Use when cutting plate on a
burn table.

• Shear Cut - First Cut Along
Length or Shear Cut - First Cut
Along Width: Use to alert Tekla
PowerFab that the nesting needs
to allow for that type of cut first.
Then, the nesting will allow for all
subsequent cuts to be made with
that condition.

Apply Kerf Select if you want to apply the
material kerf settings defined in
Shape/Grade/Size Maintenance to
the combining as part of the cutting
pattern.

Rotate Plates for Best Fit Select if the material grain direction is
unimportant and you want Tekla
PowerFab to create the best possible
optimization of a plate.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

When you click Save, the Combining optimizations settings are saved.

See also

Define default combining optimizations for requisitions (page 950)

Troubleshoot combining issues (page 1110)

Define suppliers for a requisition
You can define supplier information for individual requisitions.

You are in the Purchasing module. You are either creating a new requisition of
modifying an existing one.

To make suppliers available in the Suppliers dialog box, you must first add the
suppliers in Maintenance --> Pricing Maintenance.
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1. Click Suppliers. 

The Suppliers dialog box opens.

2. Select suppliers for each material group on the drop-down lists.

3. Click OK. 

You return to the Requisition Edit dialog box.

4. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

When you click Save, the changes you made are saved. You can further modify
the job properties by clicking the buttons.

See also

Create a requisition (page 975)

Modify a requisition (page 985)

Define default suppliers for requisitions (page 953)

Define input and display units for a requisition
You can define input and display units for individual requisitions. You can
select either metric or imperial units and the units of measurement for a
piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

You are in the Purchasing module. You are either create a new requisition or
modifying an existing requisition in the Requisition Edit dialog box.

1. Click Input/Display Units. 

The Input/Display Units dialog box opens.

2. Select the measurement system and the units of measurement on the
drop-down menus.

3. Click OK. 

You return to the <Module> Job Edit dialog box.

4. Do either of the following:

• Click Save

The <Module> Job Edit dialog box closes.
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• Continue to add or modify properties.

When you click Save, the changes you made are saved.

See also

Create a requisition (page 975)

Modify a requisition (page 985)

Define default input and display units for Purchasing (page 963)

Find a requisition
You can search to find a specific requisition.

1. In the Select Requisition/Purchase Order dialog box, click the
Purchasing ribbon tab.

2. Select Find Requisition. 

The Enter Value dialog box opens.

3. Select the requisition on the drop-down menu or enter the job number in
the search box.

4. Click OK.

The selected requisition is highlighted. To open the requisition, double-click it
or click Open.

Open a requisition
To view and modify the material items in a requisition, you need to open the
requisition:

1. At the top of the Tekla PowerFab window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Requisitions tab.

3. Select the requisition that you want to open.

4. Do one of the following:

• At the bottom of the dialog box, click Open.

• Double-click the selected requisition.
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The Requisition # dialog box opens. View the components of the dialog box in
the following image:

(1) The summary grid: shows the number of requisition items, their length,
square feet, weight, surface area, and cost for items for a single item, the
selected items, the displayed items, and the entire requisition.

(2) The mode switch button: the Requisition # dialog box has two modes: the
input mode and the manual combine mode. In the input mode, you can add
material items and modify them. In the manual combine mode, you can add
stock material items, and combine specific material items manually.

To change the mode, click the button in the upper-left corner.

(3) The display area: shows all material items in the requisition.

The visible columns and details can be modified in the Edit Display Fields
dialog box.

Note that a C in the leftmost column indicates that the material items have
been combined.

(4) The input area: allows you to add properties for new material items and
modify properties of the existing material items.

When you select an item in the display area, its properties automatically
populate the input fields.

The visible columns and details can be modified in the Edit Input Fields dialog
box.

(5) The navigation tree: allows you to only view specific items in the requisition.
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Click + to expand and select options in the navigation tree. When you select an
option, only material items that match the selected properties are displayed in
the display area.

For example, you can expand Shape and select HSS to only display hollow
structural sections.

(6) Combining information grid: shows the pieces combined to the item that is
selected in the display area.

Note that you can see the number of pieces linked to Production Control in
the lower-right corner of the dialog box.

Modify a requisition
You can modify all properties of a requisition at any time, except for the
requisition number.

1. Open the module. 

The Select <Module> Job dialog box opens.

2. Select the Requisitions tab.

3. Select the requisition that you want to modify.

4. Click Edit.. 

The Requisition Edit dialog box opens.
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5. Modify the properties in the dialog box. 

For details on the properties, see Create a requisition (page 975).

6. Click Save to update the requisition.

When you click Save, the changes you made are saved. You can further modify
the job properties by clicking the buttons.

See also

Open a requisition (page 983)

Manage files for a requisition (page 986)

Delete requisitions (page 1012)

Manage files for a requisition
Document Index is a place for storing files to be shared among other users.
In Document Index, you can store various kinds of documents for reference,
and modify, delete, open, and email these files.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

See also

Document Index (page 149)

Add a requisition item
Most items are added to requisitions by loading the material items from
combining, estimating, or production control jobs to requisitions. You can also
add new items to an open requisition manually.

1. In the Requisition # dialog box, click New.

2. Define the item properties. 
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NOTE The visible input fields and their order depend on the settings
that you have defined in Maintenance --> Requisitions --> Edit
Input Fields .

The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Base Price The base price of the material item. We

recommend that you use base prices to create
more detailed reports.

Type in the base price.

To change the base price units and to convert the
current price to the selected units, right-click the
Base Price field, and select an appropriate option
in the context menu.

Category, Sub-Category A keyword used for sorting items in the
Requisition # dialog box. Categories and sub-
categories can be used for filtering information in
the Requisition # dialog box.

Type the desired keywords in the Category and
Sub-Category fields.

Comment An optional comment that you can type for the
item.

Cost Code The cost code assigned to the item.

Select a cost code from the drop-down menu.

For more information about cost codes, see Create,
modify, or delete cost codes (page 973).

Date Promised The date when the supplier has promised to
deliver the material item. The Date Promised can
be useful in reports.

Do one of the following:

• Type the date in the Date Promised field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Select the date in the calendar.
Date Required The date when the material item is due. Entering

the required date can be useful when creating
reports.

Do one of the following:
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Option Description
• Type the date in the Date Required field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Select the date in the calendar.
Dimensions * The material dimension, or material size, of each

piece.

Depending on the shape, the dimension can also
be mandatory information.

Click the Dimensions field to select an available
material dimension, and double-click the desired
dimension in the list.

You can also use a custom material dimension.
Note that the dimension is not automatically
added to the material database.

To use a custom dimension:

a. Click in the Dimensions field.

b. Click Add Size.

c. Define the dimension properties.

d. Click Save.

You can now select the dimension and use it.
Grade * The material grade of each piece.

Either select the grade from the drop-down menu
or type the grade indicator in the field.

Item # * The item number.

You can modify the item number manually or use
the item number automatically determined by
Tekla PowerFab.

Job # The number of the production control job the
material item is reserved to.

Type in the number.
Length The length of each piece.

Default length input settings are set in Company
Standards, but you can modify them for each job.

Lot # The lot identification number of the material item.

Type the lot number in the Lot # field.

Purchasing 988 Create and manage requisitions



Option Description
Mill Mark Any extra information about the item that the mill

has given you.

Type in the mill mark.
PRC Cost, PRC Date,
PRC Unit Cost

Fields that show the current pricing information of
the selected item from the selected supplier.

If no date is displayed in the PRC Date field, the
material does not exist in the selected supplier's
pricing data set.

Double-click one of the fields to open the Pricing
Maintenance dialog box and enter pricing
information.

PRC Supplier The supplier warehouse whose pricing the item
uses.

Select the supplier from the drop-down menu.
Purchasing Notes A longer description of the item. The field can be

useful for adding specifications for buyout items.
Quantity * The number of pieces to be added.

Use the numeric keypad to add, multiply, divide, or
subtract number of items.

Reference Number A reference number that links items in inventory or
purchasing to the production control job.

The reference number can be different depending
on the case:

• If an item is sent from Production Control to
Purchasing or Inventory, Tekla PowerFab
creates a copy of the record, and the item is
linked to include the reference number.

• If an item is sent to Purchasing from an
advanced bill of material, the system mark
number or a combination of the page number
and the item number in the combining job (for
example, 1-30) becomes the reference number.

• If the item is sent to Purchasing later in the
process, the reference number is the mark or
piece mark number.

Sequence The sequence number assigned to the item.

Type in the number.
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Option Description
Shape * The material shape of each piece.

Either select the shape from the drop-down menu
or type the shape indicator in the field (for
example, HSS).

3. Click Add.

The new requisition item is added at the bottom of the requisition.

NOTE If you added the new item while in the manual combine mode, the
item will belong to stock materials. The material items added in the
manual combine mode are marked with a C in the leftmost column.
For more information on the manual combine mode, see Open a
requisition (page 983).

Modify requisition items
You can either modify items one by one, or use the Global Edit commands to
modify multiple items at one go.

TIP If you cannot find the property you want to modify, check if you can add it in
Maintenance --> Requisitions --> Edit Input Fields.

For more information, see the following links:

Modify a single requisition item (page 990)

Modify multiple requisition items (page 991)

Modify the selected requisition items (page 992)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 992)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 994)

Modify a single requisition item
You can modify the properties of requisition items one by one in the
Requisition # dialog box.

1. In the Requisition # dialog box, select the material item that you want to
modify.

2. On the right side of the dialog box, modify the properties of the item
according to your needs. 

For example, you can change the base price of the item or assign a cost
code to the item.
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3. Click Save to update the item properties.

See also

Modify multiple requisition items (page 991)

Modify the selected requisition items (page 992)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 992)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 994)

Modify multiple requisition items
Use the Global Edit command to modify the properties of multiple items at
one go. This way, you can save time, as you do not need to change the
properties of each item individually.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Global Edit --> Global Edit. 

The Global Edit Filters dialog box opens.

3. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

4. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

5. Click OK. 

To further limit the item types that you want to modify, repeat steps 3 to 5
for all necessary filter types.

6. Click OK. 

The Global Edit dialog box opens.

7. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

8. Click Update. 

The Confirm dialog box opens.

9. To confirm changing the properties of multiple items, click Yes.

The changes you made to the item properties are updated.
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See also

Modify a single requisition item (page 990)

Modify the selected requisition items (page 992)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 992)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 994)

Modify the selected requisition items
Use the Global Edit - Selected command to modify the properties of multiple
selected items at one go. This way, you can save time, as you do not need to
change the properties of each item individually.

1. In the Requisition # dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Requisition ribbon tab.

3. On the menu, select Global Edit --> Global Edit - Selected. 

The Global Edit - Selected dialog box opens.

4. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

5. Click Update.

The properties of the selected items are updated.

See also

Modify a single requisition item (page 990)

Modify multiple requisition items (page 991)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 992)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 994)

Modify the shape, grade, dimensions, or length of multiple requisition
items
Use the Global Edit By Shape command to modify the shape, grade,
dimensions, or length of all or multiple items.

1. In the Requisition # dialog box, click the Requisition ribbon tab.
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2. On the menu, select Global Edit --> Global Edit By Shape . 

The Global Edit Filters dialog box opens.

3. Select a shape on the Shape drop-down menu. 

4. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

5. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

6. Click OK. 

The Global Edit dialog box opens.

7. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

8. Click Update. 

The Confirm dialog box opens.

9. To confirm changing the properties of multiple items, click Yes.

The changes you made to the item properties are updated.
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See also

Modify a single requisition item (page 990)

Modify multiple requisition items (page 991)

Modify the selected requisition items (page 992)

Modify the shape, grade, dimensions, or length of the selected requisition
items (page 994)

Modify the shape, grade, dimensions, or length of the selected
requisition items
Use the Global Edit Selected By Shape command to modify the shape, grade,
dimensions, or length of selected items.

1. In the Requisition # dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Requisition ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected By Shape . 

The Global Edit - Selected dialog box opens.

4. Select the properties that you want to update. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

5. Click Update.

The changes you made to the item properties are updated.

All other reference information of the items remains unchanged.

See also

Modify a single requisition item (page 990)

Modify multiple requisition items (page 991)

Modify the selected requisition items (page 992)

Modify the shape, grade, dimensions, or length of multiple requisition items
(page 992)

Copy a requisition item
You can copy a requisition item and use it as the basis of a similar item. By
copying items, you can save time and avoid entering the same information
multiple times in a requisition.

1. In the Requisition # dialog box, select the item that you want to copy.
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2. At the bottom of the dialog box, click Copy. 

A copy of the item appears at the bottom of the requisition.

3. Adjust the properties of the new item according to your needs.

4. Click Edit to save the changes.

See also

Modify a single requisition item (page 990)

Delete requisition items
You can delete any unnecessary items from the requisition. Note that deleting
requisition items is permanent and cannot be undone.

You can still see the deleted items in the list of changes. For more information,
see View all changes in a requisition (page 997).

1. In the Requisition # dialog box, select the requisition items that you want
to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

Note that if the requisition item that you want to delete has been
combined, you first need to uncombine the item by clicking Uncombine.
The Delete button appears when the item has been uncombined.

2. At the bottom of the dialog box, click Delete.

3. To permanently delete the requisition items, click Yes in the confirmation
dialog box.

View the pricing history of a requisition item
Use the Purchase History command to view the pricing history of a material
item. You can filter the purchase history by various options, such as the
vendor, the requisition number, or the length.

1. In the Requisition # dialog box, select the material item whose pricing
history you want to view.

2. Click the Requisition ribbon tab.

3. On the menu, select Purchase History. 
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The Purchase Order History dialog box opens.

The top section of the dialog box allows you to filter the pricing history
information, whereas the bottom section shows the pricing history of the
material item.

4. If necessary, filter the pricing history by clicking arrows on the right side of
the different filter lists and selecting filtering options in the lists.

5. To update the pricing history to match the filters you set, click Load
History.

6. If you want to save the pricing history as a Microsoft Excel worksheet, do
the following:

a. Right-click anywhere in the display area of the Purchase Order
History dialog box.

b. In the context menu, select Export to Excel.

c. In the Save As dialog box, browse to the folder where you want to
save the file.

d. If necessary, change the file name.

e. Click Save.

If necessary, you can customize the layout of the Purchase Order History
dialog box to include only the when exporting the pricing history. For
more information, see Customize the layout of a dialog box (page 258).

7. To close the Purchase Order History dialog box, click the Close button
(X) in the upper-right corner.
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See also

View all changes in a requisition (page 997)

Update pricing information (page 1005)

View all changes in a requisition
Tekla PowerFab records every change made in the system. This is useful
because you can view all changes made in the current requisition at once. You
can filter the information to see changes made by a particular user, or on a
particular date. You can also print the list of changes.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date filter

type and click Select.

b. Do one of the following:

• Enter the start (Minimum)
and end (Maximum) dates.

• Select the Expression
checkbox for the start or end
date. Then, select the base
date and select how many
more or less days will be
taken into account.

c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do one of the following: 
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To Do this
View the list of changes • Click View.

The report opens in Tekla PowerFab Report
Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

View the pricing history of a requisition item (page 995)
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Load requisition items into a purchase order
Use the Load Material Into Purchase Order and Load Selected Material
Into Purchase Order commands to load material items from a requisition to a
purchase order. Use the Load Material Into Purchase Order command to
load all requisition items into a purchase order, or use the Load Selected
Material Into Purchase Order command to select the items in a requisition
that are loaded into a purchase order. When you load material items into a
purchase order, the items become available in the inventory.

According to your needs, see any of the following instructions:

Load all items into a purchase order
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Load Material Into Purchase Order.

3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. To only load specific types of items to the purchase order, in the
Purchasing Import Filters dialog box, select a filter type in the Type list,
and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the properties of the items that you
want to load to the purchase order to the Included list.

• Type the maximum and minimum values for the items that you want
to load to the purchase order.

6. Click OK. 

To further limit which items are loaded to the purchase order, repeat
steps 4 to 6 for all necessary filter types.

7. Click Import.

8. Click OK to close the Import Items dialog box.

The material items are loaded to the selected purchase order, so they are no
longer visible in the Requisition # dialog box.

Load selected items into a purchase order
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Load Selected Material Into Purchase Order.
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3. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

If necessary, you can also create a new purchase order and load the items
into it.

4. In the Enter Value dialog box, type the quantity of pieces that you want to
load to the purchase order.

5. Click OK.

6. Click OK to close the Import Items dialog box.

Export a request for pricing
A request for pricing allows you to get pricing from multiple suppliers. Use the
Export Request for Pricing commands to save a request for pricing as an
Microsoft Excel worksheet or a steelXML file and send it to suppliers. You can
also attach the request for pricing to an email and send it to a supplier using
Microsoft Outlook. Once you receive responses, you can import the suppliers'
pricing information to Tekla PowerFab.

Save a request for pricing as a Microsoft Excel worksheet
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Export Request for Pricing --> Export to Excel .

3. In the Save As dialog box, browse to the folder where you want to save
the file. 

By default, Tekla PowerFab saves the file to the Export folder.

4. If necessary, change the file name.

5. Click Save.

To modify the request for pricing in Microsoft Excel, see Modify pricing
information in Microsoft Excel (page 1002).

Email a request for pricing as a Microsoft Excel worksheet
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Export Request for Pricing --> Email Excel .

3. In the Select Contact dialog box, select the supplier, supplier code, and
contact person. 

Only companies whose type is set to Supplier and their contacts that are
saved in the Address Book are available.

Defining the information in the Select Contact dialog box is optional. You
can also define the information directly in the email when it is created.
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4. In the Email field, type the email address of the contact person.

5. Click OK. 

Microsoft Outlook opens. The Microsoft Excel worksheet is attached to a
new email.

6. Modify the email according to your needs.

7. Send the email.

Save or email a request for pricing as an steelXML file
The Export to steelXML command works specifically with the steelXML
software. Use the Export to steelXML command to submit requests for
pricing to suppliers, so that the suppliers can give you prices that are specific
to the material information in the current requisition.

NOTE All items in the current requisition are included in the steelXML file
that is exported. If you need to submit some of the items to different
suppliers, you need to move those items to a different requisition.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Export Request for Pricing --> Export to steelXML .

3. In the Export Pricing dialog box, select the supplier, supplier code,
contact person, and the contact person's email address. 

Only companies whose type is set to Supplier and their contacts that are
saved in the Address Book are available.

Selecting options in the Export Pricing dialog box is optional.

4. If you want the supplier to combine the items on their available inventory
and provide the nesting results in the returned pricing, select the Request
Nested Results checkbox. 

If you have already combined the items within the requisition or if you are
ordering the items cut to length by the supplier, do not to select the
Request Nested Results checkbox.

5. According to your needs, do one of the following: 

To Do this
Save the steelXML file a. Click Export.

b. In the Save As dialog box, browse to the folder
where you want to save the file.

By default, Tekla PowerFab saves the file to the
Export folder.

c. If necessary, change the file name.
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To Do this
d. Click Save.

You can later send the steelXML file to suppliers
using your email service, if necessary.

Send the steelXML file by
email

a. In the Email field, type the email address of
the contact person.

b. Select the Attach to Email checkbox.

c. Click Export.

Microsoft Outlook opens. The steelXML file is
attached to a new email.

d. Modify the email according to your needs.

e. Send the email.

After the supplier has processed the file in steelXML and sent the file back to
you, you can import the steelXML results back to Tekla PowerFab. For detailed
instructions, see Import pricing information to a requisition (page 1002).

Modify pricing information in Microsoft Excel
When you have saved or received a request for pricing as a Microsoft Excel
worksheet, you can modify the pricing in Microsoft Excel. After making the
changes, you or your client can import the pricing information back to Tekla
PowerFab.

1. In Microsoft Excel, type the prices for items in the Base Price column. 

To import the pricing information correctly, type the prices in the following
format: currency price/unit. For example, $56.99/CWT.

You only need to define the base prices of items. Tekla PowerFab
calculates the total price during the import.

2. If necessary, type the total prices for items in the Total Price field.

3. Save the Microsoft Excel worksheet.

See also

Export a request for pricing (page 1000)

Import pricing information to a requisition (page 1002)

Import pricing information to a requisition
Use the Import Requisition Pricing commands to import the pricing
information that you want to use in the current requisition from a steelXML file
or a Microsoft Excel worksheet. You can also import pricing from an email
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attachment that is either a Microsoft Excel worksheet or a steelXML file. New
pricing information can be imported multiple times, if necessary.

Note that if you want to re-use the imported pricing information later, you also
need to update the pricing information to a pricing database. For more
information, see Update pricing information (page 1005).

Import pricing information from an Excel worksheet
1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Import Requisition Pricing --> Import Pricing From
Excel File .

3. In the Open dialog box, browse to find the worksheet from which you
want to import the pricing information.

4. Select the worksheet, and click Open. 

5. In the Verify Excel Import Data dialog box, verify that the information is
correct. 

If you want to exclude information on particular rows from being
imported, you can double-click the rows.

6. Click OK. 
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The Import Field Map dialog box opens. In the dialog box, the headings
of the Excel worksheet need to be mapped to the Tekla PowerFab
standard field headings.

7. If the values of an item in the Import Field and Tekla PowerFab Field
columns do not match or are not correct, do the following:

a. Select the unmatched Import Field value.

b. On the right side of the dialog box, select a suitable field in the Tekla
PowerFab Field list.

c. Click Set Field Mapping.

8. When you have mapped all fields together, click OK to continue.

9. In the Import dialog box, view the status of the import process. 

To view the import process as a text file, you can click Open Import Log.

10. To close the Import dialog box, click the Close button (X) in the upper-
right corner.

Import pricing information from an XML file
When you have received the steelXML results from a supplier, you can import
them to Tekla PowerFab.

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Import Requisition Pricing --> Import Pricing From
steelXML File .

3. In the Open dialog box, browse to find the file from which you want to
import the pricing information.
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4. Select the file, and click Open.

5. In the Import dialog box, view the status of the import process. 

To view the import process as a text file, you can click Open Import Log.

6. To close the Import dialog box, click the Close button (X) in the upper-
right corner.

Import pricing information from an email attachment
Note that you can only import pricing information from email attachments if
you are using Microsoft Outlook.

1. In Microsoft Outlook, select the email whose attachments you want to
import.

2. In the Import dialog box, view the status of the import process. 

To view the import process as a text file, you can click Open Import Log.

3. To close the Import dialog box, click the Close button (X) in the upper-
right corner.

Update pricing information
Use the Update Pricing Maintenance command to update the pricing of
material items in a requisition to pricing maintenance as well. This way, the
pricing that you set in the requisition can be re-used in the future. You can
update the pricing information to either the global pricing or the estimate-
specific pricing.

1. In the Requisition # dialog box, select the material items whose current
pricing information you want to update. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. On the menu, select Update Pricing Maintenance. 
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3. In the Pricing Update dialog box, do one of the following: 

To Do this
Update pricing to the
global pricing

a. At the top of the dialog box, select the Update
Global Pricing option.

b. Click the arrow on the right side of the
Supplier to Update list and select the supplier
whose pricing information you want to
update.

Update pricing to the
estimate-specific pricing

a. At the top of the dialog box, select the Update
Estimate-Specific Pricing option.

b. Click the arrow on the right side of the
Estimate to Update list and select the
estimate whose pricing information you want
to update.

4. If you want to update the pricing of all material items within a previously
created global edit form, click the arrow on the right side of the Global
Edit Form list, and select the global edit form that you want to use.

5. Do one of the following to exclude items from being updated to the
pricing database:

• Select an item whose pricing information you do not want to update,
and click Exclude.

• To exclude all items, click Exclude All.

You can re-include the excluded items by clicking the Include and Include
All buttons.

6. Click Update Pricing.
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7. To confirm updating the pricing information, click Yes in the confirmation
dialog box.

The pricing information is updated to the selected location, and the Pricing
Update dialog box closes.

If the material shape, grade, or dimension does not exist in the pricing
maintenance database, it is added to the database when you update the
pricing.

See also

View the pricing history of a requisition item (page 995)

Combine items in the Requisition # dialog box
You can mult and nest requisition items using the Combine command.
Combining requisition items creates a list of materials that you can later send
out for pricing.

1. On the Requisitions tab in the Select Requisition/Purchase Order
dialog box, open a requisition.

2. Click the Requisition ribbon tab and select Combine. 

The Select Combining Run dialog box opens. When you are performing
the first combining run for a combining job, the list in the dialog box is
empty.

3. Click a desired combining option to select it. 

The options are:

• Mult: Combines linear items, like beams and angles.

• Nest: Combines items that have area, like plates or gratings.

• Mult & Nest: Combines all items.

The Combining Run Filters dialog box opens.

NOTE Filtering items is optional, so you can skip steps 4 to 7 if you do
not want to filter out items from the combining run.

4. To only combine specific types of materials, select a filter type in the Type
list, and click Select.

5. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the items that you want to combine to
the Included list.

• Type the maximum and minimum values for the items that you want
to combine.
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6. Click OK to apply the filter. 

Repeat steps 4 to 6 for each filter type that you want to set.

7. To ensure that you are using the correct settings, click the Optimizations,
INV Filter, and Suppliers buttons. 

You can modify the settings.

8. In the Combining Run Filters dialog box, click OK.

9. To combine the materials, click the button at the bottom of the
Combining Run Filters dialog box, or press F4.

Tekla PowerFab combines the materials. After the combining process is
finished, the Combining Run Results dialog box opens.

• Piece mark items included with the selected stock lengths are displayed at
the lower-left section of the dialog box.

• Combining results are shown in both the display area and in the summary
grid at the lower-right section of the dialog box.

• The material cost represents the pricing of the materials in the pricing
database that was used in the combining run.

To save the combining run, click either of the following:

• Save Combining Run: Saves the combining run as a snapshot that you can
later view by selecting it in the Select Combining Run dialog box. No cut
lists are generated.

• Save Displayed Results & Close: Completes the requisition combining
run, saves the displayed combining run results, and returns to the
Requisition # dialog box.

The material items that were combined to the existing inventory items are
removed from the requisition and disappear from the Requisition # dialog
box. The items that were combined to the supplier materials remain in the
requisition until you send the items to a purchase order.

See also

Combine requisition items manually (page 1008)

Export materials for combining (page 90)

Troubleshoot combining issues (page 1110)

Combine requisition items manually
To combine the selected material lengths manually, you need to activate the
manual combine mode. You can then select pieces to combine them into a
specific material length, or uncombine pieces from a material length.

NOTE You can only manually combine items that have been created
manually or by copying existing items in the manual combine mode.
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These items are marked with a C in the leftmost column of the
Requisition # dialog box.

1. In the upper-left corner of the Requisition # dialog box, click Manual
Combine Mode. 

The manual combine mode is activated.

2. Select the material item to which you want to combine new items.

3. At the bottom of the dialog box, click Add Items. 

The Add Item dialog box opens. You can see all available uncombined
materials that can be combined into the selected length.

Tekla PowerFab notifies you if there are no materials available to be
combined. In this case, you need to uncombine some previously
combined material items by selecting the items and clicking the
Uncombine button at the bottom of the Requisition # dialog box.

4. In the Add Item dialog box, click an uncombined item to select it.

5. If necessary, modify the quantity of inventory items that you are
combining materials to. 

If the quantity is greater than 1, the materials should be multiples of that
quantity in order to be displayed and selected in the Add Item dialog box.

6. To allow material grade substitutions, select the Use Grade Substitutions
checkbox.

7. Click Add.

The selected uncombined pieces are now combined into the selected material
item.

To return to input mode, click Input Mode in the upper-left corner of the
Requisition # dialog box.

See also

Combine items in the Requisition # dialog box (page 1007)

View, print, or export requisition-specific reports
You can create various reports based on the current requisition. After creating
a report, you can view or print the report, or export the report and save it in
another file format.

To create requisition reports, do the following:

1. In the Requisition # dialog box, click the Requisition ribbon tab.

2. On the menu, select Reports, or press Ctrl+R on the keyboard.
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3. To only include specific item types in the reports, in the Requisition
Report Filters dialog box, select a filter type in the Type list, and click
Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the item properties that you want to
include in the reports to the Included list.

• Type the maximum and minimum values for the item properties that
you want to include in the reports.

5. Click OK. 

To further limit the requisitions included in the reports, repeat steps 3 to 5
for all filter types.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view, print, or export.

According to your needs, see any of the following instructions:

View the report
• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.
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4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

7. To open the file after exporting it, select the Open Exported Document
checkbox.

8. In the Report Selection dialog box, click Export.

Export data from the report
To ensure that all data is exported from a Stimulsoft report to Excel, follow the
steps provided here.

1. In the report that you have open in Tekla PowerFab Report Viewer, click
Save.

2. In the context menu, select Microsoft Excel File. 
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The Microsoft Excel File - Export Settings dialog box opens.

3. On the Bands Filter drop-down menu, select Data and Headers/Footers.

4. Click OK. 

You are prompted to save the data in an Excel file. You can change the file
name and the location here.

5. To save the data, click Save.

See also

Customize reports (page 268)
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Delete requisitions
You can delete unnecessary requisitions in the Select Requisition/Purchase
Order dialog box.

NOTE When you delete a requisition, all material items in the requisition are
also deleted.

1. At the top of the Tekla PowerFab window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Requisitions tab.

3. Select the requisitions that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. At the bottom of the dialog box, click Delete.

5. To permanently delete the requisitions, click Yes in the confirmation
dialog box.

10.3 Create and manage purchase orders
You can create and modify purchase orders and material items within the
purchase orders in the Purchase Orders part of the Purchasing module.

We recommend that you plan the numbering of purchase orders carefully to
help you organize the purchase orders in the future.

You can also:

• Receive and unreceive materials.

• Filter the information displayed in the purchase order.

• Approve a purchase order, so that no further changes can be made.

• Finalize material items, so that no changes can be made to the items.

• Unfinalize items to allow making changes to them again.

• Copy material items to another purchase order.

• View the pricing history of a material item.

• View the transaction history of a purchase order.

• View the heat documents attached to material items.

• View all changes made to a purchase order.

• Create purchase order reports and receiving reports, and view, print, or
export the created reports.
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• Export purchase order information to a selected accounting software.

All material items on purchase orders are also visible in the inventory as items
that are on order.

Create a purchase order
To create a new purchase order where material items can be stored, you need
to define a few properties.

1. Open the module. 

The Select Requisition/Purchase Order dialog box opens.

2. Select the Purchase Orders tab.

3. Click Add. 

The Purchase Order Edit dialog box opens.

Continue to defining the properties on the tabs.

4. Click Save to create the purchase order.

The Purchase Order Edit dialog box closes, and the new purchase order is
added to the Select Requisition/Purchase Order dialog box.
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Define general settings
1. In the Purchase Order Edit dialog box, select the General tab.

2. Modify the settings as needed. 

The properties marked with an asterisk (*) are mandatory information.

Option Description
P.O. Date * The date of the purchase order.

Tekla PowerFab automatically uses the current
date. To change the date, do one of the following:

• Type the date in the P.O. Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the P.O.
Date field and select a date in the calendar.

Reference # Type any reference number related to the
purchase order.

P.O. Number Type the purchase order number.

We recommend that you plan the numbering of
purchase orders carefully to help you organize the
purchase orders in the future.

Note that the purchase order number cannot be
changed later.

All other purchase order information can be
modified later.

Job Type any job number related to the purchase
order.

Job Location Type any job location related to the purchase
order.

Ordered By The Tekla PowerFab user in your company that
created the purchase order.

Select a user in the list.
P.O. Group The groups where the purchase order belongs to.

Setting purchase order groups for the purchase
order helps you to sort purchase orders in the
Select Requisition/Purchase Order dialog box.

To set purchase order groups, do one of the
following:

• Type new purchase order group names in the
P.O. Group fields.
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Option Description
• Click the arrows on the right side of the P.O.

Group fields, and select existing purchase order
groups in the lists.

Item Increment Sets the autoincrement for item numbers.

The default autoincrement of 10 allows items to be
added in the list as needed, without having to
renumber the other items in the job.

For example, if items should be numbered as 10,
20, 30, ..., set the input increment to 10. If the
autoincrement of item numbers is not necessary,
type 1.

P.O. Type The type of the purchase order.

The available options are set in PO Type
Maintenance. For more information, see Add,
modify, or delete purchase order types (page 967).

Shipping Method The shipping method of the purchase order.

The available options are set in Purchase Order
Shipping Method Maintenance. For more
information, see Add, modify, and delete shipping
methods for purchase orders (page 968).

F.O.B. The free on board shipping destination applied to
the purchase order.

The available options are set in Purchase Order
FOB Maintenance. For more information, see
Add, modify, or delete FOB shipping destinations
(page 969).

Define vendor settings
1. Go to the Vendor tab

2. Select the vendor, the address, the contact person, and the person with
whom the purchase order has been confirmed. 

NOTE Only companies that are saved in the Address Book with the firm
type Supplier and their contact persons can be selected.

3. If you have added additional currencies to Tekla PowerFab, select the
currency and exchange rate date for the purchase order.

Define client details (Ship To/Bill To)
The Ship To/Bill To tab is primarily used to specify the shipping address of the
purchase order.

Purchasing 1016 Create and manage purchase orders



1. Add or modify the properties as needed. 

Note that only companies that are saved in Maintenance --> Address
Book with the Client or My Company company types can be selected.

You can also modify the information manually.

Option Description
Ship To Select the receiver in the list.

The contact information is
automatically added to the blank
fields as defined in Maintenance -->
Address Book.

Bill To Select the billing information.

2. If necessary, click the arrows on the right side of the Inventory Location
and Secondary Location fields to define the inventory location of the
purchase order items.

Define remarks
1. On the Remarks tab, do either of the following:

• Click the arrows on the right side of the blank fields and select
previously created remarks in the lists.

• Type new remarks in the blank fields.

You can add up to four remarks. The available remark options are set in
the Purchase Order Remark Maintenance dialog box. For more
information, see Add, modify, or delete purchase order remarks
(page 971).

You can also set default remarks that are added for all new purchase
orders in the Purchase Order Company Standards dialog box. For more
information, see Define company standard settings for purchase orders
(page 957).

Define top text
On the Top Text tab, you can define what information you want to add at the
top of the purchase order.

1. Go to the Top Text tab.

2. Do either of the following:

• Click the arrow on the right side of the Description field, and select a
previously created top text item in the list.

The Top Text field is automatically populated.

• Type any necessary information in the Top Text field.

Purchasing 1017 Create and manage purchase orders



NOTE Any text you type manually in the Top Text is not saved, so it
cannot be reused.

You can create top text items in the Purchase Order Top Text
Maintenance dialog box. For more information, see Add, modify, or
delete top text items (page 972).

You can also set default top text items that are added for all new purchase
orders in the Purchase Order Company Standards dialog box. For more
information, see Define company standard settings for purchase orders
(page 957).

Define financial information
1. Go to the Financial tab.

2. Define the freight and adjustment costs, the payment terms, and the
discount percentage used in the purchase order. 

The available payment term options are set in the Purchase Order
Payment Term Maintenance dialog box. For more information, see Add,
modify, or delete payment terms for purchase orders (page 970).

Note that the adjustment costs can also be negative.

3. If necessary, apply tax rates to the purchase order as follows:

a. Click Tax Rates. 

The Select Tax Rates dialog box opens.

b. Click the arrow buttons to move the tax rates that you want to apply
to the purchase order to the Included list.

c. Click OK.

You can create any necessary tax rates and tax groups by clicking the
Maintenance ribbon tab and selecting Tax Rates in the menu.

Define other properties
On the tab,

1. Go to the Other tab.

2. Add any applicable information to the blank fields. 

For example, you can add information about the maximum lift or the
unload instructions.

3. If necessary, adjust the units used in the purchase order by clicking the
Input/Display Units button and modifying the properties. 

For more information, see Define company standard settings for purchase
orders (page 957).
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See also

Open a purchase order (page 1019)

Modify a purchase order (page 1022)

Delete purchase orders (page 1059)

Find a purchase order
You can search to find a specific purchase order.

1. In the Select Requisition/Purchase Order dialog box, click the
Purchasing ribbon tab.

2. Select Find Purchase Order. 

The Enter Value dialog box opens.

3. Select the PO number on the drop-down menu or enter the number in the
search box.

4. Click OK.

The selected purchase order is highlighted. To open the purchase order,
double-click it or click Open.

Open a purchase order
To view and modify the material items in a purchase order, you need to open
the purchase order.

1. At the top of the Tekla PowerFab window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Purchase Orders tab.

3. Select the purchase order that you want to open.

4. Do one of the following:

• At the bottom of the dialog box, click Open.

• Double-click the selected purchase order.
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The PO # dialog box opens:

(1) The summary grid: shows the following information number of purchase
order items, their length, square feet, weight, surface area, and cost for items.
These properties are shown for:

• a single piece of the selected item

• the selected items

• the currently displayed items

• the entire purchase order

(2) The mode switch button: the PO # dialog box has two modes: the input
mode and the receive mode. In the input mode, you can add new material
items and modify the existing ones. In the receive mode, you can mark
material items as received or rejected.

To change the mode, click the button in the upper-left corner.

(3) The display area: shows all material items in the purchase order.

The visible columns and details are set in the Display Fields dialog box. ou can
access the Display Fields dialog box via Maintenance --> Purchase Orders --
> Edit Display Fields .

You can also modify the visible columns and the dialog box layout by right-
clicking in the display area and selecting Customize grid in the context menu.

Note that a C in the leftmost column indicates that the material items have
been combined.

(4) The input area: allows you to add properties for new material items and
modify properties of existing material items. You can mark material items as
received, rejected, or canceled.
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When you select an item in the display area, its properties automatically
populate the input fields.

The visible columns and details are set in the Input Fields dialog box. You can
access the Input Fields dialog box via Maintenance --> Purchase Orders -->
Edit Input Fields .

(5) The navigation tree: allows you to only view specific items in the purchase
order.

Click + to expand and select options in the navigation tree. When you select an
option, only material items that match the selected properties are displayed in
the display area.

For example, you can expand Shape and select HSS to only display hollow
structural sections.

(6) Quantities received, rejected, and canceled: shows the material order
information of the item selected in the display area. You can view the quantity
of pieces that have been received, rejected, and canceled.

Filter information in the PO # dialog box
In addition to using the navigation tree for filtering items, you can set filters
that determine which items are shown in the in the PO # dialog box. For
example, you can create filters to only display the items that have been
received. You can also save the filters for later use.

1. In the Select Requisition/Purchase Order dialog box, select the
Purchase Orders tab.

2. Open a PO. The PO # dialog box opens.

3. Click the Purchase Order ribbon tab.

4. On the menu, select Filter. 
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The <Module> Filters dialog box opens.

5. Select a filter type in the Type list and click Select. 

Note that if you have saved a filter in the Purchase Order Report Filters
dialog box when creating global receiving reports, the saved filter will also
be available as a filter in the PO # dialog box for all purchase orders.

6. Click the arrow buttons to move the items that you want to display to the
Included list.

7. Click OK. 

If you want to further filter the information displayed , repeat steps 3 to 5
for different items. Note that only items that match the items in the
Included list will be available when setting more filters.

If you want to clear all filter settings, click Reset.

The <Module> Filters dialog box closes, and the items are filtered according
to the settings you made.

To display all information again, click Clear Filters in the upper-left corner.

To create and save commonly used filters, see Create and modify module-wide
filters (page 261).

Modify a purchase order
You can modify all properties of a purchase order at any time, except for the
purchase order number. You can also approve and lock a purchase order.

Purchasing 1022 Create and manage purchase orders



1. Open the module. 

The Select <Module> Job dialog box opens.

2. Make sure that you are on the Purchase Orders tab.

3. Select the purchase order that you want to modify.

4. Click Edit. 

The Purchase Order Edit dialog box opens.

5. Modify the properies as needed. For information on the properties, see
Create a purchase order (page 1014).

6. Click Save to update the purchase order.

7. To approve and lock the purchase order, click Approve Purchase Order.

See also

Create a purchase order (page 1014)

Open a purchase order (page 1019)

Manage files for a purchase order (page 1023)

Delete purchase orders (page 1059)
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Manage files for a purchase order
Document Index is a place for storing files to be shared among other users.
In Document Index, you can store various kinds of documents for reference,
and modify, delete, open, and email these files.

NOTE You should always save heat documents in the Heat Documents
category in Document Index. The Heat Documents category differs
from other document categories in that it maintains a link to the heat
document for all items that share the same supplier, purchase order
number, and heat number.

1. To access Document Index, do either of the following:

• In Combining, Estimating, Project Management, Production
Control, and Purchasing, click Document Index/Doc Ind or press F8.

• In Inventory, go to the Inventory ribbon tab and select Document
Index.

For Combining, Project Management, and Production Control, you are
asked to select if you want to open the Document Index dialog box
related to linked jobs.

The Document Index - By Category dialog box opens.

See also

Document Index (page 149)

Add a purchase order item
Most items are added to purchase orders by loading the material items from
combining, estimating, or production control jobs to purchase orders. You can
also add new items to an open purchase order manually.

NOTE All material items on purchase orders are also inventory items.

1. In the PO # dialog box, click New.

2. Define the item properties. 

NOTE The visible input fields and their order depend on the settings
that you have defined in Maintenance --> Purchase Orders -->
Edit Input Fields.
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The properties marked with an asterisk (*) in the following table are
mandatory information.

Option Description
Base Price The base price of the material item. We

recommend that you use base prices to create
more detailed reports.

Type in the base price.

To change the base price units and to convert the
current price to the selected units, right-click the
Base Price field, and select an appropriate option
in the context menu.

Category, Sub-Category A keyword used for sorting items in the PO #
dialog box. Categories and sub-categories can be
used for filtering information in the PO # dialog
box.

The Category and Sub-Category fields are
automatically populated by the linked items in
Production Control.

Comment An optional comment that you can type for the
item.

Cost Code The cost code assigned to the item.

Select a cost code from the drop-down menu.

For more information about cost codes, see Create,
modify, or delete cost codes (page 973).

Date Promised The date when the supplier has promised to
deliver the material item. The Date Promised can
be useful in reports.

Do one of the following:

• Type the date in the Date Promised field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Select the date in the calendar.
Date Required The date when the material item is due. Entering

the required date can be useful when creating
reports.

Do one of the following:

• Type the date in the Date Required field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Select the date in the calendar.
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Option Description
Dimensions * The material dimension, or material size, of each

piece.

Depending on the shape, the dimension can also
be mandatory information.

Click the Dimensions field to select an available
material dimension, and double-click the desired
dimension in the list.

You can also use a custom material dimension.
Note that the dimension is not automatically
added to the material database.

To use a custom dimension:

a. Click in the Dimensions field.

b. Click Add Size.

c. Define the dimension properties.

d. Click Save.

You can now select the dimension and use it.
Grade * The material grade of each piece.

Depending on the shape, the grade can also be
mandatory information.

Either select the grade from the drop-down menu
or type the grade indicator in the field.

Item # * The item number.

You can modify the item number manually or use
the item number automatically determined by
Tekla PowerFab.

Job # The number of the production control job the
material item is reserved to.

Type in the number.
Length The length of each piece.

Default length input settings are set in Company
Standards, but you can modify them for each job.

Lot # The lot identification number of the material item.

The Lot # field is automatically populated by the
linked items in Production Control.

Mill Mark The mill mark that identifies the mill that produced
the steel. The mill mark usually consists of 4 letters
that are rolled into the material.

Type in the mill mark.
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Option Description
PRC Cost, PRC Date,
PRC Unit Cost

Fields that show the current pricing information of
the selected item from the selected supplier.

If no date is displayed in the PRC Date field, the
material does not exist in the selected supplier's
pricing data set.

Double-click one of the fields to open the Pricing
Maintenance dialog box and enter pricing
information.

PRC Supplier The supplier warehouse whose pricing the item
uses.

Select the supplier from the drop-down menu.

The PRC Unit Cost, PRC Cost, and PRC Date fields
are updated to show details about the pricing of
the selected pricing supplier.

Purchasing Notes A longer description of the item. The field can be
useful for adding specifications for buyout items.

Quantity * The number of pieces to be added.

Use the numeric keypad to add, multiply, divide, or
subtract number of items.

Reference Number A reference number that links items in inventory or
purchasing to the production control job.

The reference number can be different depending
on the case:

• If an item is sent from Production Control to
Purchasing or Inventory, Tekla PowerFab
creates a copy of the record, and the item is
linked to include the reference number.

• If an item is sent to Purchasing from an
advanced bill of material, the system mark
number or a combination of the page number
and the item number in the combining job (for
example, 1-30) becomes the reference number.

• If the item is sent to Purchasing later in the
process, the reference number is the mark or
piece mark number.

Requisition # The number of the requisition from which the item
was loaded to the purchase order, or the
requisition which the item can be sent back to.

Type in the number.
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Option Description
Sequence The sequence number assigned to the item.

The field is automatically populated by the linked
items in Production Control.

Shape * The material shape of each piece.

Either select the shape from the drop-down menu
or type the shape indicator in the field (for
example, HSS).

3. Click Add.

The new material item is added at the end of the purchase order.

Modify purchase order items
You can either modify items one by one, or use the Global Edit commands to
modify multiple items at one go.

TIP If you cannot find the property you want to modify, check if you can add it in
Maintenance --> Purchase Orders --> Edit Input Fields.

For more information, see the following links:

Modify a single purchase order item (page 1028)

Modify multiple purchase order items (page 1029)

Modify the selected purchase order items (page 1030)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 1030)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 1032)

Modify a single purchase order item
You can modify the properties of purchase order items one by one in the PO #
dialog box.

1. In the PO # dialog box, select the material item that you want to modify.

2. On the right side of the dialog box, modify the properties of the item
according to your needs. 

For example, you can change the base price of the item or assign a cost
code to the item.

3. Click Save to update the item properties.
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See also

Modify multiple purchase order items (page 1029)

Modify the selected purchase order items (page 1030)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 1030)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 1032)

Modify multiple purchase order items
Use the Global Edit command to modify the properties of multiple items at
one go. This way, you can save time, as you do not need to change the
properties of each item individually.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Global Edit --> Global Edit. 

The Global Edit Filters dialog box opens.

3. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

4. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

5. Click OK. 

To further limit the item types that you want to modify, repeat steps 3 to 5
for all necessary filter types.

6. Click OK. 

The Global Edit dialog box opens.

7. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

8. Click Update. 

The Confirm dialog box opens.

9. To confirm changing the properties of multiple items, click Yes.

The changes you made to the item properties are updated.
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See also

Modify a single purchase order item (page 1028)

Modify the selected purchase order items (page 1030)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 1030)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 1032)

Modify the selected purchase order items
Use the Global Edit - Selected command to modify the properties of multiple
selected items at one go. This way, you can save time, as you do not need to
change the properties of each item individually.

1. In the PO # dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Global Edit --> Global Edit - Selected. 

The Global Edit - Selected dialog box opens.

4. Select the properties that you want to update and modify as needed. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

5. Click Update.

The properties of the selected items are updated.

See also

Modify a single purchase order item (page 1028)

Modify multiple purchase order items (page 1029)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 1030)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 1032)

Modify the shape, grade, dimensions, or length of multiple purchase
order items
Use the Global Edit By Shape command to modify the shape, grade,
dimensions, or length of all or multiple items.

1. In the PO # dialog box, click the Purchase Order ribbon tab.
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2. On the menu, select Global Edit --> Global Edit By Shape . 

The Global Edit Filters dialog box opens.

3. Select a shape on the Shape drop-down menu. 

4. To modify only specific types of items, select a filter type in the Type list,
and click Select. 

The Filter dialog box opens.

5. Do one of the following depending on the filter type:

• Click the arrow buttons to move the items that you want to modify to
the Included list.

• Type the maximum and minimum values for the items that you want
to modify.

6. Click OK. 

The Global Edit dialog box opens.

7. Select the properties that you want to update. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

8. Click Update. 

The Confirm dialog box opens.

9. To confirm changing the properties of multiple items, click Yes.

The changes you made to the item properties are updated.
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See also

Modify a single purchase order item (page 1028)

Modify multiple purchase order items (page 1029)

Modify the selected purchase order items (page 1030)

Modify the shape, grade, dimensions, or length of the selected purchase order
items (page 1032)

Modify the shape, grade, dimensions, or length of the selected
purchase order items
Use the Global Edit Selected By Shape command to modify the shape, grade,
dimensions, or length of selected items.

1. In the PO # dialog box, select the items that you want to modify. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Global Edit --> Global Edit Selected By Shape . 

The Global Edit - Selected dialog box opens.

4. Select the properties that you want to update. 

You can also use Un-check All and Check Changed Fields to quickly clear
or select checkboxes.

5. Click Update.

The changes you made to the item properties are updated.

All other reference information of the items remains unchanged.

See also

Modify a single purchase order item (page 1028)

Modify multiple purchase order items (page 1029)

Modify the selected purchase order items (page 1030)

Modify the shape, grade, dimensions, or length of multiple purchase order
items (page 1030)

Copy a purchase order item
You can copy a purchase order item and use it as the basis of a similar item. By
copying items, you can save time and avoid entering the same information
multiple times in a purchase order.

1. In the PO # dialog box, select the item that you want to copy.
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2. At the bottom of the dialog box, click Copy. 

A copy of the item appears at the bottom of the purchase order.

3. Adjust the properties of the new item according to your needs.

4. Click Edit to save the changes.

Copy material items to another purchase order
Use the Copy Selected to Another Purchase Order command to copy a
group of material items from one purchase order to another. When material
items are copied, the original items still remain in the current purchase order.

1. In the PO # dialog box, select the items that you want to copy. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Copy Selected to Another Purchase Order.

4. In the Select Purchase Order dialog box, select the purchase order to
which you want to copy the items. 

You can also create a new purchase order and copy the items to the new
purchase order. For more information, see Create a purchase order
(page 1014).

5. Click OK.

The material items are copied to the selected purchase order.

See also

Copy a purchase order item (page 1032)

Receive purchase order items
You should mark all delivered purchase order items as received in the PO #
dialog box.

You can receive material items with or without attaching heat documents or
mill certifications to the items.

Use the Receive command to select the items that you want to receive and
attach heat documents to the items, or the Receive Displayed command to
receive all items currently displayed in the PO # dialog box without attaching
heat documents.

Purchasing 1033 Create and manage purchase orders



Receive specific items
1. In the upper-left corner of the PO # dialog box, ensure that you are in the

receive mode. 

If not, click the Receive Mode button to activate the receive mode.

2. Select the items that you want to receive.

3. At the bottom of the dialog box, click Receive. 

The Receive dialog box opens.

NOTE The fields available in the Receive dialog box depend on the
settings on the Receiving tab in Maintenance --> Purchase
Orders --> Company Standards.

4. Define the properties of the received items. 

Option Description
Date The date when the items were received.

Tekla PowerFab automatically uses the current
date.

To change the date, do one of the following:
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Option Description
• Type the date in the Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the Date
field and select a date in the calendar.

Quantity The quantity of the pieces that are received. If
multiple items are received at once, the Quantity
field is unavailable and all pieces of the items are
received at once.

Type the quantity of the pieces in the Quantity
field.

Substitute Grade When selected, you can select a substitute grade
for the purchase order item. When cleared, Tekla
PowerFab always uses the original grade of the
item instead of a substitute grade.

If necessary, select the Substitute Grade
checkbox, and click the arrow on the right side of
the related field to select the substitute grade.

Inventory Location The inventory location of the material items.

Click the arrow on the right side of the Location
field and select a location in the list, or type a new
location in the Location field.

Secondary Loc The secondary inventory location of the material
items.

Click the arrow on the right side of the Secondary
Loc field and select a location in the list, or type a
new secondary location in the Secondary Loc field.

For example, you can use secondary locations to
represent different inventory sites.

Bill of Lading # The bill of lading number or the shipment number
that the material items were received on.

Type the number in the B/L # field.
Heat Number The heat number of the material items.

Type the heat number in the Heat # field.

Note that you need to type a heat number for a
material item before attaching documents to it in
Document Index.

Heat SN Ensures that heat numbers are not duplicated.
However, duplications are extremely rare, so using
the Heat SN field is optional.
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Option Description
Mill of Origin When selected, you can select mill locations for

materials, both when receiving from a purchase
order and when adding to or editing inventory.

To select a supplier as a mill, you need to define
this in the Address Book. See Manage the address
book (page 141) and Modify company or contact
properties (page 146).

Country of Origin The country of origin of the material items.

You can modify the available countries in
Maintenance --> Inventory --> Countries of
Origin. See Define the countries of origin
(page 531).

Finalize on Receive When selected, the received material items are
finalized when you receive them. This means that
you cannot make further changes to the items.

If material items are received but not finalized, the
item quantity changes to zero to update the
inventory records.

5. To attach heat documents to the items, see Attach heat documents when
receiving items below.

6. In the Receive dialog box, click Receive.

The selected items are marked as received.

The inventory record is updated to display the mill of origin in the Mill of
Origin column on theInventory grid.

Attach heat documents when receiving items
You can attach heat documents to the items in the Receive dialog box.

1. On the right side of the Heat Number dialog box, click Add Doc.

2. Do either of the following:

• In the Document Index - Add Document Reference dialog box, click
Add File.

• Drag and drop the heat document to the Document Index - Add
Document Reference dialog box.

If you drag and drop the heat document to the Document Index - Add
Document Reference dialog box, skip steps 3 and 4.

3. In the Open dialog box, browse to find the document that you want to
add, and select the document.

Purchasing 1036 Create and manage purchase orders



4. Click Open. If you want to add more documents with the same settings,
click Add Additional File and browse for and select the additional files.
Then click Open.

5. In the Add File dialog box, select the company and contact that provided
you with the document in the File Source lists.

6. According to your needs, do one of the following: 

• To compress multiple documents into one archive, select the
Compress Files into a Single Archive option.

• To leave the documents you added uncompressed, select the Leave
Files Uncompressed option.

7. According to your needs, do one of the following: 

• To move the original document to the selected folder, select the Move
File option.

• To copy the document to the selected folder but leave the original
untouched, select the Copy File (Leave Original) option.

8. Type a description for the documents you added.

9. Click Add File.

10. Type a description for the entire document reference. 

This description applies to all documents, emails, and email attachments
that you add.

11. Click Add Document Reference.

12. To close the Document Index - Add Document Reference dialog box,
click the Close button (X) in the upper-right corner.

The received items have the selected heat documents attached to them.

Receive all displayed items without attaching heat documents
Note that any applied filters affect which items are displayed in the PO #
dialog box. For more information, see Filter information in the PO # dialog box
(page 1021).

1. In the upper-left corner of the PO # dialog box, ensure that you are in the
receive mode. 

If not, click the Receive Mode button to activate the receive mode.

2. At the bottom of the dialog box, click Receive Displayed.

3. In the Receive dialog box, define the properties of the received items. 

NOTE The fields available in the Receive dialog box depend on the
settings on the Receiving tab in Maintenance --> Purchase
Orders --> Company Standards.
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Option Description
Date The date when the items were received.

Tekla PowerFab automatically uses the current
date.

To change the date, do one of the following:

• Type the date in the Date field.

The acceptable formats are YYYY/MM/DD,
YY/MM/DD, MM/DD/YYYY, and MM/DD/YY.

• Click the arrow on the right side of the Date
field and select a date in the calendar.

Quantity The quantity of the pieces that are received. If
multiple items are received at once, the Quantity
field is unavailable and all pieces of the items are
received at once.

Type the quantity of the pieces in the Quantity
field.

Substitute Grade When selected, you can select a substitute grade
for the purchase order item. When cleared, Tekla
PowerFab always uses the original grade of the
item instead of a substitute grade.

If necessary, select the Substitute Grade
checkbox, and click the arrow on the right side of
the related field to select the substitute grade.

Inventory Location The inventory location of the material items.

Click the arrow on the right side of the Location
field and select a location in the list, or type a new
location in the Location field.

Secondary Loc The secondary inventory location of the material
items.

Click the arrow on the right side of the Secondary
Loc field and select a location in the list, or type a
new secondary location in the Secondary Loc field.

For example, you can use secondary locations to
represent different inventory sites.

Bill of Lading # The bill of lading number or the shipment number
that the material items were received on.

Heat Number The heat number of the material items.

Type the heat number in the Heat # field.

Note that you need to type a heat number for a
material item before attaching documents to it in
Document Index.
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Option Description
Heat SN A property that ensures that heat numbers are not

duplicated. However, duplications are extremely
rare, so using the Heat SN field is optional.

If necessary, type a value in the Heat SN field.
Country of Origin The country of origin of the material items.

You can modify the available countries in
Maintenance --> Inventory --> Countries of
Origin. See Define the countries of origin
(page 531).

Finalize on Receive When selected, the received material items are
finalized when you receive them. This means that
you cannot make further changes to the items.

If material items are received but not finalized, the
item quantity changes to zero to update the
inventory records.

4. Click Receive.

All items that are currently displayed in the PO # dialog box are marked as
received.

Unreceive purchase order items
You can revert items back to the outstanding state if you have accidentally
marked them as received or have entered wrong information for them.

NOTE Only items that have been marked as received can be unreceived. You
can unreceive only one item at a time.

1. In the main window, click Purchasing to open the module. 

The Select Requisition/Purchase Order dialog box opens.

2. Select the PO you want to change and double-click to open it. 

The PO # dialog box opens.

3. Go to the Purchase Orders tab.

4. Click Switch to Receive Mode in the top left corner.

5. Select the purchase order item that you want to unreceive.

6. In the Purchase Order ribbon tab, select and click Un-Receive.

7. In the Un-Receive dialog box, type the quantity of items that you want to
unreceive.

8. Click Un-Receive. 

You return to the PO # dialog box.
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The Quantity received and Outstanding values have changed.

See also

Receive purchase order items (page 1033)

View heat documents attached to purchase order items
Use the Check Heat Documents command to view the heat documents
attached to the purchase order items. You can also save or print the available
heat documents, or create reports on the items that have or do not have heat
documents attached to them.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Check Heat Documents. 

The Check Heat Documents dialog box opens.

Note that if the purchase order items do not have heat documents
attached to them, the Docs column is highlighted with red.

3. In the Check Heat Documents dialog box, do any of the following: 

To Do this
Update heat document
information

• Click Refresh.

Any new or modified information is updated.
Add, modify, and delete
heat documents in
Document Index

a. Click Open Document Index.

Document Index opens. For more information,
see Manage files for inventory (page 538).
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To Do this
Save heat documents a. Do one of the following:

• To only save particular heat documents,
click the item whose documents you want
to save, and click Save Documents -->
Save Documents - Selected .

• To save all available heat documents, click
Save Documents --> Save Documents -
All .

b. In the Browse For Folder dialog box, browse
to an empty folder where you want to save the
heat document information.

c. Click OK.

A report of the heat documents opens.
Print heat documents a. Do one of the following:

• To only print particular heat documents,
click the items whose documents you want
to print, and click Print Documents -->
Print Documents - Selected .

• To print all available heat documents, click
Print Documents --> Print Documents -
All .

b. In the Select Printer dialog box, click a printer
to select it.

c. Click OK.

All or the selected heat documents are printed.
Create reports a. Do one of the following:

• To create a report only containing
particular items, click the items to select
them, and click Reports --> Reports -
Selected .

• To create a report containing all items, click
Reports --> Reports - All .

b. In the Report Selection dialog box, click the
report that you want to create.

c. Do one of the following:

• To view the report, click View.

• To print the report, change the number of
copies by clicking the + and - buttons, and
click Print.
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To Do this
• To export the report, click Export, modify

the export format, file name, and location,
and click Export again.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

Manage files for a purchase order (page 1023)

Send purchase order items to a requisition
Use the Send to REQ command to send purchase order items back to
requisitions. Note that only items that have not yet been received can be sent
back to a requisition. The items need to have the correct requisition numbers
defined in their Requisition # fields, so that Tekla PowerFab knows which
requisition it should be returned to.

1. In the PO # dialog box, select the material items that you want to send
back to a requisition. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. At the bottom of the dialog box, click Send to REQ.

3. To confirm returning the items to the requisition, click Yes in the
confirmation dialog box.

The selected items are returned to the requisition. These items are no longer
displayed in the PO # dialog box.

See also

Load requisition items into a purchase order (page 998)

View the pricing history of a material item
Use the Purchase History command to view the pricing history of a material
item. You can filter the purchase history by various options, such as the
vendor, the requisition number, or the length.

1. In the PO # dialog box, select the item whose pricing history you want to
view.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Purchase History. 
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The Purchase Order History dialog box opens.

The top section of the dialog box allows you to filter the pricing history
information, whereas the bottom section shows the pricing history of the
material item.

4. If necessary, filter the pricing history by clicking arrows on the right side of
the different filter lists and selecting filtering options in the lists.

5. To update the pricing history to match the filters you set, click Load
History.

6. If you want to save the pricing history as a Microsoft Excel worksheet, do
the following:

a. Right-click anywhere in the display area of the Purchase Order
History dialog box.

b. In the context menu, select Export to Excel.

c. In the Save As dialog box, browse to the folder where you want to
save the file.

d. If necessary, change the file name.

e. Click Save.

If necessary, you can customize the layout of the Purchase Order History
dialog box to include only the when exporting the pricing history. For
more information, see Customize the layout of a dialog box (page 258).

7. To close the Purchase Order History dialog box, click the Close button
(X) in the upper-right corner.
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See also

View all changes in a purchase order (page 1046)

Finalize purchase order items
Use the Finalize Selected Items and Finalize Displayed Items commands to
finalize purchase order items, so that no further can changes can be made to
the items. The Finalize Selected Items command finalizes the material items
that are currently selected in the PO # dialog box. The Finalize Displayed
Items finalizes the material items that are currently filtered to be shown in the
PO # dialog box.

If material items are received but not finalized, the item quantity changes to
zero to update the inventory records. When the purchase order items are
finalized, the link between the purchase order and the inventory is irreversibly
broken. Even if the items are later unfinalized, they are no longer linked to the
inventory.

Finalize the selected purchase order items
1. In the PO # dialog box, select the items that you want to finalize. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. Click the Purchase Order ribbon tab.

3. On the menu, select Finalize Selected Items.

4. To confirm finalizing the items, click Yes in the confirmation dialog box.

The selected items are finalized.

Note that the letter F appears in the leftmost column of the PO # dialog box to
indicate that the items are finalized.

If you need to make changes to finalized material items, you can unfinalize the
items. For more information Unfinalize purchase order items (page 1045).

Finalize all displayed purchase order items
To change which items are displayed in the PO # dialog box, see Filter
information in the PO # dialog box (page 1021).

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Finalize Displayed Items.

3. To confirm finalizing the items, click Yes in the confirmation dialog box.
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The displayed items are finalized.

Note that the letter F appears in the leftmost column of the PO # dialog box to
indicate that the items are finalized.

If you need to make changes to finalized material items, you can unfinalize the
items. For more information Unfinalize purchase order items (page 1045).

Unfinalize purchase order items
Use the Un-Finalize command to cancel finalizing purchase order items, so
that you can make any necessary changes to the items.

Note that when purchase order items are finalized, the link between the
purchase order and the inventory is irreversibly broken. Even if you unfinalize
the items, they are no longer linked to the inventory.

1. In the upper-left corner of the PO # dialog box, ensure that you are in the
receive mode. 

If not, click the Receive Mode button to activate the receive mode.

2. Select the items that you want to unfinalize.

3. On the File menu, select Un-Finalize.

4. To confirm unfinalizing the items, click Yes in the confirmation dialog box.

The selected items are unfinalized.

Note that the letter F has disappeared from the leftmost column of each item
in the PO # dialog box.

You can now make changes to the items according to your needs.

See also

Finalize purchase order items (page 1044)

Delete purchase order items
You can delete unnecessary purchase order items at any point. Note that
deleting items from a purchase is permanent and cannot be undone.

You can still see the deleted items in the list of changes and in the transaction
history. For more information, see View all changes in a purchase order
(page 1046) and View the transaction history of a purchase order (page 1047).

1. In the PO # dialog box, select the items that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

2. At the bottom of the dialog box, click Delete.
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3. To permanently delete the items, click Yes in the confirmation dialog box.

The items are deleted from the purchase order.

View all changes in a purchase order
Tekla PowerFab records every change made in the system. This is useful
because you can view all changes made in the current purchase order at once.
You can filter the information to see changes made by a particular user, or on
a particular date. You can also print the list of changes.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select List Of Changes.

3. In the List Of Changes Report Filters dialog box, do any of the following: 

To Do this
Filter changes by user a. Select the User filter type and

click Select.

b. Click the arrow buttons to move
the users whose changes you
want to view to the Included list.

c. Click OK.
Filter changes by date a. Select the Transaction Date filter

type and click Select.

b. Do one of the following:

• Enter the start (Minimum)
and end (Maximum) dates.

• Select the Expression
checkbox for the start or end
date. Then, select the base
date and select how many
more or less days will be
taken into account.

c. Click OK.

4. Click Make Report.

5. In the Report Selection dialog box, do one of the following: 
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To Do this
View the list of changes • Click View.

The report opens in Tekla PowerFab Report
Viewer.

You can use the Email Excel and Email PDF
buttons at the top of the Tekla PowerFab Report
Viewer window to email the report via Microsoft
Outlook.

Print the list of changes a. In the Report Selection dialog box, change
the number of the printed copies by clicking
the + and - buttons.

b. If necessary, click Select Printer, select which
device you want to use for printing, and click
OK.

You can also select Default Printer to always
use the default printer with this report, or No
Printer to reset the current printer.

c. Click Print.

d. Click Yes.
Export the list of
changes

a. Click Export.

b. In the Export Format list, select an export
format.

c. Click Browse.

d. Browse to the location where you want to save
the exported file, and click Save.

e. Modify the file name according to your needs.

f. To attach the exported file to a Microsoft
Outlook email and send it to a recipient, select
the Attach to Email checkbox.

g. To open the file after exporting it, select the
Open Exported Document checkbox.

h. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.

See also

View the pricing history of a material item (page 1042)
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View the transaction history of a purchase order
Use the Transaction History dialog box to view all transactions in a purchase
order. You can also view further transaction details and item history, and view
or print different transaction history reports.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Transaction History. 

The Transaction History dialog box opens on the Transaction List tab.

3. To filter the displayed transactions, use the fields in the Estimating
Filters section of the dialog box:

a. Click Edit next to a filtering option. 

The available filtering criteria are the transaction date, the name of
the user that made the transaction, the transaction type, and the
operation type.

b. Do one of the following: 

• For transaction date, enter the start and end dates to define a
range within which the transactions have taken place.

• For user, transaction type, and operation type, use the arrow
buttons to move the desired items to the Included list.

c. Click OK. 

To view all transactions again, click Reload.

4. To view more information about a transaction, do the following:
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a. Click to select the transaction on the Transaction List tab.

b. Click the Transaction Details tab to view the details of the selected
transaction.

c. Click the Item History tab to view the item history of the selected
transaction.

Find a transaction by transaction number
1. On the Transaction List tab, click Find Transaction #.

2. Enter the transaction number in the field.

3. Click OK.

The transaction with the selected transaction number is selected on the
Transaction List tab.

Create transaction history reports
1. Click the Transaction History ribbon tab.

2. On the menu, select Reports.

3. To only include specific items in the transaction history report, select a
filter type in the Type list, and click Select.

4. Do one of the following:

• For dates, select the start and end dates in the calendar to define a
range within which the transactions have taken place.

You can also select the Expression checkbox to create expressions
that allow you to set the base date and the number of days before or
after that date.

• For other filter types, use the arrow buttons to move the desired items
to the Included list.

5. Click OK.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view or print.

8. Do any of the following: 

To Do this
View the report • In the Report Selection dialog

box, click View.
Print the report a. In the Report Selection dialog

box, change the number of the
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To Do this
printed copies by clicking the +
and - buttons.

b. If necessary, click Select Printer,
select which device you want to
use for printing, and click OK.

You can also select Default
Printer to always use the default
printer with this report, or No
Printer to reset the current
printer.

c. Click Print.

d. Click Yes.
Export the report a. Click Export.

b. In the Export Format list, select
an export format.

c. Click Browse.

d. Browse to the location where you
want to save the exported file,
and click Save.

e. Modify the file name according to
your needs.

f. To attach the exported file to a
Microsoft Outlook email and
send it to a recipient, select the
Attach to Email checkbox.

g. To open the file after exporting it,
select the Open Exported
Document checkbox.

h. Click Export.

View, print, or export purchase orders and purchase order
reports
You can view, print, or the export purchase order, or to create reports based
on the current purchase order by using the Reports command. For example,
you can create a list of the items on the purchase order or a material receiving
checklist. You can then view or print the reports, or export the reports to save
them in another file format.

To create purchase order reports, do the following:

1. In the PO # dialog box, click the Purchase Order ribbon tab.
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2. On the menu, select Reports.

3. In the Report Selection dialog box, select the report that you want to
view, print, or export. 

To customize the reports that are displayed in the Report Selection
dialog box, click the Edit Report Types.

4. If you want to include the company logo and vendor code in the report,
select the Show Company Logo and Show Vendor Code checkboxes. 

When the checkboxes are cleared, the information is not included in the
report.

According to your needs, see any of the following instructions:

View the report
• In the Report Selection dialog box, click View.

The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.
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7. To open the file after exporting it, select the Open Exported Document
checkbox.

8. In the Report Selection dialog box, click Export.

View, print, or export job-specific receiving reports
You can create receiving reports that contain information from the current
purchase order by using the Receiving Reports command. You can then view
or print the reports, or export the reports and save them in another file
format. For example, you can create a purchase order summary, a barcode
checklist, or a receiving list.

To create receiving reports, do the following:

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Receiving Reports.

3. To only include particular purchase orders in the reports, in the Purchase
Order Report Filters dialog box, select a filter type in the Type list, and
click Select.

4. In the Filter dialog box, do one of the following depending on the filter
type:

• Click the arrow buttons to move the purchase order properties that
you want to include in the report to the Included list.

• Type the maximum and minimum values for the purchase orders that
you want to include in the report.

5. Click OK. 

To further limit which properties the purchase orders in the reports
should match, repeat steps 3 to 5 for all necessary filter types.

6. Click Make Report.

7. In the Report Selection dialog box, select the report that you want to
view, print, or export. 

8. If you want to include the company logo and vendor code in the report,
select the Show Company Logo and Show Vendor Code checkboxes. 

When the checkboxes are cleared, the information is not included in the
report.

According to your needs, see any of the following instructions:

View the report
• In the Report Selection dialog box, click View.
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The report opens in Tekla PowerFab Report Viewer.

You can use the Email Excel and Email PDF buttons at the top of the Tekla
PowerFab Report Viewer window to email the report via Microsoft Outlook.

Print the report
1. In the Report Selection dialog box, change the number of the printed

copies by clicking the + and - buttons.

2. Click Print.

3. To confirm printing the selected report, click Yes in the confirmation
dialog box.

4. In the Select Printer dialog box, click a printer to select it.

5. Click OK.

Export the report
1. In the Report Selection dialog box, click Export.

2. In the Export Format list, select an export format.

3. Click Browse.

4. Modify the file name according to your needs.

5. Browse to the location where you want to save the exported file, and click
Save.

6. To attach the exported file to a Microsoft Outlook email and send it to a
recipient, select the Attach to Email checkbox.

7. To open the file after exporting it, select the Open Exported Document
checkbox.

8. In the Report Selection dialog box, click Export.

Export purchase orders
You can export the items on your purchase orders to Trimble Viewpoint,
Timberline, or Sage 300 CRE accounting solutions. This way, you can avoid
entering PO information in multiple software

Export the selected purchase orders to Trimble Viewpoint
You can export purchase orders to both Trimble Viewpoint Vista and Trimble
Viewpoint Spectrum.

Before you export the purchase order, ensure that:
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• The company code of the vendor in the Tekla PowerFab Address Book
matches the vendor in Trimble Viewpoint

• The job number of the Tekla PowerFab purchase order matches the job
number in Trimble Viewpoint

• The Cost Code field in Tekla PowerFab purchase orders is mapped to the
phase in Trimble Viewpoint purchase orders.

1. Do any of the following: 

a. At the top of the Tekla PowerFab window, click the Purchasing
button.

b. On the Maintenance menu, select Integrations --> Trimble
Viewpoint. Then, click Export on the Purchase Orders tab.

2. In the Select Requisition/Purchase Order dialog box, select the
purchase orders that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.

4. On the menu, select Export Purchase Orders --> Trimble Viewpoint -
Selected.

5. Click Yes to confirm exporting the selected purchase orders.

6. If you have selected the Prompt on export checkboxes for any properties
in the Trimble Viewpoint Integration dialog box, ensure that the values
are correct, and click OK.

7. In the Save As dialog box, browse to the folder where you want to save
the exported purchase orders. 

By default, Tekla PowerFab saves the purchase orders in the Export
folder.

8. If necessary, change the file name.

9. Click Save.

The exported purchase orders are saved as a .txt file in the folder that you
selected.

You can then import the .txt file to any Trimble Viewpoint solution according
to your needs.

Export purchase orders with receiving transactions to Viewpoint
You can export purchase orders to both Trimble Viewpoint Vista and Trimble
Viewpoint Spectrum.

Before you export the purchase order, ensure that:
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• The company code of the vendor in the Tekla PowerFab Address Book
matches the vendor in Trimble Viewpoint

• The job number of the Tekla PowerFab purchase order matches the job
number in Trimble Viewpoint

• The Cost Code field in Tekla PowerFab purchase orders is mapped to the
phase in Trimble Viewpoint purchase orders.

1. Do any of the following: 

a. At the top of the Tekla PowerFab window, click the Purchasing
button.

b. On the Maintenance menu, select Integrations --> Trimble
Viewpoint. Then, click Export on the Receiving tab.

2. In the Select Requisition/Purchase Order dialog box, select the
purchase orders that you want to export. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.

4. On the menu, select Export Purchase Orders --> Trimble Viewpoint -
Receiving.

5. In the Save As dialog box, browse to the folder where you want to save
the exported purchase orders. 

By default, Tekla PowerFab saves the purchase orders in the Export
folder.

6. If necessary, change the file name.

7. Click Save.

The exported purchase orders are saved as a .csv file in the folder that you
selected.

NOTE To avoid errors, do not open an exported .csv file with Microsoft
Excel. If you do so, the formatting of information changes, and
the .csv file will fail to import to Trimble Viewpoint products.

Export purchase orders to Timberline or Sage 300 CRE
1. At the top of the Tekla PowerFab window, click the Purchasing button.

2. If you only want to export particular purchase orders, select them in the
Select Requisition/Purchase Order dialog box. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

3. Click the Purchasing ribbon tab.
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4. On the menu, select Export Purchase Orders --> Timberline / Sage 300
CRE .

5. In the Export Purchase Orders to Timberline dialog box, define how you
want to import the items: 

Option Description
Export Received Items
Only

When selected, only items that have been received
in the inventory are exported.

When cleared, all items are exported.

You can define the range of dates between which
the exported items have been received. To do so,
enter the dates in the Date Received Minimum
and Maximum fields.

Export Selected
Purchase Orders Only

When selected, only items in the purchase orders
that are selected in the Select Requisition/
Purchase Order dialog box are exported.

When cleared, items in all purchase orders are
exported.

Date Received
Minimum

The earliest receiving date of the items that are
exported.

Note that this option is only available if the Export
Received Items Only checkbox is selected.

Maximum The latest receiving date of the items that are
exported.

Note that this option is only available if the Export
Received Items Only checkbox is selected.

Re-Export When selected, any purchase orders that have
been previously exported are ignored in the
export. This ensures that the same purchase
orders are not exported multiple times.

Date Format Allows you to select the date forma of the exported
file.

Job # Export Option Defines how the job number is shown in the
exported file. You can select to:

• Leave the job number unchanged and use the
original job number.

• Replace any digits after the first 4 digits with
zeros.

• Use both the job number and the existing
sequence numbers.

Replace Job # if Cost
Code Matches

When selected, the job number is replaced by a
piece of text that you define, if the job number
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Option Description
matches the cost code defined in the Cost Code
list.

When cleared, the job number is never replaced by
any text when the job is exported.

Cost Code The cost code that the job number needs to match
to be replaced. The replacement text is defined in
the Job # Replacement field.

Job # Replacement The text with which you to replace the job number.
Sort Lines Allows you to select how items are sorted in the

exported file. The options are:

• Item Details: the items are sorted by their
properties. This is the default option.

• Item # Only: the items are sorted by item
number.

Split Lines based on Allows you to select how items are split on
different lines in the exported file. The options are:

• Item Details Only: Items with similar
properties are considered the same item, and
therefore, the items are placed on the same
line.

• Item Details and Comments: Items that have
different information in the Comment field are
considered different items, and therefore, the
items are split on different lines.

Include Grade in
Description

When selected, the material grade is included in
the material description.

Export Filename The location where the exported file is saved and
the name of the exported file.

To modify the export location and the file name:

a. Click the ... button on the right side of the
Export Filename field.

b. In the Open dialog box, browse to the folder
where you want to save the file.

c. If necessary, change the file name.

d. Click Open.

6. Click Export Purchase Orders.

The exported text file is saved in the folder that you selected.
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Export CNC files and drawings
When you send requisitions or purchase orders to a supplier, you can export
CNC files and associated drawings as part of the package. This is especially
useful for cut-to-size orders that are fully processed by the suppliers. For
example, many fabricators fully subcontract the processing of their detailed
material, such as connection plates and angles. Providing the CNC files and
associated drawings with the purchase order eliminates a manual step for
these fabricators.

1. In an open requisition or purchase order, select the items whose attached
CNC files you want to export, or use the navigation tree to filter the items,
so that only the items whose attached CNC files you want to export are
shown.

2. Depending on where you are, do any of the following: 

• In an open purchase order, click the Purchase Order ribbon tab.

• In an open requisition, click the Requisition ribbon tab.

3. On the menu, do one of the following: 

To Do this
Export CNC files attached to
selected items

• Select Export Files --> Export CNC
Files - Selected.

Export CNC files attached to items
currently shown in the display area

• Select Export Files --> Export CNC
Files - Displayed.

Export drawings attached to
selected items

• Select Export Files --> Export
Drawings - Selected.

Export drawings attached to items
currently shown in the display area

• Select Export Files --> Export
Drawings - Displayed.

Export CNC files and drawings
attached to selected items

• Select Export Files --> Export CNC
and Drawings - Selected.

Export CNC files and drawings
attached to items currently shown
in the display area

• Select Export Files --> Export CNC
and Drawings - Displayed.

4. Save the file on your computer. 

The default export folder is set in the Default Directories dialog box.

Approve a purchase order
Approving a purchase order allows you to lock the purchase order, so that no
further changes can be made. If necessary, the order can still be unlocked to
allow making changes again.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the menu, select Approve Purchase Order.
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3. To confirm approving and locking the purchase order, click Yes in the
confirmation dialog box.

The text at the top of the PO # dialog box now shows that the purchase order
has been approved and locked, and the name of the user who approved and
locked the purchase order.

Note that purchase orders are also locked if you export them.

See also

Unlock a purchase order (page 1059)

Finalize purchase order items (page 1044)

Unfinalize purchase order items (page 1045)

Unlock a purchase order
Use the Revoke Purchase Order Approval command to unlock the purchase
order to allow making changes to the purchase order.

1. In the PO # dialog box, click the Purchase Order ribbon tab.

2. On the File menu, select Revoke Purchase Order Approval.

3. To confirm revoking the purchase order approval, click Yes in the first
confirmation dialog box.

4. To unlock the purchase order, click Yes in the second confirmation dialog
box.

The purchase order is now unlocked. Users with access to the purchase order
can make any necessary changes to the purchase order.

See also

Approve a purchase order (page 1058)

Finalize purchase order items (page 1044)

Unfinalize purchase order items (page 1045)

Delete purchase orders
You can delete old and unnecessary purchase orders at any time. What
happens to the material items within the purchase order depends on their
receiving status.

Before deleting a purchase order, note that:

• Any material items in the purchase order that have not been received are
deleted when the purchase order is deleted.

• Any received material items in the purchase order remain in the inventory,
but are no longer linked to the deleted purchase order. These items behave
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like finalized items. For more information, see Finalize purchase order
items (page 1044).

You can still see the deleted items , even though the purchase order is deleted.

1. At the top of the Tekla PowerFab window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Purchase Orders tab.

3. Select the purchase orders that you want to delete. 

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold down Shift.

4. Click Delete.

5. To permanently delete the purchase orders, click Yes in the confirmation
dialog box.

The selected purchase orders are deleted.

10.4 Create and manage splice packages
You can create splice packages on the Requisitions part of the Purchasing
module. Splicing can be very useful if you need to build longer beams and
columns out of shorter purchasable lengths. Splicing enables you to take
existing materials from the inventory and combine them with purchasable
items to make a running length that suits your needs. The same applies to
companies doing miscellaneous projects where you might choose to
prefabricate longer sections of, for example, hand railing to minimize field
welding.

Splice packages can be a great option also when the detailer implies a splice
but does not specify it in the drawing.

When you create splice packages, any available length will be considered as
available to be combined into by parts from the same job, just as an expected
drop of an inventory item. For example, if you have a splice package that has
10 meters of unused length and you perform a combining run from the same
job as the other parts in that splice package, all parts with that same shape,
grade, or dimension can be nested into that available 10 meters.

For more information, see the following links:

Check if splicing is needed (page 1061)

Create a splice package (page 1061)

View and modify splice packages (page 1065)

Heat certificate traceability (page 1068)

Set the kerf (page 1068)
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Check if splicing is needed
Use the Combine command to check if splicing is needed for a particular
requisition.

1. At the top of the Tekla PowerFab window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Requisitions tab.

3. Select the requisition for which you want to create the splice package.

4. Click Open.

5. In the Requisition # dialog box, create a combining run (page 1007).

6. Open the combining run. 

The Combining Run Results dialog box opens. As you can see, there are
drops that are going to be costly and therefore, splicing is recommended.

See also

Create and manage splice packages (page 1060)

Create a splice package (page 1061)

View and modify splice packages (page 1065)

Heat certificate traceability (page 1068)

Set the kerf (page 1068)

Create a splice package
You can create splice packages either in the inventory or in requisitions.
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To create splice packages in the inventory, see View and modify splice
packages (page 1065).

To create splice packages in requisitions, do the following:

1. At the top of the Tekla PowerFab window, click the Purchasing button.

2. In the Select Requisition/Purchase Order dialog box, ensure that you
are on the Requisitions tab.

3. Select a requisition and click Open.

4. In the Requisition # dialog box, select the parts that you want to add to
the splice package. 

You can only select parts that are currently not included in any other
splice package.

• To select multiple items, hold down Ctrl.

• To select a range of subsequent items, hold down Shift.

5. Right-click and select Create new Splice Package from Selected. 

The Splice Package - Add Stock/Parts dialog box opens showing a pre-
populated list of parts that you selected in the previous step. At the top of
the dialog box, you can see the total length that you need to compensate
for.

6. Add the required inventory pieces.

a. Go to the Add Stock tab to see the existing inventory pieces that you
have to add. 

There may also be some drops available from your previous jobs.

b. To add a drop from another job, move it to the Included list.
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c. If the available inventory cannot satisfy the required length, click Add
Unpurchased.

d. In the Add Unpurchased Stock Length dialog box, enter the lengths
that you need to purchase and then click Add.

e. When you have added all the lengths that you need, click the Add
button at the bottom of the Splice Package - Add Stock/Parts dialog
box.

7. When Tekla PowerFab asks what you want to do with the unpurchased
stock, click Purchase Order.

8. In the Select Purchase Order dialog box, select a purchase order and
click OK. 

Alternatively, you can click Add to create a new purchase order. After
opening the purchase order, the Splice Package dialog box opens. At the
top of the dialog box, you can check the details of the finalized splice
package, including the shape, grade, dimension, and total length. You can
also see what percentage of the splice package you are currently utilizing.

9. In the PO # dialog box, mark the purchase order items as received. 

See Receive purchase order items (page 1033)

10. In the Splice Package dialog box, select an inventory item and click TFS. 

The Splice Package - TFS dialog box opens. Here you can see the stock
lengths that you are using, the parts to be cut, and the drops. If you have
additional drops available, you can set a location to define where you
want the drop to go.

a. On the Stock to TFS tab, move the stock records that are to be
utilized to the Included list.
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b. On the Parts to TFS tab, move the parts that are to be cut from that
stock to the Included list.

c. On the Drop tab, enter the drop location. 

The drop length will populate with the amount calculated from the
total included stock and part length. If some stock or parts are not
included, they will remain in this splice package to be processed at
another time.

d. If you want the drop to remain reserved for this splice package, go to
the Drop tab and select the Add Back to Splice Pkg checkbox.

11. If multiple stock records are used with different heat cert details, go to the
Drop tab and define the supplier, purchase order number, and heat
number to assign to the drop in the Drop Details list.

Now you can add the splice package to a cut list in the Production
Control module, just like any other inventory nesting. On the cut list
screen, the splice package will appear with the total stock length. When a
splice package is selected, the Cut button opens the Splice Package - TFS
dialog box, instead of the regular cut list processing dialog box.

See also

Create and manage splice packages (page 1060)

Check if splicing is needed (page 1061)

View and modify splice packages (page 1065)

Heat certificate traceability (page 1068)

Set the kerf (page 1068)

Purchasing 1064 Create and manage splice packages



View and modify splice packages
To view and manage existing splice packages, click the Maintenance ribbon
tab and select Inventory > Splice Packages.

Do any of the following:

To Do this
Add a new splice package 1. Click Add.

2. Enter the required details and
click Add.

Add items to a splice package 1. Select the splice package that you
want to modify.

2. Click Details.

3. Click Add.

4. Go to the Add Stock tab to see a
list of existing inventory pieces
that you have.

There may also be some drops
available from your previous
jobs.

5. To add a drop from another job,
select the drop from the Not
Included list and click the arrow
buttons to move it to the
Included list.

6. If the available inventory cannot
satisfy the required length, click
Add Unpurchased.

7. Enter the lengths that you still
need to purchase and then click
Add.

8. When you have added all the
lengths that you need, click the
Add button at the bottom of the
Splice Package - Add Stock/
Parts dialog box.

Remove items from a splice package 1. Select the splice package that you
want to modify.

2. Click Details.

3. Select the item that you want to
remove from the splice package.
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To Do this
4. Click Remove.

5. Enter the quantity that you want
to remove.

6. Click OK.
Replace an item with a substitute of
the same length

1. Select the splice package that you
want to modify.

2. Click Details.

3. Select the item that you want to
replace.

4. Click Swap Inventory.

5. Select the item that you want to
use.

6. Click Swap.
Send unpurchased lengths
immediately into a requisition or
purchase order

1. Select the splice package that you
want to modify.

2. Click Details.

3. Select the item that you want to
send.

4. Click Send and select one of the
following:

• To Requisition

• To Purchase order

5. Select the requisition or purchase
order, and then click OK.

6. Enter the quantity that you want
to send and then click OK.

Add parts to the nesting 1. Select the splice package that you
want to modify.

2. Click Details.

3. Click Add Parts.

4. Add the required inventory
pieces.

5. Click the Add button at the
bottom of the dialog box.

OR

1. Go to the Requisition # dialog
box.
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To Do this
2. Select the parts that you want to

add.

3. Right-click and select Add
Selected to Splice Package.

Remove parts from the nesting 1. Select the splice package that you
want to modify.

2. Click Details.

3. Select the parts that you want to
remove from the nesting.

4. Click Remove Parts.

5. Click Yes to confirm.
Merge splice packages 1. Select the splice packages that

you want to merge.

2. Click Merge.

3. Click Yes to confirm.
Merge inventory items 1. Select the splice package that you

want to modify.

2. Click Details.

3. Select the inventory items that
you want to merge.

4. Click Join to Result Length.

The inventory items are merged
into one long item.

Split a package in two 1. Select the stock and parts to be
split and move them to the
Included list.

2. Click Split.
Delete a splice package 1. Select the splice package that you

want to remove.

2. Click Delete.

See also

Create and manage splice packages (page 1060)

Check if splicing is needed (page 1061)

Create a splice package (page 1061)

Heat certificate traceability (page 1068)

Set the kerf (page 1068)
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Heat certificate traceability
When parts are taken from stock from a splice package, and the stock used
has different Supplier, PO#, and Heat# values, the parts are considered as
having come from all of them. The records added to the inventory history will
have a comma-separated list of values in those fields for reporting purposes.
The price is set to the average cost of the stock.

When getting the heat certificates for parts from the TFS Details dialog box in
Production Control, parts will be duplicated in the list with each of the
Supplier, PO#, and Heat# values used in the splice package. These rows will
be highlighted in yellow. When selected, a Joined from inventory transaction
# button will be available in the bottom right corner. Click this button to open
the Inventory Transaction History dialog box selected on that transaction
number. This is the transaction that joined the stock lengths together into the
long length, either with the Join to Result Length command or as part of the
TFS operation.

See also

Create and manage splice packages (page 1060)

Check if splicing is needed (page 1061)

Create a splice package (page 1061)

View and modify splice packages (page 1065)

Set the kerf (page 1068)

Set the kerf
When you create splice packages, the kerf is set to the default for that
dimension.

To change the kerf setting, do as follows:

1. Click the Maintenance ribbon tab and select Inventory > Splice
Packages.

2. Select the splice package that you want to modify.

3. Click Details.

4. Click the Splice Package Details ribbon tab.

5. On the menu, select Set Kerf.

6. In the Set Kerf dialog box, edit the kerf.

7. To confirm the change, click OK.
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See also

Create and manage splice packages (page 1060)

Check if splicing is needed (page 1061)

Create a splice package (page 1061)

View and modify splice packages (page 1065)

Heat certificate traceability (page 1068)
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11Order Entry

Use the Order Entry module to directly sell material from your inventory. In
Order Entry, you can create and manage customer orders, quotes, invoices,
payments, credits, deliveries, and returns.

NOTE Before you start working in the Order Entry module, remember to set
up the module (page 1071).

The basic workflow in the Order Entry module is as follows:

1. Do one of the following:

• Create a quote or a quick quote for the customer, and once it gets
accepted, convert it into an order.

• Create an order.

2. Add details for the order.

3. Combine and allocate the material items in the order.

4. If necessary, add charges or order-specific credit for the customer.

5. Add invoices and deliveries.

6. If necessary, add returns.

See also

Set up the Order Entry module (page 1071)

Open the Order Entry module (page 1089)

Filter the order entry information (page 1090)

Create a quote or an order (page 1092)

Modify a quote or an order (page 1102)

Convert a quote into an order (page 1103)

Convert an order back into a quote (page 1103)

Delete a quote (page 1104)

Add an invoice (page 1104)
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Add a payment (page 1106)

Add a credit (page 1106)

Add a delivery (page 1107)

Add a return (page 1108)

Create order or quote reports (page 1108)

11.1 Set up the Order Entry module
In Order Entry Maintenance, you can create and modify the settings used
when working in the Order Entry module. For example, you can modify the
company standard settings, invoice categories, shipping methods, and
payment terms.

Remember to also set up the necessary tax rates and tax groups before you
start working in the Order Entry module.

Define company standard settings for Order Entry
For each module, you can define company-level settings that are the default
for all new jobs.

To access the Company Standards dialog box, do the following:

1. Click the Maintenance ribbon tab..

2. On the menu, select Order Entry --> Company Standards .

3. Modify the settings on the various tabs as needed.

4. Click Save.

Saving the settings closes the Company Standards dialog box.

You can find further company standard settings by clicking the buttons.

Define general order entry settings
1. On the General tab, modify the following properties: 

Option Description
New Customer -
Default Tax Group

The default tax group applied for new order entry
taxable items. The tax group can be changed job by job.
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Option Description
Restrict to
Inventory
Location

When selected, Tekla PowerFab limits the available
stock material selection to a specific inventory location.

Select the desired inventory location in the list on the
right side of the field. Inventory locations can be set and
reset in the Inventory module.

Allow Delivery of
Un-Invoiced
Material

When selected, Tekla PowerFab allows delivering
materials before invoicing.

NOTE You need to select the Allow Delivery of Un-
Invoiced Material option to view and use
delivery tickets before invoicing.

Allow Invoicing of
Material Not
Delivered

When selected, Tekla PowerFab allows creating invoices
for materials before they are delivered.

Keep Order
Selection Screen
Open

When selected, the order selection dialog box stays
open after a job has been selected.

Automatically
Create Document
Index Directories

When selected, the Document Index directories
defined in Maintenance --> Document Index -->
Standard Categories are created automatically under
the base document index directory when a job is
created. See Set the standard categories for attached
documents (page 150).

Selection Screen -
Default number of
days to view

The number of days for which orders remain in the
Order Selection dialog box. This setting allows you to
filter out older orders.

To always display all orders, type 0.
Order # Increment The default option for automatic order numbering.

New orders are numbered according to the selected
option. However, you can modify the order number
according to your needs each time you create a new
order.

Item Increment Sets the autoincrement for item numbers.

The default autoincrement of 10 allows items to be
added in the list as needed, without having to renumber
the other items in the job.

For example, if items should be numbered as 10, 20,
30, ..., set the input increment to 10. If the
autoincrement of item numbers is not necessary, type
1.
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Option Description
Quote # Regular
Expression and
Order # Regular
Expression

Optional expressions used for pattern matching.

For more details on regular expressions, click Regular
Expression Help.

New Material -
Default Price

The default material cost applied to new quotes and
orders. The options are:

• No Default: no default price is set.

• Replacement Cost: the price defined in Pricing
Maintenance is used.

• Inventory Average: the inventory average price is
used.

• Inventory High: the highest inventory price is used.
Order -
Automatically
Allocate Inventory

When selected, Tekla PowerFab automatically uses
material items in the inventory for quotes and orders.

2. Click Save. 

Saving the settings closes the Company Standards dialog box.

Define price level settings
1. Open the Price Levels tab.

2. In the Number of Price Levels field, type the number of levels of pricing
that you want to use.

3. In the Default Price Group list, select the price group to be used by
default for new orders.

4. In the Default Price Level list, select the price level to be used by default
for new orders. 

For more information on defining the pricing groups and pricing levels
used in Order Entry, see Create, modify, and delete price groups
(page 1083).

5. Click Save. 

Saving the settings closes the Company Standards dialog box.

Set credit limit settings
1. Open the Credit Limit tab.

2. In the New Customer - Default Credit Limit field, type the default credit
limit for new customers. If you do not want to set a credit limit, type 0.
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3. Select how Tekla PowerFab reacts when a customer has exceeded their
credit limit. 

The options are:

• Allow without warning: Tekla PowerFab allows creating new orders
without warning

• Allow with warning: Tekla PowerFab allows creating new orders, but a
pop-up warning is displayed

• Allow with credit limit override: Tekla PowerFab allows new orders
when you override the customer's credit limit

• Don't allow: Tekla PowerFab does not allow any new orders for
customers that have exceeded their credit limit

4. Click Save. 

Saving the settings closes the Company Standards dialog box.

Define backdating settings
If you want to mark payments and other order entry activities as created on a
previous date, you can allow back-dating for the activities.

1. Open the Back-Dating tab.

2. Click to select the checkboxes for each option for which you want to allow
back-dating order activity. 

If you do not want to allow backdating, do not select any checkboxes.

3. Click Save. 

Saving the settings closes the Company Standards dialog box.

Define QuickBooks sale tax codes
If you have connected the QuickBooks accounting software with Tekla
PowerFab, you can define the sales tax codes that are used when exporting
invoices from Tekla PowerFab to QuickBooks.

Note that you need to have exactly the same tax codes in both software.

1. Open the QuickBooks tab.

2. Type in the sales tax codes used for taxable and non-taxable items.

3. Click Save. 

Saving the settings closes the Company Standards dialog box.
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Define default input and display units for Order Entry
You can define standard input and display units for the company. You can
select either metric or imperial units and the units of measurement for a
piece.

NOTE The actual length of the item is not affected by the selection of the
input type, only the displayed length.

1. Go to Maintenance --> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Input/Display Units. Click Input/Display Units. 

The Input/Display Units dialog box opens.

3. Select the measurement system and the units of measurement on the
drop-down menus.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

You return to the <Module> Job Edit dialog box.

5. Click Save.

The input and display units are saved as defaults.

See also

Define company standard settings for Order Entry (page 1071)

Define default combining optimizations for Order Entry
You can define company-level settings for material optimization.

Text here

1. To define company-level settings, go to Maintenance --> <Module>
Company Standards.

2. Click Combining Optimizations.

The Combining Setup dialog box opens.
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3. Modify the settings on the various tabs as needed.

Define the general settings

1. Go to the General Settings tab.

2. Modify the settings as needed. 

Option Description
Use Grade Substitutions Select to check for material in

inventory that has an alternative
grade to the one specified.

Only grades of an equal or higher
rating will be used as set in
Maintenance --> Shapes/Grades/
Sizes --> Shape/Grade/Size
Maintenance dialog box.

If the grade substitutions are not set,
the material grades in the combining
run and in the supplier pricing data
set or the inventory need to match
each other exactly.

Optimizations Not Included/
Optimizations Included

Allows you to select the optimization
options that you want to use by
moving them to the Optimizations
Included list using the arrow buttons.
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Option Description
Inventory Exact-Match (In Stock) Use this option for inventory items in

stock that are an exact match without
the use of kerf or clamp allowance.

Inventory Exact-Match (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that are an
exact match without the use of kerf or
clamp allowance.

Inventory Least-Scrap (On Order) Use this option for inventory items
that are on purchase orders and have
not yet been received and that will
provide the least amount of scrap.

Inventory Least-Scrap (In Stock) Use this option for inventory items in
stock that will provide the least
amount of scrap.

Warehouse Least-Scrap Use this option to give preference to
warehouse items that will provide the
least amount of scrap. Warehouse
items will only be used when they
provide less scrap than the available
inventory items or no inventory
exists.

Warehouse Force Inventory Use this option to force the use of
inventory items if available regardless
of the amount of scrap, no matter
where it is located in the
Optimizations Included list. This
option is the opposite of Warehouse
Least-Scrap.

Note that you can only include
Warehouse Least-Scrap or
Warehouse Force Inventory, not
both.

3. Modify the order of the optimizations by using the Move Up and Move
Down buttons 

The order is important when you are performing a combining run.

4. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.
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Define plate nesting settings

1. Go to the Plate Nesting Settings tab.

2. Modify the settings as needed. 

Option Description
Shear Cut Optimization Select a suitable shear cut option. The

selected option determines the plate
allowance to be used with the
combining:

• None: Use when cutting plate on a
burn table.

• Shear Cut - First Cut Along
Length or Shear Cut - First Cut
Along Width: Use to alert Tekla
PowerFab that the nesting needs
to allow for that type of cut first.
Then, the nesting will allow for all
subsequent cuts to be made with
that condition.

Rotate Plates for Best Fit Select if the material grain direction is
unimportant and you want Tekla
PowerFab to create the best possible
optimization of a plate.

3. Do either of the following:

• Click Save.

The Combining Setup dialog box closes.

• Continue to add or modify properties.

When you click Save, the Combining optimizations settings are saved.

Define default suppliers for Order Entry
You can define default suppliers, or pricing data sets, for angles, beams, plates,
rods, tubes, and other material. This way, you can use material pricing from
the selected supplier pricing data sets for each material group.

1. Go to Maintenance --> <Module> Company Standards. 

The <Module> Company Standards dialog box opens.

2. Click Suppliers. 

The Suppliers dialog box opens.

3. Select suppliers for each material group on the drop-down lists.

4. Click OK. 

You return to the <Module> Company Standards dialog box.

Order Entry 1078 Set up the Order Entry module



5. Do either of the following:

• Click Save.

The <Module> Job Edit dialog box closes.

• Continue to add or modify properties.

See also

Define company standard settings for Order Entry (page 1071)

Create, modify, and delete charge processes
While working in Order Entry, you should use different charge processes
depending on whether you are charging the customer for material, labor, or
both. The charge processes, standard charges, and applicable costs are
defined in Charge Process Maintenance.

NOTE While working on quotes and orders in the Order Entry module, you
can only change the price per item, not the type or description. This
means that you can enter the base costs in the Charge Processes
dialog box and change them according to your needs.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Charge Process Maintenance . 
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3. In the Charge Processes dialog box, do any of the following: 

To Do this
Add a new charge
process

a. Click New.

b. In the Type list, select a suitable option.

The options are Material, Labor, and
Miscellaneous. Use the Miscellaneous option
when the charge applies to both material and
labor.

c. In the Description field, type a description for
the charge process.

For example, if the Type is Labor, the
description can be Cutting or Welding.

The description will appear in the Process
column in Order Entry.

d. In the Cost field, type the price per item.
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To Do this
e. Click Add to save the new charge process and

add it to the list.
Modify a charge process a. Select a charge process in the list.

b. Modify the type, description, and cost
according to your needs.

c. Click Edit to save the changes.
Delete a charge process a. Select a charge process in the list.

b. Click Delete.

c. To permanently delete the charge process,
click Yesin the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete invoice categories
In the Invoice Category Maintenance dialog box, you can create a list of
standard invoice categories used for customer orders. The categories that you
define are available when creating invoices in the Order Entry module.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Invoice Category Maintenance.

3. In the Invoice Categories dialog box, do any of the following according to
your needs: 

To Do this
Add a new invoice
category

a. Click New.

b. In the Category field, type a name for the
invoice category.

c. In the Description field, type a description for
the invoice category.

d. Click Add to save the new invoice category and
add it to the list.

Modify an invoice
category

a. Select the invoice category that you want to
modify.

b. Modify the name and description of the
invoice category.

c. Click Save to save the changes.
Delete an invoice
category

a. Select the invoice category that you want to
delete.
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To Do this
b. Click Delete.

c. To permanently delete the invoice category,
click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete order and quote categories
In the Order Category Maintenance dialog box, you can create a list of
standard categories for orders and quotes. For example, you can create
separate order categories for walk-in customers and regular customers. The
categories that you define are available in the Order dialog box for both
quotes and orders.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Order Category Maintenance.

3. In the Order Categories dialog box, do any of the following according to
your needs: 

To Do this
Add a category a. Click New.

b. In the Category field, type a name for the
category.

c. In the Description field, type a description for
the category.

d. Click Add to save the new category and add it
to the list.

Modify an order
category

a. Select the order category that you want to
modify.

b. Modify the name and description of the
selected order category.

c. Click Save to save the changes.
Delete a category a. Select the category that you want to delete the

list.

b. Click Delete.

c. To permanently delete the category, click Yes
in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.
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Create, modify, and delete price groups
You can add, modify, and delete price groups that are available in the Order
Entry module. You can also define different price levels within price groups.
Price levels determine the level of markup that your company gets from each
order. Note that you can use any price level with any price group.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Price Group Maintenance . 

3. In the Price Group Maintenance dialog box, do any of the following
according your needs: 

To Do this
Add a price group a. Click New.

b. In the Description field, type a description for
the price group.

c. To add price levels to the price group, type the
desired minimum order prices and markup
percentages in the available fields.

The minimum order prices and markups are
used for recovering costs and small orders. As
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To Do this
orders get larger, the amortization of costs
may set off the need for larger markups and
allow smaller minimum order prices.

d. Click Add to save the price group and add it to
the list.

Modify a price group a. Select the price group that you want to modify.

b. Modify the description and price levels
according to your needs.

c. Click Save to save the changes.
Delete a price group a. Select the price group that you want to delete.

b. Click Delete.

c. To permanently delete the price group, click
Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete payment methods
You can add, modify, and delete payment method options available for new
payments in the Order Entry module. You can also select which payment
method you want to use as the default option used for new orders.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Payment Method Maintenance.

3. In the Payment Method Maintenance dialog box, do any of the following
according to your needs: 

To Do this
Add a new payment
method

a. Click New.

b. In the Description field, type a description for
the payment method.

For example, Cash.

c. Click Add.

The new payment method is saved and added to
the list.

Set a payment method
as default

a. Select the payment method that you want to
set as the default option.

b. Click Set as Default.
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To Do this
c. To confirm using the selected payment

method as the default option, click Yes.

The default payment method is marked with
an asterisk (*). This payment method will be
used by default for new orders.

Modify a payment
method

a. Select the payment method that you want to
modify.

b. Modify the description of the payment
method.

c. Click Edit to save the changes.
Delete a payment
method

a. Select the payment method that you want to
delete.

b. Click Delete.

c. To permanently delete payment method, click
Yes.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add, modify, and delete payment terms for customer
orders
You can add, modify, or delete the payment term options that are available for
all customer orders created in Order Entry. In addition, you can set the
default payment term that will be used for new customer orders.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Payment Term Maintenance . 
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3. In the Payment Term Maintenance dialog box, do any of the following
according to your needs: 

To Do this
Add a new payment
term

a. Click New.

b. In the Description field, type a description for
the payment term.

c. If necessary, in the Discount field, type a
discount percentage for the payment term.

d. If you want to freeze a customer's credit when
an invoice is past the due date, select the
Credit Hold if Past Due checkbox.

e. In the Days to Past Due field, type the
number of days that an invoice can be past
due date before the customer's credit is
frozen.

f. Click Add to save the new payment term and
add it to the list.
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To Do this
Set a default payment
term

a. Select the payment term that you want to set
as the default option.

b. Click Set as Default.

c. To confirm using the selected payment term
as the default option, click Yes in the
confirmation dialog box.

The default payment term is marked with an
asterisk (*). This payment term will be used by
default for new customer orders.

Modify a payment term a. Select the payment term that you want to
modify.

b. Modify the payment term properties according
to your needs.

c. Click Edit to save the changes.
Delete a payment term a. Select the payment term that you want to

delete.

b. Click Delete.

c. To permanently delete the payment term, click
Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Add, modify, and delete shipping methods for customer
orders
In the Shipping Method Maintenance dialog box, you can add, modify, and
delete shipping method options that are available for the customer orders
created in Order Entry. You can also select which shipping method you want
to use as the default option.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Shipping Method Maintenance .

3. In the Shipping Method Maintenance dialog box, do any of the following
according to your needs: 

To Do this
Add a shipping method a. Click New.

b. In the Description field, type a description for
the new shipping method.
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To Do this
c. Click Add to save the new shipping method

and add it to the list.
Set a default shipping
method

a. Select a shipping method in the list.

b. Click Set as Default.

c. To confirm using the selected shipping method
as the default option, click Yes in the
confirmation dialog box.

The default shipping method is marked with an
asterisk (*). This shipping method is used by
default in the Order Entry module.

Modify a shipping
method

a. Select a shipping method in the list.

b. Modify the information in the Description
field.

c. Click Edit to save the changes.
Delete a shipping
method

a. Select a shipping method in the list.

b. Click Delete.

c. To permanently delete the shipping method,
click Yes in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

Create, modify, and delete territory options
In Territory Maintenance, you can add, modify, and delete territory options
that are available for defining order information.

1. Click the Maintenance ribbon tab.

2. In the menu, select Order Entry --> Territory Maintenance.

3. In the Territories dialog box, do any of the following according to your
needs: 

To Do this
Create a new territory a. Click New.

b. In the Territory field, type a name for the
territory.

c. In the Description field, type a description for
the territory.

d. Click Add to save the new territory and add it
to the list.
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To Do this
Modify a territory a. Select the territory that you want to modify.

b. Modify the name and description of the
territory according to your needs.

c. Click Save to save the changes.
Delete a territory a. Select the territory that you want to delete.

b. Click Delete.

c. To permanently delete the territory, click Yes
in the confirmation dialog box.

4. To close the dialog box, click the Close button (X) in the upper-right
corner.

11.2 Open the Order Entry module
To create, modify, and delete orders, quotes, invoices, payments, credits,
deliveries, and returns, open the Order Entry module.

• At the top of the Tekla PowerFab window, click the Order Entry icon. 

The Order Entry dialog box opens. You can view the existing quotes,
orders, invoices, payments, credits, deliveries, and returns.
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By default, the orders and quotes are visible for 30 days after their
creation. However, you can change this setting, see Define company
standard settings for Order Entry (page 1071). You can also use filters to
view older quotes and orders, see Filter the order entry information
(page 1090).

11.3 Filter the order entry information
You can select which orders and quotes you want to see in the Order Entry
dialog box. For example, you may want to view older orders that are hidden in
the initial view of the Order Entry dialog box.

Order Entry 1090 Filter the order entry information



1. At the top of the Order Entry dialog box, click the arrow button on the left
side of Filters. 

The Filters section expands.

If you want to see all orders created in the Order Entry module including
the completed orders, select the Show Completed Orders checkbox on
the right side of the Order Entry dialog box.

2. To apply a new filter, click Set Filters. 

The Order Filters dialog box opens.

3. Depending on what you want to filter out, click one of the available filter
buttons.

4. Click the arrow buttons to move the items that you want to display to the
Included list.

5. Click OK.

6. Click Apply Filter.

The orders and quotes displayed in the Order Entry dialog box are updated to
match the filters you set.

To clear the applied filters, close and re-open the Order Entry dialog box.

11.4 Manage quotes and orders
You can create and manage both quotes and order in the Order Entry
module. The difference between quotes and orders is that you can add
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invoices to orders, and send the materials on the orders to purchase orders.
Quotes are simply estimates that a customer can accept or reject, so they
cannot be invoiced.

See also

Create a quote or an order (page 1092)

Modify a quote or an order (page 1102)

Convert a quote into an order (page 1103)

Convert an order back into a quote (page 1103)

Delete a quote (page 1104)

Create a quote or an order
Quotes and orders are created in the exact same way. Orders can be invoiced
and their materials can be sent to purchase orders, whereas quotes are simply
price estimates that the customer can accept or decline. Alternatively, you can
also create quotes in the Inventory module.

1. At the bottom of the Order Entry dialog box, click New Quote or New
Order. 

2. If necessary, modify the quote or order number at the top of the Order
Information dialog box.

3. Enter a job description and the eventual customer purchase order
number.
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4. In the Salesman list, select the salesman. 

All users listed in the Administration dialog box are available in the
Salesman list.

5. Select the quote or order date and the delivery date.

6. In the Customer Name list on the Customer/Terms/Settings tab, select
a company. 

All companies in the address book whose firm type is Customer are
available in the list. When you select the company, the default shipping
and billing addresses and the customer code are automatically added to
the dialog box. If necessary, you can select an alternative shipping or
billing address in the appropriate lists.

7. In the Contact list, select a contact person associated with the customer
company. 

TIP You can also add a contact person into the address book in the
current dialog box. Type a new name in the Contact field and click
the Add button that has appeared on the right side of the field.
Then, enter the contact information for the new contact person.

8. Select the tax group, order category, territory, shipping method, payment
terms, price group, and price level in the appropriate lists.

9. In the Item Increment field, type a value used for numbering materials in
the quote or order. 

The default autoincrement of 10 allows items to be added in the list as
needed, without having to renumber the other items in the job.

10. To limit the available stock material selection to a certain inventory
location, select the Restrict to Inventory Location checkbox, and select
the inventory location in the list.

11. Go to the Notes tab to add notes regarding the quote or order. 

The notes will appear in quote and order reports.

12. Go to the Internal Notes tab to add private notes regarding the quote or
order.

13. At the bottom of the dialog box, click Save Quote Information or Save
Order Information.

The quote or order is created and added to the Order Entry dialog box. You
can modify all properties later, if necessary.

The Details dialog box opens. You can add quote or order details regarding,
for example, materials, charges, and discounts.

You can also find and modify further properties by clicking the buttons on the
right.
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See also

Add quote or order details (page 1094)

Create a quick quote (page 1101)

Copy quote or order information (page 1101)

Add quote or order details
Once you have created a quote or an order, you need to add details for it. This
includes adding materials to be delivered to the customer, creating additional
charges, and adding the necessary discounts. For orders, you can also add
invoices, payments, credit, deliveries, and returns.

To access the Details dialog box, do one of the following:

• In the Quote dialog box, click Quote Details.

• In the Order dialog box, click Order Details.

The Details dialog box opens on the Total tab, where all quote or order details
and job activity are shown.

Add and combine materials

Note that even though you can allocate the material items on a quote, the
material items on the quote are actually combined only when you convert the
quote into an order. When a quote is converted into an order, the the
allocated material items of the quote are automatically reflected to the order.

1. Open the Material tab. 
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2. To add materials to the list, click New.

3. Define the properties of the new material according to your needs:

a. Enter the item number, quantity, length, base price, and additional
drop price per item.

b. In the Shape, Dimensions and Grade lists, select the desired options.

c. If the item is taxable, select the Taxable checkbox.

d. If necessary, type a piece mark for the material. 

Adding piece marks can be useful if drawings are available.

e. If necessary, enter any comments regarding the part you are adding. 

The comments will be visible in both the material list and reports.

f. To apply markup for the available costs, select the Markup checkbox. 

Note that you do not need to select the Markup checkbox is you
want to use the replacement cost as markup.

g. Select the desired pricing option, and click Apply.

h. To confirm the markup, click Yes in the confirmation dialog box.

4. Click Add. 

Repeat steps 2 to 4 to add all necessary materials.

Note that as you add materials to the order or quote, the Material tab is
updated to show the total cost of the material.

5. To allocate the items, do any of the following: 
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To Do this
Automatically combine
the material items and
move them to allocation

a. Click the Order Entry ribbon tab.

b. On the menu, select Quick Combine.

When you select Quick Combine, the
combining is performed according to the
combining optimizations set for Order Entry.

If you want to manually modify the combining
setup, select Combine instead.

When Tekla PowerFab has finished the
combining process, the Combining Run
Results dialog box opens.

c. Review the combining results to make sure
that they are satisfactory, and click Save
Combining Run.

d. To close the Combining Run Results dialog
box, click the Close button (X) in the upper-
right corner.

Allocate a material item
from the inventory

Material items can be allocated from the inventory
if there is an exact match for the items in stock. If
there is no exact match for the material item in the
inventory, you need to send the item to a purchase
order. For more information, see Send materials to
a purchase order (page 1100).

a. Select the desired material item.

b. In the list in the lower-right corner of the
dialog box, select an inventory item that
matches the selected material item.

c. Click Allocate Inventory.

d. To confirm allocating the material item from
the inventory, click Yes in the confirmation
dialog box.

Allocate a material item
as an order to length
item

a. Select the desired material item.

b. At the bottom of the dialog box, click Allocate
Order to Length.

c. To confirm allocating material item as an order
to length item, click Yes in the confirmation
dialog box.

As you combine or allocate materials, the Allocation tab is updated to
show the percentage of materials that has been allocated.

6. To set the additional drop price per piece, select the item and click the Set
button in the This Item section of the dialog box.
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7. To manually set the markup for the current margin, click the % button and
select an option in the context menu.

Modify the properties of allocated materials

1. Open the Allocation tab. 

The allocated material items and the restock lengths are displayed.

2. Do any of the following according to your needs: 

To Do this
Split an allocated
material record

Use the Split command to separate a certain
quantity of pieces from an allocation record, so
that you can handle it differently from other
material. For example, you can set a different price
for the separated quantity.

a. Select the material record that you want to
split.

b. Click Split.

c. In the Enter Value dialog box, type the
quantity that you want to separate.

d. Click OK.

The split quantity is added to the list of allocated
material records.

Join allocated material
records

The Join command is used to re-join a split
allocation record.

Note that if you have made changes to one of the
split records, you cannot join the records back
together unless you change the properties back.
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To Do this
a. Select the material items that you want to join.

To select multiple items, hold down Ctrl.

To select a range of subsequent items, hold
down Shift.

b. Click Join.

The split material records are joined back together.
Ensure that the allocated
materials are available in
the inventory

Click Verify.

Delete an allocated
material record to re-
combine them

a. Select the material record that you want to
delete.

b. Click Delete.

c. To confirm deleting the materials from the
Allocation tab, click Yes in the confirmation
dialog box.

You can now re-combine the items on the Material
tab.

Set price for an allocated
material record

a. Select the material record whose price you
want to modify.

b. Click Set Price.

c. In the Enter Value dialog box, define a new
price for the material item.

d. Click OK.
Send an allocated
material record to
purchasing

See Send material items to purchasing (page 1100).

Add charges

1. Open the Charges tab. 
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2. At the bottom of the dialog box, click New Charge.

3. Select a date for the new charge.

4. Enter the quantity of charges.

5. If necessary, select the material item to which the new charge is applied. 

Note that selecting the material item is optional. You can cancel any
charges for which you have not selected a material item.

6. Select the type of charge and the charge process. 

The available charge processes are defined in Charge Process
Maintenance. For more information, see Create charge processes
(page 1079).

7. Enter the amount of money per charge. 

The amount will be multiplied by the quantity of charges.

8. If necessary, click to select the Taxable checkbox.

9. Click Add Charge. 

The charge is added for the material item and will be visible in the total
sum of the quote or order.

NOTE To modify or delete the existing charges, click to select the charge
and click either Edit Charge or Delete Charge.

Add discounts
If necessary, you can create discounts for an individual quote or order.

1. Open the Discounts tab. 
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2. At the bottom of the dialog box, click New Discount.

3. Select a date for the new discount.

4. Enter the quantity of discounts.

5. Select the charge type to which the discount is applied. 

The options are Material, Labor, and Miscellaneous.

6. Enter the amount of money per discount. 

The amount will be multiplied by the quantity of discounts.

7. If the discounts will be considered before the deduction of taxes, select
the Pre-Tax checkbox.

8. Click Add Discount. 

The discount is added for the charge type and will be visible in the total
sum of the quote or order.

Send material items to purchasing
Use the Send to PUR command to send material items on customer orders to
the Purchasing module. If you want to create invoices for materials that are
not allocated in the inventory, send the materials to a purchase order. If you
need to request quotes for materials, you should send the materials to a
requisition.

Note that materials that are on a quote cannot be sent to a purchase order.

1. Open the order and click Order Details.

2. In the Details dialog box, open the Allocation tab.
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3. Select the material item that you want to send to purchasing. 

Note that only material items whose type is Not Purchased can be sent
to purchasing.

4. At the bottom right corner of the dialog box, click Send to PUR. 

A dialog box opens, asking if you want to send the material to a
requisition or a purchase order.

5. Select either Requisitions or Purchase Orders.

6. Double-click the purchase order or requisition to which you want to send
the material.

The materials are sent to the selected requisition or purchase order.

You can view and modify the requisition or purchase order in the Purchasing
module. If you have create an invoice for the materials in the Order Entry
module.

See also

Add quote or order details (page 1094)

Add an invoice (page 1104)

Copy quote or order information
Once you have existing quotes and orders in the Order Entry dialog box, you
can use them as the basis of new quotes and orders. You can then further
modify the quote or order details according to the customer's needs. This can
be useful when a customer makes an order that is similar to a previous one.

1. In the Order Entry dialog box, select the quote or order that you want to
use as the basis of the new quote or order.

2. Click the Order Entry ribbon tab.

3. On the menu, select Copy Quote/Order.

4. To confirm copying information from the selected quote or order, click Yes
in the confirmation dialog box.

5. Adjust the quote or order information and details according to your
needs.

6. At the bottom of the dialog box, click Save Quote Information or Save
Order Information.

See also

Create a quote or an order (page 1092)

Add quote or order details (page 1094)
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Create a quick quote
Quick quotes allow you to quickly enter line items for a quote or an order. You
can then either save the line items to an existing quote or order, or create a
new quote or order containing the line items.

You can also create quick quotes in the Inventory module by clicking the
Inventory ribbon tab and selecting Order Entry --> Quick Quote .

1. In the Order Entry dialog box, click the Order Entry ribbon tab.

2. On the menu, select Quick Quote.

3. In the Quick Quote dialog box, select the customer and contact.

4. Determine the quantity of items, the shape, dimensions, grade, length,
and the base price. 

Once you have selected the shape, grade, and dimension, you can select
the item from existing inventory items.

5. If the item is taxable, select the Taxable checkbox.

6. To apply markup to the item you created, select the Markup checkbox.

7. Do one of the following:

• To save the item to an existing quote or order, click Save to Quote/
Order, and double-click the desired quote or order.

• To create a new quote or order, click Save to New Quote or Save to
New Order, and enter the quote or order information and details.

See also

Add quote or order details (page 1094)

Create a quote or an order (page 1092)

Modify a quote or an order
You can modify all order and quote properties afterwards. For example, you
may need to change the customer information, the quote or job number, the
tax group and rate used, and the input and display units used.

1. In the Order Entry dialog box, select the order or quote and click Open. 
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2. Modify the customer information, tax groups, notes, and other
information according to your needs.

3. To save the changes, click Save Quote Information or Save Order
Information.

Convert a quote into an order
Converting quotes into orders is necessary in order to send materials to
purchase orders, add invoices for them, and add credit payments.

1. In the Order Entry dialog box, select the quote and click Open.

2. In the lower-right corner of the Quote dialog box, click Convert to Order.

3. To confirm converting the quote into an order, click Yes in the
confirmation dialog box.

The quote is converted into an order, and it will no longer appear in the list of
quotes. Note that the dialog box name changes into Order.

See also

Convert an order back into a quote (page 1103)

Modify a quote or an order (page 1102)
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Convert an order back into a quote
In Tekla PowerFab, you cannot delete orders. However, you can convert an
order back into a quote and delete the quote. To convert the order into a
quote, do the following:

1. In the Order Entry dialog box, click to select the order and click Open.

2. In the lower-right corner of the Order dialog box, click Convert to Quote.

3. To confirm converting the order back into a quote, click Yes in the
confirmation dialog box.

The order is converted back into a quote, and it will no longer appear in the list
of orders. Note that the name of the dialog box changes into Quote.

See also

Modify a quote or an order (page 1102)

Delete a quote
You can delete rejected and unnecessary quotes from the Order Entry dialog
box.

NOTE Orders cannot be deleted. To delete an order, you first need to
convert the order into a quote. For more information, see Convert an
order back into a quote (page 1103).

1. In the Order Entry dialog box, select a quote.

2. At the bottom of the dialog box, click Delete Quote.

3. To permanently delete the selected quote, click Yes in the confirmation
dialog box.

11.5 Add an invoice
After you have created a customer order and allocated the material items on
the order, you can create invoices for the order. Tekla PowerFab then allows
you to view the created invoice as a report, print it, and send it to the
customer.

1. Do one of the following:

• At the bottom of the Order Entry dialog box, click New Invoice, and
double-click the order for which you want to add the invoice.

• In the Details dialog box, go to the Invoices tab, and click New
Invoice.
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2. In the New Invoice dialog box, select the invoice date and invoice
category. 

The available invoice categories are created in the Invoice Categories
dialog box that you can access via Maintenance --> Order Entry -->
Invoice Category Maintenance .

3. On the Material tab, select whether you want to invoice all material or the
material that is in stock. 

TIP If you want to invoice only a certain quantity of materials, type the
quantity in the Invoice Qty field.

4. On the Charges and Discounts tabs, select which charges and discounts
are applied to the current invoice.

5. If necessary, type notes for the invoice. 

The notes will be visible in the invoice.

6. Click Add Invoice. 

If you typed a value in the Deliver Qty field, Tekla PowerFab asks you to
confirm the delivery and materials.

7. In the confirmation dialog box, click Yes.

8. In the Report Selection dialog box, double-click Invoice to view the
invoice that you just created.

After creating the invoice, you can send it to the customer via Microsoft
Outlook email. To do so, click Email Excel or Email PDF in the upper-right
corner of the Tekla PowerFab Report Viewer.

You can also export the invoice to an external accounting software, if
necessary. For more information, see Export invoices to accounting software
(page 1105).

Export invoices to accounting software
If you have connected an accounting software with Tekla PowerFab, you can
export any invoices created in the Order Entry module to the accounting
software. By exporting the invoices to your accounting software, you can make
sure that all invoices are found in the same location. Invoices can be exported
to either QuickBooks, Timberline, or Peachtree.

1. On the left side of the Order Entry dialog box, click Invoices. The Order
Entry dialog box only shows the existing invoices.

2. If you only want to export certain invoices, select them in the Order Entry
dialog box.

3. Click the Order Entry ribbon tab.
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4. On the menu, select Export, and select a suitable export option. You can
export either all invoices visible in the Order Entry dialog box or the
invoices that you have selected.

5. If you are exporting the invoices to Timberline or Peachtree, enter the
necessary details. For example, you may need to define the job name or
the date format.

6. Click Export.

The invoices are exported to the selected accounting software.

11.6 Add a payment
Once you receive a payment from a customer, remember to add the payment
for their order in the Order Entry module. When you record the payments to
Tekla PowerFab, it is easier for all Tekla PowerFab users to stay up to date on
customer orders.

1. Do one of the following:

• In the Order Entry dialog box, click New PaymentNew Payment, and
double-click the order for which you want to add the payment.

• In the Details dialog box, go to the Payments tab, and click New
Payment.

2. Select the payment date and payment method.

3. Enter the amount paid by the customer. 

You can see the remaining amounts to be invoiced and paid on the right
side of the dialog box.

4. If necessary, add notes for the payment. 

The notes will be visible in the Payment Details report.

5. Click Add Payment.

The Report Selection dialog box opens. If you want to view the payment
information, double-click Payment Details.

See also

Add an invoice (page 1104)

11.7 Add a credit
If necessary, you can add an additional credit for the customer regarding a
specific customer order. Order-specific credits can be added regardless of the
customer's credit limit.
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1. Do one of the following:

• In the Order Entry dialog box, click New Credit, and double-click the
order for which you want to add the credit.

• In the Details dialog box, go to the Credits tab, and click New Credit.

2. Select the credit date and credit method.

3. Enter the amount of credit that you want to add for the customer.

4. If necessary, add notes on the credit.

5. Click Add Credit. 

Depending on the credit limit of the customer and the payments that are
due, confirmation dialogs may open.

6. If necessary, confirm that you want to add the current credit.

The credit is added for the customer, and the Report Selection dialog box
opens.

If you want to view the credit information, double-click Payment Details and
review the payment detail report.

11.8 Add a delivery
You can create deliveries for both quotes and orders. In order to create a
delivery, you need to determine the delivery date, quantity to deliver, shipping
method, and receiver.

1. At the bottom of the Order Entry dialog box, click New Delivery.

• In the Order Entry dialog box, click New Delivery, and double-click
the order for which you want to add the delivery.

• In the Details dialog box, go to the Deliveries tab, and click New
Delivery.

2. In the Delivery Date list, select a date.

3. Do one of the following:

• To deliver a certain quantity of material, in Qty to Deliver, type the
quantity.

• To deliver all material in stock, click Deliver All - In Stock.

4. Select a shipping method for the delivery.

5. In the Received By field, type the name of the receiver.

6. If necessary, add delivery notes.

7. At the bottom of the dialog box, click Add Delivery.
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8. To continue, click Yes in the confirmation dialog box. 

The Report dialog box opens, and the delivery information is added to the
selected quote or order.

9. To close the dialog box, click the Close button (X) in the upper-right
corner.

11.9 Add a return
If the customer returns some or all of the delivered materials in a customer
order, we recommend that you add a return. By recording the return in Tekla
PowerFab, you can ensure that the stock information is up to date and that
other Tekla PowerFab users are also aware of the return.

1. Do one of the following:

• At the bottom of the Order Entry dialog box, click New Return, and
double-click the order for which you want to add a return.

• In the Details dialog box, go to the Returns tab, and click New
Return.

2. Select the return date.

3. Enter the quantity of material to return and the restock and replace
information.

4. In the Returned By field, type the name of the returner.

5. If necessary, add notes about the return.

6. At the bottom of the dialog box, click Add Return.

7. In the Report Selection dialog box, do one of the following:

• View or print the return report.

• To close the dialog box, click the Close button (X) in the upper-right
corner.

The new return is added for the selected quote or order.

11.10 Create order or quote reports
You can create an order and quote report, view it, and email or print it for the
customer.

NOTE The Report Selection dialog box automatically shows only the reports
for the section of Order Entry dialog box in which you are working. To
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see a list of all reports, click Edit Report Types and move all reports to
the Included list.

1. In the Order Entry dialog box, select a quote or an order.

2. Click the Order Entry ribbon tab.

3. On the menu, select Reports.

4. In the Report Selection dialog box, select a report.

5. According to your needs, do any of the following: 

To Do this
View the report • At the bottom of the dialog box, click View.

The report opens in the Tekla PowerFab
Report Viewer. You can print, export, and
email reports also in the Tekla PowerFab
Report Viewer dialog box.

Print the report a. Use the + and - signs to modify the print
quantity.

b. If necessary, modify the printer options on the
right side of the dialog box.

c. At the bottom of the dialog box, click Print.

d. Select the printer that you want to use.

e. Click OK.
Export the report a. At the bottom of the dialog box, click Export.

The Export Options dialog box opens.

b. Select the export file format in the list.

c. To change the pre-defined file location and
name, click Browse, make the changes, and
click Save.

d. To email the exported file to a customer or
other person via Microsoft Outlook, select the
Attach to Email checkbox.

e. To open the exported file after the export,
select the Open Exported Document
checkbox.

f. Click Export.

6. To close the dialog box, click the Close button (X) in the upper-right
corner.
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12 Troubleshooting

Here you can find best practices and solutions to your problems

See also

Troubleshoot combining issues (page 1110)

12.1 Troubleshoot combining issues
If you have problems with combining, start with these troubleshooting tips.

Basically, if material does not to combine, the reason is that there is no
matching material available in the sources allowed in the optimizations. For
example, if we do not include warehouse at all, then only the inventory is
available. If we do not include the inventory, then only the suppliers are
available.

The available material must be the same shape, dimension, and grade. The
grade depends on any substitutions that have been set in Maintenance -->
Shapes/Grades/Sizes. The length, and for plates the width, of the available
material must accommodate the item length, trim cut, kerf, and clamp
allowance. You can select to have the clamp allowance to be included in the
items if there is an item that is longer than the clamp allowance.

See also

Add grade substitutions (page 184)

Combine materials in the Combining module (page 335)

Combine materials in the Estimating module (page 513)

Combine materials in the Production Control module (page 917)

Combine items in the Requisition # dialog box (page 1007)
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The grade of the item does not match
Possible cause: During the import of items into Production Control, you may
have allowed grades that are not in your system.

• Possible solution: Create standard acceptable grades that users and your
detailers are aware of.

Possible cause: The grade is right but it has not been set up in the pricing
maintenance.

• Possible solution: Evaluate the grade and check if it needs to be changed
to match your standard or added to a supplier in pricing maintenance. See
Set up pricing (page 199).
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The item is longer than any available material
Possible cause: Detailing the job called for a piece longer than the available
material. The length of the item is greater than what you have in Pricing
Maintenance or Inventory.

• Possible solution

If there is an option to splice existing material, you can create a splice
package whose total length becomes available material.

If the items are in inventory you may select them or add unpurchased
items and choose to put them on a requisition or purchase order. See
Create a splice package (page 1061).

Items do not combine to inventory
You may see inventory material that is there but items will not combine to it.
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Possible cause: The item in inventory already has material combined onto it.

These may be reserved for the job and have records linked to them from
previous runs either from the combining job or the PDC job that are no longer
the right length even though the actual inventory length would accommodate
the current length required.

• Possible solution:

Uncombine the unlinked material.

You are prompted to send the item back to a requisition.

If the record that is being removed is no longer correct, select no. This
deletes the incorrect record. See Combine inventory items manually
(page 556).

Possible cause: The inventory material itself has a reference number
assigned.

• Possible solution: To use this material, check the Use Inventory with
Reference Number Value checkbox in the Combining Run Inventory
Filters dialog box.

Possible cause: The inventory is reserved for a job not included in the
inventory filter.

• Possible solution:

Make sure that the available material is either unreserved or reserved for
the current job.
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If the material is reserved for another job, you must include that job
reservation in the combining run inventory filter or unreserve the material.

If there are combining details for another job, then unreserving it is not an
option.

"Save Displayed Results & Close" is not available
Possible cause: The Save Displayed Results & Close button is not available.

• Possible solution: To save the results of a combining run, select Use
PDC/PO Links in the Combining Run Filters window. See Combine
materials in the Production Control module (page 917).
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The combining dialog box opens to a blank window
Possible cause: All the items selected have previously been linked to a
purchasing record. This may be in inventory or on a requisition.

• Possible solution:

Find the items in inventory or in the requisitions.

The easiest way to do this is to use the Links button when the production
item is selected in the display grid. See View material links (page 867).
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Inventory “Manual Combine Mode” does not display
material in requisitions when “Add Item” is selected in the
"Add Item" dialog box
Possible cause: The available material is not the same shape, dimension,
grade, or grade substitute. The material simply does not match.

• Possible solution: Change the material to match, select the appropriate
inventory material, or add a grade substitution.

Possible cause: The quantity of the items in the requisition does not have a
multiple of the selected inventory quantity. In this case, you get a prompt
informing you that the quantity must be a multiple of the inventory quantity.

• Possible solution: Select the Combine quantity to match or select 1 to see
all available requisition items.
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NOTE Requisition is the same for Manual Combine Mode as for inventory except
that the option to change the combine quantity must be done on the
combined requisition line item.
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12.2 Troubleshoot 401 Unauthorized error
The 401 Unauthorized error indicates that the setup process for a user is
incomplete. It is likely that the user is not in your organization in the Tekla
Online Admin Tool or does not have the appropriate licenses assigned to them
there. This error can occur when logging into Tekla PowerFab Office or Tekla
PowerFab Go.

The main steps for setting up a new user are the following:

1. Create the Trimble Identity, see Create your Trimble Identity for Tekla
products.

2. Accept invitation to the organization, see Manage user accounts for Tekla
products.

3. Assign licensing, see Manage Tekla Structures subscriptions.

4. Set up user in Tekla PowerFab, see Manage Tekla PowerFab users
(page 54).

The first and second steps can be done when the organization's administrator
invites the user through the Tekla Online Admin Tool, which sends an email
with links to the user. Usually the 401 Unauthorized error occurs when users
set up their Trimble Identity but do not accept the invitation to the
organization.

See also

Solve problems with your Trimble Identity
Tekla Online Admin Tool
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© 2023 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced
Software. Use of the Software, and use of this Software Manual are governed
by a License Agreement. Among other provisions, the License Agreement sets
certain warranties for the Software and this Manual, disclaims other
warranties, limits recoverable damages, defines permitted uses of the
Software, and determines whether you are an authorized user of the Software.
All information set forth in this manual is provided with the warranty set forth
in the License Agreement. Please refer to the License Agreement for important
obligations and applicable limitations and restrictions on your rights. Trimble
does not guarantee that the text is free of technical inaccuracies or
typographical errors. Trimble reserves the right to make changes and
additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by
international treaties. Unauthorized reproduction, display, modification, or
distribution of this Manual, or any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla Structures, Tekla Model Sharing, Tekla PowerFab, Tekla Structural
Designer, Tekla Tedds, Tekla Civil, Tekla Campus, Tekla Downloads, Tekla User
Assistance, Tekla Discussion Forum, Tekla Warehouse and Tekla Developer
Center are either registered trademarks or trademarks of Trimble Solutions
Corporation in the European Union, the United States, and/or other countries.
More about Trimble Solutions trademarks: http://www.tekla.com/tekla-
trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in
the European Union, in the United States and/or other countries. More about
Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product
and company names mentioned in this Manual are or may be trademarks of
their respective owners. By referring to a third-party product or brand, Trimble
does not intend to suggest an affiliation with or endorsement by such third
party and disclaims any such affiliation or endorsement, except where
otherwise expressly stated.

Portions of this software:

EPM toolkit © 1995-2006 Jotne EPM Technology a.s., Oslo, Norway. All rights
reserved.
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Portions of this software make use of Open CASCADE Technology software.
Open Cascade Express Mesh Copyright © 2019 OPEN CASCADE S.A.S. All rights
reserved.

PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

This application incorporates Open Design Alliance software pursuant to a
license agreement with Open Design Alliance. Open Design Alliance Copyright
© 2002-2020 by Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

FlexNet Publisher © 2016 Flexera Software LLC. All rights reserved.

This product contains proprietary and confidential technology, information
and creative works owned by Flexera Software LLC and its licensors, if any. Any
use, copying, publication, distribution, display, modification, or transmission of
such technology in whole or in part in any form or by any means without the
prior express written permission of Flexera Software LLC is strictly prohibited.
Except where expressly provided by Flexera Software LLC in writing,
possession of this technology shall not be construed to confer any license or
rights under any Flexera Software LLC intellectual property rights, whether by
estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures,
click File menu --> Help --> About Tekla Structures --> 3rd party licenses
and then click the option.

The elements of the software described in this Manual are protected by
several patents and possibly pending patent applications in the United States
and/or other countries. For more information, go to page http://
www.tekla.com/tekla-patents.

Disclaimer 1120

http://www.tekla.com/tekla-patents
http://www.tekla.com/tekla-patents


Index

4
401 Unauthorized

troubleshooting...................................1118

A
accessing

cut list dialog box.................................. 804
accessories...................................................367

adding to estimating job...................... 492
job-specific............................................. 492
reports....................................................371

additional labor...........................................490
address book...............................................141

adding contacts..................................... 145
adding companies.................................143
adding firms...........................................143
deleting companies...............................149
deleting contacts...................................149
exporting companies and contacts.....149
finding companies................................ 142
finding contacts.....................................142
importing contacts................................147
modifying company properties...........146
modifying contact properties.............. 146
viewing firm types................................. 143

administration settings
defining.....................................................77

advance bills of materials
creating...................................................313

advance shipment notices.........................963
Advance Steel

exporting production status................ 944
assemblies............................................397,400

adding.....................................................494
importing................................................231

automated events.......................................233

B
Bluebeam

importing into Estimating.................... 515
burning

burn times..............................................427
burn types..............................................428
creating burn rate lists......................... 428
reports....................................................428
viewing burn rates................................ 428

C
categories and sub-categories

for Estimating........................................ 356
categories and sub-categories

for Production control.......................... 784
change orders

creating...................................................684
deleting...................................................684
modifying............................................... 684
reports....................................................692

change order reports................................. 692
change orders

introduction........................................... 683
printing................................................... 691
viewing....................................................690

charge processes
adding...................................................1079
deleting................................................ 1079
modifying............................................. 1079

check list items............................................599
check list reports.........................................701
check list items

modifying............................................... 699
check list items

adding.....................................................698
deleting from projects.......................... 700

Check list
adding items.......................................... 698
adding steps.......................................... 599

1121



deleting items from projects................700
deleting steps........................................ 599
introduction........................................... 698
modifying steps.....................................599
modifying items.....................................699
reports....................................................701
sending items to task list......................699

CIS/2
exporting production control jobs...... 944

client............................................................... 46
clips...............................................................490
CNC files.......................................................893
column splices

labor times.............................................401
combining jobs

creating...................................................313
combining job

combining optimizations......................316
combining optimizations

for Combining........................................303
for Estimating........................................ 358
for estimating jobs................................ 463
for Order Entry.................................... 1075
for Production Control......................... 779
for Requisitions..................................... 950
requisitions............................................ 978

Combining company standard settings
combining optimizations......................303

Combining company standard settings... 301
default suppliers................................... 307
input and display units.........................302

combining filters......................................... 261
combining items

loading all items into a requisition......346
loading all items into a purchase order....
348
loading selected items into a purchase
order....................................................... 348
loading selected items into a requisition
.................................................................347
modifying............................................... 331
modifying a single item........................ 331
modifying multiple items..................... 332
modifying selected items..................... 332
modifying shape, grade, dimensions, or
length of items...................................... 333
modifying shape, grade, dimensions, or
length of selected items....................... 334

combining jobs
adding material items...........................328
copying................................................... 309
copying pages of items.........................335
defining suppliers................................. 320
deleting...................................................308
exporting................................................ 309
filtering items.........................................324
KISS export.............................................350
managing........................................ 308,328
merging.................................................. 310
modify input and display units............321
modifying............................................... 327
opening.................................................. 322
renumbering..........................................310
setting job groups................................. 311
setting job statuses...............................311
viewing list of changes..........................325

Combining module
introduction........................................... 300
opening.................................................. 312

combining optimizations
for combining jobs................................316

combining reports
printing................................................... 351
viewing....................................................351

combining run reports
exporting................................................ 345
printing................................................... 345
viewing....................................................345

Combining
comparing combining runs..................344
finding jobs............................................ 321
loading items to purchasing................ 346
multing and nesting materials.............335
setting up............................................... 300
troubleshooting...................................1110

companies
deleting...................................................149
export..................................................... 149

company information
adjusting...................................................74

company standard settings
for Combining........................................301

company standard settings
for Purchase Order............................... 957

company standard settings
for Estimating........................................ 353

1122



for Inventory.......................................... 528
company standard settings

for Requisition....................................... 948
company standard settings

for Order Entry.................................... 1071
for Production control.......................... 769
for Project Management...................... 582

configurations............................................. 129
contacts

adding.....................................................145
deleting...................................................149
export..................................................... 149

contract items..............................................752
contract information........................... 751,752
copes

labor times.............................................402
cost codes.................................................... 973
creating

cut lists....................................................808
credits

adding...................................................1106
critical length and width differences........ 792
currencies.................................................... 223
customized reports

creating...................................................268
customized reports

Crystal Reports...................................... 268
Stimulsoft............................................... 268

customizing
dialog box layout...................................258
display fields.......................................... 251
input fields............................................. 253
menu options........................................ 256
report lists..............................................263

cut list
revalidating items..................................813
validating items..................................... 813

cut list
creating...................................................806
deleting...................................................817
sharing....................................................814

cut lists
viewing....................................................809

cut list dialog box
accessing................................................ 804

cut list items
taking from stock.................................. 915

cut lists

adjusting.................................................863
creating........................................... 808,863
importing from ProNest....................... 578
job-specific............................................. 863
managing............................................... 804
reviewing................................................ 863
swapping items..................................... 810

cut list
changing required date

sharing..............................................812
creating a report....................................815
locking.................................................... 812
locking or unlocking..............................814
updating................................................. 812

D
database backup and restore settings

defining.....................................................77
database

compressing.......................................... 112
default directories.........................................46

setting....................................................... 38
Default Directories........................................39
deliveries

adding...................................................1107
dialog box layout

customizing............................................258
dimensions

adding.....................................................188
adding alternate dimensions...............194
adding to pricing............................202,203
copying pricing...................................... 203
deleting...................................................195
deleting pricing information................ 204
managing............................................... 186
modifying properties............................ 190
modifying properties of multiple
dimensions............................................ 192
pricing.....................................................202
updating weights...................................192
viewing where dimensions are used.. 194

display fields
customizing............................................251

display units
changing.................................................199

Document Index
adding emails........................................ 153

1123



adding document references.............. 153
adding email attachments................... 153
settings standard categories............... 150

Document Index
accessing................................................ 327
for Project management...................... 618
for requisitions...................................... 986

Document Index
attaching document references to emails
.................................................................160
deleting documents..............................159
for Estimating........................................ 481
for Inventory.......................................... 538
for purchase orders............................1023
managing categories............................ 152
managing document references......... 149
managing files in................................... 850
modifying document references.........158
opening documents..............................159
viewing changes.................................... 161

document reference
viewing history.......................................161

document sending methods..................... 603
drawing logs................................................ 623
drawing reports...........................................641
drawing revisions........................................ 634
drawing logs

viewing....................................................625
drawing files

copying................................................... 637
drawing logs................................................ 607

updating links........................................ 640
drawings on hold

setting.....................................................643
drawings

adding.....................................................628
adding multiple drawings............. 630,631
approval status.............................. 597,800
copying drawing files............................ 637
copying materials..................................906
deleting...................................................628
importing status information.............. 761
introduction........................................... 621
issue history...........................................641
managing drawing logs........................ 607
modifying................................ 628,632,633
opening.................................................. 628
printing................................................... 638

project-specific settings........................621
reports....................................................641
revisions................................................. 634
search..................................................... 627
updating links to drawing log.............. 640
viewing drawing files............................ 628

drilling
creating drill rate lists........................... 431
drill types................................................431
labor times.............................................429
reports....................................................431
viewing drill rates.................................. 431

E
emergency use............................................ 133
estimate extras

creating...................................................402
formulas................................................. 383

estimate statuses........................................438
estimating items

copying................................................... 499
modifying............................................... 497
multiplying............................................. 499

estimating jobs
calculating.............................................. 480
modifying............................................... 481

estimating items
loading into another estimate.............509
loading into Production control.......... 511

estimating jobs
creating...................................................454
defining combining optimizations...... 463
linking to Trimble Connect................... 520

estimating items
multiplying selected items................... 501

Estimating company standard settings
categories and sub-categories............ 356
combining optimizations......................358

Estimating company standard settings
galvanizing............................................. 355
input and display units.........................358
suppliers.................................................362

Estimating company standard settings....353
estimating filters......................................... 261
estimating items......................................... 483

adding.....................................................483
color-coding in Trimble Connect......... 522

1124



copying................................................... 499
copying and multiplying a group of items
.................................................................500
copying pages of items.........................500
deleting...................................................502
filtering................................................... 472
loading into requisitions...................... 506
loading into a purchase order............. 507
loading items into Purchasing............. 506
loading selected items into purchase
orders..................................................... 509
loading selected items into a purchase
order....................................................... 508
loading to other jobs............................ 505
modifying selected items..................... 499
modifying multiple items..................... 498
modifying single items......................... 497
multing and nesting..............................513
multiplying all items in sub-categories....
501
search..................................................... 496
selecting in Trimble Connect............... 523
viewing labor details............................. 474
viewing labor time......................... 474,475

estimating jobs
adding accessories................................492
adding items.......................................... 483
adding assemblies................................ 494
adding parametric assemblies............ 495
calculating total material costs............480
copying................................................... 364
copying items.........................................499
copying and multiplying items............ 500
creating job-specific accessories.........492
defining markups.................................. 468
defining suppliers................................. 466
defining input and display units..........467
deleting...................................................363
estimate statuses.................................. 438
export..................................................... 364
exporting to KISS...................................517
filtering items.........................................472
job-specific galvanizing settings.......... 468
linking to project management jobs...470
list of changes........................................476
managing............................................... 363
managing items.....................................483
merging.................................................. 365

modifying items.....................................497
opening.................................................. 471
recalculating total values..................... 481
renumbering..........................................365
searching................................................471
setting job groups................................. 366
setting job status...................................366
viewing details....................................... 473
viewing all changes............................... 476
viewing in Trimble Connect..................520
visualizing...............................................937

Estimating module
opening.................................................. 453
setting up............................................... 353

Estimating
accessories..................................... 367,492
adding materials................................... 483
additional labor..................................... 490
adjusting labor information.................394
assemblies............................................. 397
burn times..............................................427
burn types..............................................428
calculating jobs......................................480
cleaning costs

cleaning systems............................. 386
cleaning maintenance.......................... 386
cleaning types........................................386
clips.........................................................490
column splices.......................................401
copes...................................................... 402
copying jobs...........................................364
creating jobs.......................................... 454
default paint types................................ 389
default paint systems........................... 389
deleting jobs.......................................... 363
drill times............................................... 429
drill types................................................431
estimate extras......................................402
export..................................................... 515
exporting jobs to KISS...........................517
extrapolation factors............................ 406
fabricator information..........................439
import.....................................................515
inbound freights....................................392
introduction........................................... 353
labor codes............................................ 407
labor standards..................................... 417
labor rates..............................................445

1125



labor groups.......................................... 411
labor operation settings.......................442
labor operations....................................414
managing assemblies........................... 400
markup percentages.............................443
paint maintenance................................389
parametric assemblies......................... 373
parametric assemblies......................... 373
production codes.................................. 505
production codes.................................. 502
proposals............................................... 524
punch types........................................... 433
punching times......................................432
punhes....................................................402
quantity labor factors........................... 422
reports....................................................478
searching for jobs..................................471
setting up proposals............................. 451
shop setups........................................... 449
shop setups........................................... 446
standard clips........................................ 424
stiffeners................................................ 402
weight labor factors..............................422
weld types.............................................. 436
welding times........................................ 435

export
CNC files...............................................1057
from Project management...................760
labor information..................................517
parametric assemblies......................... 382
part drawings...................................... 1057
production control information.......... 943
production status..................................943
production control jobs........................943
production control jobs........................791
production control jobs to CIS/2......... 944
production control jobs to KISS...........943
production status to SDS/2..................945
production status to Advance Steel....944
production status to Tekla Structures 944
production status to Trimble Connect763
project schedule to XML.......................734
RFIs..........................................................672

external users
adding.......................................................65
deleting.....................................................65
modifying................................................. 65
resetting passwords................................65

extrapolation factors.................................. 406

F
fabricator information................................439
firm types.....................................................143
FOB shipping destinations.........................969
formulas.......................................................383
freight pricing.............................................. 392
for Production control

input and display units.........................779

G
galvanizing settings

job-specific............................................. 468
grade abbreviations

adding.....................................................184
deleting...................................................184
modifying............................................... 184

grades
adding.....................................................182
adding grade overrides........................ 193
adding grade redirections....................185
adding grade substitutions.................. 184
deleting...................................................182
managing............................................... 180
modifying............................................... 182

H
heat certificate traceability...................... 1068
heat documents

viewing................................................. 1040
history of changes.......................................862

I
IFC

importing into Estimating.................... 515
imperial mode

selecting................................................. 262
importing files............................................. 226
importing IFC files.......................................349
import

assemblies............................................. 231

1126



drawing status information................. 761
parametric assemblies......................... 231
pricing lists............................................. 214
RFIs..........................................................672
to Project management........................760
translating unknown shapes and grades
.................................................................232

indexterm.............................. 23,811,815,1078
initial settings.............................................. 140
input and display units

for Requisitions..................................... 949
input and display units

for Inventory.......................................... 530
for requisitions...................................... 982
for Combining........................................302
for Estimating........................................ 358
for estimating jobs................................ 467
for Order Entry.................................... 1074
for Purchasing....................................... 963

input fields
customizing............................................253

inspection tests....................................868,869
modifying setup.................................... 873

inspection status.........................................877
inventory items

loading to Order Entry..........................553
multing manually.................................. 556
nesting manually...................................556

inventory reports
exporting................................................ 573
printing................................................... 573
viewing....................................................573

inventory history
opening.................................................. 536

inventory items
returning material to stock.................. 549
taking from stock.................................. 549

inventory location
changing.................................................553

Inventory company standard settings..... 528
Inventory company standard settings

input and display units.........................530
Inventory default settings..........................528
inventory items

adding.....................................................538
copying................................................... 548
defining serial numbers....................... 546
deleting...................................................555

modifying single items......................... 546
Inventory module

opening.................................................. 532
Inventory

adding items.......................................... 538
adding load............................................ 551
archiving jobs.........................................579
checking heat documents....................561
countries of origin.................................531
export..................................................... 575
exporting inventory transactions to
Timberline..............................................576
exporting to KSTK..................................576
exporting to SigmaNest........................577
exporting to XML...................................577
filter settings..........................................534
filtering................................................... 534
import.....................................................575
importing from HTML...........................578
importing from Microsoft Excel...........579
importing ProNest cut lists.................. 578
list of changes........................................571
location sweeps.....................................563
managing items.....................................538
modifying items.....................................545
modifying multiple items..................... 547
modifying selected items..................... 548
moving items to another location.......553
reorder quantities................................. 558
restrict locations....................................531
search..................................................... 535
setting up............................................... 528
stock quantities..................................... 558
storing document references.............. 538
synchronizing with ProNest................. 578
taking selected materials from stock..551
transaction history................................568
value of materials..................................565
viewing details....................................... 560
viewing all changes in transaction history
.................................................................571
viewing and printing TFS reports........ 573
viewing heat documents...................... 561
viewing location of barcoded materials....
563

invoice categories
adding...................................................1081
deleting................................................ 1081

1127



modifying............................................. 1081
invoices........................................................ 751

adding...................................................1104
creating...................................................755
deleting...................................................755
exporting..............................................1105
invoice documents................................755
invoice reports.......................................755
modifying............................................... 755
printing................................................... 755

J
job status

setting.....................................................792
job status

setting.....................................................311
job groups

for estimating jobs................................ 366
for Production Control......................... 791
for Project Management...................... 602

job maintenance
for Estimating........................................ 363
for Requisitions..................................... 955
for Combining........................................308
for Production Control......................... 789
for Project Management...................... 600

job statuses
for Project Management...................... 603

job status
for estimating jobs................................ 366
maintenance..........................................219

journal entries
adding.....................................................677
deleting...................................................677
modifying............................................... 677

Journal
adding entries........................................677
deleting entries..................................... 677
introduction........................................... 676
modifying entries.................................. 677
reports....................................................681

K
kerf..............................................................1068
KISS

exporting estimating jobs.............364,517
exporting production control jobs...... 943
importing into Estimating.................... 515

KTSK
exporting inventory.............................. 576

L
labor codes.................................................. 407
labor groups................................................ 411
labor operations..........................................414
labor standards...........................................417
labor time

calculating.............................................. 395
introduction........................................... 395

Labor codes................................................. 396
labor hours

comparing between production control
and estimating jobs.............................. 885

labor information
adjusting.................................................394
importing................................................518

labor operation settings.............................442
labor operation list..................................... 414
labor rates....................................................445
labor time.....................................................475
language

changing.................................................139
lengths

pricing.....................................................205
load tracking

adding records.......................................823
adding records to particular jobs........927

load
adding inventory................................... 551

loads
adding items.......................................... 926
creating...................................................919
deleting...................................................919

locations.......................................................531
log tables

clearing...................................................113
lots................................................................ 904

M
Maintenance

1128



job status................................................219
managing changes

Production Control jobs....................... 854
markup percentages.................................. 443
markup percentages.................................. 468
material finishes..........................................801
material costs.............................................. 480
material database

exporting shapes...................................177
find dimensions.....................................163
find shapes.............................................163
find grades............................................. 163
managing shapes.................................. 163
setting up............................................... 161
shape abbreviations............................. 163

material links
verifying..................................................912

material reports
creating...................................................196
exporting................................................ 198
managing............................................... 196
printing................................................... 197
sending via email.................................. 198
viewing....................................................197

metric mode
selecting................................................. 262

Microsoft Excel
importing into Estimating.................... 515

Microsoft Excel
importing contacts to address book...147

Microsoft Outlook
importing contacts to address book...147

migrating Tekla PowerFab
to a new server......................................124

modifying
combining items....................................331
Stimulsoft report................................... 278
Stimulsoft reports................................. 276

module-wide filters.....................................261
multing and nesting

customized extensions...........................89
multing and nesting

estimating items....................................513
requisition items manually................ 1008

multing and nesting
comparing combining runs..................344
in Production Control........................... 917
inventory items manually.................... 556

modifying groups of items in run-specific
pricing.....................................................339
modifying run-specific pricing
information............................................337
recombining all items........................... 341
recombining all items........................... 343
recombining items of a shape.............342
recombining items of a material grade....
342
recombining material dimensions......343
reloading information.......................... 343
renaming combining runs....................336
requisition items................................. 1007
viewing combining run filter settings. 337

O
online access

missing................................................... 133
Order Entry company standard settings1071
Order Entry company standard settings

input and display units.......................1074
suppliers...............................................1078

Order Entry company standard settings
combining optimizations................... 1075

Order Entry module
opening................................................ 1089

Order Entry
adding credits......................................1106
charge processes................................ 1079
filtering................................................. 1090
loading inventory items........................553
payment terms....................................1085
payment methods.............................. 1084
price groups.........................................1083
sending items to purchasing............. 1100
setting up............................................. 1071
territory options..................................1088

order repots.............................................. 1108
orders

adding deliveries.................................1107
adding order details........................... 1094
adding payments................................ 1106
converting into quotes....................... 1103
converting quotes into orders...........1103
copying................................................. 1101
creating....................................... 1070,1092
invoice categories............................... 1081

1129



managing....................................1070,1091
modifying............................................. 1102
order categories..................................1082

outgoing email settings..............................233

P
parametric assemblies............................... 373
parametric assemblies

creating...................................................373
example..................................................378
formulas................................................. 383
testing.....................................................373

parametric assemblies
adding to jobs........................................495
deleting...................................................383
exporting................................................ 382
importing................................................231
modifying............................................... 381

password policy
defining.....................................................77

passwords
changing.................................................132
setting.....................................................132

pay categories............................................. 786
payment methods

adding...................................................1084
deleting................................................ 1084
modifying............................................. 1084

payment terms
for customer orders........................... 1085
for purchase orders.............................. 970

payments
adding...................................................1106

piece tracking
adding records to particular jobs........927

piece tracking records................................ 931
piece tracking.............................................. 931

adding records.......................................823
price groups...............................................1083
pricing forms............................................... 211
pricing history........................................... 1042
pricing lists...................................................212

import.....................................................214
modifying in Microsoft Excel..............1002

Pricing Maintenance
opening.................................................. 200
updating pricing from requisitions... 1005

pricing reports.............................................212
pricing sets

adding.....................................................217
pricing

adding lengths.......................................205
adding dimensions............................... 203
adding pricing sets................................217
adding single dimensions.................... 202
adding special prices............................ 208
adding supplier warehouses............... 217
copying dimensions from one grade to
another...................................................203
deleting dimensions from pricing....... 204
finding dimensions............................... 201
finding shapes....................................... 201
finding grades........................................201
managing dimensions.......................... 202
modifying............................................... 204
modifying lengths................................. 204
modifying pricing of multiple items....208
search..................................................... 201
setting up............................................... 199

printing
setting the default printer....................298

Production control
export..................................................... 943
routes..................................................... 793
stations...................................................793

production reports
global...................................................... 828

production codes
for Estimating........................................ 502
global...................................................... 802

Production control
creating jobs.......................................... 833
drawing approval status.......................800
managing changes................................854
purchasing reports................................828
routes..................................................... 797

production reports..................................... 830
job-specific............................................. 891

production schedule
modifying resource capacity................889

production schedule
viewing....................................................886

production status................................ 827,866
export..................................................... 944

production tracking

1130



by piece mark........................................ 931
production codes

applying..................................................505
for Production control.......................... 865

Production control company standard
settings.........................................................769

categories and sub-categories............ 784
combining optimizations......................779
load tracking.......................................... 787

production control items
taking from stock.................................. 913

production control jobs
adding loads.......................................... 927
adding load tracking records............... 927
adding piece tracking records............. 927
combining optimizations

for production control jobs............839
creating...................................................833
defining combining optimizations...... 839

production control items
adding.....................................................896
color-coding in Trimble Connect......... 935
linking to purchasing............................ 910
loading all items into purchase orders....
907
loading all items into requisitions.......908
loading selected items into purchase
orders..................................................... 909
loading selected items into requisition....
910
modifying multiple items..................... 902
modifying selected items..................... 903
search..................................................... 849
unlinking materials from Purchasing..911

production control jobs
copying................................................... 790
exporting................................................ 791
filtering items.........................................848
finalizing................................................. 946
modifying............................................... 851
search..................................................... 845
suppliers.................................................843

Production control company standard
settings

input and display units.........................779
pay categories....................................... 786
suppliers.................................................783

production control filters........................... 261

production control items
adding to loads......................................926
copying from one drawing to another906
filtering................................................... 848
managing............................................... 895
material links......................................... 867
modifying............................................... 901
production codes.................................. 865
removing all items from sequences....905
removing from sequences................... 906
reviewing production statuses............ 866
selecting in Trimble Connect............... 936
sending to Purchasing.......................... 907
setting sequences................................. 904
verifying material links to Purchasing 912

production control jobs
adding loads.......................................... 823
adding items.......................................... 896
adding load tracking records............... 823
adding piece tracking records............. 823
attached CNC files.................................893
comparing labor hours to estimating
jobs......................................................... 885
comparing materials to combining jobs
.................................................................884
defining input and display units..........844
deleting...................................................790
exporting to CIS/2................................. 944
exporting to a KISS................................943
history of changes.................................862
input and display units

for production control jobs............844
linking to project management jobs...844
linking to Trimble Connect................... 933
list of changes........................................860
managing............................................... 789
modifying job information...................863
opening.................................................. 846
reviewing inspection status................. 877
reviewing job information....................863
reviewing production statuses............ 827
sending items to Purchasing............... 907
setting job statuses...............................792
setting job groups................................. 791
unlinking materials from Purchasing..911
viewing in Trimble Connect..................933
viewing details....................................... 853
visualizing...............................................937

1131



Production control module
opening.................................................. 832
setting up............................................... 768

Production control
checking purchase orders for received
materials................................................ 912
copying jobs...........................................790
deleting jobs.......................................... 790
global reports........................................ 828
inspection test records..................868,869
introduction........................................... 768
job-specific reports............................... 891
loads....................................................... 919
modifying items.....................................901
reports....................................................830
shipping routes......................................817
viewing job details.................................853

Production dashboard
launching from Tekla PowerFab Office....
852

production schedule
setting up............................................... 586

Production status
exporting to Advance Steel.................. 761
exporting to SDS/2.........................762,945
exporting to Tekla Structures.............. 761
exporting to Trimble Connect..............763

program errors
repairing................................................. 119

Project Management
drawing approval status.......................597
managing companies........................... 644
managing contacts................................644
reports.............................................609,763

project reports.............................................609
project schedule

baselines................................................ 704
example..................................................736
modifying Gantt chart.......................... 724
schedule templates...............................587
time-tracking..........................................741

project summaries......................................765
project tasks................................................ 619
Project management

adding multiple drawings............. 630,631
deleting jobs.......................................... 601
introduction........................................... 581
job groups.............................................. 602

job statuses............................................603
project schedule

creating...................................................702
modifying............................................... 702
settings................................................... 586
viewing....................................................702

project snapshots
saving......................................................710
viewing....................................................710

project baseline...........................................704
project check list......................................... 698
project companies...................................... 644
project journal.............................................676
project journal reports............................... 681
project management jobs

managing............................................... 619
project management job

drawing logs...........................................623
project management jobs

creating...................................................612
project management reports.................... 763
project management jobs

deleting...................................................601
drawing settings.................................... 621
linking to estimating jobs..................... 470
linking to production control jobs.......844
managing............................................... 600
opening.................................................. 616

Project management module
setting up............................................... 581

Project Management company standard
settings.........................................................582
project management filters....................... 261
project management jobs

adding contacts..................................... 614
setting job statuses...............................603

Project Management module
opening.................................................. 611

Project Management
creating projects....................................612
import and export.................................760
job groups.............................................. 602
opening jobs.......................................... 616
project management jobs....................601
renaming................................................601
renaming projects................................. 601
searching for projects...........................616
storing documents................................618

1132



project schedule
applying schedule templates...............733
breakdown items.................................. 718
edit mode...............................................703
exporting to XML...................................734
reports....................................................735
saving schedule tasks as templates....717
schedule calendars............................... 595
schedule tasks....................................... 711
setting up............................................... 586
snapshots...............................................710
updating................................................. 733

ProNest
exporting plates for nesting...................91
importing inventory................................ 91
inventory sync....................................... 578
sending work orders...............................91
setting up................................................. 91
synchronizing inventory......................... 91

proposals
creating...................................................524
creating standard setups..................... 451

punching
creating punch rate lists.......................434
labor times......................................402,432
punch types........................................... 433
reports....................................................434
viewing puch rates................................ 434

purchase orders
advance shipment notices................... 963
creating................................................ 1014
creating global receiving reports.........965
creating job-specific receiving reports....
1052
exporting..............................................1053
FOB shipping destinations................... 969
loading items from requisitions.......... 998
purchase order types............................967
purchase order remarks...................... 971
top text items.........................................972
transaction history..............................1047

purchase history....................................... 1042
purchase orders

modifying............................................. 1022
settings................................................... 957

purchase history
of requisition items...............................995

purchase order items

adding...................................................1024
finalizing............................................... 1044

purchase order reports............................1050
purchase order items

copying................................................. 1032
copying to another purchase order..1033
filtering................................................. 1021
modifying multiple items................... 1029
modifying shapes, grades, dimensions,
or lengths of selected items.............. 1032

Purchase Order company standard settings
.......................................................................957
purchase order filters.................................261
purchase order items

modifying shape, grade, dimensions, or
length....................................................1030

purchase order items
deleting................................................ 1045
modifying............................................. 1028
modifying a single item...................... 1028
modifying selected items...................1030
pricing history......................................1042
purchase history................................. 1042
sending to requisitions.......................1042
unreceiving.......................................... 1039

purchase order remarks............................ 971
purchase order settings............................. 957
purchase order types................................. 967
purchase order

searching..............................................1019
purchase orders

adding items manually.......................1024
approving............................................. 1058
checking for received materials.......... 912
copying items to another purchase order
...............................................................1033
deleting................................................ 1059
deleting items......................................1045
exporting as reports........................... 1050
filtering items...................................... 1021
introduction......................................... 1013
list of changes......................................1046
loading all production control items...907
loading selected production control
items....................................................... 909
locking.................................................. 1058
modifying items.................................. 1028
opening................................................ 1019

1133



payment terms...................................... 970
receiving items.................................... 1033
sending items to requisitions............ 1042
shipping methods................................. 968
storing documents..............................1023
unfinalizing items................................1045
unlocking..............................................1059
unreceiving items................................1039
viewing heat documents.................... 1040

purchaser order items
receiving...............................................1033

purchasing reports..................................... 828
job-specific............................................. 916

Purchasing company standard settings
input and display units.........................963

Purchasing
cost codes.............................................. 973
exporting CNC files............................. 1057
exporting part drawings.....................1057
introduction........................................... 947
linking production control items.........910
loading estimating items......................506
setting up............................................... 947

Q
quantity labor factors.................................422
quote reports............................................ 1108
quotes

adding deliveries.................................1107
adding quote details...........................1094
converting into orders........................1103
converting orders into quotes...........1103
copying................................................. 1101
creating................................................ 1092
creating quick quotes......................... 1101
deleting................................................ 1104
managing............................................. 1091
modifying............................................. 1102
quote categories................................. 1082

R
receiving reports

global...................................................... 965
job-specific...........................................1052

recovering deleted jobs..............................114

regular expressions.................................... 750
remote permissions

managing..................................................68
replicas........................................................... 74
replication settings........................................74
report lists

customizing............................................263
requests for pricing

exporting..............................................1000
requisition items

loading into purchase orders.............. 998
requisition items

adding manually....................................986
copying................................................... 994
modifying............................................... 990
modifying shape, grade, dimensions, or
length......................................................992
modifying shape, grade, dimensions, or
length of selected items....................... 994
viewing purchase history..................... 995

Requisition company standard settings
combining optimizations......................950

Requisition company standard settings...948
input and display units.........................949
suppliers.................................................953

requisition filters.........................................261
requisition items

deleting...................................................995
modifying a single item........................ 990
modifying multiple items..................... 991
modifying selected items..................... 992
multing and nesting............................1007
multing and nesting manually...........1008

requisition reports...................................... 954
job-specific...........................................1009

requisition settings..................................... 947
requisition

defining suppliers................................. 981
requisitions

adding items.......................................... 986
copying................................................... 956
creating...................................................975
defining combining optimizations...... 978
deleting......................................... 956,1012
exporting requests for pricing...........1000
global reports........................................ 954
introduction........................................... 974
job-specific reports............................. 1009

1134



list of changes........................................997
loading all production control items...908
loading items into purchase orders....998
loading selected production control
items....................................................... 910
managing............................................... 955
modifying............................................... 985
modifying pricing lists in Microsoft Excel
...............................................................1002
multing and nesting items................. 1007
multing and nesting items manually1008
opening.................................................. 983
pricing import......................................1002
searching................................................983
settings................................................... 947
storing document references.............. 986
updating pricing to Pricing maintenance
...............................................................1005

requisiton pricing
import...................................................1002

requistions
modifying items.....................................990

resources
modifying capacity................................ 889

returns........................................................1108
RFI reports................................................... 674
RFIs

adding recipients...................................662
attaching files........................................ 662
creating...................................................662
deleting...................................................662
export..................................................... 672
import.....................................................672
introduction........................................... 661
modifying............................................... 662
printing................................................... 671
reports....................................................674
saving as Microsoft Word documents 673
sending via email.................................. 673
viewing....................................................670

routes....................................................793,797
run-specific pricing

modifying groups of items...................339

S
Sage 300 CRE

exporting purchase orders................ 1053

schedule tasks.............................................711
schedule templates.................................... 587
schedule tasks

saving as templates.............................. 717
SDS/2

exporting product status......................945
searching

job........................................................... 321
production control jobs........................845
project management jobs....................616
purchase orders.................................. 1019
requisitions............................................ 983

sequences....................................................903
adding items.......................................... 905
managing............................................... 904
removing all items.................................905
removing multiple items...................... 906
setting.....................................................904
updating................................................. 904

server installation......................................... 39
settings

adjusting...................................................74
shape abbreviations

adding.....................................................176
deleting...................................................176
modifying............................................... 176

shapes
activating................................................175
adding.....................................................166
deactivating............................................175
deleting...................................................166
exporting................................................ 177
managing............................................... 163
modifying............................................... 166
splitting...................................................170
updating dimension weights............... 192
viewing dimensions.............................. 188

shipping methods
adding...................................................1087
deleting................................................ 1087
modifying............................................. 1087

shipping routes
global...................................................... 817
job-specific............................................. 878
manage destinations............................ 820

shipping methods
for purchase orders.............................. 968

Shipping calendar

1135



launching from Tekla PowerFab Office....
852

shipping
top text items.........................................822

shop setups
changing active setup...........................448
changing default setup.........................448
creating...................................................446
deleting...................................................449
modifying............................................... 446

SigmaNest
exporting inventory.............................. 577

software integrations
managing..................................................84
setting up................................................. 84

special prices............................................... 208
spell-checking

adjusting settings.................................... 82
disabling................................................... 82
enabling....................................................82
performing spell checks......................... 82

splice packages
introduction......................................... 1060
kerf........................................................1068

splice packages
add or remove parts...........................1065
add or remove items.......................... 1065
check before splicing.......................... 1061
create new package............................ 1061
delete....................................................1065
heat certificates...................................1068
merge................................................... 1065
split....................................................... 1065
view and modify..................................1065

standard clips.............................................. 424
standard text items

for transmittals......................................606
stations.........................................................793

field stations.......................................... 794
production stations...............................794

Steel Projects PLM
exporting cut lists..................................102
sending work orders.............................102
setting up............................................... 102

stiffeners
labor times.............................................402

Stimulsoft report
adding fields.......................................... 278

adding images....................................... 285
adding watermarks...............................285
data band...............................................281
Group headers and footers................. 282
moving fields

adjusting field size...........................278
Stimulsoft reports

adding a checkbox................................ 291
creating rows......................................... 290
events..................................................... 286
modifying............................................... 276
ODBC data source.................................294
record count

row count......................................... 290
Sub-Reports........................................... 283
variables................................................. 287

supplier warehouses
adding.....................................................217

suppliers
for Estimating........................................ 362
for Requisitions..................................... 953
for Combining........................................307
for combining jobs................................320
for estimating jobs................................ 466
for Order Entry.................................... 1078
for Production control.......................... 783
for production control jobs..................843
for requisitions...................................... 981

support ticket
creating...................................................298

support tool.................................................298
support

contacting...............................................298
switching units............................................ 262
system requirements....................................37

T
take from stock

details..................................................... 881
Task list

reports....................................................696
task list items

creating...................................................694
deleting...................................................694
modifying............................................... 694

task list reports............................................696
Task list

1136



assigning tasks...................................... 619
creating items........................................ 694
deleting items........................................694
introduction........................................... 693
managing tasks..................................... 619
modifying items.....................................694

tax groups.................................................... 222
tax rates....................................................... 220
taxes and currencies...................................220
Tekla PowerFab

installing.............................................. 36,46
Tekla Warehouse...........................................89
Tekla PowerFab database

managing............................................... 110
Tekla PowerFab users

managing..................................................57
Tekla PowerFab database

restoring.................................................111
Tekla PowerFab Office database

backing up..............................................110
Tekla PowerFab Office

introduction........................................... 128
setting up................................................. 50
system requirements..............................37

Tekla PowerFab Remote Server
installing................................................... 41
setting up................................................. 41
starting..................................................... 41

Tekla PowerFab settings..........................74,77
Tekla PowerFab users

adding.......................................................54
deleting.....................................................54
modifying................................................. 54
resetting passwords................................54

Tekla PowerFab
customizing............................................250
installing.............................................. 38,39
signing in................................................ 130
updating................................................... 51

Tekla Structures
exporting production status................ 944

territories
adding...................................................1088
deleting................................................ 1088
modifying............................................. 1088

TFS details....................................................881
TFS reports

printing................................................... 573

viewing....................................................573
TFS

cut list items...........................................915
inventory items..................................... 549
production control items..................... 913
selected items........................................551

Timberline
exporting inventory transactions........576
exporting purchase orders................ 1053

time-tracking records................................. 741
time-tracking records

using regular expressions.................... 750
time-tracking

settings................................................... 740
top text items

for purchase orders.............................. 972
transaction history

for purchase orders............................1047
viewing....................................................568

transmittal items
creating...................................................604
deleting...................................................604
modifying............................................... 604

transmittal reports......................................659
transmittal purposes.................................. 605
transmittals

attaching drawings................................647
attaching files........................................ 647
creating...................................................647
creating items........................................ 604
creating reports.....................................659
deleting...................................................647
deleting items........................................604
document sending methods............... 603
introduction........................................... 646
marking drawings as received.............657
modifying............................................... 647
modifying items.....................................604
printing................................................... 657
purposes................................................ 605
sending via email.................................. 658
setting up............................................... 603
standard text items...............................606
viewing....................................................656

Trimble Connect
installing................................................... 48
linking estimating jobs..........................520
linking to Tekla PowerFab.......................84

1137



Trimble Connect Content Browser........... 937
Trimble Connect Organizer........................937
Trimble Connect Status Share

setting up................................................. 84
Trimble Connect Status Sharing

installing................................................... 48
Trimble Connect

adding projects........................................87
adding users to projects.........................88
color-coding estimating items............. 522
color-coding production control items....
935
exporting production status................ 763
linking to production control job.........933
selecting items.......................................936
selecting estimating items................... 523
viewing production control jobs..........933
viewing estimating jobs........................520

Trimble Identity
creating.....................................................38

Trimble ViewPoint
exporting purchase orders................ 1053

troubleshooting........................................ 1110
401 Unauthorized............................... 1118

TXT
exporting parametric assemblies....... 382

U
updating Tekla PowerFab

on client machines.................................. 52
on the server............................................51

user permissions
viewing the user permissions report.... 60

user preferences......................................... 297
User access

troubleshooting...................................1118
user interface.............................................. 136
user permissions

managing..................................................57
user roles

adding.......................................................61
deleting.....................................................61
managing..................................................57
managing permissions........................... 61
modifying................................................. 61

users
forcing shutdown.................................... 54

viewing currently signed in users..........53

V
Viewpoint

exporting job costing transactions......104
exporting purchase orders.................. 104
inventory summary reports.................104
setting up............................................... 104

W
weight labor factors....................................422
welding

creating weld rate lists..........................437
labor times.............................................435
reports....................................................437
viewing weld rates.................................437
weld types.............................................. 436

workstations
adding.......................................................72
deleting.....................................................72
modifying................................................. 72

1138


	Contents
	1 Tekla PowerFab 2023 release notes
	1.1 Manage changes to a production control job
	1.2 Add inventory to load
	1.3 Quick access to dashboards
	1.4 Set mill of origin for material
	1.5 Swap bars in Tekla PowerFab Go
	1.6 View next station and route in Tekla PowerFab Go
	1.7 Timer for piece tracking in Tekla
			PowerFab Go
	1.8 Tekla PowerFab and Tekla
			PowerFab Go 2023 fixlist

	2 Install Tekla PowerFab
	2.1 Tekla PowerFab license content
	2.2 Tekla PowerFab installation overview
	2.3 System requirements for Tekla PowerFab server
	2.4 System requirements for Tekla PowerFab client
	2.5 Create your Trimble Identity
	2.6 Default directories
	Set the default directories for saving files

	2.7 Install Tekla PowerFab on a server
	Install Tekla PowerFab on a server
	Default directories for server
	Set up Tekla PowerFab Remote Server for Tekla PowerFab Go
	Tekla PowerFab Remote Server
	Tekla PowerFab Remote Monitor
	Install Tekla PowerFab Remote Server
	Set up and start Tekla PowerFab Remote Server


	2.8 Install Tekla PowerFab on a client
	Install Tekla PowerFab on a client
	Default directories for client

	2.9 Install Trimble
				Connect
	Install Trimble Connect Status Sharing tool


	3 Manage Tekla PowerFab
	3.1 Update Tekla PowerFab
	Update server
	Update client
	View currently signed-in users
	Force shutdown

	3.2 Manage Tekla PowerFab users
	Access user data
	Add a user
	Reset a user's password
	Modify a user
	Delete a user

	3.3 Manage Tekla PowerFab user permissions
	User permissions dialog box
	Edit user permissions
	View the user permission report
	View the permissions of all users
	View the permissions of a selected user


	3.4 Manage Tekla PowerFab user roles
	Add a user role
	Assign a user role to a user
	Modify a user role
	Delete a user role

	3.5 Manage Tekla PowerFab external users
	Add an external user
	Reset an external user's password
	Modify an external user
	Delete an external user

	3.6 Manage Tekla PowerFab remote user permissions
	3.7 Manage Tekla PowerFab workstations
	Add a workstation
	Modify a workstation
	Delete a workstation
	Create replicas

	3.8 Manage Tekla PowerFab company information
	Add company information
	Set the default company
	Modify company information
	Delete company information

	3.9 Define Tekla PowerFab administration settings
	Define general administration settings
	Define database backup and restore settings
	Define password policy

	3.10 Adjust Tekla PowerFab spell-checking settings
	Enable spell-checking
	Perform spell-checking
	Disable spell-checking
	Switch to another spell-checking dictionary

	3.11 Set up and work with integrated software in
                Tekla PowerFab
	Link Tekla PowerFab to Trimble Connect
	Linking Tekla PowerFab to Trimble Connect
	Set up status sharing with Trimble Connect
	Add Trimble Connect projects
	Add users to Trimble Connect projects

	Use Tekla PowerFab together with Tekla Warehouse
	Use customized extensions for combining
	Add and save an extension
	Export materials for combining

	Manage inventory, cut lists, and nests with ProNest
	Integration requirements
	Set up Tekla PowerFab to work with ProNest
	Synchronize inventory information with ProNest
	Import ProNest inventory to Tekla PowerFab
	Import ProNest cut lists to Tekla PowerFab
	Update the inventory using a cut list
	Export plates to be nested in ProNest
	Import nesting results to Tekla PowerFab

	Mult and nest materials with Steel Projects PLM
	Set up Tekla PowerFab to work with Steel Projects PLM
	Send a work order to Steel Projects PLM
	Export a cut list to Steel Projects PLM

	Manage purchase orders with Trimble Viewpoint
	Set up the Trimble Viewpoint integration
	Export the selected purchase orders to Trimble Viewpoint
	Export purchase orders with receiving transactions to Viewpoint
	Export job costing transactions
	View the inventory summary report


	3.12 Manage the Tekla PowerFab database
	Save a backup copy of the Tekla PowerFab database
	Restore the Tekla PowerFab database
	Compress the Tekla PowerFab database
	Clear all information from log tables
	Recover deleted files
	Recover jobs
	Recover import backups


	3.13 Repair program errors
	Repair program errors from command prompt
	Prerequisites
	Repair the database from command prompt
	Example: MySQL is in the default location and the database is on the default port (3306)
	Example: MySQL is in the default location and the database is on port 3220
	Example: MySQL is on another drive or location and the database is on port 3220


	3.14 Migrate Tekla PowerFab to a new
            server
	1. Install Tekla PowerFab server
	2. Get the data from the old server
	3. Restore the data on the new server
	4. Migrate default directories to the new locations
	5. Update the connection and settings on the client machines
	6. Update Tekla PowerFab Connection


	4 Configure and use Tekla PowerFab
	4.1 Tekla PowerFab configurations
	4.2 Sign in to Tekla PowerFab
	Set or change your Tekla PowerFab password
	Emergency use when no access to online system
	Example: No internet access or loss of internet access
	Example: Your Trimble Identity is inactive or not created


	4.3 Tekla PowerFab user interface
	Change the user interface language

	4.4 Adjust the initial settings
	4.5  Manage the address book 
	Find companies or contacts
	Find companies
	Find contacts

	View firm types
	Add companies to the address book
	Add contacts to the address book
	Add a new contact person in the company properties
	Add a new contact person in the contact list

	Modify company or contact properties
	Import contacts to the address book
	Import contacts from Microsoft Outlook
	Import companies or contacts from Microsoft Excel

	Export companies or contacts
	Delete companies or contacts from the address book

	4.6 Document
			Index
	Set the standard categories for attached documents
	Add a category
	Rename a category
	Delete a category

	Manage Document Index categories
	Add document references
	Add new documents
	Add a Microsoft Outlook email
	Add an attachment from a Microsoft Outlook email
	Search for and add a document already in Document Index
	Browse for and add a document already in Document Index

	Edit a document reference
	Open a document
	Delete a document reference
	Attach a document reference to an email
	View Document Index history of changes

	4.7  Set up the material database
	Find shapes, grades, dimensions, or shape abbreviations
	Manage shapes
	Add, modify, and delete shapes
	Add a shape
	Modify a shape
	Delete a shape

	Split shapes
	Allow a shape to be split
	Create a split configuration
	Combining setup for split tees
	Example: Combine WTs to W in a requisition

	Activate or deactivate shapes
	Deactivate shapes
	Activate shapes

	Add, modify, and delete shape abbreviations
	Add a shape abbreviation
	Modify a shape abbreviation
	Delete shape abbreviations

	Export shapes

	Manage grades
	Add, modify, and delete grades
	Add grades
	Modify grades
	Delete grades

	Add, modify, and delete grade abbreviations
	Add a grade abbreviation
	Modify a grade abbreviation
	Remove a grade abbreviation

	Add grade substitutions
	Add grade redirections

	Manage dimensions
	View the dimensions of a shape
	Add dimensions
	Modify dimension properties
	Modify the properties of multiple dimensions
	Update dimension weights for newly added shapes
	Add grade overrides
	Add alternate dimensions
	Show where grades and dimensions are used
	Delete dimensions

	Manage material reports
	Create material reports
	View material reports
	Print material reports
	Send material reports via email
	Export material reports

	Change the display units of prices

	4.8  Set up pricing 
	Open Pricing Maintenance
	Find shapes, grades, and dimensions in Pricing Maintenance
	Manage material dimensions in pricing
	Add a single material dimension to pricing
	Add material dimensions to pricing
	Copy material dimensions from one grade to another
	Delete material dimensions from pricing

	Modify lengths and pricing
	Add, modify, and delete material lengths and pricing information for a dimension
	Add a material length and its pricing information
	Modify a material length and its pricing information
	Delete a material length and its pricing information

	Add a special price
	Modify the pricing of multiple items

	Create pricing forms
	Create and manage pricing lists
	Create a pricing list
	View the pricing list
	Print the pricing list
	Export the pricing list
	Email the pricing list as an Excel worksheet or a PDF file
	Import a pricing list
	Import a pricing list from Microsoft Excel
	Import from an XML file


	Add a supplier warehouse

	4.9 Job status maintenance
	Manage job statuses

	4.10 Manage taxes and currencies
	Create, modify, or delete tax rates
	Create, modify, or delete tax groups
	Add, modify, or delete currencies
	Add a currency
	Modify an exchange rate
	Set the default currency
	Modify a currency
	Delete a currency


	4.11 Import files to Tekla
			PowerFab
	Importing files
	Example: Import a new production control job
	Import assemblies and parametric assemblies
	Translate unknown shapes and grades

	4.12 Create, modify, and delete automated events
	Define the outgoing email settings
	Create a report event
	Create an automated Trimble Connect synchronization event
	Create an automated database optimization event
	Create an automated database backup
	Create an automated inventory sync event
	Create an automated cut list import event
	Create a production status export event
	Create an API log check event
	Run an automated event manually
	Copy an automated event
	Modify an automated event
	View the run history of an automated event
	Delete an automated event

	4.13 Customize Tekla
			PowerFab
	Customize display fields
	Customize input fields
	Customize menu options
	Customize the layout of a dialog box
	Create and modify module-wide filters
	Create module-wide filters
	Modify module-wide filters
	Delete module-wide filters

	Select metric or imperial mode
	Create customized report lists
	Create a report list
	Set the default report list
	Modify a report list
	Delete a report list

	Customize reports
	Create user-defined reports for customizing


	4.14 Customize and manage Stimulsoft
            reports
	Open the report editor
	Modify report properties
	Set up toolbox
	Report panels
	Properties
	Dictionary
	Report tree

	Modify Stimulsoft report appearance
	Manage Stimulsoft report fields
	Move and modify existing fields
	Add a new field
	View data fields
	Data field examples

	Combine text and data components

	Stimulsoft report data band
	Filter data

	Stimulsoft report group headers and footers
	Specify a data field for Condition
	Add a Group header

	Stimulsoft Sub-Reports
	Create a Sub-Report
	Sub-Report example

	Add images and watermarks to a Stimulsoft report
	Add images
	Add a watermark

	Stimulsoft report events
	Display events with code

	Stimulsoft report variables
	View and edit variables
	System variables
	Example: Convert data type using variables

	Record count for tables in Stimulsoft reports
	Create a row for each quantity in Stimulsoft reports
	Add a checkbox in a Stimulsoft report
	Conditional formatting of a Stimulsoft report
	Add a simple condition
	Add icons

	ODBC data source in Stimulsoft reports
	Add an OBDC data source
	Add tables to the ODBC data source
	Add relation to the detail data band source
	Have the relation populated with the data from the added source


	4.15 Set the user preferences
	4.16 Set the default printer
	4.17 Contact support
	Create a support ticket


	5  Combining
	5.1  Set up the Combining module
	Define company standard settings for Combining
	Define default input and display units for Combining
	Define default combining optimizations for Combining
	Define the general settings
	Define multing settings
	Define plate nesting settings

	Define default suppliers for Combining

	Manage combining jobs
	Delete combining jobs
	Copy a combining job
	Export combining jobs
	Merge combining jobs
	Renumber combining page items
	Set job groups for combining jobs
	Set job statuses for combining jobs


	5.2 Open the Combining module
	Create a combining job
	Define general settings
	Define customer settings
	Define input options
	Define combining optimizations for a combining job
	Define the general settings
	Define multing settings
	Define plate nesting settings

	Define suppliers for a combining job
	Define input and display units for a combining job

	Find a combining job
	Open a combining job
	Filter information in the Combining dialog box
	View all changes in a combining job

	Manage files for a combining job
	Modify a combining job

	5.3  Manage combining items
	Add a combining item
	Modify combining items
	Modify a single combining item
	Modify multiple combining items
	Modify the selected combining items
	Modify the shape, grade, dimensions, or length of combining items
	Modify the shape, grade, dimensions, or length of the selected combining items


	5.4 Copy a page of combining items
	5.5 Combine materials in the Combining
		module
	Rename a combining run
	View combining run filter settings
	Modify run-specific pricing information
	Modify a group of items in run-specific pricing maintenance

	Recombine all items
	Recombine items of a shape
	Recombine items of a material grade
	Recombine a material dimension
	Update combining information and recombine all items
	Compare combining runs
	View, print, or export combining run reports

	5.6  Load combining items into
		purchasing
	Load all combining items into a requisition
	Load selected combining items into a requisition
	Load all combining items into a purchase order
	Load the selected combining items into a purchase order

	5.7 Import an IFC file to a combining
            job
	5.8 Export a combining job to KISS
	5.9 View or print combining reports

	6 Estimating
	6.1 Set up the Estimating module
	Define company standard settings for Estimating
	Define default galvanizing settings
	Define default categories and subcategories for Estimating
	Manage categories
	Manage subcategories

	Define default input and display units for Estimating
	Define default combining optimizations for Estimating
	Define the general settings
	Define multing settings
	Define plate nesting settings

	Define default suppliers for Estimating

	Manage estimating jobs
	Delete estimating jobs
	Copy an estimating job
	Export estimating jobs
	Merge estimating jobs
	Renumber an estimating page item
	Set job groups for estimating jobs
	Set job statuses for estimating jobs

	Manage accessories
	Create an accessory
	Copy accessories
	Modify an accessory
	Modify multiple accessories at once
	Delete an accessory
	View, customize, print, and export accessory reports

	Create and manage parametric assemblies
	Create a parametric assembly
	1. Create and name the assembly template
	2. Create variables, items, and formulas
	3. Test the parametric assembly

	Example parametric assembly: Roof ladder without cage
	1. Create a description for the parametric assembly
	2. Create variables for calculating the ladder length and the number of rungs and collection clips
	3. Create side rails
	4. Create the rungs
	5. Create the connection clips
	6. View the result

	Modify a parametric assembly
	Export parametric assemblies
	Delete a parametric assembly

	Create formulas
	Access Formula dialog box
	Example formula: Calculate the cost of an estimate extra

	Manage default cleaning types and clean systems
	Create default cleaning types
	Define cleaning costs
	Create default clean systems

	Manage default paint types and paint systems
	Create default paint types
	Create default paint systems

	Modify freight pricing
	Add or update the weight range and multiplier for different load sizes
	Add or update freight pricing per hundedweight or kilogram

	Adjust labor information
	Calculate labor time
	Labor codes

	Create assemblies
	View, rename, copy, and delete assemblies
	Adjust labor times for column splices
	Adjust labor times for copes, punches, and stiffeners
	Create estimate extras
	Create an estimate extra
	Add labor code formulas
	Add child estimate extras
	Add costs
	Add labor times for a labor group
	Add welding, burning, punching, or drilling
	Add labor code operations

	View extrapolation factors
	Adjust labor codes
	Change the default labor code of a material group
	Add a new labor code
	Add or subtract operations and formulas
	Add column splices to a labor code
	Add cleaning to a labor code
	Add, modify, and delete formulas
	View and print a list of labor codes

	Create, modify, and delete labor groups
	Create a labor group
	Modify a labor group
	Delete a labor group
	Modify miscellaneous labor groups
	View, print, or export the labor group list

	Create, modify, and delete labor operations
	Create a labor operation
	Modify an existing labor operation
	Delete a labor operation
	View, print, or export the labor operation list

	Adjust labor standards
	View the compiled labor time of a dimension
	Add shapes and dimensions
	Modify the number of standard clip holes for a single dimension
	Modify the number of standard clip holes for multiple dimensions
	Copy labor times to multiple dimensions
	Remove an individual material dimension
	Remove a shape and all of its dimensions
	Create labor standard reports

	Adjust quantity and weight labor factors
	Add quantity or weight labor factors
	Modify quantity or weight labor factors
	Delete quantity or weight labor factors

	Manage standard clips
	Modify the properties of standard clips
	Add additional labor or material items to a standard clip
	Modify additional labor or material items
	Delete additional labor or material items

	Adjust labor times for burning
	Add burn types
	View, print, or export a burn rate list

	Adjust labor times for drilling
	Add drill types
	View, print, or export the drill rate list

	Adjust labor times for punching
	Add punch types
	View, print, or export the punch rate list

	Adjust labor times for welding
	Add weld types
	View, print, or export a weld rate list


	Manage estimate statuses
	Adjust standard shop information
	Modify labor operation settings
	Define default markup percentages

	Create and modify labor rates
	Create and modify shop setups
	Change the active shop setup
	Change the default shop setup
	Delete shop setups

	Create a standard proposal setup

	6.2 Open the Estimating module
	Create an estimating job
	Define general settings
	Define paint settings
	Define paint systems
	Define clean systems
	Define combining optimizations for an estimating job
	Define the general settings
	Define multing settings
	Define plate nesting settings

	Define suppliers for an estimating job
	Define input and display units for an estimating job
	Define galvanizing settings for an estimating job
	Define markups for an estimating job
	Link an estimating job to a project management job

	Find an estimating job
	Open an estimating job
	Filter information in the Estimating dialog box
	View estimating job details
	View the labor times of items
	View and modify the labor time of an item

	View all changes in an estimating job
	View, email, export, and print estimating reports
	View or email estimating reports
	Print estimating reports
	Export estimating reports


	Calculate an estimating job
	Calculate the total material cost
	Recalculate an estimate


	Manage files for an estimating job
	Modify an estimating job

	6.3 Manage estimating items
	Add materials to an estimating job
	Add an estimating item
	Apply additional labor and clips
	Apply additional labor
	Apply clips


	Add an accessory
	Create a job-specific accessory

	Add an assembly
	Add a parametric assembly

	Find estimating items
	Modify estimating items
	Modify a single estimating item
	Modify multiple estimating items
	Modify the selected estimating items

	Copy and multiply estimating items
	Copy estimating items
	Copy a page of estimating items
	Copy and multiply a group of estimating items
	Multiply the quantity of the selected estimating items
	Multiply the quantity of all estimating items in a sub-category

	Delete an estimating item
	Manage production codes
	Create a production code
	Modify a production code
	Delete a production code
	Apply a production code

	Load estimating materials to other jobs
	Load estimating materials into purchasing
	Load all estimating items into a requisition
	Load all estimating items into a purchase order
	Load the selected estimating items into a requisition
	Load the selected estimating items into a purchase order

	Load materials into another estimate
	Load all or filtered items into an estimate
	Load selected items into an estimate

	Load materials into Production Control
	Load all items into a production control job
	Load selected items into a production control job



	6.4 Combine materials in the Estimating
        module
	6.5 Import files to and export files from the
        Estimating module
	Import files to the Estimating module
	Importing files

	Export an estimating job to KISS
	Export labor information
	Import labor information to Tekla PowerFab

	6.6 Use Trimble Connect with an estimating
        job
	Link an estimating job to Trimble Connect
	Unlink an estimating job from Trimble Connect

	Color-code estimating items in the IFC model
	Select the same items in the estimating job and in the IFC model

	6.7 Create a proposal

	7 Inventory
	7.1 Define the default inventory
        settings
	Define company standard settings for Inventory
	Define default input and display units for Inventory

	Define the countries of origin
	Restrict inventory locations

	7.2 Open the Inventory module
	Filter information in the Inventory dialog box
	Search for items in the Inventory dialog box
	Search for items by material shape, grade, or size
	Search for an item by heat number
	Search for an item by serial number

	Open Inventory History

	7.3 Manage files for inventory
	7.4 Manage inventory items
	Add an item to the inventory
	Modify inventory items
	Define serial numbers for an inventory item
	Modify a single inventory item
	Modify multiple inventory items
	Modify selected inventory items

	Copy an inventory item
	Take material from stock and return material to stock
	Take selected materials from stock

	Add inventory to load
	Move an item to another inventory location
	Add inventory items to Order Entry
	Reserve items for a customer order
	Send items to a customer order

	Delete inventory items
	Combine inventory items manually
	Switch to the manual combine mode
	Combine materials
	Uncombine materials
	Switch back to the input mode


	7.5 Add, modify, and delete stock quantities to be
            maintained
	Add a new stock record
	Modify stock records
	Delete stock records
	Load stock items to a requisition
	Load stock items to a purchase order

	7.6 View inventory details
	View heat documents attached to inventory items
	View the location of barcoded materials
	View the location of barcoded materials
	Delete a location sweep
	Cancel remaining items from a location sweep
	Complete the location sweep and move remaining items
	View, print or export reports of an existing location sweep

	View the value of inventory materials
	View the current material value in inventory or the material value on a specific date and time
	View the material value on a specific date
	View the value from an archive file

	View the transaction history in the Inventory module
	View the transaction history of an item
	Find a transaction by transaction number
	Create transaction history reports
	View all changes in the transaction history

	View and print TFS reports
	View, print, and export inventory reports
	View inventory reports
	Print inventory reports
	Export inventory reports


	7.7 Import and
        export inventory information
	Export inventory information to the KSTK format
	Export inventory transactions to Timberline
	Export inventory to SigmaNest
	Export inventory information to XML
	Synchronize inventory information with ProNest
	Import inventory information from an HTML file
	Import ProNest cut lists to Tekla PowerFab
	Import inventory information from Microsoft Excel
	Archive jobs


	8 Project
			Management
	8.1 Set up the Project Management
        module
	Define company standard settings for Project Management
	Set up schedules
	Modify the project schedule settings
	Manage schedule templates
	Create a schedule template
	Modify a schedule template
	Delete a schedule template

	Create, modify, and delete schedule calendars
	Create a schedule calendar
	Add working day exceptions
	Set a schedule calendar as the default option
	Modify a schedule calendar
	Delete a schedule calendar


	Manage approval status for drawings
	Create an approval status option
	Modify an existing approval status
	Delete an approval status

	Create, modify, and delete common steps for project management jobs
	Create a check list item
	Modify a check list item
	Change the position of a check list item
	Delete a check list item

	Manage project management jobs
	Delete project management jobs
	Rename a project management job
	Set job groups for project management jobs
	Edit job groups for project management jobs
	Set job statuses for project management jobs

	Set up transmittals
	Create, modify, and delete methods for sending documents
	Create a sending method
	Modify a sending method
	Set the default sending method
	Delete a sending method

	Create, modify, and delete transmittal items
	Create a transmittal item
	Modify a transmittal item
	Delete a transmittal item

	Create, modify, and delete transmittal purposes
	Create a transmittal purpose
	Modify a transmittal purpose
	Delete a transmittal purpose

	Create, modify, and delete commonly used text items for transmittals
	Create a text item
	Modify a text item
	Delete a text item


	Manage default drawing logs
	Add a drawing log
	Modify a drawing log
	Delete a drawing log

	View, print, or export project reports
	Create a project report
	View the report
	Print the report
	Export the report


	8.2 Open the Project Management module
	Create a project management job
	Add a project contact

	Find a project management job
	Open a project management job
	Manage files for a project management job

	8.3 Manage project information
	Manage and assign project tasks
	Create a project task
	Modify a project task
	Delete a project task

	Manage drawings
	Define drawing settings for a job
	Manage drawing logs for a job
	Add a drawing log
	Modify a drawing log
	Delete a drawing log

	View a drawing log
	Find a drawing
	View a drawing

	Add, modify, and delete drawings
	Add a drawing
	Modify a drawing
	Delete a drawing
	Add a batch of drawings without PDF attachments to a drawing log
	Add a batch drawings with PDF attachments to a drawing log
	Modify multiple drawings
	Modify the selected drawings
	Add, modify, and delete drawing revisions
	Add a single drawing revision
	Modify a drawing revision
	Modify multiple drawing revisions
	Delete a drawing revision
	Delete multiple drawing revisions


	Copy drawing files to another location
	Copy all drawing files in the current drawing log
	Copy drawing files attached to the selected drawings

	Print drawings
	Update the links to a drawing log
	View the issue history of selected drawings
	View, print, or export drawing reports
	Create a drawing report
	View a drawing report
	Print the drawing report
	Export the drawing report

	Set drawings on hold

	Manage companies in the project
	Add a company contact
	Modify a contact
	Remove a company from the project

	Manage transmittals
	Create, modify, and delete transmittals
	Create a transmittal
	Modify a transmittal
	Delete transmittals

	View transmittals
	Print transmittals
	Mark drawings in a transmittal as received
	Send a transmittal via email
	View, print, and export transmittal reports
	Create a transmittal report
	View the transmittal report
	Print the transmittal report
	Export the transmittal report


	Manage requests for information
	Create, modify, and delete requests for information
	Create a request
	Modify a request
	Delete a request

	View requests for information
	Print requests for information
	Import or export requests for information
	Import requests
	Export requests
	Save a request for information as a Microsoft Word document

	Send a request for information via email
	View, print, or export RFI reports
	Create an RFI report
	View the RFI report
	Print the RFI report
	Export the RFI report


	Manage the project journal
	Add, modify, and delete journal entries
	Add a journal entry
	Modify a journal entry
	Delete journal entries

	View, print, and export project journal reports
	Create a project journal report
	View the journal report
	Print the journal report
	Export the journal report


	Manage change orders
	Create, modify, and delete change orders
	Create a change order
	Modify a change order
	Delete change orders

	View change orders
	Print change orders
	View, print, or export change order reports
	Create a change order report
	View the change order report
	Print the change order report
	Export the change order report


	Manage the project task list
	Create, modify, and delete task list items
	Create a task list item
	Modify a task list item
	Delete task list items

	View, print, and export task list reports
	Create a task list report
	View, print, and export task list reports
	View the task list report
	Print the task list report
	Export the task list report



	Manage the project check list
	Add check list items
	Send check list items to the task list
	Modify a check list item
	Delete check list items from a project
	View, print, or export check list reports
	Create a check list report
	View the check list report
	Print the check list report
	Export the check list report



	8.4 View and adjust the project
        schedule
	Switch edit mode on and off
	Create, modify, and delete baseline plans
	Create a baseline plan
	Copy the current schedule status to baseline
	Change the current baseline plan
	View the total values and breakdown information of the project
	Modify a baseline plan
	Delete a baseline plan
	View changes in the project schedule and add savepoints

	Manage schedule tasks
	Add a task to the project schedule
	Move a task earlier or later in the schedule
	Modify a task
	Delete a task
	Save schedule tasks as a schedule template

	Add, modify, and delete breakdown items
	Add a new breakdown item
	Modify a breakdown item
	Change the priority of a breakdown item
	Delete a breakdown item

	Modify the Gantt chart
	Modify the dates of tasks
	Modify the duration of tasks
	Modify task properties
	Modify display settings
	Print a Gantt chart report

	Apply a schedule template
	Update the project schedule
	Export the project schedule to XML format
	Create a project schedule report
	Example: Create a project schedule
	1. Apply a schedule template
	2. Modify the schedule dates
	3. Set the baseline
	4. Add project breakdown information


	8.5 Define time-tracking settings
	8.6 Manage time-tracking information
	Add a time-tracking record
	Modify or delete time-tracking records
	Import time-tracking records
	View a time-tracking summary
	Regular expressions

	8.7 Manage contract and invoicing
        information
	Add and modify contract information
	Add a contract item to the original contract
	Add a contract item to a change order
	Modify a contract item
	Move a contract item up or down
	Delete a contract item
	Adjust the contract properties

	Create and modify invoices
	Create an invoice
	Modify an invoice
	Delete an invoice
	View, print, or export invoice documents or invoice reports


	8.8 Import and export project management
        information
	Import drawing status information
	Export the production status to Tekla Structures or Advance Steel
	Export the production status to SDS/2
	Publish the production status to Trimble Connect

	8.9 View, print, or export project management
            reports
	Create a project management report
	View the report
	Print the report
	Export the report
	View, print, or export the project summary
	Create a project summary report
	View the project summary report
	Print the project summary report
	Export the project summary report



	9 Production Control
	9.1 Set up the Production Control
        module
	Define company standard settings for Production Control
	Define general settings
	Define input settings
	Define import settings
	Define report settings
	Define settings for drawings on hold
	Define default input and display units for Production Control
	Define default combining optimizations for Production Control
	Define the general settings
	Define multing settings
	Define plate nesting settings

	Define default suppliers for Production Control
	Define default categories and sub-categories for Production Control
	Manage categories
	Manage subcategories

	Define default pay categories for Production Control
	Define load tracking settings
	Access Load Tracking Settings
	Adjust trailer number settings
	Adjust the load tracking fields
	Adjust receiving date settings
	Close the Load Tracking dialog box


	Manage production control jobs
	Delete production control jobs
	Copy a production control job
	Export production control jobs
	Set job groups for production control jobs
	Set job statuses for production control jobs

	Define critical length and width differences
	Manage stations and routes
	Manage stations
	Create a station
	Modify a station
	Delete a station

	Create, modify, and delete routes
	Create a new route
	Modify a route
	Delete a route


	Manage approval statuses for drawings
	Create an approval status option
	Modify an existing approval status
	Delete an approval status

	Create, modify, and delete material finish options
	Create a new finish option
	Modify an existing finish option
	Delete a finish option

	Create, modify, and delete global production codes
	Create a production code
	Modify a production code
	Delete a production code

	Manage cut lists
	Access Cut Lists dialog box
	Create a cut list
	Save cut list - partially matched filter

	View the details of a cut list item
	Swap a cut list item
	Cut a cut list item
	Update a cut list
	Validate or revalidate cut list items
	Validate cut list items
	Revalidate cut list items

	Lock or unlock a cut list
	Share or unshare a cut list
	Export a cut list to DSTV +
	View, print, or export cut list reports
	Delete a cut list

	Manage default shipping routes
	Create a shipping route
	Copy a shipping route
	Modify a shipping route
	Delete a shipping route
	Manage shipping destinations
	Add a new destination
	Modify a destination
	Delete a destination


	Add, modify, and delete top text items for shipping tickets
	Create a top text item
	Modify a top text item
	Delete a top text item

	Add piece tracking and load tracking information and loads to production control jobs
	Add piece tracking information
	Add loads, ship loads, and unship loads
	Add piece marks to trucks

	Review production statuses of jobs
	Create global production control reports
	Craete purchasing reports for all jobs
	Create a purchasing report
	View the report
	Print the report
	Save a cut list

	Create production reports for all or several jobs
	View a report
	Print a production report
	Export a production report



	9.2 Open the Production Control module
	Create a production control job
	Define general settings
	Define client details (Sold To/Ship To)
	Define input settings
	Define combining optimizations for a production control job
	Define the general settings
	Define multing settings
	Define plate nesting settings

	Define suppliers for a production control job
	Define input and display units for production control jobs
	Link a production control job to an estimating job and a project management job

	Find a production control job
	Open a production control job
	Filter information in the Production Control dialog box
	Find production control items

	Manage files for a production control job
	Modify a production control job
	View the production dashboard

	9.3 View production control job details
	Manage changes to a production control job
	Import changes to a production control job
	View the summary of revisions
	Manage changes
	View change report
	Review and manage saved changes in a job

	View all changes in a production control job
	View all changes since importing the bill of materials
	Manage production control job information
	Manage job-specific cut lists
	Manage production codes used in a production control job
	Open the PDC Production Codes dialog box
	Create a production code
	Modify a production code
	Delete a production code

	Review the production statuses of items
	View material links
	Add, modify, and review inspection test records
	Add a new inspection test record
	Add, modify, and review inspection test records
	Filter inspection test records
	Run a follow-up test
	Modify an inspection test record
	View, print, and export inspection test reports


	Modify the setup of an inspection test
	1. Modify the test properties
	2. Add new fields
	3. Modify, move, or delete fields
	4. Save the test and run a sample inspection test

	Review the inspection statuses of items
	Manage shipping routes for a production control job
	Open the shipping routes dialog box
	Create a shipping route
	Copy a shipping route
	Modify a shipping route
	Delete a shipping route

	View and adjust TFS details
	Compare the materials in a production control job and a combining job
	Compare the labor hours in a production control job and an estimating job

	View the production schedule
	Modify resource capacity
	Open the Resource Maintenance dialog box
	Add a resource
	Modify a resource
	Delete a resource


	View, print, and export job-specific production control reports
	Create a report
	View the report
	Print the report
	Export the report

	Import, view, or delete CNC files
	Import CNC files
	View CNC files
	Save CNC files to another location
	Delete CNC files


	9.4 Manage production control items
	Add a production control item
	Modify production control items
	Modify a single production control item
	Modify multiple production control items
	Modify the selected production control items
	Adjust sequences
	Set and update sequences
	Manage the sequences and lots of selected production control items
	Remove all items from a sequence
	Add multiple items to a sequence
	Remove multiple items from sequences


	Copy materials from one drawing to another
	Send production control items to purchasing
	Load all production control items into a purchase order
	Load all production control items into a requisition
	Load the selected production control items into a purchase order
	Load the selected production control items into a requisition
	Link materials in Production Control to Purchasing
	Unlink materials between Production Control and Purchasing
	Verify material links between Production Control and Purchasing
	Check purchase orders for received materials
	Check purchase orders for all materials
	Check purchase orders for selected materials

	Take production control items from stock
	Take all items from stock
	Take the selected items from stock
	Take a single cut list item from stock

	View or print job-specific purchasing reports
	Create job-specific purchasing report
	View the purchasing report
	Print the purchasing report
	Save a cut list



	9.5 Combine materials in the Production Control
        module
	9.6 Create and manage loads
	Add a new load
	Preassign or add materials to a load
	Ship a load
	Create and view a shipping ticket
	Modify a load
	View the materials on a load
	View current load locations
	Delete a load
	Add production control items to loads
	Add piece tracking and load tracking information and loads to the current production control job
	Add piece tracking information
	Add loads, ship loads, and unship loads
	Add piece marks to trucks


	9.7 Track production by piece mark
	9.8 Use Trimble Connect with a production control
        job
	Link a production control job to Trimble Connect
	Color-code production control items in the IFC model
	Select the same items in the production control job and in the IFC model
	Visualize jobs with Trimble Connect Organizer and Trimble Connect Content Browser
	Set up item categories for Trimble Connect Organizer
	Publish job information manually to Trimble Connect Organizer
	Highlight selected items in Trimble Connect Organizer
	Color-code items with Trimble Connect Content Browser


	9.9 Export production control
        information
	Export a production control job to KISS
	Export the production control job to a CIS/2 model
	Export the production status to Tekla Structures or Advance Steel
	Export the production status to SDS/2

	9.10 Finalize a production control job

	10 Purchasing
	10.1 Set up the Purchasing module
	Define the requisition settings
	Define company standard settings for requisitions
	Define default input and display units for requisitions
	Define default combining optimizations for requisitions
	Define the general settings
	Define multing settings
	Define plate nesting settings

	Define default suppliers for requisitions

	View, print, or export global requisition reports
	View the requisition report
	Print the requisition report
	Export the requisition report

	Manage requisitions
	Delete requisitions
	Copy a requisition


	Define the purchase order settings
	Define company standard settings for purchase orders
	Define general settings
	Define company standard settings for purchase orders
	Define receiving settings
	Define default remarks
	Define default top text

	Define default input and display units for Purchasing

	Import, view, or delete advance shipment notices
	Import an advance shipment notice
	View the details of an advance shipment notice
	Delete an advance shipment notice

	View, print, or export global receiving reports
	View the report
	Print the report
	Export the report

	Add, modify, or delete purchase order types
	Create a purchase order type
	Set a purchase order type as default
	Modify a purchase order type
	Delete a purchase order type

	Add, modify, and delete shipping methods for purchase orders
	Add, modify, or delete FOB shipping destinations
	Create a FOB shipping destination
	Set the default FOB shipping destination
	Modify a FOB shipping destination
	Delete a FOB shipping destination

	Add, modify, or delete payment terms for purchase orders
	Add, modify, or delete purchase order remarks
	Create a remark
	Modify a remark
	Delete a remark

	Add, modify, or delete top text items
	Create a top text item
	Modify a top text item
	Delete a top text item


	Create, modify, or delete cost codes
	Create a cost code
	Modify a cost code
	Delete a cost code


	10.2 Create and manage requisitions
	Create a requisition
	Define combining optimizations for a requisition
	Define the general settings
	Define multing settings
	Define plate nesting settings

	Define suppliers for a requisition
	Define input and display units for a requisition

	Find a requisition
	Open a requisition
	Modify a requisition
	Manage files for a requisition
	Add a requisition item
	Modify requisition items
	Modify a single requisition item
	Modify multiple requisition items
	Modify the selected requisition items
	Modify the shape, grade, dimensions, or length of multiple requisition items
	Modify the shape, grade, dimensions, or length of the selected requisition items

	Copy a requisition item
	Delete requisition items
	View the pricing history of a requisition item
	View all changes in a requisition
	Load requisition items into a purchase order
	Load all items into a purchase order
	Load selected items into a purchase order

	Export a request for pricing
	Save a request for pricing as a Microsoft Excel worksheet
	Email a request for pricing as a Microsoft Excel worksheet
	Save or email a request for pricing as an steelXML file
	Modify pricing information in Microsoft Excel

	Import pricing information to a requisition
	Import pricing information from an Excel worksheet
	Import pricing information from an XML file
	Import pricing information from an email attachment

	Update pricing information
	Combine items in the Requisition # dialog box
	Combine requisition items manually

	View, print, or export requisition-specific reports
	View the report
	Print the report
	Export the report
	Export data from the report

	Delete requisitions

	10.3 Create and manage purchase orders
	Create a purchase order
	Define general settings
	Define vendor settings
	Define client details (Ship To/Bill To)
	Define remarks
	Define top text
	Define financial information
	Define other properties

	Find a purchase order
	Open a purchase order
	Filter information in the PO # dialog box
	Modify a purchase order
	Manage files for a purchase order
	Add a purchase order item
	Modify purchase order items
	Modify a single purchase order item
	Modify multiple purchase order items
	Modify the selected purchase order items
	Modify the shape, grade, dimensions, or length of multiple purchase order items
	Modify the shape, grade, dimensions, or length of the selected purchase order items

	Copy a purchase order item
	Copy material items to another purchase order

	Receive purchase order items
	Receive specific items
	Attach heat documents when receiving items
	Receive all displayed items without attaching heat documents
	Unreceive purchase order items

	View heat documents attached to purchase order items
	Send purchase order items to a requisition
	View the pricing history of a material item
	Finalize purchase order items
	Finalize the selected purchase order items
	Finalize all displayed purchase order items
	Unfinalize purchase order items

	Delete purchase order items
	View all changes in a purchase order
	View the transaction history of a purchase order
	Find a transaction by transaction number
	Create transaction history reports

	View, print, or export purchase orders and purchase order reports
	View the report
	Print the report
	Export the report

	View, print, or export job-specific receiving reports
	View the report
	Print the report
	Export the report

	Export purchase orders
	Export the selected purchase orders to Trimble Viewpoint
	Export purchase orders with receiving transactions to Viewpoint
	Export purchase orders to Timberline or Sage 300 CRE
	Export CNC files and drawings

	Approve a purchase order
	Unlock a purchase order

	Delete purchase orders

	10.4 Create and manage splice packages
	Check if splicing is needed
	Create a splice package
	View and modify splice packages
	Heat certificate traceability
	Set the kerf


	11  Order
			Entry
	11.1  Set up the Order Entry module
	Define company standard settings for Order Entry
	Define general order entry settings
	Define price level settings
	Set credit limit settings
	Define backdating settings
	Define QuickBooks sale tax codes
	Define default input and display units for Order Entry
	Define default combining optimizations for Order Entry
	Define the general settings
	Define plate nesting settings

	Define default suppliers for Order Entry

	Create, modify, and delete charge processes
	Create, modify, and delete invoice categories
	Create, modify, and delete order and quote categories
	Create, modify, and delete price groups
	Create, modify, and delete payment methods
	Add, modify, and delete payment terms for customer orders
	Add, modify, and delete shipping methods for customer orders
	Create, modify, and delete territory options

	11.2 Open the Order Entry module
	11.3 Filter the order entry information
	11.4 Manage quotes and orders
	Create a quote or an order
	Add quote or order details
	Add and combine materials
	Modify the properties of allocated materials
	Add charges
	Add discounts

	Send material items to purchasing
	Copy quote or order information
	Create a quick quote

	Modify a quote or an order
	Convert a quote into an order
	Convert an order back into a quote
	Delete a quote

	11.5 Add an invoice
	Export invoices to accounting software

	11.6 Add a payment
	11.7 Add a credit
	11.8 Add a delivery
	11.9 Add a return
	11.10 Create order or quote reports

	12 Troubleshooting
	12.1 Troubleshoot combining issues
	The grade of the item does not match
	The item is longer than any available material
	Items do not combine to inventory
	"Save Displayed Results & Close" is not available
	The combining dialog box opens to a blank window
	Inventory “Manual Combine Mode” does not display material in requisitions when “Add Item” is selected in the "Add Item" dialog box

	12.2 Troubleshoot 401 Unauthorized error

	13 Disclaimer
	Index

